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About This Guide


The Novell Vibe 3.2 Installation Guide covers the installation and configuration of Novell Vibe. The 
guide is divided into the following sections:


 Part I, “Product Overview,” on page 11
 Part II, “Basic Installation,” on page 23
 Part III, “Advanced Installation and Reconfiguration,” on page 79
 Part IV, “Multi-Server Configurations and Clustering,” on page 113
 Part V, “Update,” on page 151
 Part VI, “Appendixes,” on page 189


Audience


This guide is intended for Novell Vibe administrators.


Feedback


We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comments feature at the bottom of each page of the 
online documentation.


Documentation Updates


For the most recent version of this manual, visit the Novell Vibe 3.2 Documentation Web site (http://
www.novell.com/documentation/vibe32). 


Additional Documentation


You can find more information in the Novell Vibe documentation, which is accessible from the 
Novell Vibe 3.2 Documentation Web site (http://www.novell.com/documentation/vibe32). 


To access the Novell Vibe User Guide from within Vibe, click the Help icon (question mark).
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I IProduct Overview


 Chapter 1, “What Is Novell Vibe?,” on page 13
 Chapter 2, “Vibe System Requirements,” on page 17
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1 1What Is Novell Vibe?


Novell Vibe is an enterprise collaboration tool designed to increase individual productivity, team 
effectiveness, and organizational success by providing the right set of tools to the right people.


 Section 1.1, “Vibe Capabilities,” on page 13
 Section 1.2, “Vibe Components,” on page 14
 Section 1.3, “Vibe Configurations,” on page 15


1.1 Vibe Capabilities
Novell Vibe users fall into three basic groups:


 Section 1.1.1, “Content Consumers,” on page 13
 Section 1.1.2, “Content Providers,” on page 13
 Section 1.1.3, “Administrators,” on page 14


1.1.1 Content Consumers


Content consumers use Novell Vibe to work with important information that pertains to them. 
Content consumers:


 Maintain their personal workspaces, including setting up a personal Blog, Calendar, Files, 
Guestbook, Photo Album, and Tasks folder


 Participate in team workspaces set up for content providers, in order to better collaborate with 
colleagues and facilitate their work assignments


 Search the Vibe site for people, places, and other information that pertains to their personal 
work assignments


 Identify subject-matter experts to assist them in their personal work assignments 


The typical tasks performed by content consumers are covered in the Novell Vibe 3.2 User Guide.


In many cases, content consumers quickly become content providers.


1.1.2 Content Providers


Content providers use Novell Vibe to create and manage teams, customize the Vibe environment, 
and import data into the Vibe site for use by other Vibe users. Content providers:


 Create and manage team workspaces and folders
 Control user access to their team workspaces
 Establish unique branding for workspaces and folders to clearly differentiate them from other 


places on the Vibe site

What Is Novell Vibe? 13







 Create landing pages for workspaces that consolidate the most necessary workspace 
information into a single page


 Customize data entry forms for gathering information from users
 Create workflows to automate otherwise time-consuming manual processes


The typical tasks performed by content providers are covered in the Novell Vibe 3.2 User Guide.


1.1.3 Administrators


A Novell Vibe administrator is responsible for installing the Vibe software and setting up the Vibe 
site. This Novell Vibe 3.2 Installation Guide provides instructions for Vibe software installation. After 
installation, the Vibe site administrator can:


 Set up user access to the Vibe site
 Create initial workspaces and populate them with information that is of interest to Vibe users
 Control user access to workspaces and folders
 Configure e-mail integration, so that Vibe users can receive notifications of updated information 


on the Vibe site and post to the Vibe site by using e-mail messages
 Set up mirrored folders to make large sets of data that are already available on disk more easily 


available through the Vibe site
 Set up software extensions (add-ons) that enhance the power and usefulness of the Vibe site
 Set up remote applications that deliver data from a remote location, such as a remote database, 


for easy access on your Vibe site
 Manage users, workspaces, and folders as the Vibe site grows and evolves
 Perform regular backups to safeguard the data stored in the Vibe site


The typical tasks performed by Vibe site administrators are covered in the  Novell Vibe 3.2 
Administration Guide.


1.2 Vibe Components
A Novell Vibe site consists of four major components:


 Section 1.2.1, “Vibe Software,” on page 14
 Section 1.2.2, “Vibe Database,” on page 14
 Section 1.2.3, “Vibe File Repository,” on page 15
 Section 1.2.4, “Lucene Index,” on page 15


1.2.1 Vibe Software


The Vibe software is a customized version of Apache Tomcat. This software provides the Web-based 
functionality you use as you access the Vibe site through your Web browser.


1.2.2 Vibe Database


The Vibe database is used for storing information about the Vibe site and its users:


 Structural information about workspaces, folders, and entries (for example, their location in the 
workspace tree)
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 Identification information about workspaces, folders, and entries (for example, titles, 
descriptions, dates of creation/modification, and users associated with creation/modification)


 User profile information (for example, full name, phone number, and e-mail address)


The Vibe database disk space requirements are relatively modest, because the database is not used 
for storing files.


1.2.3 Vibe File Repository


The Vibe file repository holds all files that are imported into Vibe, information related to the 
imported files, such as thumbnails and HTML renderings, and the search engine index.


The Vibe file repository disk space requirements depend on the size of the Vibe site. For a large Vibe 
site, disk space requirements can be substantial. 


1.2.4 Lucene Index


The Lucene Index Server is a high-performance Java search engine. The Lucene index contains 
pointers to the actual data stored in the Vibe file repository. The index enables the Lucene search 
engine to perform very fast searches through large quantities of Vibe data.


1.3 Vibe Configurations
You can configure Novell Vibe to run on a single server or multiple servers, depending on the size 
and needs of your Vibe site.


For more information, see Part IV, “Multi-Server Configurations and Clustering,” on page 113.


Configuration Description


Single Server By default, the Vibe Installation program installs all Vibe components on the same 
server. 


Remote Database 
Server


For better performance and scalability, you can install the Vibe database on a remote 
server.


Remote Lucene Index 
Server


For better performance and scalability, you can install the Lucene index on a remote 
server.


Multiple Vibe Servers By running Novell Vibe on multiple servers, you can achieve high availability, including 
failover and load balancing, depending on how you configure your servers.


Multiple Remote 
Lucene Servers


Your Novell Vibe site depends on the Lucene Index Server for full functionality. 
Running multiple Lucene Index Servers provides high availability, so that if one Lucene 
Index Server goes down, Vibe users can still access the Vibe site because other 
Lucene Index Servers are still available.


Multiple Remote 
Database Servers


Each of the three databases supported by Vibe each has its own approach to 
clustering the database server. Information about clustering database servers is 
available on the Internet.
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2 2Vibe System Requirements


You, as a Novell Vibe site administrator, must ensure that your system meets Vibe system 
requirements, so that your Vibe site can be set up successfully. After your Vibe site is set up, you must 
ensure that users’ browsers and office applications meet Vibe user requirements, so that users can 
access the Vibe site successfully.


 Section 2.1, “Vibe Server Requirements,” on page 17
 Section 2.2, “Vibe User Requirements,” on page 19
 Section 2.3, “Mobile Device Requirements,” on page 19
 Section 2.4, “Supported Environments,” on page 20
 Section 2.5, “Recommended Hardware Configurations,” on page 21


For the latest system requirements details, see the Novell Vibe 3.2 Readme (http://www.novell.com/
documentation/vibe32/vibe32_readme_novell/data/vibe32_readme_novell.html).


2.1 Vibe Server Requirements
 Hardware for the Novell Vibe server:


 x86-32 processor or x86-64 processor 
 Minimum 2 GHz processor
 Multi-CPU systems preferred
 Minimum server memory:


 At least 3 GB RAM for an x86-32 processor
 At least 4 GB RAM for an x86-64 processor


See Section 2.5, “Recommended Hardware Configurations,” on page 21 and Section 3.2.3, 
“Vibe Server Memory,” on page 27.


 Any of the following supported server operating systems for the Vibe server:
 Novell Open Enterprise Server (OES) 2, plus the latest Support Pack
 Novell Open Enterprise Server 11, plus the latest Support Pack
 SUSE Linux Enterprise Server (SLES) 10 or SLES 11, plus the latest Support Pack


NOTE: On Linux, the X Window System is required by the GUI Vibe installation program. 
It is not required to run Vibe after installation. It is not required for text-based installations 
or silent installations.


 Windows Server 2003 or Windows Server 2008, plus the latest Service Pack
 Windows Server 2003R2 or Windows Server 2008R2, plus the latest Service Pack
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 Database server:
 Linux: 


 MySQL 5.0.26 or later server and client


NOTE: MySQL 5.0.26 is included with SLES 10 SP1 and OES 2 Linux. MySQL 5.0.67 is 
included with SLES 11.


 Oracle 10g or Oracle 11g
 Windows:


 MySQL 5.0.26 or later server and tools
 Microsoft SQL Server 2005 or SQL Server 2008, plus the latest Service Pack
 Oracle 10g or Oracle 11g


More information about MySQL is available in Section A.2, “MySQL Database Server,” on 
page 193.


 Tomcat 6.0.18


NOTE: Tomcat 6.0.18 is included with Vibe on Linux and Windows.


 Java Developer Kit (JDK):
 Oracle JDK 6.0
 IBM JDK 6.0


Java scripting must be enabled for proper Vibe site functionality.
More information about JDKs is available in “Java Development Kit” in Appendix A, “Vibe 
System Requirements Assistance,” on page 191.


 Directory service:
 Linux: Novell eDirectory 8.8 or later, plus the latest Support Pack


For information about eDirectory, see the Novell eDirectory 8.8 Documentation Web site 
(http://www.novell.com/documentation/edir88).


 Windows: Microsoft Active Directory, plus the latest Service Pack, or Novell eDirectory 8.8 
or later, plus the latest Support Pack
For information about Active Directory, see Windows Server 2003 Active Directory (http://
www.microsoft.com/windowsserver2003/technologies/directory/activedirectory) or 
Windows Server 2008 Active Directory (http://www.microsoft.com/windowsserver2008/en/
us/active-directory.aspx).


 Adequate server disk space:
 Vibe software: At least 500 MB for a new installation


When you update an existing Vibe system, ensure that your server has at least twice the 
amount of disk space available as is in the following directory, plus an additional 500 MB:


 Database server software: At least 500 MB for a new installation
When you update an existing Vibe system, ensure that your server has at least twice the 
amount of disk space available as is in the following directory, plus an additional 500 MB:


Linux: /var/opt/novell/teaming


Windows: c:\Program Files\Novell\Teaming
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 Vibe file repository: Depends on the anticipated size of the Vibe site
 Database content: Substantially less than the Vibe file repository


See Section 3.6, “Planning the Vibe Database,” on page 34 to plan for the disk space needs of 
your Vibe site.


 TrueType fonts
If you are installing Vibe in a non-GUI Linux environment, you might need to manually install 
the TrueType fonts if they are not already installed. TrueType fonts enable Stellent converters to 
function properly for document conversions. For more information, see “Understanding and 
Configuring Document Conversions with Stellent” in the  Novell Vibe 3.2 Administration Guide.


2.2 Vibe User Requirements
 Web browser:


 Linux: Mozilla Firefox 3 or later; Google Chrome (latest version)
 Windows: Microsoft Internet Explorer 6 or later (must not have the Google Chrome Frame 


plug-in installed); Mozilla Firefox 3 or later; Google Chrome (latest version)
When you use Internet Explorer 6, some functionality might not be available.


 Mac: Safari 4 or later; Mozilla Firefox 3 or later
 Office applications:


 Linux: OpenOffice.org/LibreOffice 3.1.1 or later
 Windows: Microsoft Office 2007 or later; OpenOffice.org/LibreOffice 3.1.1 or later
 Mac: OpenOffice.org/LibreOffice 3.1.1 or later


NOTE: OpenOffice and LibreOffice are used synonymously throughout the Novell Vibe 
documentation. Functionality and issues that apply to OpenOffice also apply to LibreOffice.


 Collaboration clients:
 Linux:


 GroupWise 8 with the latest Support Pack
 Windows:


 GroupWise 8 with the latest Support Pack
 Outlook 2007 with iCal support enabled
 Notes 7 with iCal support enabled


2.3 Mobile Device Requirements
 Section 2.3.1, “Supported Mobile Devices,” on page 20
 Section 2.3.2, “Device Browser Requirements,” on page 20


Linux: /var/opt/novell/teaming


Windows: c:\Program Files\Novell\Teaming
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2.3.1 Supported Mobile Devices


The Novell Vibe mobile interface is supported on the following mobile devices:


 iPhone (native application is available in the iTunes Store)
 Android (native application is available in the Android Marketplace)
 BlackBerry


NOTE: The BlackBerry Curve has issues with JavaScript, so it does not work with the Vibe 
mobile interface. For more information, see “Your BlackBerry Curve Does Not Work with the 
Mobile Interface” in “Troubleshooting” in the Novell Vibe 3.2 User Guide.


 Any other mobile device that provides an HTTP/HTML-based interface


Ensure that your device’s browser meets the requirements that are discussed in Section 2.3.2, “Device 
Browser Requirements,” on page 20.


2.3.2 Device Browser Requirements


To use Vibe from a mobile device, your device’s browser must support: 


 HTML 4
 JavaScript


2.4 Supported Environments
 Section 2.4.1, “File Viewer Support,” on page 20
 Section 2.4.2, “IPV6 Support,” on page 20
 Section 2.4.3, “Clustering Support,” on page 21
 Section 2.4.4, “Xen Virtualization Support,” on page 21
 Section 2.4.5, “VMware Support,” on page 21
 Section 2.4.6, “Single Sign-On Support,” on page 21
 Section 2.4.7, “Linux File System Support,” on page 21


2.4.1 File Viewer Support


In Novell Vibe, file viewing capabilities are provided by Oracle Outside In viewer technology. See 
“Oracle Outside In Technology 8.3 Supported Formats” (http://www.oracle.com/technology/
products/content-management/oit/ds_oitFiles.pdf) for a list of the supported file formats. See “Oracle 
Outside In Technology” (http://www.oracle.com/technologies/embedded/outside-in.html) for 
background information about the Oracle viewer technology included in Vibe.


 The file viewers also support data indexing by the Lucene Index Server.


2.4.2 IPV6 Support


Novell Vibe supports the IPV6 protocol when it is available on the server. If the protocol is available, 
Vibe detects it and supports IPV6 by default, along with IPV4. 
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2.4.3 Clustering Support


You can install Vibe components on multiple servers to provide failover support, as described in 
Part IV, “Multi-Server Configurations and Clustering,” on page 113.


2.4.4 Xen Virtualization Support


You can install Vibe in virtual environments where a software program enables one physical server to 
function as if it were two or more physical servers. Xen virtualization technology in Novell Open 
Enterprise Server (Linux version) and SUSE Linux Enterprise Server is supported. For more 
information, see:


 Open Enterprise Server 2 Virtualization Documentation Web site (http://www.novell.com/
documentation/oes2/virtualization.html#virtualization)


 SLES Virtualization Technology Documentation Web site (http://www.novell.com/
documentation/vmserver).


2.4.5 VMware Support


Vibe is supported on the following versions of VMware:


 VMware Server (formally GSX Server), an enterprise-class virtual infrastructure for x86-based 
servers


 VMware ESX Server, a data-center-class virtual infrastructure for mission-critical environments
For more information, see the VMWare Web site (http://www.vmware.com).


2.4.6 Single Sign-On Support


Novell Access Manager can be used to provide single sign-on capabilities for your Vibe site. For 
setup instructions, see Section 9.8, “Configuring Single Sign-On with Novell Access Manager,” on 
page 88.


2.4.7 Linux File System Support


For best Vibe performance on Linux, the ext3 file system is recommended. If you are running OES 
Linux and need the feature-rich environment of the NSS file system, Vibe is also supported there. The 
reiser3 file system is also supported.


2.5 Recommended Hardware Configurations
The hardware configuration that you set up for your Novell Vibe site should be based on the number 
of active users that the Vibe site must support. Server machines can be physical or virtual.
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The Novell Vibe Installation program provides two installation types: Basic and Advanced. When 
you perform a Basic installation, the result is a fully functional Vibe site with all required options 
configured and with typical defaults in use for optional settings. 


If you are new to Vibe, the easiest way to get started is to perform a Basic installation first, with all 
Vibe components installed on the same server, then add advanced configuration options to your Vibe 
site after the Basic installation has been successfully tested. However, experienced Vibe 
administrators can choose to perform an Advanced installation immediately, which includes all 
installation and configuration options, as described in Part III, “Advanced Installation and 
Reconfiguration,” on page 79.


You can perform a Basic installation to set up a single-server configuration, as described in Chapter 3, 
“Planning a Basic Vibe Installation,” on page 25 and Chapter 4, “Installing and Setting Up a Basic 
Vibe Site,” on page 49.


You can perform a Basic installation to set up a multiple-server configuration, but the remote 
database must be created manually and in advance of performing the installation, as described in 
Part IV, “Multi-Server Configurations and Clustering,” on page 113.


Active 
Users Vibe Components CPU Memory


Java 
Heap


10 1 dedicated Vibe server with:


 Tomcat


 Lucene


 SQL


x86 2 GB 1 GB


50 1 dedicated Vibe server with:


 Tomcat


 Lucene


 SQL


x64 
dual core


4 GB 2 GB


100 Multiple Vibe servers:


 1 dedicated Tomcat server


 1 dedicated Lucene server


 1 dedicated SQL server


x64 
dual core


4 GB 2 GB


500 Multiple Vibe servers:


 3 dedicated Tomcat servers with an L4 load balancer


 2 dedicated Lucene servers


 2 dedicated SQL servers


x64 
quad core


8 GB 6 GB


1000 Multiple Vibe servers:


 5 dedicated Tomcat servers with an L4 load balancer


 4 dedicated Lucene servers


 2 dedicated SQL servers


x64 
quad core


8 GB 6 GB
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II IIBasic Installation


 Chapter 3, “Planning a Basic Vibe Installation,” on page 25
 Chapter 4, “Installing and Setting Up a Basic Vibe Site,” on page 49
 Chapter 5, “Adding Users to Your Vibe Site,” on page 63
 Chapter 6, “Updating Your Vibe License,” on page 69
 Chapter 7, “Setting Up Vibe,” on page 71
 Chapter 8, “Basic Vibe Installation Summary Sheet,” on page 73
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3 3Planning a Basic Vibe Installation


The installation program for Novell Vibe helps you install the Vibe software and file repository to the 
appropriate locations.


 Section 3.1, “What Is a Basic Vibe Installation?,” on page 25
 Section 3.2, “Selecting the Operating Environment for Your Vibe Server,” on page 26
 Section 3.3, “Selecting a Java Development Kit,” on page 29
 Section 3.4, “Gathering Network Information for Your Vibe Site,” on page 29
 Section 3.5, “Planning the WebDAV Authentication Method,” on page 32
 Section 3.6, “Planning the Vibe Database,” on page 34
 Section 3.7, “Gathering Outbound E-Mail Information,” on page 37
 Section 3.8, “Enabling Inbound E-Mail,” on page 39
 Section 3.9, “Planning Site Security,” on page 41
 Section 3.10, “Gathering Directory Services Information,” on page 41
 Section 3.11, “Accommodating Multiple Languages,” on page 48


3.1 What Is a Basic Vibe Installation?
The Novell Vibe installation program provides two installation types: Basic and Advanced. When 
you perform a Basic installation, the result is a fully functional Vibe site with all required options 
configured and with typical defaults in use for optional settings. 


If you are new to Vibe, the easiest way to get started is to perform a Basic installation first, with all 
Vibe components installed on the same server, then add advanced configuration options to your Vibe 
site after the Basic installation has been successfully tested. However, experienced Vibe 
administrators can choose to perform an Advanced installation immediately, which includes all 
installation and configuration options, as described in Part III, “Advanced Installation and 
Reconfiguration,” on page 79.


IMPORTANT: The following Vibe configurations require that you perform an Advanced installation 
as your initial installation of the Vibe software:


 Setting up the Vibe file repository so that some types of files are located outside the Vibe file 
repository root directory. See Section 9.2, “Distributing Different Data Types to Different 
Locations,” on page 82 for Advanced installation instructions. You cannot move subdirectories 
within the Vibe file repository after they have been created.


 Installing the Vibe software on multiple servers to create a clustered environment. See 
Chapter 15, “Running Vibe on Multiple Servers,” on page 125 for Advanced installation 
instructions. The option to enable a clustered environment is available only during an Advanced 
installation.
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If you want to implement an Advanced installation option, you should perform a Basic installation 
first, in a test environment, before performing the Advanced installation to set up your permanent 
Vibe site.


This section helps you make informed decisions about the required options for a Basic installation:


 Server platform (Linux or Windows)
 Server architecture (32-bit or 64-bit)
 Physical server memory requirements
 File locations (Vibe software and data)
 Java Development Kit (JDK) version (Sun or IBM)
 Database type (MySQL, Microsoft SQL Server, or Oracle)
 Database creation (during installation or before installation)
 Database authentication (username and password)
 Network information (Vibe server hostname or fully qualified domain name, and ports)
 Outbound e-mail configuration (SMTP vs. SMTPS, hostname, SMTP port, time zone, 


authentication)
 Inbound e-mail configuration (SMTP address, SMTP port, and TLS support)
 User and group for running the Vibe software (Linux only)


Before performing a Basic installation, make sure all system requirements are met, as listed in 
Chapter 2, “Vibe System Requirements,” on page 17.


As you proceed with planning, you can use the Basic Vibe Installation Summary Sheet to record your 
decisions about the options you want to use.


3.2 Selecting the Operating Environment for Your Vibe Server
 Section 3.2.1, “Vibe Server Platform,” on page 26
 Section 3.2.2, “Vibe Server Architecture,” on page 26
 Section 3.2.3, “Vibe Server Memory,” on page 27
 Section 3.2.4, “Vibe Installation Locations,” on page 28
 Section 3.2.5, “TrueType Font Location (Linux Only),” on page 29


3.2.1 Vibe Server Platform


Novell Vibe can run on the versions of Linux and Windows listed in Section 2.1, “Vibe Server 
Requirements,” on page 17.


3.2.2 Vibe Server Architecture


Vibe can run on 32-bit or 64-bit processors. A 64-bit processor is recommended for a large Vibe site 
where the processor load is heavy and data storage requires a large amount of disk space.


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Vibe Server Platform, mark your operating system of choice.
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3.2.3 Vibe Server Memory


If a 32-bit processor is sufficient for your Vibe server, the server needs at least 3 GB of memory. If you 
plan to use a 64-bit processor in your Vibe server, the server needs more.


Vibe server memory usage is significantly affected by some factors and less affected by others:


 Number of users logged in: No significant effect.
 Number of concurrent active sessions: No significant effect.
 Database server caches: Significant memory usage. 


When you follow the instructions for a Basic installation, the database is located on the same 
server as the Vibe software. After you have successfully tested your Basic installation, you can 
reconfigure Vibe to have its database on a remote server, so that the database uses separate 
memory resources, as described in Chapter 13, “Creating the Vibe Database on a Remote 
Server,” on page 115.


 Vibe internal data caches: Significant memory usage. 
When you follow the instructions for a Basic installation, the Vibe internal data caches are 
subdirectories of the teamingdata directory, described in Section 3.2.4, “Vibe Installation 
Locations,” on page 28. The Vibe internal data caches are separate from any caching or memory 
usage by the database server itself.


 Lucene index cache: Significant memory usage. 
The Lucene Index Server is a high-performance Java search engine. Large file repositories 
(particularly with large files or a large number of files) can create a very large data index. When 
you perform a Basic installation, the Lucene index is created on the same server where the Vibe 
software is installed. After you have successfully tested your Basic installation, you can 
reconfigure Vibe to have its Lucene index on a remote server, so that it uses separate memory 
resources, as described in “Installing the Lucene Index Server on a Remote Server” on page 121.


When you perform a Basic installation, the default amount of memory allocated to the Java Virtual 
Machine (JVM) where the Vibe software runs is 1 GB, which is adequate for a medium-sized Vibe site 
running on a 32-bit server. This memory allocation, called the Java “heap size,” does not include 
memory used by your database server or by the Lucene Index Server when these programs are 
running on the same server as the Vibe software.


A general rule is that no more than 75% of the available physical memory should be allocated to the 
JVM. Memory not allocated to the JVM must be sufficient to support the operating system, the 
database server, and the Lucene Index Server if they are also running on the Vibe server, and any 
other processes running on the Vibe server.


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Processor Architecture, mark the processor capacity required for the size of Vibe site that you 
want to set up.


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Memory Requirements, specify the amount of physical memory you plan to have for your Vibe 
server.
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IMPORTANT: A JVM on a 32-bit server should not be configured to take more than 1.5 G of memory. 
However, large numbers of users and documents often need memory settings higher than 2 GB to 
provide adequate performance. This type of Vibe system should be set up on 64-bit hardware.


Although it is possible to run Vibe with less than 1 GB of memory for the JVM, this applies only to 
very small test configurations, and is not suitable for production systems. In a test configuration, 512 
MB is the minimum amount of memory required to produce a functioning Vibe installation.


3.2.4 Vibe Installation Locations


The default file location for the Vibe software varies by platform:


Included under the main Vibe software directory are subdirectories for Tomcat and file viewer 
software.


The default file location for the Vibe file repository also varies by platform:


IMPORTANT: On Windows, the Vibe installation program displays the Windows pathname with 
forward slashes (/) rather than the traditional backslashes (\). This syntax is necessary in the 
installation program.


The Vibe file repository holds all files that are imported into Vibe, information related to the 
imported files, such as thumbnails and HTML renderings, and the search engine index.


A Basic installation allows you to change the root directory for the Vibe software and the Vibe file 
repository. 


IMPORTANT: If you want to organize the Vibe file repository so that some file types are not under 
the Vibe file repository root directory, you must perform an Advanced installation as your initial Vibe 
installation. You cannot move directories out of the Vibe file repository root directory after the initial 
installation has been performed. To perform an Advanced installation in order to organize the Vibe 
file repository to meet your needs, complete the planning steps for a Basic installation and complete 
the Basic Vibe Installation Summary Sheet, then follow the additional instructions in Section 9.2, 
“Distributing Different Data Types to Different Locations,” on page 82.


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Java JDK Location, specify the amount of memory to allocate to the JVM where Vibe runs.


Linux: /opt/novell/teaming


Windows: c:\Program Files\Novell\Teaming


Linux: /var/opt/novell/teaming


Windows: c:\Novell\Teaming


BASIC VIBE INSTALLATION SUMMARY SHEET


Under File Locations, specify the directories where you want to install the Vibe software and data if you 
prefer not to use the default locations.
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3.2.5 TrueType Font Location (Linux Only)


The Oracle Outside In viewer technology used by Novell Vibe to render various file formats into 
HTML for viewing requires access to TrueType fonts. Typical locations for these fonts are:


/usr/X11R6/lib/X11/fonts/truetype
/usr/share/fonts/truetype


If the TrueType font location is not correct, thumbnails are not displayed correctly on the Vibe site.


3.3 Selecting a Java Development Kit
As listed in Section 2.1, “Vibe Server Requirements,” on page 17, you need to install a Java 
Development Kit (JDK) before you install Novell Vibe. You can use either the Sun JDK or the IBM 
JDK for the platform where you are installing Vibe (Linux or Windows).


If you want to use an SSL connection between your Novell Vibe site and a WebDAV server, and if the 
WebDAV server has a self-signed certificate rather than a certificate provided by a certificate 
authority, you must use the Sun JDK. The existing Vibe functionality for handling self-signed 
certificates is not compatible with the way the IBM JDK handles self-signed certificates.


You must install the JDK on the Vibe server before you install the Vibe software. If you are not 
familiar with installing a JDK, see “Java Development Kit” in Appendix A, “Vibe System 
Requirements Assistance,” on page 191 for instructions.


The Vibe Installation program uses this path as if you had set the JAVA_HOME environment 
variable. The path is stored for future reference in the installer.xml file so that you need to specify 
the path to the JDK only once.


3.4 Gathering Network Information for Your Vibe Site
When you perform a Basic installation, the Novell Vibe installation program needs hostname and 
HTTP port information about the server where you are installing Vibe.


 Section 3.4.1, “Host Identification,” on page 30
 Section 3.4.2, “Port Numbers,” on page 30


BASIC VIBE INSTALLATION SUMMARY SHEET


Under TrueType Font, specify the directory that contains the TrueType font location.


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Java Development Kit, mark the JDK that you want to use with Vibe.


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Java Development Kit, specify the directory where you have installed the JDK.
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3.4.1 Host Identification


When you install Vibe, the Vibe installation program needs to know the name of the server where 
you are installing the Vibe software. The default is localhost. Do not use the default.


For internal use, you can use the DNS hostname of the Vibe server. However, if you want your Vibe 
site to be accessible from the Internet, you must specify the fully qualified domain name for the Vibe 
server in order to allow external access.


3.4.2 Port Numbers


When you install Vibe, Tomcat is installed along with the Vibe software. Vibe uses Tomcat as a 
standalone Web server for delivering data to Vibe users in their Web browsers. For more information 
about Tomcat, see the Apache Tomcat Web site (http://tomcat.apache.org). 


IMPORTANT: If the server where you want to install Vibe already has a Web server running on it, 
shut it down while you install and test Vibe. The instructions for a Basic Vibe installation assume that 
no other Web server is running on the Vibe server. If you want to maintain another Web server on the 
Vibe server, you are responsible for resolving any port conflicts that might arise.


On the command line, use the netstat command to see what ports are currently in use on the server 
where you plan to install Vibe:


Make sure that the port numbers that you specify during Vibe installation do not conflict with ports 
that are already in use on the server.


 “HTTP/HTTPS Ports” on page 30
 “HTTP/HTTPS Ports When You Use Novell Access Manager with Vibe” on page 31
 “Shutdown Port” on page 32
 “AJP Port” on page 32


HTTP/HTTPS Ports


By default, standard Web servers such as Apache and Microsoft Internet Information Services (IIS) 
use port 80 for non-secure HTTP (Hypertext Transfer Protocol) connections and port 443 for secure 
HTTPS connections. HTTPS connections use SSL (Secure Sockets Layer) for added security. As a 
result, Web browsers default to port 80 when no port is specified in a non-secure HTTP URL and to 
port 443 when no port is specified in a secure HTTPS URL.


Tomcat defaults to port 8080 for non-secure HTTP connections and to port 8443 for secure HTTPS 
connections, so that it does not conflict with the standard Web server port numbers. If you configure 
Vibe with the Tomcat default port numbers, users must include the appropriate port number when 
providing the Vibe site URL. Typically, users prefer not to do this. 


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Network Information, specify the hostname or fully qualified domain name to use for the Vibe 
server.


Linux: netstat -tan


Windows: netstat -a -n -p tcp
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Unfortunately, the situation is not as simple as just configuring Vibe to use the default port numbers 
of 80 and 443. On Linux, non-root processes are not allowed access to port numbers lower than 1024 
and you are counseled against running Vibe as root in Section 3.9.2, “Linux User ID for Vibe,” on 
page 41. Also on Linux and Windows, the default Tomcat installation expects ports 8080 and 8443.


For a Basic installation, you can use the default port numbers as presented by the Vibe Installation 
program:


HTTP port: 80
Secure HTTP port: 443
Listen port: 8080
Secure listen port: 8443


IMPORTANT: If you are installing Vibe on Novell Open Enterprise Server 2, port 80 is already in use 
by iManager. To have Vibe listen on port 80 (which is the standard port), you need to change 
iManager to listen on a non-standard port, such as 81.


After you install Vibe on Linux, you need to complete the steps in “Setting Up Port Forwarding” on 
page 54 so that users are not required to include the port number in the Vibe URL.


If you want to use secure HTTPS connections for your Vibe site, you must obtain signed certificate 
files as described in “Preparing for Secure HTTP Connections” in “Site Security” in the  Novell Vibe 3.2 
Administration Guide either before or after you install Vibe.


HTTP/HTTPS Ports When You Use Novell Access Manager with Vibe


If you are fronting Vibe with Novell Access Manager, ensure that you have configured the HTTP/
HTTPS ports as described in the following sections, depending on the operating system where Vibe 
is running.


Configuring Vibe in this way configures Novell Access Manager to access Vibe over port 80, which is 
the standard port.


 “Windows Port Configuration” on page 31
 “Linux Port Configuration” on page 32


Windows Port Configuration


Use the following port configuration when Novell Access Manager is fronting your Vibe system on 
Windows:


HTTP Port: 80


Secure HTTP Port: 443


Listen Port: 80


Secure Listen Port: 443


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Network Information, the default port numbers have been provided for you. You need to specify 
different port numbers only if you anticipate port conflicts with other software on the Vibe server. 
Resolving port conflicts is beyond the scope of this Vibe documentation.
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Linux Port Configuration


Use the following port configuration when Novell Access Manager is fronting your Vibe system on 
Linux:


HTTP Port: 80


Secure HTTP Port: 443


Listen Port: 8080


Secure Listen Port: 8443


With this suggested configuration on Linux, you also need to set up port forwarding, as described in 
Section 4.1.6, “Setting Up Port Forwarding,” on page 54.


Shutdown Port


By default, Vibe uses 8005 as its shutdown port. For an explanation of the shutdown port, see Tomcat 
- Shutdown Port (http://www.wellho.net/mouth/837_Tomcat-Shutdown-port.html). 


AJP Port


By default, Vibe uses 8009 as its AJP port. For an explanation of the Apache JServ Protocol port, see 
The AJP Connector (http://tomcat.apache.org/tomcat-6.0-doc/config/ajp.html). 


IMPORTANT: If you are installing Vibe on Novell Open Enterprise Server 2, port 8009 is already in 
use, so you need to select a different port, such as 8010. 


3.5 Planning the WebDAV Authentication Method
 Section 3.5.1, “Understanding WebDAV,” on page 33
 Section 3.5.2, “Choosing the WebDAV Authentication Method,” on page 33


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Network Information, specify the port you want Vibe to use as its shutdown port if the default of 
8005 is already in use on the Vibe server.


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Network Information, specify the port you want Vibe to use as its AJP port if the default of 8009 is 
already in use on the Vibe server.
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3.5.1 Understanding WebDAV


WebDAV is a standard collaborative editing and file management protocol. Novell Vibe relies on the 
WebDAV protocol for two key features:


 Edit-in-Place for using tools such as OpenOffice and Microsoft Office, as described in “Using 
WebDAV to Edit Individual Files” in the Novell Vibe 3.2 Advanced User Guide.


 Mapping Vibe folders as a Web folder on the client computer, which allows access to Vibe files 
from a WebDAV-compliant file navigation tool such as Windows Explorer or Nautilus, as 
described in “Creating a Mapped Drive to the Vibe Folder” in the Novell Vibe 3.2 Advanced User 
Guide.


IMPORTANT: When Vibe users are running Windows 7 as the client operating system, various 
issues can be introduced because of WebDAV limitations in Windows 7. If your Vibe users are using 
the Windows 7 operating system, see “Configuring Vibe to Support WebDAV on Windows 7” in the  
Novell Vibe 3.2 Administration Guide.


3.5.2 Choosing the WebDAV Authentication Method


The WebDAV authentication method determines how user credentials are passed from Vibe to the 
WebDAV server. Vibe 3 and later supports three types of WebDAV authentication methods:


 “Choosing Basic Authentication” on page 33
 “Choosing Digest Authentication” on page 33
 “Choosing Windows Authentication” on page 34


Choosing Basic Authentication


Basic authentication encodes the username and password with the Base64 algorithm. The Base64-
encoded string is unsafe if transmitted over HTTP, and therefore should be combined with SSL/TLC 
(HTTPS). 


Select this type of authentication when you plan to use Novell Access Manager or Internet 
Information Services (IIS) to authenticate users.


For more information about encryption algorithms, see Section 3.6.5, “Database Encryption 
Algorithm,” on page 36.


Choosing Digest Authentication


Digest authentication applies MD5 cryptographic, one-way hashing with usage of nonce values to a 
password before sending it over the network. This option is more safe than Basic Authentication 
when used over HTTP. 


Select this type of authentication when client users are using Windows 7 as their operating system 
and Microsoft Office as their text editor.


For more information about encryption algorithms, see Section 3.6.5, “Database Encryption 
Algorithm,” on page 36.

Planning a Basic Vibe Installation 33







Choosing Windows Authentication


Windows Authentication provides Windows users with a single sign-on experience, enabling users 
to automatically authenticate to Vibe after they are logged in to their individual workstations. 
Internet Information Services (IIS) provides this capability.


To configure Vibe to use Windows Authentication as the WebDAV authentication method, select basic 
in the WebDAV authentication method field during the Vibe installation program, then configure 
Windows Authentication as described in Section 9.9, “Configuring Single Sign-On with Internet 
Information Services for Windows,” on page 89.


3.6 Planning the Vibe Database
Novell Vibe database disk space requirements are relatively modest. Files that are imported into Vibe 
are saved in the Vibe file repository, as described in Section 3.2.4, “Vibe Installation Locations,” on 
page 28. 


The Vibe database is primarily used for storing the following information:


 Structural information about workspaces, folders, and entries (for example, their location in the 
workspace tree)


 Identification information about workspaces, folders, and entries (for example, titles, 
descriptions, dates of creation/modification, and users associated with creation/modification)


 User profile information (for example, full name, phone number, and e-mail address)


You or your database administrator must make the following decisions about the Vibe database:


 Section 3.6.1, “Database Type,” on page 34
 Section 3.6.2, “Database Setup Method,” on page 35
 Section 3.6.3, “Database Location,” on page 35
 Section 3.6.4, “Database Credentials,” on page 36
 Section 3.6.5, “Database Encryption Algorithm,” on page 36


3.6.1 Database Type


By default, Vibe uses open source MySQL as its database on Linux and on Windows. On Linux, Vibe 
also supports Oracle. On Windows, Vibe also supports Microsoft SQL Server and Oracle.


Make sure that a supported version of the database server, as listed in Section 2.1, “Vibe Server 
Requirements,” on page 17, is installed and running before you install Vibe.


BASIC VIBE INSTALLATION SUMMARY SHEET


Under WebDAV authentication method, specify the authentication method you want Vibe to use when 
authenticating to WebDAV.


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Database Type, mark the type of database that you want to use with Vibe.
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3.6.2 Database Setup Method


If you plan to use a MySQL database, the Vibe installation program can automatically set up the 
database for you. This is the easiest way to get started.


If you plan to use an Oracle database or a Microsoft SQL database, you must have your database 
administrator set up the database for you. Instructions for your database administrator are provided 
in Section 13.4, “Creating an Oracle Database,” on page 118 and Section 13.3, “Creating a Microsoft 
SQL Database,” on page 117.


3.6.3 Database Location


When you have the Vibe Installation program create the database for you, the database is created on 
the same server where you install the Vibe software. This is the preferable location for your Basic 
installation. The default database name is sitescape, a reference to the company that previously 
developed the Vibe software.


You can have your database administrator create a database on a remote server later, after you have 
successfully tested your Basic installation. See Chapter 13, “Creating the Vibe Database on a Remote 
Server,” on page 115.


If you need to have your database administrator create an Oracle or Microsoft SQL database, you 
must decide before installation whether you want the database on the Vibe server or on a remote 
server. See Section 13.4, “Creating an Oracle Database,” on page 118.


Vibe knows where to find its database from the JDBC (Java Database Connectivity) URL that you 
provide during installation. For a database that is local to the Vibe software, the default JDBC URL 
that provides localhost as the hostname of the Vibe server is appropriate. If the database is on a 
remote server, the JDBC URL must provide the hostname of the remote database server. 


The JDBC URL also includes the port number on which Vibe can communicate with the database 
server. The default port number depends on the database server you are using:


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Database Setup Method, mark whether you want the Vibe Installation program to automatically 
set up a MySQL database, or whether you need your database administrator to manually set up an 
Oracle database or Microsoft SQL database before you install Vibe.


Database 
Server


Default Linux Locatio
n Default Windows Location


MySQL /var/lib/mysql c:\Documents and Settings\All Users\
Application Data\MySQL\
MySQL Server version\Data


Microsoft SQL N/A N/A


Oracle N/A N/A
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Use this port number unless it is already in use by another process on the database server.


3.6.4 Database Credentials


When you have the Vibe Installation program create the database for you, it defaults to the following 
administrator usernames for the database server:


For an Oracle database and Microsoft SQL database, your database administrator establishes the 
administrator username and password for the database server.


Check with your database administrator to see if the default administrator username is still in use for 
your database server, and obtain the administrator password for the database server before you run 
the Vibe Installation program.


3.6.5 Database Encryption Algorithm


Different encryption algorithms provide differing encryption strength. The supported algorithms for 
encrypting the Vibe database password are listed below, in order from least strength to most 
strength.


 MD5
 SHA


Database Server Default Port Number


MySQL 3306


Microsoft SQL 1433


Oracle 1521


BASIC VIBE INSTALLATION SUMMARY SHEET


Under JDBC URL, specify the appropriate hostname for the database server (localhost or the 
hostname of a remote server) and the port number it will use to communicate with Vibe.


Database Default Administrative Username


MySQL root


IMPORTANT: The MySQL root username is not the same as the Linux root user on a 
Linux server.


Microsoft SQL (no default) For a Microsoft SQL database, your database administrator establishes the 
administrator username and password for the database server.


Oracle (no default) For an Oracle database, your database administrator establishes the 
administrator username and password for the database server.


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Database Credentials, specify the administrator username and password for the database server 
so that Vibe can access its database.
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This is the default option when you use Basic Authentication for WebDAV authentication, as 
described in Section 3.5, “Planning the WebDAV Authentication Method,” on page 32


 SHA-256
 PBEWithMD5AndDES 


This is the only available option when you select Digest Authentication for WebDAV 
authentication, as described in Section 3.5, “Planning the WebDAV Authentication Method,” on 
page 32


3.7 Gathering Outbound E-Mail Information
Your Novell Vibe site can be configured to send outbound e-mail through an existing e-mail system. 
E-mail from the Vibe site is useful for the following activities:


 Vibe users can subscribe to e-mail notifications, so that they automatically receive a message 
whenever content of interest changes. For more information, see “Subscribing to a Folder or 
Entry” in “Getting Informed” in the Novell Vibe 3.2 User Guide.


 From the Vibe site, users can send e-mail messages to individual users or to teams. For more 
information, see “Sending E-Mail from within Vibe” in “Connecting With Your Co-Workers” in 
the Novell Vibe 3.2 User Guide.


 If your e-mail client is iCal-enabled, appointments created in a Vibe Calendar folder can be sent 
to your e-mail client for posting in your e-mail client Calendar. For example, if you are using 
GroupWise, see “Accepting or Declining Internet Items” in “Calendar” in the GroupWise 8 
Windows Client User GuideGroupWise 8 Windows Client Help.


In order for your Vibe site to communicate with your e-mail system, you need to gather the following 
information about your e-mail system.


 Section 3.7.1, “Outbound E-Mail Protocol,” on page 37
 Section 3.7.2, “Outbound E-Mail Host,” on page 38
 Section 3.7.3, “Outbound E-Mail Authentication,” on page 38
 Section 3.7.4, “Outbound E-Mail Send Restriction,” on page 39


After installation, outbound e-mail can be disabled and enabled again on the Vibe site, as described 
in “Configuring E-Mail Integration” in “Site Setup” in the  Novell Vibe 3.2 Administration Guide. 
However, you must configure outbound e-mail in the Vibe installation program.


3.7.1 Outbound E-Mail Protocol


E-mail systems communicate by using SMTP (Simple Mail Transfer Protocol). You need to determine 
whether the e-mail system that you want your Vibe site to communicate with is using SMTP or 
SMTPS (secure SMTP).


For GroupWise, you can check how the Internet Agent is configured:


1 In ConsoleOne, browse to and right-click the Internet Agent object, then click Properties.
2 Click GroupWise > Network Address.


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Database Encryption Algorithm, mark the encryption algorithm you want to use for Vibe 
passwords.
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In the SMTP field, if the SSL column displays Disabled, GroupWise is using SMTP. If the SSL 
column displays Enabled, GroupWise is using SMTPS.


3 Click Cancel to close the Network Address page.


If the e-mail system requires SMTPS, see “Securing E-Mail Transfer” in “Site Security” in the  Novell 
Vibe 3.2 Administration Guide.


3.7.2 Outbound E-Mail Host


In order to send messages to your e-mail system, Vibe needs to know the hostname of your SMTP 
mail server.


The default SMTP port of 25 is typically appropriate, unless the SMTP mail server requires port 465 
or 587 for SMTPS connections.


For GroupWise, this is the hostname of a server where the Internet Agent is running. GroupWise 
always uses port 25, even when SSL is enabled.


When the Vibe site sends e-mail notifications for scheduled events, the messages are time-stamped 
according to the time zone you specify here during installation. This setting allows you to use a time 
zone for e-mail notifications that is different from the time zone where the server is located. The time 
zone list is grouped first by continent or region, optionally by country or state, and lastly by city. 
Some common selections for United States time zones are:


3.7.3 Outbound E-Mail Authentication


Many SMTP mail hosts require a valid e-mail address before they establish the SMTP connection. 
Some e-mail systems can construct a valid e-mail address if you specify only a valid username; other 
e-mail systems require that you specify the full e-mail address for successful authentication. You 
should provide a username (e-mail address) to ensure a successful connection. E-mail notifications 
from the Vibe system are sent using this e-mail address in the From field.


Some e-mail systems also require a password. Some do not. If authentication is required, you should 
also provide a password.


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Outbound E-Mail Protocol, mark SMTP or SMTPS to match the e-mail system that you want Vibe 
to communicate with.


Time Zone Continent/City


Pacific Time America/Los Angeles


Mountain Time America/Denver


Central Time America/Chicago


Eastern Time America/New York


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Outbound E-Mail Host, specify the name of the mail host, the SMTP port number it uses, and the 
time zone for the time stamp you want on scheduled event notifications.
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By default, the GroupWise Internet Agent does not require authentication in order to receive 
inbound messages. However, the /forceinboundauth startup switch is available for use in the Internet 
Agent startup file (gwia.cfg) to configure the Internet Agent to refuse SMTP connections where a 
valid e-mail username and password are not provided. The Internet Agent can accept just the 
username or the full e-mail address.


3.7.4 Outbound E-Mail Send Restriction


By default, the Vibe site allows Vibe users to send messages to all Vibe users by using the All Users 
group on the Vibe site. On a very large Vibe site, this generates a very large number of e-mail 
messages. If desired, you can prevent messages from being sent to the All Users group.


3.8 Enabling Inbound E-Mail
You can configure your Novell Vibe site so that users can post comments by e-mailing them to the 
folder where they want to post the comment. In order to receive e-mail postings, folders must be 
properly configured, as described in “Enabling Folders to Receive Entries through E-Mail” in “Using 
Filters on Folders” in the Novell Vibe 3.2 Advanced User Guide. Also, users must know the e-mail 
address of the folder where they want to post their comment.


 Section 3.8.1, “Internal Mail Host for Inbound E-Mail,” on page 39
 Section 3.8.2, “Inbound E-Mail Port Number,” on page 40
 Section 3.8.3, “Inbound E-Mail IP Address,” on page 40
 Section 3.8.4, “Inbound E-Mail Security,” on page 40


After installation, inbound e-mail can be disabled and enabled again on the Vibe site, as described in 
“Disabling/Enabling Inbound E-Mail Postings” in “Site Setup” in the  Novell Vibe 3.2 Administration 
Guide. However, you must configure inbound e-mail in the Vibe installation program.


3.8.1 Internal Mail Host for Inbound E-Mail


Inbound e-mail is disabled by default. When you enable it, the Vibe site starts an internal SMTP mail 
host to receive incoming messages and post them to the folders associated with the e-mail addresses 
to which the messages are addressed. By default, the internal SMTP mail host uses port 2525, so that 
it does not conflict with another mail host that might be running on the Vibe server. 


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Outbound E-Mail Authentication, indicate whether or not authentication is required for the Vibe 
site to communicate with your e-mail system. If it is, specify the username or e-mail address, and if 
necessary, the password for the e-mail account.


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Allow Sending E-Mail to All Users, mark whether or not you want users to be able to send messages to 
the All Users group.


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Inbound E-Mail Configuration, mark whether or not you want users to be able to post to the Vibe site 
from their e-mail clients.
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3.8.2 Inbound E-Mail Port Number


Selecting the port number for the Vibe internal SMTP mail host presents the same issue that needs to 
be dealt with for the HTTP port numbers, as described in “HTTP/HTTPS Ports” on page 30. You 
might want to configure the Vibe internal SMTP mail host to use the standard SMTP port of 25. How 
you handle the issue depends on whether you are installing on Linux or on Windows.


3.8.3 Inbound E-Mail IP Address


If you want to install Vibe on a server where an SMTP mail host is already running, you can do so if 
the server has multiple IP addresses. The existing SMTP mail host can use port 25 on one IP address 
and Vibe can use port 25 on another IP address. During installation, you need to specify an IP 
address only if the server has multiple IP addresses and you want Vibe to bind to a specific IP 
address rather than all of them.


3.8.4 Inbound E-Mail Security


You can choose whether the Vibe internal mail host uses TLS (Transport Layer Security) when it 
communicates with other SMTP mail hosts. In order for TLS to function properly, you must have a 
certificate on the Vibe server, as described in “Securing E-Mail Transfer” in “Site Security” in the  
Novell Vibe 3.2 Administration Guide. When an SMTP mail host queries the Vibe mail host, the Vibe 
mail host communicates its ability or inability to handle TLS. The other SMTP mail host then 
communicates appropriately, taking into account how the Vibe internal mail host is configured. The 
default is to use TLS, because this provides more secure communication between mail hosts.


You can install Vibe with Announce TLS selected, and then set up the certificate afterwards. However, 
if you select Announce TLS, inbound e-mail does not work until the certificate is available on the Vibe 
server.


Linux: Keep the default port number (2525) in the Vibe Installation program, then complete the steps in 
Section 4.1.6, “Setting Up Port Forwarding,” on page 54 so that requests incoming on port 25 are 
forwarded to port 2525. 


Windows: Specify port 25 for incoming e-mail in the Vibe Installation program.


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Inbound E-Mail Configuration, specify the port number for the Vibe internal SMTP host to listen on.


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Inbound E-Mail Configuration, specify the IP address for the Vibe internal SMTP host to listen on, if you 
are installing Vibe on a server with multiple IP addresses and you want Vibe to bind to just one of them.


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Inbound E-Mail Configuration, mark whether or not you want the Vibe server to announce that it can use 
TLS.
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3.9 Planning Site Security
 Section 3.9.1, “Vibe Site Administrator Password,” on page 41
 Section 3.9.2, “Linux User ID for Vibe,” on page 41


3.9.1 Vibe Site Administrator Password


When you first log in to the Novell Vibe site, you use admin as the Vibe administrator username and 
admin as the password. You should immediately change the password to one of your own choosing.


3.9.2 Linux User ID for Vibe


For optimum security, Vibe should not run as the Linux root user. For example, if an intruder 
manages to assume the identity of the Vibe program, the intruder gains all the privileges of the 
commandeered process. If the process is running with root user privileges, the intruder has root 
access to your system. If the process is running as a user with minimal privileges, the intruder has 
only restricted access to your system. Therefore, your system is more secure if the Vibe program does 
not run as root. For example, you might want to create a user named vibeadmin for the Vibe 
program to run as. Linux users require a full name and a password.


In addition to creating a Linux user for the Vibe program to run as, you can also create a Linux group 
for that user to belong to. This enables the Vibe program to create directories and files with consistent 
ownership and permissions. For example, you might want to create a group named vibeadmin for 
the vibeadmin user to belong to. Groups do not require passwords.


As an alternative to creating a custom Linux username and group for Vibe, you can use the existing 
wwwrun username and the www group. This account is typically used to start Web server processes.


IMPORTANT: The non-root Linux username and group must exist before you start the Vibe 
Installation program. Instructions for creating the username and group are provided in Section 4.1.1, 
“Performing Pre-Installation Tasks on Linux,” on page 49.


3.10 Gathering Directory Services Information
Unless you are planning a very small Novell Vibe site, the most efficient way to create Vibe users is to 
synchronize initial user information from your network directory service (Novell eDirectory, 
Microsoft Active Directory, or other LDAP directory service) after you have installed the Vibe 
software. Over time, you can continue to synchronize user information from the LDAP directory to 
your Vibe site.


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Vibe Administrator Credentials, specify the password that you want to use whenever you log in as 
the Vibe site administrator.


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Linux Username and Group, specify the non-root Linux username and group name to use for 
running the Vibe program. If you are creating a new Linux user, specify its full name and password.
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IMPORTANT: The following limitations apply when synchronizing user information to Vibe from 
an LDAP directory service:


 Vibe performs one-way synchronization from the LDAP directory to your Vibe site. If you 
change user information on the Vibe site, the changes are not synchronized back to your LDAP 
directory.


 Vibe does not support multi-value attributes. If your LDAP directory contains multi-value 
attributes, Vibe recognizes only the first attribute. For example, if your LDAP directory contains 
multiple e-mail addresses for a given user, only the first e-mail address is synchronized to Vibe.


 Section 3.10.1, “LDAP Directory Service,” on page 42
 Section 3.10.2, “LDAP Connections,” on page 42
 Section 3.10.3, “LDAP Synchronization Options,” on page 45


3.10.1 LDAP Directory Service


You can synchronize initial Vibe user information from any LDAP directory. This guide provides 
instructions for synchronizing user information from eDirectory and Active Directory. If you are 
using another LDAP directory, use the instructions as guidelines for the tasks you need to perform.


3.10.2 LDAP Connections


You can configure one or more LDAP connections. Each connection requires the following 
configuration information:


 “LDAP Server” on page 42
 “LDAP Attribute to Identify a User or Group” on page 43
 “LDAP Attribute for Vibe Name” on page 43
 “User and Group Object Locations” on page 44


LDAP Server


In order to synchronize initial user information, Vibe needs to access an LDAP server where your 
directory service is running. You need to provide the hostname of the server, using a URL with the 
following format:


ldap://hostname


If the LDAP server requires a secure SSL connection, use the following format:


ldaps://hostname


If the LDAP server is configured with a default port number (389 for non-secure connections or 636 
for secure SSL connections), you do not need to include the port number in the URL. If the LDAP 
server uses a different port number, use the following format for the LDAP URL:


ldap://hostname:port_number
ldaps://hostname:port_number


BASIC VIBE INSTALLATION SUMMARY SHEET


Under LDAP Directory Service, mark the LDAP directory service from which you want to synchronize 
Vibe user information.
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In addition, Vibe needs the username and password of a user on the LDAP server who has sufficient 
rights to access the user information stored there. You need to provide the username, along with its 
context in your LDAP directory tree, in the format expected by your directory service.


If the LDAP server requires a secure SSL connection, additional setup is required. You must complete 
the steps in “Securing LDAP Synchronization” in “Site Security” in the  Novell Vibe 3.2 Administration 
Guide to import the root certificate for your LDAP directory into the Java keystore on the Vibe server 
before you configure Vibe for LDAP synchronization.


LDAP Attribute to Identify a User or Group


The LDAP attribute that uniquely identifies a user or group helps facilitate renaming and moving 
Vibe users and groups in the LDAP directory. If this attribute is not set, and you rename or move a 
user in the LDAP directory, Vibe assumes that the new name (or the new location of the same name) 
represents a new user, not a modified user, and creates a new Vibe user. 


For example, suppose you have a Vibe user with a given name of William Jones. If William changes 
his name to Bill, and you make that change in the LDAP directory, Vibe creates a new user named Bill 
Jones. 


To ensure that Vibe modifies the existing user instead of creating a new user when the user is 
renamed or moved in the LDAP directory, map each user to a binary attribute, such as the GUID or 
objectGUID attribute in the LDAP directory. This attribute always has a unique value that does not 
change when you rename or move a user in the LDAP directory. If you want to map users to a 
different attribute, you must ensure that the attribute that you use is a binary attribute. For example, 
the cn attribute cannot be used because it is not a binary attribute.


LDAP Attribute for Vibe Name


LDAP directories differ in the LDAP attribute used to identify a User object. eDirectory and Active 
Directory both use the cn (common name) attribute. Other LDAP directories might use the uid 
(unique ID) attribute. Vibe needs to know which attribute to look for in order to find User objects.


Directory Service Format for the Username


eDirectory cn=username,ou=organizational_unit,o=organization


Active Directory cn=username,ou=organizational_unit,dc=domain_component


BASIC VIBE INSTALLATION SUMMARY SHEET


Under LDAP Server URL, specify the LDAP URL of the server, a fully qualified username with sufficient 
rights to read the user information, and the password for that user.


BASIC VIBE INSTALLATION SUMMARY SHEET


Under LDAP that uniquely identifies a user or group, mark GUID or objectGUID, depending on whether 
your LDAP directory is eDirectory or Active Directory.
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Vibe calls the User object attribute screenName, so when you configure LDAP synchronization, you 
map screenName to either cn or uid.


As needed, other LDAP attributes can be used for logging in to the Vibe site, as long as the attribute is 
unique for each User object. For example, the mail LDAP attribute on User objects could be used to 
enable Vibe users to log in to the Vibe site by using their e-mail addresses. 


NOTE: Because the login name becomes part of the user’s workspace URL, the at sign (@) in the e-
mail address is replaced with an underscore (_) in the workspace URL because @ is not a valid 
character in a URL. 


User and Group Object Locations


Vibe can find and synchronize initial user information from User objects located in one or more 
containers in the LDAP directory tree. A container under which User objects are located is called a 
base DN (distinguished name). The format you use to specify a base DN depends on your directory 
service.


To identify potential Vibe users, Vibe by default filters on the following LDAP directory object 
attributes:


 Person


 orgPerson


 inetOrgPerson


If you want to create Vibe groups based on information in your LDAP directory, Vibe filters on the 
following LDAP directory object attributes:


 group


 groupOfNames


 groupOfUniqueNames


You can add attributes to the user or group filter list if necessary. You can use the following operators 
in the filter:


 | OR (the default)
 & AND
 ! NOT


You can choose whether you want Vibe to search for users (and optionally, groups) in containers 
underneath the base DN (that is, in subtrees).


BASIC VIBE INSTALLATION SUMMARY SHEET


Under LDAP attribute used for Vibe name, mark cn or uid, based on the convention used by your LDAP 
directory service for User objects. Ensure that users have a value for the attribute that you mark.


Directory Service Format for the User Container


eDirectory ou=organizational_unit,o=organization


Active Directory ou=organizational_unit,dc=domain_component
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You might find it convenient to create a group that consists of all the users that you want to set up in 
Vibe, regardless of where they are located in your LDAP directory. After you create the group, you 
can use the following filter to search for User objects that have the specified group membership 
attribute:


(groupMembership=cn=group_name,ou=organizational_unit,o=organization)


IMPORTANT: Be sure to include the parentheses in your filter.


3.10.3 LDAP Synchronization Options


The following synchronization options apply to all LDAP configurations within the same Vibe zone:


 “Synchronization Schedule” on page 45
 “User Synchronization Options” on page 46
 “Group Synchronization Options” on page 47


NOTE: Because the synchronization options apply to all LDAP configurations within the same zone, 
you cannot have customized synchronization settings for each LDAP configuration. However, the 
Novell Vibe site can have multiple zones. For more information about zones, see “Setting Up Zones 
(Virtual Vibe Sites)” in “Site Setup” in the  Novell Vibe 3.2 Administration Guide. 


Synchronization Schedule


When you enable LDAP synchronization, you can set up a schedule for when it is convenient for 
synchronization to occur. In planning the schedule, take into account how often your LDAP directory 
user (and, optionally, group) information changes and the server resources required to perform the 
synchronization for the number of users (and, optionally, groups) that you have.


You can choose to have LDAP synchronization performed every day, or you can select specific days 
of the week when you want it performed (for example, on Monday, Wednesday, and Friday). You can 
choose to have it performed once a day at a specified time (for example, at 2:00 a.m.), or you can set a 
time interval, so that it is performed multiple times each day (for example, every four hours). The 
smallest time interval you can set is .25 hours (every 15 minutes).


BASIC VIBE INSTALLATION SUMMARY SHEET


Under LDAP User Context, specify a base DN, along with object attributes if any, and mark whether you 
want subtrees searched for Vibe users.


Under LDAP Group Context, specify a base DN, along with object attributes if any, and mark whether you 
want subtrees searched for Vibe groups.


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Synchronization Schedule, record the schedule for when you want LDAP synchronization to take 
place.
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User Synchronization Options


The following options are available for enabling and configuring user synchronization from your 
LDAP directory to your Vibe site:


 Synchronize User Profiles: Select this option to synchronize user information whenever the 
LDAP directory information changes after initial Vibe site setup. The attributes that are 
synchronized are the attributes that are found in the map box in the Users section on the 
Configure LDAP Synchronization page.


By default, Vibe synchronizes the following attributes from the LDAP directory:
 First name
 Last name
 Phone number
 E-mail address
 Description


For information about how to add additional attributes to be automatically synchronized, see 
“Synchronizing Additional LDAP Attributes” in the  Novell Vibe 3.2 Administration Guide.


 Register LDAP User Profiles Automatically: Select this option to automatically add LDAP 
users to the Vibe site. However, workspaces are not created until users log in to the Vibe site for 
the first time.


 Delete Users That Are Not in LDAP: Select this option to delete users that exist on the Vibe site 
but do not exist in your LDAP directory. If this option is not selected and you delete a user from 
your LDAP directory, the user is automatically disabled in Vibe. For more information about 
disabled users in Vibe, see “Disabling Vibe User Accounts” in the  Novell Vibe 3.2 Administration 
Guide.
Use this option under the following conditions:
 You have deleted users from your LDAP directory and you want the LDAP synchronization 


process to delete them from Vibe as well.
 In addition to the users synchronized from LDAP, you create some Vibe users manually, as 


described in Section 5.2, “Creating a User,” on page 65, and you want the LDAP 
synchronization process to delete the manually created users.


 When Deleting Users, Delete Associated User Workspaces and Content: Select this option to 
remove obsolete information along with the user accounts.
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 Time Zone for New Users Select this option to set the time zone for user accounts that are 
synchronized from the LDAP directory into your Vibe site. The time zone list is grouped first by 
continent or region, optionally by country or state, and lastly by city. Some common selections 
for United States time zones are:


 Locale for New Users: Select this option to set the locale for user accounts that are synchronized 
from the LDAP directory into your Vibe site. The locale list is sorted alphabetically by language.


Group Synchronization Options


The following options are available for enabling and configuring user and group synchronization 
from your LDAP directory to your Vibe site:


 Synchronize Group Profiles: Select this option to synchronize group information, such as the 
group description, to the Vibe site whenever this information changes in LDAP.


 Register LDAP Group Profiles Automatically: Select this option to automatically add LDAP 
groups to the Vibe site.


 Synchronize Group Membership: Select this option so that the Vibe group includes the same 
users (and possibly groups) as the group in your LDAP directory. If you do not select this option, 
and you make changes to group membership in the LDAP directory, the changes are not 
reflected on your Vibe site. 


 Delete Local Groups That Are Not in LDAP: Select this option to delete groups that exist on 
the Vibe site but do not exist in your LDAP directory. Use this option under the following 
conditions:
 You have deleted groups from your LDAP directory and you want the LDAP 


synchronization process to delete them from Vibe as well.
 In addition to the groups synchronized from LDAP, you create some Vibe groups manually, 


as described in “Creating Groups of Users” in “Site Setup” in the  Novell Vibe 3.2 
Administration Guide, and you want the LDAP synchronization process to delete the 
manually created groups.


Time Zone Continent/City


Pacific Time America/Los Angeles


Mountain Time America/Denver


Central Time America/Chicago


Eastern Time America/New York


BASIC VIBE INSTALLATION SUMMARY SHEET


Under LDAP User Options, mark the synchronization options you want to use.


BASIC VIBE INSTALLATION SUMMARY SHEET


Under LDAP Group Options, mark the synchronization options you want to use.
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3.11 Accommodating Multiple Languages
The Novell Vibe installation program runs in English only. When you install the Vibe software, you 
can choose to have the primary language of the Vibe site to be any of the following languages:


 Chinese-Simplified
 Chinese Traditional
 Danish
 Dutch
 English
 French
 German
 Hungarian
 Italian
 Japanese
 Polish
 Portuguese
 Russian
 Spanish
 Swedish


Some languages have an additional distinction by locale (the country where the language is spoken).


The language you select during installation establishes the language of the global text that displays in 
locations where all Vibe users see it, such as in the Workspace tree when you click the Workspace tree 
icon :


The language you select also establishes the default interface language and locale for creating new 
workspaces.


Additional language customization can be done after installation, as described in “Managing a 
Multiple-Language Vibe Site” in “Site Setup” in the  Novell Vibe 3.2 Administration Guide.


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Default Locale, mark the default language and specify the default country for your Vibe site.
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4 4Installing and Setting Up a Basic Vibe 
Site


Follow the setup instructions for the platform where you are installing Novell Vibe:


 Section 4.1, “Linux: Installing and Setting Up a Basic Vibe Site,” on page 49
 Section 4.2, “Windows: Installing and Setting Up a Basic Vibe Site,” on page 58


4.1 Linux: Installing and Setting Up a Basic Vibe Site
You should already have reviewed Chapter 3, “Planning a Basic Vibe Installation,” on page 25 and 
filled out the Basic Vibe Installation Summary Sheet. The following sections step you through the 
process of installing and starting Novell Vibe on Linux.


 Section 4.1.1, “Performing Pre-Installation Tasks on Linux,” on page 49
 Section 4.1.2, “Running the Linux Vibe Installation Program,” on page 51
 Section 4.1.3, “Installing Missing Libraries,” on page 54
 Section 4.1.4, “Checking for Available Hot Patches,” on page 54
 Section 4.1.5, “Configuring Vibe to Start Automatically on Reboot,” on page 54
 Section 4.1.6, “Setting Up Port Forwarding,” on page 54
 Section 4.1.7, “Starting Vibe on Linux,” on page 56
 Section 4.1.8, “Checking the Status of the Vibe Server,” on page 57
 Section 4.1.9, “Restarting Vibe,” on page 57
 Section 4.1.10, “Stopping Vibe,” on page 57
 Section 4.1.11, “Uninstalling Vibe,” on page 57


4.1.1 Performing Pre-Installation Tasks on Linux


1 Make sure that the Linux server where you plan to install Vibe meets the system requirements 
listed in Section 2.1, “Vibe Server Requirements,” on page 17.


2 In a terminal window, become root by entering su - and the root password.
3 Set the Linux open file limit to meet the needs of the Vibe software:


3a Open the /etc/security/limits.conf file in an ASCII text editor.
3b Add the following lines to the bottom of the list, following the format of the example lines:


* hard nofile 65535
* soft nofile 4096


3c Save the file, then exit the text editor.
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4 Perform the following conditional tasks if necessary:
 “Stopping and Disabling an Existing Web Server” on page 50
 “Creating a Vibe User and Group” on page 50


Stopping and Disabling an Existing Web Server


If a Web server is currently running on the Vibe server, stop it, and preferably disable it.


For example, to stop the Apache Web server and its associated instance of Tomcat:


1 Enter the following commands to stop Apache and Tomcat:


/etc/init.d/tomcat5 stop
/etc/init.d/apache2 stop


2 Enter the following commands to make sure that Apache and Tomcat do not start again when 
you reboot the server:


chkconfig --del apache2
chkconfig --del tomcat5


Creating a Vibe User and Group


If the user and group that you want to use for Vibe, as described in Section 3.9.2, “Linux User ID for 
Vibe,” on page 41 do not exist yet, create them. It is easier if you create the group first.


1 Create the Linux group that you want to own the Vibe software and data store directories:
1a In YaST, click Security and Users > User and Group Management to display the User and Group 


Administration page.
1b Click Groups, then click Add.
1c Specify the group name, then click Accept or OK.


The group does not need a password.
2 Create the Linux user that you want Vibe to run as:


2a Click Users, then click Add.
2b On the User Data tab, specify the user’s full name, username, and password, then select 


Disable User Login.
Like any Linux system user, the Vibe Linux user does not need to manually log in. The Vibe 
Linux user does not need a password, either, but YaST requires you to provide one.


2c Click the Details tab.
2d In the Login Shell drop-down list, select /bin/false, because this user does not need to 


manually log in.
2e In the Default Group drop-down list, select the Linux group that you created in Step 1.
2f In the Groups list, select the Linux group that you created in Step 1.


2g Click Accept or OK.
3 Exit YaST.
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4.1.2 Running the Linux Vibe Installation Program


When you run the Vibe installation program for the first time, you typically want to use the GUI 
interface. However, if you are installing Vibe on a server where the X Window System is not 
available, a text-based installation program is also available. After you are familiar with the Vibe 
installation process, you can use a silent installation to automate the process.


 “Using the GUI Installation Program” on page 51
 “Using the Text-Based Installation Program” on page 52
 “Performing a Silent Installation” on page 53


Using the GUI Installation Program


1 In a terminal window, enter su - to become the root user, then enter the root password.
You need root permissions in order to install the Vibe software, but you should not run the Vibe 
software as root.


2 Change to the directory where you downloaded and extracted the Vibe software.
3 Make sure that you have a license-key.xml file in the same directory with the Vibe installation 


program.
more license-key.xml


The Vibe installation program does not start without a license file in the same directory. If you 
have not already, rename the license file to be called license-key.xml.
For more information about licensing, see Chapter 6, “Updating Your Vibe License,” on page 69.


4 Enter the following command to start the Vibe installation program:


./installer-teaming.linux


5 Accept the License Agreement, then click Next.


6 Click Next to accept the default of New installation.


7 Click Next to accept the default of Basic.
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8 Use the information that you have gathered on the Basic Vibe Installation Summary Sheet to 
provide the information that the Vibe installation program prompts you for:


Installation Locations
Location of TrueType Fonts for Stellent Converters
Default Locale for Novell Vibe
User ID for Novell Vibe
Network Information
WebDAV Authentication Method
Database Selection


Database Type
JDBC URL
Credentials
Setup
Encryption Algorithm


Java JDK Location
Outbound E-Mail Configuration


Protocol
Host, Port, and Time Zone
Username, Password, and Authentication
Allow Sending E-Mail to All Users


Inbound E-Mail Configuration
The installation program stores the information it gathers in the installer.xml file in the same 
directory where you started the installation program.


9 After you have provided all the requested information, click Install to begin the Vibe installation.
10 When the installation is completed, click Finish to exit the Vibe installation program.


Information about the installation process is written to the installer.log file in the same 
directory where you ran the Installation program. If a problem arises during the installation, the 
installer.log file provides information that can help you resolve the problem.


11 Continue with Section 4.1.5, “Configuring Vibe to Start Automatically on Reboot,” on page 54.


Using the Text-Based Installation Program


If you try to start the GUI Vibe installation program in an environment where the X Windows System 
is not running, the text-based Vibe Installation program starts. 
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If you want to use the text-based installation program in an environment where the GUI starts by 
default, use the following command in the directory where the installation program is located:


./installer-teaming.linux --text


IMPORTANT: The text-based Vibe installation program must be run in the same directory where the 
Vibe license file is located. If the license file is not in the same directory, the text-based installation 
program cannot find it.


The text-based installation program gathers the same configuration information as the GUI 
installation program does. This information is stored in the installer.xml file in the directory 
where you run the installation program.


The installation program does not write the information it gathers into the installer.xml file until 
you exit the installation program, and you cannot go back when you use the text-based installation 
program. Therefore, when you use the text-based installation program, you should plan your 
installation carefully in advance, using the Basic Vibe Installation Summary Sheet or the Advanced 
Vibe Installation Summary Sheet. If you make a mistake during the installation, continue to the end 
of the installation process and exit the installation program normally, so that all information is saved. 
Then run the text-based installation program again. Your previous information is supplied as 
defaults and you can change the information as needed.


Performing a Silent Installation


If your Vibe system expands beyond one server, you might need to repeatedly install the same Vibe 
components. A silent installation makes this an easy process. Edit an existing installer.xml file so 
that it has the hostname of the server where you want to perform the silent installation and copy it to 
that server. In the directory where the installation program is located, use the appropriate command 
to run the Vibe installation program, depending on the action that you want the silent installation to 
perform:


./installer-teaming.linux --silent --install


./installer-teaming.linux --silent --upgrade


./installer-teaming.linux --silent --reconfigure


The Installation program obtains all the information it needs from the installer.xml file and 
completes the installation without user interaction. If you have manually modified index server 
scripts, such as the indexserver-startup.sh file as described in Section 14.1, “Installing the Lucene 
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Software,” on page 121, all modifications will be lost when you perform a silent upgrade. To retain 
your modifications, you should upgrade with the GUI installation program, as described in “Using 
the GUI Installation Program” on page 51.


4.1.3 Installing Missing Libraries


After you install Vibe on SLES, you should check for and install any missing libraries.


1 Change to the following directory:


/opt/novell/teaming/stellent-converter/linux/x86


2 Run the exporter program.
The errors about missing input and output files are expected, and you can safely ignore them.


3 Look for errors about missing libraries.
4 If there are library errors, install any libraries that are missing. 


On 64-bit Linux systems, a common missing library is libstdc++.
You can use the following command to install the missing libraries:


zypper in library_file


4.1.4 Checking for Available Hot Patches


After you install Vibe, make sure that you check on the Vibe download site where you downloaded 
the Vibe software for any hot patches that might be available.


4.1.5 Configuring Vibe to Start Automatically on Reboot


You can configure Vibe to start automatically each time you reboot the Linux server.


1 As the Linux root user, enter the following command:


chkconfig --add teaming


2 To verify that automatic startup is turned on, enter the following command:


chkconfig teaming


4.1.6 Setting Up Port Forwarding


In order to make Vibe available on the default HTTP/HTTPS ports of 80 and 443, you must set up 
port forwarding in order to forward the browser default ports (80 and 443) to the Vibe server ports 
(8080 and 8443). In addition, you must set up port forwarding if you want to forward the default 
SMTP mail host port (25) to the default Vibe internal mail host port (2525).


You can set up port forwarding in one of two ways, depending on whether or not you are using the 
Vibe server as a firewall.


 “Using the SuSEfirewall2 File” on page 55
 “Using iptables Commands” on page 55
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Using the SuSEfirewall2 File


To enable port forwarding on a SUSE Linux server that uses SuSEfirewall2:


1 As the Linux root user, open the following file:
/etc/sysconfig/SuSEfirewall2


2 Find the following line:
FW_REDIRECT=""


3 Between the quotation marks, copy and insert the following string:


0/0,ip_address,tcp,80,8080 0/0,ip_address,tcp,443,8443 
0/0,ip_address,tcp,25,2525


4 Replace ip_address with the IP address of the Vibe server.
5 Save the SuSEfirewall2 file, then exit the text editor.
6 Use the following command to restart the firewall:


/sbin/SuSEfirewall2 start


7 Use the following command to verify that the default browser ports (80 and 443) have been 
forwarded to the Vibe server ports (8080 and 8443) and that the default SMTP mail host port (25) 
has been forwarded to the Vibe internal mail host:
iptables-save | grep REDIRECT


Now, users do not need to include a port number in the Vibe site URL.


Using iptables Commands


To use iptables commands to enable port forwarding on any type of Linux server:


1 As the Linux root user, change to the /etc/init.d directory.
2 In a text editor, create a new file for a set of iptables commands, for example:


gedit vibe-iptables


3 Copy and paste the following lines into the vibe-iptables file:
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iptables -t nat -A OUTPUT -d localhost -p tcp --dport 80 
-j REDIRECT --to-ports 8080


iptables -t nat -A OUTPUT -d hostname -p tcp --dport 80 
-j REDIRECT --to-ports 8080


iptables -t nat -A PREROUTING -d hostname -p tcp --dport 80 
-j REDIRECT --to-ports 8080


iptables -t nat -A OUTPUT -d localhost -p tcp --dport 443 
-j REDIRECT --to-ports 8443


iptables -t nat -A OUTPUT -d hostname -p tcp --dport 443 
-j REDIRECT --to-ports 8443


iptables -t nat -A PREROUTING -d hostname -p tcp --dport 443 
-j REDIRECT --to-ports 8443


iptables -t nat -A OUTPUT -d localhost -p tcp --dport 25 
-j REDIRECT --to-ports 2525


iptables -t nat -A OUTPUT -d hostname -p tcp --dport 25 
-j REDIRECT --to-ports 2525


iptables -t nat -A PREROUTING -d hostname -p tcp --dport 25 
-j REDIRECT --to-ports 2525


In this example, the lines are wrapped for readability. When you paste them into the text editor, 
if the lines are still wrapped, remove the hard returns so that you have six iptables commands, 
each on its own line.


4 Replace hostname with the hostname or IP address of the Vibe server.
5 Save the vibe-iptables file, then exit the text editor.
6 Use the following command to make the file executable:


chmod +x vibe-iptables


7 Use the following command to immediately execute the commands in the vibe-iptables file:
chkconfig vibe-iptables on


8 Use the following command to add vibe-iptables to future server boot initialization:
chkconfig --add vibe-iptables


9 Use the following command to verify that the default browser ports (80 and 443) have been 
forwarded to the Vibe server ports (8080 and 8443) and that the default SMTP mail host port (25) 
has been forwarded to the Vibe internal mail host:
iptables-save | grep REDIRECT


Now, users do not need to include a port number in the Vibe site URL.


4.1.7 Starting Vibe on Linux


The Vibe Installation program created a teaming startup script in the /etc/init.d directory.


1 In a terminal window, become root by entering su - and the root password.
2 Enter the following command to start Vibe:


/etc/init.d/teaming start


You must execute the teaming script as root, but the script runs Vibe as the user you selected in 
Section 3.9.2, “Linux User ID for Vibe,” on page 41 and specified during installation.
You should see output similar to the following example:
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Using CATALINA_BASE: /opt/teaming/apache-tomcat
Using CATALINA_HOME: /opt/teaming/apache-tomcat
Using CATALINA_TEMPDIR: /opt/teaming/apache-tomcat/temp
Using JRE_HOME: /use/java/jdk1.6.0_02/jre


3 To make sure that Vibe is ready for work:
3a Change to the following directory:


/opt/novell/teaming/apache-tomcat/logs


3b Enter the following command to display the end of the Tomcat log:
tail --f catalina.out


At the end of the log file listing, you should see:


INFO: Server startup in nnnn ms 


4 Press Ctrl+C when you finish viewing the catalina.out file.


4.1.8 Checking the Status of the Vibe Server


You can see if Vibe is running by checking for its process ID (PID).


1 In a terminal window, enter the following command:
ps -eaf | grep teaming


You should see the Vibe PID number, along with a listing of configuration settings.


4.1.9 Restarting Vibe


You need to restart Vibe whenever you use the Vibe installation program to make configuration 
changes, as described in Chapter 10, “Performing an Advanced Vibe Installation,” on page 105.


1 As root in a terminal window, enter the following command:
/etc/init.d/teaming restart


You should see the same output as when you originally started Vibe.


4.1.10 Stopping Vibe


1 As root in a terminal window, enter the following command:
/etc/init.d/teaming stop


You should see the same output as when you started Vibe.
2 To verify that Vibe has stopped, check for its PID number:


ps -eaf | grep teaming


The Vibe PID number, along with a listing of configuration settings, should no longer be 
displayed.


4.1.11 Uninstalling Vibe


If you move the Vibe site to a different server, you can delete the Vibe files from the original server to 
reclaim disk space. The default Vibe file locations are: 


Vibe Software /opt/novell/teaming
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For a complete list of your Vibe files, check the installer.xml file in the directory where you 
originally ran the Vibe installation program.


4.2 Windows: Installing and Setting Up a Basic Vibe Site
You should already have reviewed Chapter 3, “Planning a Basic Vibe Installation,” on page 25 and 
filled out the Basic Vibe Installation Summary Sheet. The following sections step you through the 
process of installing and starting Novell Vibe on Windows.


 Section 4.2.1, “Performing Pre-Installation Tasks on Windows,” on page 58
 Section 4.2.2, “Running the Windows Vibe Installation Program,” on page 59
 Section 4.2.3, “Checking for Available Hot Patches,” on page 60
 Section 4.2.4, “Running Vibe as a Windows Service,” on page 61
 Section 4.2.5, “Running Vibe as a Windows Application,” on page 62
 Section 4.2.6, “Uninstalling Vibe,” on page 62


4.2.1 Performing Pre-Installation Tasks on Windows


 “Verifying System Requirements” on page 58
 “Stopping an Existing Web Server” on page 58
 “Setting Environment Variables” on page 59


Verifying System Requirements


Make sure that the Windows server where you plan to install Vibe meets the system requirements 
listed in Section 2.1, “Vibe Server Requirements,” on page 17.


Stopping an Existing Web Server


If a Web server is currently running on the Vibe server, stop it, and preferably disable it.


For example, to stop and disable the Internet Information Services (IIS) Web server:


1 On the Windows desktop, click Start > Administrative Tools > Services.
2 Right-click World Wide Web Publishing Service, then click Properties.
3 In the Startup type drop-down list, select Disabled.
4 Click Stop, then click OK.


Vibe File Repository and 
Lucene Index


/var/opt/novell/teaming


MySQL Database /var/lib/mysql
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Setting Environment Variables


Make sure that the JAVA_HOME environment variable is set to the path where you installed the JDK 
and that the Windows PATH environment variable includes the path to your database server.


1 Right-click My Computer, then click Properties.
2 On the Advanced tab, click Environment Variables.
3 Set the JAVA_HOME environment variable:


3a In the System variables box, click New.
3b In the Variable name field, specify JAVA_HOME.
3c In the Variable value field, specify the path where you installed the JDK.
3d Click OK to add the JAVA_HOME environment variable to the list of system variables, then 


click OK again to save the setting and return to the Advanced tab.
4 Check the PATH environment variable:


4a On the Advanced tab, click Environment Variables.
4b In the System variables list, locate the PATH environment variable.
4c If the path includes your database server software directory, click Cancel.


or
If the path does not include your database server software directory, add the directory, then 
click OK. 


4.2.2 Running the Windows Vibe Installation Program


1 Log in to the Windows server as a user with Administrator rights.
2 In Windows Explorer, browse to the directory where you downloaded and extracted the Vibe 


software.
3 Make sure that there is a license-key.xml file in the directory.


The Vibe installation program does not start without a license file, and it has a different name 
when you download it.
For more information about licensing, see Chapter 6, “Updating Your Vibe License,” on page 69.


4 Double-click the installer-teaming.exe file to start the Vibe installation program.
5 Accept the License Agreement, then click Next.


6 Click Next to accept the default of New installation.
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7 Click Next to accept the default of Basic.
8 Use the information that you have gathered on the Basic Vibe Installation Summary Sheet to 


provide the information that the Vibe installation program prompts you for:


Installation Locations
Default Locale for Novell Vibe
Network Information
WebDAV Authentication Method
Database Selection


Database Type
JDBC URL
Credentials
Setup
Encryption Algorithm


Java JDK Location
Outbound E-Mail Configuration


Protocol
Host, Port, and Time Zone
Username, Password, and Authentication
Allow Sending E-Mail to All Users


Inbound E-Mail Configuration
The installation program stores the information it gathers in the installer.xml file in the same 
directory where you started the installation program.


9 After you have provided all the requested information, click Install to begin the Vibe installation.
10 When the installation is completed, click Finish to exit the Vibe installation program.


Information about the installation process is written to the installer.log file in the same 
directory where you ran the Installation program. If a problem arises during the installation, the 
installer.log file provides information that can help you resolve the problem.


11 Continue with one of the following sections, depending on how you want to run the Vibe 
software:
 Section 4.2.4, “Running Vibe as a Windows Service,” on page 61
 Section 4.2.5, “Running Vibe as a Windows Application,” on page 62


4.2.3 Checking for Available Hot Patches


After you install Vibe, make sure that you check on the Vibe download site where you downloaded 
the Vibe software for any hot patches that might be available.
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4.2.4 Running Vibe as a Windows Service


 “Configuring Vibe as a Windows Service” on page 61
 “Starting Vibe as a Windows Service” on page 61
 “Configuring the Vibe Service to Start Automatically on Reboot” on page 61
 “Restarting the Vibe Service” on page 62
 “Stopping the Vibe Service” on page 62


Configuring Vibe as a Windows Service


The Vibe installation program created a service.bat file for configuring Vibe to run as a Windows 
service.


1 In a Command Prompt window, change to the following directory:
c:\Program Files\Novell\Teaming\apache-tomcat\bin\windows


2 In the windows directory, copy the files from the appropriate subdirectory.
The following subdirectories exist: x86, x64, ia64. 
If you are unsure which subdirectory is appropriate for your server, use the readme.txt file 
located in the c:\Program Files\Novell\Teaming\apache-tomcat\bin\windows directory as 
a reference.


3 Paste the files into the c:\Program Files\Novell\Teaming\apache-tomcat\bin directory.
4 (Conditional) If Vibe is running on a supported 64-bit Windows operating system and you have 


a 64-bit JDK, complete the following steps:
4a Change to the c:\Program Files\Novell\Teaming\apache-tomcat\bin\windows\x64 


directory.
4b Copy any 64-bit .exe files and paste them into the c:\Program 


Files\Novell\Teaming\apache-tomcat\bin directory, overwriting any existing files.
5 Use the following command to configure Vibe as a Windows service:


service.bat install Teaming


This creates a service named Apache Tomcat Teaming.


Starting Vibe as a Windows Service


1 On the Windows desktop, click Start > Administrative Tools > Services.
2 Right-click Apache Tomcat Teaming, then click Start.


Configuring the Vibe Service to Start Automatically on Reboot


When you run Vibe as a Windows service, you can configure Vibe to start automatically each time 
you reboot the Windows server.


1 On the Windows desktop, click Start > Administrative Tools > Services.
2 Right-click Apache Tomcat Teaming, then click Properties.
3 In the Startup type drop-down list, select Automatic, then click OK.
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Restarting the Vibe Service


You need to restart Vibe whenever you use the Vibe installation program to make configuration 
changes, as described in Chapter 10, “Performing an Advanced Vibe Installation,” on page 105.


1 On the Windows desktop, click Start > Administrative Tools > Services.
2 Right-click Apache Tomcat Teaming, then click Restart.
3 Close the Services window.


Stopping the Vibe Service


1 On the Windows desktop, click Start > Administrative Tools > Services.
2 Right-click Apache Tomcat Teaming, then click Stop.
3 Close the Services window.


4.2.5 Running Vibe as a Windows Application


 “Starting Vibe as an Application” on page 62
 “Stopping Vibe as an Application” on page 62


Starting Vibe as an Application


The Vibe installation program created a startup.bat file for starting Vibe.


1 In a Command Prompt window, change to the following directory:


c:\Program Files\Novell\Teaming\apache-tomcat\bin


2 Run the startup.bat file to start Vibe as an application.


Stopping Vibe as an Application


1 In a Command Prompt window, change to the following directory:


c:\Program Files\Novell\Teaming\apache-tomcat\bin


2 Run the shutdown.bat file to stop the Vibe application.


4.2.6 Uninstalling Vibe


If you move the Vibe site to a different server, you can delete the Vibe files from the original server to 
reclaim disk space. The default Vibe file locations are: 


For a complete list of your Vibe files, check the installer.xml file in the directory where you 
originally ran the Vibe Installation program.


Vibe Software c:\Program Files\Novell\Teaming


Vibe File Repository and 
Lucene Index


c:\Novell\Teaming


MS SQL Database c:\Program Files\Microsoft SQL Server\MSSQL\Data
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5 5Adding Users to Your Vibe Site


After you have installed Novell Vibe and made sure that Vibe starts successfully, you are ready to 
access your Vibe site from your Web browser and add users.


 Section 5.1, “Accessing Your Basic Vibe Site as the Site Administrator,” on page 63
 Section 5.2, “Creating a User,” on page 65
 Section 5.3, “Adding Vibe Users from Your LDAP Directory,” on page 66


5.1 Accessing Your Basic Vibe Site as the Site Administrator
1 In your Web browser, specify one of the following URLs, depending on whether or not you are 


using a secure SSL connection:


http://vibe_server
https://vibe_server


Replace vibe_server with the DNS hostname or fully qualified domain name of the Novell 
Vibe server. If you have configured the HTTP ports correctly, you do not need to include the port 
number in the Vibe URL.


2 Log in using admin as the login name and admin as the password.
3 Click My Workspace in the Action toolbar.


The Vibe administrator’s personal workspace is displayed.
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4 Change the default administrator password to a secure password:
4a Click Profile, then in the upper right corner of the Profile page, click Edit.
4b Specify your own password for the Vibe administrator in the New Password and Confirm 


New Password fields.
4c (Optional) Provide useful information in the additional fields of the Vibe administrator’s 


profile.
4d Click OK to return to the administrator’s profile.
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5.2 Creating a User
For testing purposes or for a very small Novell Vibe site, you can create each Vibe user manually.


1 Log in as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 In the Management section, click User Accounts.
4 In the Add Account tab, provide the user’s information, then click OK.
5 Specify at least the user ID, password, first name, and last name.
6 (Optional) Provide useful information in the additional fields for the new user.
7 Click OK, then click Close to return to the administrator’s workspace.


If you click the Workspace tree icon , then expand Personal Workspaces, you see that the 
workspace for the user you just created does not exist yet. Workspaces are not created for users 
until the users log in for the first time.


8 Click the Settings icon  in the upper right corner of the page, then lick Log Out to log out as 
the Vibe administrator.


9 On the login page, provide the username and password for the Vibe user you just created, then 
click OK to log in to the Vibe site.


10 Click My Workspace in the Action toolbar to see the workspace for the new user.
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As each new user logs into the Vibe site, a personal workspace is created.
11 Click Log Out to leave the new user’s personal workspace.


5.3 Adding Vibe Users from Your LDAP Directory
Unless you have a very small Novell Vibe site, you create Vibe users by synchronizing their user 
information from an LDAP directory service such as Novell eDirectory or Microsoft Active Directory. 


IMPORTANT: For a large Vibe site with thousands of users, the synchronization process can 
consume substantial server resources and can take some time to complete. Perform the initial import 
from the LDAP directory at a time when this processing does not conflict with other activities on the 
server.


1 If the LDAP server requires a secure SSL connection in order to access the directory service, 
create a public key certificate for the Vibe server.
For instructions, see “Securing LDAP Synchronization” in “Site Security” in the  Novell Vibe 3.2 
Administration Guide.


2 Log in to the Vibe site as the Vibe administrator. 


3 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
4 Under System, click Configure LDAP, then click Add a New LDAP Connection.
5 Fill in the following fields based on the information you gathered on the Basic Vibe Installation 


Summary Sheet:
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LDAP Server URL
User DN
Password
LDAP attribute that uniquely identifies a user or group
LDAP attribute used for Vibe name
Base DN


6 Set the following synchronization options based on the information you gathered on the Basic 
Vibe Installation Summary Sheet:
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Enable Schedule
Synchronize User Profiles
Register LDAP User Profiles Automatically


7 Click Apply to save the information and settings.
8 Select Run Immediately, then click Apply to test LDAP synchronization.


A status box displays the users and groups that have been added, modified, or deleted on the 
Vibe site. 


IMPORTANT: If you used an LDAP user attribute of uid and some users were not 
synchronized from the LDAP directory to Vibe, repeat the procedure and use cn instead of uid.
The usernames admin and guest are reserved for use by Vibe. If your LDAP directory includes 
users with these names, LDAP information for these reserved usernames is not imported into 
the Vibe site.


9 Click Close to close the status box, then click Close to close the Configure LDAP Synchronization 
page.
Vibe performs one-way synchronization from the LDAP directory to your Vibe site. If you 
change user information on the Vibe site, the changes are not synchronized back to your LDAP 
directory.


IMPORTANT: At this point, users could log into the Vibe site by using their eDirectory or Active 
Directory usernames and passwords. However, you should not invite users to visit the Vibe site until 
after you have finished setting up the Vibe site, as described in “Site Setup” in the  Novell Vibe 3.2 
Administration Guide.
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6 6Updating Your Vibe License


Several different Vibe licenses are available:


 Evaluation License: Available from Novell Downloads (http://download.novell.com).


You receive your 60-day evaluation license when you download the evaluation version of Vibe.
 Starter Pack License: Available from Novell Downloads (http://download.novell.com) and from 


the Novell Vibe Starter Pack Web page  (http://www.novell.com/products/teaming/
starterpack.html).
You receive your 10-user starter pack license when you download the 10-user starter pack.


 Standard Vibe License: Purchased through a Novell sales representative or Novell partner.
The Standard Vibe License gives full Vibe functionality on a per-user basis. It includes Guest 
user functionality for Vibe users who are covered by a Standard Vibe License. However, if non-
licensed Vibe users are accessing the Vibe site through the Guest user functionality (as an 
anonymous user), then you must purchase a Guest Access Instance License in addition to the 
Standard Vibe License for each Vibe instance.
After you purchase the Standard Vibe License, you can access your license key or view your 
purchase history in the Novell Customer Center (http://www.novell.com/customercenter).


 Guest Access Instance License: Purchased through a Novell sales representative or Novell 
partner.
This license must be purchased in addition to the Standard Vibe License. If you purchase 500 or 
more Standard Vibe Licenses, the Guest Access Instance License is included for free. 
The Guest Access Instance License allows you to provide Guest user access to your Vibe site for 
non-licensed Vibe users. If you are using Guest user access for licensed Vibe users only, you do 
not need to purchase this license.
The Guest Access Instance License is a paper license and does not require a new license-
key.xml file.
The Guest Access Instance License can provide added benefit to your site at a manageable cost. 
For example, suppose that your company employs 500 people. Only 200 are company 
knowledge-workers whom you expect to actively participate in the Vibe site; the other 300 
employees simply need to access information that is already posted on the Vibe site, such as 
files, news, or other company information. In this case, you would purchase 200 Standard Vibe 
Licenses. For the remaining 300 employees, who will simply be accessing the site to obtain 
information, you would purchase a single Guest Access Instance License. 
You must purchase one Guest Access Instance License for each Vibe instance that you are 
running.
For more information about the added functionality provided by this license, see “Allowing 
Guest Access to Your Vibe Site” and “Allowing Web Crawler Access to Your Vibe Site” in “Site 
Setup” in the  Novell Vibe 3.2 Administration Guide.
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If you originally installed Vibe with an Evaluation License or a Starter Pack License, it is easy to 
update your Vibe site with a new license file.


1 Copy the new license file that you downloaded from one of the sources listed above into the 
directory where you originally ran the Vibe installation program.


2 Rename the existing license-key.xml file to a different name.
3 Rename the new license file to license-key.xml.
4 Stop Vibe.
5 Run the Vibe Installation program, select the Reconfigure Settings option, then select the Basic 


Installation option.
6 Click Next through all the installation program pages, then click Install to update your Vibe 


license.
7 Start Vibe.
8 Log in to the Vibe site as the Vibe administrator.


9 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
10 Under Management, click License.


You should see the contents of the new license file.
11 Click Close.


At any time, you can generate a report of license usage, as described in “License Report” in “Site 
Maintenance” in the  Novell Vibe 3.2 Administration Guide.
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7 7Setting Up Vibe


After you have installed and started Novell Vibe, there are still administrative tasks to perform before 
your Vibe site is ready for users to log in and use Vibe efficiently. Refer to the following sections of 
the  Novell Vibe 3.2 Administration Guide as you finish setting up your Vibe site.


 “Setting Up Initial Workspaces”
 “Planning and Controlling User Access to Workspaces and Folders”
 “Setting Up User Access to the Vibe Site”
 “Setting Up Site-Wide Customizations”
 “Configuring Vibe to Support WebDAV on Windows 7”
 “Configuring E-Mail Integration”
 “Configuring Weekends and Holidays”
 “Configuring Real-Time Communication Tools”
 “Enabling Custom JSPs to Be Used on Your Vibe Site”
 “Enabling Custom JAR Files to Be Used on Your Vibe Site”
 “Setting Up Mirrored Folders”
 “Setting Up Zones (Virtual Vibe Sites)”
 “Adding Software Extensions to Your Vibe Site”
 “Using Remote Applications on Your Vibe Site”
 “Managing a Multiple-Language Vibe Site”
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8 8Basic Vibe Installation Summary Sheet


Installation Program Field Value for Your Vibe Site Explanation


Vibe Server Platform: 


 Windows


 Linux


See Section 3.2.1, “Vibe Server 
Platform,” on page 26.


Vibe Server Architecture: 


 32-bit


 64-bit


See Section 3.2.2, “Vibe Server 
Architecture,” on page 26.


Vibe Server Memory: 


 4 GB


 8 GB


 More


See Section 3.2.3, “Vibe Server 
Memory,” on page 27.


Java Development Kit (JDK): 


 Sun JDK


 IBM JDK


See Section 3.3, “Selecting a 
Java Development Kit,” on 
page 29.


Vibe Installation Locations: 


 Software


Linux default:


/opt/novell/teaming


Windows default:


c:\Program 
Files\Novell\Teaming


 File repository


Linux default:


/var/opt/novell/teaming


Windows default:


c:\Novell\Teaming


See Section 3.2.4, “Vibe 
Installation Locations,” on 
page 28.
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TrueType Font Location: 


Default:


/usr/X11R6/lib/X11/fonts/
truetype


See Section 3.2.5, “TrueType 
Font Location (Linux Only),” on 
page 29.


Vibe Site Locale: 


Language:


 Chinese-Simplified


 Chinese Traditional


 Danish


 Dutch


 English


 French


 German


 Hungarian


 Japanese


 Polish


 Portuguese


 Russian


 Spanish


 Swedish


Country:


See Section 3.11, 
“Accommodating Multiple 
Languages,” on page 48.


User ID for Novell Vibe (Linux only): 


 User ID:


Full name:


Password:


 Group ID:


See Section 3.9.2, “Linux User ID 
for Vibe,” on page 41.


Network Information: 


 Host:


 HTTP port: 80


 Secure HTTP port: 443


 Listen port: 8080


 Secure listen port: 8443


 Shutdown port:


 AJP port:


See Section 3.4, “Gathering 
Network Information for Your Vibe 
Site,” on page 29.


Installation Program Field Value for Your Vibe Site Explanation
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WebDAV Authenticaiton Method: 


 basic


 digest


See Section 3.5, “Planning the 
WebDAV Authentication Method,” 
on page 32.


Database Type: 


 MySQL


 Microsoft SQL


 Oracle


See Section 3.6.1, “Database 
Type,” on page 34.


JDBC URL: 


 Hostname:


 Port number:


See Section 3.6.3, “Database 
Location,” on page 35.


Database Credentials: 


 Username:


 Password:


See Section 3.6.4, “Database 
Credentials,” on page 36.


Database Setup Method: 


 During installation (automatically by 
the Vibe Installation program)


 Before installation (manually by 
your database administrator)


See Section 3.6.2, “Database 
Setup Method,” on page 35.


Database Encryption Algorithm: 


 SHA


 SHA-256


 MD5


 PBEWithMD5AndDES


See Section 3.6.5, “Database 
Encryption Algorithm,” on 
page 36.


Java JDK Location: 


 Java home:


 JVM heap size:


See Section 3.3, “Selecting a 
Java Development Kit,” on 
page 29.


Outbound E-Mail Protocol: 


 SMTP


 SMTPS


See Section 3.7.1, “Outbound E-
Mail Protocol,” on page 37.


Installation Program Field Value for Your Vibe Site Explanation
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Outbound E-Mail Host: 


 Hostname:


 SMTP port:


Default: 25


 Time zone


 Continent/region:


 Country/state:


 City:


See Section 3.7.2, “Outbound E-
Mail Host,” on page 38.


Outbound E-Mail Authentication: 


 Username:


 Password:


 Authentication required? No / Yes


See Section 3.7.3, “Outbound E-
Mail Authentication,” on page 38.


Allow Sending E-Mail to All Users 


Yes / No


See Section 3.7.4, “Outbound E-
Mail Send Restriction,” on 
page 39.


Inbound E-Mail Configuration 


 Enable: No / Yes


 SMTP bind address:


 SMTP port:


 Announce TLS: Yes / No


See Section 3.8, “Enabling 
Inbound E-Mail,” on page 39.


Vibe Site Password: 


 Administrator username: admin


 Default password: admin


 Your password:


See Section 3.9.1, “Vibe Site 
Administrator Password,” on 
page 41.


LDAP Directory Service: 


 Novell eDirectory


 Microsoft Active Directory


 Other LDAP directory


See Section 3.10, “Gathering 
Directory Services Information,” 
on page 41.


LDAP Server: 


 LDAP server URL:


 User DN:


 Password:


See “LDAP Server” on page 42.


Installation Program Field Value for Your Vibe Site Explanation
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LDAP Attribute to Identify User: 


 GUID


screenName=GUID


 object GUID


screenName=objectGUID


See “LDAP Attribute to Identify a 
User or Group” on page 43.


LDAP Attribute for Vibe Name: 


 cn


screenName=cn


 uid


screenName=uid


See “LDAP Attribute for Vibe 
Name” on page 43.


LDAP User Search Context: 


 Base DNs:


 Additional filter attributes:


 Search subtree: Yes / No


See “User and Group Object 
Locations” on page 44.


LDAP Group Search Context: 


 Base DNs:


 Additional filter attributes:


 Search Subtree: Yes / No


See “User and Group Object 
Locations” on page 44.


LDAP Synchronization Schedule: 


 Days


 Every day


 Weekly


Sun Mon Tue Wed Thu Fri Sat


 Hours:


 At time:


 Repeat every nn hours


See “Synchronization Schedule” 
on page 45.


LDAP User Options: 


 Synchronize user profiles


 Register LDAP user profiles 
automatically


 Delete users that are not in LDAP


 When deleting a user, delete 
associated user workspaces and 
content


 Time zone for new users


See “User Synchronization 
Options” on page 46.


Installation Program Field Value for Your Vibe Site Explanation
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LDAP Group Options: 


 Synchronize group profiles


 Register LDAP group profiles 
automatically


 Synchronize group membership


 Delete local groups that are not in 
LDAP


See “User Synchronization 
Options” on page 46.


Installation Program Field Value for Your Vibe Site Explanation
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III IIIAdvanced Installation and 
Reconfiguration


 Chapter 9, “Planning an Advanced Vibe Installation,” on page 81
 Chapter 10, “Performing an Advanced Vibe Installation,” on page 105
 Chapter 11, “Setting Configuration Options after Installation,” on page 107
 Chapter 12, “Advanced Vibe Installation Summary Sheet,” on page 109
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9 9Planning an Advanced Vibe Installation


The Advanced installation provides additional options for you to customize Novell Vibe.


 Section 9.1, “What Is an Advanced Installation?,” on page 81
 Section 9.2, “Distributing Different Data Types to Different Locations,” on page 82
 Section 9.3, “Using Advanced Network Information Settings,” on page 83
 Section 9.4, “Configuring Web Services,” on page 84
 Section 9.5, “Changing Your Lucene Index Server Configuration,” on page 85
 Section 9.6, “Managing RSS Feeds,” on page 86
 Section 9.7, “Configuring Presence,” on page 87
 Section 9.8, “Configuring Single Sign-On with Novell Access Manager,” on page 88
 Section 9.9, “Configuring Single Sign-On with Internet Information Services for Windows,” on 


page 89
 Section 9.10, “Configuring Mirrored Folder Resource Drivers,” on page 102
 Section 9.11, “Installing the Vibe Software in a Clustered Environment,” on page 103


As you proceed with planning, you can use the Advanced Vibe Installation Summary Sheet to record 
your decisions about the options you want to use.


9.1 What Is an Advanced Installation?
In addition to the Basic installation options described in Section 3.1, “What Is a Basic Vibe 
Installation?,” on page 25, the installation program for Vibe provides several advanced installation 
and configuration alternatives. You can implement the advanced options after performing a Basic 
installation, or you can have the installation program present all the options together.


Compared to a Basic installation, an Advanced installation offers the following additional options:


 Changing the session timeout
 Specifying a keystore file
 Specifying different directories for different types of data
 Disabling and enabling four different Web services
 Changing the configuration of the Lucene Index Server
 Configuring a remote Lucene Index Server or a group of high-availability Lucene nodes
 Reconfiguring how RSS feeds are retained or disabling them entirely
 Enabling presence in conjunction with Novell Messenger
 Configuring a reverse proxy to accommodate single sign-on
 Configuring Windows Authentication
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 Configuring mirrored folders
 Installing Vibe in a clustered environment


IMPORTANT: The following Vibe configurations require that you perform an Advanced installation 
as your initial installation of the Vibe software:


 Setting up the Vibe file repository so that some types of files are located outside the Vibe file 
repository root directory. See Section 9.2, “Distributing Different Data Types to Different 
Locations,” on page 82 for Advanced installation instructions. You cannot move subdirectories 
within the Vibe file repository after they have been created.


 Installing the Vibe software on multiple servers to create a clustered environment. See 
Chapter 15, “Running Vibe on Multiple Servers,” on page 125 for Advanced installation 
instructions. The option to enable a clustered environment is available only during an Advanced 
installation.


If you want to implement an Advanced installation option, you should perform a Basic installation 
first, in a test environment, before performing the Advanced installation to set up your permanent 
Vibe site.


9.2 Distributing Different Data Types to Different Locations
The default location for the Novell Vibe file repository varies by platform:


Under the main Vibe file repository root directory are subdirectories for various kinds of data files 
that are not stored in the Vibe database (MySQL, Microsoft SQL Server, or Oracle). You can use an 
Advanced installation to store Vibe data files in various locations.


The data files not stored in the Vibe database are divided into several functional areas:


 Simple file repository: A large consumer of disk space.


All attachment files are stored in the file repository. All versions of files are also stored here.
 Jackrabbit repository: (Optional) Takes only a fraction of the space consumed by the file 


repository.
By default, Vibe stores all data files individually on disk, in the file repository. If you prefer to 
store data files in the database itself, you can use Apache Jackrabbit with Vibe. See the Apache 
Jackrabbit Web site (http://jackrabbit.apache.org) for setup instructions.


 Extensions repository: Disk space consumption depends on the number of extensions you add 
to your Vibe site.
An extension is a software program that you can incorporate into your Vibe site in order to 
enhance (extend) Vibe capabilities. Adblock Plus is an example of a Firefox browser extension 
that filters out advertisements. You or a Java developer can create custom extensions for your 
Vibe site. For more information about creating and using Vibe extensions, see the Novell Vibe 3.2 
Developer Guide.


 Archive store: A large consumer of disk space.


Linux: /var/opt/novell/teaming


Windows: c:\Novell\Teaming
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When entries are deleted, files that were attached to the deleted entries are retained in the 
archive store in order to meet compliance and archival goals. Previous versions of documents 
are also retained in the archive store. After files have been archived, they are inaccessible from 
the Vibe site. Files that accumulate in the archive store must be manually deleted as needed to 
manage the disk space occupied by the archive store.


 Cache store: Consumes less disk space than the file repository.
Information derived from the attachments, such as thumbnails, HTML renderings, scaled 
images, and word lists for indexing are stored in the cache store. 


 Lucene index: Takes only a fraction of the space consumed by the file repository.
The Lucene index contains only pointers to the actual data stored in the file repository. The index 
enables the Lucene search engine to perform very fast searches through large quantities of data.


The directories for the various types of data can be on the Vibe server or on a remote server. Data 
access is fastest if the data is local, but depending on the size of your Vibe site and the types of data 
you store, the Vibe server might not be the best place to store all the Vibe data. If you want to store 
any of the data types on a remote server, you must ensure that the remote location of the data appears 
local to the Vibe server and that it is always available with read/write access.


Complete the planning process for additional Advanced installation features as needed, then 
perform the Advanced installation as described in Chapter 10, “Performing an Advanced Vibe 
Installation,” on page 105.


9.3 Using Advanced Network Information Settings
 Section 9.3.1, “Changing the Vibe Session Timeout,” on page 83
 Section 9.3.2, “Providing a Secure Keystore File,” on page 84


9.3.1 Changing the Vibe Session Timeout


By default, if a user’s Novell Vibe session is idle for four hours (240 minutes), Vibe logs the idle user 
out. For increased convenience to Vibe users, you can make the session timeout interval longer. For 
increased security for your Vibe site, you can make the session timeout shorter.


Linux: Mount the file repository to the Vibe server.


Windows: Map a drive from the Vibe server to the file repository.


Linux and 
Windows


Place the file repository on a SAN (storage area network) with read/write access. This alternative 
provides the most reliable remote location for the Vibe file repository. This is required for a 
clustered environment, as described in Chapter 15, “Running Vibe on Multiple Servers,” on 
page 125.


ADVANCED VIBE INSTALLATION SUMMARY SHEET


Under Data Locations, specify the directories where you want to store the various types of Vibe data.


ADVANCED VIBE INSTALLATION SUMMARY SHEET


Under Network Information, specify the session timeout interval (in minutes) for your Vibe site.
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Complete the planning process for additional Advanced installation features as needed, then 
perform the Advanced installation as described in Chapter 10, “Performing an Advanced Vibe 
Installation,” on page 105.


9.3.2 Providing a Secure Keystore File


For your convenience, the Vibe software includes a self-signed public certificate that enables you to 
specify secure HTTP and listen ports during installation. This certificate is stored in the .keystore 
file in the following directory:


To ensure secure SSL connections for your Vibe site, you should replace the self-signed public 
certificate with a public certificate issued by a valid certificate authority. 


If you do not already have a permanent public certificate for your Vibe server, see “Securing HTTP 
Browser Connections” in “Site Security” in the  Novell Vibe 3.2 Administration Guide.


Complete the planning process for additional Advanced installation features as needed, then 
perform the Advanced installation as described in Chapter 10, “Performing an Advanced Vibe 
Installation,” on page 105.


9.4 Configuring Web Services
When you install and set up your Novell Vibe site, three Web services are enabled by default. A 
fourth is available for selection. These Web services enable programs to access information on your 
Vibe site just as users would. Allowing programmatic access to your Vibe site can be useful or can be 
viewed as a security risk.


 WSS authentication: Uses OASIS Web Services Security (WSS) (http://www.oasis-open.org).
 HTTP Basic authentication: Uses HTTP Basic Access authentication (http://tools.ietf.org/html/


rfc2617).
 Token-based authentication: Uses custom Vibe tokens to communicate with Vibe remote 


applications. For more information, see “Using Remote Applications on Your Vibe Site” in “Site 
Setup” in the  Novell Vibe 3.2 Administration Guide.


 Anonymous access: Allows access to your Vibe site without authentication. It is similar to the 
Guest access provided for users, as described in “Allowing Guest Access to Your Vibe Site” in 
“Site Setup” in the  Novell Vibe 3.2 Administration Guide.


Linux: /opt/novell/teaming/apache-tomcat/conf


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\conf


ADVANCED VIBE INSTALLATION SUMMARY SHEET


Under Network Information, specify the name and location of the public certificate.


ADVANCED VIBE INSTALLATION SUMMARY SHEET


Under Web Services, mark which Web services you want enabled for your Vibe site. The first three are 
enabled by default. The fourth is disabled by default.
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Complete the planning process for additional Advanced installation features as needed, then 
perform the Advanced installation as described in Chapter 10, “Performing an Advanced Vibe 
Installation,” on page 105.


9.5 Changing Your Lucene Index Server Configuration
The default Lucene Index Server configuration is appropriate for a medium-sized Novell Vibe site. If 
you have a larger Vibe site, you can change its Lucene Index Server configuration.


 Section 9.5.1, “Understanding Indexing,” on page 85
 Section 9.5.2, “Changing Lucene Configuration Settings,” on page 85
 Section 9.5.3, “Running the Lucene Index Server in Its Own JVM,” on page 86
 Section 9.5.4, “Running the Lucene Index Server on a Remote Server,” on page 86
 Section 9.5.5, “Running Multiple Lucene Index Servers,” on page 86


After planning your Lucene configuration, complete the planning process for additional Advanced 
installation features as needed, then perform the Advanced installation as described in Chapter 10, 
“Performing an Advanced Vibe Installation,” on page 105.


9.5.1 Understanding Indexing


The Lucene Index Server is responsible for indexing all data on the Vibe site so that Vibe users can 
easily use the Find and Search features to retrieve the information that they need. Text posted in 
folder entries is easy to index, because the formatting is simple. However, text in attached files arrives 
in many different file formats, many of which require conversion before the text in the files can be 
indexed. Therefore, the Lucene Index Server is dependent on the available file conversion technology 
in order to perform its indexing function. For information about the file viewers that Vibe uses, see 
Section 2.4.1, “File Viewer Support,” on page 20.


The Lucene Index Server provides additional services on your Vibe site in addition to indexing. In 
fact, you cannot access your Vibe site if the Lucene Index Server is not running. For this reason, 
Novell Vibe provides multi-server Lucene configuration options that are not available in Kablink 
Vibe.


9.5.2 Changing Lucene Configuration Settings


If you have an extremely large Vibe site and you need to reindex the Vibe data, you might see 
improved performance by increasing these settings.


 Max booleans: The default is 10000. This means that 10,000 Boolean clauses are allowed in a 
query. You need to increase this only if your Vibe site includes more than 10,000 users, groups, or 
teams.


 RAM in MB that may be used for buffering: The default is 256 MB for remote and high 
availability Lucene configurations and 32 MB for local Lucene configurations. This is the amount 
of RAM that is allocated for buffering documents and deletions before they are flushed to the 
directory. (This setting can be changed only in the Lucene installer; it is not available in the Vibe 
installer.)


 Merge factor: The default is 10. This sets the number of index segments that are created on disk. 
When additional index segments are needed, existing segments are merged to keep the merge 
factor constant.
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 Network interface for RMI service: (Optional) Specify the IP address or hostname for the 
network interface for the RMI (Remote Method Invocation (http://java.sun.com/javase/
technologies/core/basic/rmi/index.jsp)) service.
This is the hostname of the server where the Lucene Index is installed.


9.5.3 Running the Lucene Index Server in Its Own JVM


By default, the Lucene Index Server runs in the same Java Virtual Machine (JVM) as the Vibe 
software. To leave more memory available for the Novell Vibe software, you can configure the 
Lucene Index Server to run in a separate JVM. In this configuration, it communicates with the Vibe 
software using the RMI (Remote Method Invocation (http://java.sun.com/javase/technologies/core/
basic/rmi/index.jsp)) port, which by default is 1199.


To change from running the Lucene Index Server in the same JVM with Vibe to running it in its own 
JVM, you must complete the same steps that you use for setting up the Lucene Index Server on a 
remote server. This includes manually installing the Lucene Index Server software on the Vibe server, 
as described in Chapter 14, “Installing the Lucene Index Server on a Remote Server,” on page 121.


9.5.4 Running the Lucene Index Server on a Remote Server


If the Lucene Index Server requires more memory, disk space, or CPU resources than are available on 
the Novell Vibe server, you can move it to a remote server. This requires installing the Lucene Index 
Server software on that server. For instructions, see Chapter 14, “Installing the Lucene Index Server 
on a Remote Server,” on page 121.


9.5.5 Running Multiple Lucene Index Servers


Because the availability of the index is critical to the functioning of the Novell Vibe site, you can 
install multiple Lucene Index Servers on multiple remote servers to provide high availability. For 
instructions, see Chapter 16, “Running Multiple Lucene Index Servers,” on page 131.


9.6 Managing RSS Feeds
By default, Novell Vibe users can set up RSS feeds in folders on the Vibe site, as described in 
“Viewing Folders as RSS or Atom Feeds” in “Getting Informed” in the Novell Vibe 3.2 User Guide. 


 Section 9.6.1, “Configuring RSS Feeds,” on page 87
 Section 9.6.2, “Disabling RSS Feeds,” on page 87


After planning the RSS settings, complete the planning process for additional Advanced installation 
features as needed, then perform the Advanced installation as described in Chapter 10, “Performing 
an Advanced Vibe Installation,” on page 105.


ADVANCED VIBE INSTALLATION SUMMARY SHEET


Under Lucene Configuration, specify any Lucene configuration settings that you want to change.


ADVANCED VIBE INSTALLATION SUMMARY SHEET


Under Lucene Configuration, specify a hostname of localhost. Use the default RMI port number 
unless it is already in use on the server.
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9.6.1 Configuring RSS Feeds


The following aspects of RSS functionality on your Vibe site are configurable:


 Max elapsed days: By default, items from RSS feeds are retained on the Vibe site for 31 days. 
You can decrease the number of days to reduce the amount of disk space occupied by the RSS 
files.


 Max inactive days: By default, if no one on the Vibe site accesses an RSS feed for 7 days, the feed 
is no longer updated. Increase or decrease the retention time for inactive feeds to meet the needs 
of Vibe users and disk space considerations.


9.6.2 Disabling RSS Feeds


Some administrators consider RSS feeds to be a security risk because the RSS feed URL includes 
username and password information. If you do not want Vibe site users to be able to subscribe to RSS 
feeds from the Vibe site, you can disable this feature.


9.7 Configuring Presence
If you are using Novell Messenger as your instant messaging solution, you can configure Novell Vibe 
to display a user’s Messenger presence information. For information about where presence 
information is displayed in Vibe, see “Sending an Instant Message from within Vibe” in the Novell 
Vibe 3.2 User Guide.


When you click a user’s presence icon, the Profile Quick View is displayed, which enables you to 
send an instant message to the user, view the user’s personal workspace, follow the user, and more. 


In order to configure Messenger presence to be displayed in Vibe, you need the following 
information about the Messenger system during the Vibe installation:


 Server address: Specify the IP address or DNS hostname of the messaging agent for your 
Messenger system.


 Port: Specify the port number.
 Server user: Specify the fully typed, comma-delimited context username of the Allowed Service 


User that you want to log in to the Messenger system and retrieve presence information.
For example, cn=vibesvc,o=acme
For more information about the Allowed Service User, see “Integrating Novell Vibe OnPrem 
with Novell Messenger” in the Novell Messenger 2.2 Administration Guide.


 Password: Specify the password for the Allowed Service User that you want to log in to the 
Messenger system and retrieve presence information.
For more information about the Allowed Service User, see “Integrating Novell Vibe OnPrem 
with Novell Messenger” in the Novell Messenger 2.2 Administration Guide.


ADVANCED VIBE INSTALLATION SUMMARY SHEET


Under RSS Configuration, specify the number of days that meet the needs of your Vibe site.


ADVANCED VIBE INSTALLATION SUMMARY SHEET


Under RSS Configuration, mark No.
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 Server Certificate: Browse to and select the Messaging Agent’s SSL certificate. Vibe uses this 
certificate to identify the Messenger server.
If Messenger is installed on a separate server, copy the certificate from the Messenger server and 
place it in a location on the Vibe server that can be reached from the Vibe installation program.
The certificate is located in the following directory on the Messenger server:


To remove the certificate after you have already selected it, click Browse > Cancel.


Complete the planning process for additional Advanced installation features as needed, then 
perform the Advanced installation as described in Chapter 10, “Performing an Advanced Vibe 
Installation,” on page 105.


IMPORTANT: For Messenger presence to display in Vibe when using LDAP, you need to map 
presenceID to your authentication attribute in the Vibe LDAP configuration page. For example, 
presenceID=cn. For more information, see “Configuring Presence” in the  Novell Vibe 3.2 
Administration Guide


9.8 Configuring Single Sign-On with Novell Access Manager
Novell Access Manager provides secure single sign-on access to your Novell Vibe site by functioning 
as a reverse proxy server. Access Manager 3.1 SP1 IR1 is required for use with Novell Vibe. You can 
download the required version of Access Manager from Novell Downloads (http://
download.novell.com).


For background information about setting up Novell Access Manager 3.1, see the Access Manager 3.1 
Documentation Web site (http://www.novell.com/documentation/novellaccessmanager31). For 
instructions specific to Vibe, see “Configuring a Protected Resource for a Novell Teaming 2.x Server” 
(http://www.novell.com/documentation/novellaccessmanager31/accessgateway/data/
b3nqgsg.html#blpk97e). These instructions are based on the Linux text-based Vibe installation 
program, as described in “Using the Text-Based Installation Program” on page 52. They can easily be 
adapted for running the Linux GUI Vibe installation program, as described in “Using the GUI 
Installation Program” on page 51, or when installing on Windows, as described in Section 4.2.2, 
“Running the Windows Vibe Installation Program,” on page 59.


After you have configured Novell Access Manager, you must configure your Vibe site with the IP 
address of one or more Access Gateway servers and with the logout URL. When you configure the 
Vibe site to use the Access Gateway, the IP addresses that you specify are the only locations from 
which the Vibe site accepts logins. The logout URL is the location where users find themselves when 
they log out of the Vibe site.


When you enable the Access Gateway for use with your Vibe site, all Vibe users must log in through 
the Access Gateway. It is not possible to set up the Vibe site so that some users log in through the 
Access Gateway and some do not.


Linux: /opt/novell/messenger/certs


Windows: c:\Novell\Messenger\certs


ADVANCED VIBE INSTALLATION SUMMARY SHEET


Under Presence Configuration, select Enable Novell Messenger Presence, then list the information that 
the Vibe site needs to know in order to communicate with the Messenger system.
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Complete the planning process for additional Advanced installation features as needed, then 
perform the Advanced installation as described in Chapter 10, “Performing an Advanced Vibe 
Installation,” on page 105.


9.9 Configuring Single Sign-On with Internet Information 
Services for Windows
Like Novell Access Manager, Windows Authentication provides Windows users with a single sign-
on experience, enabling users to automatically authenticate to Novell Vibe after they log in to their 
individual workstations. Internet Information Services (IIS) provides this capability.


Before you implement Windows Authentication, consider the following limitations:


 IIS is best suited for an intranet environment. Because NTLM is a connection-based protocol, it 
does not work well with HTTP proxy servers.


 IIS does not support Guest Access.


After you configure the Vibe server to support Windows Authentication, complete the planning 
process for additional Advanced installation features as needed, then perform the Advanced 
installation as described in Chapter 10, “Performing an Advanced Vibe Installation,” on page 105.


 Section 9.9.1, “System Requirements,” on page 89
 Section 9.9.2, “Planning Your IIS Installation and Configuration,” on page 90
 Section 9.9.3, “Configuring the Vibe Server to Support Windows Authentication,” on page 92
 Section 9.9.4, “Running the Vibe Installation Program,” on page 98
 Section 9.9.5, “Configuring Your Browser to Allow Access to the Vibe Site,” on page 98
 Section 9.9.6, “Bypassing Windows Authentication to Configure LDAP and Perform Other 


Tasks,” on page 99
 Section 9.9.7, “Logging In to the Vibe Site through Windows Authentication,” on page 99
 Section 9.9.8, “Editing Files through WebDAV with Windows Authentication,” on page 100
 Section 9.9.9, “Configuring IIS to Load Balance in a Clustered Environment,” on page 101


9.9.1 System Requirements


Windows Authentication with IIS can be enabled for Vibe only in the following environments:


Server


 Windows 2008 Server
 Windows 2008 R2 Server


ADVANCED VIBE INSTALLATION SUMMARY SHEET


Under Reverse Proxy Configuration, list one or more IP addresses of Access Gateway servers that have 
been configured for use by Vibe. List the logout URL, and if necessary, the Access Gateway hostname 
for WebDAV connections.
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IIS


 IIS 7 with IIS Manager with CGI and ISAPI components
 IIS 7.5 with IIS Manager with CGI and ISAPI components


Authentication Protocol


One of the following authentication protocols:


 NTLM
 Kerberos v5
 Negotiate/SPNEGO (wrapper for NTLM and Kerberos v5)


Domain Controller


 Active Directory Service


Vibe needs to be configured and synchronized with your Active Directory directory service. For 
more information about configuring LDAP synchronization within Vibe, see Section 3.10, 
“Gathering Directory Services Information,” on page 41 and “Synchronizing Users and Groups 
from an LDAP Directory” in the  Novell Vibe 3.2 Administration Guide.


If you are using Kerberos as your authentication protocol, then Key Distribution Services is also 
required.


For more information about installing and configuring the domain controller and other domain 
services to support Windows Authentication, refer to the appropriate Microsoft documentation.


Client


One of the following clients:


 Windows 7
 Windows XP


Browser


One of the following browsers, configured to support Windows Authentication:


 Internet Explorer
 Firefox


For information on how to configure your browser to support Windows Authentication, see 
Section 9.9.5, “Configuring Your Browser to Allow Access to the Vibe Site,” on page 98.


9.9.2 Planning Your IIS Installation and Configuration


Use the information in the following table as you consider your IIS installation.
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Directory: The default installation directory for the IIS plug-in is C:\Program Files\Novell. 
This is the recommended directory. If for some reason you choose to install the IIS plug-in in a 
directory other than the C:\Program Files\Novell directory, then you need to modify the 
isapi_redirect.properties files, as described in “Installing the Vibe IIS Plug-In” on page 92.


External or Local Server: You can install the IIS plug-in on the same server where you are running 
Vibe, or you can install it on an external server. Installing IIS on an external server can have several 
benefits, such as:


 Performance improvement


 Ability to integrate with several Vibe servers in a clustered environment


 Ability to run Vibe from a non-Windows server


If you are running IIS from an external server, then you need to edit the C:\Program 
Files\Novell\Vibe IIS Plugin\conf\workers.properties file, as described in 
“Installing the Vibe IIS Plug-In” on page 92.


64-bit/32-bit: You can install the IIS plug-in on a 64-bit or 32-bit operating system. However, Vibe 
should run on a 64-bit operating system, so if you install IIS on a 32-bit operating system, you 
should use an external server.


HTTP Ports: Regardless of whether IIS and Vibe are located on the same server or separate 
servers, the HTTP port and secure HTTP port for Vibe should always be 80 and 443. This ensures 
that when links are generated, they contain the correct hostname and port number. 


These are the ports that Vibe uses to refer to the browser. In a very basic Vibe system (single server 
without Windows Authentication), the HTTP ports can be the same as the listen ports. However, in 
a Vibe system with Windows Authentication enabled, the HTTP ports correspond with the ports that 
the IIS server is configured to use.


Listen Ports: If you plan to run IIS on the same server as the Vibe server, you need to set the listen 
port and secure listen port for Vibe to something other than 80 and 443.


By default, Vibe listens on ports 80 and 443. Because IIS also uses these ports to listen on, you 
must reconfigure the Vibe listen ports to ports that are not currently in use, such as 8080 for the 
listen port and 8443 for the secure listen port.


You configure Vibe ports during the Vibe installation, as described in Chapter 10, “Performing an 
Advanced Vibe Installation,” on page 105.


ADVANCED VIBE INSTALLATION SUMMARY SHEET


Under Network Information, specify the HTTP ports and listen ports.


Under Integration with IIS for Windows Authentication, select Enable Integration with IIS for Windows 
Authentication, then list the logout URL.
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9.9.3 Configuring the Vibe Server to Support Windows Authentication


To configure the Vibe server to support Windows Authentication, you must first configure IIS. You 
can set up IIS on the same server where Vibe is running, or on a separate server. See Section 9.9.2, 
“Planning Your IIS Installation and Configuration,” on page 90 for more information.


Complete the following sections to ensure that IIS is configured correctly to work with Vibe.


 “Installing the Vibe IIS Plug-In” on page 92
 “Installing IIS Manager” on page 93
 “Installing Windows Authentication Role Service” on page 93
 “Creating and Managing Vibe Resources with IIS Manager” on page 94


Installing the Vibe IIS Plug-In


1 Locate the teaming-version-iis-plugin.zip file from the Vibe distribution, then unzip it into 
the C:\Program Files\Novell directory.
This creates a directory called Vibe IIS Plugin.


2 If in Step 1 you chose to unzip the teaming-version-iis-plugin.zip file into the C:\Program 
Files\Novell directory, continue with Step 3.
or
If in Step 1 you chose to unzip the teaming-version-iis-plugin.zip file into a location other 
than C:\Program Files\Novell, you must complete the following steps:
2a Locate the isapi_redirect.properties file in each of the following directories: 


 Vibe IIS Plugin\resources1\bin


 Vibe IIS Plugin\resources2\bin


2b In each of the directories, open the isapi_redirect.properties file in a text editor.
2c Adjust the values of the log_file, worker_file, and worker_mount_file properties to 


reflect the directory where you chose to unzip the teaming-version-iis-plugin.zip file.
2d Save your changes and close both of the isapi_redirect.properties files.


3 If IIS and the Vibe server are located on the same server, continue with Step 4. 
or
If IIS and the Vibe server are located on separate servers, complete the following steps:
3a Locate the C:\Program Files\Novell\Vibe IIS Plugin\conf\workers.properties 


file.
3b Open the workers.properties file in a text editor.
3c Adjust the value of the worker.worker1.host property from localhost to the hostname 


or IP address of the Vibe server.
3d Save your changes and close the editor.


4 (Conditional) If you are running IIS on a 64-bit server, complete the following steps:
4a Locate the C:\Program Files\Novell\Vibe IIS Plugin\library\win64 directory.
4b Copy the appropriate version of the .dll library and paste it into each of the following 


directories:
 C:\Program Files\Novell\Vibe IIS Plugin\resources1\bin


 C:\Program Files\Novell\Vibe IIS Plugin\resources2\bin
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Ensure that you copy the correct version of the .dll library. If you copy the incorrect 
version, you receive a 500 error when you try to access the Vibe site.


4c Delete the existing isapi_redirect.dll files from the C:\Program Files\Novell\Vibe 
IIS Plugin\resources1\bin directory, as well as from the C:\Program 
Files\Novell\Vibe IIS Plugin\resources2\bin directory.


4d Rename the .dll library files that you copied in Step 4b to isapi_redirect.dll.
For example, if Vibe is running on an AMD64/EM64T platform, copy C:\Program 
Files\Novell\Vibe IIS Plugin\library\win64\amd64\isapi_redirect-
version.dll into the C:\Program Files\Novell\Vibe IIS Plugin\resources1\bin 
and C:\Program Files\Novell\Vibe IIS Plugin\resources2\bin directories, then 
delete the original isapi_redirect.dll file and rename isapi_redirect-version.dll 
to isapi_redirect.dll.


Installing IIS Manager


If Internet Information Services (IIS) Manager is not already installed on your server, you need to 
download and install it. You also need to install the CGI and ISAPI components.


1 Install the IIS 7 Administration Pack:
1a Navigate to Microsoft IIS Download Site (http://www.iis.net/download/Manage).
1b Click the Manage tab.
1c Under Administration Pack, click Install.
1d (Conditional) If you have not yet installed the Microsoft Web Platform, click Get the 


Microsoft Web Platform to download the .exe file, install the Microsoft Web Platform, then 
click Finish your installation.
The Launch Application dialog box is displayed.


1e Select Web Platform Installer, then click OK.
The Web Platform Installer 2.0 dialog box is displayed.


1f Click Install to install the Administration Pack, then accept the terms of the license 
agreement.


2 Install the ISAPI and CGI components:
2a Launch the Web Platform Installer.
2b From the Web Platform Installer, select Web Platform.
2c Under Web Server, click Customize.
2d In the Application Development section, select CGI, ISAPI Extensions, and ISAPI Filters.
2e Click Install, then accept the terms of the license agreement.
2f Click Finish after the components have been installed successfully.


Installing Windows Authentication Role Service


If the Windows Authentication Role Service is not already installed, you need to install it.


1 On the Windows 2008 server, click Start > Administrative Tools > Server Manager.
2 Expand Roles, then right-click Web Server (IIS).
3 Click Add Role Services.


The Add Role Services window is displayed.
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4 Scroll to the Security section, then select Windows Authentication.
5 Click Next, then complete the installation.


Creating and Managing Vibe Resources with IIS Manager


1 Click Start > Administrative Tools > Internet Information Services (IIS) Manager.
2 In the Connections pane on the left side of the window, expand your server, then expand Sites.
3 Right-click Default Web Site, then click Add Virtual Directory.


The Add Virtual Directory dialog box is displayed.


4 In the dialog box, specify the following information:
Alias: VibeResources1.
Physical path: C:\Program Files\Novell\Vibe IIS Plugin\resources1\bin.


5 Click OK.
6 Repeat Step 3 through Step 5 to add another virtual directory.


This time, specify the following information in the Add Virtual Directory dialog box:
Alias: VibeResources2
Physical path: C:\Program Files\Novell\Vibe IIS Plugin\resources2\bin
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7 In the Connections panel, select VibeResources1, then double-click Handler Mappings.


8 In the Actions pane, click Edit Feature Permissions.
The Edit Feature Permissions dialog box is displayed.


9 Select Execute, then click OK.
10 Repeat Step 7 through Step 9 for the VibeResources2 virtual directory.
11 In the Connections pane, select Default Web Site, then double-click ISAPI Filters.
12 In the Actions panel, click Add.


The Add ISAPI Filter dialog box is displayed.
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13 In the dialog box, specify the following information:
Filter name: VibeResources1.
You must name the filter VibeResources1 for Windows Authentication to work successfully.
Executable: C:\Program Files\Novell\Vibe IIS 
Plugin\resources1\bin\isapi_redirect.dll.


14 Click OK.
15 Repeat Step 12 through Step 14 to add another ISAPI filter.


This time, specify the following information in the Add ISAPI Filter dialog box:
Filter name: VibeResources2.
You must name the filter VibeResources2 for Windows Authentication to work successfully.
Executable: C:\Program Files\Novell\Vibe IIS 
Plugin\resources2\bin\isapi_redirect.dll.


16 In the Connections pane, select the server, then double-click ISAPI and CGI Restrictions.
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17 In the Actions pane, click Add.
The Add ISAPI or CGI Restriction dialog box is displayed.


18 In the dialog box, specify the following information:
ISAPI or CGI path: Specify C:\Program Files\Novell\Vibe IIS 
Plugin\resources1\bin\isapi_redirect.dll.
Description: VibeResources1.
Allow extension path to execute: Select this option to allow the path to execute.


19 In the Actions pane, click Add.
The Add ISAPI or CGI Restriction dialog box is displayed.
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20 In the dialog box, specify the following information:
ISAPI or CGI path: Specify C:\Program Files\Novell\Vibe IIS 
Plugin\resources2\bin\isapi_redirect.dll.
Description: VibeResources2.
Allow extension path to execute: Select this option to allow the path to execute.


21 In the Connections pane, select VibeResources1, then double-click Authentication.
22 Select Anonymous Authentication, then click Disable in the Actions panel.
23 Select Windows Authentication, then click Enable in the Actions panel.
24 Exit the Internet Information Services Manager.
25 Perform the Advanced installation as described in Chapter 10, “Performing an Advanced Vibe 


Installation,” on page 105.


9.9.4 Running the Vibe Installation Program


See “Choosing Windows Authentication” on page 34 for information about how to configure the 
Vibe installation program to support Windows Authentication, then follow the instructions for the 
advanced installation as described in Chapter 10, “Performing an Advanced Vibe Installation,” on 
page 105. Return here and continue with additional configuration steps.


9.9.5 Configuring Your Browser to Allow Access to the Vibe Site


After Windows Authentication has been enabled on the server, you need to configure the client 
browser to allow access to the Vibe site.


 “Internet Explorer” on page 98
 “Firefox” on page 99


Internet Explorer


1 In an Internet Explorer window, click Tools > Internet Options.
The Internet Options dialog box is displayed.


2 Click the Security tab, select Local intranet, then click Sites.
The Local Intranet dialog box is displayed.


3 Click Advanced.
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4 In the Add this website to the zone field, specify the Vibe Web site.
5 Click Add > Close.


Firefox


1 In Firefox, specify about:config in the URL field.
2 Specify ntlm in the Filter window, then locate and select the network.automatic-ntlm-auth.trusted-


uris entry.
The Enter String Value dialog box is displayed.


3 Specify the DNS name of your Vibe site, then click OK.
For example, vibe.mycompany.com.


4 Repeat Step 2 through Step 3 for network.negotiate-auth.trusted-uris and network.negotiate-
auth.delegation-uris.


9.9.6 Bypassing Windows Authentication to Configure LDAP and Perform 
Other Tasks


After Windows Authentication is working on your Vibe server, you can bypass the Windows 
Authentication functionality by including the Vibe listening port in the Vibe URL. 


You need to do this in order to configure your LDAP directory.


1 In a Web browser, specify your Vibe URL with the Vibe listening port.
For example, http://vibe:8080.
The Vibe login page is displayed.


2 Log in to the Vibe site as the Vibe administrator.
3 Configure LDAP, as described in Section 5.3, “Adding Vibe Users from Your LDAP Directory,” 


on page 66.


You might also need to bypass Windows Authentication to access Vibe for the following reasons:


 To access a specific Vibe node in a clustered environment.
 To troubleshoot the Vibe system.


9.9.7 Logging In to the Vibe Site through Windows Authentication


After you have performed the configuration steps described in Section 9.9.3, “Configuring the Vibe 
Server to Support Windows Authentication,” on page 92 through Section 9.9.5, “Configuring Your 
Browser to Allow Access to the Vibe Site,” on page 98, users can access the Vibe site through 
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Windows Authentication. Users who have been configured through LDAP and are already logged in 
to their individual workstations do not need to log in again to access the Vibe site. Users who are not 
already logged in before they access Vibe see the following dialog box:


9.9.8 Editing Files through WebDAV with Windows Authentication


 “Achieving Single Sign-On When Editing Files through WebDAV” on page 100
 “Enabling Basic Authentication for WebDAV” on page 100


Achieving Single Sign-On When Editing Files through WebDAV


By default, when you edit a file in Vibe through WebDAV, you are prompted for your system login 
credentials before you can edit the file. However, when Windows Authentication is enabled on your 
Vibe server, you are no longer prompted for your system login credentials before you edit a file 
through WebDAV.


This functionality is supported only when you use Microsoft Office as your default document editor. 
When you use OpenOffice 3.1 or later as your default document editor, Vibe allows you to edit files 
through WebDAV, but it still requires you to enter your system login credentials. The single sign-on 
experience is only available when you use Microsoft Office.


Enabling Basic Authentication for WebDAV


If you are using OpenOffice 3.0 or earlier, or any other document editor that requires basic 
authentication (it does not support Windows Authentication), you need to configure your IIS server 
to support basic authentication. Supporting basic authentication enables Vibe users to edit files 
through WebDAV when using a document editor other than Microsoft Office or OpenOffice 3.1 or 
later.


NOTE: If you enable basic authentication on your IIS server, all users who access the Vibe site 
through Firefox are prompted for their login credentials. Single sign-on to the Vibe server no longer 
functions. However, users who access the Vibe site using Internet Explorer retain the single sign-on 
experience.


To enable basic authentication on your IIS server, you need to install the Basic Authentication Role 
Service.


1 On the Windows 2008 server, click Start > Administrative Tools > Server Manager.
2 Expand Roles, then right-click Web Server (IIS).
3 Click Add Role Services.


The Add Role Services window is displayed.
4 Scroll to the Security section, then select Basic Authentication.
5 Click Next, then complete the installation.
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6 Click Start > Administrative Tools > Internet Information Services (IIS) Manager.
7 In the Connections pane on the left side of the window, expand your server, expand Sites, then 


expand Default Web Site.
8 Select VibeResources1, then double-click Authentication.
9 Select Basic Authentication, then click Enable in the Actions panel.


10 Close the Internet Information Services (IIS) Manager.


9.9.9 Configuring IIS to Load Balance in a Clustered Environment


If you have Vibe installed in a clustered environment where there are multiple Vibe nodes, you can 
configure IIS to balance the load of user requests from the multiple Vibe nodes, while still supporting 
Windows Authentication.


1 On the IIS server, locate the C:\Program Files\Novell\Vibe IIS 
Plugin\conf\workers.properties.clustered.template file, then open the file in a text 
editor.


2 Copy the contents of the file.
3 Locate the C:\Program Files\Novell\Vibe IIS Plugin\conf\workers.properties file, 


then open the file in a text editor.
4 Paste the contents of the C:\Program Files\Novell\Vibe IIS 


Plugin\conf\workers.properties.clustered.template that you copied in Step 2 and into 
the C:\Program Files\Novell\Vibe IIS Plugin\conf\workers.properties file, 
overwriting the content that was previously there.


5 Replace the value of worker.worker1.host from first_hostname_or_ip with the hostname or IP 
address of your first Vibe node.


6 Repeat Step 5 for each additional Vibe node that is running in your environment. If you have 
more than two Vibe nodes, you should add an additional section to the workers.properties 
file for each additional node.
The values that you specify in the workers.properties file (for example, worker1, worker2, 
etc.) must exactly match the values that you specify as the JVM Route setting during the Vibe 
installation, as described in Section 15.2, “Installing the Vibe Software on Multiple Servers,” on 
page 126. 


7 Locate the C:\Program Files\Novell\Vibe IIS 
Plugin\resources1\conf\uriworkermap.properties file, then open the file in a text editor.


8 Replace all instances of worker1 with balancer.
9 Repeat Step 7 and Step 8 for each Vibe node.


10 Locate the C:\Program Files\Novell\Vibe IIS 
Plugin\resources2\conf\uriworkermap.properties file, then open the file in a text editor.


11 Replace all instances of worker1 with balancer.
12 Repeat Step 10 and Step 11 for each Vibe node.
13 Restart each Vibe node.
14 Restart the IIS server:


14a Click Start > Administrative Tools > Internet Information Services (IIS) Manager.
14b Select your server in the Connections panel, then click Restart in the Actions panel.
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9.10 Configuring Mirrored Folder Resource Drivers
A mirrored folder is a directory, either local or shared on a SAN (storage area network), that is 
directly accessible from the Novell Vibe site. The files on the file system are accessed by the Novell 
Vibe program through a resource driver, not directly by individual Vibe users. A resource driver 
defines how the Vibe program accesses the file system. 


During installation, you define the users and groups that can access the mirrored folder resource 
drivers. After installation, from the Vibe site, you associate resource drivers with specific Vibe folders 
and use folder access controls to govern which users and groups can access the data in the mirrored 
folder. As a result, you can set up a small number of users who can create mirrored folders, and allow 
a larger number of users to access the mirrored folders.


Vibe attempts to keep the metadata about each mirrored folder synchronized with the contents of the 
actual file system. Therefore, mirrored folders are most appropriate for large sets of relatively static 
data. Mirrored folders are also useful for making extremely large files available from your Vibe site 
without including them in the Vibe file repository.


Although the installation program allows you to set up three mirrored folder resource drivers during 
installation, you can set up and test just one to start with, then set up additional resource drivers later. 


 Section 9.10.1, “File System Type,” on page 102
 Section 9.10.2, “File System Directory,” on page 102
 Section 9.10.3, “File System Access,” on page 103
 Section 9.10.4, “Mirrored Folder Setup,” on page 103


After planning mirrored folders, complete the planning process for additional Advanced installation 
features as needed, then perform the Advanced installation as described in Chapter 10, “Performing 
an Advanced Vibe Installation,” on page 105.


9.10.1 File System Type


Vibe provides resource drivers for two different types of file systems:


 file: A directory in a regular file system on a Linux or Windows server.
 webdav: A directory on a Web server that supports WebDAV (Web-based Distributed 


Authoring and Versioning). The WebDAV server must support HTTP Basic Authentication 
(http://en.wikipedia.org/wiki/Basic_access_authentication) so that Vibe can provide a username 
and a password when making a request from the WebDAV server.


9.10.2 File System Directory


The file system that a Vibe mirrored folder uses can be on Linux, NetWare, or Windows, as long as 
the following conditions are met:


 The file system is accessible from the Vibe server by using a directory path specification that the 
Vibe server operating system understands.


 The file system is accessible through the standard java.io package interface.


ADVANCED VIBE INSTALLATION SUMMARY SHEET


Under Mirrored Folder Resource Driver Configuration, mark the type of directory that you want to mirror 
in your Vibe site.
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IMPORTANT: On Windows, you must use forward slashes (/) in the pathname, not the typical 
Windows backslashes (\). For example, use c:/Documents rather than c:\Documents.


If you need to eventually set up more than three directories as mirrored folders in your Vibe site, you 
can edit the installer.xml file in the directory where you run the Installation program.


9.10.3 File System Access


Vibe offers several security options for controlling access to the data that resides on the file system.


 You can restrict the Vibe program to read-only access to the mirrored data, or you can allow full 
read/write access.


 You can list specific Vibe users who are allowed to access the mirrored folder resource drivers 
and thereby create mirrored folders.


 You can list specific Vibe groups whose members are allowed to access the mirrored folder 
resource drivers and thereby create mirrored folders.


 For WebDAV mirrored folder resource drivers, you must also specify a username and password 
that the Vibe program can use to access the WebDAV server.


9.10.4 Mirrored Folder Setup


After you run the Vibe Installation program to configure the Vibe site for mirrored folder resource 
drivers, additional folder setup is required. Follow the instructions in “Setting Up Mirrored Folders” 
in “Site Setup” in the  Novell Vibe 3.2 Administration Guide.


9.11 Installing the Vibe Software in a Clustered Environment
You must use an Advanced installation in order to install the Novell Vibe software on multiple 
servers and set up a clustered environment. Setting up multiple Vibe servers, along with other 
clustering options, are described in Chapter 15, “Running Vibe on Multiple Servers,” on page 125.


ADVANCED VIBE INSTALLATION SUMMARY SHEET


Under Mirrored Folder Resource Driver Configuration, specify the full path for the directory that you want 
to mirror in your Vibe site. Also, provide a title for the mirrored folder resource driver that indicates what 
directory or data is being mirrored. For WebDAV mirrored folders, you must also specify the URL of the 
WebDAV host where the data is located.


ADVANCED VIBE INSTALLATION SUMMARY SHEET


Under Mirrored Folder Resource Driver Configuration, list the file access (read/write or read-only) for the 
mirrored data, along with users and groups that you want to have access to the resource driver. For a 
WebDAV mirrored folder, list a username and password that provides access to the WebDAV server.
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10 10Performing an Advanced Vibe 
Installation


You should already have reviewed Chapter 3, “Planning a Basic Vibe Installation,” on page 25 and 
filled out the Basic Vibe Installation Summary Sheet. You should also have reviewed Chapter 9, 
“Planning an Advanced Vibe Installation,” on page 81 and filled out the Advanced Vibe Installation 
Summary Sheet for those aspects of an Advanced installation that you want to implement for your 
Novell Vibe site.


1 Follow the Basic installation instructions provided in Chapter 4, “Installing and Setting Up a 
Basic Vibe Site,” on page 49 for the platform where you are installing Vibe.


2 When you run the installation program, select Advanced on the Choose Installation Type page.


3 Use the information that you have gathered on the Basic Vibe Installation Summary Sheet and 
the Advanced Vibe Installation Summary Sheet to provide the information that the Vibe 
Installation program prompts you for:
Basic Installation Pages: 


Installation Locations
Location of TrueType Fonts for Stellent Converters
Default Locale for Novell Vibe
User ID for Novell Vibe (Linux only)
Network Information
WebDAV Authentication Method
Database Selection
Java JDK Location
Outbound E-Mail Configuration
Inbound E-Mail Configuration
Some Basic installation pages have additional options available when you perform an Advanced 
installation.
Advanced Installation Pages: 


Web Services
Lucene Configuration
RSS Configuration
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Presence Configuration
Reverse Proxy Configuration
Integration with IIS for Windows Authentication
Mirrored Folder Resource Driver Configuration
Vibe Cluster Configuration
The Installation program stores the information it gathers in the installer.xml file in the same 
directory where you started the Installation program.


4 After you have provided all the requested information, click Install to begin the Advanced 
installation.


5 When the installation is complete, click Finish to exit the Vibe installation program.
Information about the installation process is written to the installer.log file in the same 
directory where you ran the Installation program. If a problem arises during the installation, the 
installer.log file provides information that can help you resolve the problem.


6 After you complete the Advanced installation, continue setting up your Vibe site, as described in 
Chapter 5, “Adding Users to Your Vibe Site,” on page 63.
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11 11Setting Configuration Options after 
Installation


After you install Novell Vibe, following the instructions in Part II, “Basic Installation,” on page 23 or 
Part III, “Advanced Installation and Reconfiguration,” on page 79, you can rerun the Vibe installation 
program to change configuration options or add new functionality to your Vibe site.


1 Stop Vibe.
2 Start the Vibe installation program as described in Section 4.1.2, “Running the Linux Vibe 


Installation Program,” on page 51 and Section 4.2.2, “Running the Windows Vibe Installation 
Program,” on page 59.


Because the Installation program finds an existing installer.xml file, it defaults to Reconfigure 
settings. 


3 Click Next.
The Vibe Installation program asks you to verify that you have stopped Vibe.


4 Click Yes.


5 Select Basic or Advanced, depending on the configuration settings that you want to change, then 
click Next.


6 Click Next until you reach an installation page where you want to reconfigure settings.
Basic Installation Pages: 


Installation Locations
Location of TrueType Fonts for Stellent Converters
Default Locale for Novell Vibe
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User ID for Novell Vibe (Linux only)
Network Information
WebDAV Authentication Method
Database Selection
Java JDK Location
Outbound E-Mail Configuration
Inbound E-Mail Configuration
Advanced Installation Pages: 


Web Services
Lucene Configuration
RSS Configuration
Presence Configuration
Reverse Proxy Configuration
Integration with IIS for Windows Authentication
Mirrored Folder Resource Driver Configuration
Vibe Cluster Configuration


7 When you reach the Ready to Install page, click Install to implement the reconfigured settings.
8 Start Vibe.
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12 12Advanced Vibe Installation Summary 
Sheet


Installation Program Field Value for Your Vibe Site Explanation


Data Locations: 


Linux default:


/var/opt/novell/teaming


Windows default:


c:\Novell\Teaming


 Simple file repository


 Jackrabbit repository


 Extensions repository


 Cache store


 Lucene index


See Section 9.2, “Distributing 
Different Data Types to Different 
Locations,” on page 82.


Network Information: 


 Enable Web services: 


No / Yes


 Session timeout


Default: 240 minutes


 Enable Tomcat access log: 


No / Yes


 Keystore file:


See Section 9.3, “Using Advanced 
Network Information Settings,” on 
page 83.


WebDAV Authentication Method 


 basic


 digest


See Section 3.5, “Planning the 
WebDAV Authentication Method,” 
on page 32.


Web Services: 


 Enable WSS authentication


 Enable Basic authentication


 Enable token-based 
authentication


 Enable anonymous access


See Section 9.4, “Configuring Web 
Services,” on page 84.
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Lucene Configuration: 


Configuration type: all


 Max booleans:


Default: 10000


 Merge factor:


10


See Section 9.5.2, “Changing 
Lucene Configuration Settings,” on 
page 85.


Server Lucene Configuration: 


Configuration type: server only


 Host:


 RMI port:


Default: 1199


See Section 9.5.3, “Running the 
Lucene Index Server in Its Own 
JVM,” on page 86.


High Availability Lucene 
Configuration: 


Configuration type: high availability 
only


Number of high availability search 
nodes:


 Service name:


 Service title:


 Host:


 RMI port:


 Service name:


 Service title:


 Host:


 RMI port:


See Chapter 16, “Running Multiple 
Lucene Index Servers,” on 
page 131.


RSS Configuration: 


Enable RSS: No / Yes


 Max elapsed days:


 Max inactive days:


See Section 9.6, “Managing RSS 
Feeds,” on page 86.


Presence Configuration: 


Enable presence: No / Yes


 Server address:


 Port:


 Server user:


 Password:


 Server Certificate:


See Section 9.7, “Configuring 
Presence,” on page 87.


Installation Program Field Value for Your Vibe Site Explanation
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Conferencing Configuration: 


Enable Conferencing: No / Yes


 Conferencing URL:


See Section 9.7, “Configuring 
Presence,” on page 87.


Reverse Proxy Configuration: 


Enable Access Gateway: No / Yes


 Access Gateway address(es):


 Logout URL:


 Use Access Gateway for 
WebDav connections: No / Yes


 WebDAV Access Gateway 
address:


See Section 9.8, “Configuring 
Single Sign-On with Novell Access 
Manager,” on page 88.


Integration with IIS for Windows 
Authentication: 


Enable Integration with IIS for 
Windows Authentication: No / Yes


 IIS address(es):


 Logout URL:


See Section 9.9, “Configuring 
Single Sign-On with Internet 
Information Services for Windows,” 
on page 89.


Mirrored Folder Resource Driver 
Configuration: 


Enable file share: No / Yes


 Share type


 File


 WebDav


 Read only: No / Yes


 Title


 Root path


 Allowed users


 Allowed groups


 User


 Password


 Host URL


See Section 9.10, “Configuring 
Mirrored Folder Resource Drivers,” 
on page 102.


Installation Program Field Value for Your Vibe Site Explanation
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IV IVMulti-Server Configurations and 
Clustering


 Chapter 13, “Creating the Vibe Database on a Remote Server,” on page 115
 Chapter 14, “Installing the Lucene Index Server on a Remote Server,” on page 121
 Chapter 15, “Running Vibe on Multiple Servers,” on page 125
 Chapter 16, “Running Multiple Lucene Index Servers,” on page 131
 Chapter 17, “Running Multiple Database Servers,” on page 149

Multi-Server Configurations and Clustering 113







114 Novell Vibe 3.2 Installation Guide







13 13Creating the Vibe Database on a Remote 
Server


The default database location for Novell Vibe is on the same server with the Vibe software, as 
described in Section 3.6.3, “Database Location,” on page 35. However, for better performance and 
scalability, you can install the database server (MySQL, Microsoft SQL, or Oracle) on a remote server, 
then use the scripts that are included with the Vibe software to manually create the Vibe database in 
any location that you prefer.


 Section 13.1, “Preparing to Manually Create a Database,” on page 115
 Section 13.2, “Creating a MySQL Database,” on page 116
 Section 13.3, “Creating a Microsoft SQL Database,” on page 117
 Section 13.4, “Creating an Oracle Database,” on page 118
 Section 13.5, “Installing Vibe with a Remote Database,” on page 119


NOTE: This section assumes that you already have a Basic installation of Vibe up and running 
successfully. We highly recommend that you follow the instructions in Part II, “Basic Installation,” on 
page 23 before attempting a more complex Vibe configuration.


13.1 Preparing to Manually Create a Database
Novell Vibe includes scripts for creating the Vibe database on a remote server.


1 Copy the teaming-3.1.n-sql.zip file from the Vibe server where the Vibe installation 
program is located and copy it to the database server.
or
Download and unzip the Vibe software onto the database server.


2 In the directory where the Vibe Installation program is located on the database server, or in the 
location where you copied the teaming-3.1.n-sql.zip file, unzip the teaming-3.1.n-
sql.zip file.
This creates two new subdirectories, the create subdirectory for database creation scripts and 
the update-3.0.n-3.1.n directory for database update scripts.


3 Change to the create subdirectory.
4 Copy all the scripts for your database type to a convenient temporary location on the server 


where you want to create the database, and make sure that your database management utility is 
on your path so that you can run it from that directory
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5 Continue with the instructions for the type of database that you want to create:
 Section 13.2, “Creating a MySQL Database,” on page 116
 Section 13.3, “Creating a Microsoft SQL Database,” on page 117
 Section 13.4, “Creating an Oracle Database,” on page 118


13.2 Creating a MySQL Database
Before you begin, you should be familiar with standard database maintenance procedures.


For more information about MySQL, see the following references:


 MySQL 5.0 Reference Manual (http://dev.mysql.com/doc/refman/5.0/en)
 MySQL 5.1 Reference Manual (http://dev.mysql.com/doc/refman/5.1/en)


The following database tools can be helpful:


 MySQL GUI Tools (http://dev.mysql.com/downloads/gui-tools)
 SQLyog (http://www.webyog.com)
 Squirrel SQL Client (http://squirrel-sql.sourceforge.net)


1 Review the MySQL requirements listed in Section 2.1, “Vibe Server Requirements,” on page 17.
2 Make sure that the MySQL database server and client have been installed and configured, as 


described in Section A.2, “MySQL Database Server,” on page 193.
3 Make sure that the MySQL database client is also installed on the Vibe server.


The Vibe installation program needs the MySQL client in order to communicate with the remote 
MySQL database server.


4 Make sure that you know the password for the MySQL root administrator user.
5 Make sure that innodb support is enabled. 


It is enabled by default. To verify that innodb support is enabled:
5a Enter the following command to access the MySQL monitor:


mysql -u root -p


For information on how to set a password for your MySQL database if you have not already 
done so, see “Configuring MySQL” on page 194.


5b Specify your password.
5c From the MySQL prompt, enter the following command to display status information 


about the server’s storage engines:


SHOW ENGINES\G


5d Locate the InnoDB engine, and ensure that innodb support is enabled.


Database Database Script Database Management Utility


MySQL *mysql.sql mysql


Microsoft SQL *sqlserver.sql osql


Oracle *oracle.sql sqlplus
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6 Update the MySQL configuration file:
6a Locate the MySQL configuration file and open it in a text editor.


6b Under the [client] section, add the following line:


default_character_set = utf8


6c Under the [mysqld] section, add the following line:


character_set_server = utf8


Setting the character set to UTF-8 ensures that extended characters are handled correctly in 
the database.


6d (Conditional) For a system with multiple network interfaces, in the [mysqld] section, add 
the following line:


bind-address = mysql_server_address


Replace mysql_server_address with the IP address that you want MySQL to bind to and 
to listen on.


6e Save the updated configuration file, then exit the text editor.
7 In the directory where you copied the database scripts (Step 4 in Section 13.1, “Preparing to 


Manually Create a Database,” on page 115), enter the following command to run the MySQL 
database creation script:


mysql -uuser -ppassword < create-database-mysql.sql


8 Configure MySQL to allow access from a remote server:


mysql -uuser -ppassword
mysql> grant all privileges on *.* 


-> to 'username'@'%'
-> identified by 'password' 
-> with grant option
-> ;


9 Skip to Section 13.5, “Installing Vibe with a Remote Database,” on page 119.


13.3 Creating a Microsoft SQL Database
Before you begin, you should be familiar with standard database maintenance procedures.


For more information about Microsoft SQL, see the following references:


 Microsoft SQL Server 2008 Learning Resources (http://www.microsoft.com/sqlserver/2008/en/
us/learning.aspx)


 Microsoft SQL Server 2005 Learning Resources (http://www.microsoft.com/sqlserver/2005/en/
us/learning-resources.aspx)


The following database tool can be helpful:


 Squirrel SQL Client (http://squirrel-sql.sourceforge.net)


Linux: /etc/my.cnf


Windows: c:\Program Files\MySQL\MySQL Server version\my.ini
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To create a Microsoft SQL database:


1 Review the Microsoft SQL requirements listed in Section 2.1, “Vibe Server Requirements,” on 
page 17.


2 Make sure that the Microsoft SQL Server and Client have been installed and configured 
properly.


IMPORTANT: Make sure that TCP/IP is enabled for the Microsoft SQL Server.


For more information, see “Microsoft SQL Server” (http://msdn.microsoft.com/en-us/library/
bb545450.aspx).


3 Make sure that the Microsoft SQL database client is also installed on the Vibe server.
The Vibe installation program needs the Microsoft SQL client in order to communicate with the 
remote Microsoft SQL database server.


4 When you install Microsoft SQL Server, select SQL Server and Windows for authentication.
The default is Windows Only, which is not appropriate for Vibe.


5 Immediately establish the database administrator username and password for the SQL database 
server.


6 Change to the directory where you copied the database scripts in Step 4 in Section 13.1, 
“Preparing to Manually Create a Database,” on page 115.


7 Enter the following command to run the Microsoft SQL database creation script:


osql -Uuser -Ppassword -i create-database-sqlserver.sql


8 Skip to Section 13.5, “Installing Vibe with a Remote Database,” on page 119.


13.4 Creating an Oracle Database
When you use an Oracle database, your database administrator must create it for you. The Novell 
Vibe installation program cannot create an Oracle database.


Before you begin, you should be familiar with standard database maintenance procedures.


For more information about your Oracle database, see the following references:


 Oracle Product Documentation (http://www.oracle.com/technetwork/indexes/documentation/)
 Oracle SQL Plus Documentation (http://download.oracle.com/docs/cd/B19306_01/server.102/


b14357/toc.htm)


The following database tool can be helpful:


 Squirrel SQL Client (http://squirrel-sql.sourceforge.net)


1 Review the Oracle database requirements listed in Section 2.1, “Vibe Server Requirements,” on 
page 17.


2 Make sure that the Oracle database server software has been installed and configured properly.
For more information, see Oracle Database (http://www.oracle.com/database).


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Database Creation, make sure you have marked that you want your database administrator to 
manually create the Oracle database before installation.
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3 Set up the Oracle database character set to support Unicode character encodings. 
Vibe requires either the UTF-8 or AL32UTF8 character set for proper operation. Oracle 
recommends AL32UTF8, because it has increased support for certain Asian languages. For more 
information, see “Choosing a Character Set” (http://download.oracle.com/docs/cd/B19306_01/
server.102/b14225/ch2charset.htm) in the Oracle Database Globalization Support Guide.


4 Change to the directory where you copied the Oracle database scripts in Step 4 in Section 13.1, 
“Preparing to Manually Create a Database,” on page 115.


5 Edit the create-database-oracle.sql script with your Oracle database password.
Original: 


drop user sitescape cascade;
create user sitescape identified by sitescape;
grant connect, resource to sitescape;
connect sitescape/sitescape;


SiteScape is the name of the company that previously owned the Vibe software. 
Updated: 


drop user sitescape cascade;
create user sitescape identified by your_oracle_password;
grant connect, resource to sitescape;
connect sitescape/your_oracle_password;


IMPORTANT: Unless you are very familiar with editing scripts, change only the password. Do 
not attempt to change the name of the database from the legacy default of sitescape.


6 Enter the following commands to run the database creation script:


sqlplus "/ as sysdba"
SQL> spool create-database-oracle.out;
SQL> @create-database-oracle;
SQL> quit


7 Check the resulting create-database-oracle.out file for errors and resolve them.
8 If you created the Oracle database on the Vibe server, skip to Chapter 4, “Installing and Setting 


Up a Basic Vibe Site,” on page 49 or Chapter 10, “Performing an Advanced Vibe Installation,” on 
page 105.


IMPORTANT: On the Database Selection page in the Installation program, be sure to select 
Database already exists or has already been created.


or
If you created the Oracle database on a remote server, continue with Installing Vibe with a 
Remote Database.


13.5 Installing Vibe with a Remote Database
1 Run the Novell Vibe installation program, as described in Chapter 4, “Installing and Setting Up 


a Basic Vibe Site,” on page 49 or Chapter 10, “Performing an Advanced Vibe Installation,” on 
page 105.


2 Fill in the fields on the Database Selection page:
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Database type: Select the type of database that you just created.
JDBC URL: Replace localhost, with the hostname of the server where you created the Vibe 
database. If needed, replace the port number with the port that Vibe uses to communicate with 
the database, and replace the database name with the name of your database.
Credentials: Specify the password for the database administrator user.
Setup: Select Database already exists or has already been created so that the installation program 
does not create one for you.
Encryption algorithm: Set the encryption appropriate for the security needs of the Vibe site. For 
more information, see Section 3.6.5, “Database Encryption Algorithm,” on page 36.


3 Click Next.
The Vibe installation program tries to connect to the database. If it connects successfully, you can 
continue with the installation. If the Vibe installation program cannot connect to the database, 
you must resolve the problem with the database before you can continue with the Vibe 
installation.


4 When the Vibe installation program can successfully connect to the remote database, continue as 
usual with the installation.
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14 14Installing the Lucene Index Server on a 
Remote Server


You can install the Lucene Index Server on a different server from where Novell Vibe is running. If 
the Lucene Index Server is already running on the same server as Vibe, you can move the Lucene 
Index Server to a different server. 


Running the Lucene Index Server on a remote server allows both the Lucene Index Server and the 
Vibe server to have access to more server memory, disk space, and CPU resources.


Complete the following sections whether you are installing the Lucene Index Server on a remote 
server, or moving the Lucene Index Server to a remote server.


IMPORTANT: The Vibe server and the Lucene Index Server must not have a firewall between them. 
The RMI protocol used for the Lucene Index Server port works only within a trusted local area 
network (LAN).


 Section 14.1, “Installing the Lucene Software,” on page 121
 Section 14.2, “Updating Your Vibe Site,” on page 123
 Section 14.3, “Managing a Remote Lucene Index Server,” on page 123


NOTE: This section assumes that you already have a Basic installation of Vibe up and running 
successfully. We highly recommend that you follow the instructions in Part II, “Basic Installation,” on 
page 23 before attempting a more complex Vibe configuration.


14.1 Installing the Lucene Software
1 Make sure that the Java Developer Kit (JDK) is installed on the remote server where you want to 


install the Lucene Index Server.
You must use the same JDK that is being used on the server where Vibe is running. For example, 
if you are using the IBM JDK on the server where Vibe is running, you must use the IBM JDK on 
the remote Lucene Index Server.
For instructions, see Appendix A, “Vibe System Requirements Assistance,” on page 191.


2 Make sure that there is no firewall between the Vibe server and the Lucene Index Server.
3 Copy the Lucene installation program from its original location in the same directory with the 


Vibe installation program to a convenient temporary directory on the remote server.
The filename for the Lucene Installation program varies by platform:


Linux: lucene-installer.linux


Windows: lucene-installer.exe
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4 Change to the directory where you copied the Lucene installation program, then start it.
5 Accept the License Agreement, then click Next.
6 Select New installation, then click Next.
7 Browse to and select the directory where you want to install the Lucene Index Server, then click 


Next.
The default location varies by platform:


8 Browse to and select the directory where you installed the JDK, then click Next.
9 Adjust the configuration of the Lucene Index Server, as described in Section 9.5, “Changing Your 


Lucene Index Server Configuration,” on page 85, then click Next.
10 Click Install to install the Lucene software.
11 (Conditional) On Linux, deselect Start Lucene server.


You must edit the Lucene Index Server startup script before you start the Lucene Index Server. 
Instructions are provided later in this procedure.


12 (Conditional) On Windows, if you do not want to start the Lucene Index Server immediately, 
deselect Start Lucene server.
For instructions for starting and stopping the Lucene Index Server manually, see Section 14.3, 
“Managing a Remote Lucene Index Server,” on page 123.


13 Click Finish.
14 (Conditional) On Linux:


14a Change to the following directory:


/opt/novell/teaming/luceneserver/indexserver/bin


14b Open the indexserver-startup.sh file in a text editor.
14c Add the following switch to the java launch command at the end of the script:


-Djava.rmi.server.hostname=ip_address


Rename ip_address with the IP address of the server where you installed the Lucene Index 
Server.


14d Save the indexserver-startup.sh file, then exit the text editor.
14e Start the Lucene Index Server.


For instructions for starting and stopping the Lucene Index Server manually, see 
Section 14.3, “Managing a Remote Lucene Index Server,” on page 123.


Moving the Lucene Index Server from the Vibe server to a remote server increases the scalability of 
your Vibe system because the workload is distributed between two different physical servers. 
However, in this configuration, the Lucene Index Server still runs on a single server. Your Vibe site 
depends on the Lucene Index Server for full functionality. If that server goes down for some reason, 
the Vibe site becomes inaccessible until access to the Lucene Index Server is restored. You can further 
expand your Vibe system by setting up multiple Lucene Index Servers to provide high availability, as 
described in Chapter 16, “Running Multiple Lucene Index Servers,” on page 131.


Linux: /opt/novell/teaming/luceneserver


Windows: c:\Program Files\Novell\Teaming\luceneserver
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14.2 Updating Your Vibe Site
Complete this section only if you are moving the Lucene Index Server. If you are performing a fresh 
Lucene Index Server installation, disregard this section.


1 Stop Novell Vibe.
2 Start the Vibe installation program to reconfigure the Lucene Index Server settings.


For information on how to start the installation program, see Section 4.1.2, “Running the Linux 
Vibe Installation Program,” on page 51 or Section 4.2.2, “Running the Windows Vibe Installation 
Program,” on page 59.


3 On the Choose Installation Type page, select Advanced, then click Next.
4 Click Next until you reach the Lucene Configuration page.


5 In the Lucene configuration type field, select server to activate additional fields.
Host: Specify the hostname of the server where you installed the Lucene Index Server software.
RMI Port: Use the same port number that you used when you installed the Lucene Index Server 
software. The default RMI port is 1199.


6 Click Next until you reach the Ready to Install page, then click Install.
7 When the installation is complete, click Finish.
8 Start Vibe.


14.3 Managing a Remote Lucene Index Server
 Section 14.3.1, “Linux: Managing a Remote Lucene Index Server,” on page 123
 Section 14.3.2, “Windows: Managing a Remote Lucene Index Server,” on page 124


14.3.1 Linux: Managing a Remote Lucene Index Server


Use the following commands to start and stop the Lucene Index Server manually:


/etc/init.d/indexserver start
/etc/init.d/indexserver stop


To configure the Lucene Index Server to start automatically when the Linux server reboots, use:


chkconfig --add indexserver
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14.3.2 Windows: Managing a Remote Lucene Index Server


Use the following commands at a DOS command prompt to start and stop the Lucene Index Server 
manually:


c:\Program Files\Novell\Teaming\luceneserver\indexserver\bin\
indexserver-startup.bat


c:\Program Files\Novell\Teaming\luceneserver\indexserver\bin\
indexserver-shutdown.bat


To configure the Lucene Index Server to start automatically when the Windows server reboots, you 
can set it up as a scheduled task that runs at system startup.


1 On the Windows server where the Lucene Index Server is installed, click Start > All Programs > 
Accessories > System Tools > Scheduled Tasks.


2 Double-click Add Scheduled Task. to open the Scheduled Task Wizard, then click Next to continue.
3 Click Browse, then browse to and double-click the indexserver-startup.bat file in the 


following directory:


c:\Program Files\Novell\Teaming\luceneserver\indexserver\bin


4 In the Task name field, specify an informative name for the task, such as Lucene Index Server.
The default task name is the name of the batch file.


5 In the Perform this task field, select When my computer starts, then click Next.
6 Specify and confirm the Administrator password for the Windows server, then click Next.
7 Select Open advanced properties for this task when I click Finish, then click Finish.
8 Verify that Run only if logged on is deselected, then click OK.


A new task with the name you specified in Step 4 is added to the list in the Scheduled Tasks 
window.


9 Click File > Exit to close the Scheduled Task Wizard.
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15 15Running Vibe on Multiple Servers


By running Novell Vibe on multiple servers, you can achieve high availability, including failover and 
load balancing, depending on how you configure your servers. You must perform an Advanced 
installation on each server in order to configure the Vibe software for such a clustered environment. 


 Section 15.1, “Planning a Multi-Server Vibe Configuration,” on page 125
 Section 15.2, “Installing the Vibe Software on Multiple Servers,” on page 126
 Section 15.3, “Configuring a Web Application to Provide High Availability Functionality for 


Your Vibe Site,” on page 128
 Section 15.4, “Configuring Internet Information Services to Support Multiple Vibe Servers,” on 


page 130


NOTE: This section assumes that you already have a Basic installation of Vibe up and running 
successfully. We highly recommended that you follow the instructions in Part II, “Basic Installation,” 
on page 23 before attempting a more complex Vibe configuration.


15.1 Planning a Multi-Server Vibe Configuration
 Section 15.1.1, “Lucene Index Server Considerations,” on page 125
 Section 15.1.2, “Vibe File Repository Considerations,” on page 125
 Section 15.1.3, “Configuring Routing for Multicast IP on the Vibe Server,” on page 126


15.1.1 Lucene Index Server Considerations


Before you can implement a multi-server Novell Vibe configuration, you must move your Lucene 
Index Server away from the initial Vibe server, as described in Chapter 14, “Installing the Lucene 
Index Server on a Remote Server,” on page 121. 


15.1.2 Vibe File Repository Considerations


Before you implement a multi-server Novell Vibe configuration, you must plan the Vibe file 
repository for the clustered Vibe servers. Your configuration must comply with the following 
restrictions:


 The Vibe file repository must be placed in a shared location that is accessible to each Tomcat 
instance.


 All Tomcat instances must be configured with the same path leading to the shared storage.


For background information on the contents of the Vibe file repository, see Section 9.2, “Distributing 
Different Data Types to Different Locations,” on page 82.
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15.1.3 Configuring Routing for Multicast IP on the Vibe Server


If you are planning to use ehcache as your hibernate caching provider, you might need to set up the 
routing for multicast IP on each server where Vibe is installed. If this is not done, then depending on 
your Vibe system, you might see a communication error when you start the Vibe server. For example, 
in the log file you might see the following:


Error starting heartbeat. Error was: No such device.


To prevent this error, or to fix the Vibe system after the error occurs:


1 Run the following command:


route add -net 232.0.0.0/8 dev eth0


15.2 Installing the Vibe Software on Multiple Servers
1 Update your existing Novell Vibe server to participate in a multi-server configuration:


1a Stop Vibe.
1b Start the Vibe Installation program.


For information on how to start the installation program, see Section 4.1.2, “Running the 
Linux Vibe Installation Program,” on page 51 or Section 4.2.2, “Running the Windows Vibe 
Installation Program,” on page 59.


1c On the Installation Settings page, select Reconfigure Settings, then click Next.
1d On the Choose Installation Type page, select Advanced, then click Next.
1e Click Next to proceed through the installation pages where no changes are needed.
1f (Conditional) If you do not have the Basic Vibe Installation Summary Sheet and Advanced 


Vibe Installation Summary Sheet from the initial Vibe server installation, record the 
configuration of the initial Vibe server as you proceed through the installation pages.
Subsequent Vibe servers in the multi-server configuration must be installed with the same 
configuration settings as the initial Vibe server.


1g On the Vibe Cluster Configuration page, select Enable clustered environment to enable 
clustering.


1h On the first Vibe node, in the JVM Route field, specify worker1. On the second Vibe node, in 
the JVM Route field, specify worker2, and so forth for each Vibe node, incrementing the 
JVM Route setting. Each tomcat instance should have a unique JVM Route setting.
worker1, worker2, and so forth are the default names for the matching values used for the 
reverse proxy configuration. For example, if you have set up Apache or IIS as a reverse 
proxy, these are the default values. The JVM Route setting in the Vibe installer must match 
these values.


1i  Select one of the following options for your hibernate caching provider:
ecache: Ecache is recommended for small clustered Vibe sites, and is included in the Vibe 
software. If you select this option, no further configuration is necessary. For more 
information, see Ehcache (http://ehcache.sourceforge.net).
memcached: Memcached is recommended for medium to large clustered Vibe sites. 
Memcached is not included in the Vibe software. If you select this option, you must 
download and install memcached on each server in your Vibe cluster. For information 
about downloading and installing memcached, see Memcached (http://
software.opensuse.org).
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Depending on the cache provider you select, different options are displayed.


1j (Conditional) If you selected ehcache as the hibernate caching provider in Step 1g, specify 
the following information on the Vibe Cluster Configuration page to configure ehcache:
Network interface for distributed cache service: Specify the IP address or hostname of the 
distributed cache service.
Multicast Group Address: (Optional) Specify the common multicast group IP address. 
Each clustered node recognizes other nodes in the cluster by means of this IP address.


IMPORTANT: Make sure you specify the same IP address on all Vibe nodes in the cluster. 
After you have set this IP address for each Vibe node, restart each node in succession, 
allowing each node to initialize before restarting the next.


The default multicast group IP address is 232.0.0.1. If you have more than one clustered 
Vibe system (for example, one in the lab and one in production), or if you have another 
software product that is already using the default multicast group IP address, you must 
update this field for one system so that it uses an IP address other than the default.
Use an IP address in the range of 224.0.0.1 to 239.255.255.255.
Multicast Group Port: (Optional) Specify the port number through which the Vibe nodes 
will communicate.


1k (Conditional) If you selected memcached as the hibernate caching provider in Step 1g, 
specify the following information on the Vibe Cluster Configuration page to configure 
memcached:
Server Addresses: Specify a list of memcached servers, with each server separated by a 
space. For example, hostname1:port hostname2:port hostname3:port
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Memcached is not included in the Vibe software. If you select memcached as your hibernate 
caching provider, you must download and install memcached on each server in your Vibe 
cluster. For information about downloading and installing memcached, see Memcached 
(software.opensuse.org).


1l On the Ready to Install page, click Install.
1m On the Installation Complete page, click Finish.


2 Install the Vibe software on each additional server, using the same installation settings that you 
used for the initial Vibe server.


3 On each Linux server where you installed the Vibe software, set the multicast route to enable the 
servers to function as a cluster:
3a Use the following command on the command line to immediately set the multicast route 


for the server:


route add -net 232.0.0.0/8 dev eth0


3b To run this command each time the server reboots, add the command to the following file 
on each server:


/etc/init.d/boot.local


4 Start Vibe on each server, as described for the platform where you are installing Vibe:
 Section 4.1.7, “Starting Vibe on Linux,” on page 56
 Section 4.2.4, “Running Vibe as a Windows Service,” on page 61
 Section 4.2.5, “Running Vibe as a Windows Application,” on page 62


5 (Conditional) If you set up ehcache as the caching provider and the Vibe servers fail to start 
because of a communication error, ensure that you have followed the steps in Section 15.1.3, 
“Configuring Routing for Multicast IP on the Vibe Server,” on page 126.


6 Continue with Configuring a Web Application to Provide High Availability Functionality for 
Your Vibe Site.


15.3 Configuring a Web Application to Provide High Availability 
Functionality for Your Vibe Site
After Novell Vibe is installed and running on multiple servers, you must provide additional software 
to provide high availability functionality. Because Vibe is based on Tomcat, you can use software that 
provides high availability for Tomcat.


1 Install and configure one of the following Web applications to provide high availability for your 
Vibe site:
 Apache Web server (http://www.apache.org)
 Linux Virtual Server (http://www.linuxvirtualserver.org)
 Novell Access Manager (https://www.netiq.com/products/access-manager/)
 Microsoft Internet Information Services (http://www.iis.net)


2 Configure the Web application to establish the Vibe site URL, which then stays constant for Vibe 
users regardless of which Vibe server they access at any given time.


3 Start the Web application with its new configuration settings.
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4 Test your Vibe site for high availability.
 If you are using Apache Web server, Linux Virtual Services, or Microsoft Internet 


Information Services, users can immediately log in to the Vibe site again after a failover has 
occurred. The connection between the user’s browser and the Vibe site is maintained as the 
failover occurs.


 If you are using Novell Access Manager, users must start a new browser session, then log in 
to the Vibe site after a failover has occurred. They cannot log in again from the same 
browser session because the connection between the user’s browser and the Vibe site must 
be reestablished after the failover.


The following sections provide examples of how to configure the Web applications:


 Section 15.3.1, “Configuring Tomcat and Apache as a Load Balancer,” on page 129
 Section 15.3.2, “Configuring Linux Virtual Server as a Load Balancer,” on page 130


15.3.1 Configuring Tomcat and Apache as a Load Balancer


The following example configuration uses the balancer module built into the newer Apache (version 
2.2.4 and later) Web server. It is based on a widely used sticky session technique. Novell Vibe does 
not support session sharing/replication among Tomcat instances.


If you are using Novell Access Manager as described in Section 9.8, “Configuring Single Sign-On 
with Novell Access Manager,” on page 88, you do not need to configure Tomcat and Apache to load 
balance as described in this section, because Access Manager provides this service.


NOTE: When you update your Vibe system, these settings are not preserved. You must redefine 
these settings each time you update your Vibe system.


To configure Tomcat and Apache to load balance:


1 Install the Apache Web server (http://httpd.apache.org) on one server.
2 Edit the httpd.conf file in the Apache installation:


The httpd.conf file is located in the conf subdirectory in the Apache installation.
2a Locate and uncomment the following lines:


LoadModule proxy_module modules/mod_proxy.so
LoadModule proxy_ajp_module modules/mod_proxy_ajp.so
LoadModule proxy_balancer_module modules/mod_proxy_balancer.so


2b Append the following section to the httpd.conf file, providing a BalancerMember line for 
each jvmRoute value in a Tomcat server.xml file. 


<Location /balancer-manager>
SetHandler balancer-manager
Order deny,allow
Deny from all
Allow from 127.0.0.1


</Location>
<Proxy balancer://cluster_name>


BalancerMember ajp://vibe_server_1:8009 route=worker1
BalancerMember ajp://vibe_server_2:8009 route=worker2


</Proxy>
<Location />


ProxyPass balancer://cluster_name/ stickysession=JSESSIONID
</Location>
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The values that you specify for the route setting (for example, worker1, worker2, etc.) must 
exactly match the values that you specify as the JVM Route setting during the Vibe 
installation, as described in Section 15.2, “Installing the Vibe Software on Multiple Servers,” 
on page 126. 


2c Save the httpd.conf file.
3 Reconfigure each Vibe server in the cluster so that each server has the same hostname as the 


Apache Web server.
For information on how to reconfigure your Vibe server, see Chapter 11, “Setting Configuration 
Options after Installation,” on page 107.


4 Restart Tomcat and Apache.


TIP: For enhanced performance when using the Internet Explorer browser to access a Vibe system 
that is using Apache as an SSL reverse-proxy server, change the Apache SSL exclusion regular 
expression configuration from the following:


SetEnvIf User-Agent ".*MSIE.*" \
nokeepalive ssl-unclean-shutdown \
downgrade-1.0 force-response-1.0


to the following:


SetEnvIf User-Agent ".*MSIE [1-5].*"
nokeepalive ssl-unclean-shutdown
downgrade-1.0 force-response-1.0


SetEnvIf User-Agent ".*MSIE [6-9].*"
ssl-unclean-shutdown


15.3.2 Configuring Linux Virtual Server as a Load Balancer


Consult the following online sources for instructions for setting up Linux Virtual Server as a load 
balancer for your Novell Vibe site:


 The Linux Virtual Server Project (http://www.linuxvirtualserver.org)
 Linux Virtual Server (LVS) Project (http://www.austintek.com/LVS)
 Linux Virtual Server Tutorial (http://www.ultramonkey.org/papers/lvs_tutorial/html)


15.4 Configuring Internet Information Services to Support 
Multiple Vibe Servers
You can configure Internet Information Services (IIS) to support multiple Novell Vibe servers. For 
more information, see Section 9.9.9, “Configuring IIS to Load Balance in a Clustered Environment,” 
on page 101.
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16 16Running Multiple Lucene Index Servers


Your Novell Vibe site depends on the Lucene Index Server for full functionality. Different Lucene 
configurations provide different levels of scalability and reliability.


You can install the Lucene Index Server on a different server from where Vibe is running so that both 
programs have access to more server memory, disk space, and CPU resources. However, the Vibe 
server and the Lucene Index Server must not have a firewall between them. The RMI protocol used 
for the Lucene Index Server port works only within a trusted local area network (LAN).


 A Basic installation of Vibe places the Lucene Index Server on the same server where the Vibe 
software is installed.


 To provide additional memory for the Lucene Index Server, you might already have configured 
it to run in its own memory space, as described in Section 9.5.3, “Running the Lucene Index 
Server in Its Own JVM,” on page 86. 


 To provide additional disk space and memory for the Lucene Index Server, you might already 
have moved it to a different server, as described in Chapter 14, “Installing the Lucene Index 
Server on a Remote Server,” on page 121.


These configurations provide additional resources for the Lucene Index Server, but it is still a single 
point of failure for your Vibe site. If the Lucene Index Server goes down, the Vibe site becomes 
inaccessible until access to the Lucene Index Server is restored.


Running multiple Lucene Index Servers provides high availability functionality, so that if one Lucene 
Index Server goes down, Vibe users can still access the Vibe site because other Lucene Index Servers 
are still available.


 Section 16.1, “Planning a High Availability Lucene Configuration,” on page 131
 Section 16.2, “Setting Up a High Availability Lucene Configuration,” on page 132
 Section 16.3, “Testing Your Lucene High Availability Configuration,” on page 144
 Section 16.4, “Synchronizing a High Availability Lucene Configuration,” on page 146


NOTE: This section assumes that you already have a Basic installation of Vibe up and running 
successfully. We highly recommend that you follow the instructions in Part II, “Basic Installation,” on 
page 23 before attempting a more complex Vibe and Lucene configuration.


16.1 Planning a High Availability Lucene Configuration
A high availability Lucene Index Server configuration must include at least two different servers 
(either physical or virtual), referred to as “nodes” in the Vibe installation program. Lucene nodes in a 
high availability configuration can be set up on Linux servers, Windows servers, or both.


Each Lucene node must have its own independent directory structure for index files. The default 
location for the index files for the Lucene Index Server varies by platform:
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As you plan your high availability Lucene configuration, you can use the Advanced Vibe Installation 
Summary Sheet to record the options you want to use.


Each Lucene node needs a unique name, a descriptive title, and a static IP address. The name and title 
identify the node in the Vibe administrative interface. Typically, the Lucene Index Server listens on 
RMI port 1199 on its server, but you can configure it to use a different port number if the default port 
number is already in use.


If you have already accumulated index data on your initial Vibe server, you can choose to copy the 
index files to the Lucene nodes, or you can reindex the Vibe site after the new Lucene nodes are 
running. Depending on the amount of accumulated index data, reindexing can be a time-consuming 
process.


The Vibe server and the Lucene nodes must not have a firewall between them. The RMI protocol used 
for the Lucene Index Server port works only within a trusted local area network (LAN).


16.2 Setting Up a High Availability Lucene Configuration
 Section 16.2.1, “Changing from a Local Lucene Index Server,” on page 132
 Section 16.2.2, “Changing from a Single Remote Lucene Index Server,” on page 135
 Section 16.2.3, “Expanding an Existing High Availability Lucene Configuration,” on page 138
 Section 16.2.4, “Changing Your Lucene Configuration without Vibe Site Down Time,” on 


page 140


16.2.1 Changing from a Local Lucene Index Server


To change from a local Lucene Index Server running on the Novell Vibe server, you must install the 
Lucene Index Server on two or more remote servers, then reconfigure Vibe for a high availability 
Lucene configuration.


Linux: /var/opt/novell/teaming/lucene


Windows: c:\Novell\Teaming\lucene


ADVANCED VIBE INSTALLATION SUMMARY SHEET


Under High Availability Lucene Configuration, specify the number of Lucene nodes that you want in your 
high availability Lucene configuration.


ADVANCED VIBE INSTALLATION SUMMARY SHEET


Under High Availability Lucene Configuration, specify the name, description, IP address, and RMI port 
number for each Lucene node.
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NOTE: Although it is possible to use the Lucene Index Server on the Vibe server as one of the 
“remote” Lucene nodes, this is not a recommended configuration. Consider it only if you are 
restricted to two servers for your Vibe site.


1 Set up two or more Lucene nodes:
1a Install the Lucene Index Server on each node, as described in Section 14.1, “Installing the 


Lucene Software,” on page 121.
1b (Optional) Copy accumulated index data from the initial Lucene Index Server to each 


additional Lucene node.
The default location for the index files varies by platform:


1c Start the Lucene Index Server on each Lucene node, as described in Section 14.3, “Managing 
a Remote Lucene Index Server,” on page 123.


2 Stop Vibe.
If you have installed the Vibe software on multiple servers, as described in Chapter 15, 
“Running Vibe on Multiple Servers,” on page 125, stop Vibe on all servers, or follow the 
instructions in Section 16.2.4, “Changing Your Lucene Configuration without Vibe Site Down 
Time,” on page 140.


3 Run the Vibe installation program to configure the Vibe server for multiple Lucene nodes:
3a On the Installation Settings page, select Reconfigure Settings, then click Next.
3b On the Choose Installation Type page, select Advanced, then click Next.
3c Click Next to proceed through the installation pages where no changes are needed.
3d On the Lucene Configuration page, fill in the following fields:


Lucene configuration type: Select high availability.
Number of high availability search nodes: Specify the number of Lucene nodes where 
you have installed and started the Lucene Index Server.


3e Click Next.


Linux: /var/opt/novell/teaming/lucene


Windows: c:\Novell\Teaming\lucene
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3f On the Configure High Availability Search Nodes page, specify the configuration 
information for each Lucene node from the Advanced Vibe Installation Summary Sheet that 
you filled out in Section 16.1, “Planning a High Availability Lucene Configuration,” on 
page 131, then click Next.


3g Click Next until you reach the Ready to Install page, then click Install.
3h On the Installation Complete page, click Finish.
3i Start Vibe.
3j (Conditional) If you have multiple Vibe servers, repeat Step 3 on each Vibe server.


4 Configure the Vibe site for the additional Lucene nodes:
4a Log in to the Vibe site as the Vibe administrator.


4b Click the Settings icon  in the upper right corner of the page, then click the 


Administration Console icon .
4c Under Search Index, click Nodes.
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By default, the first Lucene node in the list has Read and Write access, meaning that Vibe 
updates it as new content is added to the Vibe site. By default, subsequent nodes in the list 
have Write Only access, meaning that the Vibe software can update content on the server, 
but users cannot access it. This setting is useful when you need to perform maintenance on 
a Lucene node, but it is not the setting you want when you set up a new Lucene node.


4d In the User Mode Access box, select Read and Write for all Lucene nodes, click Apply, then 
click Close.
The new setting is put into effect immediately, so that users immediately have access to the 
additional Lucene nodes.


5 Skip to Section 16.3, “Testing Your Lucene High Availability Configuration,” on page 144.


16.2.2 Changing from a Single Remote Lucene Index Server


To change from a single remote Lucene Index Server to a high availability configuration, you must 
install the Lucene Index Server on one or more additional remote servers, then reconfigure Novell 
Vibe for additional Lucene nodes.


1 Bring down your Vibe site:
1a Stop Vibe.


If you have installed the Vibe software on multiple servers, as described in Chapter 15, 
“Running Vibe on Multiple Servers,” on page 125, stop Vibe on all servers, or follow the 
instructions in Section 16.2.4, “Changing Your Lucene Configuration without Vibe Site 
Down Time,” on page 140.


1b Make sure that the existing remote Lucene Index Server also stops.
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2 Set up one or more additional Lucene nodes:
2a Install the Lucene Index Server on each additional remote server, as described in 


Section 14.1, “Installing the Lucene Software,” on page 121.
2b (Optional) Copy accumulated index data from the initial remote Lucene node to each 


additional Lucene node.
The default location for the index files varies by platform:


2c Start the Lucene Index Server on each Lucene node, as described in Section 14.3, “Managing 
a Remote Lucene Index Server,” on page 123, but do not bring up your Vibe site.


3 Run the Vibe installation program to configure the Vibe server for multiple Lucene nodes:
3a On the Installation Settings page, select Reconfigure Settings, then click Next.
3b On the Choose Installation Type page, select Advanced, then click Next.
3c Click Next to proceed through the installation pages where no changes are needed.
3d On the Lucene Configuration page, fill in the following fields:


Lucene configuration type: Change server to high availability.
Number of high availability search nodes: Specify the number of Lucene nodes where 
you have installed the Lucene Index Server.


3e Click Next.
3f On the Configure High Availability Search Nodes page, specify the configuration 


information for each Lucene node from the Advanced Vibe Installation Summary Sheet that 
you filled out in Section 16.1, “Planning a High Availability Lucene Configuration,” on 
page 131, then click Next.


Linux: /var/opt/novell/teaming/lucene


Windows: c:\Novell\Teaming\lucene
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3g Click Next until you reach the Ready to Install page, then click Install.
3h On the Installation Complete page, click Finish.
3i Start Vibe.
3j (Conditional) If you have multiple Vibe servers, repeat Step 3 on each Vibe server.


4 Configure the Vibe site for the additional Lucene nodes:
4a Log in to the Vibe site as the Vibe administrator.


4b Click the Settings icon  in the upper right corner of the page, then click the 


Administration Console icon .
4c Under Search Index, click Nodes.
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By default, the first Lucene node in the list has Read and Write access, meaning that Vibe 
updates it as new content is added to the Vibe site. By default, subsequent nodes in the list 
have Write Only access, meaning that the Vibe software can update content on the server, 
but users cannot access it. This setting is useful when you need to perform maintenance on 
a Lucene node, but it is not the setting you want when you set up a new Lucene node.


4d In the User Mode Access box, select Read and Write for all Lucene nodes.
4e Click Apply, then click Close.


The new setting is put into effect immediately, so that users immediately have access to the 
additional Lucene nodes.


5 Skip to Section 16.3, “Testing Your Lucene High Availability Configuration,” on page 144.


16.2.3 Expanding an Existing High Availability Lucene Configuration


After you have set up an initial high availability Lucene configuration, you can add additional 
Lucene nodes at any time.


1 Bring down your Vibe site:
1a Stop Vibe.


If you have installed the Vibe software on multiple servers, as described in Chapter 15, 
“Running Vibe on Multiple Servers,” on page 125, stop Vibe on all servers, or follow the 
instructions in Section 16.2.4, “Changing Your Lucene Configuration without Vibe Site 
Down Time,” on page 140.


1b Stop all Lucene nodes, as described in Section 14.3, “Managing a Remote Lucene Index 
Server,” on page 123.


2 Set up one or more additional Lucene nodes:
2a Install the Lucene Index Server on each additional remote server, as described in 


Section 14.1, “Installing the Lucene Software,” on page 121.
2b (Optional) Copy accumulated index data from an existing Lucene node to each additional 


Lucene node.
The default location for the index files varies by platform:


2c Start the Lucene Index Server on each Lucene node, as described in Section 14.3, “Managing 
a Remote Lucene Index Server,” on page 123, but do not bring up your Vibe site.


3 Run the Vibe installation program to configure the Vibe server for the additional Lucene nodes:
3a On the Installation Settings page, select Reconfigure Settings, then click Next.
3b On the Choose Installation Type page, select Advanced, then click Next.
3c Click Next to proceed through the installation pages where no changes are needed.
3d On the Lucene Configuration page, increase the number of nodes in the Number of high 


availability search nodes field, then click Next.


Linux: /var/opt/novell/teaming/lucene


Windows: c:\Novell\Teaming\lucene
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3e On the Configure High Availability Search Nodes page, specify the configuration 
information for each additional Lucene node, then click Next.


3f Click Next until you reach the Ready to Install page, then click Install.
3g On the Installation Complete page, click Finish.
3h Start Vibe.
3i (Conditional) If you have multiple Vibe servers, repeat Step 3 on each Vibe server.


4 Configure the Vibe site for the additional Lucene nodes:
4a Log in to the Vibe site as the Vibe administrator.


4b Click the Settings icon  in the upper right corner of the page, then click the 


Administration Console icon .
4c Under Search Index, click Nodes.
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By default, the first Lucene node in the list has Read and Write access, meaning that Vibe 
updates it as new content is added to the Vibe site. By default, subsequent nodes in the list 
have Write Only access, meaning that the Vibe software can update content on the server, 
but users cannot access it. This setting is useful when you need to perform maintenance on 
a Lucene node, but it is not the setting you want when you set up a new Lucene node.


4d In the User Mode Access box, select Read and Write for all Lucene nodes.
4e Click Apply, then click Close.


The new setting is put into effect immediately, so that users immediately have access to the 
additional Lucene nodes.


5 Skip to Section 16.3, “Testing Your Lucene High Availability Configuration,” on page 144.


16.2.4 Changing Your Lucene Configuration without Vibe Site Down Time


Vibe site down time can be avoided only if you have installed the Vibe software on multiple servers, 
as described in Chapter 15, “Running Vibe on Multiple Servers,” on page 125.


To change to a high availability Lucene configuration in a multiple Vibe server configuration:


1 Set up two or more Lucene nodes:
1a Install the Lucene Index Server on each node, as described in Section 14.1, “Installing the 


Lucene Software,” on page 121
1b Start the Lucene Index Server on each Lucene node, as described in Section 14.3, “Managing 


a Remote Lucene Index Server,” on page 123.
2 Stop Vibe on one server.


The other Vibe servers remain in service for users and continue to communicate with the 
original Lucene Index Server.


3 Run the Vibe installation program on the Vibe server that you stopped to configure it for 
multiple Lucene Index Servers:
3a On the Installation Settings page, select Reconfigure Settings, then click Next.
3b On the Choose Installation Type page, select Advanced, then click Next.
3c Click Next to proceed through the installation pages where no changes are needed.
3d On the Lucene Configuration page, fill in the following fields.

140 Novell Vibe 3.2 Installation Guide







Lucene configuration type: Select high availability.
Number of high availability search nodes: Specify the number of Lucene nodes where 
you have installed the Lucene Index Server.


3e Click Next.
3f On the Configure High Availability Search Nodes page, specify the configuration 


information for each Lucene node from the Advanced Vibe Installation Summary Sheet that 
you filled out in Section 16.1, “Planning a High Availability Lucene Configuration,” on 
page 131, then click Next.


3g Click Next until you reach the Ready to Install page, then click Install.
3h On the Installation Complete page, click Finish.


4 Start the reconfigured Vibe server.
5 Access the reconfigured Vibe server and prevent access to the additional Lucene nodes:
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IMPORTANT: All Vibe servers must be reconfigured before any of them access the additional 
Lucene nodes.


5a Log in to the reconfigured Vibe server as the Vibe administrator, using the server hostname 
rather than your Vibe site URL.


5b Click the Settings icon  in the upper right corner of the page, then click the 


Administration Console icon .
5c Under Search Index, click Nodes.


By default, the first Lucene node in the list has Read and Write access, meaning that Vibe 
updates it as new content is added to the Vibe site. By default, subsequent nodes in the list 
have Write Only access, meaning that the Vibe software can update content on the server, 
but users cannot access it. When you set up a high availability Lucene configuration 
without Vibe site down time, you need to prevent write access during the reconfiguration 
process.


5d In the User Mode Access box, change Write Only to No Access for the additional Lucene 
nodes.


5e Click Apply, then click Close.
The new setting is put into effect immediately, so that the reconfigured Vibe server does not 
communicate with the additional Lucene nodes. 


6 Reconfigure the rest of the Vibe servers:
6a Stop each Vibe server.
6b Repeat Step 3 to configure each Vibe server for the additional Lucene nodes.
6c Start each reconfigured Vibe server.


7 Access the reconfigured Vibe site and allow write access to the additional Lucene nodes:
7a Log in to the reconfigured Vibe as the Vibe administrator.


7b Click the Settings icon  in the upper right corner of the page, then click the 


Administration Console icon .
7c Under Search Index, click Nodes.
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7d In the User Mode Access box, change No Access to Write Only for the additional Lucene 
nodes.


7e Click Apply, then click Close.
The new setting is put into effect immediately, so that the reconfigured Vibe servers can 
now communicate with the additional Lucene nodes, although user access is still 
disallowed. 


8 Reindex the Vibe site, so that the additional Lucene nodes are updated with the same index data 
that the original Lucene Index Server has:
8a On the Administration page, under Search Index, click Index.


8b On the Manage Search Index tab, select Re-Index Everything, so that the entire Vibe site is 
reindexed.


8c Select the additional Lucene nodes, but do not select any previously existing nodes.
8d Click OK to start the indexing.
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Depending on the size of your Vibe site, reindexing can be a time-consuming process. 
However, because one or more previously existing Lucene Index Servers are still servicing 
the Vibe site, users are not affected by the reindexing process.


8e When the reindexing is completed, click Close.
9 Make the additional Lucene nodes available to Vibe users:


9a On the Administration page, under Search Index, click Nodes.


9b In the User Mode Access box, change Write Access to Read and Write for the additional Lucene 
nodes.


9c Click Apply, then click Close.
The new setting is put into effect immediately, so that Vibe users have additional Lucene 
Index Servers available as they use the Vibe site.


16.3 Testing Your Lucene High Availability Configuration
When you first set up your high availability Lucene configuration, you can configure Novell Vibe to 
write Lucene node information to the Tomcat log file so that you can observe the behavior of the 
Lucene nodes. Then you can take nodes down and bring them up again to see the effect on your Vibe 
site. This process helps you prepare for the situation where a Lucene node goes down unexpectedly 
or you need to take one down on purpose, perhaps for maintenance.


 Section 16.3.1, “Configuring Vibe to Log Lucene Node Activity,” on page 145
 Section 16.3.2, “Observing Lucene Node Activity,” on page 145


NOTE: For background information about the Tomcat log file, see “Tomcat Log File” in “Site 
Maintenance” in the  Novell Vibe 3.2 Administration Guide.
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16.3.1 Configuring Vibe to Log Lucene Node Activity


By default, Vibe writes an error to the Tomcat log file whenever it cannot communicate with a Lucene 
node. For testing purposes, you can change the logging level so that the Tomcat log file includes a 
message for each time Vibe contacts a Lucene Index Server. 


After observing and understanding the behavior, you should return the logging to normal levels.


1 Open the log4j.properties file in a text editor.
The location of the log4j.properties file varies by platform. 


2 Search for the following line:


#log4j.category.com.novell.teaming.search=DEBUG


3 Remove the pound sign (#) from the beginning of the line to activate the DEBUG logging level 
for the Lucene Index Server.
The DEBUG logging level adds a message for each time Vibe contacts a Lucene Index.


4 Save the log4j.properties file, then exit the text editor.
5 Stop Vibe, then start Vibe to put the new logging level into effect.


16.3.2 Observing Lucene Node Activity


After changing the Vibe logging level to include Lucene node activity, you can monitor the Tomcat 
log file to see which Lucene nodes Vibe is contacting.


1 Change to the directory where the Tomcat log file is located.
For background information about the Tomcat log file, see “Tomcat Log File” in “Site 
Maintenance” in the  Novell Vibe 3.2 Administration Guide.


2 On Linux, use the tail command to monitor the end of the Tomcat log file.
tail -f catalina.out


or
On Windows, download an equivalent command from the Internet in order to perform the 
following steps.
For example, there is a command available at SourceForge.net (http://sourceforge.net/projects/
tailforwin32).


3 Perform some activities on the Vibe site to create new content.
For example, you could create a blog entry. The Tomcat log file shows that Vibe is contacting 
each available Lucene Index Server in turn as it submits the new information for indexing. 
Nodes are considered available if they are marked Read and Write in the User Mode Access box on 
the Lucene Nodes page.


4 Bring down one of the Lucene nodes.
For example, you might reboot the Lucene server, stop the Lucene Index Server on the node, or 
otherwise prevent Vibe from contacting the Lucene node.


5 Observe that the Tomcat log file displays an error when the Lucene node becomes unavailable.


Linux: /opt/novell/teaming/apache-tomcat/webapps/ssf/WEB-INF


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF
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6 Perform some additional activities on the Vibe site that create new content.
You might notice a pause as Vibe tries to connect with the Lucene node that is no longer 
available.


7 Observe that the Tomcat log file shows when normal Vibe processing has resumed without 
access to the unavailable Lucene node.


8 Make the unavailable Lucene node available again.
9 Observe that the Tomcat log file indicates that Vibe has created a journal record on the Lucene 


node that was temporarily unavailable.
The journal record contains the indexing operations that failed to take place while the Lucene 
node was unavailable. Even though the Lucene node is back up, Vibe does not start accessing it 
until it has been synchronized with the latest index information.


10 To synchronize the out-of-date Lucene node, follow the steps in Section 16.4, “Synchronizing a 
High Availability Lucene Configuration,” on page 146.
After the out-of-date Lucene node has been synchronized, Vibe starts accessing it again.


If a situation arises where no Lucene node is marked Read and Write in the User Mode Access box on 
the Lucene Nodes page, Vibe temporarily accesses the first node in the list that is set to Write Only. If 
no nodes are set to Write Only or Read and Write, Vibe temporarily access the first node in the list, even 
though it is set to No Access. This functionality is required because you cannot log in to the Vibe site 
without access to a Lucene Index Server.


16.4 Synchronizing a High Availability Lucene Configuration
You should ensure that your Lucene node servers remain in sync with each other. Whenever a 
Lucene node is down for a relatively short period of time (no more than one or two days), you can 
synchronize it with other Lucene nodes whose index files are up-to-date.


1 Make sure that the out-of-date Lucene node is running reliably again.
2 Log in to the Novell Vibe site as the Vibe administrator.


3 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
4 Under Search Index, click Nodes.


5 To repair the out-of-date Lucene node, select Apply Deferred Update Log Records to the Index, then 
click Apply.
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The Deferred Update Log options disappear if the update is successful. If for some reason the 
deferred update log records cannot be applied to the index, you can rebuild the index, as 
described in “Rebuilding the Lucene Index” in “Site Maintenance” in the  Novell Vibe 3.2 
Administration Guide.


6 Click Close.
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17 17Running Multiple Database Servers


Each of the three databases supported by Novell Vibe (MySQL, Microsoft SQL, and Oracle) has its 
own approach to clustering the database server. Information about clustering database servers is 
available on the Internet, for example:


 MySQL Cluster (http://www.mysql.com/products/database/cluster)
 SQL Server Clustering (http://www.sql-server-performance.com/articles/clustering/


clustering_intro_p1.aspx)
 Oracle Real Application Clusters (http://www.oracle.com/technology/products/database/


clustering)


NOTE: We highly recommend that you follow the instructions in Part II, “Basic Installation,” on 
page 23 before attempting a more complex Vibe configuration.
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V VUpdate


 Chapter 18, “What’s New in Novell Vibe 3.x,” on page 153
 Chapter 19, “Updating From Novell Vibe 3.1 to Novell Vibe 3.2,” on page 157
 Chapter 20, “Updating from Novell Vibe 3 to Novell Vibe 3.2,” on page 165
 Chapter 21, “Updating from Novell Vibe 3 to Novell Vibe 3.1,” on page 173
 Chapter 22, “Updating the Operating System Where Vibe Is Running,” on page 179
 Chapter 23, “Migrating Existing Novell Vibe Data into a New Vibe 3.2 System,” on page 181
 Chapter 24, “Migrating from SiteScape Forum or Other Collaboration Software,” on page 187
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18 18What’s New in Novell Vibe 3.x


Novell Vibe is the new name for the product formerly known as Novell Teaming. This section 
describes new features that have been added to Novell Vibe 3.x.


 Section 18.1, “Vibe 3.x User Enhancements,” on page 153
 Section 18.2, “Vibe 3.x Installation Enhancements,” on page 153
 Section 18.3, “Vibe 3.x Administration Enhancements,” on page 153


18.1 Vibe 3.x User Enhancements
For a list of Novell Vibe enhancements and instructions for use, see:


 “What’s New in Novell Vibe 3.x” in the Novell Vibe 3.2 User Guide
 “What’s New in Vibe 3.x”in the Novell Vibe 3.2 Advanced User Guide


18.2 Vibe 3.x Installation Enhancements
 Support for memcached caching (v3.2): Memcached is a high-performance, distributed caching 


system that is suitable for large clustered Vibe systems. For more information, see Section 15.2, 
“Installing the Vibe Software on Multiple Servers,” on page 126.


 Support for Windows Authentication (v3.1): You can configure a single sign-on experience for 
your users when you run Novell Vibe on a Windows server. For more information, see 
Section 9.9, “Configuring Single Sign-On with Internet Information Services for Windows,” on 
page 89.


18.3 Vibe 3.x Administration Enhancements
 Monitor the Vibe Site with JMX (3.2): You can now monitor your Vibe site through JMX. For 


more information, see “Using JMX to Monitor the Vibe Site” in the  Novell Vibe 3.2 Administration 
Guide.


 Disable User Accounts (v3.1): You can disable user accounts rather than delete them. For more 
information, see “Disabling Vibe User Accounts” in the  Novell Vibe 3.2 Administration Guide.


 E-Mail Report (v3.1): You can generate reports for all e-mail messages sent from and into the 
Vibe site, as well as e-mail errors that have been encountered. For more information, see “E-Mail 
Report” in the  Novell Vibe 3.2 Administration Guide.


 Restricting User Access by IP Address (v3.1): You can restrict what information users can 
access when they are outside your corporate firewall. For more information, see “Restricting 
Access Rights of Users Outside the Firewall” in the  Novell Vibe 3.2 Administration Guide.
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 Workspace and Folder Data Quotas (3.1): You can limit the amount of information that can exist 
in specific workspaces and folders. For more information, see “Managing Workspace and Folder 
Data Quotas” in the  Novell Vibe 3.2 Administration Guide.


 Configuring Search Functionality (3.1): You can configure the settings for how items are 
indexed and how searches are executed on the Vibe site. For more information, see 
“Understanding and Configuring Search Functionality” in the  Novell Vibe 3.2 Administration 
Guide.


 Site-Wide Brand: You can create a site-wide brand and manage users’ ability to create 
individual brands on lower-level workspaces. For more information, see “Creating a Site-Wide 
Brand” in the  Novell Vibe 3.2 Administration Guide.


 Default Home Page: You can set a default home page where all users are first taken when they 
access the Novell Vibe site. You can create a separate default home page for visitors. For more 
information, see “Setting a Default Home Page” in the  Novell Vibe 3.2 Administration Guide.


 User and Group Management: When you move or rename users and groups that are being 
synchronized via LDAP, Vibe now recognizes the change and maintains the association between 
the user or group that was moved or renamed and the LDAP server. For more information, see 
“LDAP Attribute to Identify a User or Group” on page 43.


 User Visibility: You can hide one set of users from another set of users. For example, you might 
want to do this if your Vibe site has users from more than one company and you want users to 
see only the users who belong to the same company. For more information, see “Restricting 
Groups of Users from Seeing One Another” in the  Novell Vibe 3.2 Administration Guide.


 Integrations with Novell Messenger: Vibe 3 provides tight integrations with Novell Messenger, 
which allows Vibe users to see who is currently online. Presence icons  are located next to 
users’ names in folder entries. 
Vibe administrators must configure Novell Messenger to work with Novell Vibe, as described in 
“Integrating Messenger with Vibe” in the  Novell Vibe 3.2 Administration Guide.


 Expanded User Profile: The User Profile section in Vibe 3 has been expanded to rival other 
professional knowledgebases such as LinkedIn. Now users can include more information to 
share with their colleagues, such as education, qualifications, and competencies. For more 
information, see “Modifying Your Profile” in the Novell Vibe 3.2 User Guide.
For information about how Vibe administrators can modify the information that is displayed in 
the profile view, see “Customizing the Default User Profile View” in “Setting Up Users’ Personal 
Workspaces” in the  Novell Vibe 3.2 Administration Guide.
If you have modified the User Profile definition for your Vibe site, these changes are not 
displayed when you update to Vibe 3. To display these changes, complete the steps in 
Section 21.4.1, “Resetting Your Definitions,” on page 177.


 Profile Quick View Dialog Box: The Profile Quick View dialog box is displayed when users 
click a user’s Presence icon . It enables them to see information about that user, view the 
user’s micro-blog or workspace, follow the user, and more.
For information about how Vibe administrators can modify the information that is displayed in 
the Profile Quick View, see “Customizing the Default Profile Quick View” in the  Novell Vibe 3.2 
Administration Guide.
If you have modified the User Profile definition for your Vibe site, this dialog box is not 
displayed when you update to Vibe 3. To display these changes, complete the steps in 
Section 21.4.1, “Resetting Your Definitions,” on page 177.
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 Ability to Send Vibe Mail Messages from a Custom Address: You can configure Vibe to send 
e-mail messages from a zone-specific or site-wide address. In previous versions of Vibe, when a 
user sends an e-mail message from Vibe, the message can be shown only as being from that 
specific user.
For more information, see “Configuring Vibe to Send E-Mail Messages and Notifications from a 
Custom Address” in the  Novell Vibe 3.2 Administration Guide.
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19 19Updating From Novell Vibe 3.1 to Novell 
Vibe 3.2


This section describes how to update to Novell Vibe 3.2 from Novell Vibe 3.1. If you are updating 
from a version of Vibe prior to Vibe 3 (Vibe versions prior to Vibe 3 are called Novell Teaming), you 
must first update to Vibe 3 before you can update to Vibe 3.1. For information on how to update to 
Novell Vibe 3, see “Update” in the Novell Vibe OnPrem 3 Installation Guide (http://www.novell.com/
documentation/vibe_onprem3/vibeprem3_inst/data/bookinfo.html).


After you update your Vibe system, make sure that you check on the Vibe download site where you 
downloaded the Vibe software for any hot patches that might be available.


 Section 19.1, “Understanding the Update Process,” on page 157
 Section 19.2, “Updating a Single-Server System from Vibe 3.1 to Vibe 3.2,” on page 158
 Section 19.3, “Updating a Multiple-Server System from Vibe 3.1 to Vibe 3.2,” on page 160
 Section 19.4, “Performing Post-Update Tasks,” on page 162


19.1 Understanding the Update Process
When you update to Novell Vibe 3.2, each user who has used a previous version of Vibe must clear 
his or her browser’s cache, regardless of which browser he or she is using. Not clearing the browser 
cache results in Vibe not displaying correctly.


Ensure that you communicate this to each Vibe user in your system.


During the update from Novell Vibe 3.1 to Vibe 3.2, the following aspects of your Vibe system are 
modified:


 The software is updated from Vibe 3.1 to Vibe 3.2.
 A backup copy of your existing Vibe 3.1 installation is created in the following directory:


If your original Vibe system began with version 1.0 (this version of Novell Vibe is called Novell 
Teaming), the backup copy is located in the following directory:


Linux: /opt/novell/teaming/teaming-backup


Windows: C:\Program Files\Novell\Teaming\teaming-backup


Linux: /opt/icecore


Windows: C:\Program Files\icecore
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19.2 Updating a Single-Server System from Vibe 3.1 to Vibe 3.2
When you update a single-server Novell Vibe installation from Vibe 3.1 to Vibe 3.2, you need to 
update the Vibe software and the Vibe database separately. You can update the software and 
database in whichever order you prefer.


 Section 19.2.1, “Backing Up Vibe Data,” on page 158
 Section 19.2.2, “Updating the Vibe Database from 3.1 to 3.2,” on page 158
 Section 19.2.3, “Updating the Vibe Software,” on page 158


19.2.1 Backing Up Vibe Data


Make sure your Vibe data is backed up before you begin the update process. For information 
regarding the data that needs to be backed up, see “Backing Up Vibe Data” in the  Novell Vibe 3.2 
Administration Guide.


19.2.2 Updating the Vibe Database from 3.1 to 3.2


When updating to Vibe 3.2, The Vibe Installation program does not update the database as part of the 
Vibe software update. Therefore, you must manually run the database update script after you have 
stopped Vibe:


1 Make sure you have a current backup of your Vibe 3.1 system.
2 Stop Vibe.
3 Ensure that no application (such as a command prompt or Windows Explorer) is running on the 


Vibe 3.1 system.
4 Change to the directory where the Vibe 3.2 installation program is located.
5 Unzip the teaming-3.2.n-sql.zip file to create the update-3.1.0-3.2.n directory


The update-3.1.0-3.2.n directory contains an update script for each type of database 
(MySQL, Microsoft SQL, and Oracle).


6 Use the database utility for your database type to run the script:


7 Continue with Section 19.2.3, “Updating the Vibe Software,” on page 158.


19.2.3 Updating the Vibe Software


1 Make sure you have a current backup of your Vibe 3.1 system.
2 Stop Vibe.


MySQL: mysql -uusername -ppassword < /path/update-mysql.sql


Microsoft 
SQL:


osql -Uusername -Ppassword -i update-sqlserver.sql


You can also use the script with the SQL Server Express Utility (http://www.microsoft.com/
downloads/details.aspx?familyid=fa87e828-173f-472e-a85c-
27ed01cf6b02&displaylang=en) to update the database.


Oracle: sqlplus "/ as sysdba"
SQL>spool update-oracle.out;
SQL>@update-oracle
SQL>quit;
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3 Ensure that no application (such as a command prompt or Windows Explorer) is running on the 
Vibe 3.1 system.


4 Copy the installer.xml file from the directory where the Vibe 3.1 Installation program is 
located to the directory where you have extracted the Vibe 3.2 software.
You must obtain a new license-key.xml file when upgrading to Vibe 3.2.
The installer.xml file provides default values when you run the Vibe 3.2 Installation 
program.


5 Start the Vibe 3.2 installation program.
If you need assistance with this task, see the detailed installation instructions for the platform 
where you are updating Vibe:
 Section 4.1.2, “Running the Linux Vibe Installation Program,” on page 51
 Section 4.2.2, “Running the Windows Vibe Installation Program,” on page 59


6 Accept the License Agreement, then click Next.


Because you provided your Vibe 3.1 installer.xml file in the directory with the Vibe 3.2 
installation program, the Update software and settings installation option is selected by default.


7 Click Next to continue.
8 Click Yes to let the Installation program know that you have stopped Vibe.
9 Select the check box to let the installation program know that you have backed up all of your 


data, then click Next.
10 Select Basic or Advanced, depending on the type of Vibe installation you are updating, then click 


Next.
For more information about the differences between basic and advanced installations, see 
Section 3.1, “What Is a Basic Vibe Installation?,” on page 25 and Section 9.1, “What Is an 
Advanced Installation?,” on page 81.


11 Continue through the installation process, retaining or changing configuration information 
depending on the needs of your Vibe 3.2 system.


12 Click Install when you are ready to perform the update.
13 Click Finish when the update is completed.
14 If you have not yet updated the Vibe database, complete Section 19.2.2, “Updating the Vibe 


Database from 3.1 to 3.2,” on page 158 before you start Vibe.
15 Start Vibe 3.2 in the same way that you have been starting Vibe 3.1.


When you start Vibe for the first time after the update, it takes longer to start than usual because 
data in the Vibe database must be updated before the Vibe site is ready to use.
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19.3 Updating a Multiple-Server System from Vibe 3.1 to Vibe 3.2
If your Novell Vibe 3.1 system is distributed across multiple servers, the Vibe 3.2 installation program 
can update Vibe components on the Vibe server, but you must manually update any Vibe 
components that you have placed on remote servers.


 Section 19.3.1, “Backing Up Vibe Data,” on page 160
 Section 19.3.2, “Manual Vibe Database Update,” on page 160
 Section 19.3.3, “Remote Lucene Index Server Update,” on page 161


19.3.1 Backing Up Vibe Data


Make sure your Vibe data is backed up before you begin the update process. For information 
regarding the data that needs to be backed up, see “Backing Up Vibe Data” in the  Novell Vibe 3.2 
Administration Guide.


19.3.2 Manual Vibe Database Update


In order to update a database from Vibe 3.1 to 3.2, you must run the Vibe 3.2 database update script.


1 Stop Vibe.
2 Ensure that no application (such as a command prompt or Windows Explorer) is running on the 


Vibe 3.1 system.
3 Change to the directory where the Vibe 3.1 installation program is located.
4 Unzip the teaming-3.2.n-sql.zip file to create the update-3.1.0-3.2.n directory


The update-3.1.0-3.2.n directory contains an update script for each type of database 
(MySQL, Microsoft SQL, and Oracle).


5 Copy the script for your database type to the server where the Vibe database is located.
6 (Conditional) If you have multiple Oracle databases, you must edit the update-oracle.sql 


script and add @database_name to the first line of the script. For example, connect sitescape/
sitescape@vibe.


7 Use the database client utility for your database type to run the script:


8 After you have updated the database from Vibe 3.1 to Vibe 3.2:


MySQL: mysql -uusername -ppassword < /path/update-mysql.sql


Microsoft 
SQL:


osql -Uusername -Ppassword -i update-sqlserver.sql


You can also use the script with the SQL Server Express Utility (http://www.microsoft.com/
downloads/details.aspx?familyid=fa87e828-173f-472e-a85c-
27ed01cf6b02&displaylang=en) to update the database.


Oracle: sqlplus "/ as sysdba"
SQL>spool update-oracle.out;
SQL>@update-oracle
SQL>quit;
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If your Lucene Index Server is also on a remote server, continue with Section 19.3.3, “Remote 
Lucene Index Server Update,” on page 161.
or
If all remaining components that need to be updated from Vibe 3.1 to Vibe 3.2 are on the Vibe 
server, follow the instructions in Section 19.2, “Updating a Single-Server System from Vibe 3.1 to 
Vibe 3.2,” on page 158.


19.3.3 Remote Lucene Index Server Update


In order to update your index from Novell Vibe 3.1 to Novell Vibe 3.2 when the Vibe installation 
program cannot do it for you, you need to run the Remote Lucene Server installation program. 


1 Stop Vibe.
2 Stop the Lucene Index Server.
3 Ensure that no application (such as a command prompt or Windows Explorer) is running on the 


Vibe 3.1 system.
4 Copy the Vibe 3.2 Remote Lucene Server Installation program from the directory where the Vibe 


3.2 Installation program is located to a convenient directory on the server where the remote 
Lucene Index Server is located.
The name of the Remote Lucene Server Installation program varies by platform:


5 Start the Vibe 3.2 Remote Lucene Server installation program.
6 Accept the License Agreement, then click Next.
7 Select Update software and settings.
8 Click Next to continue.
9 Click Next to accept the installation location.


10 Click Next to accept the Java JDK location.
11 In the Host field, specify the hostname where you are installing the remote Lucene Index Server.
12 Change Lucene configuration settings as needed, then click Next.


For information about Lucene configuration settings, see Section 9.5.2, “Changing Lucene 
Configuration Settings,” on page 85.


13 Click Install to install the updated Lucene Index Server software.
14 Click Finish when the update is completed.
15 Start the Lucene Index Server.
16 Now that all remote Vibe components have been updated, follow the instructions in 


Section 19.2, “Updating a Single-Server System from Vibe 3.1 to Vibe 3.2,” on page 158.


Linux: lucene-installer.linux


Windows: lucene-installer.exe
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19.4 Performing Post-Update Tasks
After you start Novell Vibe 3.2, you can access your Vibe site as usual. However, you need to reset 
some aspects of the interface before you allow users to access the updated site. The interface reset 
affects only those definitions and templates that are included with the Vibe product. If you have 
created custom definitions and templates, they are unaffected by the interface reset.


 Section 19.4.1, “Resetting Your Definitions,” on page 162
 Section 19.4.2, “Resetting the Search Index,” on page 162
 Section 19.4.3, “Resetting the Standard Templates,” on page 163


19.4.1 Resetting Your Definitions


Various aspects of the Vibe interface have been redesigned and enhanced in Vibe 3.2. Some of these 
enhancements affect entries, folders, user profiles, and user workspaces. If you have made 
customizations to these areas of Vibe, you must reset these definitions in order to see the Vibe 3.2 
enhancements, as described in this section.


WARNING: The following procedure deletes any custom modifications that you have previously 
made to the default Vibe definitions. If you want to save any modified definitions before proceeding, 
you can export the modified definitions. Also, you might want to document exactly what changes 
you have made in order to make it easier to reconstruct the definition after you reset it.


To reset your Vibe definitions:


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 In the System section, click Form/View Designers to display the Form and View Designers page.
4 Click Reset.


The Reset Definitions page is displayed.
5 Click Select All.


You can expand each definition to ensure that all definitions have been selected.
6 Click OK.


19.4.2 Resetting the Search Index


Search functionality has been improved in Vibe 3.2. For optimal search performance, you need to re-
index the search index after you update to Vibe 3.2.


The steps to reset the search index differ depending on whether you have multiple Lucene Index 
servers. For more information about multiple search indexes, see Chapter 16, “Running Multiple 
Lucene Index Servers,” on page 131.


Depending on the size of your Vibe site, this can be a very time-consuming process.


 “Resetting a Single Search Index” on page 163
 “Resetting the Search Index with Multiple Index Servers” on page 163
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Resetting a Single Search Index


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 In the Management section, click Search Index.
4 Select Re-Index Everything.
5 Click OK, then click Close.


Users can still access the Vibe site during the indexing process, but search results might not be 
accurate until the index has been completely rebuilt.
A message notifies you when indexing is complete.


Resetting the Search Index with Multiple Index Servers


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 In the Search Index section, click Index.
4 Select Re-Index Everything.
5 Select each node that you want to re-index.
6 Click OK, then click Close.


Users can still access the Vibe site during the indexing process, but search results might not be 
accurate until the index has been completely rebuilt.
A message notifies you when indexing is complete.


19.4.3 Resetting the Standard Templates


IMPORTANT: If you have manually customized any templates that are included with the Vibe 
product, back up the files you have modified before performing the interface reset.


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 In the Management section, click Workspace and Folder Templates.
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4 Click Reset.
5 Click OK to confirm, then click Close.


Your Vibe 3.2 site is now ready for use.


IMPORTANT: If Vibe users encounter problems displaying any pages on the Vibe site after the 
update, simply have them clear the browser cache.
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20 20Updating from Novell Vibe 3 to Novell 
Vibe 3.2


This section describes how to update to Novell Vibe 3.2 from Novell Vibe 3. If you are updating from 
a version of Vibe prior to Vibe 3 (Vibe versions prior to Vibe 3 are called Novell Teaming), you must 
first update to Vibe 3 before you can update to Vibe 3.2. For information on how to update to Novell 
Vibe 3, see “Update” in the Novell Vibe OnPrem 3 Installation Guide (http://www.novell.com/
documentation/vibe_onprem3/vibeprem3_inst/data/bookinfo.html).


After you update your Vibe system, make sure that you check on the Vibe download site where you 
downloaded the Vibe software for any hot patches that might be available.


 Section 20.1, “Understanding the Update Process,” on page 165
 Section 20.2, “Updating a Single-Server System from Vibe 3 to Vibe 3.2,” on page 166
 Section 20.3, “Updating a Multiple-Server System from Vibe 3 to Vibe 3.2,” on page 168
 Section 20.4, “Performing Post-Update Tasks,” on page 170


20.1 Understanding the Update Process
When you update to Novell Vibe 3.2, each user who has used a previous version of Vibe must clear 
his or her browser’s cache, regardless of which browser he or she is using. Not clearing the browser 
cache results in Vibe not displaying correctly.


Ensure that you communicate this to each Vibe user in your system.


During the update from Novell Vibe 3.1 to Vibe 3.2, the following aspects of your Vibe system are 
modified:


 The software is updated from Vibe 3.1 to Vibe 3.2.
 A backup copy of your existing Vibe 3.1 installation is created in the following directory:


If your original Vibe system began with version 1.0 (this version of Novell Vibe is called Novell 
Teaming), the backup copy is located in the following directory:


Linux: /opt/novell/teaming/teaming-backup


Windows: C:\Program Files\Novell\Teaming\teaming-backup


Linux: /opt/icecore


Windows: C:\Program Files\icecore

Updating from Novell Vibe 3 to Novell Vibe 3.2 165



http://www.novell.com/documentation/vibe_onprem3/vibeprem3_inst/data/bookinfo.html





20.2 Updating a Single-Server System from Vibe 3 to Vibe 3.2
When you update a single-server Novell Vibe installation from Vibe 3 to Vibe 3.2, you need to update 
the Vibe software and the Vibe database separately. You can update the software and database in 
whichever order you prefer.


 Section 20.2.1, “Backing Up Vibe Data,” on page 166
 Section 20.2.2, “Updating the Vibe Database,” on page 166
 Section 20.2.3, “Updating the Vibe Software,” on page 167


20.2.1 Backing Up Vibe Data


Make sure your Vibe data is backed up before you begin the update process. For information 
regarding the data that needs to be backed up, see “Backing Up Vibe Data” in the  Novell Vibe 3.2 
Administration Guide.


20.2.2 Updating the Vibe Database


When updating to Vibe 3.2, The Vibe Installation program does not update the database as part of the 
Vibe software update. Therefore, you must manually run the database update scripts after you have 
stopped Vibe:


1 Make sure you have a current backup of your Vibe 3 system.
2 Stop Vibe.
3 Ensure that no application (such as a command prompt or Windows Explorer) is running on the 


Vibe 3 system.
4 Change to the directory where the Vibe 3.2 installation program is located.
5 Unzip the teaming-3.2.n-sql.zip file to create the update-3.0.0-3.1.0 and update-3.1.0-


3.2.n directories.
The update-3.0.0-3.1.0 and update-3.1.0-3.2.n directories contain update scripts for each 
type of database (MySQL, Microsoft SQL, and Oracle).


6 Use the database utility for your database type to run the corresponding script for your database 
from both the update-3.0.0-3.1.0 and update-3.1.0-3.2.n directories:


NOTE: You must run each database update script in the correct order: first run the update script 
for Vibe 3 to 3.1, then run the script for Vibe 3.1 to Vibe 3.2.


7 Continue with Section 19.2.3, “Updating the Vibe Software,” on page 158.


MySQL: mysql -uusername -ppassword < /path/update-mysql.sql


Microsoft 
SQL:


osql -Uusername -Ppassword -i update-sqlserver.sql


You can also use the script with the SQL Server Express Utility (http://www.microsoft.com/
downloads/details.aspx?familyid=fa87e828-173f-472e-a85c-
27ed01cf6b02&displaylang=en) to update the database.


Oracle: sqlplus "/ as sysdba"
SQL>spool update-oracle.out;
SQL>@update-oracle
SQL>quit;
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20.2.3 Updating the Vibe Software


1 Make sure you have a current backup of your Vibe 3 system.
2 Stop Vibe.
3 Ensure that no application (such as a command prompt or Windows Explorer) is running on the 


Vibe 3 system.
4 Copy the installer.xml file from the directory where the Vibe 3 Installation program is located 


to the directory where you have extracted the Vibe 3.2 software.
You must obtain a new license-key.xml file when upgrading to Vibe 3.2.
The installer.xml file provides default values when you run the Vibe 3.2 Installation 
program.


5 Start the Vibe 3.2 installation program.
If you need assistance with this task, see the detailed installation instructions for the platform 
where you are updating Vibe:
 Section 4.1.2, “Running the Linux Vibe Installation Program,” on page 51
 Section 4.2.2, “Running the Windows Vibe Installation Program,” on page 59


6 Accept the License Agreement, then click Next.


Because you provided your Vibe 3 installer.xml file in the directory with the Vibe 3.2 
installation program, the Update software and settings installation option is selected by default.


7 Click Next to continue.
8 Click Yes to let the Installation program know that you have stopped Vibe.
9 Select the check box to let the installation program know that you have backed up all of your 


data, then click Next.
10 Select Basic or Advanced, depending on the type of Vibe installation you are updating, then click 


Next.
For more information about the differences between basic and advanced installations, see 
Section 3.1, “What Is a Basic Vibe Installation?,” on page 25 and Section 9.1, “What Is an 
Advanced Installation?,” on page 81.


11 Continue through the installation process, retaining or changing configuration information 
depending on the needs of your Vibe 3.2 system.


12 Click Install when you are ready to perform the update.
13 Click Finish when the update is completed.
14 If you have not yet updated the Vibe database, complete Section 19.2.2, “Updating the Vibe 


Database from 3.1 to 3.2,” on page 158 before you start Vibe.
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15 Start Vibe 3.2 in the same way that you have been starting Vibe 3.
When you start Vibe for the first time after the update, it takes longer to start than usual because 
data in the Vibe database must be updated before the Vibe site is ready to use.


20.3 Updating a Multiple-Server System from Vibe 3 to Vibe 3.2
If your Novell Vibe 3 system is distributed across multiple servers, the Vibe 3.2 installation program 
can update Vibe components on the Vibe server, but you must manually update any Vibe 
components that you have placed on remote servers.


 Section 20.3.1, “Backing Up Vibe Data,” on page 168
 Section 20.3.2, “Manual Vibe Database Update,” on page 168
 Section 20.3.3, “Remote Lucene Index Server Update,” on page 169


20.3.1 Backing Up Vibe Data


Make sure your Vibe data is backed up before you begin the update process. For information 
regarding the data that needs to be backed up, see “Backing Up Vibe Data” in the  Novell Vibe 3.2 
Administration Guide.


20.3.2 Manual Vibe Database Update


In order to update a database from Vibe 3 to 3.2, you must run the Vibe 3.2 database update scripts.


1 Stop Vibe.
2 Ensure that no application (such as a command prompt or Windows Explorer) is running on the 


Vibe 3 system.
3 Change to the directory where the Vibe 3 installation program is located.
4 Unzip the teaming-3.2.n-sql.zip file to create the update-3.0.0-3.1.0 and update-3.1.0-


3.2.n directories.
The update-3.0.0-3.1.0 and update-3.1.0-3.2.n directories contain update scripts for each 
type of database (MySQL, Microsoft SQL, and Oracle).


5 Copy the scripts for your database type to the server where the Vibe database is located.
6 (Conditional) If you have multiple Oracle databases, you must edit the update-oracle.sql 


scripts in each directory and add @database_name to the first line of the scripts. For example, 
connect sitescape/sitescape@vibe.


7 Use the database utility for your database type to run the corresponding script for your database 
from both the update-3.0.0-3.1.0 and update-3.1.0-3.2.n directories:


MySQL: mysql -uusername -ppassword < /path/update-mysql.sql


Microsoft 
SQL:


osql -Uusername -Ppassword -i update-sqlserver.sql


You can also use the script with the SQL Server Express Utility (http://www.microsoft.com/
downloads/details.aspx?familyid=fa87e828-173f-472e-a85c-
27ed01cf6b02&displaylang=en) to update the database.


Oracle: sqlplus "/ as sysdba"
SQL>spool update-oracle.out;
SQL>@update-oracle
SQL>quit;
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8 After you have updated the database from Vibe 3 to Vibe 3.2:
If your Lucene Index Server is also on a remote server, continue with Section 19.3.3, “Remote 
Lucene Index Server Update,” on page 161.
or
If all remaining components that need to be updated from Vibe 3 to Vibe 3.2 are on the Vibe 
server, follow the instructions in Section 20.2, “Updating a Single-Server System from Vibe 3 to 
Vibe 3.2,” on page 166.


20.3.3 Remote Lucene Index Server Update


In order to update your index from Novell Vibe 3.0 to Novell Vibe 3.2 when the Vibe installation 
program cannot do it for you, you need to run the Remote Lucene Server installation program. 


1 Stop Vibe.
2 Stop the Lucene Index Server.
3 Ensure that no application (such as a command prompt or Windows Explorer) is running on the 


Vibe 3 system.
4 Copy the Vibe 3.2 Remote Lucene Server Installation program from the directory where the Vibe 


3.2 Installation program is located to a convenient directory on the server where the remote 
Lucene Index Server is located.
The name of the Remote Lucene Server Installation program varies by platform:


5 Start the Vibe 3.2 Remote Lucene Server installation program.
6 Accept the License Agreement, then click Next.
7 Select Update software and settings.
8 Click Next to continue.
9 Click Next to accept the installation location.


10 Click Next to accept the Java JDK location.
11 In the Host field, specify the hostname where you are installing the remote Lucene Index Server.
12 Change Lucene configuration settings as needed, then click Next.


For information about Lucene configuration settings, see Section 9.5.2, “Changing Lucene 
Configuration Settings,” on page 85.


13 Click Install to install the updated Lucene Index Server software.
14 Click Finish when the update is completed.
15 Start the Lucene Index Server.
16 Now that all remote Vibe components have been updated, follow the instructions in 


Section 19.2, “Updating a Single-Server System from Vibe 3.1 to Vibe 3.2,” on page 158.


Linux: lucene-installer.linux


Windows: lucene-installer.exe
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20.4 Performing Post-Update Tasks
After you start Novell Vibe 3.2, you can access your Vibe site as usual. However, you need to reset 
some aspects of the interface before you allow users to access the updated site. The interface reset 
affects only those definitions and templates that are included with the Vibe product. If you have 
created custom definitions and templates, they are unaffected by the interface reset.


 Section 20.4.1, “Resetting Your Definitions,” on page 170
 Section 20.4.2, “Resetting the Search Index,” on page 170
 Section 20.4.3, “Resetting the Standard Templates,” on page 171


20.4.1 Resetting Your Definitions


Various aspects of the Vibe interface have been redesigned and enhanced in Vibe 3.2. Some of these 
enhancements affect entries, folders, user profiles, and user workspaces. If you have made 
customizations to these areas of Vibe, you must reset these definitions in order to see the Vibe 3.2 
enhancements, as described in this section.


WARNING: The following procedure deletes any custom modifications that you have previously 
made to the default Vibe definitions. If you want to save any modified definitions before proceeding, 
you can export the modified definitions. Also, you might want to document exactly what changes 
you have made in order to make it easier to reconstruct the definition after you reset it.


To reset your Vibe definitions:


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 In the System section, click Form/View Designers to display the Form and View Designers page.
4 Click Reset.


The Reset Definitions page is displayed.
5 Click Select All.


You can expand each definition to ensure that all definitions have been selected.
6 Click OK.


20.4.2 Resetting the Search Index


Search functionality has been improved in Vibe 3.2. For optimal search performance, you need to re-
index the search index after you update to Vibe 3.2.


The steps to reset the search index differ depending on whether you have multiple Lucene Index 
servers. For more information about multiple search indexes, see Chapter 16, “Running Multiple 
Lucene Index Servers,” on page 131.


Depending on the size of your Vibe site, this can be a very time-consuming process.


 “Resetting a Single Search Index” on page 171
 “Resetting the Search Index with Multiple Index Servers” on page 171
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Resetting a Single Search Index


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 In the Management section, click Search Index.
4 Select Re-Index Everything.
5 Click OK, then click Close.


Users can still access the Vibe site during the indexing process, but search results might not be 
accurate until the index has been completely rebuilt.
A message notifies you when indexing is complete.


Resetting the Search Index with Multiple Index Servers


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 In the Search Index section, click Index.
4 Select Re-Index Everything.
5 Select each node that you want to re-index.
6 Click OK, then click Close.


Users can still access the Vibe site during the indexing process, but search results might not be 
accurate until the index has been completely rebuilt.
A message notifies you when indexing is complete.


20.4.3 Resetting the Standard Templates


IMPORTANT: If you have manually customized any templates that are included with the Vibe 
product, back up the files you have modified before performing the interface reset.


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 In the Management section, click Workspace and Folder Templates.
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4 Click Reset.
5 Click OK to confirm, then click Close.


Your Vibe 3.2 site is now ready for use.


IMPORTANT: If Vibe users encounter problems displaying any pages on the Vibe site after the 
update, simply have them clear the browser cache.
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21 21Updating from Novell Vibe 3 to Novell 
Vibe 3.1


This section describes how to update to Novell Vibe 3.1 from Novell Vibe 3. If you are updating from 
an earlier version of Novell Vibe (earlier versions of Novell Vibe are called Novell Teaming), you 
must first update to Novell Vibe 3 before you can update to Novell Vibe 3.1. For information on how 
to update to Novell Vibe 3, see “Update” in the Novell Vibe OnPrem 3 Installation Guide (http://
www.novell.com/documentation/vibe_onprem3/vibeprem3_inst/data/bookinfo.html)


 Section 21.1, “Understanding the Update Process,” on page 173
 Section 21.2, “Updating a Single-Server System from Vibe 3 to Vibe 3.1,” on page 174
 Section 21.3, “Updating a Multiple-Server System from Vibe 3 to Vibe 3.1,” on page 175
 Section 21.4, “Performing Post-Update Tasks,” on page 177


21.1 Understanding the Update Process
When you update to Novell Vibe 3.1, each user who has used a previous version of Vibe must clear 
his or her browser’s cache, regardless of which browser he or she is using. Not clearing the browser 
cache results in Vibe not displaying correctly.


Ensure that you communicate this to each Vibe user in your system.


During the update from Novell Vibe 3 to Vibe 3.1, the following aspects of your Vibe system are 
modified:


 The software is updated from Vibe 3 to Vibe 3.1.
 A backup copy of your existing Vibe 3 installation is created in the following directory:


If your original Vibe system began with version 1.0 (this version of Novell Vibe is called Novell 
Teaming), the backup copy is located in the following directory:


Linux: /opt/novell/teaming/teaming-backup


Windows: C:\Program Files\Novell\Teaming\teaming-backup


Linux: /opt/icecore


Windows: C:\Program Files\icecore
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21.2 Updating a Single-Server System from Vibe 3 to Vibe 3.1
When you update a single-server Novell Vibe installation from Vibe 3 to Vibe 3.1, the Vibe 
Installation program can perform the entire update in a single process.


1 Make sure you have a current backup of your Vibe 3 system.
2 Stop Vibe.
3 Ensure that no application (such as a command prompt or Windows Explorer) is running on the 


Vibe 3 system.
4 Copy the installer.xml file from the directory where the Vibe 3 Installation program is located 


to the directory where you have extracted the Vibe 3.1 software.
You must obtain a new license-key.xml file when upgrading to Vibe 3.1.
The installer.xml file provides default values when you run the Vibe 3.1 Installation 
program.


5 Start the Vibe 3.1 installation program.
If you need assistance with this task, see the detailed installation instructions for the platform 
where you are updating Vibe:
 Section 4.1.2, “Running the Linux Vibe Installation Program,” on page 51
 Section 4.2.2, “Running the Windows Vibe Installation Program,” on page 59


6 Accept the License Agreement, then click Next.


Because you provided your Vibe 3 installer.xml file in the directory with the Vibe 3.1 
installation program, the Update software and settings installation option is selected by default.


7 Click Next to continue.
8 Click Yes to let the Installation program know that you have stopped Vibe.
9 Select the check box to let the installation program know that you have backed up all of your 


data, then click Next.
10 Select Basic or Advanced, depending on the type of Vibe installation you are updating, then click 


Next.
For more information about the differences between basic and advanced installations, see 
Section 3.1, “What Is a Basic Vibe Installation?,” on page 25 and Section 9.1, “What Is an 
Advanced Installation?,” on page 81.


11 Continue through the installation process, retaining or changing configuration information 
depending on the needs of your Vibe 3.1 system.


12 Click Install when you are ready to perform the update.
The Installation program might seem to pause at this point. It needs to update tables and 
indexes in the Vibe database. If you have a large database, this process can be time-consuming.


13 Click Finish when the update is completed.
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14 Start Vibe 3.1 in the same way that you have been starting Vibe 3.
When you start Vibe for the first time after the update, it takes longer to start than usual because 
data in the Vibe database must be updated before the Vibe site is ready to use.


21.2.1 Updating an Oracle Database from 3 to 3.1


The Vibe Installation program can update MySQL and Microsoft SQL databases as part of the Vibe 
software update, but it cannot update an Oracle database. Therefore, if you are using Oracle, you 
must manually run the database update script after you have stopped Vibe:


1 Change to the directory where the Vibe 3.1 Installation program is located.
2 Unzip the teaming-3.1.n-sql.zip file to create the update-3.0.0-3.1.n directory


The update-3.0.0-3.1.n directory contains an update script for each type of database 
(MySQL, Microsoft SQL, and Oracle).


3 Run the update-oracle.sql script to update the database structure.


sqlplus "/ as sysdba"
SQL>spool update-oracle.out;
SQL>@update-oracle;
SQL>quit;


4 Return to Step 5 in Section 21.2, “Updating a Single-Server System from Vibe 3 to Vibe 3.1,” on 
page 174.


21.3 Updating a Multiple-Server System from Vibe 3 to Vibe 3.1
If your Novell Vibe 3 system is distributed across multiple servers, the Vibe 3.1 installation program 
can update Vibe components on the Vibe server, but you must manually update any Vibe 
components that you have placed on remote servers.


 Section 21.3.1, “Manual Vibe Database Update,” on page 175
 Section 21.3.2, “Remote Lucene Index Server Update,” on page 176


21.3.1 Manual Vibe Database Update


In order to update a database from Vibe 3 to 3.1 when the Vibe installation program cannot do it for 
you, you must run the Vibe 3.1 database update script.


1 Stop Vibe.
2 Ensure that no application (such as a command prompt or Windows Explorer) is running on the 


Vibe 3 system.
3 Change to the directory where the Vibe 3 installation program is located.
4 Unzip the teaming-3.1.n-sql.zip file to create the update-3.0.0-3.1.n directory


The update-3.0.0-3.1.n directory contains an update script for each type of database 
(MySQL, Microsoft SQL, and Oracle).


5 Copy the script for your database type to the server where the Vibe database is located.
6 Use the database client utility for your database type to run the script:


MySQL: mysql -uusername -ppassword < /path/update-mysql.sql

Updating from Novell Vibe 3 to Novell Vibe 3.1 175







7 After you have updated the database from Vibe 3 to Vibe 3.1:
If your Lucene Index Server is also on a remote server, continue with Section 21.3.2, “Remote 
Lucene Index Server Update,” on page 176.
or
If all remaining components that need to be updated from Vibe 3 to Vibe 3.1 are on the Vibe 
server, follow the instructions in Section 21.2, “Updating a Single-Server System from Vibe 3 to 
Vibe 3.1,” on page 174.


21.3.2 Remote Lucene Index Server Update


In order to update your index from Novell Vibe 3 to Novell Vibe 3.1 when the Vibe installation 
program cannot do it for you, you need to run the Remote Lucene Server installation program. 


1 Stop Vibe.
2 Stop the Lucene Index Server.
3 Ensure that no application (such as a command prompt or Windows Explorer) is running on the 


Vibe 3 system.
4 Copy the Vibe 3.1 Remote Lucene Server Installation program from the directory where the Vibe 


3.1 Installation program is located to a convenient directory on the server where the remote 
Lucene Index Server is located.
The name of the Remote Lucene Server Installation program varies by platform:


5 Start the Vibe 3.1 Remote Lucene Server installation program.
6 Accept the License Agreement, then click Next.
7 Select Update software and settings.
8 Click Next to continue.
9 Click Next to accept the installation location.


10 Click Next to accept the Java JDK location.
11 In the Host field, specify the hostname where you are installing the remote Lucene Index Server.
12 Change Lucene configuration settings as needed, then click Next.


For information about Lucene configuration settings, see Section 9.5.2, “Changing Lucene 
Configuration Settings,” on page 85.


13 Click Install to install the updated Lucene Index Server software.
14 Click Finish when the update is completed.


Microsoft 
SQL:


osql -Uusername -Ppassword -i update-sqlserver.sql


You can also use the script with the SQL Server Express Utility (http://www.microsoft.com/
downloads/details.aspx?familyid=fa87e828-173f-472e-a85c-
27ed01cf6b02&displaylang=en) to update the database.


Oracle: sqlplus "/ as sysdba"
SQL>spool update-oracle.out;
SQL>@update-oracle
SQL>quit;


Linux: lucene-installer.linux


Windows: lucene-installer.exe
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15 Start the Lucene Index Server.
16 Now that all remote Vibe components have been updated, follow the instructions in 


Section 21.2, “Updating a Single-Server System from Vibe 3 to Vibe 3.1,” on page 174.


21.4 Performing Post-Update Tasks
After you start Novell Vibe 3.1, you can access your Vibe site as usual. However, you need to reset 
some aspects of the interface before you allow users to access the updated site. The interface reset 
affects only those definitions and templates that are included with the Vibe product. If you have 
created custom definitions and templates, they are unaffected by the interface reset.


 Section 21.4.1, “Resetting Your Definitions,” on page 177
 Section 21.4.2, “Resetting the Search Index,” on page 177
 Section 21.4.3, “Resetting the Standard Templates,” on page 178


21.4.1 Resetting Your Definitions


Various aspects of the Vibe interface have been redesigned and enhanced in Vibe 3.1. Some of these 
enhancements affect entries, folders, user profiles, and user workspaces. If you have made 
customizations to these areas of Vibe, you must reset these definitions in order to see the Vibe 3.1 
enhancements, as described in this section.


WARNING: The following procedure deletes any custom modifications that you have previously 
made to the default Vibe definitions. If you want to save any modified definitions before proceeding, 
you can export the modified definitions. Also, you might want to document exactly what changes 
you have made in order to make it easier to reconstruct the definition after you reset it.


To reset your Vibe definitions:


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Administration icon  in the upper right corner of the page.
3 In the System section, click Form/View Designers to display the Form and View Designers page.
4 Click Reset.


The Reset Definitions page is displayed.
5 Click Select All.


You can expand each definition to ensure that all definitions have been selected.
6 Click OK.


21.4.2 Resetting the Search Index


Search functionality has been improved in Vibe 3.1. For optimal search performance, you need to re-
index the search index after you update to Vibe 3.1.


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Administration icon  in the upper right corner of the page.
3 In the Management section, click Search Index.

Updating from Novell Vibe 3 to Novell Vibe 3.1 177







4 Select Re-Index Everything.
5 Click OK, then click Close.


21.4.3 Resetting the Standard Templates


IMPORTANT: If you have manually customized any templates that are included with the Vibe 
product, back up the files you have modified before performing the interface reset.


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Administration icon  in the upper right corner of the page.
3 In the Management section, click Workspace and Folder Templates.


4 Click Reset.
5 Click OK to confirm, then click Close.


Your Vibe 3.1 site is now ready for use.


IMPORTANT: If Vibe users encounter problems displaying any pages on the Vibe site after the 
update, simply have them clear the browser cache.
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22 22Updating the Operating System Where 
Vibe Is Running


You can update the operating system where Vibe is running.


1 update the Linux or Windows operating system to a version that Vibe supports.
For information about which versions are supported, see Section 2.1, “Vibe Server 
Requirements,” on page 17.
For information about how to update the operating system, view the appropriate 
documentation for your operating system.


2 (Conditional) If you updated a Linux server, the TrueType font path that Vibe uses for document 
conversion might be broken after the update. To fix this problem, you need to re-run the Vibe 
installation after upgrading the Linux operating system.
For information on how to run the Vibe installation, see Section 4.1, “Linux: Installing and 
Setting Up a Basic Vibe Site,” on page 49 for a basic installation, or Chapter 10, “Performing an 
Advanced Vibe Installation,” on page 105 for an advanced installation.
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23 23Migrating Existing Novell Vibe Data into 
a New Vibe 3.2 System


This section describes how to migrate data from an existing Vibe server to a new Vibe server. You 
might want to do this for any of the following reasons:


 Your existing Vibe system has outgrown the server where you originally set it up
 You want to move your existing Vibe system to a different operating system


In this case, you can install Vibe 3.2 on a new server, then migrate your existing Vibe 3.2 data (or 
data from a previous version of Vibe) to your new Vibe 3.2 system
If you are migrating from a Teaming 2.1 server, follow the instructions in “Update” in the Novell 
Vibe OnPrem 3 Installation Guide (http://www.novell.com/documentation/vibe_onprem3/
vibeprem3_inst/data/bookinfo.html).


 You created your Vibe system by using the Virtual Eval version of the Novell Vibe Starter Pack 
(http://download.novell.com/Download?buildid=Y7J2HFucjfw~)


 You are upgrading from Kablink Vibe to Novell Vibe


Complete the following sections to migrate your Vibe data:


 Section 23.1, “Linux Migration with a MySQL Database,” on page 181
 Section 23.2, “Windows Migration with an MS SQL Database,” on page 183


NOTE: In these instructions, “target server” refers to the server where you install the Vibe 3.2 
software, and “source server” refers to the existing server from which you are migrating Vibe data.


The instructions in this section are based on a single-server Vibe configuration. If you have a multi-
server Vibe configuration, the single-server instructions can serve as a foundation to get you started 
with your more complex migration process.


This section does not include instructions for migrating an Oracle database. Use the instructions for 
your Vibe platform as a guideline for the tasks that are involved in migrating Vibe data, then apply 
these guidelines to your Oracle database migration.


23.1 Linux Migration with a MySQL Database
 Section 23.1.1, “Preparing the Target Linux Server,” on page 182
 Section 23.1.2, “Preparing the Source Linux Server,” on page 182
 Section 23.1.3, “Transferring Data from the Source Server to the Target Server,” on page 182
 Section 23.1.4, “Importing the Vibe Database to the Target Server,” on page 183
 Section 23.1.5, “Updating the Vibe Database on the Target Server,” on page 183
 Section 23.1.6, “Finalizing Your New Vibe 3.2 Site,” on page 183
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23.1.1 Preparing the Target Linux Server


On the target server:


1 Install the Vibe 3.2 software on the target server, as described in Part II, “Basic Installation,” on 
page 23, paying special attention to these important details:
 Set up the same Linux user to run the Vibe software that has been used to run the Vibe 


software in the past.
 Select the same encryption algorithm for the Vibe database that was used in Vibe 3. 


IMPORTANT: If the database encryption algorithms do not match between the source and 
target Vibe systems, you cannot log in to the new Vibe 3.2 site.


2 Start Vibe on the target server.
3 Verify that the new Vibe site is working as expected.
4 Stop Vibe on the target server.
5 Rename the teaming directory to teaming_backup. This is because in a future step you will 


copy the teaming directory from the source server to the target server.
The location of the teaming directory varies by platform:


6 Continue with Section 23.1.2, “Preparing the Source Linux Server,” on page 182.


23.1.2 Preparing the Source Linux Server


On the source server:


1 Stop Vibe.
2 Back up your existing database:


mysqldump -uusername -ppassword sitescape > sitescape.sql


This creates a file named sitescape.sql in the directory where you executed the mysqldump 
command.


3 Make sure that you have a recent backup of your entire Vibe system.
4 Continue with Section 23.1.3, “Transferring Data from the Source Server to the Target Server,” on 


page 182.


23.1.3 Transferring Data from the Source Server to the Target Server


On the source server:


1 Mount the target server to the source server so that data can be copied from one server to the 
other.


2 In a terminal window on the source server, become the Linux user that runs the Vibe software. 
3 Copy the database backup of your existing Vibe database (sitescape.sql file) that you created 


in Step 2 in Section 23.1.2, “Preparing the Source Linux Server,” on page 182 to a convenient 
temporary location on the target server.


Linux: /var/opt/novell/teaming


Windows: c:\novell\teaming
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4 Copy the entire data area from /var/opt/novell/teaming on the source server to the same 
location on the target server.


5 Continue with Section 23.1.4, “Importing the Vibe Database to the Target Server,” on page 183.


23.1.4 Importing the Vibe Database to the Target Server


On the target server:


1 Remove the empty Vibe database that was created when you installed the Vibe 3.2 software:


mysql>drop database sitescape;


2 Change to the directory where you copied the sitescape.sql file in Step 3 in Section 23.1.3, 
“Transferring Data from the Source Server to the Target Server,” on page 182.


3 Create an empty database called sitescape:


mysql -uusername -ppassword -e "create database sitescape"


4 Manually re-create the Vibe database with the data that you copied from the source server:


mysql -uusername -ppassword sitescape < sitescape.sql


23.1.5 Updating the Vibe Database on the Target Server


You must complete this section only if you are updating from a previous version of Vibe to Vibe 3.2.


On the target server:


1 Unzip the teaming-3.2.n.sql.zip file.
2 In the teaming-3.2.n-sql folder, change to the resulting update-3.1.0-3.2.n directory, then 


run the update script to update the database from Vibe 3.1 to Vibe 3.2:


mysql -uusername -ppassword < update-mysql.sql


For more complete database update instructions, refer to Section 21.3.1, “Manual Vibe Database 
Update,” on page 175. 


3 Continue with Section 23.1.6, “Finalizing Your New Vibe 3.2 Site,” on page 183.


23.1.6 Finalizing Your New Vibe 3.2 Site


1 Start Vibe 3.2, as described in Section 4.1.7, “Starting Vibe on Linux,” on page 56.
2 Reindex the Vibe site, as described in “Rebuilding the Lucene Index” in “Site Maintenance” in 


the  Novell Vibe 3.2 Administration Guide.
Your Vibe site should now function just as it did on the original source server.


23.2 Windows Migration with an MS SQL Database
 Section 23.2.1, “Preparing the Target Windows Server,” on page 184
 Section 23.2.2, “Preparing the Source Windows Server,” on page 184
 Section 23.2.3, “Transferring Data from the Source Server to the Target Server,” on page 184
 Section 23.2.4, “Importing the Database to the Target Server,” on page 185
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 Section 23.2.5, “Updating the Vibe Database on the Target Server,” on page 185
 Section 23.2.6, “Finalizing Your New Vibe 3.2 Site,” on page 186


23.2.1 Preparing the Target Windows Server


On the target server:


1 Install the Vibe 3.2 software, as described in Part II, “Basic Installation,” on page 23.


IMPORTANT: Select the same encryption algorithm for the Vibe 3.2 database as you selected for 
the Vibe 3.1 database. If the database encryption algorithms do not match between the source 
and target systems, you cannot log in to the new Vibe 3.2 site.


2 Start Vibe on the target server.
3 Verify that the new Vibe site is working as expected.
4 Stop Vibe on the target server.
5 Rename the teaming directory to teaming_backup. This is because in a future step you will 


copy the teaming directory from the source server to the target server.
The location of the teaming directory varies by platform:


6 Continue with Section 23.2.2, “Preparing the Source Windows Server,” on page 184.


23.2.2 Preparing the Source Windows Server


On the source server:


1 Stop Vibe.
2 Back up your existing database:


2a In Microsoft SQL Server Management Studio, browse to and right-click the existing 
database (named sitescape), then click Tasks > Back Up.


2b For Backup type, select Full.
2c Set other backup options as desired, then click OK.


This creates a file named sitescape.bak in the following directory:


c:\Program Files\Microsoft SQL Server\MSSQL\Backup


3 Make sure that you have a recent backup of your entire system.
4 Continue with Section 23.2.3, “Transferring Data from the Source Server to the Target Server,” on 


page 184.


23.2.3 Transferring Data from the Source Server to the Target Server


On the source server:


1 Map a drive from the target server to the source server so that data can be copied from one 
server to the other.


Linux: /var/opt/novell/teaming


Windows: c:\Program Files\Novell\Teaming
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2 Copy your existing software extensions to the target server:


Beginning with Vibe 3, the extensions directory now contains kablink and liferay.com 
directories.


3 Delete the empty kablink directory.
4 Delete or rename the following directories to make room for the corresponding directories that 


you are copying from the source server:


c:\novell\teaming
c:\novell\teaming\lucene
c:\novell\teaming\extensions


5 Copy the entire data area from c:\novell\teaming on the source server to the same location on 
the target server.


6 Continue with Section 23.2.4, “Importing the Database to the Target Server,” on page 185.


23.2.4 Importing the Database to the Target Server


On the target server:


1 In Microsoft SQL Server Management Studio, browse to and right-click the existing Vibe 
database (named sitescape) that was created when you installed the Vibe 3.2 software, then 
click Delete.


2 To import the data from your source database, browse to and right-click Databases, then click 
Tasks > Restore.


3 In the To database field, specify sitescape.
4 In the From device field, browse to and select the sitescape.bak file that you transferred to the 


target server.
5 Set other restore options as desired, then click OK.


This creates the sitescape database in the following directory on the target server:


c:\Program Files\Microsoft SQL Server\MSSQL


Backed-up data from the source database is imported into the database for your new Vibe 3.2 
system.


23.2.5 Updating the Vibe Database on the Target Server


You must complete this section only if you are updating from a previous version of Vibe to Vibe 3.2.


On the target server:


1 Unzip the teaming-3.2.n-sql.zip file, change to the resulting update-3.1.0-3.2.n directory, 
then run the update script to update the database from Vibe 3.1 to Vibe 3.2:


osql -Uusername -Ppassword -i update-sqlserver.sql


For more complete database update instructions, refer to Section 21.3.1, “Manual Vibe Database 
Update,” on page 175. 


2 Continue with Section 23.2.6, “Finalizing Your New Vibe 3.2 Site,” on page 186.


From: c:\home\icecoredata\extensions


To: c:\novell\teaming\extensions
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23.2.6 Finalizing Your New Vibe 3.2 Site


1 Start Vibe 3.2, as described in Section 4.1.7, “Starting Vibe on Linux,” on page 56.
2 Reindex the Vibe site, as described in “Rebuilding the Lucene Index” in “Site Maintenance” in 


the  Novell Vibe 3.2 Administration Guide.
Your Vibe site should now function just as it did on the original source server.
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24 24Migrating from SiteScape Forum or 
Other Collaboration Software


Moving legacy corporate data into a new collaboration system can look like a long, challenging 
process. To make the job easier, see the Novell Teaming Migration Services Flyer. (http://
www.novell.com/docrep/2009/04/Novell_Teaming_Migration_Flyer_en.pdf)
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 Appendix A, “Vibe System Requirements Assistance,” on page 191
 Appendix B, “Third-Party Materials,” on page 197
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A AVibe System Requirements 
Assistance


The system requirements for Novell Vibe include supporting components that might or might not be 
already installed on your Vibe server. This section helps you meet the Vibe system requirements if 
you are not familiar with how to install these supporting components.


 Section A.1, “Java Development Kit,” on page 191
 Section A.2, “MySQL Database Server,” on page 193


A.1 Java Development Kit
The Novell Vibe software runs inside a Java Virtual Machine (JVM). At present, Vibe requires a Java 
Development Kit (JDK), not a Java Runtime Environment (JRE), in order to run properly. You can use 
either the Sun JDK or the IBM JDK. Follow the instructions in the section below for your operating 
system and JDK preference:


If you want to use an SSL connection between your Novell Vibe site and a WebDAV server, and if the 
WebDAV server has a self-signed certificate rather than a certificate provided by a certificate 
authority, you must use the Sun JDK. The existing Vibe functionality for handling self-signed 
certificates is not compatible with the way the IBM JDK handles self-signed certificates.


 Section A.1.1, “Oracle JDK on Linux,” on page 191
 Section A.1.2, “IBM JDK on Linux,” on page 192
 Section A.1.3, “Oracle JDK on Windows,” on page 193


A.1.1 Oracle JDK on Linux


1 Go to the following URL:
Java SE Downloads (http://www.oracle.com/technetwork/java/javase/downloads/index.html)
The update you need is listed as “Java SE 6 Update nn.”


2 Click Download next to this update.
3 Accept the License Agreement.
4 Click the jdk-6unn-linux-version-rpm.bin file in the Download column, then save the file to 


an empty temporary directory on your Linux server.
5 As the root user, change to that temporary directory, then use the following command to make 


sure that the download arrived safely:


ls -l


You should see a file named jdk-6unn-linux-version-rpm.bin.
6 Change the permissions on the file to include execute permissions:
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chmod +x jdk-6unn-linux-version-rpm.bin


7 Run the self-extracting file:


./jdk-6unn-linux-version-rpm.bin


This creates a file named jdk-6unn-linux-version.rpm, and a directory named /usr/java/
jdk.1.6.0_nn with the Sun JDK software in it.
The Sun JDK is now installed on your Linux server.


A.1.2 IBM JDK on Linux


 “Installing the IBM JDK on SUSE Linux Enterprise Server 11” on page 192
 “Installing the IBM JDK on Open Enterprise Server 2 and SUSE Linux Enterprise Server 10” on 


page 192


Installing the IBM JDK on SUSE Linux Enterprise Server 11


The IBM JDK 6.0 is available with SUSE Linux Enterprise Server (SLES) 11, which is used for Open 
Enterprise Server (OES) 2. You can install it by using YaST.


1 In YaST, click Software > Software Management.
2 In the Search field, type ibm, then click Search.
3 Select Java 5 SDK, Standard Edition (java-1_5_0-ibm-devel), then click Accept.
4 Click Continue to accept the suggested dependencies, then click No because you don’t need any 


more packages.
5 Exit YaST.


This creates a directory named /usr/lib/jvm/java-1_5_0-ibm-1.5.0_sr3 with the IBM JDK 
software in it.


Installing the IBM JDK on Open Enterprise Server 2 and SUSE Linux Enterprise 
Server 10


The IBM JDK 6.0 is not included with SUSE Linux Enterprise Server (SLES) 10. 


To download the IBM JDK 6.0:


1 Go to the following URL:
Java SE Downloads (http://www.ibm.com/developerworks/java/jdk/linux/download.html)


2 In the Java SE Version 6 table, in the Download column, click the appropriate link for your 
operating system. 


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Java JDK Location on the Basic Vibe Installation Summary Sheet, specify the directory where you install 
the JDK. The Vibe installation program prompts you for this location.


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Java JDK Location on the Basic Vibe Installation Summary Sheet, specify the directory where you install 
the JDK. The Vibe installation program prompts you for this location.
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3 Sign in using your IBM account. If you don’t have an account, create one.
4 Agree to IBM’s License Agreement, then continue.
5 Download the ibm-java-i386-sdk-6.0-n.n.i386.rpm file to an empty temporary directory 


on your Linux server.
6 Change to that directory, then run the downloaded file.


This creates a directory named opt\ibm with the IBM JDK in it.
The IBM JDK is now installed on your Linux server.


A.1.3 Oracle JDK on Windows


1 Go to the following URL:
Java SE Downloads (http://www.oracle.com/technetwork/java/javase/downloads/index.html)
The update you need is listed as “Java SE 6 Update nn.”


2 Click Download next to this update.
3 Accept the license agreement.
4 Click the jdk-6unn-windows-version.exe file in the Download column, then save the file to an 


empty temporary directory on your Windows server.
5 Change to that temporary directory, then run the downloaded executable.


This creates a directory named c:\Program Files\Java\jdk6unn with the Oracle JDK software 
in it.
The Oracle JDK is now installed on your Windows server.


A.2 MySQL Database Server
 Section A.2.1, “MySQL on Linux,” on page 193
 Section A.2.2, “MySQL on Windows,” on page 195


A.2.1 MySQL on Linux


Depending on the options you select when installing Open Enterprise Server 2 and SUSE Linux 
Enterprise Server (SLES), the MySQL database server might be installed along with the operating 
system. Check for the following directory:


/usr/bin/mysql


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Java JDK Location on the Basic Vibe Installation Summary Sheet, specify the directory where you install 
the JDK. The Vibe installation program prompts you for this location.


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Java JDK Location on the Basic Vibe Installation Summary Sheet, specify the directory where you install 
the JDK. The Vibe installation program prompts you for this location.
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If the /usr/bin/mysql directory does not exist, you need to install the MySQL database server. If 
MySQL is already installed, you still need to configure it for use with Vibe.


 “Installing MySQL” on page 194
 “Configuring MySQL” on page 194
 “Learning More about MySQL” on page 195


Installing MySQL


1 Make sure you have access to your operating system installation media.
2 In YaST, click Software > Software Management.
3 In the Search field, type mysql, then click Search.
4 Select mysql, then click Accept.
5 Click Continue to resolve dependencies.
6 Click Continue to acknowledge package support status.


MySQL is then installed from the SLES media.
7 Continue with “Configuring MySQL” on page 194.


Configuring MySQL


When MySQL is initially installed, it is not configured with an administrator password, nor is it 
configured to start automatically. Follow the steps below to set up the MySQL database server for use 
with Vibe:


1 In YaST, click System > System Services.
2 Scroll to and select the MySQL service, then click Enable.
3 Click Continue to install dependencies, then click OK to close the status box.
4 Click OK > Yes to finish the installation, then exit YaST.
5 In a terminal window, become the root user.
6 To verify that the MySQL database server has started, use the following command:


ps -eaf | grep mysql


You should see MySQL processes running. 
7 Set the administrator password for the MySQL database server:


mysqladmin -u root password new_password


This command changes the password for the MySQL root user, which is the default 
administrator username for the MySQL database server. This command is part of the MySQL 
client package.


IMPORTANT: The MySQL root username is not the same as the Linux root user. The Linux 
root user has a password established for it when you install Linux. In a parallel fashion, the 
MySQL root user needs to have a password established for it when you install MySQL. 


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Database Credentials on the Basic Vibe Installation Summary Sheet, specify the MySQL administrator 
password. The Vibe installation program prompts you for this information.
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Learning More about MySQL


The following table includes some basic and useful MySQL commands:


If you want to administer MySQL through a GUI interface, you can download tools from:


MySQL GUI Tools Downloads (http://dev.mysql.com/downloads/gui-tools/5.0.html)


For more information about MySQL, see:


MySQL Documentation (http://dev.mysql.com/doc)


A.2.2 MySQL on Windows


1 In your Web browser, go to the following URL:
MySQL 5.1 Downloads (http://dev.mysql.com/downloads/mysql/5.1.html)


2 Scroll down if necessary, then click the type of Windows operating system you are using (32-bit 
or 64-bit).


3 On the Windows Essentials line, click Download.
4 Click Save File, browse to and select a convenient temporary directory, then click Save. 
5 In Windows Explorer, browse to the directory where you saved the MySQL .exe file. 
6 Double-click the MySQL .exe file to start the MySQL Setup Wizard.
7 Follow the online instructions to install the MySQL software on the Windows server, then 


continue with Step 8 to configure the server.
8 Unless you are already familiar with configuring MySQL on a Windows server, select Standard 


Configuration, then click Next.
9 Select Include Bin Directory in Windows PATH, then click Next.


10 Set the MySQL root user password, then click Next.


11 Click Execute to configure the MySQL database server, then click Finish.
Some messages report the status of your MySQL installation.


12 To monitor the MySQL database server, click Start > All Programs, then click MySQL > MySQL 
Server 5.1 > MySQL Command Line Client.


Action Command


Stop MySQL /etc/initd/mysql stop


Start MySQL /etc/initd/mysql start


Show MySQL status mysqladmin -u root -p extended-status


BASIC VIBE INSTALLATION SUMMARY SHEET


Under Database Credentials on the Basic Vibe Installation Summary Sheet, specify the MySQL 
administrator password. The Vibe installation program prompts you for this information.
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B BThird-Party Materials


 Section B.1, “ANTLR 3 License,” on page 197
 Section B.2, “Colt License Agreement,” on page 198
 Section B.3, “Dom4j License,” on page 198
 Section B.4, “iCal4j License,” on page 199
 Section B.5, “ICU4J license (ICU4J 1.3.1 and later),” on page 199
 Section B.6, “JAXEN License,” on page 200
 Section B.7, “Jung,” on page 200
 Section B.8, “ASM,” on page 201
 Section B.9, “Firebug Lite,” on page 202


B.1 ANTLR 3 License
Copyright (c) 2003-2008, Terence Parr


All rights reserved.


Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met


 Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer. 


 Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution. 


 Neither the name of the author nor the names of its contributors may be used to endorse or 
promote products derived from this software without specific prior written permission.


THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE. 
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B.2 Colt License Agreement
Packages cern.colt*, cern.jet*, cern.clhep 


Copyright (c) 1999 CERN - European Organization for Nuclear Research.
Permission to use, copy, modify, distribute and sell this software and its documentation for any 
purpose is hereby granted without fee, provided that the above copyright notice appear in all 
copies and that both that copyright notice and this permission notice appear in supporting 
documentation. CERN makes no representations about the suitability of this software for any 
purpose. It is provided “as is” without expressed or implied warranty. 


Packages hep.aida.* 
Written by Pavel Binko, Dino Ferrero Merlino, Wolfgang Hoschek, Tony Johnson, Andreas 
Pfeiffer, and others. Check the FreeHEP home page for more info. Permission to use and/or 
redistribute this work is granted under the terms of the LGPL License, with the exception that 
any usage related to military applications is expressly forbidden. The software and 
documentation made available under the terms of this license are provided with no warranty.


B.3 Dom4j License
Copyright 2001-2005 (C) MetaStuff, Ltd. All Rights Reserved.


Redistribution and use of this software and associated documentation (“Software”), with or without 
modification, are permitted provided that the following conditions are met: 


1. 1.Redistributions of source code must retain copyright statements and notices. Redistributions 
must also contain a copy of this document.


2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution. 


3. The name “DOM4J” must not be used to endorse or promote products derived from this 
Software without prior written permission of MetaStuff, Ltd. For written permission, please 
contact dom4j-info@metastuff.com.


4. The name “DOM4J” must not be used to endorse or promote products derived from this 
Software without prior written permission of MetaStuff, Ltd. For written permission, please 
contact dom4j-info@metastuff.com. 


5. Products derived from this Software may not be called “DOM4J” nor may “DOM4J” appear in 
their names without prior written permission of MetaStuff, Ltd. DOM4J is a registered 
trademark of MetaStuff, Ltd. 


6. Due credit should be given to the DOM4J Project (http://www.dom4j.org).


THIS SOFTWARE IS PROVIDED BY METASTUFF, LTD. AND CONTRIBUTORS “AS IS”' AND ANY 
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL METASTUFF, LTD. OR ITS CONTRIBUTORS BE LIABLE 
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, 
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE 
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.


Copyright 2001-2005 (C) MetaStuff, Ltd. All Rights Reserved.
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B.4 iCal4j License
Copyright (c) 2008, Ben Fortuna


All rights reserved.


Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:


 Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer.


 Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution.


 Neither the name of Ben Fortuna nor the names of any other contributors may be used to 
endorse or promote products derived from this software without specific prior written 
permission.


THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.


B.5 ICU4J license (ICU4J 1.3.1 and later)
COPYRIGHT AND PERMISSION NOTICE


Copyright (c) 1995-2001 International Business Machines Corporation and others


All rights reserved.


Permission is hereby granted, free of charge, to any person obtaining a copy of this software and 
associated documentation files (the "Software"), to deal in the Software without restriction, including 
without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the 
Software, and to permit persons to whom the Software is furnished to do so, provided that the above 
copyright notice(s) and this permission notice appear in all copies of the Software and that both the 
above copyright notice(s) and this permission notice appear in supporting documentation.


THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY 
RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS 
NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL 
DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR 
PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS 
ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS 
SOFTWARE.
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Except as contained in this notice, the name of a copyright holder shall not be used in advertising or 
otherwise to promote the sale, use or other dealings in this Software without prior written 
authorization of the copyright holder. 


B.6 JAXEN License
Copyright (C) 2000-2002 Bob McWhirter & James Strachan.


All rights reserved.


Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:


1. Redistributions of source code must retain the above copyright notice, this list of conditions, and 
the following disclaimer.


2. Redistributions in binary form must reproduce the above copyright     notice, this list of 
conditions, and the disclaimer that follows these conditions in the documentation and/or other 
materials provided with the distribution.


3. The name “Jaxen” must not be used to endorse or promote products     derived from this 
software without prior written permission. For written permission, please contact 
license@jaxen.org.


4. Products derived from this software may not be called “Jaxen,” nor may “Jaxen” appear in their 
name, without prior written permission from the Jaxen Project Management (pm@jaxen.org).


In addition, we request (but do not require) that you include in the end-user documentation 
provided with the redistribution and/or in the software itself an acknowledgement equivalent to the 
following:


“This product includes software developed by the Jaxen Project (http://www.jaxen.org).”


Alternatively, the acknowledgment may be graphical using the logos available at http://
www.jaxen.org.


THIS SOFTWARE IS PROVIDED “AS IS” AND ANY EXPRESSED OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY 
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
Jaxen AUTHORS OR THE PROJECT CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.


This software consists of voluntary contributions made by many individuals on behalf of the Jaxen 
Project and was originally created by bob mcwhirter (bob@werken.com) and James Strachan 
(jstrachan@apache.org). For more information on the Jaxen Project, please see http://www.jaxen.org.


B.7 Jung
THE JUNG LICENSE


Copyright (c) 2003-2004, Regents of the University of California and the JUNG Project
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All rights reserved.


Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:


 Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer.


 Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution.


 Neither the name of the University of California nor the names of its contributors may be used to 
endorse or promote products derived from this software without specific prior written 
permission.


THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF 
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.


B.8 ASM
Copyright (c) 2000-2005, INRIA, France Telecom


All rights reserved.


Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:


 Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer.


 Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution.


 Neither the name of the copyright holders nor the names of its contributors may be used to 
endorse or promote products derived from this software without specific prior written 
permission.


THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
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ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF 
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.


B.9 Firebug Lite
Copyright (c) 2006-2007, Joe Hewitt


All rights reserved.


Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:


 Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer.


 Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution.


 Neither the name of the copyright holders nor the names of its contributors may be used to 
endorse or promote products derived from this software without specific prior written 
permission.


THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF 
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Quick Start


You can synchronize your Novell Vibe files with your computer, then modify the files without accessing the Vibe site directly. 
Additions and modifications are synchronized between Vibe and your computer. If you delete a Vibe file from your desktop, it 
is not deleted in Vibe, and is synchronized back to your desktop at the next synchronization.


Your Vibe administrator must enable this functionality in order for it to be available. For information on how administrators can 
enable this functionality, see “Configuring Vibe Desktop and the Microsoft Office Add-In” in the  Novell Vibe 3.2 Administration 
Guide.


Getting Started


 “Understanding Synchronization” on page 1


 “Downloading and Installing Vibe Desktop” on page 1


 “Configuring Vibe Desktop for the First Time” on 
page 2


UNDERSTANDING SYNCHRONIZATION


 “When Synchronization Occurs” on page 1


 “Which Folders Are Synchronized” on page 1


 “What Actions Are Supported” on page 1


 “What Actions Are Not Supported” on page 1


When Synchronization Occurs


Synchronization occurs at an interval designated by your 
Vibe administrator. The default is every 15 minutes.


You can manually synchronize files if you do not want to 
wait for the scheduled synchronization. For more 
information, see “Manually Synchronizing Files” on page 3.


Which Folders Are Synchronized


Only files in Files folders and Photo Album folders within 
your personal workspace are synchronized by default.


You can easily configure files in Files folders and Photo 
Album folders within your teams or followed places to be 
synchronized, as described in “Synchronizing Your Teams 
and Favorite Places” on page 3.


It is possible to configure other types of Vibe folders (such 
as Blog folders or Wiki folders) within your personal 
workspace, team workspaces, or followed places to be 
synchronized. For information on how to accomplish this, 
see “Configuring Folders to Be Synchronized” on page 4.


What Actions Are Supported


When you perform any of the following actions on 
documents, the action is synchronized between your 
computer’s file system and the Vibe server:


 Create documents


 Modify documents


What Actions Are Not Supported


In order to prevent you from inadvertently making changes 
on the Vibe server that you do not want to make, the 
following actions are not synchronized between your 
computer’s file system and the Vibe server:


 Delete documents


 Delete folders


 Create folders


DOWNLOADING AND INSTALLING VIBE DESKTOP


1 On your personal workstation, download Vibe Desktop 
from the Novell Downloads Web site (http://
download.novell.com/Download?buildid=-
WYcs2nWDPQ~), or by accessing the Novell Beta 
Program Site (http://www.novell.com/beta/)..


2 Run the downloaded NovellVibeDesktop-x86-
version-B5.msi file or NovellVibeDesktop-x64-
version-B5.msi file, depending on whether you have 
a 32-bit or 64-bit operating system.



http://download.novell.com/Download?buildid=-WYcs2nWDPQ~

http://www.novell.com/beta/

http://www.novell.com/beta/





3 Click Next.


4 Accept the license agreement, then click Next.


5 Change the installation location for Vibe Desktop, or 
simply click Next to accept the default location.


6 Click Install.


7 Click Finish when the installation is complete, then 
continue with “Configuring Vibe Desktop for the First 
Time” on page 2.


CONFIGURING VIBE DESKTOP FOR THE FIRST TIME


After you have downloaded and installed Vibe Desktop as 
described in “Downloading and Installing Vibe Desktop” on 
page 1, you are prompted to configure it. This process 
includes entering account information, choosing which 
workspaces and folders to synchronize, and choosing 
where to store information on your computer’s file system.


1 Click Start to begin setting up Vibe Desktop.


2 In the Account Information section, specify the 
following information:


Account Name: Specify a descriptive name for the 
Vibe account. A folder with this name is created in your 
user directory in the file system.


Server URL: Specify the URL for the Vibe site where 
you want to synchronize files to your computer. For 
example, https://vibe.mycompany.com.


Username: Specify the Vibe username that you use to 
log in to the Vibe site.


Password: Specify the Vibe password that you use to 
log in to the Vibe site.


3 Click Next.


4 In the Synchronized Workspaces section, click Add, 
select which folders and workspaces you want to 
synchronize, then click OK.


Files folders and Photo Album folders within your 
personal workspace are synchronized by default. You 
can select Files folders and Photo Album folders in 
your teams or followed places to be synchronized. For 
more information about how to enable other kinds of 
folders to be synchronized, see “Configuring Folders to 
Be Synchronized” on page 4.


5 Click Next.


6 In the Vibe Desktop Folder section, click Browse if you 
want to change the installation location for Vibe 
Desktop, or simply click Next to accept the default 
location.


7 Click Next > Finish.


Vibe Desktop is now running, and the Vibe Desktop 


icon  is visible in the notification area.
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Viewing Vibe Files from Your Computer


1 Double-click the Vibe Desktop icon  in the 
notification area.


or


Right-click the Vibe Desktop icon  in the notification 
area, then click Open Vibe Desktop Folder.


You can access the Vibe folder directly from your file 
system. By default, Vibe Desktop synchronizes Vibe files to 
the Vibe Desktop folder on your file system, which is 
typically in the following location, depending on your 
operating system:


 Windows 7 or Vista: c:\Users\username\Vibe


 Windows XP: c:\Docuents and 
Settings\username\My Documents\Vibe


On Windows Vista, the Vibe folder is also located in your 
Favorites.


On Windows 7, the Vibe folder is also located in your 
Favorites and in your Libraries.


For information on how to change the default location, see 
“Changing the Vibe Desktop Location on Your File System” 
on page 4.


You should not synchronize files to a location on a network 
that can be accessed by multiple computers. If the Vibe 
Desktop folder is on a network location that is accessed by 
multiple computers, synchronization issues can occur when 
Vibe files accessed from either computer are out of sync 
with each other and with what is on the Vibe server.


Manually Synchronizing Files


You can manually synchronize files between Vibe and your 
computer if you do not want to wait for the scheduled 
synchronization.


1 Right-click the Vibe Desktop icon  in the notification 
area, then click Synchronize Now.


Launching Vibe in a Browser from Vibe 
Desktop


You can launch Novell Vibe in a browser by using Vibe 
Desktop.


1 Right-click the Vibe Desktop icon  in the notification 
area, then click Launch Novell Vibe.


Viewing Recent Activity


You can view activity that has recently taken place with 
Vibe Desktop. For example, you can see the date and time 
that Vibe folders were synchronized, which files were 
modified, and so forth.


To view recent Vibe Desktop activity:


1 Right-click the Vibe Desktop icon  in the notification 
area, then click Open Desktop Console.


2 Click Recent Activity.


Viewing System Alerts


Vibe Desktop might need to make you aware of various 
alerts, such as new software updates, expired passwords, 
server downtime, and so forth.


To view system alerts:


1 Right-click the Vibe Desktop icon  in the notification 
area, then click Open Desktop Console.


2 Click System Alerts.


Synchronizing Your Teams and Favorite 
Places


When you first configure Vibe Desktop, you can choose 
workspaces and folders in your teams or favorite places to 
synchronize. You can also configure Vibe Desktop to 
synchronize files in your teams and favorite places any time 
after the initial configuration.


Before you can synchronize favorite workspaces and 
folders, you must ensure that the workspaces and folders 
that you want to synchronize have been added as favorites 
in Vibe. For information on how to add a workspace or 
folder as a favorite, see “Adding a Favorite Place” in the 
Novell Vibe 3.2 User Guide.
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To configure your teams and favorite places in Vibe to be 
synchronized to your computer:


1 Right-click the Vibe Desktop icon  in the notification 
area, then click Open Desktop Console.


2 Click Synchronized Workspaces to display the 
workspaces that are currently being synchronized.


3 Click Add.


4 Expand My Teams and My Favorites, then select the 
workspace or folder that you want to be synchronized 
to your computer.


By default, only Files folders and Photo Album folders 
can be synchronized. Folders that are dimmed cannot 
be selected by default. For information on how to 
configure these folders to be synchronized, see 
“Configuring Folders to Be Synchronized” on page 4.


5 Click OK.


Configuring Folders to Be Synchronized


 “Synchronizing Files Folders and Photo Album 
Folders” on page 4


 “Mirrored Files Folder and Micro-Blog Folder 
Synchronization” on page 4


 “Synchronizing All Other Folder Types” on page 4


SYNCHRONIZING FILES FOLDERS AND PHOTO ALBUM 
FOLDERS


Files folders and Photo Album folders can be easily 
synchronized to your computer with Vibe Desktop because 
they require each file to have a unique name. For more 
information on how to synchronize Files folders and Photo 
Album folders that are not already synchronized, see 
“Synchronizing Your Teams and Favorite Places” on 
page 3.


MIRRORED FILES FOLDER AND MICRO-BLOG FOLDER 
SYNCHRONIZATION


Synchronizing Mirrored Files folders and Micro-Blog folders 
is not supported in this release of Vibe Desktop.


SYNCHRONIZING ALL OTHER FOLDER TYPES


Other types of Vibe folders such as Blog folders and Wiki 
folders must first be configured in Vibe in order to be 
synchronized with Vibe Desktop because by default these 
types of folders allow you to add multiple files with the same 
name to a single folder. Synchronizing folders that have 
multiple files with the same name would be confusing in 
Vibe Desktop because when you view a folder through Vibe 
Desktop, you see only the files that are within the folder and 
not the entries that contain each file.


You can configure folders such as Blog folders to require 
unique filenames if you have rights to edit the folder in Vibe. 
After you configure a folder in this way, you can then 
synchronize the folder to your computer with Vibe Desktop.


1 When you access Vibe from your browser, navigate to 
the folder that you want to configure to support Vibe 
Desktop.


2 Click Folder > Edit Folder in the Action toolbar.


3 Near the bottom of the page, select Require that all 
files uploaded into this folder have a unique name.


4 Click OK.


Changing the Vibe Desktop Location on Your 
File System


By default, Vibe Desktop is installed in the 
c:\Users\username\Vibe folder on your file system.


The Vibe folder contains a folder named after the Vibe 
account name that you created when you first configured 
Vibe Desktop, as described in “Configuring Vibe Desktop 
for the First Time” on page 2. This folder contains all of your 
synchronized files. To quickly access this folder, follow the 
steps in “Viewing Vibe Files from Your Computer” on 
page 3.


When you first configure Vibe Desktop, you can specify the 
installation location on your file system. You can change the 
location of the Vibe folder at any time after initial 
configuration:


1 Right-click the Vibe Desktop icon  in the notification 
area, then click Open Desktop Console.


2 Click Vibe Desktop Folder, then click Browse to 
browse to the new location on the file system where 
you want the Vibe folder to reside.


3 Click OK > Apply.
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Changing Your Vibe Account Information for 
Vibe Desktop


When you first configure Vibe Desktop, you specify your 
account information and Vibe server information. You can 
change your Vibe Desktop account information and Vibe 
server information at any time after the initial configuration: 


1 Right-click the Vibe Desktop icon  in your 
notification area.


2 Click Open Desktop Console.


3 Click Account Information in the Novell Vibe Desktop 
Console dialog box.


4 Specify the following information:


Account Name: Specify a descriptive name for the 
Vibe account. A folder with this name is created in your 
user directory in the file system.


Server URL: Specify the URL for the Vibe site where 
you want to synchronize files to your computer. For 
example, https://vibe.mycompany.com.


Username: Specify the Vibe username that you use to 
log in to the Vibe site.


Password: Specify the Vibe password that you use to 
log in to the Vibe site.


5 Click Apply.


Uninstalling Novell Vibe Desktop


If you have upgraded Vibe Desktop since the beta release, 
you might want to uninstall Vibe Desktop before you install 
the shipping version. Complete the following sections to 
completely uninstall Vibe Desktop:


 “Uninstalling Vibe Desktop from the Windows Control 
Panel” on page 5


 “Deleting the Vibe Directory” on page 5


 “Deleting Registry Keys” on page 5


 “Deleting Credentials” on page 5


UNINSTALLING VIBE DESKTOP FROM THE WINDOWS 
CONTROL PANEL


1 Click the Start icon, then click Control Panel.


2 Click Programs > Uninstall a program.


3 Select Novell Vibe Desktop > Uninstall.


DELETING THE VIBE DIRECTORY


The location of the Vibe directory differs depending on your 
operating system:


Windows Vista or Windows 7: 


UserProfile\AppData\Local\Novell\Vibe


Windows XP: UserProfile\Local 
Settings\Application\Data\Novell\Vibe


DELETING REGISTRY KEYS


1 Click the Start icon, then click Run.


If Run does not appear, type Run in the Search field, 
then press Enter.


2 Type regedit, then click OK.


3 Delete the following registry keys if they exist:


 \\HKEY_CURRENT_USER\Software\Novell\Vibe 
Desktop


 \\HKEY_LOCAL_MACHINE\Software\Novell\Vibe  
Desktop


DELETING CREDENTIALS


NOTE: These credentials are shared with the Novell Vibe 
Add-in for Microsoft Office. If you are running the Vibe Add-
in, you should not delete these credentials.


On Windows Vista and Windows 7


1 Click the Start icon, then click Control Panel.


2 Click User Accounts and Family Safety > Credential 
Manager.


3 Remove credentials beginning with 
Novell.Collaboration.Vibe.
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On Windows XP


1 Click Start, then click Control Panel.


2 Double-click User Accounts.


3 Click the user account that you are logged in as.


4 Click Manage my network passwords.


5 Remove credentials beginning with 
Novell.Collaboration.Vibe.


Known Issues


For a list of known issues, see the Novell Vibe Desktop 
Readme (http://www.novell.com/documentation/vibe32/
vibe_readme_desktop1/data/vibe_readme_desktop1.html).


Legal Notices: Copyright © 2011-2012 Novell, Inc. All rights reserved. No part of this 
publication may be reproduced, photocopied, stored on a retrieval system, or transmitted 
without the express written consent of the publisher. For Novell trademarks, see the Novell 
Trademark and Service Mark list (http://www.novell.com/company/legal/trademarks/
tmlist.html). All third-party trademarks are the property of their respective owners.
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Quick Start


When you begin to use Novell Vibe, the first thing you might want to do is set up your personal workspace and create a team 
workspace. This document explains how to get started with Vibe by accomplishing these important tasks.


Starting Novell Vibe


1 Launch a Web browser such as Mozilla Firefox or 
Internet Explorer.


2 Specify the URL of your corporation’s Novell Vibe site.


3 In the User ID field, specify your Vibe username.


4 In the Password field, specify your Vibe password.


If you do not know your Vibe username and password, 
contact your Vibe administrator.


5 Click OK.


Getting to Know the Novell Vibe Interface and 
Its Features


When you first launch Novell Vibe, you see the What’s New 
page.


You can easily navigate to your personal workspace by 
clicking My Workspace, which includes the following 
toolbars and features:


 “Understanding the Masthead” on page 1


 “Understanding the Navigation Panel” on page 2


 “Understanding the Action Toolbar” on page 2


 “Understanding the Relevance Tabs in the Home Page 
of Your Personal Workspace” on page 2


 “Understanding the Content Area” on page 2


UNDERSTANDING THE MASTHEAD


The Masthead contains the following features:


Personal Workspace Link: Quickly access your personal 
workspace by clicking your linked name.


Log Out Link: Logs you out of the Vibe site.


Settings:  Displays the following options:


 Personal Preferences:  Displays your personal 
preferences, such as the way you want entries to be 
displayed and how many entries you want to appear 
on a given page.







 News Feed:  Displays live feeds of the latest 
entries in your teams, places you are following, or 
across the entire site.


 Vibe Resource Library:  Displays the Vibe 
Resource Library, which includes additional 
information and resources, including downloadable 
custom forms and workflows, relevant articles, and 
more.


 Help:  Displays the Vibe Help documentation.


UNDERSTANDING THE NAVIGATION PANEL


The Navigation panel contains a navigation tree that 
displays the current workspace and all sub-workspaces and 
sub-folders.


UNDERSTANDING THE ACTION TOOLBAR


The Action toolbar contains the following features:


Expand/Contract Navigation Panel Icon:  Hides and 
displays the Navigation panel.


Expand/Contract Masthead Icon:  Hides and displays 
the Masthead.


Workspace Toolbar Icon:  Displays the Workspace 
toolbar, which enables you to quickly navigate to any 
location where you have appropriate rights.


My Workspace: Displays your personal workspace.


What’s New: Displays the What’s New page, where you 
can quickly see what’s new in your teams, favorite places, 
and more.


My Favorites: Enables you to add a place as a favorite, or 
to quickly visit your favorite places on the Vibe site.


My Teams: Displays links to all of the team workspaces 
where you are a member.


Recent Places: Displays the places that you have most 
recently visited.


Workspace: (This option is displayed only when you are 
viewing a workspace.) Provides various functions that 
enable you to manage the workspace, including adding 
new folders, managing access control, configuring the 
workspace, and more.


Folder: (This option is displayed only when you are viewing 
a folder.) Provides various functions that enable you to 
manage the folder, including adding new folders, managing 
access control, configuring the folder, and more.


View: Enables you to accomplish various tasks, such as 
seeing what’s new or unread in the workspace or folder, 
viewing who has access, viewing the Vibe clipboard, and 
accessing the Vibe Trash.


Search: Enables you to search the entire site for entries, 
places, and people. You can locate subject-matter experts, 
or see what information is available concerning a particular 
topic.


Click the Search Options icon  if you want to specifically 
search for a person, place, or a tag. You can also use a 
saved search or perform an Advanced Search. 


UNDERSTANDING THE RELEVANCE TABS IN THE HOME 
PAGE OF YOUR PERSONAL WORKSPACE


The home page of your personal workspace contains 
various tabs that are designed to help facilitate your work. 
Use these tabs as a central location where you can quickly 
be informed of new entries, upcoming tasks, your daily 
meetings, and more.


What’s New: Enables you to quickly see new entries in 
your teams, places you are following, or across the entire 
site.


Recent: Enables you to view entries that you have recently 
posted, and entries that you have recently visited. You can 
view who has recently visited your workspace, as well as 
see your personal tags.


Tasks and Calendars: Enables you to view tasks that are 
assigned to you, as well as today’s events from the 
calendars you are following.


Micro-Blogs and Shared Items: Enables you to view the 
micro-blog entries of the people you are following, as well 
as items that people have shared with you.


Accessories: Contains an Accessory panel that lists 
entries from your Guestbook, Blog, and Photo Album 
folders. 


UNDERSTANDING THE CONTENT AREA


The Content Area in Vibe is where the majority of 
information is displayed, such as workspaces, folders, and 
entries.


Setting Up Your Personal Workspace


Before you take advantage of all of the features and 
functionality of Novell Vibe, you might want to customize 
your personal workspace. 


 “Modifying Your Profile” on page 3


 “Branding Your Workspace” on page 3
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MODIFYING YOUR PROFILE


You might need to manually update your profile in order for 
important contact information to be seen, such as your e-
mail address, phone number, time zone, and picture.


Another reason to modify your profile is to publicize your 
skills and past experience to other Vibe users. One 
advantage of Vibe is the ability to find experts on any 
subject within your organization. You, as a Vibe user, have 
the ability to be a subject-matter expert.


NOTE: If you are unable to modify your personal 
information (such as your Vibe password) as described in 
this section, it is most likely because your personal 
information is being synchronized from an external 
directory server. You must consult your Vibe administrator 
to make changes.


1 In the home page of your personal workspace, click 
the Profile link next to your name and avatar.


or


Click your Presence icon , located next to any entry 
that you have created or modified, then click Profile.


Your profile is displayed.


If you are a new user, your profile probably does not 
currently contain much information.


2 Click Edit in the upper right corner of the profile.


The User page is displayed. 


3 Change your password, e-mail address, phone 
number, time zone, language of the interface, upload a 
picture, and more.


4 When you are finished modifying your profile, click OK.


BRANDING YOUR WORKSPACE


Adding a personal brand to your workspace can enhance 
the appearance of your workspace and make you feel more 
at home.


1 Navigate to your personal workspace.


2 Click Workspace > Brand Workspace.


The Workspace/Folder Branding dialog box is 
displayed.


3 Specify the following information to create your desired 
brand:


Use Branding Image: Select this option if you want to 
use the drop-down list to select an existing image, or 
click the Browse icon  to browse to an image on 
your computer’s file system.


Use Advanced Branding: Select this option, then 
click Advanced if you want to create a brand that 
includes advanced features, such as a YouTube video.


You can add a YouTube video in your branding section 


by clicking the Video icon .


Background Image: Click the Browse icon  to 
browse to an image on your computer’s file system. 
The provided drop-down list contains images only if 
you are branding a team workspace and if you have 
attached images to the workspace


The background image is displayed behind your 
regular branding.


Stretch Image: Stretches the background image so 
that it occupies the entire branding area. 


If you stretch your background image, the image 
overrides any background color that you have set.


Background Color: Adds a background color that 
occupies the entire branding area. To change the 
background color, click the color name to the right of 
this field, select the new color, then click OK.


If you added a background image and stretched the 
image, the background color is not displayed.


Text Color: Changes the text color of the workspace 
name in the upper right corner of the branding area. To 
change the text color, click the color name to the right 
of this field, select the new color, then click OK.


Clear branding: Click this option to clear all of your 
current branding selections.


4 Click OK.


Your workspace now displays the brand that you 
created.


Creating a Team Workspace


By default, everyone in Novell Vibe has rights to create a 
team workspace.


Team workspaces are the most common type of 
workspaces. They facilitate team objectives by enabling 
team members to quickly share files, share ideas, and work 
together more efficiently and effectively.


To create a team workspace:


1 Click the Browse icon  in the Action toolbar, then 
expand Home Workspace in the Workspace tree.


The Home Workspace directory is the highest-level 
folder in the workspace tree, and might be named 
something specific to your organization.


2 Click Team Workspaces.


3 Click Add a Team Workspace.


The Add a Team Workspace page is displayed.


If you do not see the Add a Team Workspace option, 
your site administrator has not permitted you to create 
a new workspace at this level. Continue to expand the 
workspace tree, following the path of your 
organizational unit, click the name of the directory 
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where you want to create the new team workspace, 
then click Workspace > New Workspace. Ensure that 
you select Team Workspace in the Workspace section. 


4 Specify the following information:


Title: Provide a title for the workspace. 


Team Members: Specify the team members.


You can specify individual users, entire groups, or add 
names that are on your clipboard. 


Workspace Folders: Select the folders that you want 
the workspace to contain.


If you later decide that you want to add additional 
folders, you can add them at any time. 


Announcement: (Optional) Select the check box, 
then type a message in the Announcement Text field.


This message informs team members about the 
existence of the workspace, and can also explain the 
value of the workspace.


5 Click OK to create the new workspace.


Using Novell Vibe Folders


Novell Vibe includes multiple types of folders that enable 
you to organize the various kinds of information in your 
workspaces.


 “Discussion” on page 4


 “Blog” on page 4


 “Calendar” on page 4


 “Guestbook” on page 4


 “Files” on page 4


 “Milestones” on page 4


 “Micro-Blog” on page 4


 “Mirrored Files” on page 4


 “Photo Album” on page 5


 “Surveys” on page 5


 “Tasks” on page 5


 “Wiki” on page 5


DISCUSSION


Use discussions as a way of obtaining comments and 
feedback to questions and thoughts that you might have. 
You can start general discussion threads in the Discussion 
folder in your personal workspace. For discussion threads 
that are more specific to a project and team, start the 
discussion thread in the Discussion folder of an appropriate 
team workspace.


BLOG


Blogs are a good way to express your thoughts about 
topics that are important to you. For example, if you are 
working on a project and are responsible for a certain 
aspect of that project, you can update your team on your 
individual progress by posting a blog in the Blog folder in 
the team workspace.


CALENDAR


Vibe enables you to create a Calendar folder in any 
workspace that you desire. You can maintain a personal 
calendar in your personal workspace, and then add 
separate calendars in your team workspaces to keep track 
of events that are specific to that team.


GUESTBOOK


The Guestbook folder in Vibe is a place to store all of your 
guestbook entries. By default, users can sign your 
Guestbook by clicking the Overview tab on the home page 
of your personal workspace. This is a quick way for your 
friends and co-workers to communicate with you.


FILES


Files folders in Vibe make it easy to store and keep track of 
your files. You can store personal files in the Files folder in 
your personal workspace, and team-related files in your 
individual team folders. This makes it easy to share files 
with your teammates and others who might be interested in 
viewing them.


MILESTONES


Milestones folders track the progress of several Tasks 
folders. Milestones folders are most often used in Project 
Management workspaces, although they can also be used 
in other workspaces. 


MICRO-BLOG


The Micro-Blog folder in Vibe is a place to store all of your 
micro-blog entries. Use the Micro-Blog feature to capture 
quick personal notes, or to inform others of what you are 
currently working on. This provides a greater transparency, 
so those you work with know what you are doing, and how 
they might offer assistance to help you accomplish your 
tasks.


You can navigate to someone else’s Micro-Blog folder to 
see what they have been working on, and possibly provide 
help by sharing your knowledge and experience.


MIRRORED FILES


Mirrored Files folders use a reference to a file system on an 
external server, instead of the Vibe file system where other 
Vibe information is stored. Mirrored Files folders can 
reference any WebDAV or local file path.

4







PHOTO ALBUM


Photo albums store and display pictures. You can store 
your personal photos in the Photo Album in your personal 
workspace, and team-related photos in the Photo Album of 
the team workspace.


SURVEYS


Surveys folders store surveys that you or other Vibe users 
have created. Surveys enable you to poll team members, or 
any other Vibe users, about issues that are important to 
you, your team, or your company.


TASKS


Tasks folders keep track of the progress made in 
completing work assignments. Vibe enables you to create a 
Tasks folder in any workspace that you desire. You can 
maintain a personal Tasks folder in your personal 
workspace, and then add separate Tasks folders in your 
team workspaces to keep track of tasks that are specific to 
that team.


WIKI


Wiki folders contain wiki entries. A wiki is a set of related 
entries coauthored by folder participants. For example, the 
best-known wiki on the Internet is Wikipedia. Other 
examples of possible wiki content are glossaries, or policies 
and procedures.


Displaying Help Documentation


1 Click the Settings icon  in the upper right corner of 
each Vibe page, then click the Novell Vibe Help icon 


.


When you click this icon, Vibe displays the Vibe User 
Guide in a new browser window.


Legal Notices: Copyright © 2010-2011 Novell, Inc. All rights reserved. No part of this 
publication may be reproduced, photocopied, stored on a retrieval system, or transmitted 
without the express written consent of the publisher. For Novell trademarks, see the Novell 
Trademark and Service Mark list (http://www.novell.com/company/legal/trademarks/
tmlist.html). All third-party trademarks are the property of their respective owners.
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Quick Start


The Novell Vibe Add-in for Microsoft Office enables you to work with documents on the Vibe site without leaving Microsoft 
Office. You can easily browse to a document that is located on the Vibe site, open the document, edit it, then save it back to 
the Vibe site, directly from Microsoft Office.


You can work directly from Microsoft Word, Excel, or PowerPoint documents.


Getting Started


 “System Requirements” on page 1


 “Installing the Vibe Add-In” on page 1


 “Setting Up the Integration” on page 2


SYSTEM REQUIREMENTS


To use the Vibe Add-in, ensure that your software meets 
the following prerequisites:


 Windows XP, Vista, or 7


The Vibe Add-in is not currently available for Mac


 Microsoft Office 2007 or 2010 (Word, Excel, and 
PowerPoint documents are supported)


 Novell Vibe 3.2 or later configured with HTTPS


INSTALLING THE VIBE ADD-IN


1 On your personal workstation, download the Vibe Add-
in from the Novell Downloads Web site (http://
download.novell.com/Download?buildid=-
WYcs2nWDPQ~), or by accessing the Novell Beta 
Program Site (http://www.novell.com/beta/).


2 Run the VibeAddinSetup-B5.exe file to install the 
Vibe Add-in and run the installation wizard.


3 Click Next.


4 Accept the license agreement, then click Next.


5 Browse to the location where you want to install the 
Vibe Add-in, or accept the default location, then click 
Next.


6 Click Install to begin the installation.


7 After the installation is complete, click Finish.


8 Continue with “Setting Up the Integration” on page 2.



http://download.novell.com/Download?buildid=-WYcs2nWDPQ~

http://www.novell.com/beta/

http://www.novell.com/beta/





SETTING UP THE INTEGRATION


After you download and install the Vibe Add-in as described 
in “Installing the Vibe Add-In” on page 1, you need to point 
the Vibe Add-in to a Vibe system as a repository.


You can configure the Vibe Add-in to connect to multiple 
Vibe sites. Simply repeat the process described in this 
section to configure multiple accounts.


1 In Microsoft Office, click the Vibe tab, then click 
Accounts.


The Accounts dialog box is displayed.


2 Click Add, then specify the following information:


URL: Specify the URL of your Vibe site. For example, 
https://vibesite.com:8443


Username: Specify your Vibe username.


Password: Specify your Vibe password.


Use system proxy configuration: Select this option 
if you are accessing the Vibe site through a proxy 
server.


If selected, the Vibe Add-in uses the proxy settings 
defined in the Internet Options dialog box (accessed 
either through the Windows Control Panel or through 
Internet Explorer).


Contact your Vibe administrator if you are unsure 
whether you are accessing the Vibe site through a 
proxy server.


3 Click OK.


It might take a few seconds to validate your 
information. If the Vibe server you are connecting to 
does not have a valid certificate, you are prompted to 
accept it.


Creating a New Document


You can create a new document in Microsoft Office and 
save it directly to the Vibe site.


1 In Microsoft Office, create a new document.


2 Continue saving the document as described in “Saving 
a Document to the Vibe Site” on page 5.


Opening a Document


You can open a Vibe document by browsing to it directly 
from Microsoft Office, or you can open a Vibe document 
from the Vibe site, and configure the Vibe site to always 
launch the document in Microsoft Office.


 “Opening a Vibe Document from Microsoft Office” on 
page 2


 “Opening a Vibe Document from the Vibe Site” on 
page 2


OPENING A VIBE DOCUMENT FROM MICROSOFT OFFICE


 “Opening a Document You Recently Opened” on 
page 2


 “Opening a Document You Have Not Recently 
Opened” on page 2


Opening a Document You Recently Opened


1 In Microsoft Office, click the Vibe tab, then click the 
arrow beneath the Open icon to display a list of 
recently opened documents.


2 Click the document that you want to open.


Opening a Document You Have Not Recently Opened


1 In Microsoft Office, click the Vibe tab, then click Open.


You see your personal workspace, your favorite 
places, and your teams. 


2 (Conditional) If you have configured multiple Vibe 
sites, click the drop-down in the upper left corner of the 
dialog box to select the site that contains the document 
that you want to open.


3 Navigate to the document that you want to open by 
using one of the following methods:


 Expand the appropriate workspaces, then select 
the workspace or folder that contains the 
document that you want to open.


When you select a workspace, all documents that 
are contained in any sub-folder or sub-workspace 
in the workspace hierarchy are displayed.


 In the Search field, specify the name of the 
document that you want to locate on the Vibe site, 
then press Enter.


This searches entries as well as documents in all 
workspaces and folders where you have rights to 
view entries. It does not search for folder names.


 Select the folder in the Recent Places section if 
you are opening a Vibe document that you have 
recently opened or saved from Microsoft Office.


4 Select the document, then click Open.


OPENING A VIBE DOCUMENT FROM THE VIBE SITE


You can open a Vibe document in Microsoft Office directly 
from the Vibe site.


This feature is not implemented by default in this preview 
release. However, if you want to test this feature, you can 
configure Vibe to use Microsoft Office as the default 
document editor for Edit-in-Place functionality.
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Before you can open a Vibe document in Microsoft Office 
from the Vibe site as described in this section, you must 
first configure Vibe to use Microsoft Office as the default 
document editor for Edit-in-Place functionality. To do this:


1 In Vibe, click the Settings icon , then click the 


Personal Preferences icon  to display the Personal 
Preferences dialog box.


2 Click Define Editor Overrides.


3 Click Add.


4 In the Select an Extension drop-down list, select the 
type of extension that you want to edit using the Vibe 
Add-in.


For example, select .docx.


5 In the Application field, type addinedit /
application to configure Vibe to use the Vibe Add-in 
to edit all documents of the application type that you 
specify.


For example, to have Vibe use the Vibe Add-in to edit 
all Word documents, type addinedit /word in the 
Application field.


To open a Vibe document in Microsoft Office directly from 
the Vibe site after you have made the necessary 
configuration changes in Vibe:


1 Navigate to and open the entry that contains the file 
that you want to edit.


2 (Conditional) If the file that you want to edit is an 
attachment, click the Attachments tab.


Only Files folders can contain files that are not 
attachments.


3 Next to the file that you want to edit, click Edit This 
File.


The file is launched in Microsoft Office, if you have 
changed the default editor settings as previously 
discussed.


Editing an Existing Vibe Document


You can use Microsoft Office to directly edit documents that 
are located in your personal workspace, one of your team 
workspaces, or one of your favorite places on the Vibe site. 
Users can open the same document, edit it, and merge 
changes in near real time.


 “Editing Vibe Documents” on page 3


 “Co-Editing a Vibe Document” on page 3


 “Editing a Read-Only Document” on page 4


 “Editing a Document After Losing Connection to the 
Vibe Site” on page 4


EDITING VIBE DOCUMENTS


1 Open the document as described in “Opening a 
Document” on page 2.


2 Make the desired changes to the document.


3 Click Save.


A new version of this document is created in Vibe.


For information about how to save the document to a 
location on the Vibe site that is different from the 
location where the document currently resides, see 
“Saving a Document to the Vibe Site” on page 5.


CO-EDITING A VIBE DOCUMENT


Before you can co-edit documents as described in this 
section, the Vibe administrator must enable document co-
editing, as described in “Enabling Users to Edit Vibe 
Documents with Microsoft Office” in the  Novell Vibe 3.2 
Administration Guide.


To co-edit a document, multiple people open the same 
document and edit it simultaneously. If you want to restrict 
others from editing a document at the same time as you, 
you can lock the document, as described in “Locking a 
Document” on page 5.


To co-edit a Vibe document with the Vibe Add-in:


1 Open the same Vibe document that other collaborators 
have opened, then make your changes.


For information on how to open a Vibe document in 
Microsoft Office directly from Microsoft Office or from 
the Vibe site, see “Opening a Document” on page 2.


2 Click Save.


If the changes you made conflict with the changes of a 
collaborator, you are prompted to choose one of the 
following actions:


 Merge: Combines your edits with the edits from 
your collaborators.


This feature is supported in Word 2007 and 2010 
and PowerPoint 2010. It is not supported in 
PowerPoint 2007 or Excel 2007 and 2010.


 Merge and Review: Combines your edits with 
the edits from your collaborators and highlights 
any changes that have been made.


 Cancel: Temporarily hides the prompt to merge 
your changes so that you can continue making 
edits and combine them with edits from your 
collaborators later.


Click More Options to reveal additional options:


 Update: Discards your changes and opens the 
collaborator’s version of the document.
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 Overwrite: Overwrites the collaborator’s version 
of the document with the version that you are now 
creating.


Collaborators who are also working on the document 
see a notification informing them that changes have 
been made to the document. Collaborators can then 
choose an action from the same options, which are 
Merge Changes, Merge and Review, Cancel, Update, 
and Overwrite.


EDITING A READ-ONLY DOCUMENT


When you open a document, it appears as Read-Only if it is 
locked by another user or if you don’t have rights to modify 
the document. You can still edit the document. However, 
when you save the document by pressing Ctrl+S or by 
clicking Save in Office, you are prompted to save a copy of 
the document to your local file system. 


To save the document back to the Vibe site:


1 In Microsoft Office, click the Vibe tab, click Save or 
Save As, then choose a location to save the document 
on the Vibe site where you have rights to create a file.


EDITING A DOCUMENT AFTER LOSING CONNECTION TO 
THE VIBE SITE


If you lose your connection to the Vibe site while editing a 
Vibe document in Microsoft Office, the Vibe Add-in for 
Microsoft Office saves your document. You can continue 
editing the document offline, then re-save the document to 
Vibe after you reestablish a connection to the Vibe site.


 “Losing Your Connection to the Vibe Site” on page 4


 “Opening a Document after You Lose Your Connection 
to the Vibe Site” on page 4


 “Saving Documents to Vibe after You Regain Your 
Connection to the Vibe Site” on page 4


Losing Your Connection to the Vibe Site


You might lose your connection to the Vibe site if the Vibe 
server is unavailable, or if you lose your Internet 
connection.


If you lose your connection to the Vibe site while you are 
editing a Vibe document and then try to save the document 
to Vibe site, the following items indicate that you are 
working offline:


  is displayed next to the document name in the 
Dashboard.


 The Pending button is displayed on the ribbon in the 
Vibe tab. Clicking this button displays the documents 
that are waiting to be uploaded to the Vibe site.


 A numeral indicating the number of documents waiting 
to be uploaded to the Vibe site is displayed on the Vibe 
tab.


You can continue editing documents after you lose the 
connection to your Vibe site, then save them after you 
regain your connection, as described in “Saving Documents 
to Vibe after You Regain Your Connection to the Vibe Site” 
on page 4. If you close the document, you can open it 
again, as described in “Opening a Document after You Lose 
Your Connection to the Vibe Site” on page 4.


Opening a Document after You Lose Your Connection to 
the Vibe Site


If you lose your connection to the Vibe site while editing a 
Vibe document in Microsoft Office, you can close the 
document, then re-open the document and continue editing 
it.


1 In Microsoft Office, click the Vibe tab, click Pending, 
then click the file that you want to open.


or


In Microsoft Office, click the Vibe tab, click the arrow 
beneath the open icon to display a list of recently 
opened documents, then click the file that you want to 
open.


After you regain your connection to the Vibe site, you can 
save the document as described in “Saving Documents to 
Vibe after You Regain Your Connection to the Vibe Site” on 
page 4.


Saving Documents to Vibe after You Regain Your 
Connection to the Vibe Site


After you regain your connection to Vibe, you can save the 
documents to Vibe. If you were working on multiple 
documents when you lost your connection to Vibe, you can 
view all the documents that you were working on, then 
decide whether you want to save the documents to Vibe or 
delete them.


1 If the document you were editing is still open in 
Microsoft Office, simply click Save to save the 
document to the Vibe site.


or


If the document you were editing is no longer open, 
click the Vibe tab in Microsoft Office, then click 
Pending > Manage.


The Manage Pending Uploads dialog box is displayed.
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2 Select the document that you want to manage, then 
click one of the following options:


 View File: Opens the Upload folder where the 
document is located on your local file system. You 
can then open the document to view its contents.


 Upload: Uploads the document to the Vibe site. If 
there were other changes made to the document 
since you last uploaded it to the Vibe site, you are 
prompted with the options discussed in “Co-
Editing a Vibe Document” on page 3.


 Delete: Deletes the document from your local file 
system. The document is not uploaded to the Vibe 
site.


Locking a Document


You can lock a document while you are editing it to prevent 
others from editing it at the same time. If you do not lock the 
document, you might be co-editing the document, as 
described in “Co-Editing a Vibe Document” on page 3.


1 With the document open in Microsoft Office, click the 
Vibe tab, then click Lock.


A Lock icon  is displayed next to the document 
name in the Dashboard, indicating that the document 
cannot be edited by other users.


To see which user is locking the document:


1 Mouse over the Lock icon  next to the document 
name in the Dashboard.


Saving a Document to the Vibe Site


After you create a document in Microsoft Office, you can 
save the document directly to your personal workspace, 
one of your team workspaces, or one of your favorite 
places on the Vibe site.


1 With the document open in Microsoft Office, click the 
Vibe tab, then click Save As.


2 Specify a name for the file, then use the drop-down list 
to select the type of extension that you want to use for 
the file, such as .docx.


3 (Conditional) If you have configured multiple Vibe 
sites, click the drop-down list in the lower right corner 
of the dialog box to select the site that you want to 
save the file to.


4 To save the file to a Files folder, click the Location 
drop-down list, then click the Files folder in your 
personal workspace, team workspaces, or favorites 
where you want to save the file.


or


To save the file to any type of folder, click the Location 
drop-down list, then click Browse to browse to the 
folder in your personal workspace, team workspace, or 
favorites where you want to save the file.


When files are saved to folders other than Files 
folders, the files are created as entry attachments.


You can save a document only in workspaces and 
folders where you have rights to create a Vibe entry. If 
you do not have rights in a folder to save a document, 
the workspace or folder is not displayed in the Vibe 
folder structure.


5 (Optional) Click Show additional properties to specify a 
title or description for the document.


6 Click Save.


The document is added to the folder as a folder entry. 
For more information about how to work with folder 
entries when you access Vibe from your browser, see 
“Working with Folder Entries” in the Novell Vibe 3.2 
User Guide.


If a document with the same name already exists in the 
folder, select from the following options:


 Save As New Version: Saves the document as a 
new version of the existing document. 


 Overwrite: Overwrites the existing document with 
the document you are saving.


 Rename: Allows you to rename the document or 
save the document to a new location.


Viewing Information about a Document


Vibe documents reside in entries that contain additional 
information about the document, such as who created the 
document, who last edited it, a document description, 
comments, and more. You can view this information within 
Microsoft Office.


1 With the document open in Microsoft Office, click the 
Vibe tab, then click the Dashboard button if the 
dashboard is not already displayed on the right side of 
the page.
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2 View the following information about the document:


Title: Title of the document.


Click the document title to launch a browser and 
display the entry that contains the document in Vibe.


Version: Version of the document.


Click the version number to see a list of versions and 
perform various actions on the versions, as described 
in “Working with Previous Versions of a Document” on 
page 7.


Location: Location of the document on the Vibe site.


Click the location to launch the Open Document dialog 
box, as described in “Viewing Other Files in the Same 
Vibe Folder” on page 8.


Description: Description of the document.


Mouse over the description and click the Edit icon  
to edit the description in an HTML editor.


Created By: User who created the document.


Click the user’s name to display details about the user. 
Click More Details to launch a browser and view the 
user’s profile information in Vibe.


Last Edited By: User who most recently edited the 
document.


Click the user’s name to display details about the user. 
Click More Details to launch a browser and view the 
user’s profile information in Vibe.


Average Rating: Average number of stars the 
document has received. This is based on a five-star 
rating system.


Click a star to provide a rating, as described in “Rating 
a Document” on page 6.


Tags: Tags that are assigned to the document.


Click Add Tag to add a tag, as described in “Tagging a 
Document” on page 6.


Comments: Comments that have been made on the 
document.


Click in the Write a comment field to provide a 
comment, as described in “Commenting on a 
Document” on page 7.


Rating a Document


You can use Microsoft Office to rate a document that is on 
the Vibe site in your personal workspace, team 
workspaces, or favorite places.


1 With the document open in Microsoft Office, click the 
Vibe tab, then click the Dashboard button if the 
dashboard is not already displayed on the right side of 
the page.


2 Click the star that represents your evaluation.


For example, to give an entry a rating of three stars, 
click the third star from the left.


For information about how to rate a document in the regular 
Vibe interface, see “Rating a Folder Entry” in the Novell 
Vibe 3.2 User Guide.


Tagging a Document


You can use Microsoft Office to tag a document that is on 
the Vibe site in your personal workspace, team 
workspaces, or favorite places.


1 With the document open in Microsoft Office, click the 
Vibe tab, then click the Dashboard button if the 
dashboard is not already displayed on the right side of 
the page.


2 Click Add Tag.


3 Select Personal or Global, depending on whether you 
want to create a personal or global tag.


For more information about personal and global tags, 
see “Choosing Between Personal Tags and Global 
Tags” in the Novell Vibe 3.2 User Guide.


4 Specify the name of the tag that you want to add, then 
click Add.


For general information about using tags in Vibe, see 
“Using Tags” in the Novell Vibe 3.2 User Guide.
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Providing a Description for a Document


You can provide a description from Microsoft Office for a 
document that is on the Vibe site in your personal 
workspace, team workspaces, or favorite places.


1 With the document open in Microsoft Office, click the 
Vibe tab, then click the Dashboard button if the 
dashboard is not already displayed on the right side of 
the page.


2 Click Add a description.


3 Specify the description for the document, then click 
OK.


To edit an existing description:


1 Mouse over the description in the Dashboard, then 


click the Edit icon .


Commenting on a Document


You can comment on a Vibe document directly from 
Microsoft Office.


1 With the document open in Microsoft Office, click the 
Vibe tab, then click the Dashboard button if the 
dashboard is not already displayed on the right side of 
the page.


2 In the Write a comment field, specify your comment, 
then press Enter.


For more information about making comments in Vibe, 
see “Commenting on a Folder Entry” in the Novell Vibe 
3.2 User Guide.


Working with Previous Versions of a 
Document


 “Viewing a Previous Version of a Document” on page 7


 “Comparing Previous Versions of a Document” on 
page 7


 “Incrementing the Major Version Number of a 
Document” on page 7


 “Viewing and Editing a Note for a Previous Version” on 
page 8


 “Promoting a Previous Version to Be the Current 
Version” on page 8


 “Deleting a Previous Version of a File” on page 8


 “Changing the Status of a Previous Version of a File” 
on page 8


VIEWING A PREVIOUS VERSION OF A DOCUMENT


You can view a previous version of a document directly 
from Microsoft Office.


1 With the document open in Microsoft Office, click the 
Vibe tab, then click the Dashboard button if the 
dashboard is not already displayed on the right side of 
the page.


2 Next to the document title, click the current version 
number to display a list of previous versions.


3 Right-click the version that you want to open, then click 
Open.


or


Double-click the version that you want to open.


For more information about managing versions of 
documents in Vibe, see “Using Version Control with Files” 
in the Novell Vibe 3.2 User Guide.


COMPARING PREVIOUS VERSIONS OF A DOCUMENT


This functionality is available only in Microsoft Word.


1 With the document open in Microsoft Office, click the 
Vibe tab, then click the Dashboard button if the 
dashboard is not already displayed on the right side of 
the page.


2 Next to the document title, click the current version 
number to display a list of previous versions.


3 Right-click the version that you want to compare with 
the current version, then click Compare.


Differences between the two versions are displayed 
with underlined red text.


INCREMENTING THE MAJOR VERSION NUMBER OF A 
DOCUMENT


By default, when you create new versions of a file, Vibe 
tracks the versions with minor version numbers. For 
example, 1.0, 1.1, 1.2, and so forth. You can increment the 
major version number of the most recent version of a file. 
For example, version 1.2 becomes version 2.0.


You can increment the major version number of a file 
directly from Microsoft Office:


1 With the document open in Microsoft Office, click the 
Vibe tab, then click the Dashboard button if the 
dashboard is not already displayed on the right side of 
the page.


2 Next to the document title, click the current version 
number to display a list of previous versions.


3 Click Increment Major Version Number.
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For more information about incrementing the major version 
number in Vibe, see “Incrementing the Major Version 
Number of a File” in “Working with Files in a Folder Entry” in 
the Novell Vibe 3.2 User Guide.


VIEWING AND EDITING A NOTE FOR A PREVIOUS 
VERSION


To view a note that has already been added to a file 
version:


1 With the document open in Microsoft Office, click the 
Vibe tab, then click the Dashboard button if the 
dashboard is not already displayed on the right side of 
the page.


2 Next to the document title, click the current version 
number to display a list of previous versions.


3 Mouse over the version that contains the note that you 
want to read.


The note is displayed as a ToolTip.


You can add and edit notes for previous versions of files:


1 With the document open in Microsoft Office, click the 
Vibe tab, then click the Dashboard button if the 
dashboard is not already displayed on the right side of 
the page.


2 Next to the document title, click the current version 
number to display a list of previous versions.


3 Right-click the version that has the note you want to 
edit, then click Edit Note.


4 Specify the note for the version, then click OK.


For more information about file version notes, see “Adding 
a Note about a File or File Version” in the Novell Vibe 3.2 
User Guide.


PROMOTING A PREVIOUS VERSION TO BE THE CURRENT 
VERSION


1 With the document open in Microsoft Office, click the 
Vibe tab, then click the Dashboard button if the 
dashboard is not already displayed on the right side of 
the page.


2 Next to the document title, click the current version 
number to display a list of previous versions.


3 Right-click the version that you want to promote to be 
the current version, then click Promote To Current.


DELETING A PREVIOUS VERSION OF A FILE


1 With the document open in Microsoft Office, click the 
Vibe tab, then click the Dashboard button if the 
dashboard is not already displayed on the right side of 
the page.


2 Next to the document title, click the current version 
number to display a list of previous versions.


3 Right-click the version that you want to delete, then 
click Delete Version.


CHANGING THE STATUS OF A PREVIOUS VERSION OF A 
FILE


If you have multiple versions of a file, you might want to set 
a status for each version to help keep track of the official 
version, the draft versions, and so forth. Files can have the 
status of Official, Draft, or Obsolete.


1 With the document open in Microsoft Office, click the 
Vibe tab, then click the Dashboard button if the 
dashboard is not already displayed on the right side of 
the page.


2 Next to the document title, click the current version 
number to display a list of previous versions.


3 Right-click the version where you want to change the 
status, then click Status > None, Official, Draft, or 
Obsolete.


Viewing Other Files in the Same Vibe Folder


You can quickly view other files that are located in the same 
Vibe folder as the document that you are currently viewing.


1 With the document open in Microsoft Office, click the 
Vibe tab, then click the Dashboard button if the 
dashboard is not already displayed on the right side of 
the page.


2 Click the folder that contains the document.


All the documents contained in the folder are displayed 
in the Open Document dialog box.


Checking for Updates to a Document


When you are using Microsoft Office to edit a document, 
you can check to see if there have been any updates to the 
document since you began working on it. 


1 With the document open in Microsoft Office, click the 
Vibe tab, then click Update.


If there have been changes to the document, you can take 
any of the following actions:


 Merge: Combines your edits with the edits from your 
collaborators.
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 Merge and Review: Combines your edits with the 
edits from your collaborators and highlights any 
changes that have been made.


 Cancel: Temporarily hides the prompt to merge your 
changes so that you can continue making edits and 
combine them with edits from your collaborators later.


If you select this option, the document version is 
displayed in red, indicating that you are working on a 
non-current version.


Click More Options to reveal additional options:


 Update: Discards your changes and opens the newer 
version of the document.


 Overwrite: Overwrites the new version of the 
document with the version that you are now creating.


Viewing the Entry in Vibe


Vibe folder entries contain documents as either main 
documents in File entries, or as attachments in any type of 
entry (such as a Blog entry). When you view an entry in 
Vibe, you can perform various actions on the entry that you 
can’t perform from Microsoft Office, such as sharing the 
entry with another Vibe user, modifying access controls to 


the entry, and more. For more information about folder 
entries in Vibe, see “Working with Folder Entries” in the 
Novell Vibe 3.2 User Guide.


When you edit a document in Microsoft Office, you can 
quickly view the entry that contains the document in Vibe.


1 With the document open in Microsoft Office, click the 
Vibe tab, then click View Online.


2 Log in to the Vibe site.


The Vibe entry that contains the document is 
displayed.


Providing a Link to the Document


You can copy the link to the document that you are 
currently working on, then use instant messaging or e-mail 
to send it to other users who might be interested in the 
document.


1 With the document open in Microsoft Office, click the 
Vibe tab, then click Copy Link.


You can now paste the link into an instant message or 
e-mail message.


Known Issues


For a list of known issues, see the Novell Vibe Add-In 
Readme (http://www.novell.com/documentation/vibe32/
vibe_readme_office1/data/vibe_readme_office1.html).


Legal Notices: Copyright © 2011-2012 Novell, Inc. All rights reserved. No part of this 
publication may be reproduced, photocopied, stored on a retrieval system, or transmitted 
without the express written consent of the publisher. For Novell trademarks, see the Novell 
Trademark and Service Mark list (http://www.novell.com/company/legal/trademarks/
tmlist.html). All third-party trademarks are the property of their respective owners.
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1 Product Overview
Novell Vibe 3.2 offers many enhancements over prior Vibe versions for both Vibe users and 
administrators:


For Users


 Landing Page Enhancements: Define background images and background colors, configure 
table column widths, and more.


 Versioning Enhancements: Simultaneously delete multiple versions and configure versions to 
be automatically deleted after a certain number of days.


 File Quotas: Set quotas for how big an individual file can be in a given folder.


 Change Entry Type: Change an existing entry from one type to another type. For example, you 
can change an entry from a Blog view to a Discussion view after the entry is created.


 Survey Enhancements: Modify the order that questions appear in a survey.


 Workflow Enhancements: Transition a workflow based on field value, configure a workflow to 
modify the value of a field, and display an entry link in a workflow notification e-mail message.


 Task Enhancements: Modify task dates directly from the task list, reorder tasks directly from 
the task list, and more.


For Administrators


 Versioning Enhancements: Enable and disable versioning, set a maximum number of versions, 
enable or disable minor versioning, and more.


 JMX Monitoring: Monitor applications, system objects, devices, and services through Java 
Management Extensions (JMX).


2 Vibe System Requirements
Novell Vibe 3.2 system requirements (including requirements for mobile devices that access the Vibe 
mobile interface) are listed in “Vibe System Requirements” in the Novell Vibe 3.2 Installation Guide.


3 Linux Installation Instructions
1 Make sure that the Linux server where you plan to install Novell Vibe meets the system 


requirements.


2 If a Web server is currently running on the Vibe server, stop it, and preferably disable it.


3 Create or select a non-root Linux user and group that you want to own the Vibe directories and 
files and to run the Vibe software.
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4 Download the Vibe software to a temporary directory on your Linux server.


5 In a terminal window, become root by entering su - and the root password.


6 Change to the temporary directory where you downloaded the Vibe 3.2 tar file, then use the 
following command to untar the file:


tar xvf novell-vibe-3.2.0.linux.tar


7 In the directory where you downloaded and extracted the Vibe software, enter the following 
command to start the Vibe Installation program:


./installer-teaming.linux


Complete installation instructions are available in the Novell Vibe 3.2 Installation Guide.


4 Windows Installation Instructions
1 Make sure that the Windows server where you plan to install Novell Vibe meets the system 


requirements.


2 Log in to the Windows server as a user with Administrator rights.


3 If a Web server is currently running on the Vibe server, stop it, and preferably disable it.


4 Download the Vibe software to a temporary directory on your Windows server.


5 In Windows Explorer, browse to the directory where you downloaded and extracted the Vibe 
software, then double-click the installer-teaming.exe file to start the Vibe Installation 
program.


Complete installation instructions are available in the Novell Vibe 3.2 Installation Guide


5 Update Issues
 Section 5.1, “Updating a Vibe 3.1 System,” on page 2


 Section 5.2, “Updating a Vibe 3 System,” on page 3


 Section 5.3, “Updating a Teaming 2.1 System,” on page 3


 Section 5.4, “Incompatibility between Index Servers When Updating a High Availability 
System,” on page 3


 Section 5.5, “Caching Issues When Updating from Teaming 2.x to Vibe 3.x,” on page 3


 Section 5.6, “Issues When Updating from a Previous Vibe Release to Vibe 3.2,” on page 4


 Section 5.7, “Performance Issues after Updating to a New Version,” on page 5


 Section 5.8, “Cannot Reset Factory Workflow Definitions When Workflow Is in a Custom State,” 
on page 5


 Section 5.9, “Manual Ehcache Configuration Settings Are Not Preserved on Update,” on page 5


5.1 Updating a Vibe 3.1 System


You can update from Vibe 3.1 to Vibe 3.2. For more information, see “Updating From Novell Vibe 3.1 
to Novell Vibe 3.2” in “Update” in the Novell Vibe 3.2 Installation Guide.
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5.2 Updating a Vibe 3 System


To update a Vibe 3 system to Vibe 3.2, you must first update to Vibe 3.1 before you can update to Vibe 
3.2. For information on how to update to Vibe 3.1, see “Update” in the Novell Vibe 3.1 Installation Guide 
(http://www.novell.com/documentation/vibe_onprem31/vibeprem31_inst/data/bookinfo.html).


5.3 Updating a Teaming 2.1 System


 If you are upgrading from Teaming 2.1 or earlier, you must first update to Novell Vibe 3 before you 
can update to Vibe 3.1 and then 3.2. For information on how to update to Novell Vibe 3, see “Update” 
in the Novell Vibe 3 Installation Guide (http://www.novell.com/documentation/vibe_onprem3/
vibeprem3_inst/data/bookinfo.html).


5.4 Incompatibility between Index Servers When Updating a High 
Availability System


When you update your high availability Vibe system to Vibe 3 or later from an earlier version, any 
deferred log records that currently exist become incompatible with each other.


To ensure that no incompatibility issues arise with deferred update logs during the update to Vibe 3 
or later, you must clear all deferred update logs prior to upgrading.


For information on how to clear deferred update logs, see “Performing Maintenance on a High 
Availability Lucene Index” in the  Novell Vibe 3.2 Administration Guide.


5.5 Caching Issues When Updating from Teaming 2.x to Vibe 3.x
If you have done performance tuning for your Vibe cache, you might experience caching issues after 
you update from a previous release to Vibe 3 or later, if you have modified either of the following 
configuration files: 


 ehcache-hibernate.xml (single-server Vibe environment)


 ehcache-hibernate-clustered.xml (clustered Vibe environment)


You encounter issues only if you have modified either of the above files, because these files are 
overwritten during the Vibe update.


The issues you experience differ depending on whether you have a single-server Vibe environment, 
or whether you have a clustered Vibe environment.


If you have modified the ehcache-hibernate.xml file in order to optimize the caching performance 
for your single Vibe server, you might notice a decrease in caching performance after you update 
Vibe.


If you have modified the ehcache-hibernate-clustered.xml file in order to configure your 
clustered environment, you might notice that items that are added to the Vibe site are not always 
visible, or other erratic behavior. This is because information is not being cached and synchronized 
correctly across the various Vibe servers. 


To resolve caching issues after an update:


1 Modify the ehcache-hibernate.xml file or the ehcache-hibernate-clustered.xml file to 
reflect the file’s state before the Vibe update.


The files are located in the following directories:
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To see what these files looked like before the Vibe update, you can look in the backup directories 
in the following locations:


IMPORTANT: Use these backup files only as a reference. Do not replace the entire ehcache-
hibernate.xml file or ehcache-hibernate-clustered.xml file with the files in the backup 
directory. The new files contain important new settings that must be retained. You must 
manually add any customizations that existed in your old files.


2 (Conditional) If you have a clustered Vibe environment and you need to modify the ehcache-
hibernate-clustered.xml file, ensure that the values for the hostName, 
multicastGroupAddress, and multicastGroupPort properties are correct in the new 
ehcache-hibernate-clustered.xml file.


3 Save any modifications that you made to the configuration files, then restart Vibe.


5.6 Issues When Updating from a Previous Vibe Release to Vibe 3.2


 Section 5.6.1, “Resetting Definitions for the Vibe Site,” on page 4


 Section 5.6.2, “Re-Indexing the Vibe Search Index,” on page 4


5.6.1 Resetting Definitions for the Vibe Site


When you update to Vibe 3.2 from a previous version, you should reset the definitions for your Vibe 
site if you want your folder and workspace definitions to no longer include the Branding element. 
This element is no longer useful and could be potentially confusing to users. Branding a folder or 
workspace is now done as described in “Branding a Folder or Workspace” in the Novell Vibe 3.2 
Advanced User Guide.


For information on how to reset definitions in Vibe, see “Resetting Your Definitions” in “Update” in 
the Novell Vibe 3.2 Installation Guide.


5.6.2 Re-Indexing the Vibe Search Index


You should re-index the search index after you update to Vibe 3.2. For more information, see 
“Resetting Your Definitions” in “Update” in the Novell Vibe 3.2 Installation Guide.


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/WEB-INF/classes/config


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF\classes\config


Linux: /opt/novell/teaming/teaming-backup/
ssf/WEB-INF/classes/config


Windows: c:\Program Files\Novell\Teaming\teaming-backup\
ssf\WEB-INF\classes\config
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5.7 Performance Issues after Updating to a New Version


After updating your Vibe system to a new version, you experience performance issues when you first 
navigate the Vibe system. This is because Vibe needs to compile the JSPs after an update.


These performance issues do not persist on subsequent visits to the Vibe site.


5.8 Cannot Reset Factory Workflow Definitions When Workflow Is in a 
Custom State


When resetting the workflow definitions to the factory default as described in “Resetting Your 
Definitions” in “Update” in the Novell Vibe 3.2 Installation Guide, you encounter a general error 
informing you to contact your system administrator if you have added a custom state to a factory 
workflow (such as the Task workflow) and there is currently an entry in the custom state.


If you are trying to reset multiple definitions simultaneously and the factory workflow fails to reset 
due to this issue, all definitions will fail to reset.


5.9 Manual Ehcache Configuration Settings Are Not Preserved on 
Update


If you manually edited the ehcache configuration settings by modifying the ehcache-hibernate-
clustered.xml file on your Vibe server, the settings are not preserved when you update Vibe. 


If you manually edited the ehcache-hibernate-clustered.xml file, you must complete the 
following after updating Vibe in order to preserve your settings:


1 On your updated Vibe server, locate the ehcache-hibernate-clustered.xml file in the backup 
directory.


2 Manually copy the custom information from your old ehcache-hibernate-clustered.xml file 
in the backup directory to the new ehcache-hibernate-clustered.xml file on the current Vibe 
server.


IMPORTANT: Do not replace the new ehcache-hibernate-clustered.xml file with your old 
ehcache-hibernate-clustered.xml file. Doing so overwrites important factory changes that 
were made to the ehcache-hibernate-clustered.xml file.


3 Save and close the ehcache-hibernate-clustered.xml file that you modified on the current 
Vibe server.


4 Stop and restart Vibe.


Linux: /opt/novell/teaming/teaming-backup/
webapps/ssf/WEB-INF/classes/config


Windows: c:\Program Files\Novell\Teaming\teaming-backup\
webapps\ssf\WEB-INF\classes\config


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/WEB-INF/classes/config


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF\classes\config
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6 Installation Issues
 Section 6.1, “The Vibe Server and the Lucene Server Must Use the Same JDK,” on page 6


 Section 6.2, “Character Restrictions in Usernames and Passwords,” on page 6


 Section 6.3, “Username Character Restrictions for LDAP Synchronization and Login,” on page 6


 Section 6.4, “Character Restrictions in the Software Installation Directory Name,” on page 7


 Section 6.5, “Character Restrictions in the File Repository Directory Name,” on page 7


 Section 6.6, “Default Database Name,” on page 7


 Section 6.7, “Restrictions on Applet Support,” on page 7


 Section 6.8, “Edit in Place Support for Mac Users,” on page 7


 Section 6.9, “NFS Support,” on page 8


 Section 6.10, “Firewall Issue on Windows Server 2008 R2,” on page 8


 Section 6.11, “JDK Dependency for SSL Connections to WebDAV Servers,” on page 9


 Section 6.12, “Updated Visual C++ Redistributable Package on Windows,” on page 9


 Section 6.13, “Compatibility with Access Manager,” on page 9


6.1 The Vibe Server and the Lucene Server Must Use the Same JDK


If Vibe and the Lucene Index are running on separate servers, you must use the same JDK for both 
servers. Using different JDKs results in undesired behavior, such as not being able to create calendar 
entries.


6.2 Character Restrictions in Usernames and Passwords


Do not use extended characters or double-byte characters in Novell Vibe usernames and passwords. 
This includes usernames and passwords that are synchronized from an LDAP directory into Vibe.


This limitation is caused by the open source Spring Security (http://static.springframework.org/
spring-security/site) that Vibe uses for authentication, in combination with the various authentication 
methods (both basic authentication (http://en.wikipedia.org/wiki/Basic_access_authentication) and 
form-based authentication (http://en.wikipedia.org/wiki/Form_based_authentication)) used by 
single sign-on products such as Novell Authentication Manager, by Web services, and by WebDAV. 
Only ASCII characters are properly interpreted in all combinations.


6.3 Username Character Restrictions for LDAP Synchronization and 
Login


LDAP usernames that contain special characters ( / \ * ? " < > : | ) cannot be used as Novell Vibe 
usernames. If your LDAP directory includes usernames with these characters, they synchronize to 
the Vibe site, but the associated users cannot log in.


These characters cannot be used in a Vibe username because a Vibe username becomes the user’s 
workspace title, and the workspace title becomes an element of the hierarchical path that leads to the 
workspace. These characters are not legal characters in Linux and Windows pathnames.
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6.4 Character Restrictions in the Software Installation Directory Name


Do not use extended characters or double-byte characters in the installation directory name for 
Novell Vibe file. The default location for the Vibe software is:


6.5 Character Restrictions in the File Repository Directory Name


Do not use extended characters or double-byte characters in directory names in the path to the Novell 
Vibe file repository. The default location for the file repository root directory is:


The Oracle Outside In viewers that are used to render various file types into HTML for viewing in the 
Vibe site and for indexing do not handle directory names that include extended characters and 
double-byte characters.


6.6 Default Database Name


When you have the Novell Vibe installation program create the Vibe database for you, the database is 
given the name of sitescape. This database name is currently hard-coded into the database creation 
scripts used by the installation program. The name dates back to the name of the company that 
previously owned the Vibe software.


If you want the Vibe database to have a different name, you can edit the database creation script, then 
run the database creation script manually before you start the Vibe installation program. If you do 
this, you must also update the JDBC URL when you run the Vibe installation program. Prior to 
upgrading to a new version, the database update scripts also need to be modified.


IMPORTANT: Changing the Vibe database name is not recommended.


6.7 Restrictions on Applet Support


Applets are not supported on 64-bit Firefox on a system with a Java Runtime Environment (JRE) 
earlier than 1.6.0_12.


On a 64-bit operating system, updating to JRE 1.6.0.12 or later enables the applets to work.


For example, multi-file drag-and-drop from the desktop, file paste from the desktop, Edit in Place, 
and the graphical display in the workflow editor do not work where applets are not supported.


6.8 Edit in Place Support for Mac Users


For Mac users, Vibe looks for OpenOffice.org in the following directory on users’ Mac workstations:


/Applications/OpenOffice.org.app 


Linux: /opt/novell/teaming


Windows: c:\Program Files\Novell\Teaming


Linux: /var/opt/novell/teaming


Windows: c:\Novell\Teaming
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If your organization’s standard location for OpenOffice.org is in a different location on users’ 
workstations, you can reconfigure Vibe to look for OpenOffice.org in your preferred location.


1 Change to the following directory:


2 Open the ssf.properties file in a text editor.


3 Locate the block of lines that start with:


edit.in.place.mac.editor


4 Copy that set of lines to the clipboard of your text editor.


5 Open the ssf-ext.properties file, which is located in the same directory as the 
ssf.properties file.


6 Paste the block of lines you copied at the end of the ssf-ext.properties file.


7 Edit the location of the OpenOffice.org software to reflect its location in your organization.


8 Save and close the ssf-ext.properties file.


9 Close the ssf.properties file without saving it.


10 Stop and restart Vibe to put the new software location into effect on your Vibe site.


6.9 NFS Support


NFS file system mounts are supported for placing the Vibe file repository on a remote server from 
where Vibe is running. However, NFS file system mounts are not supported for placing the Lucene 
index on a remote server from where the Lucene Index Server is running.


6.10 Firewall Issue on Windows Server 2008 R2


On Windows Server 2008 R2, the firewall is enabled by default and ports 80 and 443 are blocked. Vibe 
needs to use these ports, so Vibe needs to be an allowed program on your Windows server.


To prepare your Windows Server 2008 R2 machine for use with Vibe:


1 In the Control Panel, double-click Windows Firewall.


2 Click Allow a program through Windows Firewall.


3 Open the ports that Vibe needs to use through the firewall:


3a Click Add Port.


3b In the Name field, specify a descriptive name for the HTTP port that Vibe uses for non-
secure connections.


3c In the Port field, specify 80.


3d Click OK.


3e Repeat Step 3a through Step 3d for the secure HTTP port of 443.


4 After defining the two ports, click OK in the Windows Firewall Settings dialog box to allow Vibe 
to communicate through the firewall on these ports.


Linux: /opt/novell/teaming/apache-tomcat-version/
webapps/ssf/WEB-INF/classes/config


Windows: c:\Program Files\Novell\Teaming\apache-tomcat-version\
webapps\ssf\WEB-INF\classes\config

8 Novell Vibe 3.2 Readme







6.11 JDK Dependency for SSL Connections to WebDAV Servers


If you want to use an SSL connection between your Novell Vibe site and a WebDAV server, and if the 
WebDAV server has a self-signed certificate rather than a certificate provided by a certificate 
authority, you must use the Sun JDK. The existing Vibe functionality for handling self-signed 
certificates is not compatible with the way the IBM JDK handles self-signed certificates.


6.12 Updated Visual C++ Redistributable Package on Windows


Novell Vibe uses Oracle Outside In 8.3.2 viewer technology for displaying documents and images on 
the Vibe site and for indexing documents. This viewer technology relies on Support Pack 1 of the 
Microsoft Visual C++ 2005 Redistributable Package. If the Windows server where you install Vibe 
does not already have the latest version of the Visual C++ Redistributable Package installed, you must 
install it before your Vibe site can function properly. The required version of the Visual C++ 
Redistributable Package is available from:


 Microsoft Visual C++ 2005 SP1 Redistributable Package (x86) (http://www.microsoft.com/
downloads/details.aspx?familyid=200B2FD9-AE1A-4A14-984D-389C36F85647&displaylang=en)


 Microsoft Visual C++ 2005 SP1 Redistributable Package (x64) (http://www.microsoft.com/
downloads/details.aspx?familyid=EB4EBE2D-33C0-4A47-9DD4-
B9A6D7BD44DA&displaylang=en)


For more information, see New Dependency for Outside In 8.2.0 and Newer Versions, Windows Products 
Only (Doc ID 468895.1) on the Oracle Support Web site (http://www.oracle.com/support). Oracle 
Support site login is required in order to access the support document.


6.13 Compatibility with Access Manager


To successfully use Novell Vibe with Novell Access Manager, Access Manager 3.1 SP1 IR1 is 
required. This version is available on the Novell Downloads Web site (http://download.novell.com).


7 Vibe Issues
 Section 7.1, “Cannot Perform Actions on Multiple Tasks Simultaneously,” on page 10


 Section 7.2, “Saving a Vibe Document with OpenOffice on Linux Creates Two File Versions,” on 
page 10


 Section 7.3, “Link (URL) Element on a Landing Page Does Not Work With Internet Explorer,” on 
page 11


 Section 7.4, “Safari on Mac Does Not Allow RSS Feed Creation with the Add Bookmark Option,” 
on page 11


 Section 7.5, “Adding Files with Drag and Drop Does Not Work on Mac,” on page 11


 Section 7.6, “LDAP Synchronization Issues,” on page 11


 Section 7.7, “Workspace Copy Limitation,” on page 12


 Section 7.8, “Export/Import Limitation,” on page 12


 Section 7.9, “File Deletion Issue with MySQL,” on page 12


 Section 7.10, “Password-Protected Files,” on page 12


 Section 7.11, “Mirrored Folder Issues,” on page 12


 Section 7.12, “Folder and Workspace Nesting Issue,” on page 13
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 Section 7.13, “License Report Issues,” on page 13


 Section 7.14, “Date Attribute in Custom Entries and Views,” on page 13


 Section 7.15, “Drag and Drop from a GroupWise Message,” on page 13


 Section 7.16, “GroupWise Integration Issue,” on page 14


 Section 7.17, “Firefox Limitation When Sending E-Mail,” on page 14


 Section 7.18, “WebDAV Issues,” on page 14


 Section 7.19, “Viewing a Vibe Folder through Windows Explorer Displays an Additional Folder 
on Windows XP,” on page 17


 Section 7.20, “Data Quota Issue with OpenOffice.org,” on page 17


 Section 7.21, “HTML Conversion Error on a Linux Server,” on page 18


 Section 7.22, “The User Profile Does Not Support Custom JSP Files,” on page 18


 Section 7.23, “Cannot Read the Latest File Version if Filenames Are Not the Same Case,” on 
page 18


7.1 Cannot Perform Actions on Multiple Tasks Simultaneously


When you perform the following actions on multiple tasks in the task list, your changes are reverted 
when you refresh the page:


 Reordering tasks by selecting multiple tasks in the task list, as described in “Reordering Tasks 
One Number at a Time” in the Novell Vibe 3.2 User Guide.


 Simultaneously making multiple tasks sub-tasks to a main task by selecting the tasks in the task 
list, as described in “Making a Main Task a Sub-Task” in the Novell Vibe 3.2 User Guide.


 Simultaneously making multiple sub-tasks main tasks by selecting the tasks in the task list, as 
described in “Making a Sub-Task a Main Task” in the Novell Vibe 3.2 User Guide.


You can reorder tasks, make tasks sub-tasks, and make sub-tasks main tasks when you perform these 
actions one task at a time, as described in “Reordering Tasks One Number at a Time”, “Making a 
Main Task a Sub-Task”, and “Making a Sub-Task a Main Task” in the Novell Vibe 3.2 User Guide.


7.2 Saving a Vibe Document with OpenOffice on Linux Creates Two 
File Versions


When you edit a file in Vibe with OpenOffice on Linux, two new file versions are generated each time 
you save the file.


This issue is due to a bug in the way that OpenOffice communicates with WebDAV.


For more information about editing files in Vibe, see “Viewing and Editing Files” in “Working with 
Folder Entries” in the Novell Vibe 3.2 User Guide (http://www.novell.com/documentation/vibe32/
vibe32_user/data/bookinfo.html).
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7.3 Link (URL) Element on a Landing Page Does Not Work With 
Internet Explorer


When you create a link from a landing page with the Link (URL) element, the link is not activated on 
the landing page unless you select the Open the URL in a new window option when configuring the 
element. 


For more information about how to add this element to your landing page, see “Adding Content to 
Your Landing Page” in the Novell Vibe 3.2 Advanced User Guide.


7.4 Safari on Mac Does Not Allow RSS Feed Creation with the Add 
Bookmark Option


The Add Bookmark option that is available after you paste the RSS URL into the browser does not 
work when you use Safari on a Mac. Instead, you must use the Bookmark menu to create an RSS feed.


This is an issue with the way Safari deals with RSS feeds; it is not an issue with Vibe itself.


7.5 Adding Files with Drag and Drop Does Not Work on Mac


Because of Java limitations on the Mac, you cannot drag and drop files to add files to a folder or to 
attach files to an entry as described in “Dragging and Dropping Files” in “Working with Folder 
Entries” in the Novell Vibe 3.2 User Guide. 


You can use the Vibe applet that is used for drag and drop if you copy the file that you want to add 
and paste it into the applet. However, dragging the file onto the applet does not work.


7.6 LDAP Synchronization Issues


 Section 7.6.1, “Issues with Initial Synchronization of Vibe Users,” on page 11


 Section 7.6.2, “Issues with Renaming and Moving Users in Your LDAP Directory,” on page 11


7.6.1 Issues with Initial Synchronization of Vibe Users


If you create Novell Vibe users by importing users from an LDAP directory, all users in the LDAP 
directory might not appear in Vibe if the value of the LDAP attribute that you are using to 
synchronize users is not unique. For example, if you are using the cn attribute to identify users and if 
you have multiple users with the same cn value, only the first instance of the duplicate username is 
synchronized into Vibe. 


To resolve this issue, use an attribute whose value is always unique across all containers, such as 
emailAddress.


7.6.2 Issues with Renaming and Moving Users in Your LDAP Directory


Renaming or moving users in your LDAP directory might result in new users being created in Vibe. 
This is because when you rename or move a user in the LDAP directory, Vibe assumes that the new 
name (or the new location of the same name) represents a new user, not a modified user, and creates 
a new Vibe user.


To resolve this issue, you should specify an LDAP attribute that uniquely identifies the user. For 
more information, see “LDAP Attribute to Identify a User or Group” in “LDAP Connections” in the 
Novell Vibe 3.2 Installation Guide.
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7.7 Workspace Copy Limitation


When you copy a workspace, the custom form and workflow definitions in that workspace are not 
transferred to the copy of the workspace. You can work around this limitation by moving the 
definitions to a higher level in the workspace tree.


1 Navigate to the folder in the original workspace where the definitions are located.


2 On the Workspace toolbar, click Manage > Form and View Designers.


3 Expand the Form and View Designers tree, then click the definition that you want to move.


4 In the Definition Properties box, click Move This Definition to display the workspace and folder 
tree for your Vibe site, then expand the tree as needed to display an appropriate destination for 
the definition.


To make the definition available in the copy of the original workspace, move the definition to a 
location in the tree that is above both the original workspace and the copy of the workspace.


To make the definition available globally on your Vibe site, move it to the root of the workspace 
and folder tree.


5 To move the definition, select the destination, then click OK.


6 Click Close twice to return to the main Vibe page.


7 Verify that the definition is now available in the copy of the workspace.


8 Repeat this procedure for each definition that needs to be available in the copied workspace.


7.8 Export/Import Limitation


When an exported workspace, folder, or entry has a link to something that isn’t included in the 
export file, the link won’t work correctly when it is imported to a different Vibe system.


7.9 File Deletion Issue with MySQL


If you are using MySQL, you might see the following error when you upload files and then delete 
them:


class org.hibernate.exception.GenericJDBCException
Cannot release connection


This is related to a MySQL defect (http://bugs.mysql.com/bug.php?id=45357). To resolve the 
problem, update MySQL to version 5.1.40 or later (http://dev.mysql.com/downloads/mysql).


7.10 Password-Protected Files


Files that have been password-protected in the application where they were created cannot be 
viewed on the Novell Vibe site. This is working as designed.


7.11 Mirrored Folder Issues


 Section 7.11.1, “Mirrored Folder Structure Limitation,” on page 13


 Section 7.11.2, “Mirrored Folder Versioning Limitation,” on page 13
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7.11.1 Mirrored Folder Structure Limitation


You cannot use the Novell Vibe Move This Folder feature to move one Mirrored File folder inside of 
another Mirrored File folder.


7.11.2 Mirrored Folder Versioning Limitation


If you edit a file in a mirrored folder and then check the version history, you see only the latest 
version of the file and only the latest version of the file is available for editing from the mirrored 
location. This is working as designed. Document versioning is not currently available in mirrored 
folders.


7.12 Folder and Workspace Nesting Issue


Because of database restrictions, the maximum number of nested folders and workspaces that Vibe 
allows is 45. For example, you can create a folder within a folder, then create a folder within that 
folder, and so forth, until the folder structure is 45 levels deep. You cannot exceed 45 levels in the 
folder structure.


7.13 License Report Issues


You can view current Novell Vibe license usage by clicking the Administration icon, then under 
Reports, clicking License Report. The License Report currently counts Administrator, Guest, and three 
internal users (_emailPostingAgent, _jobProcessingAgent, and _synchronizationAgent) as 
local users. Administrator counts as an active user, but the other four local users do not count against 
your Vibe license usage.


7.14 Date Attribute in Custom Entries and Views


If you use the Date attribute in a custom entry or view, users in different time zones might see a 
different date compared to what you see. 


Novell Vibe stores the date as midnight on the selected date in the Vibe user’s time zone in GMT. So, 
for example, January 13, 2010 in the Mountain time zone is stored as GMT-7:00 (20100113T0700). No 
problem appears for people in the same time zone. However, for people in a different time zone, 
Mountain time zone midnight could be a different day in their time zone. This discrepancy will be 
resolved in an upcoming release.


7.15 Drag and Drop from a GroupWise Message


In the GroupWise client, you cannot drag a file that is attached to a GroupWise message and drop it 
successfully into the Novell Vibe drag-and-drop window that opens when you click Add file to folder 
on the Folder Entry toolbar. Save the attachment first, then drag and drop the saved file into the drag-
and-drop window.
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7.16 GroupWise Integration Issue


In order to access a Novell Vibe site from the GroupWise Windows client, the time setting on the 
GroupWise user’s workstation must match the time setting on the Vibe server within five minutes. If 
there is a discrepancy of more than five minutes, the GroupWise client’s attempt to contact the Vibe 
site times out. If possible, reset the time of the server or the workstation to the correct and matching 
time.


If the time difference is a necessary part of your system configuration, you can change the timeout 
setting for Web services such as GroupWise that authenticate to the Vibe site through WS-Security 
(http://en.wikipedia.org/wiki/Web_Services_Security).


1 Make a backup copy of the following file:


teaming_directory/webapps/ssf/WEB-INF/server-config.wsdd


2 Open the server-config.wsdd file in a text editor.


3 Search for the following section:


<handler type="java:org.apache.ws.axis.security.WSDoAllReceiver">
<parameter name="passwordCallbackClass"
value="org.kablink.teaming.remoting.ws.security.PWCallback"/>
<parameter name="action" value="UsernameToken Timestamp"/>
</handler>


4 Insert a timeToLive parameter with large timeout value (for example, 86400 for 24 hours).


<handler type="java:org.apache.ws.axis.security.WSDoAllReceiver">
<parameter name="passwordCallbackClass"
value="org.kablink.teaming.remoting.ws.security.PWCallback"/>
<parameter name="action" value="UsernameToken Timestamp"/>
<parameter name="timeToLive" value="86400"/>
</handler>


5 Repeat Step 3 and Step 4 for the second instance of the section in the server-config.wsdd file.


6 Save the server-config.wsdd file, then restart the server. 


This configuration change affects all client applications that authenticate to the server through WS-
Security, not just GroupWise.


7.17 Firefox Limitation When Sending E-Mail


If you send an e-mail message from the Novell Vibe site, and you have a typographical error or 
invalid recipient in the Add E-Mail Addresses field, an error displays, along with a Return to Previous 
Page button. In Firefox, you return to the Send E-Mail page, but the message content is lost. In 
Internet Explorer, the message content is retained.


When you use Firefox to send e-mail from the Vibe site, select Vibe users as recipients whenever 
possible, or copy recipient e-mail addresses to avoid typographical errors in the Add E-Mail Addresses 
field.


7.18 WebDAV Issues


 Section 7.18.1, “File Rename Issue When Using WebDAV,” on page 15


 Section 7.18.2, “Windows Update for WebDAV Functionality for Windows Vista and Windows 
XP,” on page 15
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 Section 7.18.3, “WebDAV/Edit in Place Issues with Microsoft Windows Vista and Microsoft 
Office,” on page 15


 Section 7.18.4, “WebDAV/Edit in Place Issue on Windows 7,” on page 16


 Section 7.18.5, “WebDAV URL Issue on Windows Vista and Windows 7,” on page 16


 Section 7.18.6, “WebDAV Limitations on Mac,” on page 16


7.18.1 File Rename Issue When Using WebDAV


Renaming a Vibe file through a WebDAV client renames the attachment file only. It does not rename 
the title of the Vibe folder entry that the file is associated with.


This is because of the capability recently added to Vibe that allows you to specify any title of your 
choosing when creating a File entry, regardless of the filename of the associated file. Historically, the 
title for all File entries was the same as the filename of the associated file.


7.18.2 Windows Update for WebDAV Functionality for Windows Vista and Windows XP


IMPORTANT: Install this update only on Windows Vista and Windows XP. Do not install this 
update on Windows 7.


In order to use the Novell Vibe Edit in Place feature in your browser on Windows Vista and Windows 
XP, you must install the following Windows WebDAV update:


Software Update for Web Folders (KB907306) (http://www.microsoft.com/downloads/
details.aspx?familyid=17C36612-632E-4C04-9382-987622ED1D64&displaylang=en). 


This Windows update enables OpenOffice.org and Microsoft Office to interact correctly with the 
Vibe Edit in Place feature.


7.18.3 WebDAV/Edit in Place Issues with Microsoft Windows Vista and Microsoft Office


Microsoft Windows Vista has some issues with WebDAV access that affect all WebDAV interactions. 
In addition, a Vista-specific issue with applets can prevent the Novell Vibe Edit in Place feature from 
working properly. Be sure you are running the latest version of Vista. Be sure you have installed the 
Windows WebDAV update described in Section 7.18.2, “Windows Update for WebDAV Functionality 
for Windows Vista and Windows XP,” on page 15.


Windows Vista users who are using Internet Explorer might see a Java warning when they try to use 
Edit in Place. (Firefox users do not see this error.)


To configure Internet Explorer to support the Vibe Edit in Place feature:


1 In Internet Explorer, click Tools > Internet Options.


2 Click Security, select Trusted Sites, then click Sites.


3 In the Add this website to the zone field, specify the URL of your Vibe server, then click Add.


4 Select or deselect Require server verification (https:) for all sites in this zone as appropriate for your 
Vibe server.


5 Click Close, then click OK to save the security settings.
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To configure Windows Vista to support the Vibe Edit in Place feature in Microsoft Office, you must 
add new keys to the Windows registry for each Microsoft Office application.


1 In Windows Explorer, navigate to Program Files/Microsoft Office/Office12.


2 Scroll down to each Microsoft Office .exe in turn:


excel.exe
powerpnt.exe
winword.exe
...


3 Right-click each executable, then click Properties.


4 Click Compatibility.


5 Select Run this program in compatibility mode for, then select Windows XP (Service Pack 2) from the 
drop-down list.


6  Reboot the computer.


You should now be able to use the Vibe Edit in Place feature with Microsoft Office files.


NOTE: Although these steps enable Edit in Place for Vibe, they do not fix Vista’s inability to attach 
via WebDAV in Vibe.


For additional information on applets, view the following Sun bulletins:


 Bug 6440902 (http://bugs.sun.com/bugdatabase/view_bug.do?bug_id=6440902)


 Bug 6432317 (http://bugs.sun.com/bugdatabase/view_bug.do?bug_id=6432317)


7.18.4 WebDAV/Edit in Place Issue on Windows 7


If you use the Novell Vibe Edit in Place feature to edit a Word document using Office 2007 or Office 
2010 on a Windows 7 workstation, Word requests a location to save the edited file rather than saving 
it back to the Vibe site. Depending on whether you want to run Vibe with a secure HTTPS) or non-
secure (HTTP) connection, this affects how you need to configure Vibe. For more information, see 
“Editing Files with Edit-in-Place Functionality” in “Configuring Vibe to Support WebDAV on 
Windows 7” in the Novell Vibe 3.2 Administration Guide.


7.18.5 WebDAV URL Issue on Windows Vista and Windows 7


If you copy the WebDAV URL associated with a Novell Vibe folder and try to use the Add Network 
Location feature, Windows Vista and Windows 7 might not be able to map the drive. Instead, you 
should always use the Map Network Drive feature when using Vibe on Windows Vista and 
Windows 7.


7.18.6 WebDAV Limitations on Mac


When using WebDAV functionality in a Mac environment, you encounter various limitations.


 Section 7.18.6.1, “Limitations When Editing Files on Mac through WebDAV,” on page 17


 Section 7.18.6.2, “Limitations When Viewing a Vibe Folder on Mac through WebDAV,” on 
page 17
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7.18.6.1 Limitations When Editing Files on Mac through WebDAV


Edit-in-Place functionality is not supported on Mac when you use Microsoft Office as your document 
editor. To use Edit-in-Place functionality on Mac, you must use OpenOffice (or LibreOffice) as your 
document editor.


For more information, see “Using WebDAV to Edit Individual Files” in the Novell Vibe 3.2 Advanced 
User Guide.


7.18.6.2 Limitations When Viewing a Vibe Folder on Mac through WebDAV


Because of limitations with WebDAV on Mac, you cannot use WebDAV to view a Vibe folder in a Mac 
environment.


For more information, see “Using WebDAV on a Vibe Folder” in the Novell Vibe 3.2 Advanced User 
Guide.


7.19 Viewing a Vibe Folder through Windows Explorer Displays an 
Additional Folder on Windows XP


On Windows XP, when you view a Vibe folder through Windows Explorer, an additional sub-folder 
with the same name as the parent folder might be displayed.


To resolve this problem:


1 Launch a Web browser.


2 Navigate to the Microsoft Download Center and install the Software Update for Web Folders 
(KB907306)  (http://www.microsoft.com/downloads/details.aspx?FamilyId=17C36612-632E-
4C04-9382-987622ED1D64&displaylang=en)


3 Follow the on-screen instructions to install the software update.


7.20 Data Quota Issue with OpenOffice.org


OpenOffice.org creates a new document version each time you click Save, instead of creating one new 
version when you exit the edited document. This behavior can cause you to quickly meet your data 
quota. You can avoid creating unnecessary versions of the same document, and if you do create them, 
you can delete them.


 Section 7.20.1, “Avoiding Unnecessary Document Version Creation,” on page 17


 Section 7.20.2, “Deleting Unnecessary Versions of a Document,” on page 17


7.20.1 Avoiding Unnecessary Document Version Creation


To avoid creating unnecessary versions of the same document, do either of the following:


 Do not click Save multiple times when editing a document. Instead, click Save only once, before 
closing the document in OpenOffice.org.


 When you edit documents in Vibe, use a document editor other than OpenOffice.org, such as 
Microsoft Word.


7.20.2 Deleting Unnecessary Versions of a Document


You can delete specific versions of a file, as described in “Deleting Existing Versions of a File” in the 
Novell Vibe 3.2 User Guide.
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7.21 HTML Conversion Error on a Linux Server


If you see an HTML Conversion Error when you try to view a file, your Vibe Linux server might be 
missing necessary libraries.


To install the missing libraries:


1 Change to the following directory:


/opt/novell/teaming/stellent-converter/linux/x86


2 Run the exporter program.


The errors about missing input and output files are to be expected.


3 Look for errors about missing libraries.


4 If there are library errors, install any libraries that are missing.


7.22 The User Profile Does Not Support Custom JSP Files


When you create or modify attributes for the User Profile form and view in the Form and View 
Designers tool, you cannot reference custom JSP files. 


This ability still exists for modifying attributes for workspaces, folders, and entries, as described in 
“Enabling Vibe Forms and Views to Reference JSP Files” in the Novell Vibe 3.2 Advanced User Guide.


7.23 Cannot Read the Latest File Version if Filenames Are Not the Same 
Case


With previous versions of Vibe that are installed on Linux, when you add a new version of an 
existing file, and the filenames for the current version and the new version do not have the same case 
(for example, test.odp and test.ODP), Vibe recognizes these as two different files in the database, and 
you cannot access the latest version of the file.


To fix this problem, simply rename the filename to match the case of the original filename.


In Vibe 3 and later, this issue does not exist if the original file was uploaded after the upgrade to Vibe 
3. Filenames can be uploaded to the Vibe site with mismatching case (for example, test.odp and 
test.ODP) and the Vibe database recognizes them as the same file.


8 Database Issues
 Section 8.1, “Log File Does Not Accurately Report Database Creation,” on page 18


8.1 Log File Does Not Accurately Report Database Creation


The installer.log file sometimes reports that the Vibe database was created successfully when it 
actually wasn’t. Ensure that your database was created successfully.


The Vibe database is called sitescape.


For more information about the Vibe database, see “Planning the Vibe Database” in the Novell Vibe 3.2 
Installation Guide.
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9 Developer Issues
 Section 9.1, “Multi-Reference Values in SOAP Payloads,” on page 19


9.1 Multi-Reference Values in SOAP Payloads


By default, Novell Vibe SOAP payloads do not generate multi-reference values. You can change the 
server-config.wsdd files so that multi-reference values are generated.


1 Change to the directory where a server-config.wsdd file is located.


A Vibe installation includes two server-config.wsdd files. The default locations of these files 
vary by platform:


2 In the following line:


<parameter name="sendMultiRefs" value="false"/>


change false to true.


3 Save the server-config.wsdd file, then exit the text editor.


4 Create a backup copy of the modified server-config.wsdd file.


If you update the Vibe software, the server-config.wsdd file is overwritten by the Vibe 
Installation program. You must either restore the updated file after the update or repeat the 
modification.


5 Repeat the procedure for the second server-config.wsdd file in the Vibe software.


10 Localization Issues
 Section 10.1, “Extended Characters Are Not Allowed in Simple URLs,” on page 19


 Section 10.2, “Extended and Double-Byte Characters in Attachment Filenames,” on page 20


 Section 10.3, “Filenames That Contain Extended and Double-Byte Characters Are Changed 
When Creating a ZIP File,” on page 20


 Section 10.4, “Chinese Characters in Activity Logs,” on page 20


 Section 10.5, “Internet Explorer 6 Limitation with International Characters in Filenames,” on 
page 20


10.1 Extended Characters Are Not Allowed in Simple URLs


On the Configure Default Settings page of your workspace, the Define URL field does not accept 
extended characters. Use only alphabetic characters and numbers in simple URLs.


Linux: /opt/novell/teaming/apache-tomcat-version/webapps/ssf/WEB-INF
/opt/novell/teaming/apache-tomcat-version/webapps/ssr/WEB-INF


Windows: c:\Program Files\Novell\Teaming\apache-tomcat-version\webapps\
ssf\WEB-INF


c:\Program Files\Novell\Teaming\apache-tomcat-version\webapps\
ssr\WEB-INF
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10.2 Extended and Double-Byte Characters in Attachment Filenames


If Outlook users send postings to the Novell Vibe site and if the messages have attachments with 
extended or double-byte characters in the filenames, the attachment does not arrive on the Vibe site 
unless the Exchange server is properly configured. To configure the Exchange server to pass the 
filenames correctly, follow the instructions in Foreign Characters Appear as Question Marks When Sent 
from OWA (http://www.windowsnetworking.com/kbase/WindowsTips/Windows2000/AdminTips/
Exchange/ForeigncharactersappearasquestionmarkswhensentfromOWA.html).


10.3 Filenames That Contain Extended and Double-Byte Characters Are 
Changed When Creating a ZIP File


When Vibe 3 or later is used to create a ZIP file with files that contain double-byte characters in the 
filename, the filenames for the downloaded files are displayed as _file1, _file2, _file3, etc. This is 
because the Java ZIP file facility is not capable of creating filenames that contain double-byte 
characters.


The files within Vibe remain unchanged.


This is due to a problem in the way Java handles non-ASCII characters. For information on how you 
can modify the way Vibe deals with .zip files that are downloaded that contain extended or double-
byte characters in the filename, see “Enabling ZIP Files That Contain Extended or Double-Byte 
Characters in the Filename to Be Downloaded” in the  Novell Vibe 3.2 Administration Guide.


For information on how to download files in Vibe, see “Downloading Files” in the Novell Vibe 3.2 User 
Guide.


10.4 Chinese Characters in Activity Logs


When a report.csv file for an activity report is opened in Microsoft Excel, Chinese characters do not 
display correctly, even though the report.csv file has been created correctly, because Excel always 
reads the file using the ISO Latin character set.


One workaround is to use the OpenOffice.org Calc spreadsheet program instead of Excel. It displays 
Chinese characters correctly.


As a workaround in Excel:


1 Import the report.csv file into Excel by using Data > Import External Data > Import Data.


2 Select the report.csv file, then click Open.


3 Select Delimited, select UTF-8, then click Next.


4 Select Comma as the delimiter, click Next, then click Finish.


Excel should now display the Chinese characters correctly.


10.5 Internet Explorer 6 Limitation with International Characters in 
Filenames


In Internet Explorer 6, if you upload a file whose filename includes international characters into a File 
folder, and if you edit that file and create a new version, the link to the original version of the file no 
longer works, because Internet Explorer 6 double-encoded the filename. To resolve this issue, update 
to Internet Explorer 7 or later.
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11 Security Issues
To ensure that your Novell Vibe site is adequately secure, keep your operating system updated with 
all patches and security fixes.


12 Vibe 3.2 Bug Fixes
For a list of the bugs that have been fixed since Vibe 3.1, see Novell Vibe 3.2 Bug List (http://
www.novell.com/documentation/vibe32/vibe32_fixes/vibe32_fixes.html). You can look up the bug 
numbers in Bugzilla (https://bugzilla.novell.com) for more information about each bug.


13 Vibe 3.1 Bug Fixes
For a list of the bugs that have been fixed since Vibe 3, see the Novell Vibe 3.1 Bug List (http://
www.novell.com/documentation/vibe_onprem31/vibe31_fixes/vibe31_fixes.html). You can look up 
the bug numbers in Bugzilla (https://bugzilla.novell.com) for more information about each bug.


14 Vibe Documentation
The following sources provide information about Novell Vibe 3.2:


 Online product documentation: Novell Vibe 3.2 Documentation Web site  (http://
www.novell.com/documentation/vibe32) 


 Product documentation included within Novell Vibe. Click the Help icon (question mark) in the 
upper right corner of the Vibe Home page.


In addition to the Novell Vibe product documentation, the following resources provide additional 
information about Vibe 3.2:


 Novell Vibe product site (http://www.novell.com/products/vibe/)


 Novell Vibe Resource Library (http://www.novell.com/products/vibe/resource-library/)


 Novell Vibe Cool Solutions (http://www.novell.com/communities/coolsolutions/vibe)


 Novell Vibe Support Forum (http://forums.novell.com/forumdisplay.php?f=989)


15 Legal Notices
Novell, Inc. makes no representations or warranties with respect to the contents or use of this 
documentation, and specifically disclaims any express or implied warranties of merchantability or 
fitness for any particular purpose. Further, Novell, Inc. reserves the right to revise this publication 
and to make changes to its content, at any time, without obligation to notify any person or entity of 
such revisions or changes.


Further, Novell, Inc. makes no representations or warranties with respect to any software, and 
specifically disclaims any express or implied warranties of merchantability or fitness for any 
particular purpose. Further, Novell, Inc. reserves the right to make changes to any and all parts of 
Novell software, at any time, without any obligation to notify any person or entity of such changes.


Any products or technical information provided under this Agreement may be subject to U.S. export 
controls and the trade laws of other countries. You agree to comply with all export control 
regulations and to obtain any required licenses or classification to export, re-export, or import 
deliverables. You agree not to export or re-export to entities on the current U.S. export exclusion lists 
or to any embargoed or terrorist countries as specified in the U.S. export laws. You agree to not use 
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deliverables for prohibited nuclear, missile, or chemical biological weaponry end uses. Please refer to 
the Novell International Trade Services Web page (http://www.novell.com/info/exports/) for more 
information on exporting Novell software. Novell assumes no responsibility for your failure to obtain 
any necessary export approvals.


Copyright © 2011 Novell, Inc. All rights reserved. No part of this publication may be reproduced, 
photocopied, stored on a retrieval system, or transmitted without the express written consent of the 
publisher.


For Novell trademarks, see the Novell Trademark and Service Mark list (http://www.novell.com/
company/legal/trademarks/tmlist.html).


All third-party trademarks are the property of their respective owners.
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About This Guide


The Novell Vibe 3.2 User Guide explains how to use the Novell Vibe product.


This guide includes the following topics:


 Chapter 1, “Getting Started,” on page 13
 Chapter 2, “Getting Informed,” on page 25
 Chapter 3, “Navigating the Novell Vibe Interface,” on page 47
 Chapter 4, “Managing and Using Workspaces,” on page 51
 Chapter 5, “Managing and Using Folders,” on page 63
 Chapter 6, “Working with Specific Folder Types,” on page 75
 Chapter 7, “Working with Folder Entries,” on page 101
 Chapter 8, “Managing Accessories,” on page 123
 Chapter 9, “Connecting With Your Co-Workers,” on page 133
 Chapter 10, “Using Workflows,” on page 139
 Chapter 11, “Using Vibe on Your Mobile Phone,” on page 141
 Appendix A, “What’s New in Novell Vibe 3.x,” on page 143
 Appendix B, “Troubleshooting,” on page 147
 Appendix C, “Accessibility for People with Disabilities,” on page 157


Audience


This guide is intended for all new Novell Vibe users.


Feedback


We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comments feature at the bottom of each page of the 
online documentation.


Documentation Updates


For the most recent version of this manual, visit the Novell Vibe 3.2 Documentation Web site (http://
www.novell.com/documentation/vibe32). 


Additional Documentation and Resources


You can find more information in the Novell Vibe documentation, which is accessible from the 
Novell Vibe 3.2 Documentation Web site (http://www.novell.com/documentation/vibe32). 


To access the Novell Vibe User Guide from within Novell Vibe, click the Help icon (question mark).
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See the Novell Vibe Resource Library (http://www.novell.com/products/vibe-onprem/resource-
library/) for additional information and resources, including downloadable custom forms and 
workflows, relevant articles, and more.
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1 1Getting Started


When you begin to use Novell Vibe, the first thing you might want to do is set up your personal 
workspace and create a team workspace. This section explains how to get started with Vibe by 
accomplishing these important tasks.


 Section 1.1, “About Novell Vibe,” on page 13
 Section 1.2, “Starting Novell Vibe,” on page 14
 Section 1.3, “Getting to Know the Novell Vibe Interface and Its Features,” on page 15
 Section 1.4, “Setting Up Your Personal Workspace,” on page 18
 Section 1.5, “Creating a Team Workspace,” on page 20
 Section 1.6, “Using Novell Vibe Folders,” on page 21
 Section 1.7, “Displaying Help Documentation,” on page 23


As you use this guide to help you accomplish tasks in Vibe, you might discover that you are unable to 
complete the tasks as the sections describe. If you encounter this problem, it is probably because you 
have not been granted appropriate rights. You should consult with your Vibe administrator. 


For more information on rights and access control in Vibe, see “Controlling Access” in the Novell Vibe 
3.2 Advanced User Guide.


1.1 About Novell Vibe
 Section 1.1.1, “Novell Vibe Is Collaboration Software,” on page 13
 Section 1.1.2, “Novell Vibe Is Social Networking Software,” on page 14


1.1.1 Novell Vibe Is Collaboration Software


Collaboration through Vibe facilitates online work, creating a “virtual meeting space.”


You experience an increase in team synergy when using Vibe:


 You and your teammates can work together without being in the same room or working at your 
computers at the same time. Someone can post a note or document to a folder, and, at their 
convenience, teammates can comment on the work, review and edit files, and further develop 
the idea. With Vibe, teamwork is ongoing and seamless.


 When you are working online, the “presence” feature of Vibe allows you to see which 
teammates are currently online, and allows you to start a chat session by using Novell 
Messenger, make a Skype phone call, and so on.


 Ideas are formed together, interactively, with your teammates. By the time you hold a meeting in 
the conference room, the team has already been part of the formation of the idea, and teammates 
are more likely to understand it, buy into it, and assist with its implementation. Vibe becomes a 
“pre-meeting” meeting. 
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 Documents are reviewed earlier in the process, which allows for easier modifications and 
adjustments. Vibe also makes it easier to co-author documents, because of workflow processes 
that automate drafting and review, and because of Vibe access control that easily designates 
writers and reviewers.


 Your collaborative process is preserved and publicly accessible in Vibe. No more searching 
through e-mail folders in a frantic effort to “catch someone up” on a lengthy e-mail discussion. 
To review past discussions and decisions, or to review a previous version of a document, you 
can use the powerful search capability of Vibe to locate historical information quickly and easily. 


 You can use various Vibe tools in combination—a milestones folder, tasks, workflow, 
discussions, chat, online meetings—to track progress against goals for multiple teams working 
on a large project.


1.1.2 Novell Vibe Is Social Networking Software


The out-of-the-box Novell Vibe tools provide powerful enhancements to online collaboration. In 
addition, when you use the tools in combination and apply structure to content design, Vibe becomes 
a powerful knowledge-management and enterprise social networking tool. Knowledge management 
involves the efficient development, management, access, and distribution of organizational 
knowledge. Enterprise social networking involves the efficient connection of knowledgeable people 
needed to form teams, make decisions, and complete work (like FaceBook for the workplace).


Consider these examples:


 When people use their personal workspaces to provide detailed information about themselves, 
the purpose of the workspace moves beyond merely contact data (phone numbers, e-mail 
addresses, and so on). It enables searches for various subject-matter experts. Also, Vibe analyzes 
its search results, telling you which people discuss your search topic the most and in which 
places these conversations are happening. It is easy to see pockets of expertise associated with 
your area of interest.


 Experts can rate entries in Vibe by using a five-star rating system (one star indicating the least 
impressive, and five stars the most impressive), providing an additional tool for determining the 
quality of information.


 Vibe provides tools, such as wikis (information coauthored by all participants), blogs 
(chronological journal entries allowing for comments from readers), workflow (an online 
representation of a business process), and tags (categorical labels applied to items). People can 
use these tools to create and organize information organically, over time, in ways that map best 
to the team’s natural work style. Through these tools, teams literally move their business 
processes online and automate their work.


 Vibe provides work-area summaries, called accessories, that provide a snapshot of a potentially 
large amount of information, highlighting the most relevant data. For example, the accessory 
can present entries submitted by an expert on a given subject, or it can summarize task-
completion information by providing a milestone overview.


1.2 Starting Novell Vibe
1 Launch a Web browser (such as Mozilla Firefox or Internet Explorer).
2 Specify the URL of your corporation’s Novell Vibe site.
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3 In the User ID field, specify your Vibe username.
4 In the Password field, specify your Vibe password.


If you do not know your Vibe username and password, contact your Vibe administrator.
5 Click OK.


1.3 Getting to Know the Novell Vibe Interface and Its Features
When you first launch Novell Vibe, you see the What’s New page. This page shows you what’s new 
in your teams, favorite places, and more. For more information about the What’s New page, see 
Section 2.2, “Finding What’s New,” on page 26.


You can easily navigate to your personal workspace by clicking My Workspace, which includes the 
following toolbars and features:
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 Section 1.3.1, “Understanding the Masthead,” on page 16
 Section 1.3.2, “Understanding the Navigation Panel,” on page 17
 Section 1.3.3, “Understanding the Action Toolbar,” on page 17
 Section 1.3.4, “Understanding the Relevance Tabs in the Home Page of Your Personal 


Workspace,” on page 18
 Section 1.3.5, “Understanding the Content Area,” on page 18


1.3.1 Understanding the Masthead


The Masthead contains the following features:


Personal Workspace Link: Quickly access your personal workspace by clicking your linked name.


Log Out Link: Logs you out of the Vibe site.


Settings:  Displays the following options:


 Personal Preferences:  Displays your personal preferences, such as the way you want entries 
to be displayed and how many entries you want to appear on a given page.


For more information, see Section 7.19, “Configuring the Display Style of Entries,” on page 121 
and Section 5.14, “Configuring the Number of Entries to Display on a Folder Page,” on page 71.


 News Feed:  Displays live feeds of the latest entries in your teams, places you are following, 
or across the entire site.
For more information, see Section 2.13, “Viewing Live Feeds,” on page 44.
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 Vibe Resource Library:  Displays the Vibe Resource Library, which includes additional 
information and resources, including downloadable custom forms and workflows, relevant 
articles, and more.


 Help:  Displays the Vibe Help documentation.


1.3.2 Understanding the Navigation Panel


The Navigation panel contains a navigation tree that displays the current workspace and all sub-
workspaces and sub-folders.


1.3.3 Understanding the Action Toolbar


The Action toolbar contains the following features:


Expand/Contract Navigation Panel Icon:  Hides and displays the Navigation panel.


Expand/Contract Masthead Icon:  Hides and displays the Masthead.


Workspace Toolbar Icon:  Displays the Workspace toolbar, which enables you to quickly navigate 
to any location where you have appropriate rights.


My Workspace: Displays your personal workspace.


What’s New: Displays the What’s New page, where you can quickly see what’s new in your teams, 
favorite places, and more.


For more information, see Section 2.2, “Finding What’s New,” on page 26.


My Favorites: Enables you to add a place as a favorite, or to quickly visit your favorite places on the 
Vibe site.


For more information, see Section 3.4, “Managing Your Favorite Places,” on page 48.


My Teams: Displays links to all of the team workspaces where you are a member.


Recent Places: Displays the places that you have most recently visited.


For more information, see Section 3.2, “Viewing and Revisiting Recent Places,” on page 47.


Workspace: (This option is displayed only when you are viewing a workspace.) Provides various 
functions that enable you to manage the workspace, including adding new folders, managing access 
control, configuring the workspace, and more.


For more information on how to manage a workspace, see Section 4.1, “General Workspace 
Management,” on page 51.


Folder: (This option is displayed only when you are viewing a folder.) Provides various functions 
that enable you to manage the folder, including adding new folders, managing access control, 
configuring the folder, and more.


For more information on how to manage a folder, see Chapter 5, “Managing and Using Folders,” on 
page 63.


View: Enables you to accomplish various tasks, such as seeing what’s new or unread in the 
workspace or folder, viewing who has access, viewing the Vibe clipboard, and accessing the Vibe 
Trash.


Search: Enables you to search the entire site for entries, places, and people. You can locate subject-
matter experts, or see what information is available concerning a particular topic.
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Click the Search Options icon  if you want to specifically search for a person, place, or a tag. You can 
also use a saved search or perform an Advanced Search. 


For more information about searching in Vibe, see Section 2.4, “Searching for Information,” on 
page 29.


1.3.4 Understanding the Relevance Tabs in the Home Page of Your Personal 
Workspace


The home page of your personal workspace contains various tabs that are designed to help facilitate 
your work. Use these tabs as a central location where you can quickly be informed of new entries, 
upcoming tasks, your daily meetings, and more.


What’s New: Enables you to quickly see new entries in your teams, places you are following, or 
across the entire site.


Recent: Enables you to view entries that you have recently posted, and entries that you have recently 
visited. You can view who has recently visited your workspace, as well as see your personal tags.


Tasks and Calendars: Enables you to view tasks that are assigned to you, as well as today’s events 
from the calendars you are following.


Micro-Blogs and Shared Items: Enables you to view the micro-blog entries of the people you are 
following, as well as items that people have shared with you.


Accessories: Contains an Accessory panel that lists entries from your Guestbook, Blog, and Photo 
Album folders. You can manage these accessories as described in Chapter 8, “Managing 
Accessories,” on page 123.


1.3.5 Understanding the Content Area


The Content Area in Vibe is where the majority of information is displayed, such as workspaces, 
folders, and entries.


1.4 Setting Up Your Personal Workspace
Before you take advantage of all of the features and functionality of Novell Vibe, you might want to 
customize your personal workspace. 


 Section 1.4.1, “Modifying Your Profile,” on page 18
 Section 1.4.2, “Branding Your Workspace,” on page 19


1.4.1 Modifying Your Profile


You might need to manually update your profile in order for important contact information to be 
seen, such as your e-mail address, phone number, time zone, and picture.


Another reason to modify your profile is to publicize your skills and past experience to other Vibe 
users. One advantage of Vibe is the ability to find experts on any subject within your organization. 
You, as a Vibe user, have the ability to be a subject-matter expert.
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NOTE: If you are unable to modify your personal information (such as your Vibe password) as 
described in this section, it is most likely because your personal information is being synchronized 
from an external directory server. You must consult your Vibe administrator to make changes.


1 In the home page of your personal workspace, click the Profile link next to your name and avatar.
or


Click your Presence icon , located next to any entry that you have created or modified, then 
click Profile.
Your profile is displayed.
If you are a new user, your profile probably does not currently contain much information.


2 Click Edit in the upper right corner of the profile.
The User page is displayed. 


3 Change your password, e-mail address, phone number, time zone, language of the interface, 
upload a picture, and more.


4 When you are finished modifying your profile, click OK.


1.4.2 Branding Your Workspace


Adding a personal brand to your workspace can enhance the appearance of your workspace and 
make you feel more at home.


1 Navigate to your personal workspace.
2 Click Workspace > Brand Workspace.


The Workspace/Folder Branding dialog box is displayed.
3 Specify the following information to create your desired brand:


Use Branding Image: Select this option if you want to use the drop-down list to select an 
existing image, or click the Browse icon  to browse to an image on your computer’s file system.
Use Advanced Branding: Select this option, then click Advanced if you want to create a brand 
that includes advanced features, such as a YouTube video.


You can add a YouTube video in your branding section by clicking the Video icon .
For more information about displaying YouTube videos in Vibe, see Section 7.16, “Displaying 
YouTube Videos in a Folder Entry,” on page 120.
Background Image: Click the Browse icon  to browse to an image on your computer’s file 
system. The provided drop-down list contains images only if you are branding a team 
workspace and if you have attached images to the workspace, as described in Section 4.1.2, 
“Modifying a Workspace,” on page 52.
The background image is displayed behind your regular branding.
Stretch Image: Stretches the background image so that it occupies the entire branding area. 
If you stretch your background image, the image overrides any background color that you have 
set.
Background Color: Adds a background color that occupies the entire branding area. To change 
the background color, click the color name to the right of this field, select the new color, then 
click OK.
If you added a background image and stretched the image, the background color is not 
displayed.
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Text Color: Changes the text color of the workspace name in the upper right corner of the 
branding area. To change the text color, click the color name to the right of this field, select the 
new color, then click OK.
Clear branding: Click this option to clear all of your current branding selections.


4 Click OK.
Your workspace now displays the brand that you created.


For more information about creating a brand for workspaces and folders, see “Branding a Folder or 
Workspace” in the Novell Vibe 3.2 Advanced User Guide.


1.5 Creating a Team Workspace
By default, everyone in Novell Vibe has rights to create a team workspace.


Team workspaces are the most common type of workspaces. They facilitate team objectives by 
enabling team members to quickly share files, share ideas, and work together more efficiently and 
effectively.


To create a team workspace:


1 Click the Browse icon  in the Action toolbar, then expand Home Workspace in the Workspace 
tree.
The Home Workspace directory is the highest-level folder in the workspace tree, and might be 
named something specific to your organization.


2 Click Team Workspaces.
3 Click Add a Team Workspace.


The Add a Team Workspace page is displayed.
If you do not see the Add a Team Workspace option, your site administrator has not permitted you 
to create a new workspace at this level. Continue to expand the workspace tree, following the 
path of your organizational unit, click the name of the directory where you want to create the 
new team workspace, then click Workspace > New Workspace. Ensure that you select Team 
Workspace in the Workspace section. Or, follow the steps in “Creating a Team Workspace inside of 
an Existing Team Workspace” on page 60.


4 Specify the following information:
Title: Provide a title for the workspace. 
Team Members: Specify the team members.
You can specify individual users, entire groups, or add names that are on your clipboard. For 
more information about using the Vibe clipboard, see Section 9.5, “Using the Vibe Clipboard,” 
on page 136.
Workspace Folders: Select the folders that you want the workspace to contain.
If you later decide that you want to add additional folders, you can add them at any time. For 
information on how to add folders to a workspace, see Section 5.1, “Creating a New Folder,” on 
page 63.
Announcement: (Optional) Select the check box, then type a message in the Announcement Text 
field.
This message informs team members about the existence of the workspace, and can also explain 
the value of the workspace.


5 Click OK to create the new workspace.
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For information on how to create a team workspace inside of an existing workspace, see “Creating a 
Team Workspace inside of an Existing Team Workspace” on page 60.


1.6 Using Novell Vibe Folders
Novell Vibe includes multiple types of folders that enable you to organize the various kinds of 
information in your workspaces.


 Section 1.6.1, “Discussion,” on page 21
 Section 1.6.2, “Blog,” on page 21
 Section 1.6.3, “Calendar,” on page 22
 Section 1.6.4, “Guestbook,” on page 22
 Section 1.6.5, “Files,” on page 22
 Section 1.6.6, “Milestones,” on page 22
 Section 1.6.7, “Micro-Blog,” on page 22
 Section 1.6.8, “Mirrored Files,” on page 22
 Section 1.6.9, “Photo Album,” on page 23
 Section 1.6.10, “Surveys,” on page 23
 Section 1.6.11, “Tasks,” on page 23
 Section 1.6.12, “Wiki,” on page 23


For more detailed information about each type of Vibe folder, see Chapter 6, “Working with Specific 
Folder Types,” on page 75.


1.6.1 Discussion


Use discussions as a way of obtaining comments and feedback to questions and thoughts that you 
might have. You can start general discussion threads in the Discussion folder in your personal 
workspace. For discussion threads that are more specific to a project and team, start the discussion 
thread in the Discussion folder of an appropriate team workspace.


For more information on Discussion folders, see Section 6.1, “Working with Discussion Folders,” on 
page 75.


1.6.2 Blog


Blogs are a good way to express your thoughts about topics that are important to you. For example, if 
you are working on a project and are responsible for a certain aspect of that project, you can update 
your team on your individual progress by posting a blog in the Blog folder in the team workspace.


For more information on Blog folders, see Section 6.2, “Working with Blog Folders,” on page 76.
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1.6.3 Calendar


Vibe enables you to create a Calendar folder in any workspace that you desire. You can maintain a 
personal calendar in your personal workspace, and then add separate calendars in your team 
workspaces to keep track of events that are specific to that team.


For more information on Calendar folders, see Section 6.3, “Working with Calendar Folders,” on 
page 78.


1.6.4 Guestbook


The Guestbook folder in Vibe is a place to store all of your guestbook entries. By default, users can 
sign your Guestbook by clicking the Overview tab on the home page of your personal workspace. This 
is a quick way for your friends and co-workers to communicate with you.


For more information on Guestbook folders, see Section 6.4, “Working with Guestbook Folders,” on 
page 81.


1.6.5 Files


Files folders in Vibe make it easy to store and keep track of your files. You can store personal files in 
the Files folder in your personal workspace, and team-related files in your individual team folders. 
This makes it easy to share files with your teammates and others who might be interested in viewing 
them.


For more information on Files folders, see Section 6.5, “Working with Files Folders,” on page 81.


1.6.6 Milestones


Milestones folders track the progress of several Tasks folders. Milestones folders are most often used 
in those workspaces, although they can also be used in other workspaces. For more information, see 
Section 4.5, “Managing a Project Management Workspace,” on page 62.


1.6.7 Micro-Blog


The Micro-Blog folder in Vibe is a place to store all of your micro-blog entries. Use the Micro-Blog 
feature to capture quick personal notes, or to inform others of what you are currently working on. 
This provides a greater transparency, so those you work with know what you are doing, and how 
they might offer assistance to help you accomplish your tasks.


You can navigate to someone else’s Micro-Blog folder to see what they have been working on, and 
possibly provide help by sharing your knowledge and experience.


For more information on the Micro-Blog feature, see Section 2.10, “Using Micro-Blogs,” on page 40.


1.6.8 Mirrored Files


Mirrored Files folders use a reference to a file system on an external server, instead of the Vibe file 
system where other Vibe information is stored. Mirrored Files folders can reference any WebDAV or 
local file path.


For more information about Mirrored Files folders, see “Working with Mirrored Folders” in the 
Novell Vibe 3.2 Advanced User Guide.
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1.6.9 Photo Album


Photo albums store and display pictures. You can store your personal photos in the Photo Album in 
your personal workspace, and team-related photos in the Photo Album of the team workspace.


For more information on Photo Album folders, see Section 6.9, “Working with Photo Album 
Folders,” on page 83.


1.6.10 Surveys


Surveys folders store surveys that you or other Vibe users have created. Surveys enable you to poll 
team members, or any other Vibe users, about issues that are important to you, your team, or your 
company.


For more information on Surveys folders, see Section 6.10, “Working with Surveys Folders,” on 
page 85.


1.6.11 Tasks


Tasks folders keep track of the progress made in completing work assignments. Vibe enables you to 
create a Tasks folder in any workspace that you desire. You can maintain a personal Tasks folder in 
your personal workspace, and then add separate Tasks folders in your team workspaces to keep track 
of tasks that are specific to that team.


For more information on Tasks folders, see Section 6.11, “Working with Tasks Folders,” on page 87.


1.6.12 Wiki


Wiki folders contain wiki entries. A wiki is a set of related entries coauthored by folder participants. 
For example, the best-known wiki on the Internet is Wikipedia. Other examples of possible wiki 
content are glossaries, or policies and procedures.


For more information on Wiki folders, see Section 6.12, “Working with Wiki Folders,” on page 96.


1.7 Displaying Help Documentation


1 Click the Settings icon  in the upper right corner of each Vibe page, then click the Novell 


Vibe Help icon .
When you click this icon, Vibe displays the Vibe User Guide in a new browser window.
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2 2Getting Informed


Novell Vibe provides numerous methods to help keep you informed of what’s going on in your 
teams and in your organization.


 Section 2.1, “Accessing Novell Vibe from Your Mobile Phone,” on page 25
 Section 2.2, “Finding What’s New,” on page 26
 Section 2.3, “Finding What’s Unread,” on page 29
 Section 2.4, “Searching for Information,” on page 29
 Section 2.5, “Following and Unfollowing Places and People of Interest,” on page 36
 Section 2.6, “Viewing Recent Contributions,” on page 38
 Section 2.7, “Viewing Assigned Tasks,” on page 39
 Section 2.8, “Viewing Calendar Events,” on page 39
 Section 2.9, “Sharing Workspaces, Folders, and Entries,” on page 39
 Section 2.10, “Using Micro-Blogs,” on page 40
 Section 2.11, “Subscribing to a Folder or Entry,” on page 42
 Section 2.12, “Using Remote Applications,” on page 44
 Section 2.13, “Viewing Live Feeds,” on page 44
 Section 2.14, “Viewing Folders as RSS or Atom Feeds,” on page 45
 Section 2.15, “Synchronizing Tasks and Calendars to a Desktop Application,” on page 46


2.1 Accessing Novell Vibe from Your Mobile Phone
Novell Vibe includes a mobile interface that is supported on the following mobile devices:


 iPhone (native application is available in the iTunes Store)
 Android (native application is available in the Android Market)
 BlackBerry
 Any other mobile device that provides an HTTP/HTML-based interface


In other words, most phones that have a data service plan can access the Vibe mobile interface.


For more information about using Vibe on your mobile phone, see “Using Vibe on Your Mobile 
Phone” in the Novell Vibe 3.2 User Guide.
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2.2 Finding What’s New
One key to effective and efficient teamwork is knowing what people are working on and what they 
are saying. Vibe enables you to view and act on new entries by using the What’s New page. You can 
view new entries for various categories, comment on entries, and more.


To perform actions on entries, you must have appropriate rights. For more information about rights, 
see “Controlling Access” in the Novell Vibe 3.2 Advanced User Guide.


 Section 2.2.1, “Viewing New Entries,” on page 26
 Section 2.2.2, “Marking an Entry as Unread,” on page 27
 Section 2.2.3, “Replying to a New Entry,” on page 27
 Section 2.2.4, “Sharing a New Entry,” on page 27
 Section 2.2.5, “Subscribing to a New Entry,” on page 28
 Section 2.2.6, “Tagging a New Entry,” on page 28
 Section 2.2.7, “Editing and Deleting a New Entry,” on page 28
 Section 2.2.8, “Displaying Only Unread Entries,” on page 29
 Section 2.2.9, “Pausing Updates on the What’s New Page,” on page 29
 Section 2.2.10, “Configuring How Many Entries Are Displayed on a Page,” on page 29


2.2.1 Viewing New Entries


By default, the What’s New page is displayed when you first access the Vibe site. If the What’s New 
page is not displayed, or if you navigate away from it, you can easily access it to view new entries.


1 Click What’s New in the Action toolbar from any folder or workspace in Vibe.
By clicking the appropriate category in the What’s New navigation panel on the left side of the 
page, you can view new entries for any of the following categories:
 Current Folder or Workspace: Displays new entries in the folder or workspace that you are 


in when you click What’s New in the Action toolbar.
 My Favorites: Displays new entries in your favorite places.


For information on how to add places as favorites, see Section 3.4.1, “Adding a Favorite 
Place,” on page 48.


 My Teams: Displays new entries in your teams.
For more information on how to create a team workspace, see Section 4.3.1, “Creating a 
Team Workspace,” on page 59.


 Followed People: Displays new entries that have been added by the people you are 
following.
For information on how to follow people, see Section 2.5.2, “Following People,” on page 37.


 Followed Places: Displays new entries that have been added to the places you are 
following.
For information on how to follow places, see Section 2.5.1, “Following Workspaces and 
Folders,” on page 36.
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 Site Wide: Displays new entries that have been added anywhere in the Vibe site.
2 (Optional) If a category contains sub-categories, you can expand the category in the What’s New 


navigation panel to view new entries in a more specific location. For example, if you are a 
member of multiple teams, you can expand My Teams and click a specific team to see what’s new 
in that team workspace.


2.2.2 Marking an Entry as Unread


After you view an entry from the What’s New page, the entry is marked as Read. You can mark an 
entry as Unread, directly from the What’s New page.


1 Click the Actions drop-down arrow  next to the entry that you want to mark as Unread.
2 Click Mark Unread.


You can mark the entry as Read by clicking the Actions drop-down arrow  next to the entry, then 
clicking Mark Read.


For information about how to display only unread entries on the What’s New page, see Section 2.2.8, 
“Displaying Only Unread Entries,” on page 29.


2.2.3 Replying to a New Entry


You can reply to entries directly from the What’s New page.


1 Click the Actions drop-down arrow  next to the entry that you want to comment on.
2 Click Reply.


A comment field is opened inline on the What’s New page.
3 Specify your reply in the provided field, then click Send.


2.2.4 Sharing a New Entry


You can share entries directly from the What’s New page.


1 Click the Actions drop-down arrow  next to the entry that you want to share.
2 Click Share.


The Share this Entry dialog box is displayed.
3 Select whether you want to share the entry with users or groups.
4 Begin typing the name of the user or group that you want to share the entry with in the provided 


field, then click the name when it appears in the drop-down list. Repeat this step to add multiple 
users and groups.


5 In the Share with Teams section, select the teams who you want to share the entry with.
6 In the Comments field, provide any additional comments.
7 Click OK.
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2.2.5 Subscribing to a New Entry


You can subscribe to entries directly from the What’s New page.


1 Click the Actions drop-down arrow  next to the entry that you want to subscribe to.
2 Click Subscribe.


The Subscribe to Entry dialog box is displayed.
3 Select the e-mail addresses or phone numbers where you want the notifications to be sent. You 


can subscribe to full e-mails, e-mails without attachments, or text messages.


You can update the e-mail addresses and phone numbers that Vibe uses to send you notifications by 
modifying your personal profile, as described in Section 1.4.1, “Modifying Your Profile,” on page 18.


2.2.6 Tagging a New Entry


You can tag an entry directly from the What’s New page.


1 Click the Actions drop-down arrow  next to the entry that you want to tag.
2 Click Tag.


The Tag this Entry dialog box is displayed.
3 Select either Personal Tag or Global Tag, depending on whether you want this tag to be visible to 


only yourself or to the entire community.
For more information about the difference between personal and community tags, see 
Section 3.6.4, “Choosing Between Personal Tags and Global Tags,” on page 50.


4 Begin typing the name of the tag that you want to apply to the entry.
This field uses type-to-find functionality, so if a tag already exists with the desired name, it 
appears in the drop-down list. If the name does not appear in the drop-down list, you are 
creating a new tag.
To see a list of existing tags, click inside the provided field, then press the Spacebar.


5 Finish typing the name of the tag, or select it from the drop-down list, then click the Add icon .
The entry is now marked with the tag that you specified.


6 Click OK.


For more information about tags, see Section 3.6, “Using Tags,” on page 49.


2.2.7 Editing and Deleting a New Entry


You can edit and delete entries directly from the What’s New page.


1 Click the title of the entry or reply that you want to edit or delete.
The entry is displayed.


2 Click Modify or Delete in the Entry toolbar.
3 (Optional) Close the entry by clicking the X icon in the upper right corner of the entry to return 


to the What’s New page.
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2.2.8 Displaying Only Unread Entries


You can display only unread entries on the What’s New page. By default, all entries are displayed.


1 On the What’s New page, click Showing all entries in the upper right corner.
2 Click Show unread.


For information about how to mark entries as Unread after you have read them, see Section 2.2.2, 
“Marking an Entry as Unread,” on page 27.


2.2.9 Pausing Updates on the What’s New Page


By default, the What’s New page is automatically updated with the latest comments and entries 
every 60 seconds. You can temporarily stop the What’s New page from updating. This can be helpful 
if you need more time to look at current entries.


1 Click the Pause icon  in the upper right corner of the What’s New page.
To resume updates on the What’s New page, click the Play icon .


2.2.10 Configuring How Many Entries Are Displayed on a Page


You can configure how many entries you want to show on a single page in the Vibe interface by 
modifying your personal preferences, as described in Section 5.14, “Configuring the Number of 
Entries to Display on a Folder Page,” on page 71.


2.3 Finding What’s Unread
Novell Vibe enables you to view unread entries in any workspace or folder.


1 Navigate to the workspace or folder where you want to view all unread entries.
2 Click View > What’s Unread in Workspace in the Action toolbar to see what’s unread in a 


workspace.
or
Click View > What’s Unread in Folder in the Action toolbar to see what’s unread in a folder.
Vibe displays all of the entries that you have not yet read.


Click Mark These Read to mark all unread entries as read. These entries no longer appear when you 
click What’s Unread in this workspace or folder.


2.4 Searching for Information
Search functionality in Novell Vibe enables you to accomplish the following tasks:


 Discover what information is available about a particular topic.
 Quickly navigate to a workspace (personal, team, etc.), folder, or tagged item that you know 


exists on the Vibe site.
 Locate a subject-matter expert.
 Locate a relevant workspace or folder.
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The following topics describe Search functionality:


 Section 2.4.1, “Using Basic Search,” on page 30
 Section 2.4.2, “Searching for Specific People, Places, or Tagged Items,” on page 33
 Section 2.4.3, “Using Advanced Search,” on page 33
 Section 2.4.4, “Searching for Deleted Items,” on page 34
 Section 2.4.5, “Saving and Reusing Searches,” on page 35
 Section 2.4.6, “Locating a Subject-Matter Expert,” on page 36
 Section 2.4.7, “Locating a Relevant Workspace or Folder,” on page 36


2.4.1 Using Basic Search


To perform a basic search:


1 Type the words or quoted phrases into the Search field, then either press Enter on your keyboard, 
or click the Search icon .


Vibe enables you to refine your basic search in the following ways: 


Search Capability Function Example


AND, OR, and NOT between two 
terms.


Searches for Vibe entries where 
two terms or phrases:


 Both exist (AND)


 Either exist (OR)


 One exists but not the other 
(NOT)


By default, Vibe uses AND when 
you do not specify an operator 
between two terms.


sales NOT figure searches for 
Vibe entries that contain the term 
“sales” but not the term “figure.”


Double quotation marks 
surrounding a phrase.


Groups words together to make a 
phrase.


“marketing meeting notes”
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Field name followed by a colon, 
followed by brackets that contain a 
date range.


Searches a specific field that 
contains values within a specific 
date range.


birthDate:{20070503* TO 
20100608*} searches all entries 
whose birthDate field contains 
values greater than 5/3/2007 and 
less than 6/8/2010. Use curly 
brackets if you want to exclude the 
beginning and ending dates from 
the search, as in the above 
example. Or, use square brackets if 
you want to include the beginning 
and ending dates that you specify. 
For example, 
birthDate:[20070503* TO 
20100608*] searches all entries 
whose birthDate field contains 
values of 5/3/2007 or greater and 6/
8/2010 or less.


The search field name (birthDate) is 
the same as the internal data 
element name that you can obtain 
from the Form and View Designer 
for entry definitions. (For more 
information, see “Creating a 
Custom Folder Entry Form” in the 
Novell Vibe 3.2 Advanced User 
Guide.)


Asterisk (*) after word fragments.


You cannot put an asterisk before 
word fragments.


Searches for words that begin with 
the word fragment that you specify.


work* searches for words such as 
“workspace” and “workshop.”


*space does not search for words 
ending in “space,” such as 
“workspace.”


Question mark (?) as a replacement 
for any single character.


Replaces any single character in 
your search. You can use multiple 
question marks to replace multiple 
characters.


t??e returns all results containing 
the words “true,” “tree,” and so 
forth.


You cannot use a question mark as 
the first character in a search.


Tilde (~) after a term. Searches for approximate matches 
for a single word.


roam~ finds matches such as 
“foam” and “roams”.


Tilde (~) after a group of words, 
followed by a number.


Searches for instances of the words 
that you specify that are within a 
certain distance.


“marketing notes”~5 searches 
for instances where the words 
“marketing” and “notes” appear 
within 5 words of each other.


Search Capability Function Example
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Caret (^) after a term. When you search for more than one 
word, using the caret (^) symbol 
after a word gives higher relevance 
to the word (entries with more 
occurrences of the term are 
displayed first in the search results). 
Adding a number after the caret 
symbol gives even higher relevance 
to the word.


By default, the relevance factor is 1. 
For example sales is the same as 
sales^1.


sales^ figure finds matches for 
“sales” and “figure,” giving higher 
relevance to the term “sales” 
(entries with more occurrences of 
the term “sales” are displayed first 
in the search results). To give even 
higher relevance, sales^2 is 
higher than sales^, and sales^3 
is higher than sales^2, and so 
forth.


You can also give relevance to 
phrases. For example, “sales 
figure”^2 “marketing 
figure”


Minus (-) before a word Excludes the word from the search. -tree excludes all items 
containing “tree,” “Tree,” “TREE,” 
and so on.


Field name followed by a colon, 
followed by what you want to 
search for.


Searches a specific field. When 
searching a specific field, you must 
search on the data name of the 
field. Data names resemble the true 
names found in the interface.


Fields you can search on are:


_creationDate


_creatorName


_modificationDate


_modificationName


_ownerName


_ownerTitle


_workflowState


_fileName


_fileStatus


_fileExt


_rating


_loginName


_groupName


firstName


middleName


lastName


emailAddress


txtEmailAddress


mobileEmailAddress


title


description


When searching in a specific field, 
the field name is always case-
sensitive, even for a case-
insensitive search.


title:meeting finds instances of 
the word “meeting” in the entry Title 
field.


description:meeting finds 
instances of the word “meeting” in 
the entry Description field.


emailAddress:jchavez* finds 
instances of  “jchavez” in the Email 
Address field.


Search Capability Function Example
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Click the Search Options icon  to refine your search to include only people, places, or tags, as 
described in Section 2.4.2, “Searching for Specific People, Places, or Tagged Items,” on page 33. 


You can also select one of your saved searches.


2.4.2 Searching for Specific People, Places, or Tagged Items


To refine your search to include only people, places, or tags:


1 Click the Search Options icon .
2 Select one of the following options:


 People: Enables you to quickly navigate to a user’s personal workspace.
 Places: Enables you to quickly navigate to any folder or workspace within Vibe. For 


example, if you want to locate a colleague’s Blog folder, simply type blog, then specify the 
name of your colleague. The appropriate place is listed in the drop-down list.


 Tags: Enables you to locate any workspaces, folders, or entries that have been tagged. 
Specify the name of the tag that you are searching for, and click the name in the drop-down 
list. Vibe displays all of the workspaces, folders, and entries that have been tagged with that 
particular tag.
Vibe displays all personal tags, and all community tags for which you have appropriate 
rights.


3 In the provided field, begin typing the name of the person, place, or tag that you are searching 
for.
Vibe applies type-to-find functionality. As you type, Vibe lists items matching what you have 
typed so far (all items matching “d”, then all items matching “di,” for example).
If there is more than one panel of choices, you can click the left-arrow and right-arrow icons to 
review your choices.


4 Click the name of the person, place, or tag when it appears in the drop-down list.
The person, place, or tagged items are displayed.


2.4.3 Using Advanced Search


Advanced Search enables you to narrow your search based on various criteria.


1 Click the Search Options icon .
2 Click Advanced Search.


You can also perform an advanced search from the Search Results page.


1 Click Advanced Search.


If your search requires more than one criterion, click Add and Vibe provides another field for your 
use. 


Click the X icon next to a criterion to remove it from the search.


Text: Enter the specific text that you are searching for.


For more information about the various ways that you can refine a text-based search, see 
Section 2.4.1, “Using Basic Search,” on page 30.
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Places: This section enables you to restrict your search to a particular place. Expand the tree by 
clicking the plus sign (+) next to the Home Workspace, then navigate to and select the workspace or 
folder that you want to search.


Search All Sub Places: Searches everything below what you selected in the Workspace tree.


Search deleted items: Search for items that have been deleted. The search returns only items that 
have been deleted.


Items Per Page: Select how many results you want to display on each Search Results page.


Words Per Item: Select the number of words to display for each search result.


Sort by: Select how you want to sort your search results. You can sort search results by the following 
categories:


 Relevance: When you select Relevance, the most relevant results are displayed at the top of the 
list.


 Date: When you select Date, the results that were most recently added or modified that match 
the search criteria are displayed at the top of the list.


 Rating: When you select Rating, entries that have the highest rating are displayed at the top of 
the list. For more information on rating entries, see Section 7.18, “Rating a Folder Entry,” on 
page 121.


 Reply Count: When you select Reply Count, entries that have the most replies are displayed at 
the top of the list.


Sort by (secondary): Enables you to sort your search results by a secondary category. 


If you want to sort by only one category, select the same category that you selected in the Sort by 
drop-down list.


Authors: Search for items based on the author.


Tags: Search for items that are tagged, whether they are community or personal tags. For more 
information on tags, see Section 3.6, “Using Tags,” on page 49.


Workflow: Search for items that have a particular workflow applied to them.


Entry Attributes: Search for entries based on an element that the user selected in the entry, such as a 
select box or a radio button. For example, select Task Entry, then in the next field that appears, select 
Due Date. In the third field that appears, select a day to perform a search for all tasks due on that 
particular day.


Last Activity in Days: Select to search for items that have been active in the last 1, 3, 7, 30, or 90 days.


Creation Dates: Search for items based on when the items were created. In the fields provided, 
specify the start and end dates of the desired interval.


Modification Dates: Search for items based on when the items were last modified. In the fields 
provided, specify the start and end dates of the desired interval.


Item Type: Select the type of item you are searching for.


2.4.4 Searching for Deleted Items


Vibe enables you to search for items that have been deleted from the Vibe site. After you find the 
deleted item that you’re searching for, you can view the item by clicking it. For information on how to 
undelete the item, see Section 4.1.4, “Undeleting a Workspace,” on page 53, Section 5.4, “Undeleting 
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a Folder,” on page 64, or Section 7.9, “Undeleting a Folder Entry,” on page 108. You can undelete the 
item only if you have appropriate rights. If you want to undelete the item but you do not have 
appropriate rights, contact the user who created the item and ask them to undelete it.


For more information on undeleting items in Vibe, see “Restoring Deleted Items” in the Novell Vibe 
3.2 Advanced User Guide.


To search for a deleted item:


1 Click the Search Options icon .
The Search Options dialog box is displayed.


2 Click Advanced Search.
3 Select Search deleted items.
4 (Optional) Narrow your search in any of the ways described in Section 2.4.3, “Using Advanced 


Search,” on page 33.
If you decide not to narrow your search, all items that have been deleted from Vibe are 
displayed.
 Purged items cannot be displayed.


5 Click Search.


2.4.5 Saving and Reusing Searches


Vibe enables you to save searches, so you can reuse them in the future.


 “Saving Your Search” on page 35
 “Accessing Saved Searches” on page 35


Saving Your Search


To save a search for later use:


1 After you have performed a search that you want to save, click View > Saved Searches in the 
Action toolbar.
The Saved Searches dialog box is displayed.


2 In the Manage Saved Searches section, specify the name of the search that you want to save, then 
click Save > Close. 


Accessing Saved Searches


1 Click the Search Options icon .
The Search Options dialog box is displayed.


2 In the Saved Searches drop-down list, click the saved search that you want to access.
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2.4.6 Locating a Subject-Matter Expert


Vibe enables you to locate subject-matter experts by providing a list of users who have written the 
most concerning a particular topic. For example, you might want to locate a user in your organization 
who knows a lot about Java code.


1 Perform a basic or advanced search, as described in Section 2.4.1, “Using Basic Search,” on 
page 30 and Section 2.4.3, “Using Advanced Search,” on page 33.
The Search Results page is displayed with a list of entries that match your search criteria.


2 Click View > Top Ranked in the Action toolbar.
A list of top-ranked places and top-ranked people is displayed. The users at the top of the Top 
Ranked People section have made the most posts to the Vibe site concerning the particular topic 
that you searched. Click a user’s name to navigate to the user’s personal workspace.


2.4.7 Locating a Relevant Workspace or Folder


Vibe enables you to locate workspaces and folders that contain information about a particular topic. 
For example, you might want to locate a discussion forum on the Vibe site that is centered on Java 
code.


1 Perform a basic or advanced search, as described in Section 2.4.1, “Using Basic Search,” on 
page 30 and Section 2.4.3, “Using Advanced Search,” on page 33.
The Search Results page is displayed with a list of entries that match your search criteria.


2 Click View > Top Ranked in the Action toolbar.
A list of top-ranked places and top-ranked people is displayed. The places at the top of the Top 
Ranked Places section contain the most information about the particular topic that you searched. 
Click the name of the workspace or folder to quickly navigate there.


2.5 Following and Unfollowing Places and People of Interest
Novell Vibe enables you to follow workspaces, folders, or people. When you follow something or 
someone in Vibe, you can easily see activity generated in the specific place that you are following, or 
by the specific person that you are following.


 Section 2.5.1, “Following Workspaces and Folders,” on page 36
 Section 2.5.2, “Following People,” on page 37
 Section 2.5.3, “Viewing the Workspaces, Folders, and People You Are Following,” on page 37
 Section 2.5.4, “Viewing Activity from the Workspaces, Folders, and People You Are Following,” 


on page 38
 Section 2.5.5, “Unfollowing Workspaces, Folders, or People,” on page 38


2.5.1 Following Workspaces and Folders


 “Following Workspaces” on page 37
 “Following Folders” on page 37
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Following Workspaces


1 Navigate to the workspace that you want to follow.
2 Click Workspace > Follow this Workspace in the Action toolbar.


Following Folders


1 Navigate to the folder that you want to follow.
2 Click Folder > Follow this Folder in the Action toolbar.


2.5.2 Following People 


 “Using the Workspace to Follow Someone” on page 37
 “Using the Presence Icon to Follow Someone” on page 37


Using the Workspace to Follow Someone


1 Navigate to the personal workspace of the user who you want to follow.
2 Click Workspace > Follow this Person in the Action toolbar.


or
On the user’s profile page, click Follow.


Using the Presence Icon to Follow Someone


1 Click the Presence icon  of the user you want to follow.
The Presence icon is displayed next to a user’s name wherever the user has posted or commented 
on a Vibe entry. When you click a user’s presence icon, the Profile Quick View is displayed.


2 Click Follow.


2.5.3 Viewing the Workspaces, Folders, and People You Are Following


You can quickly see which workspaces, folders, and people you are currently following:


1 Navigate to the home page of your personal workspace.
2 Click the What’s New tab.
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3 Select People and Places being Followed.
4 On the right side of the page, the workspaces, folders, and people you are following are 


displayed.


2.5.4 Viewing Activity from the Workspaces, Folders, and People You Are 
Following


If you are currently following a workspace, folder, or person, Vibe enables you to easily see activity 
generated in the specific place that you are following, or by the specific person that you are following.


1 Click What’s New in the Action toolbar.
2 Click Followed Places to view new entries that have been posted to the places you are following.


or
Click Followed People to view new entries that have been contributed by the people you are 
following.


Staying up-to-date on another Vibe user’s micro-blog entries is another reason that you might want to 
follow a person in Vibe. For information on the various and convenient ways that you can view the 
micro-blog entries of people you are following, see Section 2.10.2, “Viewing the Micro-Blog Entries of 
People You Are Following,” on page 40.


2.5.5 Unfollowing Workspaces, Folders, or People


If you are currently following someone or some place in Vibe, it is easy to unfollow that person or 
place.


1 Navigate to the home page of your personal workspace.
2 Click the What’s New tab.
3 Select People and Places being Followed.
4 On the right side of the page, click the X icon next to the person or place that you want to 


unfollow.


2.6 Viewing Recent Contributions
Novell Vibe enables you to quickly revisit entries that you recently posted or recently visited.


1 Navigate to the home page of your personal workspace.
2 Click the Recent tab.


The left column lists all of the entries that you have most recently posted. The right column lists 
all of the entries that you have most recently visited.
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2.7 Viewing Assigned Tasks
To help you keep track of tasks that have been assigned to you, Novell Vibe provides a quick, easy 
way to view tasks.


1 Navigate to the home page of your personal workspace.
2 Click the Tasks and Calendars tab.


In the left column, Vibe displays the tasks that are assigned to you. You can sort them by tasks 
due within two weeks, or any tasks that are currently assigned to you.


2.8 Viewing Calendar Events
To help you keep track of your calendar events, Novell Vibe enables you to view all of the calendar 
events for which you are scheduled on the current day. 


1 Navigate to the home page of your personal workspace.
2 Click the Tasks and Calendars tab.


The right section of the page displays today’s schedule with all of the calendar events from all of 
the calendars you are following.


2.9 Sharing Workspaces, Folders, and Entries
Novell Vibe enables you to share workspaces, folders, and entries with other Vibe users. This is a 
quick and easy way to refer a co-worker to a place on the Vibe site.


 Section 2.9.1, “Sharing Workspaces and Folders,” on page 39
 Section 2.9.2, “Sharing Entries,” on page 39
 Section 2.9.3, “Viewing Shared Items,” on page 40


2.9.1 Sharing Workspaces and Folders


1 Navigate to the workspace or folder that you want to share.
2 Click Workspace > Share This Workspace or Folder > Share This Folder in the Action toolbar.
3 Specify the individual users, groups, or teams that you want to share the workspace or folder 


with.
4 In the Comments field, specify any comments that you want to include in the e-mail.
5 Click OK.


A notification is displayed, stating that an e-mail was successfully sent to the users, groups, or 
teams that you specified.


2.9.2 Sharing Entries


1 Navigate to and open the entry that you want to share.
2 Click Actions > Share this Entry in the Entry toolbar.
3 Specify the individual users, groups, or teams that you want to share the entry with.
4 In the Comments field, specify any comments that you want to include in the e-mail.
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5 Click OK.
A notification is displayed, stating that an e-mail was successfully sent to the users, groups, or 
teams that you specified.


2.9.3 Viewing Shared Items


When others share an item with you, Vibe sends you an e-mail notification with a link to the item. 
Also, Vibe makes it easy to find items that others have shared with you, directly from the Vibe 
interface.


1 Navigate to your personal workspace.
2 Click the Micro-Blogs and Shared Items tab.


In the right column, Vibe lists all of the items that people have shared with you.


2.10 Using Micro-Blogs
Use the Micro-Blog feature to capture quick personal notes, or to inform others of what you are 
currently working on. This provides a greater transparency, so those you work with know what you 
are doing, and how they might offer assistance to help you accomplish your tasks.


Micro-blogs differ from regular blogs because their purpose is not to present an entire topic or 
argument, but rather to give a quick snippet of information from the author of the micro-blog. Micro-
blogs should be only one or two short sentences.


For more information on traditional blogs within Novell Vibe, see Section 6.2, “Working with Blog 
Folders,” on page 76.


 Section 2.10.1, “Posting a Micro-Blog,” on page 40
 Section 2.10.2, “Viewing the Micro-Blog Entries of People You Are Following,” on page 40
 Section 2.10.3, “Viewing the Micro-Blog Entries of Vibe Users You Are Not Following,” on 


page 41


2.10.1 Posting a Micro-Blog


1 Navigate to the home page of your personal workspace.
2 In the What are you working on? field, specify your micro-blog entry, then click Share.


2.10.2 Viewing the Micro-Blog Entries of People You Are Following


You can view the micro-blog entries of people you are following in three convenient ways:


 “Setting Up a Live Feed to View the Micro-Blog Entries of People You Are Following” on 
page 41


 “Using the Relevance Tabs in Your Personal Workspace to View the Micro-Blog Entries of People 
You Are Following” on page 41


 “Using Your Mobile Device to View the Micro-Blog Entries of People You Are Following” on 
page 41


For information on how to follow people in Vibe, see Section 2.5.1, “Following Workspaces and 
Folders,” on page 36.
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Setting Up a Live Feed to View the Micro-Blog Entries of People You Are 
Following


Like Twitter, Vibe enables you to see live feeds for the micro-blog entries of the people you are 
following.


For information on how to set up a live micro-blog feed, see Section 2.13.1, “Setting Up a Live Feed,” 
on page 44.


Using the Relevance Tabs in Your Personal Workspace to View the Micro-Blog 
Entries of People You Are Following


1 Navigate to your personal workspace.
2 Click the Micro-Blogs and Shared Items tab.


The Micro-Blogs being Followed column lists the micro-blog entries of the people you are currently 
following.


Using Your Mobile Device to View the Micro-Blog Entries of People You Are 
Following


Vibe enables you to use your mobile device to view the micro-blog entries of the people you are 
following, as described in  “Viewing the Newest Micro-Blog Entries of People You’re Following” in 
“Using Vibe on Your Mobile Phone” in the Novell Vibe 3.2 Advanced User Guide.


2.10.3 Viewing the Micro-Blog Entries of Vibe Users You Are Not Following


 “Viewing a User’s Micro-Blog Entries by Using the Presence Icon” on page 41
 “Viewing a User’s Micro-Blog Entries by Navigating to His or Her Personal Workspace” on 


page 42


Viewing a User’s Micro-Blog Entries by Using the Presence Icon


Vibe enables you to view a user’s micro-blog entries by clicking the user’s Presence icon , located 
next to his or her name in an entry.


1 Click the Presence icon  of the user whose micro-blog entries you want to view.
The Profile Quick View is displayed.


2 Click Micro-Blog.
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Viewing a User’s Micro-Blog Entries by Navigating to His or Her Personal 
Workspace


You can navigate to a user’s personal workspace to view the micro-blog entries.


1 Navigate to the personal workspace of the user whose micro-blog entries you want to view.
2 In the Navigation panel, click the Micro-Blog folder.


The user’s micro-blog entries are listed in the folder.


2.11 Subscribing to a Folder or Entry
You can configure Novell Vibe to send you e-mail notifications for folders and their sub-folders, or 
for individual entries. This is called “subscribing” to a folder or entry. Also, folder owners can 
configure Vibe to send e-mail notifications to you (as described in “Configuring Folders to Send E-
Mail Notifications to Other Users” in the Novell Vibe 3.2 Advanced User Guide Novell Vibe 3.2 User 
Guide). However, because a user’s individual subscription settings override those of the folder owner, 
you can override any higher-level configurations.


If you are particularly interested in a specific folder or entry, you might want to subscribe to that 
folder or entry. When you subscribe to a folder or entry, Vibe notifies you of the activity that takes 
place in the folder or entry.


 Section 2.11.1, “Subscribing to a Folder,” on page 42
 Section 2.11.2, “Subscribing to an Entry,” on page 42
 Section 2.11.3, “Selecting Notification Types and Delivery Destinations,” on page 43
 Section 2.11.4, “Adding and Modifying Delivery Destinations,” on page 43
 Section 2.11.5, “Overriding Higher-Level Notification Settings,” on page 43


2.11.1 Subscribing to a Folder


1 Navigate to the folder that you want to subscribe to.
2 Click Folder > E-Mail Notification in the Action toolbar.


The Select the Type of E-Mail Notification dialog box is displayed.
3 Continue with Section 2.11.3, “Selecting Notification Types and Delivery Destinations,” on 


page 43.


2.11.2 Subscribing to an Entry


1 Navigate to and open the entry that you want to subscribe to.
2 In the Footer toolbar of the entry, click Subscribe to This Entry.


The Select the Type of E-Mail Notification form is displayed.
3 Continue with Section 2.11.3, “Selecting Notification Types and Delivery Destinations,” on 


page 43.

42 Novell Vibe 3.2 User Guide







2.11.3 Selecting Notification Types and Delivery Destinations


This form enables you to choose which type of notification that you want to receive, as well as the e-
mail address or phone number that you want the notifications to be sent to.


1 Select an e-mail address or phone number where you want the notifications to be sent.
You can select multiple e-mail or phone number delivery destinations for each notification type 
by simply pressing Ctrl and selecting the e-mail addresses or phone numbers.
You can select these delivery destinations in any of the provided sections, which represent the e-
mail notification types:
Digest: (Available for folders only) Vibe sends one message that summarizes all of the activity in 
the folder and its sub-folders. Vibe sends digest notifications at a schedule established by your 
site administrator.
Individual Messages: (Includes Attachments) Vibe sends one message for every new or 
changed entry, and messages include attached files.
Individual Messages without Attachments: Vibe sends one message for every new or changed 
entry. The e-mail messages do not include files that might be attached to the new or changed 
entries. Vibe sends all types of individual notifications every five minutes.
Message Suitable for Text Messaging: Vibe sends a message suitable for viewing as a text 
message. The content of the message includes only the linked title of the new or changed entry. 
Vibe sends text-message notifications up to every five minutes.


2 (Optional) Select Override preset notifications with these selections if you want your selections to 
override those made by the administrator or folder owner.
For more information, see Section 2.11.5, “Overriding Higher-Level Notification Settings,” on 
page 43. 


3 Click OK.


2.11.4 Adding and Modifying Delivery Destinations


You can add and modify your e-mail and phone number contact information in your Personal Profile.


1 Navigate to the home page of your personal workspace, then click the Profile link next to your 
avatar (picture).


2 Click Edit.
3 Specify the appropriate delivery destination information in the E-Mail Address, Mobile E-Mail 


Address, and Text Messaging E-Mail Address fields.
4 Click OK.


Now, when you select your notification types and delivery destinations as described in Section 2.11.3, 
“Selecting Notification Types and Delivery Destinations,” on page 43, the new or modified contact 
information is displayed.


2.11.5 Overriding Higher-Level Notification Settings


If a folder owner or administrator has configured a folder to send you e-mail notifications, you can 
override the higher-level settings.


1 Navigate to the folder where you want to override the higher-level notification settings.
2 Click Folder > E-mail Notification.
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3 Select the kinds of notification that you want to receive.
4 Select Override preset notifications with these selections.
5 Click OK.


If you want to receive no e-mail notifications:


1 Navigate to the folder where you want to override the higher-level notification settings.
2 Click Folder > E-mail Notification.
3 Ensure that no e-mail address is selected in any of the sections.
4 Select Override preset notifications with these selections.
5 Click OK.


2.12 Using Remote Applications
Remote applications communicate with a third-party online application, and send information from 
that third-party application back to Novell Vibe. 


For example, your Vibe administrator could create a remote application for Twitter that displays all 
of your Twitter entries in Vibe. 


Remote applications are very customizable, and are set up by your Vibe administrator. Consult your 
Vibe administrator if you have a request for a new remote application.


For information on displaying remote applications that have been enabled by your Vibe 
administrator, see “Managing Remote Applications” in the Novell Vibe 3.2 Advanced User Guide.


You can also display remote applications as folder and workspace accessories, as described in 
Section 8.1, “Creating an Accessory,” on page 123.


2.13 Viewing Live Feeds
Novell Vibe enables you to view live feeds of the latest entries in your teams, followed places, or 
across the entire site, so you can be up-to-date in real time without entering the Vibe site. And, like 
Twitter, you can see live feeds for the micro-blog entries of the people you are following.


 Section 2.13.1, “Setting Up a Live Feed,” on page 44
 Section 2.13.2, “Viewing New Entries in Your Live Feed,” on page 45
 Section 2.13.3, “Using the Notification Area to View the Number of New Entries,” on page 45
 Section 2.13.4, “Displaying a News Feed in the GroupWise Client,” on page 45


2.13.1 Setting Up a Live Feed


To set up a live feed from your Vibe site:


1 Click the Settings icon  in the upper right corner of the Vibe site, then click the News Feed icon 


.
The live feed is displayed.


2 In the Select Feed drop-down list, select from the following options:
 My Teams: Displays the most recent entries of members of your various teams.
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 All Followed: Displays the most recent entries that have been posted to the places that you 
are currently following, as well as the by the people you are currently following.


 Site Wide: Displays the most recent entries that have been posted to the Vibe site.
 Micro-Blogs: Displays the most recent micro-blog entries of the people that you are 


currently following.
3 (Optional) Minimize the live feed window.


The live feed window is displayed in your desktop notification area.


2.13.2 Viewing New Entries in Your Live Feed


1 Open the live feed window that you minimized (located in your desktop notification area).
The live feed is automatically updated every five minutes. To instantly update the feed and see 
the most recent entries, click Refresh.


2.13.3 Using the Notification Area to View the Number of New Entries


In the Firefox Web browser, you can view how many new entries have been posted since the last time 
the live feed was refreshed.


1 Look at the notification area of the feed window that you minimized. The number of new entries 
is displayed on the left. If there are no new entries, no number is displayed.


2.13.4 Displaying a News Feed in the GroupWise Client


You can display your Vibe news feed in the GroupWise client. This enables you to keep up with the 
latest Vibe additions without leaving GroupWise.


For information on how to do this, see “Creating a New Panel” in “Getting Organized” in the 
GroupWise 2012 Windows Client User Guide.


2.14 Viewing Folders as RSS or Atom Feeds
RSS and Atom enable you to set up feeds to Novell Vibe folders and view those feeds in one 
convenient location.


You can set up a Vibe folder to be accessed by an RSS or Atom reader, so the Vibe folder sends new or 
modified folder entries to your RSS or Atom reader. This is an easy way to stay informed on activity 
in a certain folder.


For more information, see“Viewing Vibe Folders as RSS or Atom Feeds” in the Novell Vibe 3.2 
Advanced User Guide.

Getting Informed 45



http://www.novell.com/documentation/groupwise2012/pdfdoc/gw2012_guide_userwin/gw2012_guide_userwin.pdf#b9pq1v4

http://www.novell.com/documentation/groupwise2012/pdfdoc/gw2012_guide_userwin/gw2012_guide_userwin.pdf#bg1iyzw

http://www.novell.com/documentation/groupwise2012/pdfdoc/gw2012_guide_userwin/gw2012_guide_userwin.pdf#Ab32nt1





2.15 Synchronizing Tasks and Calendars to a Desktop 
Application
iCal functionality in Novell Vibe enables you to synchronize Vibe tasks and calendars with any 
desktop application that supports the iCal format (for example, Google and Outlook). You can 
synchronize tasks and calendars in the following ways:


 Section 2.15.1, “Synchronizing Tasks Folders and Calendar Folders,” on page 46
 Section 2.15.2, “Synchronizing Task and Calendar Items When Entries Are Created,” on page 46


2.15.1 Synchronizing Tasks Folders and Calendar Folders


You can synchronize Vibe Tasks folders and Calendar folders to other task lists and calendars that 
support the iCal format.


1 Navigate to the Tasks folder or Calendar folder that you want to synchronize to your desktop 
calendar application.


2 Click the Footer toolbar, located at the bottom of the folder page.
3 In the iCal URL section in the provided table, select and copy the iCal URL.


You use this link to export Vibe calendar data for inclusion in another calendar that supports the 
iCal format.


4 Paste the iCal URL into the required section of the desktop calendar application.
Consult the documentation for the desktop application for instructions on where to paste the 
iCal URL and complete the synchronization.


2.15.2 Synchronizing Task and Calendar Items When Entries Are Created


When you create a task or calendar entry in Vibe, you can configure Vibe to send an e-mail 
notification and iCal task/appointment to all of the users, groups, or teams that you associated with 
the task or calendar entry. 


1 When creating the entry, select Send an E-Mail Notification to Assignees, or Send an E-Mail 
Notification to Attendees, depending on whether you are creating a task or a calendar entry.


iCal tasks and appointments appear in the recipients’ main task list or calendar if the e-mail 
application supports iCal. When users mark a task Accepted or Completed, an e-mail message is sent 
to the original entry creator, notifying the entry creator of the change. However, the change in status 
is not reflected in Vibe.


For more information on how to create an entry in Vibe, see Section 7.1, “Creating a Folder Entry,” on 
page 101.
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3 3Navigating the Novell Vibe Interface


Novell Vibe provides various methods of navigating the interface.


 Section 3.1, “Navigating the Workspace Tree,” on page 47
 Section 3.2, “Viewing and Revisiting Recent Places,” on page 47
 Section 3.3, “Viewing and Revisiting Recent Entries,” on page 47
 Section 3.4, “Managing Your Favorite Places,” on page 48
 Section 3.5, “Accessing Your Teams,” on page 48
 Section 3.6, “Using Tags,” on page 49


3.1 Navigating the Workspace Tree
You can access the Workspace tree from any page within Novell Vibe. Located in the upper left 
corner of the Vibe interface, the Workspace tree icon  displays the path of all of the workspaces and 
folders that contain the place you are currently viewing, without leaving the current page. 


To navigate to another workspace or folder:


1 Click the Workspace tree icon .
2 Expand Home Workspace.
3 Navigate to and click the linked name of the desired location in the Workspace tree.


Vibe displays the desired location.


3.2 Viewing and Revisiting Recent Places
Novell Vibe provides a list of folders and workspaces that you have recently visited in the Vibe site. 
You can quickly revisit the places you have most recently accessed.


1 Click Recent Places in the Action toolbar, then click the place that you want to revisit.


By default, Vibe stores your 20 most-recently visited places.


3.3 Viewing and Revisiting Recent Entries
Novell Vibe enables you to view and quickly revisit the entries that you have recently posted and 
recently visited.


1 Click My Workspace in the Action toolbar.
2 Click the Recent tab.
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In the left column, Vibe displays the entries that you have recently posted.
In the right column, Vibe displays the entries that you have recently visited.


3.4 Managing Your Favorite Places
Novell Vibe enables you to easily add, access, and edit your favorite places in the Vibe site.


 Section 3.4.1, “Adding a Favorite Place,” on page 48
 Section 3.4.2, “Accessing Your Favorite Places,” on page 48
 Section 3.4.3, “Editing Your Favorite Places,” on page 48


3.4.1 Adding a Favorite Place


1 Navigate to a workspace or folder that you want to add as a favorite.
2 Click My Favorites in the Action toolbar.
3 Click Add This Place.


3.4.2 Accessing Your Favorite Places


1 Click My Favorites in the Action toolbar.
2 Click the linked title of the place that you want to visit.


3.4.3 Editing Your Favorite Places


You can edit your favorite places by reordering their position in the list, or by deleting them.


1 Click My Favorites in the Action toolbar. 
2 Click Edit Favorites.


The Edit Favorites dialog box is displayed.
3 Select the item you want to edit.
4 Click Move Up, Move Down, or Delete.
5 Click OK.


3.5 Accessing Your Teams
Novell Vibe makes it easy to quickly access team workspaces where you are a member.


1 Click My Teams in the Action toolbar.
All of the teams of which you are a member are displayed.


2 Click the linked title of the team workspace that you want to visit.
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3.6 Using Tags
Tags are keywords that categorize a workspace, folder, or entry. Tagging functionality in Novell Vibe 
enables you to create virtual containers for places and entries. Like folders in your e-mail, you can 
categorize information, and then come back to it at a later time.


 Section 3.6.1, “Tagging Workspaces or Folders,” on page 49
 Section 3.6.2, “Tagging Entries,” on page 49
 Section 3.6.3, “Locating Tagged Items,” on page 50
 Section 3.6.4, “Choosing Between Personal Tags and Global Tags,” on page 50


3.6.1 Tagging Workspaces or Folders


1 Navigate to the workspace or folder that you want to tag.
2 Click Workspace > Tag this Workspace, or click Folder > Tag this Folder in the Action toolbar, 


depending on whether you want to tag a workspace or folder.
The Tag this Workspace or Tag this Folder dialog box is displayed.


3 Select either Personal Tag or Global Tag, depending on whether you want this tag to be visible to 
only yourself or to the entire community.
For more information about the difference between personal and community tags, see 
Section 3.6.4, “Choosing Between Personal Tags and Global Tags,” on page 50.


4 Begin typing the name of the tag that you want to apply to the workspace or folder.
This field uses type-to-find functionality, so if a tag already exists with the desired name, it 
appears in the drop-down list. If the name does not appear in the drop-down list, you are 
creating a new tag.
To see a list of existing tags, click inside the provided field, then press the Spacebar.


5 Finish typing the name of the tag, or select it from the drop-down list, then click the Add icon .
The workspace or folder is now marked with the tag that you specified, and the tag is displayed 
in the Tag this Workspace dialog box.


6 Click OK.


3.6.2 Tagging Entries


1 In the entry that you want to tag, click the Tags tab.
2 Click Add Tags.
3 Select either Personal Tag or Global Tag, depending on whether you want this tag to be visible to 


only yourself or to the entire community.
For more information about the difference between personal and community tags, see 
Section 3.6.4, “Choosing Between Personal Tags and Global Tags,” on page 50.


4 Begin typing the name of the tag that you want to apply to the entry.
This field uses type-to-find functionality, so if a tag already exists with the desired name, it 
appears in the drop-down list. If the name does not appear in the drop-down list, you are 
creating a new tag.
To see a list of existing tags, click inside the provided field, then press the Spacebar.


5 Finish typing the name of the tag, or select it from the drop-down list, then click the Add icon .
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The entry is now marked with the tag that you specified.
6 Click Close.


3.6.3 Locating Tagged Items


Vibe enables you to locate all places and entries that have a particular tag.


1 Click the Search Options icon .
The Search Options dialog box is displayed.


2 Select Tags.
3 In the provided field, specify the name of the tag that you are searching for.


To see a list of existing tags, click inside the provided field, then press the Spacebar.
4 Select the tag from the drop-down list.


Vibe displays all of the places and entries that have been tagged with the tag that you specified.


3.6.4 Choosing Between Personal Tags and Global Tags


Personal Tags: Personal tags are for your use only. When you create a personal tag, it can be used and 
viewed only by you.


Global Tags: Global tags can be used and viewed by anyone who has rights to view the workspace, 
folder, or entry where a global tag is implemented. For example, if you create a global tag on the Files 
folder in your team workspace, then anyone with View rights to the Files folder can use the tag you 
created to tag other places with the same tag name. They can also use Vibe Search and Find features 
to locate entries that have been tagged with that tag name.


You can tag places and entries with a global tag only if you have appropriate rights. 


For more information on using Search to locate tagged items, see Section 2.4.3, “Using Advanced 
Search,” on page 33.
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4 4Managing and Using Workspaces


Your Novell Vibe site is made up of various workspaces. Workspaces are designated areas where 
people can work together to accomplish tasks. Vibe supports multiple types of workspaces, including 
personal workspaces, where you can store items such as your personal files, calendars, and tasks; and 
team workspaces, where you can collaborate with team members by sharing ideas, files, and more. 
Other useful types of workspaces are also available for you to use. 


You can see the structure of the workspaces in your Vibe site by clicking the Workspace tree icon , 
expanding Home Workspace, and browsing the Workspace tree.


 Section 4.1, “General Workspace Management,” on page 51
 Section 4.2, “Managing Your Personal Workspace,” on page 56
 Section 4.3, “Managing a Team Workspace,” on page 59
 Section 4.4, “Managing a Discussions Workspace,” on page 62
 Section 4.5, “Managing a Project Management Workspace,” on page 62
 Section 4.6, “Managing a Landing Page,” on page 62
 Section 4.7, “Understanding Global Workspaces,” on page 62


4.1 General Workspace Management
This section contains task information that applies to all types of workspaces.


 Section 4.1.1, “Creating a New Workspace,” on page 52
 Section 4.1.2, “Modifying a Workspace,” on page 52
 Section 4.1.3, “Deleting a Workspace,” on page 52
 Section 4.1.4, “Undeleting a Workspace,” on page 53
 Section 4.1.5, “Copying a Workspace,” on page 53
 Section 4.1.6, “Moving a Workspace,” on page 53
 Section 4.1.7, “Adding a Sub-Workspace,” on page 54
 Section 4.1.8, “Adding Additional Folders to a Workspace,” on page 54
 Section 4.1.9, “Generating Activity Reports for a Workspace,” on page 55
 Section 4.1.10, “Defining a User-Friendly URL for a Workspace or Folder,” on page 55
 Section 4.1.11, “Setting a Data Quota for a Workspace,” on page 56
 Section 4.1.12, “Customizing the Workspace View,” on page 56
 Section 4.1.13, “Branding a Workspace,” on page 56
 Section 4.1.14, “Displaying YouTube Videos in a Workspace,” on page 56
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4.1.1 Creating a New Workspace


Novell Vibe enables you to create new workspaces in any workspace where you have appropriate 
rights.


1 Navigate to the workspace where you want to create the new workspace.
2 Click Workspace > New Workspace.


The New Workspace page is displayed.
3 Specify the appropriate information for the page.


Workspace Title: Specify a title for the workspace.
If you leave this field blank, the workspace is titled Workspace.
Workspace: Select the type of workspace that you want to create.
Fill in any additional information fields that display when you select the workspace type.
Team Members: (Conditional) This section is displayed only if you are creating a team 
workspace. Use this section to specify users and groups that you want to include as members of 
your team workspace.
Workspace Folders: Use this section to select the folders that you want the workspace to contain.
Announcement: (Optional) Create an announcement message to be sent to all members of the 
team.
If you are not creating a team workspace, this message is sent to all team members of the parent 
workspace.


4 Click OK.


4.1.2 Modifying a Workspace


After the workspace has been created, you can modify the workspace title and description, change 
the icon that represents the workspace, and upload attachments to the workspace.


1 Navigate to the workspace that you want to modify.
2 Click Workspace > Edit Workspace.
3 Modify the workspace as desired, then click OK.


4.1.3 Deleting a Workspace


1 Navigate to the workspace that you want to delete.
2 Click Workspace > Delete Workspace.


The Delete Workspace page is displayed.
3 (Optional) Select Purge this workspace immediately if you want to purge the workspace so that it 


cannot be recovered.


IMPORTANT: Selecting this option renders the workspace and all folders and entries within the 
workspace unrecoverable; they are permanently deleted from the Vibe site.


If you do not select this option, you can undelete the workspace as described in Section 4.1.4, 
“Undeleting a Workspace,” on page 53.


4 (Conditional) If the workspace contains mirrored folders, you can select to delete the source files 
of the folders, and also all of the mirrored folders’ sub-folders.
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For more information on working with mirrored folders, see “Working with Mirrored Folders” 
in the Novell Vibe 3.2 Advanced User Guide.


5 Click OK.


4.1.4 Undeleting a Workspace


Vibe enables you to undelete a workspace that you previously deleted, restoring it to its previous 
location.


1 Navigate to the workspace where the deleted workspace previously resided.
For example, if you want to restore a team workspace that was in the Team Workspaces directory, 
navigate to the Team Workspaces directory.


TIP: If you want to see everything that has been deleted in the Vibe site, navigate to the highest 
level workspace. (By default this is the Home Workspace directory.)


2 Click the Trash folder in the Navigation panel.
or
Click View > Trash in the Action toolbar.
The Trash page displays all workspaces, folders, and entries that have been deleted in or below 
the current workspace. Items that have been purged are not displayed because they are 
unrecoverable.


3 Select the workspace that you want to undelete. Also, select any folders that the workspace 
contained that you also want to restore.


4 Click Restore.
The workspace and any folders that you selected are restored to their previous location.


For more information about undeleting, see “Restoring Deleted Items” in the Novell Vibe 3.2 Advanced 
User Guide.


4.1.5 Copying a Workspace


1 Navigate to the workspace that you want to copy.
2 Click Workspace > Copy Workspace.


The Copy Workspace page is displayed.
3 Use one of the following methods to copy the workspace:


 Select the Destination Folder or Workspace: Use the Workspace tree to navigate to and 
select the folder or workspace where you want to copy the workspace.


 Find the Destination Folder or Workspace: In the provided field, specify the name of the 
folder or workspace where you want to copy the workspace.


4 Click OK.


4.1.6 Moving a Workspace


Vibe enables you to move a workspace into any folder or workspace where you have appropriate 
rights.


1 Navigate to the workspace that you want to move.
2 Click Workspace > Move Workspace.
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The Move Workspace page is displayed.
3 Use one of the following methods to move the workspace:


 Select the Destination Folder or Workspace: Use the Workspace tree to navigate to and 
select the folder or workspace where you want to move the workspace.


 Find the Destination Folder or Workspace: In the provided field, specify the name of the 
folder or workspace where you want to move the workspace.


4 Click OK.


4.1.7 Adding a Sub-Workspace


Vibe enables you to create sub-workspaces inside of existing workspaces.


1 Navigate to the workspace where you want to add the sub-workspace.
2 Click Workspace > New Workspace.


The New Workspace page is displayed.
3 Specify the information.


Workspace title: Specify a title for the workspace.
If you leave this field blank, the workspace is titled Workspace.
Team Members: (Conditional) This section is displayed only if you are creating a team 
workspace. Use this section to specify users and groups that you want to include as members of 
your team workspace.
Workspace: Select the type of workspace that you want to create.
Fill in any additional information fields that display when you select the workspace type.
Workspace Folders: Use this section to select the folders that you want the workspace to contain.
Announcement: (Optional) Create an announcement message to be sent to all members of the 
team.
If you are not creating a team workspace, this message is sent to all team members of the parent 
workspace.


4 Click OK.


4.1.8 Adding Additional Folders to a Workspace


Vibe enables you to add additional folders to your workspace at any time.


1 Navigate to the workspace where you want to add the new folders.
2 Click Workspace > New Folder.


The New Folder page is displayed.
3 Specify the following information:


Folder Title: Specify a title for the folder.
If you do not provide a title, the folder is given the default folder name. For example, a 
Discussion folder is named Discussion.
Folder: Select the type of folder that you want to create.
For information about each type of folder, see Chapter 6, “Working with Specific Folder Types,” 
on page 75.


4 Click OK.
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4.1.9 Generating Activity Reports for a Workspace


Vibe enables you to generate reports about the activity that has occurred in a particular workspace.


1 Navigate to the workspace that you want to generate the activity report for.
2 Click View > Activity Report.


The Folder Activity page is displayed.
3 Specify the following information:


Report on Activity Between: Select the date range for which you want to generate the activity 
report.
Report Workspace or Folder Activity: Select this option to see how many views, adds, modifies, 
and deletes have been made in the folder. You can generate a report for the following categories 
of users:
 Team Members: View the workspace activity of individual team members only.
 All Users: View the workspace activity of all Vibe users. This option shows the name of 


each user who has had some type of activity in the workspace.
 Summary: View a summary of all the activity that has occurred in the workspace. This 


option does not list individual users.
Report on Workflow State: Select this option to view the activity of a workflow. You can select 
to show the average amount of time the workflow spent in each state, or show the number of 
entries that are currently in each state.
Select the Folders for Reporting: Select the folders about which you want to generate the 
activity report. If you select the workspace, then Vibe generates an activity report that includes 
all folders in the workspace.


4 Click OK.
Vibe launches the report in a spreadsheet. For information regarding the columns in this 
spreadsheet, see Section 7.15.1, “Generating Activity Reports,” on page 119.


4.1.10 Defining a User-Friendly URL for a Workspace or Folder


A user-friendly URL for your workspace or folder can make it easier for others to navigate to the 
workspace or folder.


1 Navigate to the workspace where you want to define the URL.
2 Click Workspace > Configure Views, URLs and Controls in the Action toolbar.
3 Click the Simple URLs and E-mail Addresses tab.
4 In the Define simple URLs for this folder or workspace section, select one of the predefined global 


keywords from the Define URL drop-down list.
Unless you are a site administrator, your URL must begin with one of these predefined global 
keywords.


5 In the provided field, specify the desired URL for the folder or workspace.
6 Click Add > Close.


To delete a defined URL, select the URL in the Currently defined URLs section, then click Delete selected 
URLs.


Defining a user-friendly URL for a folder can also enable users to e-mail folder entries into the folder, 
as described in Section 5.10, “Setting Up a Folder to Receive Entries Via E-Mail,” on page 68.
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4.1.11 Setting a Data Quota for a Workspace


The Vibe administrator can allow you to set your own data quotas for your workspaces and folders. 
For more information, see “Setting a Data Quota for Workspaces and Folders” in the Novell Vibe 3.2 
Advanced User Guide.


4.1.12 Customizing the Workspace View


Vibe enables you to customize the layout of your workspace. For more information, see “Creating 
Custom Workspace Views” in the Novell Vibe 3.2 Advanced User Guide.


4.1.13 Branding a Workspace


Branding a workspace is a good way to make the workspace more unique and identifiable. When you 
brand a workspace, the brand is also applied to all sub-workspaces and sub-folders.


For more information on branding, see “Branding a Folder or Workspace” in the Novell Vibe 3.2 
Advanced User Guide.


4.1.14 Displaying YouTube Videos in a Workspace


This section describes how to display YouTube videos in the Description section of the workspace. For 
information on how to display YouTube videos in the Branding section of a workspace, see “Branding 
a Folder or Workspace” in the Novell Vibe 3.2 Advanced User Guide.


To display a YouTube video in the Description section of a workspace:


1 Navigate to the workspace where you want to display the YouTube video.
2 Click Workspace > Edit Workspace in the Action toolbar.


3 In the Description section, click the Expand icon  to expand the options in the HTML editor, 
then click the Video icon .


4 In the URL of a Video on YouTube field, paste the URL of the YouTube video that you want to post.
5 In the Dimensions fields, do not make any changes if you want to keep the default YouTube 


dimensions.
6 Click Insert, then click OK to display the video in the workspace.


For more information about other places where you can display YouTube videos in Vibe, see 
Section 7.16, “Displaying YouTube Videos in a Folder Entry,” on page 120.


4.2 Managing Your Personal Workspace
Your personal workspace in Novell Vibe is a place where you can store your personal files, blogs, 
photos, and all other types of Vibe folder entries.


Your personal workspace also includes relevance tabs that help you easily keep track of tasks and 
calendar events, get informed on new entries, view shared items, and more.
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The relevance tabs are located in the home page of your personal workspace. These tabs enable you 
to get quick access to important information that pertains directly to you.


 Section 4.2.1, “Using the What’s New Tab,” on page 57
 Section 4.2.2, “Viewing Recently Posted and Recently Visited Entries,” on page 57
 Section 4.2.3, “Using the Tasks and Calendars Tab,” on page 57
 Section 4.2.4, “Using the Micro-Blogs and Shared Items Tab,” on page 58
 Section 4.2.5, “Using the Accessories Tab,” on page 58
 Section 4.2.6, “Viewing Your Profile Information,” on page 58


4.2.1 Using the What’s New Tab


The What’s New tab enables you to find new content in your teams, in the places you are following, or 
across the entire site.


1 In the home page of your personal workspace, click the What’s New tab.
2 Select My Teams, Places being followed, or Site Wide, depending on where you want Vibe to search 


for new items.
All of the new items recently added are displayed in the left side of the page, in the What’s New 
section.


4.2.2 Viewing Recently Posted and Recently Visited Entries


Vibe enables you to view which entries you have recently posted, and which entries you have 
recently visited. This can help you prioritize what you are working on, or quickly locate an entry that 
you have recently created or viewed.


1 In the home page of your personal workspace, click the Recent tab.
The left section of the page displays the entries that you have recently posted, and the right 
section of the page displays the entries that you have recently visited.


4.2.3 Using the Tasks and Calendars Tab


Use the Tasks and Calendars tab to accomplish the following tasks:


 “Viewing Your Tasks” on page 57
 “Viewing Today’s Calendar Events” on page 58


Viewing Your Tasks


To help you keep track of tasks that have been assigned to you, Vibe provides a quick, easy way to 
view tasks.


1 In the home page of your personal workspace, click the Tasks and Calendars tab.
In the left column, Vibe displays the tasks that are assigned to you. You can sort these tasks by 
tasks due within two weeks, or any tasks that are currently assigned to you.
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Viewing Today’s Calendar Events


To help you keep track of your calendar events, Vibe enables you to view all of the calendar events for 
which you are scheduled on the current day. 


1 In the home page of your personal workspace, click the Tasks and Calendars tab.
The right section of the page displays today’s schedule with all of the calendar events from all of 
the calendars you are following.
For information on how to follow a calendar, see Section 2.5.1, “Following Workspaces and 
Folders,” on page 36.


4.2.4 Using the Micro-Blogs and Shared Items Tab


Use the Micro-Blogs and Shared Items tab to accomplish the following tasks:


 “Viewing the Micro-Blog Entries of People You Are Following” on page 58
 “Viewing What Others Have Shared With You” on page 58


Viewing the Micro-Blog Entries of People You Are Following


1 In the home page of your personal workspace, click the Micro-Blogs and Shared Items tab.
The Micro-Blogs column lists the micro-blog entries of the people you are currently following.
For information on how to select someone to follow, see Section 2.5.2, “Following People,” on 
page 37.


Viewing What Others Have Shared With You


When others share an item with you, Vibe sends you an e-mail notification with a link to the item. 
Also, Vibe makes it easy to find items that others have shared with you.


1 In the home page of your personal workspace, click the Micro-Blogs and Shared Items tab.
In the right column, Vibe lists all of the items that people have shared with you.


4.2.5 Using the Accessories Tab


The Accessories tab contains an accessory panel. You can use this accessory panel to make items in 
your personal workspace more visible. For example, by default, the Accessory tab contains a 
Guestbook accessory that references the Guestbook folder in your personal workspace. By displaying 
this accessory in the Accessories tab, you don’t need to view the Guestbook folder in order to see who 
has signed your Guestbook.


By default, a Task, Guestbook, Blog, and Photo Album accessory exist in this accessory panel, but you 
can add more as you desire. (For information on how to add additional accessories, see Section 8.1, 
“Creating an Accessory,” on page 123.)


4.2.6 Viewing Your Profile Information


1 In the home page of your personal workspace, click the Profile link next to your name and avatar.
or
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Click your Presence icon , located next to any entry that you have created.
Your personal profile information is displayed.


For information on modifying your profile information, see Section 1.4.1, “Modifying Your Profile,” 
on page 18.


4.3 Managing a Team Workspace
Team workspaces are the key to helping you and your team accomplish tasks and meet objectives, 
together.


As the owner of a workspace, you are primarily responsible for workspace administration. You can 
create other containers for information (sub-workspaces and folders), adjust access controls to 
determine who can do what in the workspace, and provide some initial content to assist team 
members to get started.


 Section 4.3.1, “Creating a Team Workspace,” on page 59
 Section 4.3.2, “Adding Additional Team Members to Your Workspace,” on page 60
 Section 4.3.3, “Sending E-Mail to Team Members and Announcing the Workspace after Its 


Creation,” on page 61
 Section 4.3.4, “Viewing Team Members,” on page 61
 Section 4.3.5, “Allowing Visitors to Your Team Workspace,” on page 62


4.3.1 Creating a Team Workspace


By default, everyone in Novell Vibe has rights to create a team workspace.


Team workspaces are the most common type of workspaces. They facilitate team objectives by 
enabling team members to quickly share files, share ideas, and work together more efficiently and 
effectively.


Vibe enables you to create a highly visible team workspace in the Team Workspaces directory, or you 
can create a nested team workspace, which is a team workspace inside of an existing team 
workspace.


 “Creating a Highly Visible Team Workspace” on page 59
 “Creating a Team Workspace inside of an Existing Team Workspace” on page 60


Creating a Highly Visible Team Workspace


If you want your team workspace to be highly visible and easy to find in the workspace tree, create 
the team workspace in the Team Workspaces directory, as described in Section 1.5, “Creating a Team 
Workspace,” on page 20.
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Creating a Team Workspace inside of an Existing Team Workspace


Vibe enables you to create nested workspaces, which are workspaces inside of other workspaces. You 
can create a team workspace inside of any existing workspace where you have appropriate rights. 


You might want to do this if you are not concerned about having high visibility in the workspace tree, 
and if the team workspace that you want to create consists mostly of members who already belong to 
a certain workspace.


1 Navigate to the workspace where you want to create the new team workspace.
2 Click Workspace > New Workspace.


The New Workspace page is launched.
3 In the Workspace section, select Team Workspace.


You can also create a basic workspace, a project management workspace, and a discussions 
workspace.


4 Specify the following information:
Workspace Title: Specify a title for the workspace.
Workspace: Select Team Workspace.
Team Members: Specify the team members.
You can specify individual users, entire groups, or add names that are on your clipboard. For 
more information about using the Vibe clipboard, see Section 9.5, “Using the Vibe Clipboard,” 
on page 136. 
You can also click Team Members. This displays a list of all of the members of the team workspace 
where you are creating your new team workspace. Select the names of the users that you want to 
include in your new team workspace.
Workspace Folders: Select the folders that you want the workspace to contain.
If you later decide that you want to add additional folders, you can add them at any time.
For information on how to add folders to an existing workspace, see Section 4.1.8, “Adding 
Additional Folders to a Workspace,” on page 54.
Announcement: (Optional) Select the check box, then type a message in the Announcement Text 
field. 
This message informs team members about the existence of the workspace, and can also explain 
the value of the workspace.


5 Click OK to create the new workspace.


4.3.2 Adding Additional Team Members to Your Workspace


After you create your workspace, you can add other Vibe users who need to join your team.


1 Navigate to the team workspace where you want to add the additional team members.
2 Click Workspace > Edit Team in the Action toolbar.


The Add or Delete Team Members page is launched.
3 (Conditional) If this workspace is currently inheriting its team membership from a parent folder, 


click Yes.
4 In the Users field, specify the names of the individual users that you want to add to the team.
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You can also specify entire groups in the Groups field, or you can add names that are on your 
clipboard by clicking Clipboard User Names. For more information about using the Vibe 
clipboard, see Section 9.5, “Using the Vibe Clipboard,” on page 136.


5 Click OK.


You can announce the workspace to the new team members. For information on how to do this, see 
Section 4.3.3, “Sending E-Mail to Team Members and Announcing the Workspace after Its Creation,” 
on page 61.


4.3.3 Sending E-Mail to Team Members and Announcing the Workspace after 
Its Creation


Vibe enables you to send e-mail messages to your entire team. Also, if new team members join the 
team after the team workspace has already been created, you can use this functionality to announce 
the workspace to the new team members.


To send mail to team members:


1 Navigate to the team workspace.
2 Click Workspace > E-Mail Team in the Action toolbar.


The Send E-Mail page is displayed.
3 Fill in the appropriate fields.


For information on filling in the rest of the Send E-Mail form, see Section 9.4, “Filling Out the 
Send E-Mail Page,” on page 135.


4 Click OK.


4.3.4 Viewing Team Members


 “Viewing Team Members from Any Page within The Workspace” on page 61
 “Viewing Team Members in an Accessory from the Workspace Home Page” on page 61


Viewing Team Members from Any Page within The Workspace


You can view the members of the team from any folder within the workspace:


1 On any page within the workspace, click Workspace > View Team in the Action toolbar.


Viewing Team Members in an Accessory from the Workspace Home Page


Accessories are sections at the top of workspaces and folders that provide summary information for 
you. For more information on working with accessories, see Chapter 8, “Managing Accessories,” on 
page 123.


By default, Vibe includes a team-membership accessory on the home page of your workspace. This 
accessory displays all team members.
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4.3.5 Allowing Visitors to Your Team Workspace


By default, only team members can view and participate in the workspaces and folders contained in 
the team workspace. There might be times when you want to allow other people to visit your team 
workspace (which, by default, means that they can read entries and comment on them, but they 
cannot create entries).


For information on how to allow visitors to your team workspace, see “Allowing Visitors to Your 
Team Workspace” in the Novell Vibe 3.2 Advanced User Guide.


4.4 Managing a Discussions Workspace
Create a Discussions workspace if you want a place to store multiple discussion forums. This can 
help organize your Novell Vibe site, so users know where they should go if they are looking for a 
particular discussion forum.


For more information on Discussions workspaces, see “Creating and Managing a Discussions 
Workspace” in the Novell Vibe 3.2 Advanced User Guide.


4.5 Managing a Project Management Workspace
Project Management workspaces are optimized for managing a project.


Project Management workspaces include special accessories that help a leader to track the progress of 
task completion for a potentially large project. Although Project Management workspaces can 
contain any type of folder, they are specifically designed to work in conjunction with Tasks and 
Milestones folders.


For more information on Project Management workspaces, see “Creating and Managing a Project 
Management Workspace” in the Novell Vibe 3.2 Advanced User Guide.


4.6 Managing a Landing Page
Novell Vibe enables you to configure a workspace to have a landing page. When you create a 
workspace landing page, you can populate it with entries that exist within the workspace. 


For information on how to create a landing page on a workspace, see “Creating and Managing 
Landing Pages” in the Novell Vibe 3.2 Advanced User Guide.


4.7 Understanding Global Workspaces
Global workspaces contain information that might be of interest throughout your organization.


For more information on global workspaces, see “Creating Global Workspaces” in the  Novell Vibe 3.2 
Administration Guide.
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5 5Managing and Using Folders


The topics in this section describe how to perform management functions for all types of folders in 
Novell Vibe. 


Most functions are the same, regardless of the type of folder that you are managing. However, some 
management functions are unique to individual folder types. These functions are described in 
Chapter 6, “Working with Specific Folder Types,” on page 75.


 Section 5.1, “Creating a New Folder,” on page 63
 Section 5.2, “Modifying a Folder,” on page 64
 Section 5.3, “Deleting a Folder,” on page 64
 Section 5.4, “Undeleting a Folder,” on page 64
 Section 5.5, “Copying a Folder,” on page 65
 Section 5.6, “Moving a Folder,” on page 65
 Section 5.7, “Importing Files into a Folder,” on page 66
 Section 5.8, “Generating an Activity Report on a Folder,” on page 67
 Section 5.9, “Subscribing to E-Mail Notifications from a Folder,” on page 68
 Section 5.10, “Setting Up a Folder to Receive Entries Via E-Mail,” on page 68
 Section 5.11, “Adding Entries to a Folder Via E-Mail,” on page 69
 Section 5.12, “Configuring Folder Columns,” on page 69
 Section 5.13, “Changing the Folder View,” on page 71
 Section 5.14, “Configuring the Number of Entries to Display on a Folder Page,” on page 71
 Section 5.15, “Branding a Folder,” on page 72
 Section 5.16, “Setting a Data Quota for a Folder,” on page 72
 Section 5.17, “Displaying YouTube Videos in a Folder,” on page 72
 Section 5.18, “Using Filters on Folders,” on page 72
 Section 5.19, “Listing Folder Entries and Pages,” on page 74


5.1 Creating a New Folder
Novell Vibe enables you to create folders and sub-folders in any workspace or folder where you have 
appropriate rights.


1 Navigate to the workspace or folder where you want to create the new folder.
2 Click Workspace > New Folder.


or
Click Folder > New Folder to create a subfolder.
The New Folder page is displayed.
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3 Specify the following information:
Folder Title: Specify a title for the folder.
If you do not provide a title, the folder is given the default folder name. For example, a 
Discussion folder is named Discussion.
Folder: Select the type of folder that you want to create.
For information about each type of folder, see Chapter 6, “Working with Specific Folder Types,” 
on page 75.


4 Click OK.


5.2 Modifying a Folder
You can modify the folder title and description, and change the icon that represents the folder, after 
the folder has been created.


1 Navigate to the folder that you want to modify.
2 Click Folder > Edit Folder.
3 Modify the folder as desired, then click OK.


5.3 Deleting a Folder
1 Navigate to the folder that you want to delete.
2 Click Folder > Delete Folder.


The Delete Folder page is displayed.
3 (Optional) Select Purge this folder immediately if you want to purge the folder so that it cannot be 


recovered.


IMPORTANT: Selecting this option renders the folder unrecoverable and it is permanently 
deleted from the Novell Vibe site.


If you do not select this option, you can undelete the folder as described in Section 5.4, 
“Undeleting a Folder,” on page 64.


4 (Conditional) If the folder is a mirrored folder, you can select to delete the source files of the 
folder, and also all of the mirrored folders’ sub-folders.
For more information on working with mirrored folders, see “Working with Mirrored Folders” 
in the Novell Vibe 3.2 Advanced User Guide.


5 Click OK.


5.4 Undeleting a Folder
Novell Vibe enables you to undelete a folder that you previously deleted, restoring it to its previous 
location.


1 Navigate to the folder or workspace where the deleted folder previously resided.
For example, if you want to restore a Blog folder that was in your personal workspace, navigate 
to your personal workspace.
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TIP: If you want to see everything that has been deleted in the Vibe site, navigate to the highest 
level workspace. (By default this is the Home Workspace directory.)


2 Click the Trash icon , located in the Navigation panel.
The Trash page displays all workspaces, folders, and entries that have been deleted in or below 
the current workspace or folder. Items that have been purged are not displayed because they are 
unrecoverable.


3 Select the folder that you want to undelete.
4 Click Restore.


The folder is restored to its previous location. Contents of the folder are not automatically 
restored.


For more information about undeleting, see “Restoring Deleted Items” in the Novell Vibe 3.2 Advanced 
User Guide.


5.5 Copying a Folder
1 Navigate to the folder that you want to copy.
2 Click Folder > Copy Folder.


The Copy Folder page is displayed.
3 Use one of the following methods to copy the folder:


 Select the Destination Folder or Workspace: Use the Workspace tree to navigate to and 
select the folder or workspace where you want to copy the folder.


 Find the Destination Folder or Workspace: In the provided field, specify the name of the 
folder or workspace where you want to copy the folder.


4 Click OK.


NOTE: You cannot copy a Mirrored Files sub-folder into a Files folder. This operation is not 
supported.


5.6 Moving a Folder
Novell Vibe enables you to move a folder into any folder or workspace where you have appropriate 
rights.


1 Navigate to the folder that you want to move.
2 Click Folder > Move Folder.


The Move Folder page is displayed.
3 Use one of the following methods to move the folder:


 Select the Destination Folder or Workspace: Use the Workspace tree to navigate to and 
select the folder or workspace where you want to move the folder.


 Find the Destination Folder or Workspace: In the provided field, specify the name of the 
folder or workspace where you want to move the folder.


4 Click OK.

Managing and Using Folders 65







5.7 Importing Files into a Folder
Novell Vibe enables you to import files from any location and add them to a folder in your 
workspace. There are two ways to do this.


 Section 5.7.1, “Dragging and Dropping Files,” on page 66
 Section 5.7.2, “Importing Files as Entry Attachments,” on page 66
 Section 5.7.3, “Importing Files into the Files Folder,” on page 66


5.7.1 Dragging and Dropping Files


Vibe enables you to drag files from any location, and drop them into any Vibe folder.


If you are adding files to a Vibe Files folder, the behavior can be different. For more information 
about adding files to a Files folder, see Section 6.5.1, “Adding Files to a Files Folder and Other 
WebDAV-Enabled Folders,” on page 81.


1 Navigate to the folder where you want to add the files.
2 Click Add Files in the Folder Entry toolbar.


The drag-and-drop window opens.
3 Drag a file from one location, such as your desktop, and drop it onto the folder icon in the drag-


and-drop window.
A new entry is created with the file as an entry attachment. The name of the document is 
automatically the name of the entry.


5.7.2 Importing Files as Entry Attachments


If you want to attach files to a folder entry, you can attach the file when you are creating the entry, as 
described in Section 7.1, “Creating a Folder Entry,” on page 101, or you can modify an existing entry 
to attach the file, as described in Section 7.13.2, “Attaching Files to a Folder Entry,” on page 111.


5.7.3 Importing Files into the Files Folder


Because Files folders require each file to have a unique name, Files folders behave differently from 
other types of Vibe folders. For specific information about importing files into a Vibe Files folder, see 
Section 6.5.1, “Adding Files to a Files Folder and Other WebDAV-Enabled Folders,” on page 81.


You can import single files into a Files folder by browsing your computer’s file system and creating a 
new file entry, if the file that you want to import has a unique name from all other files in the Files 
folder.


1 Navigate to the Files folder where you want to import the file.
2 Click New File Entry in the Folder Entry toolbar.
3 Click Choose File, then browse to and select the file that you want to import.
4 Add a description of the file in the Description field, then click OK.
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5.8 Generating an Activity Report on a Folder
You can generate a report that tells you the user activity in the folder, or you can generate a report 
that tells you how many entries in the folder have individual access control settings.


You must have appropriate rights to generate these reports. If you do not have appropriate rights, 
these options are not available to you.


 Section 5.8.1, “Generating a User Activity Report,” on page 67
 Section 5.8.2, “Generating an Entry Access Activity Report,” on page 68


5.8.1 Generating a User Activity Report


1 Navigate to the folder about which you want to generate the activity report.
2 Click View > Activity Reports in the Action toolbar.


The Activity Reports page is displayed.
3 Click User Activity Report.


The Folder Activity page is displayed.
4 Select the date range for which you want to generate the activity report.
5 Choose between the following options:


Report Workspace or Folder Activity: Select this option to see how many views, adds, modifies, 
and deletes have been made in the folder. You can generate a report for the following categories 
of users:
 Team Members: View the folder activity of individual team members only.
 All Users: View the folder activity of all Novell Vibe users. This option shows the name of 


each user who has had some type of activity in the folder.
 Summary: View a summary of all the activity that has occurred in the folder. This option 


does not list individual users.
Report on Workflow State: Select this option if you want to view a report on workflows in the 
folder. You can select to show the average time entries spent in each workflow state, or the 
number of entries that are currently in each state.


6 In the Select the Folders for Reporting section, navigate to and select the folders for which you want 
to generate the report. You can select multiple folders.


7 Click OK.
Vibe launches the report in a spreadsheet. For information regarding the columns in this 
spreadsheet, see Section 7.15.1, “Generating Activity Reports,” on page 119.


You can run activity reports on individual entries. For information on how to do this, see Section 7.15, 
“Generating Reports about a Folder Entry,” on page 119.
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5.8.2 Generating an Entry Access Activity Report


Because users can set access controls on individual entries, as discussed in “Controlling Access to 
Entries” in the Novell Vibe 3.2 Advanced User Guide, folder owners can generate reports that specify 
how many entries in the folder have individual access control settings that differ from the folder 
access controls. Also, folder owners can see how many entries are hidden from them.


1 Navigate to the folder about which you want to generate the activity report.
2 Click View > Activity Reports in the Action toolbar.


The Activity Reports page is displayed.
3 Click Entry Access Report.


The Entry Access Report page is displayed. It contains the following information:
 Entries in the folder: Displays how many entries exist in the folder.
 Entries with an entry-level access control setting: Displays how many entries contain 


unique entry-level access controls that differ from the access controls that exist on the 
folder.


 Hidden entries: Displays how many hidden entries exist in the folder. Hidden entries are 
entries that the folder owner does not have rights to view, because the entry creator has 
restricted rights by setting an entry-level access control, as described in “Controlling Access 
to Entries” in the Novell Vibe 3.2 Advanced User Guide.
As a folder owner, if you discover that there are hidden entries within a folder, you can 
request the Vibe administrator to inspect the entries to ensure there is no inappropriate or 
invalid content.


 Creation Date: Displays the date that the hidden entry was created.
 Author: Displays the name of the user who authored the hidden entry.


4 Click Close to exit the activity report.


5.9 Subscribing to E-Mail Notifications from a Folder
You can configure a folder to send you e-mail notifications to inform you about activity that takes 
place in the folder.


For information on how to subscribe to receive e-mail notifications from a folder, see Section 2.11, 
“Subscribing to a Folder or Entry,” on page 42.


5.10 Setting Up a Folder to Receive Entries Via E-Mail
Before you can add e-mail and text message entries to a folder, as described in Section 5.11, “Adding 
Entries to a Folder Via E-Mail,” on page 69, you first need to set up the folder to allow such entries.


For information on how to do this, see “Enabling Folders to Receive Entries through E-Mail” in the 
Novell Vibe 3.2 Advanced User Guide.
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5.11 Adding Entries to a Folder Via E-Mail
Novell Vibe enables you to e-mail entries into folders. This is useful if you don’t have access to the 
Vibe site and you still want to create an entry. You can also text-message entries into folders, so when 
you don’t have access to a computer or the Internet, you can still capture thoughts and contribute to 
conversations.


NOTE: When you e-mail an appointment that contains HTML to a Vibe calendar, the HTML is 
stripped out of the appointment, and Vibe displays the appointment in plain text.


To e-mail entries into folders, you must have sufficient rights to create entries in the folder, as 
described in Section 7.1, “Creating a Folder Entry,” on page 101.


You must also know the previously defined e-mail address for the folder.


To see the e-mail address of a folder:


1 Navigate to the folder where you want to add entries via e-mail.
2 Click the Footer toolbar, located at the bottom of the folder page.


In the E-Mail Addresses section of the provided table, the e-mail address of the folder is 
displayed.
This is the e-mail address that you use to make entries to the folder via e-mail.


If you are the folder owner and want to define an e-mail address for the folder, see “Enabling Folders 
to Receive Entries through E-Mail” in the Novell Vibe 3.2 Advanced User Guide for instructions on how 
to do this.


5.12 Configuring Folder Columns
Vibe enables you to configure table columns in folders where these columns appear. Folders that 
display columns by default are Files folders, Mirrored Files folders, and Discussions folders. 


You can configure any type of folder to display folder columns by changing the folder view to be a 
Files, Mirrored Files, or Discussions folder view, as described in Section 5.13, “Changing the Folder 
View,” on page 71. 


 Section 5.12.1, “Showing and Hiding Columns,” on page 69
 Section 5.12.2, “Renaming Columns,” on page 70
 Section 5.12.3, “Reordering Columns,” on page 70
 Section 5.12.4, “Adjusting the Column Width,” on page 71
 Section 5.12.5, “Restoring Column Defaults,” on page 71


5.12.1 Showing and Hiding Columns


By default, the columns that are available are:


 Title: Displays the title of the entry.
 Comments: Displays how many comments have been made on the entry.
 Size: Displays the file size of the entry.
 Download: Enables you to download the file to your local workstation.
 VIEW: Enables you to view the file in the HTML format.

Managing and Using Folders 69







 State: Shows the workflow state of the file.
 Author: Displays the author of the entry.
 Date: Displays when the entry was last modified or commented on.


You can add the following columns:


 Number (No.): Displays the number of the entry (“1” indicates that the entry was created first)
 Rating: Displays the rating that users have given the entry.


To show or hide table columns in the Files folder:


1 Navigate to the folder where you want to show or hide the table columns.
2 Click Folder > Folder Options in the Action toolbar.


The Folder Options dialog box is displayed.
3 In the Configure Options section, select Configure Columns, then click OK.
4 Select the columns that you want to show, and deselect the columns that you want to hide.
5 (Optional) Select Set the default folder columns for everyone if you want all users to see only the 


columns that you have selected.
6 Click OK.


5.12.2 Renaming Columns


1 Navigate to the folder where you want to rename the table columns.
2 Click Folder > Folder Options in the Action toolbar.


The Folder Options dialog box is displayed.
3 In the Configure Options section, select Configure Columns, then click OK.
4 In the Custom Label field next to the column that you want to rename, specify the new column 


name in the available field.
5 (Optional) Select Set the default folder columns for everyone if you want all users to see only the 


columns that you have selected.
6 Click OK.


5.12.3 Reordering Columns


1 Navigate to the folder where you want to reorder the table columns.
2 Click Folder > Folder Options in the Action toolbar.


The Folder Options dialog box is displayed.
3 In the Configure Options section, select Configure Columns, then click OK.
4 Click the Up Arrow and Down Arrow icons in the Order column to move the column up or 


down.
5 (Optional) Select Set the default folder columns for everyone if you want all users to see only the 


columns that you have selected.
6 Click OK.
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5.12.4 Adjusting the Column Width


Vibe enables you to adjust the column width of the table.


1 Click and drag the arrow icons, located at the top of each column.
2 When the column is the desired width, release the mouse.


5.12.5 Restoring Column Defaults


You can restore the column defaults if you have made changes to the columns that you no longer 
want to retain.


1 Navigate to the folder where you want to restore the defaults for columns.
2 Click Folder > Folder Options in the Action toolbar.


The Folder Options dialog box is displayed.
3 In the Configure Options section, select Configure Columns, then click OK.
4 Click Restore Defaults.


5.13 Changing the Folder View
Novell Vibe enables you to change the view of a folder. For example, if you are viewing your 
Calendar folder in the default Calendar view, you can change the view to the Tasks folder view. You 
can also change the default view of the folder, so no other options are available to those who want to 
view the folder.


Anyone who has access to a folder can change the view of the folder, if the folder owner or someone 
with appropriate rights has configured the folder to allow alternate folder views. 


If you are the owner of a folder and you want to allow alternate views on a folder, or if you want to 
change the default view of a folder, see “Managing Folder Views” in the Novell Vibe 3.2 Advanced User 
Guide.


To change the view of a folder after the folder owner has configured it to support alternate folder 
views:


1 Navigate to the folder where you want to change the view.
2 Click Folder > Folder Options in the Action toolbar.


The Folder Options dialog box is displayed.
3 In the View Options section, select the view that you want the folder to be displayed as, then click 


OK.
The folder view is changed to the view that you specified.


5.14 Configuring the Number of Entries to Display on a Folder 
Page
You can select how many entries per page you want to be displayed in each folder on the Novell Vibe 
site.


1 Click the Settings icon  in the upper right corner of the Vibe interface, then click the Personal 
Preferences icon .
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The Personal Preferences dialog box is displayed.
2 In the Entries per Folder Page field, specify the maximum number of entries that you want to be 


displayed on each page in the Vibe site.
The default is 25.


3 Click OK.


5.15 Branding a Folder
Branding a folder is a good way to make the folder more unique and identifiable. When you brand a 
folder, the brand is applied to all sub-workspaces and sub-folders.


For more information on branding, see “Branding a Folder or Workspace” in the Novell Vibe 3.2 
Advanced User Guide.


5.16 Setting a Data Quota for a Folder
The Vibe administrator can allow you to set your own data quotas for your workspaces and folders. 
For more information, see “Setting a Data Quota for Workspaces and Folders” in the Novell Vibe 3.2 
Advanced User Guide.


5.17 Displaying YouTube Videos in a Folder
This section describes how to display YouTube videos in the Description section of the folder. For 
information on how to display YouTube videos in the Branding section of a folder, see  “Branding a 
Folder or Workspace” in the Novell Vibe 3.2 Advanced User Guide.


To display a YouTube video in the Description section of a folder:


1 Navigate to the folder where you want to display the YouTube video.
2 Click Folder > Edit Folder in the Action toolbar.


3 In the Description section, click the Expand icon  in the HTML editor, then click the Video icon 
.


4 In the URL of a Video on YouTube field, paste the URL of the YouTube video that you want to post.
5 In the Dimensions fields, do not make any changes if you want to keep the default YouTube 


dimensions.
6 Click Insert, then click OK to display the video in the folder.


For more information about other places where you can display YouTube videos in Novell Vibe, see 
Section 7.16, “Displaying YouTube Videos in a Folder Entry,” on page 120.


5.18 Using Filters on Folders
Many types of folders in Novell Vibe provide a filter that helps you quickly sift through information 
in your folder.


 Section 5.18.1, “Creating a Filter,” on page 73
 Section 5.18.2, “Applying an Existing Filter,” on page 73
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 Section 5.18.3, “Modifying a Filter,” on page 73
 Section 5.18.4, “Deleting a Filter,” on page 73


5.18.1 Creating a Filter


In the Filter section, Vibe enables you to create multiple filters in your folder. You can easily apply 
those filters to help you quickly sift through your entries.


1 Navigate to the folder where you want to create the filter.
2 In the Filter section, click Filters.
3 Click Add a New Filter.


This form is nearly identical to the one used for advanced searches (see Section 2.4.3, “Using 
Advanced Search,” on page 33 for information regarding the various fields in this form).
In addition to the elements explained in Section 2.4.3, “Using Advanced Search,” on page 33, 
you must consider the following elements when creating a filter:
Filter Name: Specify a name for the filter.
Make This Filter Available to Everyone: Select this option if you want the filter to be available 
to all users who visit the folder. If this option is not selected, the filter is available only to the user 
who created it.


4 Click OK.


5.18.2 Applying an Existing Filter


1 Navigate to the folder where you have already created the filter that you want to apply.
2 In the Filter section, click the name of the filter.


The filter is applied to the folder.


After you apply a filter, items that do not match the filter criteria in that folder are not displayed in 
the folder listing. To clear the filter, click None in the Filter section.


5.18.3 Modifying a Filter


1 Navigate to the folder where you want to modify a filter that has already been created.
2 In the Filter section, click Filters.
3 In the Personal Filters section, click the drop-down list and select the filter that you want to 


modify.
4 Click Modify.
5 Make the modifications that you desire, then click OK.


5.18.4 Deleting a Filter


1 Navigate to the folder where you want to delete a filter that has already been created.
2 In the Filter section, click Filters.
3 In the Personal Filters section, click the drop-down list and select the filter that you want to 


delete.
4 Click Delete, then click OK to confirm that you want to delete the filter.
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5.19 Listing Folder Entries and Pages
Many types of folders in Novell Vibe provide an Entry Listing toolbar that enables you to search for 
entries individually, or navigate among pages of listings. Some of these tools are useful only if there is 
more than one page of entries. The available tools are:


Entry: Specify the number (displayed in the # column) of the entry that you want to view, then click 
Go.


Previous/Next Arrows: Enables you to scroll through the pages of the folder.


Page: Type a page number in this text box, then click Go to display the entries on that page of listings.
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6 6Working with Specific Folder Types


Novell Vibe provides various kinds of folders that enable you and your teams to accomplish specific 
tasks.


Many folder management functions are the same for all types of folders. For information on how to 
perform general folder management functions, see Chapter 5, “Managing and Using Folders,” on 
page 63.


This section describes how to perform tasks that are unique to each folder type.


 Section 6.1, “Working with Discussion Folders,” on page 75
 Section 6.2, “Working with Blog Folders,” on page 76
 Section 6.3, “Working with Calendar Folders,” on page 78
 Section 6.4, “Working with Guestbook Folders,” on page 81
 Section 6.5, “Working with Files Folders,” on page 81
 Section 6.6, “Working with Milestones Folders,” on page 82
 Section 6.7, “Working with Micro-Blog Folders,” on page 82
 Section 6.8, “Working with Mirrored Files Folders,” on page 83
 Section 6.9, “Working with Photo Album Folders,” on page 83
 Section 6.10, “Working with Surveys Folders,” on page 85
 Section 6.11, “Working with Tasks Folders,” on page 87
 Section 6.12, “Working with Wiki Folders,” on page 96
 Section 6.13, “Creating Folder Content,” on page 100


6.1 Working with Discussion Folders
Use discussions as a way of obtaining comments and feedback to questions and thoughts that you 
might have. You can start general discussion threads in the Discussion folder in your personal 
workspace. For discussion threads that are more specific to a project or team, start the discussion 
thread in the Discussion folder of the appropriate workspace.


Starting a discussion thread is often more effective than sending individual users an e-mail, because 
other interested parties and knowledge holders can easily join the discussion, without waiting for the 
e-mail to be forwarded partway through the discussion.


By default, the Discussion folder is sorted with the most recent discussions appearing first in the list 
of discussion entries.


 Section 6.1.1, “Sorting Discussion Entries by Column Title,” on page 76
 Section 6.1.2, “Pinning Discussion Entries,” on page 76

Working with Specific Folder Types 75







 Section 6.1.3, “Viewing Discussion Entries,” on page 76
 Section 6.1.4, “Customizing Columns in Discussions Folders,” on page 76


6.1.1 Sorting Discussion Entries by Column Title


You can organize your discussion entries by any of the column titles, which are Entry Number (No.), 
Title, State, Author, Date, or Rating.


To sort discussion entries by column titles:


1 Click the title of the column that represents how you want to sort your discussions.
The Sort icon  is displayed next to the column title that represents how the discussions are 
being sorted.


2 Click the column title again to reverse the sort order for the discussions.


6.1.2 Pinning Discussion Entries


Novell Vibe enables you to pin discussion entries, which makes them easy to view in the future by 
bringing them to the top of the list of discussion entries. This is like placing a bookmark on a 
discussion entry that you want to keep track of.


1 In a Discussion folder, click the gray Pin icon  next to a discussion entry that you are 
interested in.
The Pin icon changes from gray to orange. The next time the page refreshes, the discussion entry 
is brought to the top of the list of discussion entries. It remains at the top of the list until you click 
the Pin icon again, and un-pin the discussion entry.
You can pin multiple discussion entries. Pinned discussion entries are sorted alphabetically by 
title.


6.1.3 Viewing Discussion Entries


1 Click the title of the discussion entry.
The discussion entry is opened either in the Content Area or in a dialog box, as described in 
Section 7.19, “Configuring the Display Style of Entries,” on page 121.


6.1.4 Customizing Columns in Discussions Folders


For information on how to customize the columns that appear in Discussions folders, see 
Section 5.12, “Configuring Folder Columns,” on page 69. 


6.2 Working with Blog Folders
Blogs are a good way to express your thoughts about topics that are important to you. For example, if 
you are working on a project and are responsible for a certain aspect of that project, you can update 
your team on your individual progress by posting a blog in the Blog folder in the team workspace.


 Section 6.2.1, “Using the Blog Toolbar,” on page 77
 Section 6.2.2, “Organizing Your Blog Folder,” on page 77
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6.2.1 Using the Blog Toolbar


Unlike other folder views, the Blog folder provides the Blog toolbar on each entry. The toolbar is 
displayed at the bottom of any blog entry, and enables you to do several actions without opening the 
entry:


 Add Comment: Enables you to quickly add a comment to an entry.
 View Comments: Opens a list containing all of the comments that have been made on the entry.
 Send to Friend: Enables you to e-mail the blog entry to anybody who might be interested in 


viewing it.
 Subscribe: Enables you to send notifications to yourself when activity takes place in this entry. 


For more information, see Section 2.11, “Subscribing to a Folder or Entry,” on page 42.


6.2.2 Organizing Your Blog Folder


There are various ways that you can organize your Blog folder.


 “Creating a New Blog Page” on page 77
 “Sorting Blog Entries” on page 77
 “Using the Archives Section” on page 77


Creating a New Blog Page


You can organize your Blog folder into separate Blog pages. Blog pages are displayed in the Blog 
sidebar, located in the right section of the Blog folder, above the Archives section. Also, in the 
Navigation panel, you can expand your Blog folder to view your Blog pages.


To create a new Blog page:


1 In a Blog folder, click New Blog Page in the Folder Entry toolbar.
2 In the Title field, specify the name of the new Blog page that you want to create.
3 Click OK.


Sorting Blog Entries


You can sort your blog entries by Entry Number (No.), Title, State, Author, Created/Modified.


1 Click the Sort by drop-down list in the Folder Entry toolbar.
2 Select how you want to sort the entries in your Blog folder.


Using the Archives Section


The Blog sidebar in the Blog folder includes an Archives section that displays each month of the year 
that blogs were created. When you first enter a Blog folder, all of the blog entries are displayed in the 
main viewing area. Selecting an archived month simply filters the entries in the folder to display only 
entries that were created in that month.


You can use the Archives section to quickly navigate to a specific blog entry if you know the month 
when it was created. Or, you can view all of the blog entries that were created in any given month.


1 In the Archives section, click the month the blog was created.
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The most recent month is displayed at the top of the Archives section.
In the main viewing area of the Blog folder, Novell Vibe displays all of the blog entries that were 
created in that month.


2 (Optional) You can further navigate to the blog you are looking for by clicking the name of the 
Blog page where the blog is stored.
The blog is displayed in the Content Area.


6.3 Working with Calendar Folders
Novell Vibe enables you to create a Calendar folder in any workspace that you desire. You can 
maintain a personal calendar in your personal workspace, and then add separate calendars in your 
team workspaces to keep track of events that are specific to that team.


 Section 6.3.1, “Changing the View of Your Calendar Folder,” on page 78
 Section 6.3.2, “Viewing All Calendar Events for Which You Are Scheduled,” on page 79
 Section 6.3.3, “Synchronizing Vibe Calendars of Your Choice,” on page 79
 Section 6.3.4, “Viewing Today’s Calendar Items from All of the Calendars You Are Following,” 


on page 80
 Section 6.3.5, “Synchronizing Your Calendar with a Desktop Application,” on page 80
 Section 6.3.6, “Importing Calendars,” on page 80


6.3.1 Changing the View of Your Calendar Folder


You can customize the Calendar folder view in various ways:


 Click Work day or Full day to specify whether Vibe should display all hours in the day, or only 
regular working hours.


 Use the left-arrow icon  and right-arrow icon  to specify the next or previous folder page. 
For example, if you are currently viewing three days of information, clicking the arrows shows 
you the previous or next three days of information.


 Click the calendar applet  to jump to a specific month and day.


 Click the Today icon  to jump to the current day.
 Click the appropriate icon to specify the amount of time displayed on a single folder page (1 day 


, 3 days , 5 days , 7 days , 14 days , or one month ).


 Click the Calendar Settings icon  to specify the following options:
 The day of the week that the calendar starts. (Saturday, Sunday, or Monday).
 The time your work day starts.


 Click the Show drop-down list to display one of the following views: 
 Assigned Events: Displays all calendar events that are currently assigned to you.


For more information, see Section 6.3.2, “Viewing All Calendar Events for Which You Are 
Scheduled,” on page 79.


 From Folder - Events: (Default) Displays all entries in the calendar on the day when the 
event is scheduled for.
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 From Folder - All by Creation: Displays entries on the day that the entry was created. This 
includes file entries that were added to the Calendar folder using the Add Files option.


 From Folder - All by Activity: Displays entries on the day when the entry was last 
modified. This includes file entries that were added to the Calendar folder using the Add 
Files option.


6.3.2 Viewing All Calendar Events for Which You Are Scheduled


Vibe enables you to display all past and future calendar events for which you are scheduled in one 
convenient location. These are any events for which you are assigned, either individually, or through 
team or group membership.


1 Navigate to the calendar folder in your personal workspace.
2 In the Show drop-down list, select Assigned Events.


All calendar events that are assigned to you in the Vibe system are displayed in the calendar.


6.3.3 Synchronizing Vibe Calendars of Your Choice


Vibe enables you to synchronize the Vibe calendars of your choice, and display them in a single, 
summarized calendar in the Accessory Panel. This eliminates the need to check multiple calendars.


1 Navigate to the workspace or folder where you want to display the calendar.
2 Click the Accessory Panel drop-down list.
3 Click Add an Accessory.
4 In the Accessory Scope section, select where you want the accessory to be displayed.


Personal accessory for this page only: This accessory appears only to you and only on the 
currently displayed workspace or folder page.
Personal accessory for all workspaces and folders: This accessory appears only to you, but it 
appears on all workspace and folder pages that you view.
Community accessory for this page: This accessory appears only on this page, and it appears to 
everyone who views the current page. Only workspace and folder owners are allowed to 
establish community accessories.


5 In the Accessory Type section, select Calendar Summary.
6 Click OK.


The Accessory Setup page is displayed.
7 In the Title field, provide a title for the calendar.
8 In the Display Style section, select whether you want the calendar to have a border.
9 In the Select the Calendar Folder(s) to be Shown section, navigate the workspace tree and select all 


of the calendars that you want to be included in the Calendar Summary accessory. 
Vibe takes the calendar events from all of the Calendar folders that you select here, and displays 
them in a single, convenient calendar in the Accessory Panel.


10 Click Apply > Close.
The Calendar Summary accessory is displayed in the Accessory Panel on the pages where you 
configured it to be shown, as explained in Step 4.
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6.3.4 Viewing Today’s Calendar Items from All of the Calendars You Are 
Following


Vibe enables you to view all of your calendar events for the current day, in one synchronized view. 
This view displays events from the calendars that you are following, and displays only those events 
for which you are scheduled.


1 Navigate to the home page of your personal workspace.
2 Click the Tasks and Calendars tab.


The right section of the page displays today’s schedule with all of the calendar events from all of 
the calendars you are following.


For information on how to follow a calendar in Vibe, see Section 2.5.1, “Following Workspaces and 
Folders,” on page 36.


6.3.5 Synchronizing Your Calendar with a Desktop Application


Vibe provides iCal URLs for Calendar folders, so you can synchronize your Vibe Calendar folder to 
your desktop application. 


For information on using iCal to synchronize your calendar with a desktop application, see 
Section 2.15, “Synchronizing Tasks and Calendars to a Desktop Application,” on page 46.


6.3.6 Importing Calendars


Vibe enables you to import calendars from other software applications. You can import calendars 
from Outlook or from other applications that export to files of .ical, .ics, .ifb, and .icalendar 
formats.


You can import calendars as a single file, or you can import a list of calendars from a URL.


 “Importing Calendars as a Single File” on page 80
 “Importing Calendars from a URL” on page 80


Importing Calendars as a Single File


1 Navigate to the Calendar folder where you want to import the calendar.
2 Click Folder > Folder Options in the Action toolbar.


The Folder Options dialog box is displayed.
3 In the Calendar Import Options section, select From iCalendar File.
4 Click OK.


The Import Calendar from File dialog box is displayed.
5 Click Choose File, then browse to and select the task that you want to import.
6 Click Upload.


Importing Calendars from a URL


1 Navigate to the Calendar folder where you want to import the calendar.
2 Click Folder > Folder Options in the Action toolbar.
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The Folder Options dialog box is displayed.
3 In the Calendar Import Options section, select By URL.
4 Click OK.


The Import Calendar by URL dialog box is displayed.
5 In the provided field, specify the URL where there is a list of calendars that you want to import.
6 Click OK.


6.4 Working with Guestbook Folders
The Guestbook folder in Novell Vibe is a place to store all of your guestbook entries. By default, 
guestbook signatures are displayed in the Accessories tab of a user’s personal workspace. Signing the 
Guestbook is a quick way for your friends and co-workers to communicate with you.


To sign another user’s Guestbook:


1 Navigate to the user’s Guestbook folder.
2 In the upper right corner of the folder, click Sign the guestbook.
3 In the Title section, provide a title for the signature.
4 In the Description section, compose your message.
5 (Optional) In the Attachments section, add any attachments.
6 Click OK.


6.5 Working with Files Folders
Files folders in Novell Vibe make it easy to store and keep track of your files. You can store personal 
files in the Files folder in your personal workspace, and team-related files in your team folders. This 
makes it easy to share files with your teammates and others who might be interested in viewing 
them.


 Section 6.5.1, “Adding Files to a Files Folder and Other WebDAV-Enabled Folders,” on page 81
 Section 6.5.2, “Customizing Columns in Files Folders,” on page 82


6.5.1 Adding Files to a Files Folder and Other WebDAV-Enabled Folders


Files folders behave differently from other types of Vibe folders. With most types of Vibe folders, 
Vibe allows you to add multiple files with the same name to a single folder, if each file is added as a 
separate entry. Files folders, however, require each file to have a unique name. Folders that have been 
configured to support WebDAV also require each file to have a unique name.


For information about how to configure a folder to support WebDAV, see “Configuring a Folder to 
Support WebDAV” in the Novell Vibe 3.2 Advanced User Guide.


When you add a file to a Files folder or a WebDAV-enabled folder, and the file has the same name as 
a file that has already been added to the folder, you see the following behavior, depending on the 
method you use to add the file:


 “Adding a File as a New File Entry” on page 82
 “Adding a File by Dragging and Dropping” on page 82
 “Adding a File through WebDAV” on page 82
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Adding a File as a New File Entry


When you add a file as a new file entry in your Files folder, and a file with the same name already 
exists in the folder, a status message informs you that a file with the same name already exists, and 
you are not allowed to upload the file.


For information about how to add a new file entry to your Files folder when the file entry has a 
unique name, see Section 5.7.3, “Importing Files into the Files Folder,” on page 66.


Adding a File by Dragging and Dropping


When you add a file by dragging and dropping a file into a Files folder, and a file with the same name 
already exists in the folder, the newly uploaded file replaces the existing file, and the existing file is 
stored as a previous version.


For information about how to drag and drop a file into a Vibe folder, see Section 5.7.1, “Dragging and 
Dropping Files,” on page 66.


For more information about file versioning, see Section 7.13.8, “Using Version Control with Files,” on 
page 115.


Adding a File through WebDAV


When you add a file to a WebDAV-enabled folder, and a file with the same name already exists in the 
folder, the newly uploaded file replaces the existing file, and the existing file is stored as a previous 
version.


For more information about file versioning, see Section 7.13.8, “Using Version Control with Files,” on 
page 115.


6.5.2 Customizing Columns in Files Folders


For information on how to customize the columns that appear in Files folders, see Section 5.12, 
“Configuring Folder Columns,” on page 69. 


6.6 Working with Milestones Folders
Milestones folders track the progress of several Tasks folders. Milestones folders are most often used 
in those workspaces, although they can also be used in other workspaces. For more information, see 
Section 4.5, “Managing a Project Management Workspace,” on page 62.


6.7 Working with Micro-Blog Folders
The Micro-Blog folder in Novell Vibe is a place to store all of your micro-blog entries. Use micro-blog 
entries to display your status to your co-workers. You can navigate to someone else’s Micro-Blog 
folder to see what they have been working on, and possibly provide help by sharing your knowledge 
and experience.


For more information on the Micro-Blog feature, see Section 2.10, “Using Micro-Blogs,” on page 40.
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6.8 Working with Mirrored Files Folders
Mirrored Files folders use a file system on an external server, instead of the Novell Vibe file system 
where other Vibe information is stored. Mirrored Files folders can use any WebDAV or local file path.


For more information about Mirrored Files folders, see “Working with Mirrored Folders” in the  
Novell Vibe 3.2 Administration Guide.


For information on how to customize the columns that appear in Files folders, see Section 5.12, 
“Configuring Folder Columns,” on page 69. 


6.9 Working with Photo Album Folders
Photo albums store and display pictures. You can store your personal photos in the Photo Album 
folder in your personal workspace, and team-related photos in the Photo Album folder of the team 
workspace.


 Section 6.9.1, “Organizing Your Photo Album,” on page 83
 Section 6.9.2, “Synchronizing Photo Albums,” on page 84
 Section 6.9.3, “Viewing and Managing Photo Entries,” on page 85


6.9.1 Organizing Your Photo Album


 “Creating New Photo Albums within the Folder” on page 83
 “Sorting Photo Entries” on page 83
 “Using the Archives Section” on page 84


Creating New Photo Albums within the Folder


You can organize your Photo Album folder into separate photo albums. Photo albums are displayed 
in the Photo Album sidebar, located in the right section of the Photo Album folder. Also, in the 
Navigation panel, you can expand your Photo Album folder to view all of your photo albums in the 
folder.


To create a new photo album in your Photo Album folder:


1 Click New Photo Album in the Folder Entry toolbar.
The New Photo Album page is displayed.


2 In the Folder Title field, specify the name of the new photo album that you want to create.
3 Click OK.


Sorting Photo Entries


You can organize your photo album entries by Creation Date, Title, or Created/Modified.


1 Click the Sort by drop-down list in the Folder Entry toolbar.
2 Select how you want to sort the entries in your Photo Album folder.
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Using the Archives Section


The Photo Album sidebar in the Photo Album folder includes an Archives section that displays each 
month of the year that photos were created. When you first enter a Photo Album folder, all of the 
photo album entries are displayed in the main viewing area. Selecting an archived month simply 
filters the entries in the folder to display only entries that were created in that month.


You can use the Archives section to quickly navigate to a specific photo entry if you know the month 
when it was created. Or, you can view all of the photo entries that were created in any given month.


1 In the Archives section, click the month when the photo was created.
The most recent month is displayed at the top of the Archives section.
In the Content Area of the Photo Album folder, Novell Vibe displays all of the photo entries that 
were created in that month.


2 (Optional) You can further navigate to the photo entry you are looking for by clicking the name 
of the Photo Album where the photo entry is stored.
The photo entry is displayed in the main viewing area.


6.9.2 Synchronizing Photo Albums


Vibe enables you to synchronize the Vibe photo albums of your choice, and display them in a single, 
summarized photo album (called a Photo Gallery) in the Accessory Panel.


1 Navigate to the workspace or folder where you want to display the Photo Gallery.
2 Click the Accessory Panel drop-down list.
3 Click Add an Accessory.
4 In the Accessory Scope section, select where you want the accessory to be displayed.


Personal accessory for this page only: This accessory appears only to you and only on the 
currently displayed workspace or folder page.
Personal accessory for all workspaces and folders: This accessory appears only to you, but it 
appears on all workspace and folder pages that you view.
Community accessory for this page: This accessory appears only on this page, and it appears to 
everyone who views the current page. Only workspace and folder owners are allowed to 
establish community accessories.


5 In the Accessory Type section, select Photo Gallery.
6 Click OK.


The Accessory Setup page is displayed.
7 In the Title field, provide a title for the photo gallery.
8 In the Display Style section, select whether you want the photo gallery to have a border.
9 In the Number of Photos to Show field, specify how many results you want to display at any one 


time in the photo list.
10 Select whether you want photos to be shown big or small.
11 In the Select the Photo Album(s) to be Shown section, navigate the workspace tree and select all of 


the photo albums that you want to be included in the Photo Gallery accessory. 
Vibe takes the photos from all of the Photo Album folders that you select here, and displays 
them in a single, convenient Photo Gallery in the Accessory Panel.
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12 Click Apply > Close.
The Photo Gallery accessory is displayed in the Accessory Panel on the pages where you 
configured it to be displayed, as explained in Step 4.


6.9.3 Viewing and Managing Photo Entries


 “Viewing Photos” on page 85
 “Managing Photo Entries” on page 85


Viewing Photos


To view a photo in a full-sized view in a separate window, click the thumbnail picture.


To scroll through an album that contains multiple photos, simply click the navigation arrows.


Managing Photo Entries


To manage a photo entry, including deleting, modifying, commenting, etc., click the linked title of the 
photo entry.


6.10 Working with Surveys Folders
Surveys folders store surveys that you or other Novell Vibe users have created. Surveys enable you to 
poll team members, or any other Vibe users, about issues that are important to you, your team, or 
your entire organization.


 Section 6.10.1, “Participating in a Survey,” on page 85
 Section 6.10.2, “Creating a Survey,” on page 85
 Section 6.10.3, “Modifying a Survey,” on page 86
 Section 6.10.4, “Checking the Results of a Survey,” on page 87


6.10.1 Participating in a Survey


1 Navigate to the Surveys folder that contains the survey that you want to participate in.
2 Click the entry title of the survey.
3 Provide answers to the survey questions, then click Vote.


6.10.2 Creating a Survey


When you create a survey, you become its moderator. Depending on the access control settings that 
you set for the survey, the moderator can have more rights than regular users.


1 Navigate to the Surveys folder where you want to create the survey.
2 Click New Survey in the Folder Entry toolbar.


The Survey page is launched. 
3 Fill in the Title, Description, and Attachments sections as described in Section 7.1.1, “Filling In the 


Entry Form,” on page 102.
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4 In the Due Date section, specify the date when you want to stop all voting on the survey. After 
the date that you specify, users cannot cast a vote.


5 Select one of the following options for the first question of your survey:
 Multiple Choice: Multiple Answers: Adds a multiple-choice question, and enables users 


to select more than one answer.
 Multiple Choice: Single Answer: Adds a multiple-choice question, and restricts users to 


only one answer.
 Written Reply: Adds a written reply question, and provides users with a field where they 


can specify their written response.
6 (Optional) Select Answer to this question is required, if you want to require users to answer the 


question.
7 (Optional) Click Add More Answers, if you want to add more answer possibilities for a multiple-


choice question. (This option does not exist for Written Reply questions.)


8 (Optional) Click the Move Up icon  or Move Down  icon to change the order of questions in 
the survey.
The numbers of the questions are modified to reflect the new order. When you click OK to create 
the survey (or to update the survey if you are modifying a survey), the questions appear in the 
order that you choose.


9 Repeat Step 5 through Step 7 to add additional questions to your survey.
10 Specify the following access control settings:


Who Can See Vote Results Before Due Time: When users have access to view the vote results 
before the survey is due, they can see how other participants have voted so far. You can enable 
all users to have this ability, the moderator and those users who have already voted, or only the 
moderator.
Who Can See Vote Results After Due Time: When users have access to view the vote results 
after the survey is due, they can see how other participants have voted, but only after they have 
cast a vote and the voting is closed. You can enable all users to have this ability, the moderator 
and those users who have voted, or only the moderator.
Who Can See Who Has Voted and How: When users have access to see who has voted and 
how, they can see how other individual users have voted. Using this option is not recommended 
if your users want their votes to remain confidential. You can enable all users to have this ability, 
the moderator and those users who have voted, or only the moderator.
Allow Votes to be changed or removed before due date: Select this option if you want to grant 
users the ability to change or remove their votes before the survey is due. Users who are logged 
in as Guest cannot have this ability.


11 Click OK.


6.10.3 Modifying a Survey


You can modify a survey just as you can any other type of entry in Vibe. You can reword questions, 
add answers, change the order of questions, and so forth.


1 Open the survey that you want to modify, then click Modify.
2 You can modify the options that are described in Section 6.10.2, “Creating a Survey,” on page 85.
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6.10.4 Checking the Results of a Survey


After you have voted, you can check the results by viewing the entry again.


1 Navigate to and open the survey where you want to check the voting results.
2 Click View Voting Details, located near the bottom of the survey entry.


Vibe displays the percentage of votes cast for each survey question.


6.11 Working with Tasks Folders
Tasks folders keep track of the progress made in completing work assignments. Novell Vibe enables 
you to create Tasks folders in any workspace that you desire. You can maintain a personal Tasks 
folder in your personal workspace, and then add separate Tasks folders in your team workspaces to 
keep track of tasks that are specific to that team.


 Section 6.11.1, “Sorting Tasks in Your Tasks Folder By Task Characteristics,” on page 87
 Section 6.11.2, “Filtering the Task List,” on page 88
 Section 6.11.3, “Modifying Tasks in the Task List,” on page 88
 Section 6.11.4, “Creating Tasks in a Specific Location in the Task List,” on page 88
 Section 6.11.5, “Creating Linked Tasks,” on page 89
 Section 6.11.6, “Changing the Order of Tasks,” on page 90
 Section 6.11.7, “Managing Sub-Tasks,” on page 90
 Section 6.11.8, “Synchronizing the Vibe Tasks Folders of Your Choice,” on page 92
 Section 6.11.9, “Changing the View of Your Tasks Folder,” on page 93
 Section 6.11.10, “Viewing All Tasks That Are Assigned to You,” on page 93
 Section 6.11.11, “Viewing All Tasks That Are Assigned to a Specific Team, Group, or Individual 


User,” on page 94
 Section 6.11.12, “Importing Tasks,” on page 95


6.11.1 Sorting Tasks in Your Tasks Folder By Task Characteristics


Vibe enables you to sort the tasks in your task list by number, task name, priority, due date, status, 
assignee, and percent done. By default, the task list is sorted by the No. column. When you sort the 
task list by a different column, the No. column automatically becomes a secondary sort. For example, 
when you sort the task list by priority, tasks are sorted by priority first and by number second. Within 
each task group that is sorted by priority, tasks are sorted by number.


When you sort the task list as described in this section, tasks are displayed in a flat view (sub-tasks 
are no longer displayed as indented beneath the main task). To display sub-tasks as indented again, 
sort on the No. column in ascending order.


To sort tasks:


1 Navigate to the Tasks folder where you want to sort your tasks.
2 At the top of the task list, click the title of the column heading by which you want to sort the 


tasks.
Tasks in the Tasks folder are sorted according to the column title that you click. The No. column 
automatically becomes a secondary sort.
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6.11.2 Filtering the Task List


You can quickly locate a task by using the filter. This is helpful if the task list contains many task 
entries.


1 In the upper right corner of the task list, click inside the Search Name field, specify the title of a 
task entry that you are searching for, then press Enter.


6.11.3 Modifying Tasks in the Task List


You can modify individual tasks and sub-tasks directly from the task list. You can modify the priority, 
status, due date, and the percent done.


1 Click the down-arrow icon  in the Priority, Status, Due Date, or Closed-% Done columns for the 
task that you want to modify.


2 Click the new priority, status, or percent done in the drop-down list. 
or
If you are modifying the due date, make the modifications in the Due Date dialog box, then click 
OK.
In Vibe 3.1 and later, when you mark a task as Completed (in the Status column) or 100% (in the 
Closed-% Done column), the date and time when the task was marked Completed is displayed in 
the Closed-% Done column. Nothing is displayed in this column if the task was marked 
Completed or 100% in a version prior to 3.1.


You can modify other aspects of a task entry as described in Section 7.4.1, “Modifying All Sections of 
an Entry,” on page 106.


6.11.4 Creating Tasks in a Specific Location in the Task List


When you create new task entries as described in Section 7.1, “Creating a Folder Entry,” on page 101, 
the new task entry appears at the bottom of the task list. You can create a task entry at a specific 
location in the task list.


1 Click the No. column in the task list to ensure that tasks are sorted by number in ascending 
order.
You might need to click the No. column a second time if the column is sorted in descending 
order the first time you click it.
Sorting the task list by the No. column in ascending order displays a drop-down arrow to the 
right of each task in the task list.


2 Click the drop-down arrow next to the task where you want to create a sub-task, then click New 
Task Above or New Task Below, depending on where you want the task to be located in the task 
list.


3 Fill out the entry form, then click OK to finish creating the sub-task.
For more information about filling in the entry form, see Section 7.1.1, “Filling In the Entry 
Form,” on page 102.
The task is created at the appropriate location in the task list.
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6.11.5 Creating Linked Tasks


Before you link tasks with other tasks, ensure that you understand how task linking works in Vibe.


 “Understanding Linked Tasks” on page 89
 “Linking Sub-Tasks with Other Tasks” on page 89


Understanding Linked Tasks


A linked task is a task that is due a designated number of days after either the start date or the due 
date of the task that precedes it. Only sub-tasks can be linked. The first sub-task beneath a main task 
can be linked with the start date of the main task. Subsequent sub-tasks can be linked with the due 
date of the sub-task that precedes them in the task list.


For example, sub-task A begins when the main task begins, and the due date of sub-task A is the start 
date of the main task plus whatever the duration is for sub-task A. The due date of sub-task B is the 
due date of sub-task A plus the duration of sub-task B, and so forth.


To link a sub-task with either the main task or another sub-task, you must set the duration of the sub-
task when you are creating or modifying the sub-task. You do this in the Duration field on the entry 
form. (For more information about setting the task duration, see “Linking Sub-Tasks with Other 
Tasks” on page 89.) 


Linking Sub-Tasks with Other Tasks


To link a sub-task with another task:


1 Create a sub-task.
Ensure that the position of the sub-task in the task list is directly beneath the main task or sub-
task that you want it to be linked with.
For more information about how to create a sub-task and change its position in the task list, see 
“Creating Sub-Tasks” on page 91.


2 Modify the sub-task that you want to link with either the main task or sub-task by clicking the 
title of the sub-task, then clicking Modify.
The entry form is displayed.


3 In the Time Period section of the entry form, ensure that the Start fields and End fields are blank. 
4 In the Duration field, specify the number of days before the sub-task is due.


For sub-tasks that are linked to the main task, this number begins after the start date of the main 
task. For sub-tasks that are linked with other sub-tasks, this number begins after the due date of 
the sub-task that precedes it in the task list.
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6.11.6 Changing the Order of Tasks


Tasks appear in the order that they are created when tasks are sorted by number in ascending order 
in the task list. (For more information on the various ways that you can sort tasks, see Section 6.11.1, 
“Sorting Tasks in Your Tasks Folder By Task Characteristics,” on page 87.) 


You can change the order that tasks appear in the task list. When you change the order of a task, all 
sub-tasks that are associated with the main task are also moved. Sub-tasks cannot be moved outside 
of the main task in the task list unless you first make the sub-task a main task, as described in 
“Making a Sub-Task a Main Task” on page 91.


 “Reordering Tasks One Number at a Time” on page 90
 “Reordering a Single Task Anywhere in the Task List with a Single Click” on page 90


Reordering Tasks One Number at a Time


You can change the order of a single task, or multiple tasks simultaneously.


1 Click the No. column in the task list to ensure that tasks are sorted by number in ascending 
order.
You might need to click the No. column a second time if the column is sorted in descending 
order the first time you click it.
Sorting the task list by the No. column in ascending order activates the arrow icons that are 
located above the task list.


2 Select the task that you want to move up or down in the task list.
You can select multiple tasks for convenience.


3 Click the up-arrow and down-arrow icons  to move the task up and down in the task list.


Reordering a Single Task Anywhere in the Task List with a Single Click


You can quickly move a task to any location within the task list.


1 Click the number of the task in the No. column.
2 Specify the number where you want the task to be moved to in the task list.
3 Press Enter.


6.11.7 Managing Sub-Tasks


Sub-tasks allow you to break down a larger task into smaller components. Multiple users can be 
assigned to multiple sub-tasks in order to accomplish a main task. When all sub-tasks are marked 
Complete, the main task is also marked Complete.


 “Creating Sub-Tasks” on page 91
 “Making a Main Task a Sub-Task” on page 91
 “Making a Sub-Task a Main Task” on page 91
 “Viewing Sub-Tasks” on page 92
 “Deleting Sub-Tasks and Tasks That Contain Sub-Tasks” on page 92
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Creating Sub-Tasks


When you create a sub-task, ensure that you provide a meaningful name. This is necessary because 
sub-tasks are not always displayed in a hierarchical view in the task list. For more information, see 
“Viewing Sub-Tasks” on page 92.


To create a sub-task:


1 Click the No. column in the task list to ensure that tasks are sorted by number in ascending 
order.
You might need to click the No. column a second time if the column is sorted in descending 
order the first time you click it.
Sorting the task list by the No. column in ascending order displays a drop-down arrow to the 
right of each task in the task list.


2 Click the drop-down arrow next to the task where you want to create a sub-task, then click New 
Subtask.


3 Fill out the entry form, then click OK to finish creating the sub-task.
For more information about filling in the entry form, see Section 7.1.1, “Filling In the Entry 
Form,” on page 102.
The sub-task is created beneath the task where you create it.


Making a Main Task a Sub-Task


You can make any main task a sub-task to another task. Furthermore, you can make a task a sub-task 
to a sub-task (that is, sub-tasks can be nested).


1 Click the No. column in the task list to ensure that tasks are sorted by number in ascending 
order.
You might need to click the No. column a second time if the column is sorted in descending 
order the first time you click it.
Sorting the task list by the No. column in ascending order activates the arrow icons that are 
located above the task list.


2 Select the task that you want to make a sub-task.


3 Click the up-arrow or down-arrow icons  to move the task directly beneath the task that 
you want to become the main task.


4 Click the right-arrow icon  to make the task a sub-task to the task directly above it in the task 
list.


Making a Sub-Task a Main Task


To make a sub-task a main task:


1 Click the No. column to ensure that the task list is sorted by number in ascending order.
You might need to click the No. column a second time if the column is sorted in descending 
order the first time you click it.
Sorting the task list by the No. column in ascending order activates the arrows that are located 
above the task list.


2 Select the sub-task that you want to make a main task, then click the left-arrow icon .
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Viewing Sub-Tasks


Sub-tasks display indented beneath the main task only when the task list is sorted by the No. column. 
If you click any other column heading, sub-tasks are displayed in line with main tasks.


To ensure that the task list is sorted by the No. column:


1 Click the No. column.


Deleting Sub-Tasks and Tasks That Contain Sub-Tasks


When you delete sub-tasks and tasks that contain sub-tasks, be aware of the following behaviors:


 Undeleting a sub-task after it has been deleted causes the sub-task to be restored to the task list 
as a main task (it is no longer a sub-task).


For more information about undeleting entries, see Section 7.9, “Undeleting a Folder Entry,” on 
page 108.


 Deleting a main task that contains sub-tasks deletes only the main task. Any sub-tasks 
associated with the main task are retained in the task list and become main tasks (they are no 
longer sub-tasks).


6.11.8 Synchronizing the Vibe Tasks Folders of Your Choice


Vibe enables you to synchronize the Vibe Tasks folders of your choice and display them in a single, 
summarized task list in the Accessory Panel. You can display tasks that are assigned to specific users, 
groups, or teams.


1 Navigate to the page where you want to display the task list.
2 Click the Accessory Panel drop-down list.
3 Click Add an Accessory.
4 In the Accessory Scope section, select where you want the accessory to be displayed.


Personal accessory for this page only: This accessory appears only to you and only on the 
currently displayed workspace or folder page.
Personal accessory for all workspaces and folders: This accessory appears only to you, but it 
appears on all workspace and folder pages that you view.
Community accessory for this page: This accessory appears only on this page, and it appears to 
everyone who views the current page. Only workspace and folder owners are allowed to 
establish community accessories.


5 In the Accessory Type section, select Task Summary.
6 Click OK.


The Accessory Setup page is displayed.
7 In the Title field, provide a title for the task list.
8 In the Display Style section, select whether you want the task list to have a border.
9 In the Number of Results to be Shown field, specify how many results you want to display at any 


one time in the task list.
10 In the Show Only the Tasks Assigned To section, specify the specific users, groups, or teams whose 


tasks you want to display.
11 In the Select the Task Folder(s) to be Shown section, navigate the workspace tree and select all of the 


Tasks folders that you want to be included in the task list. 
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Vibe takes the tasks from all of the Tasks folders that you select here, and displays them in a 
single, convenient task list in the Accessory Panel.


12 Click Apply > Close.
The Task Summary accessory is displayed in the Accessory Panel on the pages where you 
configured it to be shown in Step 4.


6.11.9 Changing the View of Your Tasks Folder


The View setting in the Tasks folder enables you to choose the kinds of tasks that you want to display 
in the task list.


1 Click the View drop-down in the upper right corner of the task list.
2 Click one of the following options for the tasks that you want to display in the task list:


 All Entries: Displays all tasks.
 Completed: Displays tasks that have the status of Closed.
 Today: Displays tasks that have a due date of today.
 Week: Displays tasks that have a due date sometime in the next seven days.
 Month: Displays tasks that have a due date sometime in the next 30 days.
 All Active: Displays tasks that are currently active.


The following options are available only in user workspaces:
 Assigned Tasks: Displays all tasks assigned to the owner of the workspace, regardless of 


where the tasks are located in Vibe.
 From Folder: Displays all tasks that are in the current folder.


For more information, see “Viewing Your Tasks in a Full Interactive View” on page 93.


6.11.10 Viewing All Tasks That Are Assigned to You


Vibe enables you to display all of the tasks that are assigned to you, whether they are assigned 
personally to you, or assigned to a group or team of which you are a member.


 “Viewing Your Tasks in a Full Interactive View” on page 93
 “Viewing Summaries of All Your Assigned Tasks” on page 94
 “Viewing Summaries of Your Assigned Tasks That Are Due within the Next Two Weeks” on 


page 94


Viewing Your Tasks in a Full Interactive View


Vibe enables you to view a full interactive view of all of your assigned tasks.


1 Navigate to a Tasks folder in your personal workspace.
2 Click the View drop-down list in the upper right corner of the task list, then click Assigned Tasks.


Vibe displays all tasks that are currently assigned to you.


For information about how to modify tasks from the task list by using the interactive view, see 
Section 6.11.3, “Modifying Tasks in the Task List,” on page 88.
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Viewing Summaries of All Your Assigned Tasks


1 Navigate to the home page of your personal workspace.
2 Click the Tasks and Calendars tab.


The left section of the page displays all of the tasks that are assigned to you, whether they are 
assigned personally to you, or assigned to a group or team of which you are a member.


3 Select Due Anytime.
Vibe displays a summarized view of all tasks that are assigned to you.


Viewing Summaries of Your Assigned Tasks That Are Due within the Next Two 
Weeks


1 Navigate to the home page of your personal workspace.
2 Click the Tasks and Calendars tab.


The left section of the page displays all of the tasks that are assigned to you, whether they are 
assigned personally to you or assigned to a group or team of which you are a member.


3 Select Due Within 2 Weeks.
Vibe displays a summarized view of all tasks that are due within the next two weeks and are 
assigned to you.


6.11.11 Viewing All Tasks That Are Assigned to a Specific Team, Group, or 
Individual User


Vibe enables you to view all tasks located in the Vibe site that are assigned to a specific team, group, 
or individual user, and display them in a single, summarized task list in the Accessory Panel.


1 Navigate to the page where you want to display the task list.
2 Click the Accessory Panel drop-down list.
3 Click Add an Accessory.
4 In the Accessory Scope section, select where you want the accessory to be displayed.


Personal accessory for this page only: This accessory appears only to you and only on the 
currently displayed workspace or folder page.
Personal accessory for all workspaces and folders: This accessory appears only to you, but it 
appears on all workspace and folder pages that you view.
Community accessory for this page: This accessory appears only on this page, and it appears to 
everyone who views the current page. Only workspace and folder owners are allowed to 
establish community accessories.


5 In the Accessory Type section, select Task Summary.
6 Click OK.


The Accessory Setup page is displayed.
7 In the Title field, provide a title for the task list.
8 In the Display Style section, select whether you want the task list to have a border.
9 In the # of Results to be Shown section, specify how many results you want to display at any one 


time in the task list.

94 Novell Vibe 3.2 User Guide







10 In the Show Only the Tasks Assigned To section, specify the specific users, groups, or teams whose 
tasks you want to display.


11 In the Select the Task Folder(s) to be Shown section, do not select anything. 
Vibe takes the tasks from the entire Vibe site that are associated to the user, group, or team that 
you specified in Step 10, and displays them in a single, convenient task list in the Accessory 
Panel.


12 Click Apply > Close.
The Task Summary accessory is displayed in the Accessory Panel on the pages where you 
configured it to be shown, as explained in Step 4.


6.11.12 Importing Tasks


Vibe enables you to import tasks from other software applications. You can import tasks from 
Outlook or from other applications that export to files of .ical, .ics, .ifb, and .icalendar 
formats.


You can import tasks as a single file, or you can import a list of tasks from a URL.


 “Importing Tasks as a Single File” on page 95
 “Importing Tasks from a URL” on page 95


Importing Tasks as a Single File


1 Navigate to the Tasks folder where you want to import the task.
2 Click Folder > Folder Options in the Action toolbar.


The Folder Options dialog box is displayed.
3 In the Task Import Options section, select From iCalendar File.
4 Click OK.


The Import Tasks from File dialog box is displayed.
5 Click Choose File, then browse to and select the task that you want to import.
6 Click Upload.


Importing Tasks from a URL


1 Navigate to the Tasks folder where you want to import the task.
2 Click Folder > Folder Options in the Action toolbar.


The Folder Options dialog box is displayed.
3 In the Task Import Options section, select By URL.
4 Click OK.


The Import Tasks by URL dialog box is displayed.
5 In the provided field, specify the URL where there is a list of tasks that you want to import.
6 Click OK.
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6.12 Working with Wiki Folders
A wiki is a set of related entries coauthored by folder participants. For example, the best-known wiki 
on the Internet is Wikipedia. Other examples of possible wiki content are glossaries, and policies or 
procedures.


 Section 6.12.1, “Organizing Your Wiki Folder,” on page 96
 Section 6.12.2, “Creating a New Wiki Topic,” on page 97
 Section 6.12.3, “Creating a New Wiki Page,” on page 98
 Section 6.12.4, “Using the Wiki Home Page,” on page 98
 Section 6.12.5, “Sorting Wiki Pages,” on page 99
 Section 6.12.6, “Finding a Wiki Page,” on page 99
 Section 6.12.7, “Formatting Your Wiki Page,” on page 100


6.12.1 Organizing Your Wiki Folder


Wikis in Novell Vibe are organized into Wiki Topics (folders), with each Wiki Topic containing 
individual Wiki pages. 


Depending on the content that you are planning to have in your Wiki, you can organize your Vibe 
Wiki in either of the following ways: 


 Adding Wiki folders to a Vibe workspace


You can organize your Wikis with multiple high-level folders in a single workspace. You might 
want to do this if the information in each Wiki folder is not related.


For information on how to add additional Wiki folders in a workspace, see Section 4.1.8, 
“Adding Additional Folders to a Workspace,” on page 54.


 Adding Wiki Topics (folders) to an existing Wiki folder (Recommended)
You can organize your Wikis with multiple Topics (folders) within a single Wiki folder. 
Organizing your Wikis in this way makes it easy for those who access the Wiki to go from topic 
to topic in a single, convenient interface.


This section describes how to organize Wikis with multiple Wiki Topics within a Wiki folder.


 “Understanding Wiki Folder Organization” on page 96
 “Understanding Wiki Page Organization” on page 97


Understanding Wiki Folder Organization


Like other types of Vibe folders, you can create sub-folders within a main Wiki folder, as described in 
Section 6.12.2, “Creating a New Wiki Topic,” on page 97. However, unlike other types of Vibe folders, 
when you create Wiki Topics inside a Wiki folder, the main Wiki folder and the Wiki Topics inside 
that folder are considered equal, with none considered as higher in the folder hierarchy. The Wiki 
folder and the Wiki Topics within that folder are displayed side-by-side in the Wiki Topics section.
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Understanding Wiki Page Organization


Pages are where information is contained within Wiki Topics. You can add a page to any Wiki Topic, 
as described in Section 6.12.3, “Creating a New Wiki Page,” on page 98.


Wiki pages are contained within Wiki Topics. You can view pages by selecting the Wiki Topic where 
the page is contained, in the Wiki Topics section, then clicking the page.


6.12.2 Creating a New Wiki Topic


You can organize your Wiki pages (Wiki entries) into separate Wiki Topics (Wiki folder and Wiki sub-
folders). Wiki Topics are displayed in the Topics and Pages tab, in the Wiki Topics section. Also, in the 
Navigation panel, you can expand your Wiki folder to view your Wiki Topics.


You can use the Topics and Pages tab to create a new Wiki Topic:


1 In the Wiki folder where you want to create the new Wiki Topic, click the Topics and Pages tab.
2 Click New Wiki Topic.


The New Wiki Topic page is displayed.
3 In the Title field, specify the name of the new Wiki Topic that you want to create.
4 Click OK.
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You can also use the Action toolbar to create a new Wiki Topic:


1 In the Wiki folder where you want to create the new Wiki Topic, click Folder > New Folder in the 
Action toolbar.
The New Folder page is displayed.


2 In the Folder Title field, specify the name of the new Wiki Topic that you want to create.
3 In the Folder section, select Wiki.
4 Click OK.


You delete a Wiki Topic in the same way that you delete any folder in Vibe. For information on how 
to delete a Vibe folder, see Section 5.3, “Deleting a Folder,” on page 64.


6.12.3 Creating a New Wiki Page


Wiki pages (Wiki entries) make up the content that is available in a Wiki Topic. You can make any 
page within a Wiki Topic the home page for the Wiki Topic where the page resides, as described in 
Section 6.12.4, “Using the Wiki Home Page,” on page 98.


To create a new Wiki page:


1 In the Wiki folder where you want to create the new Wiki page, click the Topics and Pages tab.
2 In the Wiki Topics section, select the Wiki Topic where you want to create the new Wiki page.
3 Click New Wiki Page.


The Wiki page is displayed.
4 In the Title field, specify the name of the new Wiki page that you want to create.
5 In the Description section, specify the content for your Wiki page.
6 Click OK.


You delete a Wiki page in the same way that you delete any folder entry in Vibe. For information on 
how to delete a folder entry, see Section 7.8, “Deleting a Folder Entry,” on page 107.


6.12.4 Using the Wiki Home Page


The home page is the first page users see when they access the Wiki Topic. You should define a home 
page for each Wiki Topic.


 “Setting a Wiki Home Page” on page 98
 “Navigating to Your Wiki Home Page” on page 99


Setting a Wiki Home Page


Vibe enables you to set any Wiki page to be the home page for the Wiki Topic where the page resides.


1 Navigate to and open the Wiki page that you want to set as the home page for your Wiki Topic.
2 Click Actions > Set Wiki Home Page, then click OK.


The Wiki page is now set as the home page for the Wiki Topic. When users access the Wiki Topic, 
this is the page they see first.
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Navigating to Your Wiki Home Page


When a home page is defined, it is automatically displayed when you first access the Wiki Topic. If 
you are viewing a Wiki Topic in the Topics and Pages tab, only the title of the home page is displayed 
(in bold), along with all of the other Wiki pages that belong to the Wiki Topic.


1 Navigate to the Wiki Topic where you want to display the home page.
The home page for the Wiki Topic is displayed.


2 (Conditional) If the home page is not already displayed, click the Page tab.


6.12.5 Sorting Wiki Pages


You can organize your Wiki Topics to display pages by Title, Author, Created/Modified, or Rating.


To sort Wiki pages:


1 Click the Topics and Pages tab.
2 Click the Wiki Topic that contains the pages that you want to sort.
3 In the table, click the column heading that represents how you want to sort the pages in your 


Wiki Topic. Click the column heading a second time to reverse the order.
 Title: Lists pages in alphabetical order according to the title.
 Author: Lists pages in alphabetical order according to the author.
 Created/Modified: Lists pages in order according to when the page was created or last 


modified.
 Rating: Lists pages according to each page’s rating.


For more information on rating, see Section 7.18, “Rating a Folder Entry,” on page 121.


6.12.6 Finding a Wiki Page


Wiki pages are contained within Wiki Topics. You can view entries by selecting the Wiki Topic where 
the page is contained, in the Wiki Topics section.
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For Wiki Topics that contain many pages, you can use the Find Page field.


1 Select the Wiki Topic that contains the Wiki page that you are searching for.
2 In the Find Page field in the upper right corner, begin typing the name of the Wiki page that you 


are looking for. Click the name of the Wiki page when it appears in the drop-down list.


6.12.7 Formatting Your Wiki Page


After you create a new Wiki page in your Wiki Topic, you can add section headings and links. (For 
information on creating a page, see Section 6.12.3, “Creating a New Wiki Page,” on page 98.)


 “Creating Sections and Subsections” on page 100
 “Linking to Another Wiki Page” on page 100


Creating Sections and Subsections


You can create section and subsection headings in a Wiki page by typing text enclosed in the equals 
sign.


Linking to Another Wiki Page


If you know the exact title of the Wiki page that you want to link to, you can enter [[title]] in the 
Description section of the page that you are linking from to create a link to another page. For more 
information about linking within Vibe, see Section 7.2, “Linking to a Folder or Folder Entry,” on 
page 104.


6.13 Creating Folder Content
For information on creating and managing content within folders, see Chapter 7, “Working with 
Folder Entries,” on page 101.


Example Description


==Section name== Creates a section heading in the Wiki page.


===Subsection name=== Creates a subsection heading in the Wiki page.
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7 7Working with Folder Entries


Folder entries in Novell Vibe are individual sections or parts that are used to populate folders with 
information.


 Section 7.1, “Creating a Folder Entry,” on page 101
 Section 7.2, “Linking to a Folder or Folder Entry,” on page 104
 Section 7.3, “Commenting on a Folder Entry,” on page 105
 Section 7.4, “Modifying a Folder Entry,” on page 106
 Section 7.5, “Locking a Folder Entry,” on page 106
 Section 7.6, “Moving a Folder Entry,” on page 107
 Section 7.7, “Copying a Folder Entry,” on page 107
 Section 7.8, “Deleting a Folder Entry,” on page 107
 Section 7.9, “Undeleting a Folder Entry,” on page 108
 Section 7.10, “Notifying Others about a Folder Entry,” on page 109
 Section 7.11, “Subscribing to a Folder Entry,” on page 110
 Section 7.12, “Tagging a Folder Entry,” on page 110
 Section 7.13, “Working with Files in a Folder Entry,” on page 111
 Section 7.14, “Viewing the History of an Entry,” on page 118
 Section 7.15, “Generating Reports about a Folder Entry,” on page 119
 Section 7.16, “Displaying YouTube Videos in a Folder Entry,” on page 120
 Section 7.17, “Displaying Images in a Folder Entry,” on page 120
 Section 7.18, “Rating a Folder Entry,” on page 121
 Section 7.19, “Configuring the Display Style of Entries,” on page 121
 Section 7.20, “Printing a Folder Entry,” on page 121
 Section 7.21, “Enabling Alternate Folder Entry Types,” on page 122
 Section 7.22, “Creating Custom Folder Entry Forms,” on page 122
 Section 7.23, “Displaying Folder Entries on a Landing Page,” on page 122


7.1 Creating a Folder Entry
Novell Vibe enables you to create folder entries in any folder where you have appropriate rights. If 
you do not have appropriate rights in a folder, you are not able to create an entry as described in this 
section.


1 Navigate to the folder where you want to create the entry.
2 In the Folder Entry toolbar, click the appropriate item to add the entry. For example, to add a 


blog entry in the Blog folder, click New Blog Entry.
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The Blog Entry page is launched.
3 Specify the appropriate information in the Entry page. For more detailed information on the 


fields, see Section 7.1.1, “Filling In the Entry Form,” on page 102.
4 Click OK.


The entry is added to the folder.


7.1.1 Filling In the Entry Form


Although the process for creating a folder entry is similar for each type of entry (file entry, calendar 
entry, discussion entry, etc.), the Entry form can vary considerably.


Because Vibe is highly customizable, field names in the Entry form can be defined and changed by 
Vibe administrators and other Vibe users who create forms. This section contains a list of named 
fields for the various default entry types. For more information on creating custom forms, see 
“Designing Custom Folder Entry Forms” in the Novell Vibe 3.2 Advanced User Guide.


Title: Provide a title for the entry.


Location: Specify the location for the event.


Description: Provide a description of the entry. This is the body of the entry where you add the main 
content. Descriptions can be simple text, or it can be more complex, with tables, videos, and more. 
For more information on creating an entry description, see Section 7.1.2, “Composing an Entry 
Description,” on page 103.


Event: Specify the start and end time, whether you want the entry to adjust for the time zone of 
attendees, how you want your status to be displayed during this event (Free, Busy, Tentative, or Out of 
Office), and if you want the entry to repeat (Does not repeat, Daily, Weekly, Monthly, or Yearly).


Time Period: Specify the start time, end time, and duration of the task. You can specify only a start 
time, a start time and an end time, a start time and a duration, or only a duration. For more 
information, see Section 6.11.5, “Creating Linked Tasks,” on page 89.


Priority: Specify the priority of the entry.


Attendee: Specify individual attendees whom you want to invite to the calendar event.


Clipboard User Names: Use names that are on your clipboard to invite users to the event. For more 
information about the Vibe clipboard, see Section 9.5, “Using the Vibe Clipboard,” on page 136.


Groups: Specify groups that you want to be associated with the entry. When you specify a group, 
each member of the group is associated with the entry. For example, if you are scheduling a meeting 
and you specify a group to attend the meeting, each member of the group is considered to be an 
attendee.


Teams: Specify teams that you want to be associated with the entry. When you specify a team, each 
member of the team is associated with the entry. For example, if you are assigning a task to a team, 
each member of the team is responsible for completing the task.


Send an E-Mail Notification to Assignees/Attendees: Select this option if you want Vibe to send an 
e-mail notification and iCal task/appointment to all of the users, groups, or teams that you associated 
with the entry.


For more information on iCal functionality in Vibe, see Section 2.15, “Synchronizing Tasks and 
Calendars to a Desktop Application,” on page 46.


Status: Select the current state for the task, such as In Process, Completed, and so forth.
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Completed: Select the percentage of the task that is complete.


Attachments: Enables you to browse your file system and attach a file to the entry. Click Add more files 
to add additional attachments.


Photo: Enables you to browse to and upload a photo.


Due Date: The last day the entry is active.


Survey: Enables you to set parameters for your survey, such as whether to allow multiple answers, 
single answers, or written replies, who can see the vote results before the survey is due, who can see 
vote results after the survey is due, and who can see participant names. It also provides an option to 
allow voters to change or remove their votes.


For more detailed instructions on creating a survey, see “Creating a Survey” on page 85.


Subscribe to This Entry: You can configure Vibe to send you notifications when activity takes place 
in this entry. For more information, see Section 2.11, “Subscribing to a Folder or Entry,” on page 42.


Send E-Mail When Entry is Submitted: To ensure that certain co-workers are aware of your entry, 
you can send them an e-mail directly from Vibe, notifying them that an entry has been created. For 
more information, see Section 9.4, “Filling Out the Send E-Mail Page,” on page 135.


7.1.2 Composing an Entry Description


Entry descriptions can be simple text, or they can be more complex, with tables, videos, and more. 
The following table describes some of the non-obvious options that are available when creating an 
entry description:


Icon Function


Enables you to view and edit the HTML source code for the entry description.


Expands the editor to display more options for editing the entry description.


Inserts a horizontal line into the entry descrition.


Links to an external Web page. For more information, see Section 7.2.3, “Linking to an External Page 
on the Web,” on page 105.


Breaks a link that has been created to an external Web page.


Highlights selected text.


Inserts a table. Other icons are available to insert new rows, delete rows, merge cells, and so forth.


To insert a table within a table, create the second table, then select it and drag it into the desired cell of 
the first table.


Pastes text that is currently on the system clipboard into the editor as plain text.


Pastes text that you copied from Microsoft Word into the editor.


Reverts your most recent change.


Adds back any change that you have reverted.
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7.2 Linking to a Folder or Folder Entry
When you create an entry, or an advanced brand, or at other places in the Novell Vibe interface, you 
can include a link to another folder or entry in your Vibe site, or to anywhere else on the Internet.


 Section 7.2.1, “Linking to an Entry in the Current Folder,” on page 104
 Section 7.2.2, “Linking to Another Folder or an Entry in Another Folder,” on page 105
 Section 7.2.3, “Linking to an External Page on the Web,” on page 105


7.2.1 Linking to an Entry in the Current Folder


1 In the Description section of the Entry form, click the Expand icon  in the HTML editor, then 


click the Link icon , located near the end of the row of buttons.
Vibe displays a window that allows you to specify the entry to which you want to link.


2 In the Page name to link to field, do either of the following:
 Type the exact entry title.
 Click Find next to the field, start typing the name of the entry, then select the appropriate 


title from the drop-down list.
3 Click Insert.


If you know the exact name of the entry that you want to link to, you can specify [[entry title]] in 
the Description section of the entry to create a link to that entry. For more information about 
additional types of markup that you can add to the Description section of entries, folders, and 
workspaces, see “Using HTML Markup in Vibe” in the Novell Vibe 3.2 Advanced User Guide.


When selected, words you type are displayed as subscript.


When selected, words you type are displayed as superscript.


Displays a pallette of custom characters that you can select and insert into the editor.


Removes formatting for selected text.


Inserts an anchor into the selected location of the editor. An anchor is a bookmark inside the editor that 
you can use to link directly to.


Cleans up HTML code that you copied in from another source.


Inserts an image into the editor. For more information, see Section 7.17, “Displaying Images in a 
Folder Entry,” on page 120.


Inserts a link to another Vibe entry or folder. For more information, see Section 7.2, “Linking to a Folder 
or Folder Entry,” on page 104.


Inserts a YouTube video into the editor.


Icon Function
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7.2.2 Linking to Another Folder or an Entry in Another Folder


1 In the Description section of the Entry form, click the Expand icon  in the HTML editor, then 


click the Apply link icon , located near the end of the row of buttons in the HTML editor.
Vibe displays a window that allows you to specify the folder or entry to which you want to link.


2 Click the Change link.
3 In the provided field, start typing the name of the folder that you want to link to, or the name of 


the folder that contains the entry that you want to link to.
4 When the desired folder appears in the drop-down list, click it.
5 (Optional) If you want to link to an entry, go to the Page name to link to field and specify the 


complete name of the entry that you want to link to, or click Find to use type-to-find 
functionality.


6 After you have finished typing the name, or after you have clicked the name in the drop-down 
list, click Insert.
 The linked title of your chosen entry is inserted into the Description box.


7.2.3 Linking to an External Page on the Web


1 In the Description section of the Add Entry form, select the text that you want to convert into a 
link.


2 Click the Expand icon  in the HTML editor, then click the Insert/edit link icon .
Vibe displays a window that allows you to specify the entry to which you want to link.


3 Fill in the following fields:
Link URL: Specify the URL of the page that you want to link to.
Target: Specify whether you want to open the link in the same window, or open the link in a new 
window.
Title: Specify a title for the link.
Class: Specify how big you want the link to appear.
If you leave this field blank, 12px is automatically selected. This is the standard setting.


4 Click Insert.


7.3 Commenting on a Folder Entry
People often post a folder entry to generate ideas and obtain feedback. Novell Vibe enables you to 
comment on any type of entry, so you can share your ideas and provide input.


1 Navigate to and open the entry that you want to comment on.
2 Click Comment in the Entry toolbar.


For entries in Discussion folders, click Reply.
3 In the Description field, specify your comment.
4 (Optional) Click Browse to attach a file to your comment.
5 Click OK.


Your comment is displayed in the Comments tab as the last comment in the list of comments.
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For Blog entries, you can use the Blog toolbar to make comments. For information on using the Blog 
toolbar, see “Using the Blog Toolbar” on page 77.


For information on how to comment on an entry from the What’s New page, see Section 2.2.3, 
“Replying to a New Entry,” on page 27.


7.4 Modifying a Folder Entry
If you have appropriate rights, Novell Vibe enables you to modify a folder entry after it has been 
created. You can modify all sections of an entry, or the Description section only.


 Section 7.4.1, “Modifying All Sections of an Entry,” on page 106
 Section 7.4.2, “Modifying the Description Section of an Entry,” on page 106


7.4.1 Modifying All Sections of an Entry


1 Navigate to and open the entry that you want to modify.
2 Click Modify in the Entry toolbar.
3 Modify the entry as necessary.


You can modify the title or description of the entry. You can also subscribe to the entry, or send 
an e-mail when the entry is submitted.


4 When you have finished modifying the entry, click OK.


7.4.2 Modifying the Description Section of an Entry


1 Navigate to and open the entry that you want to modify.
2 In the lower right corner of the Description section, click Edit.
3 Use the provided HTML editor to modify the Description section.
4 Click OK.


7.5 Locking a Folder Entry
When you lock a folder entry in Novell Vibe, other users who might want to modify, move, copy, or 
delete the entry are unable to do so for as long as you have the entry locked.


This does not apply to users accessing the entry through WebDAV.


1 Navigate to and open the entry that you want to lock.
2 Click Actions > Lock in the Entry toolbar.


The entry is now locked from other activity. Nobody else can modify, move, copy, or delete the 
entry.
When you are finished modifying the entry, click Actions > Unlock in the Entry toolbar to make it 
available to be modified by other users.
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7.6 Moving a Folder Entry
Novell Vibe enables you to move a folder entry into any folder where you have appropriate rights. If 
you do not have sufficient rights, this option is not available to you.


1 Navigate to and open the entry that you want to move.
2 Click Actions > Move in the Entry toolbar.
3 In the Select the Destination Folder or Workspace section, use the Workspace tree to navigate to the 


folder where you want to move the entry.
4 Click the linked title of the folder where you want to move the entry.


The Current Save Location section shows you the path where the entry is currently located.
5 To move the entry to the location specified, click OK.


7.7 Copying a Folder Entry
Novell Vibe enables you to copy a folder entry from one folder and paste it into any folder where you 
have appropriate rights. If you do not have sufficient rights, this option is not available to you.


1 Navigate to and open the entry that you want to copy.
2 Click Actions > Copy in the Entry toolbar.
3 In the Select the Destination Folder or Workspace section, use the Workspace tree to navigate to the 


folder that you want to copy the entry into.
4 Click the linked title of the folder that you want to copy the entry into.


The Current Save Location section shows you the path where the entry is currently located.
5 To copy the entry into the location specified, click OK.


7.8 Deleting a Folder Entry
 Section 7.8.1, “Deleting a Single Entry,” on page 107
 Section 7.8.2, “Deleting Multiple Entries,” on page 108


7.8.1 Deleting a Single Entry


You can delete a folder entry if you have appropriate rights to do so. If you do not have sufficient 
rights, this option is not available to you.


1 Navigate to and open the entry that you want to delete.
2 Click Delete in the Entry toolbar.


Novell Vibe asks you if you really want to delete the entry.
3 (Optional) Select Purge this entry immediately if you want to purge the entry so that it cannot be 


recovered.


IMPORTANT: Selecting this option renders the entry unrecoverable and it is permanently 
deleted from the Vibe site.
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If you do not select this option, you can undelete the entry as described in Section 7.9, 
“Undeleting a Folder Entry,” on page 108.


4 Click OK.


7.8.2 Deleting Multiple Entries


You can delete multiple entries within a folder if you have appropriate rights to do so. If you do not 
have sufficient rights, this option is not available to you.


Deleting multiple entries is supported only in Discussion, Files, and Tasks folders.


TIP: If you want to delete multiple entries in a folder that does not support multiple deletion of 
entries (such as a Blog folder), you can view the folder as a Discussion, Files, or Tasks folder if the 
folder owner makes these views available. For information on how to change the view of a folder 
after the folder owner has made alternate views available, see Section 5.13, “Changing the Folder 
View,” on page 71.


1 Navigate to the folder where you want to delete the entries.
2 Select the entries that you want to delete.
3 Click Delete if you want to move the entry to the Trash.


If you click this option you can undelete the entries as described in Section 7.9, “Undeleting a 
Folder Entry,” on page 108.
or
Click Purge if you want to permanently delete the entries from the Vibe system.
If you click this option you cannot recover the entries.


4 Click OK.


7.9 Undeleting a Folder Entry
Novell Vibe enables you to undelete a folder entry that has been deleted, restoring it to its previous 
location.


1 Navigate to the folder where the deleted entry previously resided.
For example, if you want to restore an entry that was in your Blog folder in your personal 
workspace, navigate to the Blog folder in your personal workspace.


TIP: If you want to see everything that has been deleted in the Vibe site, navigate to the highest 
level workspace. (By default this is the Home Workspace directory.)


2 Click the Trash icon  in the Navigation panel.
The Trash page displays all workspaces, folders, and entries that have been deleted in or below 
the current folder.


3 Select the entry that you want to undelete.
4 Click Restore.


The entry is restored to its previous location. If the folder or workspace containing this entry has 
also been deleted, it is restored when you restore the entry.


For more information about undeleting, see “Restoring Deleted Items” in the Novell Vibe 3.2 Advanced 
User Guide.
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7.10 Notifying Others about a Folder Entry
When viewing a folder entry, you might think of a co-worker who also needs the information. Novell 
Vibe provides various ways to inform your friends and co-workers about entries that you think they 
might be interested in.


These options are functional only if you have an e-mail account assigned to you in Vibe. To assign an 
e-mail account to your Vibe profile, see Section 2.11.4, “Adding and Modifying Delivery 
Destinations,” on page 43.


 Section 7.10.1, “Sharing an Entry,” on page 109
 Section 7.10.2, “Sending an E-Mail about an Entry,” on page 109


NOTE: Notifying another Vibe user about an entry does not automatically grant the user access 
rights to view the entry. If the user does not already have access rights to view the entry, you can 
modify the access control settings of the entry, as described in “Controlling Access to Entries” in the 
Novell Vibe 3.2 Advanced User Guide.


7.10.1 Sharing an Entry


When you share a folder entry with someone, that person can view that entry in the Micro-Blogs and 
Shared Items tab in his or her personal workspace. For information on how to view shared entries, see 
Section 2.9.3, “Viewing Shared Items,” on page 40.


1 In the entry that you want to share, click Actions > Share this Entry in the Entry toolbar.
2 In the provided page, select the users, groups, or teams with whom you want to share the entry.
3 In the Comments section, provide any comments that you want to include.
4 Click OK.


The entry is now shared with the users that you specified.


7.10.2 Sending an E-Mail about an Entry


You can send a notification e-mail about a folder entry when you create the entry, or after the entry 
has already been created.


 “Sending an E-Mail When You Create the Entry” on page 109
 “Sending an E-Mail After the Entry Is Created” on page 110


Sending an E-Mail When You Create the Entry


1 In the entry creation form when you are creating an entry, click Send E-Mail When Entry is 
Submitted.


2 Fill in the appropriate fields.
For information on filling in the rest of the Send E-Mail form, see Section 9.4, “Filling Out the 
Send E-Mail Page,” on page 135.


3 Click OK to create the entry and send the e-mail.
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Sending an E-Mail After the Entry Is Created


You do not need to be the author of the entry to send this type of e-mail.


1 Navigate to and open the entry that you want to inform others about via e-mail.
2 Click E-mail Contributors in the entry’s Footer toolbar.


The Send E-Mail page is displayed.
A link to this entry is automatically created and is visible in the body of the received message.


3 Fill in the appropriate fields.
For information on filling in the rest of the Send E-Mail form, see Section 9.4, “Filling Out the 
Send E-Mail Page,” on page 135.


4 Click OK to send the notification.


For Blog entries, you can use the Blog toolbar to send an e-mail about the entry. For information on 
using the Blog toolbar, see “Using the Blog Toolbar” on page 77.


7.11 Subscribing to a Folder Entry
If you are particularly interested in a specific folder entry, you can subscribe to that entry. When you 
subscribe to an entry, Novell Vibe notifies you of any activity that takes place in the entry.


1 Navigate to and open the entry that you want to subscribe to.
2 In the Footer toolbar of the entry, click Subscribe to This Entry.
3 Select the type of e-mail notification that you want to receive, then click OK.


For more information on subscribing to entries, see Section 2.11, “Subscribing to a Folder or Entry,” 
on page 42.


For Blog entries, you can use the Blog toolbar to subscribe to the entry. For information on using the 
Blog toolbar, see “Using the Blog Toolbar” on page 77.


7.12 Tagging a Folder Entry
Tags are keywords that categorize a workspace, folder, or folder entry. Tagging functionality in 
Novell Vibe enables you to create virtual containers for places and entries. Like folders in your e-
mail, you can categorize information, then come back to it at a later time.


1 In the entry that you want to tag, click the Tags tab.
2 Click Add Tags.
3 Select either Personal Tag or Global Tag, depending on whether you want this tag to be visible to 


only yourself or to the entire community.
For more information about the difference between personal and community tags, see 
Section 3.6.4, “Choosing Between Personal Tags and Global Tags,” on page 50.


4 Begin typing the name of the tag that you want to apply to the entry.
This field uses type-to-find functionality, so if a tag already exists with the desired name, it 
appears in the drop-down list. If the name does not appear in the drop-down list, you are 
creating a new tag.
To see a list of existing tags, click inside the provided field, then press the Spacebar.


5 Finish typing the name of the tag, or select it from the drop-down list, then click the Add icon .
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The entry is now marked with the tag that you specified.
6 Click Close.


For more information on tagging, see Section 3.6, “Using Tags,” on page 49.


7.13 Working with Files in a Folder Entry
 Section 7.13.1, “Creating a File Entry,” on page 111
 Section 7.13.2, “Attaching Files to a Folder Entry,” on page 111
 Section 7.13.3, “Viewing and Editing Files,” on page 112
 Section 7.13.4, “Downloading Files,” on page 114
 Section 7.13.5, “Obtaining the WebDAV URL for a File,” on page 114
 Section 7.13.6, “Adding a Note about a File or File Version,” on page 114
 Section 7.13.7, “Setting the File Status,” on page 115
 Section 7.13.8, “Using Version Control with Files,” on page 115


7.13.1 Creating a File Entry


Novell Vibe enables you to create file entries in designated Files folders. Creating a file entry is 
different than attaching a file to another type of folder entry. File entries in Vibe Files folders contain 
a primary file. Other files can be associated to the file entry as attachments, but there is only one 
primary file.


You can create file entries in Files folders the same way that you create any other type of folder entry 
in Vibe, as described in Section 7.1, “Creating a Folder Entry,” on page 101. Or, you can create file 
entries as described in Section 5.7, “Importing Files into a Folder,” on page 66. Only Files folders can 
contain files that are not attachments.


For more information about the difference between Files folders and other types of Vibe folders when 
you add files, see Section 6.5.1, “Adding Files to a Files Folder and Other WebDAV-Enabled Folders,” 
on page 81.


7.13.2 Attaching Files to a Folder Entry


Vibe provides various alternatives to add attachments to an entry.


 “Dragging and Dropping Files” on page 111
 “Uploading a Single File” on page 112


Dragging and Dropping Files


You can attach a file to an entry by dragging it from another location and dropping it into the entry.


1 Navigate to and open the entry where you want to attach the file.
2 Click the Attachments tab.
3 Click Drag and Drop Files.


The Drag and Drop Files dialog box is displayed.
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4 Drag the file that you want to upload and drop it onto the folder icon in the Drag and Drop Files 
dialog box.
Vibe displays an opening and closing folder to signify that your dropped files are being 
uploaded as attachments.


You can also copy and paste files into the folder icon.


Uploading a Single File


1 Navigate to and open the entry where you want to attach the file.
2 Click the Attachments tab.
3 Click Upload a Single File.


The Upload a Single File dialog box is displayed.
4 Click Choose File, then browse to and select the file that you want to attach.
5 Click OK.


7.13.3 Viewing and Editing Files


Vibe enables you to easily view and edit files that are associated with entries. Files can be associated 
with entries in one of two ways:


 Files can be attached to an entry
 Files can be a primary file for the entry


Primary files can exist only in entries in Files folders


The following sections describe how to view and edit attached files:


 “Viewing Files” on page 112
 “Editing Files” on page 113


Viewing Files


You can view files in a text editor or in HTML format.


 “Viewing a File in a Text Editor” on page 112
 “Viewing the File in HTML Format” on page 113


Viewing a File in a Text Editor


When you view a file in a text editor, the file is opened in Read-Only mode.


1 Navigate to and open the entry that contains the file that you want to view.
2 (Conditional) If the file that you want to view is an attachment, click the Attachments tab.


Only Files folders can contain files that are not attachments.
3 Next to the file that you want to view, click File Actions > View This File.


or
Click the name of the file.
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Viewing the File in HTML Format


If you want to quickly view a file, you can view it in HTML format. 


Some file types cannot be viewed in HTML format, such as PNG, JPG, GIF, and PDF.


1 Navigate to and open the entry that contains the file that you want to view.
2 (Conditional) If the file that you want to view is an attachment, click the Attachments tab.


Only Files folders can contain files that are not attachments.
3 Next to the file that you want to view, click File Actions > View This File as HTML.


Editing Files


Vibe enables you to edit documents in-place, using the Edit-in-Place feature. This feature allows you 
to seamlessly edit documents that are stored on the Vibe server.


You can edit files only if you have the editing application for that specific type of file installed on your 
personal workstation. For example, to edit a .doc file, you must have Microsoft Word installed on 
your personal workstation.


1 Navigate to and open the entry that contains the file that you want to edit.
2 (Conditional) If the file that you want to edit is an attachment, click the Attachments tab.


Only Files folders can contain files that are not attachments.
3 Next to the file that you want to edit, click File Actions > Edit This File.


The file is launched in the file editor that you specified. For information on how to change the 
editor that Vibe uses to edit files, see Section B.10, “Unable to Edit Files That Are Attached to 
Entries,” on page 150.


4 (Conditional) If Vibe prompts you to provide your Vibe credentials, specify the username and 
password that you use to log in to Vibe, then click OK.
You can now edit the file.


5 After you have edited the file, save your changes, then exit the editing application.
Vibe creates a version of the file as it was before you modified it. When you exit and reopen the 
entry, you can view the older version of the file, as described in “Accessing a Previously Saved 
Version of a File” on page 117.


IMPORTANT: When you edit an attached document using OpenOffice, Vibe creates a new version 
of the document each time you click Save. Because each version of a document counts against your 
data quota (for more information on data quota, see “Managing Your Data Quota” in the Novell Vibe 
3.2 Advanced User Guide), you should save the document only when you close it if you are using 
OpenOffice. For information on how to delete versions of a file, see “Deleting Existing Versions of a 
File” on page 117.


When you use Microsoft Office, Vibe creates only one new version each time you edit the document. 
Clicking Save multiple times does not create multiple versions.
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7.13.4 Downloading Files


You can download files that are associated with an entry. You can download a single file, or all files 
that are associated with the entry. Files are downloaded in a .zip file.


 “Downloading Single Files” on page 114
 “Downloading All Files” on page 114


Downloading Single Files


1 Navigate to and open the entry that contains the file that you want to download.
2 Next to the file, click File Actions > Download This File in a Zip File.


Downloading All Files


1 Navigate to and open the entry that contains the files that you want to download.
2 Next to any file within the entry, click File Actions > Download All Files.


or
Click the Attachments tab, then click Download All Files.


7.13.5 Obtaining the WebDAV URL for a File


When you know a file’s WebDAV URL, you can open the file directly from an editing application 
such as Microsoft Office, or directly from the command line.


To obtain the WebDAV URL for a file:


1 Navigate to and open the entry that contains the file for which you want to obtain the WebDAV 
URL.


2 (Conditional) If the file for which you want to obtain the WebDAV URL is an attachment, click 
the Attachments tab.
Only Files folders can contain files that are not attachments.


3 Next to the file, click File Actions > WebDAV URL.
The WebDAV URL is displayed for you to copy.


After you have obtained the WebDAV URL for the file, you can specify the URL in a document editor 
such as Microsoft Office to open the file. Refer to the documentation for your specific document 
editor for instructions on how to accomplish this.


7.13.6 Adding a Note about a File or File Version


You might want to add a note about a particular file or version of a file. File notes are displayed 
directly below the filename in the Attachments and File Versions tabs. File notes can make it easier for 
users to know exactly what the file contains without opening it. They can also be an easy way to 
differentiate one version of a file from another.


1 Navigate to and open the entry that contains the attached file or file version for which you want 
to add a note.


2 (Conditional) If the file for which you want to add a note is an attachment, click the Attachments 
tab.
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Only Files folders can contain files that are not attachments.
3 Next to the file for which you want to add a note, click File Actions > Edit File Note.


The Add a File Note page is displayed.
4 Specify the note that you want to add, then click OK.


7.13.7 Setting the File Status


If you have multiple versions of a file, you might want to set a status for each version to help keep 
track of which is the official version, which versions are just drafts, and so forth. Files can have the 
status of Official, Draft, or Obsolete.


1 Navigate to and open the entry that contains the attached file or file version for which you want 
to set the file status.


2 (Conditional) If the file for which you want to set the file status is an attachment, click the 
Attachments tab.
Only Files folders can contain files that are not attachments.


3 In the Status column next to the file for which you want to set the status, click the current status, 
then click the status that you want to set for the file. 


7.13.8 Using Version Control with Files


When you modify a file in Vibe, Vibe saves the previous version of the file, and makes it available for 
easy reference. This includes files that are stored in Vibe Files folders, or any files that are saved as 
attachments to a folder entry.


 “Creating a New Version of a File” on page 115
 “Incrementing the Major Version Number of a File” on page 116
 “Accessing a Previously Saved Version of a File” on page 117
 “Promoting a Previous File Version to Be the Current Version” on page 117
 “Deleting Existing Versions of a File” on page 117
 “Setting a Maximum Number of Allowed Versions” on page 117


Creating a New Version of a File


When you edit and save a file, Vibe creates a new version of the file and saves the old version. For 
information about how to edit a file, see “Editing Files” on page 113.


You can also use the drag-and-drop functionality to create a new version of an attached file or a new 
version of a file entry in a Files folder, as described in the following sections:


 “Dragging and Dropping a File to Update a File Entry Attachment” on page 116
 “Dragging and Dropping a File to Update the Primary File of a File Entry” on page 116
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Dragging and Dropping a File to Update a File Entry Attachment


In order to create a new version of an existing entry attachment, the file that you drag and drop must 
have the same name as the existing entry attachment for which you want to create a new version.


1 Navigate to and open the entry that contains the file attachment for which you want to create a 
new version.


2 Click the Attachments tab, then click Drag and Drop Files.
3 Drag a file from one location, such as your desktop, and drop it onto the folder icon in the drag-


and-drop window.
The document is added as a new version of the existing entry attachment. Older versions are 
displayed in the File Versions tab in the entry.


Dragging and Dropping a File to Update the Primary File of a File Entry


Only Files folders allow you to create updated versions of folder entries as described in this section. 
For more information about the difference between Files folders and other types of Vibe folders in 
regards to adding files, see Section 6.5.1, “Adding Files to a Files Folder and Other WebDAV-Enabled 
Folders,” on page 81.


In order to create a new version of an existing file in the Files folder, the file that you drag and drop 
must have the same name as the existing file for which you want to create a new version.


1 Navigate to the folder where you want to import the new version of the file.
A file with the same name must already exist in the folder as a file entry.


2 Click Add Files in the Folder Entry toolbar.
The drag-and-drop window opens.


3 Drag a file from one location, such as your desktop, and drop it onto the folder icon in the drag-
and-drop window.
The document is added as a new version of the existing file entry. Older versions are displayed 
in the File Versions tab in the entry.


Incrementing the Major Version Number of a File


By default, when you create new versions of a file, Vibe tracks the versions with minor version 
numbers. For example, 1.0, 1.1, 1.2, and so forth. You can increment the major version number of the 
most recent version of a file. For example, version 1.2 becomes version 2.0.


If the folder has been configured to automatically delete old file versions, as described in 
“Automatically Deleting Minor File Versions That Exceed the Allowed Maximum” in “Managing 
Folders” in the Novell Vibe 3.2 Advanced User Guide, incrementing a minor version of a file to be a 
major version preserves the version from being deleted.


To increment the major version number of a file:


1 Navigate to and open the entry that contains the file for which you want to increment the major 
version number.


2 (Conditional) If the file for which you want to increment the major version number is an 
attachment, click the Attachments tab.
Only Files folders can contain files that are not attachments.


3 Next to the file for which you want to increment the major version, click File Actions > Increment 
Major Version Number.
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The Increment Major Version Number page is displayed.
4 Click OK.


Accessing a Previously Saved Version of a File


1 Navigate to and open the entry that contains the file for which you want to access a previous 
version.


2 Click the File Versions tab.
All of the previously saved versions of each file that are associated with the entry are listed in 
reverse chronological order. Vibe displays information such as the date, file size, and the person 
who modified the file.


Promoting a Previous File Version to Be the Current Version


You can promote a previous version of a file to be the current version. The current version is the main 
file in the file entry. Additional versions are located below the main version in the File Versions tab.


1 Navigate to and open the entry where the file version resides that you want to promote to be the 
current version.


2 Click the File Versions tab.
3 Next to the file version that you want to promote to be the current version, click File Actions > 


Promote This Version To Be Current, then click OK.


You can revert the entire entry to a previous version (such as the title and description of the entry), as 
described in Section 7.14.3, “Reverting an Entry to a Previous Version,” on page 118.


Deleting Existing Versions of a File


IMPORTANT: Files and file versions that are deleted from the Vibe site cannot be recovered.


1 Navigate to and open the entry that contains the file for which you want to access a previous 
version.


2 Click the File Versions tab.
All of the previously saved versions of each file that are associated with the entry are listed in 
reverse chronological order. Vibe displays information such as the date, file size, and the person 
who modified the file.


3 To delete multiple versions simultaneously, select the file versions that you want to delete, then 
click Delete Selected Versions.
or
To delete a single version, click File Actions next to the version that you want to delete, then click 
Delete This Version.


4 Click OK to confirm the deletion.


Setting a Maximum Number of Allowed Versions


If you are a folder or workspace owner, you can set a maximum number of versions that are allowed 
for each file. For more information, see “Limiting File Versions for Folders and Workspaces by 
Configuring Automatic Deletion” in the Novell Vibe 3.2 Advanced User Guide.
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7.14 Viewing the History of an Entry
Novell Vibe enables you to view the history of an entry. You can view the various versions of an entry, 
compare two versions to see what changes were made, and revert the entry to a previous version. 


 Section 7.14.1, “Viewing Previous Versions of an Entry,” on page 118
 Section 7.14.2, “Comparing Versions of an Entry,” on page 118
 Section 7.14.3, “Reverting an Entry to a Previous Version,” on page 118


7.14.1 Viewing Previous Versions of an Entry


You can view version information about the entry, such as when it was created, when it was edited, 
and who edited it.


1 Navigate to and open the entry where you want to view the previous versions.
2 Click the Entry History tab.


For each version of the entry, you see the version number, the date the entry was modified, the 
user who modified the entry, and the way in which the entry changed.
You can click the date of the entry to view what the entry looked like on that date.


7.14.2 Comparing Versions of an Entry


When you compare two versions of an entry you see additions and deletions that have been made to 
the Title and Description sections of an entry. You cannot compare the contents of files that are 
attached to the entry.


1 Navigate to and open the entry where you want to compare two versions.
2 Click the Entry History tab.
3 Select the two versions that you want to compare, then click Compare.


Vibe displays the additions highlighted in green, and the deletions marked with strikeout.


7.14.3 Reverting an Entry to a Previous Version


When you or another user modifies an entry, as described in Section 7.4, “Modifying a Folder Entry,” 
on page 106, the latest version of the entry is displayed in Vibe. 


If you are no longer satisfied with the latest version of an entry, you can revert to a previous version.


1 Navigate to and open the entry that you want to revert to a previous version.
2 Click the Entry History tab.
3 Locate the version that you want to revert to, then click Promote To Current.


The Promote To Current page is displayed. You can view how the entry looks in this version.
4 Click OK to make this version of the entry the current version.


To keep an accurate history, the version that you revert to also retains its position in the Entry 
History list.
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7.15 Generating Reports about a Folder Entry
Novell Vibe enables you to generate reports about a folder entry. If you do not have sufficient rights, 
the option is not available to you.


 Section 7.15.1, “Generating Activity Reports,” on page 119
 Section 7.15.2, “Generating Workflow History Reports,” on page 119


7.15.1 Generating Activity Reports


1 Navigate to and open the entry that you want to generate an activity report about.
2 Click Reports > Activity Report in the Entry toolbar.


Vibe launches a spreadsheet that displays the entry activity.
For information on how to change the default application that Vibe uses to view activity reports, 
see Section B.10.1, “Changing the Default Editor Settings for a Single File Type,” on page 150.


Activity reports contain the following kinds of information:


 User: Shows the users who have had some kind of activity in the entry.
 Views: Displays how many times the user has viewed the entry.
 Adds: Displays who created the entry.
 Edits: Displays who has edited the entry.
 Deletes: Displays who deleted the entry. This column lists only entries that have been both 


deleted and purged.
To acquire this information, you must run the report at the folder level, as described in 
Section 5.8, “Generating an Activity Report on a Folder,” on page 67.


 Pre-deletes: Displays who deleted the entry. This column lists entries that have been deleted but 
not yet purged.
To acquire this information, you must either run the report at the folder level, as described in 
Section 5.8, “Generating an Activity Report on a Folder,” on page 67, or navigate to the Trash 
folder to view the entry, as described in Section 7.9, “Undeleting a Folder Entry,” on page 108.


 Restores: Displays who restored the entry.


7.15.2 Generating Workflow History Reports


1 Navigate to and open the entry that you want to generate a report about.
2 Click Reports > Workflow History in the Entry toolbar.


Vibe opens a new page that displays the workflow history of the entry.


Workflow history reports contain the following kinds of information:


 Event: Displays the order of the actions that have been performed concerning the workflow.
 Date: Displays the date the entry was modified for the workflow.
 Modified by: Displays the user who modified the entry for the workflow.
 Operation: Displays the operation that was performed.
 Process: The name of the original workflow.
 Parallel Workflow Thread: Name of the workflow thread that is parallel to this workflow.
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 State: State of the workflow process.


7.16 Displaying YouTube Videos in a Folder Entry
Novell Vibe enables you to post YouTube videos in a folder entry, as well as in the following locations 
throughout the Vibe site:


 In a workspace or folder brand, as described in “Branding a Folder or Workspace” in the Novell 
Vibe 3.2 Advanced User Guide.


 In a workspace description, as described in Section 4.1.14, “Displaying YouTube Videos in a 
Workspace,” on page 56.


 In a folder description, as described in Section 5.17, “Displaying YouTube Videos in a Folder,” on 
page 72.


 On a landing page, as described in “Displaying YouTube Videos on a Landing Page” in the 
Novell Vibe 3.2 Advanced User Guide.


To post a YouTube video in a folder entry:


1 Navigate to the folder where you want to post the YouTube video.
2 Create a new folder entry by clicking the appropriate item in the Folder Entry toolbar. For 


example, to add a blog entry in the Blog folder, click New Blog Entry.
or
Open an existing folder entry that you want to modify, then click Modify in the Entry toolbar.
The Entry page is launched.


3 In the Description section, click the Expand icon  in the HTML editor, then click the Video icon 
.


4 In the provided window, in the URL of a Video on YouTube field, paste the URL of the YouTube 
video that you want to post.


5 In the Dimensions fields, do not make any changes if you want to keep the default YouTube 
dimensions.


6 Click Insert, then click OK to post the entry.


7.17 Displaying Images in a Folder Entry
This section describes how to add images to the Description section of an entry. For information on 
how to attach images to an entry, see Section 7.13.2, “Attaching Files to a Folder Entry,” on page 111.


1 Navigate to the folder where you want to post the image.
2 Create a new folder entry by clicking the appropriate item in the Folder Entry toolbar. For 


example, to add a blog entry in the Blog folder, click New Blog Entry.
or
Open an existing folder entry that you want to modify, then click Modify in the Entry toolbar.
The Entry page is launched.


3 In the Description section, click the Expand icon  in the HTML editor, then click the Image icon 
.
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4 Select Upload an Image File, then click Choose File to select a file on your computer’s file system.
or
Select Select an Attached Image File to select an image that is already attached to the folder or 
workspace. This image must already be added to the entry as an attachment. For information on 
how to create an entry attachment, see Section 7.13.2, “Attaching Files to a Folder Entry,” on 
page 111.


5 Click Insert.


7.18 Rating a Folder Entry
Novell Vibe enables you to rate folder entries by using a five-star rating system (one star indicating 
the least impressive, and five stars the most impressive), which gives you an additional tool for 
determining the quality of information.


1 Navigate to and open the entry that you want to rate.
2 Click the star that represents your evaluation.


For example, to give an entry a rating of three stars, click the third star from the left.


To the right of the stars, Vibe displays the average rating for the entry, and how many users have 
rated the entry.


You can rate an entry as many times as you want, but Vibe records only your most recent rating.


7.19 Configuring the Display Style of Entries
You can select how you want your Novell Vibe entries to be displayed.


1 Click the Settings icon  the upper right corner of the Vibe interface, then click the Personal 


Preferences icon .
The Personal Preferences dialog box is displayed.


2 In the Entry Display drop-down list, select one of the following options:
 Display Entries in Content Area: (Default) When you click an entry, Vibe displays the 


entry in the Content Area.
This is the default style.


 Display Entries in a Dialog: When you click an entry, the entry is displayed in a dialog box 
on the current Vibe page.


3 Click OK.


7.20 Printing a Folder Entry
Novell Vibe enables you to print the content of a folder entry.


1 Navigate to the entry that you want to print.


2 In the Entry toolbar, click the Print icon .
3 Configure your printer settings, then click Print.
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7.21 Enabling Alternate Folder Entry Types
Novell Vibe enables you to configure a folder to allow you to create folder entry types that you 
cannot create by default in a specific type of folder. For example, if you want your tasks to appear in 
your Calendar folder, you can configure your Calendar folder to allow you to create task entries.


For information about how to enable alternate folder entry types, see “Enabling Alternate Folder 
Entry Types” in the Novell Vibe 3.2 Advanced User Guide.


7.22 Creating Custom Folder Entry Forms
Novell Vibe enables you to create custom folder entry forms, so you can display fields that are 
specific to your organization and business requirements.


For instructions on how to create custom entry forms, see “Designing Custom Folder Entry Forms” in 
the Novell Vibe 3.2 Advanced User Guide.


7.23 Displaying Folder Entries on a Landing Page
When you configure a workspace to have a landing page, you populate that landing page with 
entries that exist within that workspace. 


For information on how to display entries on a landing page, see “Adding Content to Your Landing 
Page” in the Novell Vibe 3.2 Advanced User Guide.
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8 8Managing Accessories


Accessories are subsections of a workspace or folder page in Novell Vibe that enhance the use of 
pages in various ways. Accessories do not contain new information; instead, they point to existing 
information, organizing and presenting it in a summarized way that makes your work easier by 
making the most useful information more accessible and easy to consume.


For a list of different accessories that you can create, see Step 5 in Section 8.1.2, “Adding the 
Accessory,” on page 124.


 Section 8.1, “Creating an Accessory,” on page 123
 Section 8.2, “Modifying an Accessory,” on page 130
 Section 8.3, “Deleting an Accessory,” on page 130
 Section 8.4, “Minimizing an Accessory,” on page 131
 Section 8.5, “Minimizing the Accessory Panel,” on page 131
 Section 8.6, “Repositioning Accessories,” on page 131
 Section 8.7, “Establishing a Default Layout,” on page 131
 Section 8.8, “Providing a Title for the Accessory Panel,” on page 132


8.1 Creating an Accessory
To create an accessory, you locate the panel where you want it to display, add the accessory, then set it 
up.


 Section 8.1.1, “Locating The Accessory Panel,” on page 123
 Section 8.1.2, “Adding the Accessory,” on page 124
 Section 8.1.3, “Setting Up the Accessory,” on page 126


8.1.1 Locating The Accessory Panel


Accessories display in an area called the Accessory Panel, which is located in different sections of the 
page, depending on whether you are in a workspace or a folder.


 “Locating the Accessory Panel in Workspaces” on page 123
 “Locating the Accessory Panel in Folders” on page 124


Locating the Accessory Panel in Workspaces


The location of the Accessory Panel differs, depending on the type of workspace that you are 
viewing.


Project Management Workspace: Upper right corner of the workspace.
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Personal Workspace: In the Accessories tab, in the upper right corner of the page.


Team Workspace: Upper right corner of the workspace.


Discussions Workspace: Upper right corner of the workspace.


Basic Workspace: Upper right corner of the workspace.


Landing Page: You can add an Accessory Panel element to any location in your landing page.


For more information on how to add an Accessory Panel to a landing page, see “Adding Accessories 
to Your Landing Page” in the Novell Vibe 3.2 Advanced User Guide.


Locating the Accessory Panel in Folders


For folders, The Accessory Panel is located in the upper right corner of the folder page, above the 
content of the folder.


By default, accessory panels are not displayed in Blog folders and Micro-Blog folders. You can create 
a custom folder view on your folder that contains an accessory panel, as described in “Creating 
Custom Folder Views” in the Novell Vibe 3.2 Advanced User Guide.


8.1.2 Adding the Accessory


1 Navigate to the workspace or folder where you want to add the accessory.
2 Click the Accessory Panel drop-down list.


If you are unable to find the Accessory Panel, see Section 8.1.1, “Locating The Accessory Panel,” 
on page 123.
If you currently have no accessories, only the Add an Accessory item appears in the list.


3 Click Add an Accessory.
4 In the Accessory Scope section, select where you want the accessory to be displayed.


Personal Accessory for This Page Only: This accessory appears only to you and only on the 
currently displayed workspace or folder page.
Personal Accessory for all Workspaces and Folders: This accessory appears only to you, but it 
appears on all workspace and folder pages that you view.
Community Accessory for This Page: This accessory appears only on this page, and it appears 
to everyone who views the current page. Only workspace and folder owners are allowed to 
establish community accessories.


5 In the Accessory Type section, select the type of accessory that you want to display.


Accessory Name Description Setup Information


Search Results Enables you to configure a search, then apply that 
search to any Novell Vibe page that you desire, 
across the entire site or only on the page where the 
accessory is displayed.


See “Search Results” on 
page 126.


Workspace Tree Enables you to display a customized Workspace 
tree. Unlike the main Workspace tree, you can 
configure the Workspace Tree accessory to start on 
any workspace that you desire.


See “Workspace Tree” on 
page 127.
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Formatted Text (HTML 
Editor)


Enables you to use the HTML editor to compose a 
message and display it in the Accessory Panel.


See “Formatted Text (HTML 
Editor)” on page 127.


Embedded Web Page 
(iframe)


Enables you to display any Web page as an 
accessory in a workspace or folder. For example, if a 
team you are working on often refers to a specific 
Web site, you could create an Embedded Web Page 
accessory in the team workspace, so team members 
don’t need to navigate separately to the Web site.


See “Embedded Web Page 
(iframe)” on page 127.


Buddy List Enables you to specify certain Vibe users with whom 
you communicate often, so you can quickly contact 
them by using their Presence icon, or access their 
workspaces by clicking a linked name.


See “Buddy List” on 
page 127.


Team Members Enables you to display all members of the team in 
the folder or workspace where you currently are.


See “Team Members” on 
page 127.


Photo Gallery Enables you to display photos from any Photo Album 
that you desire.


See “Photo Gallery” on 
page 128.


Blog Summary Enables you to synchronize the Vibe Blog folders of 
your choice, and display them in a single, 
summarized Blog folder in the Accessory Panel.


See “Blog Summary” on 
page 128.


Guestbook Enables you to use the Accessory Panel to display 
the contents of a Guestbook folder. Unlike other 
accessories, such as the Calendar Summary and 
Task Summary, you can display the contents of only 
one Guestbook folder in each Guestbook accessory.


See “Guestbook” on 
page 128.


Task Summary Enables you to synchronize the Vibe Tasks folders of 
your choice, and display them in a single, 
summarized task list in the Accessory Panel. This 
eliminates the need to check multiple Tasks folders. 
You can display tasks that are assigned to specific 
users, groups, or teams.


For more information, see “Synchronizing the Vibe 
Tasks Folders of Your Choice” on page 92 and 
Section 6.11.11, “Viewing All Tasks That Are 
Assigned to a Specific Team, Group, or Individual 
User,” on page 94.


See “Task Summary” on 
page 128.


Wiki Home Page Enables you to display the wiki home page of any 
Wiki folder (Wiki Topic) as an accessory. 


For information on how to set a wiki home page for a 
Wiki Topic, see “Setting a Wiki Home Page” on 
page 98.


See “Wiki Home Page” on 
page 129.


Calendar Summary Enables you to synchronize the Vibe calendars of 
your choice, and display them in a single, 
summarized calendar in the Accessory Panel. This 
eliminates the need to check multiple calendars.


For more information, see Section 6.3.3, 
“Synchronizing Vibe Calendars of Your Choice,” on 
page 79.


See “Calendar Summary” on 
page 129.


Accessory Name Description Setup Information
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6 Click OK.
The Accessory Setup page is displayed.


7 To finish creating the accessory, continue with Section 8.1.3, “Setting Up the Accessory,” on 
page 126 for specific information on filling in the Accessory Setup page for each type of 
accessory. 


8.1.3 Setting Up the Accessory


Use the steps in this section to set up an accessory after you have completed the steps in Section 8.1.2, 
“Adding the Accessory,” on page 124.


This section contains specific information on filling in the Accessory Setup page for each type of 
accessory.


 “Search Results” on page 126
 “Workspace Tree” on page 127
 “Formatted Text (HTML Editor)” on page 127
 “Embedded Web Page (iframe)” on page 127
 “Buddy List” on page 127
 “Team Members” on page 127
 “Photo Gallery” on page 128
 “Blog Summary” on page 128
 “Guestbook” on page 128
 “Task Summary” on page 128
 “Wiki Home Page” on page 129
 “Calendar Summary” on page 129
 “Remote Application” on page 129


Search Results


1 In the Accessory Setup page, specify the following information:
Title: Specify a title for the Search Results accessory.
Display Style: Specify whether you want a border around the accessory.
Advanced Search: For information on all of the Advanced Search options, see Section 2.4.3, 
“Using Advanced Search,” on page 33.


2 Click Apply > Close.


Remote Application Enables you to add a remote application as an 
accessory, if the application has been enabled by 
your administrator.


For more information on remote applications, see 
Section 2.12, “Using Remote Applications,” on 
page 44.


See “Remote Application” on 
page 129.


Accessory Name Description Setup Information
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Workspace Tree


1 In the Accessory Setup page, specify the following information:
Title: Specify a title for the Workspace Tree accessory.
Display Style: Specify whether you want a border around the accessory.
Starting Point for the Tree: Select whether you want to start at the current workspace, or select a 
starting workspace in the workspace tree. If you want to select a starting workspace, select Select 
a Starting Workspace and then navigate to and select the workspace in the workspace tree.
Expand the First Level of the Tree: Select Yes if you want the first level of the tree to always be 
expanded. Select No if you want to manually expand the tree.


2 Click Apply > Close.


Formatted Text (HTML Editor)


1 In the Accessory Setup page, specify the following information:
Title: Specify a title for the Formatted Text (HTML Editor) accessory.
Display Style: Specify whether you want a border around the accessory.
Enter the HTML to be Shown: Create your HTML message in the HTML editor provided.
This message is displayed in your Formatted Text accessory.


2 Click Apply > Close.


Embedded Web Page (iframe)


1 In the Accessory Setup page, specify the following information:
Title: Specify a title for the Embedded Web Page (iframe) accessory.
Display Style: Specify whether you want a border around the accessory.
Iframe URL: Specify the URL of the Web page that you want to display in this accessory.
Iframe height in pixels: Specify the height for your embedded Web page. 
If you don’t specify anything in this field, Vibe uses the default height (about 200 pixels).


2 Click Apply > Close.


Buddy List


1 In the Accessory Setup page, specify the following information:
Title: Specify a title for the Buddy List accessory.
Display Style: Specify whether you want a border around the accessory.
Configure Buddy List: Specify the users, groups, and team members that you want to add to 
your buddy list.


2 Click Apply > Close.


Team Members


1 In the Accessory Setup page, specify the following information:
Title: Specify a title for the Team Members accessory.
Display Style: Specify whether you want a border around the accessory.
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Number of Results to be Shown: Specify the number of team members that you want to be 
shown at one time.


2 Click Apply > Close.


Photo Gallery


1 In the Accessory Setup page, specify the following information:
Title: Specify a title for the Photo Gallery accessory.
Display Style: Specify whether you want a border around the accessory.
Number of Photos to be Shown: Specify the number of photos that you want to display at any 
one time in your photo gallery.
Image Size: Select whether you want to display big images or small images.
Select the Photo Album(s) to be Shown: Use the workspace tree to browse to and select the 
photo albums that you want to be displayed in the accessory.


2 Click Apply > Close.


Blog Summary


1 In the Accessory Setup page, specify the following information:
Title: Specify a title for the Blog Summary accessory.
Display Style: Specify whether you want a border around the accessory.
Number of Results to be Shown: Specify the number of Blog results that you want to show in 
the Blog Summary.
Number of Words of Summary to be Shown: Specify the number of words that you want to 
display for each Blog Summary.
Select the blog(s) to be shown: Use the Workspace tree to navigate to and select the Blog folders 
that you want to display in the Blog Summary.


2 Click Apply > Close.


Guestbook


1 In the Accessory Setup page, specify the following information:
Title: Specify a title for the Guestbook accessory.
Display Style: Specify whether you want a border around the accessory.
Number of Results to be Shown: Specify the number of Guestbook results that you want to 
show in the Guestbook accessory.
Number of Words of Summary to be Shown: Specify the number of words that you want to 
display for each Guestbook entry.
Select the guestbook to be shown: Use the Workspace tree to navigate to and select the 
Guestbook folder that you want to display in the Guestbook accessory.


2 Click Apply > Close.


Task Summary


1 In the Accessory Setup page, specify the following information:
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Title: Specify a title for the Task Summary accessory.
Display Style: Specify whether you want a border around the accessory.
Number of Results to be Shown: Specify the number of task results that you want to show in 
the Task Summary accessory.
Show Only the Tasks Assigned To: Specify the users, groups, or teams who are the assignees of 
the tasks that you want to display.
Select the Task Folder(s) to be Shown: Use the Workspace tree to navigate to and select the 
Task Summary folder that you want to display in the Task Summary accessory.


2 Click Apply > Close.


Wiki Home Page


1 In the Accessory Setup page, specify the following information:
Title: Specify a title for the Wiki Home Page accessory.
Display Style: Specify whether you want a border around the accessory.
Select the Wiki to be Shown: Use the Workspace tree to navigate to and select the Wiki folder 
that you want to display in the Wiki Home Page accessory.
In the Wiki Home Page accessory, Vibe displays the wiki entry that you have configured to be 
the wiki home page for the Wiki folder (Wiki Topic) that you select here.


2 Click Apply > Close.


Calendar Summary


1 In the Accessory Setup page, specify the following information:
Title: Specify a title for the Calendar Summary accessory.
Display Style: Specify whether you want a border around the accessory.
Select the Calendar Folder(s) to be Shown: Use the Workspace tree to navigate to and select the 
Calendar folders that you want to display in the Calendar Summary accessory.


2 Click Apply > Close.


Remote Application


You can set up a remote application as an accessory if your administrator has enabled the application.


1 In the Accessory Setup page, specify the following information:
Title: Specify a title for the Remote Application accessory.
Display Style: Specify whether you want a border around the accessory.
Remote Application: From the provided drop-down list, select the remote application that you 
want to display in the accessory.


2 Click Apply > Close.
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8.2 Modifying an Accessory
You can modify an accessory after you have created it.


 Section 8.2.1, “Modifying an Accessory That Has a Border,” on page 130
 Section 8.2.2, “Modifying an Accessory That Doesn’t Have a Border,” on page 130


8.2.1 Modifying an Accessory That Has a Border


1 Click the Modify icon  in the accessory’s title bar.
2 Make the modifications that you desire, then click Apply > Close.


8.2.2 Modifying an Accessory That Doesn’t Have a Border


1 Click the Accessory Panel drop-down list > Show Hidden Borders and Controls.
The accessory’s title bar is displayed.


2 Click the Modify icon  in the accessory’s title bar.
3 Make the modifications that you desire, then click Apply > Close.


8.3 Deleting an Accessory
When you delete an accessory, remember that accessories do not contain information; they merely 
point to and summarize information that exists elsewhere. When you delete an accessory, you delete 
the pointer, not the source information. It is very easy to add the accessory again, if you mistakenly 
delete it.


 Section 8.3.1, “Deleting an Accessory That Has a Border,” on page 130
 Section 8.3.2, “Deleting an Accessory That Doesn’t Have a Border,” on page 130


8.3.1 Deleting an Accessory That Has a Border


1 Click the Delete icon (X) in the accessory’s title bar.
2 Click OK.


8.3.2 Deleting an Accessory That Doesn’t Have a Border


1 Click the Accessory Panel drop-down list > Show Hidden Borders and Controls.
The accessory’s title bar is displayed.


2 Click the Delete icon (X) in the accessory’s title bar.
3 Click OK.
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8.4 Minimizing an Accessory
After you minimize an accessory, only the accessory’s title bar is displayed.


 Section 8.4.1, “Minimizing an Accessory That Has a Border,” on page 131
 Section 8.4.2, “Minimizing an Accessory That Doesn’t Have a Border,” on page 131


8.4.1 Minimizing an Accessory That Has a Border


1 Click the Minimize icon  in the accessory’s title bar.
The accessory is minimized and only the accessory’s title bar is displayed.


8.4.2 Minimizing an Accessory That Doesn’t Have a Border


1 Click the Accessory Panel drop-down list > Show Hidden Borders and Controls.
The accessory’s title bar is displayed.


2 Click the Minimize icon  in the accessory’s title bar.


8.5 Minimizing the Accessory Panel
You can minimize the entire Accessory Panel. This hides all of the accessories that are in the 
Accessory Panel on the current page.


1 Click the Minimize icon , located to the right of the Accessory Panel drop-down list.


8.6 Repositioning Accessories
On pages where you have more than one accessory, you can reposition accessories within the 
Accessory Panel.


1 In the title bar of the accessory that you want to move, click the arrow icons , depending 
on whether you want to move the accessory up or down in the Accessory Panel.


8.7 Establishing a Default Layout
When you create accessories for every page that you view or for a community accessories panel, the 
accessories are displayed in the reverse order in which they were created. Novell Vibe enables you to 
rearrange the order of the accessories within the panel, allowing you to determine an optimal default 
order in which the defined accessories appear. (If you are not the owner of the community accessory, 
you can override higher-level settings by personalizing the order of the accessories within the 
community panel, as described in Section 8.6, “Repositioning Accessories,” on page 131.)


To change the layout of a global personal accessory panel or a community accessory panel:


1 Click the Accessory Panel drop-down list.
2 Click Set Default Layout for Community Accessories, or Set Default Layout for Personal Global 


Accessories, depending on which type of layout that you want to set.
The Configure the Accessory Panel page is displayed.
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3 In the title bar of the accessory that you want to move, click the arrow icons , depending 
on whether you want to move the accessory up or down in the Accessory Panel.


4 Click Close.


8.8 Providing a Title for the Accessory Panel
1 Click the Accessory Panel drop-down list.
2 Click Set the accessory panel’s title.
3 Specify the following information:


New Title: Provide a title for your Accessory Panel.
Accessory Panel Title Scope: Select whether you want the new name to apply to your personal 
Accessory Panel for this page only, your personal Accessory Panel for all pages, or the 
community Accessory Panel for this place only.


4 Click OK.
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9 9Connecting With Your Co-Workers


Novell Vibe enables you to directly connect with your co-workers.


 Section 9.1, “Sending E-Mail from within Vibe,” on page 133
 Section 9.2, “Sending an Instant Message from within Vibe,” on page 134
 Section 9.3, “Using Skype From within Vibe,” on page 135
 Section 9.4, “Filling Out the Send E-Mail Page,” on page 135
 Section 9.5, “Using the Vibe Clipboard,” on page 136


9.1 Sending E-Mail from within Vibe
Novell Vibe enables you to send e-mail messages to your co-workers from a variety of places within 
Vibe, and for a variety of reasons.


 Section 9.1.1, “Informing Others about a Folder or Workspace,” on page 133
 Section 9.1.2, “Informing Others about an Entry,” on page 134
 Section 9.1.3, “Configuring Folders to Send E-Mail Notifications to Other Users,” on page 134


9.1.1 Informing Others about a Folder or Workspace


Vibe enables you to send an e-mail message to inform others about a specific folder or workspace.


This option is functional only if you have an e-mail account assigned to you in Vibe. To assign an e-
mail account to your Vibe profile, see Section 2.11.4, “Adding and Modifying Delivery Destinations,” 
on page 43.


1 Navigate to the folder or workspace that you want to inform others about via e-mail.
2 Click Workspace or Folder in the Action toolbar, then click one of the following options:


 E-Mail Team: E-mails team members who are associated with this folder or workspace.
 E-Mail Contributors: E-mails all users who have added entries or comments to the current 


page.
The Send E-Mail page is displayed.
A link to this folder or workspace is automatically created in the Message field.


3 Fill in the appropriate fields.
For information on filling in the rest of the Send E-Mail form, see Section 9.4, “Filling Out the 
Send E-Mail Page,” on page 135.


4 Click OK.
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9.1.2 Informing Others about an Entry


You can send an e-mail notification to inform other Vibe users about a new or existing folder entry. 
For information on how to do this, see Section 7.10, “Notifying Others about a Folder Entry,” on 
page 109.


These options are functional only if you have an e-mail account assigned to you in Vibe. To assign an 
e-mail account to your Vibe profile, see Section 2.11.4, “Adding and Modifying Delivery 
Destinations,” on page 43.


9.1.3 Configuring Folders to Send E-Mail Notifications to Other Users


If you are the owner of a folder, you can configure that folder to send e-mail notifications to specific 
Vibe users.


For information on how to do this, see “Configuring Folders to Send E-Mail Notifications to Other 
Users” in the Novell Vibe 3.2 Advanced User Guide.


9.2 Sending an Instant Message from within Vibe
Novell Vibe 3 and later supports the use of Novell Messenger to display presence information in 
Vibe. Before you can see Messenger presence in Vibe as described in this section, your Vibe 
administrator must enable these integrations, as described in “Configuring Presence” in the Novell 
Vibe 3.2 Installation Guide.


To send an instant message to another Vibe user:


1 Click a user’s presence icon .
 Presence is displayed in the following locations in Vibe:
 In a folder entry next to a user’s name
 In a user’s profile
 In the home page of a user’s personal workspace


The Profile Quick View is displayed.


2 Click IM.
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9.3 Using Skype From within Vibe
Novell Vibe enables you to communicate with other Vibe users through Skype, without leaving the 
Vibe interface.


 Section 9.3.1, “Setting Up Your Skype Address in Vibe,” on page 135
 Section 9.3.2, “Contacting Other Vibe Users with Skype,” on page 135


9.3.1 Setting Up Your Skype Address in Vibe


After Skype has been configured by your Vibe administrator, you must specify your Skype name in 
your personal profile. 


1 In the home page of your personal workspace, click the Profile link next to your name and avatar.
or


Click your Presence icon , located next to any entry that you have created or modified, then 
click Profile.


2 In the Profile page, click Edit.
The User page is displayed. 


3 In the Skype Name field, specify your Skype username.
4 Click OK.


9.3.2 Contacting Other Vibe Users with Skype


You can use Skype to contact only those users who have specified a Skype name in their personal 
profiles. For information on how to modify your personal profile, see Section 9.3.1, “Setting Up Your 
Skype Address in Vibe,” on page 135.


To contact a Vibe user by using Skype:


1 Click the Presence icon  of the user you want to call by using Skype.
or
Navigate to the profile page of the user you want to call by using Skype.


2 In the Skype section, click Call me.
The Skype application is launched.
For information on how to use Skype, see the Skype documentation.


9.4 Filling Out the Send E-Mail Page
When you send e-mail from within Vibe, Vibe displays the Send E-Mail page. This page contains the 
following fields and options:


Add E-Mail Addresses: Specify users’ individual e-mail addresses. You must separate multiple e-
mail addresses with commas; do not include spaces between addresses.


Your e-mail address: Select your name if you want to include yourself in the e-mail.


Users: Use type-to-find functionality to specify individual users to whom you want to send the e-
mail.
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Groups: Use type-to-find functionality to specify individual groups to whom you want to send the e-
mail.


Clipboard User Names: Click this option to include all users whose names are currently on your 
clipboard.


For more information on using the Vibe clipboard, see Section 9.5, “Using the Vibe Clipboard,” on 
page 136.


Team Members: Click this option to include all team members.


CC: Click this option to specify users to whom you want to send a carbon copy of the message.


BCC: Click this option to specify users to whom you want to send a blind copy of the message.


Subject: Specify the subject of your e-mail message.


Message/Additional Text Sent with the Entry: Specify the main content of your e-mail message.


Include Attachments: (This option is not available when you send an e-mail from a folder or 
workspace.) Select this option if you want to include any attachments that are attached to the entry 
from where you are sending the e-mail.


9.5 Using the Vibe Clipboard
The clipboard in Novell Vibe is a tool that you can use to gather people’s names as you visit places 
within Vibe. Later, when using a tool that requires you to specify usernames, you can easily reference 
the names on your clipboard. For example, you can put a name on the clipboard, then when you 
want to send an e-mail message from Vibe, you refer to the clipboard to specify the name of the user 
to whom you want to send the e-mail.


Names remain on the clipboard until you remove them or until you log out.


 Section 9.5.1, “Adding Names to the Clipboard,” on page 136
 Section 9.5.2, “Removing Names from the Clipboard,” on page 137
 Section 9.5.3, “Using the Names on Your Clipboard,” on page 137


9.5.1 Adding Names to the Clipboard


 “Adding Users from the Current Page” on page 136
 “Adding Team Members” on page 137


Adding Users from the Current Page


Vibe enables you to add all users to the clipboard who have created content on the current page, or 
who have modified an entry on the current page.


1 Navigate to the page where you want to add users to the clipboard.
2 Click View > Clipboard.


The Clipboard dialog box is displayed.
3 Click Add people from this page.


Those users who have added or modified entries on this page are added to the clipboard.
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If you are in the home page of a user’s personal workspace, clicking this option adds the owner 
of the personal workspace.


4 Click Close.


Adding Team Members


Vibe enables you to add all team members to the clipboard from the team workspace where you 
currently are.


You must be in a team workspace to add team members to the clipboard.


1 Navigate to the team workspace where you want to add team members to the clipboard.
2 Click View > Clipboard.


The Clipboard dialog box is displayed.
3  Click Add team members.


All members of the team are added to the clipboard.
4 Click Close.


9.5.2 Removing Names from the Clipboard


You can easily remove names from the Vibe clipboard after you have added them.


1 In the Clipboard dialog box, select the names that you want to delete.
You can simultaneously select all names by clicking Select All. Click Clear All to deselect all 
names.


2 Click Remove Selected Names.
3 Click Close.


9.5.3 Using the Names on Your Clipboard


There are various places in Vibe where you can use the names that are stored on your clipboard:


 When you send e-mail
 When you create a new team workspace
 When you add additional team members to a workspace
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10 10Using Workflows


Workflows in Novell Vibe can improve efficiency in your organization by automating common 
business processes.


Before you can use a workflow, it must first be created and enabled. Workflows can be created and 
enabled by folder owners for use in a folder, or they can be created and enabled by Vibe 
administrators for use across the entire Vibe site. For information on how to create and enable a 
workflow, see “Creating and Managing Workflows” in the Novell Vibe 3.2 Advanced User Guide.


Because workflow creators can control who has rights to perform certain functions concerning the 
workflow, you might not have appropriate rights to work with workflows as described in this 
section. For more information on setting access controls on workflows, see “Adding Access Controls 
to a Workflow” in the Novell Vibe 3.2 Advanced User Guide.


 Section 10.1, “Manually Starting and Stopping a Workflow,” on page 139
 Section 10.2, “Manually Transitioning a Workflow after It Starts,” on page 140


10.1 Manually Starting and Stopping a Workflow
If a workflow has been enabled for use in a folder where you are creating an entry, the workflow 
either automatically starts when you create the entry, or you can manually start it after the entry is 
created, depending on how the folder owner or site administrator enabled the workflow.


 Section 10.1.1, “Manually Starting a Workflow,” on page 139
 Section 10.1.2, “Manually Stopping a Workflow,” on page 139


10.1.1 Manually Starting a Workflow


1 Navigate to and open the entry where you want to start the workflow.
2 In the Entry toolbar, click Actions > Start Workflow for the workflow that you want to start.


Multiple workflows can be enabled in the same folder, so multiple workflows might appear in 
the drop-down list.


3 Click OK when you are prompted about whether you really want to start the workflow.


10.1.2 Manually Stopping a Workflow


1 Navigate to and open the entry where you want to stop the workflow.
2 In the Entry toolbar, click Actions > Stop Workflow for the workflow that you want to stop.


Multiple workflows can be active on the same entry, so multiple workflows might appear in the 
drop-down list.


3 Click OK when you are prompted about whether you really want to stop the workflow.
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10.2 Manually Transitioning a Workflow after It Starts
Workflows can be configured to automatically transition to another workflow state after the entry is 
modified, after someone has commented or replied to the entry, after a specified amount of time, or 
various other options.


Workflows can also be configured to be manually transitioned. If a workflow has been configured to 
be manually transitioned, and if you have appropriate rights, then you can manually transition the 
workflow from one workflow state to another.


1 Navigate to and open the entry that you want to transition to another workflow state.
The workflow must already be started on the entry.


2 In the Workflow section, click the drop-down arrow and select the workflow state that you want 
to transition the entry to, then click OK.
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11 11Using Vibe on Your Mobile Phone


Novell Vibe supports using Vibe from your mobile phone. Native applications are available to 
download for both iPhone and Android devices. For more information, see “Using Vibe on Your 
Mobile Phone” in the Novell Vibe 3.2 Advanced User Guide.
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A AWhat’s New in Novell Vibe 3.x


Welcome to Novell Vibe 3.x. You’ll find new features, a fresh user interface, and significant updates. 
The following list is an overview of the new features:


 Section A.1, “Survey Improvements (v3.2),” on page 143
 Section A.2, “Task Improvements (v3.2, v3.1),” on page 143
 Section A.3, “Navigation Improvements (v3.1),” on page 144
 Section A.4, “Folder Columns (v3.1),” on page 144
 Section A.5, “Search Improvements (v3 and v3.1),” on page 144
 Section A.6, “User Interface Improvements (v3),” on page 144
 Section A.7, “What’s New Page (v3),” on page 145
 Section A.8, “Document Management (v3),” on page 145
 Section A.9, “Entry History (v3),” on page 146
 Section A.10, “Expanded User Profile (v3),” on page 146
 Section A.11, “Wiki Improvements (v3),” on page 146
 Section A.12, “Advanced User Enhancements,” on page 146


A.1 Survey Improvements (v3.2)
Novell Vibe 3.2 enables you to change the order of survey questions after a survey has been created 
or during its creation.


For more information, see Section 6.10.3, “Modifying a Survey,” on page 86.


A.2 Task Improvements (v3.2, v3.1)
 Section A.2.1, “Task Improvements in Vibe 3.2,” on page 143
 Section A.2.2, “Task Improvements in Vibe 3.1,” on page 144


A.2.1 Task Improvements in Vibe 3.2


Novell Vibe 3.2 provides the following task management improvements:


 Editing task due dates directly from the task list, as described in Section 6.11.3, “Modifying 
Tasks in the Task List,” on page 88.
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 Changing task order directly from the task list, as described in Section 6.11.6, “Changing the 
Order of Tasks,” on page 90.


 Sorting tasks in the task list by a primary and secondary category, as described in Section 6.11.1, 
“Sorting Tasks in Your Tasks Folder By Task Characteristics,” on page 87.


A.2.2 Task Improvements in Vibe 3.1


Novell Vibe 3.1 offers an improved and more intuitive task management experience. It’s easier than 
ever to change task priority, re-order your task list, and manage your tasks by creating sub-tasks.


For more information, see Section 6.11, “Working with Tasks Folders,” on page 87.


A.3 Navigation Improvements (v3.1)
The Recent Places menu now displays your most recently visited places in previous Vibe sessions as 
well as in your current Vibe session. For more information, see Section 3.2, “Viewing and Revisiting 
Recent Places,” on page 47.


A.4 Folder Columns (v3.1)
Novell Vibe 3.1 enables you to customize folder columns. You can customize the column name, order, 
size, and so forth.


For more information, see Section 5.12, “Configuring Folder Columns,” on page 69.


A.5 Search Improvements (v3 and v3.1)
When you perform an advanced search, you can now specify whether you want to search by 
relevance, date, rating, or reply count. You can have a primary and secondary sort order. For more 
information, see Section 2.4.3, “Using Advanced Search,” on page 33.


A.6 User Interface Improvements (v3)
The user interface for Novell Vibe 3 has been significantly redesigned to facilitate maximum 
productivity.


 Section A.6.1, “Masthead,” on page 144
 Section A.6.2, “Navigation Panel,” on page 145
 Section A.6.3, “Action Toolbar,” on page 145


A.6.1 Masthead


The Masthead in Vibe 3 has been simplified to include access to your personal workspace, your 
personal preferences , News Feed , and Help documentation . It also provides an easy way to 
log out of the Vibe site .


For more information about the Masthead, see Section 1.3.1, “Understanding the Masthead,” on 
page 16.
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A.6.2 Navigation Panel


The Navigation panel in Vibe 3 has been consolidated and refined to include only the tree navigation, 
which enables you to view the current workspace and all sub-workspaces and sub-folders.


For more information, see Chapter 3, “Navigating the Novell Vibe Interface,” on page 47.


A.6.3 Action Toolbar


The Action toolbar in Vibe 3 has been consolidated and simplified to include most of the actions that 
users can perform. From the Action toolbar, users can navigate to their personal workspaces, team 
workspaces, favorites, and recent places. Also, users can perform various actions on the folder or 
workspace that they are currently viewing, such as viewing activity reports and creating a brand. 
Users can also use the Action toolbar to search the Vibe site or to browse the Workspace tree.


For more information about the Action toolbar, see Section 1.3.3, “Understanding the Action 
Toolbar,” on page 17.


A.7 What’s New Page (v3)
Novell Vibe 3 provides an easier, more prominent What’s New page. You can quickly see what’s new 
in your teams, tracked places, and more. You can even see what’s new in specific team workspaces, or 
what’s new from specific people that you’re following.


For more information, see Section 2.2, “Finding What’s New,” on page 26.


A.8 Document Management (v3)
Novell Vibe 3 provides enhanced document management capabilities.


 Section A.8.1, “Minor Versioning,” on page 145
 Section A.8.2, “Version Notes,” on page 145
 Section A.8.3, “File Status,” on page 146
 Section A.8.4, “Deleting Past Versions,” on page 146


A.8.1 Minor Versioning


You can now track documents on a more granular level. For example, instead of versions of a 
document being 1, 2, 3, Vibe documents can now be versioned as 1, 1.2, 2, 2.2, 2.3, and so forth. You 
can also increment the major version of a document. For more information, see “Incrementing the 
Major Version Number of a File” on page 116.


A.8.2 Version Notes


You can now add personal notes to specific versions of a document. For more information, see 
Section 7.13.6, “Adding a Note about a File or File Version,” on page 114.
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A.8.3 File Status


You can now indicate if a file has a status of Official, Draft, or Obsolete. For more information, see 
Section 7.13.7, “Setting the File Status,” on page 115.


A.8.4 Deleting Past Versions


You can now delete past versions of a document. For more information, see “Deleting Existing 
Versions of a File” on page 117.


A.9 Entry History (v3)
You can now view the history of an entry in a new, concise view. For more information, see 
Section 7.14, “Viewing the History of an Entry,” on page 118.


A.10 Expanded User Profile (v3)
 Section A.10.1, “User Profile Section in a User’s Personal Workspace,” on page 146
 Section A.10.2, “Profile Quick View Dialog Box,” on page 146


A.10.1 User Profile Section in a User’s Personal Workspace


The User Profile section in Novell Vibe 3 has been expanded to rival other professional 
knowledgebases such as LinkedIn. Now you can include more information to share with your 
colleagues, such as your education, qualifications, and competencies. For more information, see 
Section 1.4.1, “Modifying Your Profile,” on page 18.


A.10.2 Profile Quick View Dialog Box


The Profile Quick View dialog box is displayed when you click a user’s Presence icon . It enables 
you to see information about that user, view the user’s micro-blog or workspace, follow the user, and 
more.


A.11 Wiki Improvements (v3)
Novell Vibe 3 offers an improved and more intuitive wiki experience. It’s easier than ever to create 
new Wiki Topics and pages, organize and retrieve information, and set home pages.


For more information, see Section 6.12, “Working with Wiki Folders,” on page 96.


A.12 Advanced User Enhancements
For a list of advanced features that are new in Novell Vibe, see “What’s New in Vibe 3.x” in the Novell 
Vibe 3.2 Advanced User Guide.

146 Novell Vibe 3.2 User Guide







B BTroubleshooting


The following sections provide guidance for difficulties you might encounter when using Novell 
Vibe:


 Section B.1, “Unable to Edit Files on Windows 7 with Microsoft Office 2007 or Later,” on 
page 147


 Section B.2, “You Have Exceeded Your Data Quota and Cannot Add Any Files or Attachments to 
the Vibe Site,” on page 147


 Section B.3, “You Are Unable to Change Your Vibe Password,” on page 148
 Section B.4, “Vibe Interface Is Not Displayed Correctly,” on page 148
 Section B.5, “Understanding Mirrored Folders,” on page 148
 Section B.6, “Too Many Sign-Ins for WebDAV,” on page 149
 Section B.7, “WebDAV Phantom Folders,” on page 149
 Section B.8, “Unable to Open Pictures from WebDAV in Microsoft Office Picture Manager,” on 


page 150
 Section B.9, “Unable to Move Files and Folders within the WebDAV Interface,” on page 150
 Section B.10, “Unable to Edit Files That Are Attached to Entries,” on page 150
 Section B.11, “Cannot Upload a File Because it Is Too Large,” on page 151
 Section B.12, “Upload Applet Problems on SLED 10 SP1,” on page 152
 Section B.13, “Vibe Applets Are Not Working,” on page 153
 Section B.14, “Edit-In-Place Applet Is Not Working on Mac,” on page 154
 Section B.15, “Troubleshooting Your Mobile Device,” on page 155


B.1 Unable to Edit Files on Windows 7 with Microsoft Office 
2007 or Later
When you are using Microsoft Office 2007 or later as your document editor on a Windows 7 
workstation, you are unable to edit files using the Edit-in-Place feature as described in “Editing Files” 
on page 113. You might need to perform some additional configuration procedures before editing 
works. For more information, see “Configuring Vibe to Support WebDAV on Windows 7” in the  
Novell Vibe 3.2 Administration Guide.


B.2 You Have Exceeded Your Data Quota and Cannot Add Any 
Files or Attachments to the Vibe Site
Problem: When you try to add files and attachments to the Novell Vibe site you are unable to do so 
because you have exceeded your data quota.
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You can remove superfluous files and attachments that are counting toward your data quota by 
purging items that you have previously deleted from the Vibe site. Workspaces, folders, and entries 
that do not contain attached documents do not count toward your data quota.


NOTE: Purged items cannot be recovered. Before you purge an item, verify that you no longer want 
this item to exist on the Vibe site.


1 Navigate to the folder or workspace where you deleted the items that you now want to purge 
from the Vibe site.


2 Click the Trash icon , located in the Navigation panel.
3 Select the item that you want to purge from the Vibe site.
4 Click Purge > OK.


For more information about purging deleted items, see “Making Disk Space Available by Purging 
Deleted Items” in the Novell Vibe 3.2 Advanced User Guide.


For information on how to view your current disk space usage as it relates to your data quota, see 
“Viewing Your Data Quota” in the Novell Vibe 3.2 Advanced User Guide.


B.3 You Are Unable to Change Your Vibe Password
Problem: You are unable to change your Novell Vibe password as described in section Section 1.4.1, 
“Modifying Your Profile,” on page 18.


If you are unable to modify your Vibe password it is probably because your personal information is 
being synchronized from an external directory server. You must consult your Vibe administrator to 
make any changes.


B.4 Vibe Interface Is Not Displayed Correctly
Problem: When you access Novell Vibe 3 after upgrading from a previous version, the Vibe interface 
is not displayed correctly.


You must clear your browser cache after upgrading to Vibe 3 from a previous version.


For example, if you are using Mozilla Firefox, click Tools > Clear Cache in the browser toolbar.


For information about how to clear the browser cache for other browsers, consult the documentation 
for your specific browser.


B.5 Understanding Mirrored Folders
Problem: You are not sure if you want to use mirrored folders, because you do not understand how 
they work.


A mirrored folder is a library folder within Novell Vibe that is synchronized with a folder located on 
a system drive outside of Vibe. When you perform basic actions (adding sub-folders and files, 
modifying files, deleting folders and files) by using the Vibe interface or by accessing the file on the 
drive, the change is reflected in the other interface. The advantage to using mirrored files is that you 
can apply Vibe tools to files on a drive, including tools such as text search, workflow, and discussion 
(in the form of comments applied to the entry in the library folder).
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Vibe supports two types of external folders:


 A directory on a file system
 A folder accessible through WebDAV


Consider the following tips for using mirrored files:


 When you specify the path to the system folder, specify the full (absolute) path to the folder.
 After creating the mirrored folder, you cannot alter the pathname, and you cannot reconfigure 


the Vibe library folder to be a non-mirrored folder.
 To initialize the new mirrored folder, click Manage > Modify this folder, and use the Synchronize 


tool.
For more information on how to synchronize a mirrored folder, see  “Synchronizing a Mirrored 
Folder” in the Novell Vibe 3.2 Advanced User Guide.


 Do not attach additional files to entries in a mirrored folder. Behavior regarding additional 
attachments is unpredictable.
Synchronization occurs only through manually using the Vibe menu items; you cannot schedule 
synchronization.


 When you delete a file on the server, Vibe deletes the entire entry in the library folder (not just 
the attached file).


 Adding and deleting sub-folders adds and deletes sub-folders in the other system. When you 
delete a sub-folder, you delete all of its contents in both places.
For more information about Mirrored Files folders, see “Working with Mirrored Folders” in the 
Novell Vibe 3.2 Advanced User Guide.


B.6 Too Many Sign-Ins for WebDAV
Problem: When you use WebDAV, you must specify your Novell Vibe username and password more 
than once.


This is expected behavior for WebDAV. WebDAV requires that you sign in each time you access a 
separate program (for example, your Web browser and Vibe). It might ask you to sign in again to 
access a file.


If you are using Windows Authentication, you might not experience this problem.


B.7 WebDAV Phantom Folders
Problem: When you use Novell Vibe to access a WebDAV folder, you might see a link to a sub-folder 
that does not exist (a phantom folder). Clicking the link to the phantom folder returns you to your 
current folder (therefore, it has no effect). 


This error is caused by an interaction between WebDAV and Windows Explorer. It does not occur 
consistently, and there is no Vibe solution for this problem. Simply ignore phantom folders if you 
encounter them.
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B.8 Unable to Open Pictures from WebDAV in Microsoft Office 
Picture Manager
Problem: When you are attempting to open pictures from WebDAV in Microsoft Office Picture 
Manager, you see the following error message: 


Picture Manager is unable to open pictures over the Internet that are not from a 
Windows SharePoint Services picture library. Please specify a valid picture library 
and try again.


This message occurs because Microsoft Office Picture Manager does not support the standard 
WebDAV protocol.


To work around this problem:


1 Copy the picture file to your local machine, then open the file using whatever photo viewer you 
want.


B.9 Unable to Move Files and Folders within the WebDAV 
Interface
Problem: You cannot drag and drop or otherwise move files from one folder to another within the 
WebDAV interface.


Moving files and folders within the WebDAV interface is not supported in Novell Vibe. If you want to 
move files and folders within Vibe, you must use the regular Vibe interface, as described in 
Section 5.6, “Moving a Folder,” on page 65 and Section 7.6, “Moving a Folder Entry,” on page 107.


B.10 Unable to Edit Files That Are Attached to Entries
Problem: You are unable to edit files that are attached to entries. 


If you are unable to edit a file, Novell Vibe might not be configured to support the editing application 
that is installed on your computer. For example, if Vibe is configured to use Microsoft Word as the 
default editor for all text files, but you have OpenOffice instead of Microsoft Word installed on your 
computer, Vibe displays an error, and won’t edit the document.


To fix this problem, Vibe enables you to override the default editor setting.


 Section B.10.1, “Changing the Default Editor Settings for a Single File Type,” on page 150
 Section B.10.2, “Changing the Default Editor Settings for All File Types,” on page 151
 Section B.10.3, “Changing the Default Editor Settings When the Editor is Not Installed in the 


Default Location,” on page 151


B.10.1 Changing the Default Editor Settings for a Single File Type


1 Click the Settings icon , then click the Personal Preferences icon  to display the Personal 
Preferences dialog box.


2 Click Define Editor Overrides.
3 Click Add.
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4 From the drop-down list, select the file extension for which you want to change the default 
editing application. 


5 In the Application field, specify the name of the application that you want to use to edit the type 
of files that you selected in Step 4.


6 Select the check box, then click OK.


B.10.2 Changing the Default Editor Settings for All File Types


You can configure Vibe to use the same editing application for all file types.


1 Click the Settings icon , then click the Personal Preferences icon  to display the Personal 
Preferences dialog box.


2 Click Define Editor Overrides.
3 Click the Use drop-down list, then select the application that you want Vibe to use to edit all file 


types.
4 Select the check box to the left of Extension, then click OK.


B.10.3 Changing the Default Editor Settings When the Editor is Not Installed 
in the Default Location


1 Click the Settings icon , then click the Personal Preferences icon  to display the Personal 
Preferences dialog box.


2 Click Define Editor Overrides.
3 In the Extension column, ensure that the correct file extension is selected in the drop-down list.
4 In the field in the Application column, specify the path to the application that you selected in 


Step 3.
For example, if your OpenOffice application is installed in a location other than the default 
location, and you want Vibe to recognize the unique location, specify the pathname to the 
OpenOffice application.


5 Click OK.


B.11 Cannot Upload a File Because it Is Too Large
Problem: You are having trouble uploading a file because the file is too large. 


You might be able to fix this problem by increasing the default amount of memory used by Java 
applets.


 Section B.11.1, “Increasing the Default Memory Amount on Windows,” on page 151
 Section B.11.2, “Increasing the Default Memory Amount on Linux,” on page 152


B.11.1 Increasing the Default Memory Amount on Windows


1 Navigate to the Control Panel (Click Start > Settings > Control Panel).
2 Double-click Java.


The Java Control Panel is launched.
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3 Select the Java tab.
4 In the Java Applet Runtime Settings section, click View.
5 For each of your Java Runtime Versions, add -Xmx256m as a Java Runtime Parameter.
6 Click OK.


After increasing the default memory size for Java applets, you must exit all browsers and restart 
them before the change can take effect.


This setting causes the applet used for uploading files into a Novell Vibe folder to start up with 256 
MB of memory. If the applet still indicates that there is not enough memory to run the applet, you 
might need to reduce this number.


B.11.2 Increasing the Default Memory Amount on Linux


1 Locate the JRE or JDK being used for the browser plug-in.
The location of the JRE or JDK varies, depending on your system.


2 In the bin directory of the JRE or JDK, run the ControlPanel file.
The Control Panel is launched.


3 Select the Java tab.
4 In the Java Applet Runtime Settings section, click View.
5 For each of your Java Runtime Versions, add -Xmx256m as a Java Runtime Parameter.
6 Click OK.


After increasing the default memory size for Java applets, you must exit all browsers and restart 
them before the change can take effect.


This setting causes the applet used for uploading files into a Vibe folder to start up with 256 MB of 
memory. If the applet still indicates that there is not enough memory to run the applet, you might 
need to reduce this number.


B.12 Upload Applet Problems on SLED 10 SP1
Problem: When you use Novell Vibe in a browser running on SUSE Linux Enterprise Desktop 
(SLED) 10 SP1, dragging and dropping picture files onto the upload applet results in the pictures 
being displayed in the browser instead of being added to the Vibe entry as attachments. This problem 
was reported by a user running a Firefox Version 2.0.0.12 browser, but the problem can also appear 
with other browsers.


In future releases of SLED, this problem might not occur if the Java JRE software is updated. Until 
then, you can either use the HTML form method of uploading files (the icon is next to the icon for the 
upload applet). You can also use the following procedure as a workaround for the problem:


1 Use your windowing software to select and copy the photo files to your windowing system 
clipboard.


2 Click Add Files.
3 Right-click the Upload applet icon (a blue folder) within the upload applet box.
4 Select Paste.


Vibe attaches the pictures to the entry.
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B.13 Vibe Applets Are Not Working
The following Novell Vibe applets do not currently work:


 The Add Files applet. This applet enables you to drag files from one location and drop them into 
a Vibe folder. It also enables to you copy and paste files into a Vibe folder.


 The Edit in Place applet. This applet enables you to easily edit files that are attached to entries.
 The Workflow Graphical Display applet. This applet enables you to graphically view the setup 


of your workflows.


You might be having difficulty using applets in Vibe in the following environments:


 Section B.13.1, “Applets Are Not Working on a 64-Bit Operating System,” on page 153
 Section B.13.2, “Applets Are Not Working on Windows with Firefox 3.6 and Later,” on page 154
 Section B.13.3, “Applets Are Not Working on Mac OS with Safari,” on page 154


B.13.1 Applets Are Not Working on a 64-Bit Operating System


Problem:  If you are using a 64-bit operating system with a 64-bit version of Firefox (this is the default 
browser for some Linux 64-bit operating systems), Vibe applets do not work.


You can solve this problem in one of the following ways:


 “Updating to JRE 1.6.0.12 or Later” on page 153
 “Changing Your Browser to a 32-Bit Version of Firefox” on page 153
 “Installing a 64-Bit Java Browser Plug-In and Firefox 3.0 or Higher” on page 153


Updating to JRE 1.6.0.12 or Later


On a 64-bit operating system, updating to JRE 1.6.0.12 or later enables the applets to work.


Changing Your Browser to a 32-Bit Version of Firefox


A simple solution to this problem is to run a 32-bit version of Firefox on your 64-bit operating system.


1 Install a 32-bit version of Firefox.
2 Install the 32-bit Java browser plug-in into the 32-bit version of Firefox that you installed in 


Step 1.
The Vibe applets now work as expected.


Installing a 64-Bit Java Browser Plug-In and Firefox 3.0 or Higher


If you want to keep your 64-bit browser, you can solve the applet problem by installing a 64-bit Java 
browser plug-in, and a version of Firefox greater than 3.0.


1 Download and install a 64-bit Java browser plug-in.
This Java browser plug-in supports only Firefox 3 or higher.


2 Download and install Firefox 3 or higher.
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B.13.2 Applets Are Not Working on Windows with Firefox 3.6 and Later


Problem: After upgrading to Firefox 3.6 or later on a Windows client, Vibe applets no longer work.


To fix this problem:


1 Update your Java client software to Java version 1.6.0_18 or later.


B.13.3 Applets Are Not Working on Mac OS with Safari


Applets do not work with older versions of Mac OS and Safari.


To fix this problem:


1 Upgrade to the latest version of Mac OS and the latest version of Safari.


B.14 Edit-In-Place Applet Is Not Working on Mac
 Section B.14.1, “Edit-in-Place Applet is Not Working with OpenOffice,” on page 154
 Section B.14.2, “Edit-in-Place Applet is Not Working with Microsoft Office,” on page 154


B.14.1 Edit-in-Place Applet is Not Working with OpenOffice


The Edit-in-Place applet might not work if you have installed OpenOffice anywhere other than the 
default location.


To fix this problem:


1 Ensure that OpenOffice is installed at /Applications/OpenOffice.org.app.
If OpenOffice is not installed, you must install it.
If you have installed OpenOffice somewhere other than the default location, you must specify 
this location in the Define Editor Overrides section in Vibe, as described in Section B.10.3, 
“Changing the Default Editor Settings When the Editor is Not Installed in the Default Location,” 
on page 151.


If the problem persists, consult your Vibe administrator. The Vibe administrator can change this 
setting for the entire Vibe site, as described in “Edit in Place Support for Mac Users” in the Novell 
Vibe 3.2 Readme (http://www.novell.com/documentation/vibe32/vibe32_readme_novell/data/
vibe32_readme_novell.html).


B.14.2 Edit-in-Place Applet is Not Working with Microsoft Office


Edit-in-Place functionality is not supported on Mac when you use Microsoft Office as your document 
editor. To use Edit-in-Place functionality on Mac, you must use OpenOffice as your document editor.

154 Novell Vibe 3.2 User Guide



http://www.novell.com/documentation/vibe32/vibe32_readme_novell/data/vibe32_readme_novell.html

http://www.novell.com/documentation/vibe32/vibe32_readme_novell/data/vibe32_readme_novell.html





B.15 Troubleshooting Your Mobile Device
The following sections provide guidance for difficulties you might encounter when accessing Novell 
Vibe from a mobile device:


 Section B.15.1, “Your Browser Does Not Automatically Direct You to the Mobile Interface,” on 
page 155


 Section B.15.2, “You Are Unable to View YouTube Videos from Your Mobile Device,” on 
page 155


 Section B.15.3, “Your BlackBerry Curve Does Not Work with the Mobile Interface,” on page 155


B.15.1 Your Browser Does Not Automatically Direct You to the Mobile 
Interface


Problem: When you access Vibe from your mobile device, the regular Vibe interface is displayed 
rather than the Vibe mobile interface. Because the regular Vibe interface is not optimized for mobile 
devices, this can make accomplishing tasks in Vibe difficult.


Some mobile device browsers do not automatically direct you to the Vibe mobile interface.


You can resolve this problem by manually accessing the Vibe mobile interface from your mobile 
device:


1 Launch a browser on your mobile device.
2 Specify the URL for your Vibe site, followed by /mobile.


For example: http://host/mobile.
The Vibe mobile interface is displayed.


B.15.2 You Are Unable to View YouTube Videos from Your Mobile Device


Problem: You are unable to view YouTube videos when you access Vibe from a mobile device, such 
as a BlackBerry.


If you are unable to view YouTube videos when you access Vibe from your mobile device, your 
device is probably not properly configured. To fix this problem:


1 Launch a Web browser, then navigate to the YouTube mobile interface (http://m.youtube.com).
2 Click the Help link, located near the bottom of the page.
3 Follow the instructions for optimizing YouTube Mobile for your device.


B.15.3 Your BlackBerry Curve Does Not Work with the Mobile Interface


Problem: You cannot get the Vibe mobile interface to function on your BlackBerry Curve.


The BlackBerry Curve has issues with JavaScript, and does not work with the Vibe mobile interface.


To fix this problem, update the browser on your BlackBerry Curve by updating the device software. 
For information on how to do this, see the BlackBerry Web site  (http://docs.blackberry.com/en/) for 
documentation about updating your BlackBerry device software.
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C CAccessibility for People with 
Disabilities


Users with disabilities can use assistive technology such as a screen reader to access pages in Novell 
Vibe. Assistive technology users must adapt to the following Vibe functionality:


 Section C.1, “New Windows Opened without Notification,” on page 157
 Section C.2, “Text Added to a Page Is Not Conveniently Available,” on page 157
 Section C.3, “Drop-Down List Access,” on page 157


C.1 New Windows Opened without Notification
When you click certain areas in Novell Vibe, the Vibe interface opens new windows. However, Vibe 
does not notify the assistive technology user that it is opening a new window. As assistive technology 
users become familiar with Vibe, they identify and remember where new windows are opened.


C.2 Text Added to a Page Is Not Conveniently Available
For some actions, Novell Vibe adds text to a page that is already displayed. However, assistive 
technology software is not able to recognize that new text has been added unless the page is 
refreshed. After the page refreshes, the newly added text is available at the bottom of the page. The 
assistive technology user must move to the bottom of the page and then move backwards up through 
the new content.


C.3 Drop-Down List Access
In fields where you type text and a drop-down list appears, press Enter to move the focus into the list. 
Press Tab to move down through the list, then press Enter to select an item in the list. 
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About This Guide


The Novell Vibe 3.2 Advanced User Guide explains how to use advanced features of the Vibe product.


 Chapter 1, “Are You an Advanced Vibe User?,” on page 11


 Chapter 2, “Creating and Managing Workspaces,” on page 15


 Chapter 3, “Managing Folders,” on page 25


 Chapter 4, “Controlling Access,” on page 43


 Chapter 5, “Branding a Folder or Workspace,” on page 53


 Chapter 6, “Creating and Managing Landing Pages,” on page 55


 Chapter 7, “Creating Custom Workspace Views,” on page 85


 Chapter 8, “Creating Custom Folder Views,” on page 95


 Chapter 9, “Designing Custom Folder Entry Forms,” on page 105


 Chapter 10, “Using Custom JSP Files to Enhance Your Vibe Pages,” on page 117


 Chapter 11, “Creating and Managing Workflows,” on page 121


 Chapter 12, “Managing Remote Applications,” on page 159


 Chapter 13, “Managing Your Data Quota,” on page 167


 Chapter 14, “Restoring Deleted Items,” on page 175


 Chapter 15, “Using Vibe on Your Mobile Phone,” on page 177


 Chapter 16, “Using Novell Vibe with Novell GroupWise,” on page 193


 Appendix A, “What’s New in Vibe 3.x,” on page 195


 Appendix B, “Using HTML Markup in Vibe,” on page 201


Audience


This guide is intended for all new Novell Vibe users who want more information about advanced 
Vibe functionality.


Feedback


We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comments feature at the bottom of each page of the 
online documentation.


Documentation Updates


For the most recent version of this manual, visit the Novell Vibe 3.2 Documentation Web site (http://
www.novell.com/documentation/vibe32). 
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Additional Documentation


You can find more information in the Novell Vibe documentation, which is accessible from the 
Novell Vibe 3.2 Documentation Web site (http://www.novell.com/documentation/vibe32). 


To access the Novell Vibe 3.2 User Guide from within Vibe, click the Help icon (question mark).
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1 1Are You an Advanced Vibe User?


Novell Vibe is an enterprise collaboration tool designed to increase individual productivity, team 
effectiveness, and organizational success by providing the right set of tools to the right people. Key 
Vibe features include Team workspaces, calendars, task lists, document management, discussion 
threads, wikis, blogs, RSS feeds, and workflows.


Vibe enables ordinary users to perform content-management functions. Because all Vibe users need 
to manage a personal workspace, and can also create team workspaces, all users have the potential to 
become “advanced Vibe users.”


Although all Vibe users have the ability to become advanced users, many users never have the need 
to progress beyond the basic Vibe functionality. This is because Vibe lends itself to two main groups: 
content consumers and content providers.


 Section 1.1, “Content Consumers,” on page 11


 Section 1.2, “Content Providers,” on page 11


1.1 Content Consumers
Content consumers use Novell Vibe to get important information that pertains to them. They 
participate in team workspaces in order to better collaborate with colleagues and facilitate their work 
assignments. They identify subject-matter experts and search for important information. 


Content consumers can learn how to accomplish these and other important tasks in the Novell Vibe 3.2 
User Guide


1.2 Content Providers
Content providers use Novell Vibe to manage teams by creating team workspaces and making 
information easily accessible through landing pages and other advanced Vibe features.


Advanced Vibe users might perform any of the following functions:


 Create or manage workspaces and folders: When you create your own workspace or folder, 
you are the owner of that workspace or folder. By default, you are also the owner of all sub-
workspaces and sub-folders.


For example, suppose that your manager assigns you to lead an advertising campaign for a new 
product. Because accomplishing this assignment involves the combined efforts of various 
members of your team, you decide to create a new workspace dedicated to the new campaign.


For in-depth information, see Chapter 2, “Creating and Managing Workspaces,” on page 15 and 
Chapter 3, “Managing Folders,” on page 25.
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 Control user access to workspaces and folders: As the owner of a workspace or folder, you are 
responsible for controlling which users have access rights, and deciding which rights are 
appropriate for which people.


For example, as the advertising campaign manager for a new product, you need to decide if Vibe 
users who are not members of your team are allowed to create entries in your team workspace, 
or whether non-team members should even be allowed to view the workspace.


Also, when new users join the team, it is your responsibility to grant them appropriate rights.


For in-depth information, see Chapter 4, “Controlling Access,” on page 43.


 Create unique brands for workspaces and folders: As the owner of a workspace or folder, you 
are responsible for creating a unique and attractive brand. Creating a unique brand is a good 
way to differentiate your workspace or folder from other places in the Vibe site.


For example, as the advertising campaign manager for a new product, you brand your team 
workspace with a graphic of the product logo, along with the new marketing slogan.


For in-depth information, see Chapter 5, “Branding a Folder or Workspace,” on page 53.


 Create landing pages: As the owner of a workspace, you can present the most important 
information on the home page of the workspace. At the same time, you can change the look and 
feel of the home page. (You can create landing pages in personal workspaces only if your Vibe 
administrator has enabled this functionality.)


For example, as the advertising campaign manager for a new product, you create a landing page 
in the team workspace. In the landing page you display the current product shipment schedule, 
the latest news concerning the product, open tasks as they relate to your team members, and so 
forth.


For in-depth information, see Chapter 6, “Creating and Managing Landing Pages,” on page 55.


 Create custom workspace and folder views: As the owner of a workspace or folder, you can 
create custom views that modify what is displayed on the home page of your workspace or 
folder. You can display uploaded files, remote applications, pictures, and more.


For example, as the advertising campaign manager for a new product, you can customize the 
home page of your team workspace to display pictures of the various marketing logo options for 
the product, as well as uploaded notes from team meetings.


For in-depth information, see Chapter 7, “Creating Custom Workspace Views,” on page 85 and 
Chapter 8, “Creating Custom Folder Views,” on page 95.


 Create custom folder entry forms: As the owner of a workspace or folder, you can create 
custom folder entry forms that users can fill in when they are making entries in the workspace or 
folder. 


For example, as the advertising campaign manager for a new product, you decide to create a 
new folder called “Slogans.” Inside this folder, you create a new entry form that enables team 
members to easily submit their ideas for catchy slogans for the new product. The entry form 
contains a field for the team member to type his or her name, a field where they can type the 
slogan, a field where they can upload pertinent pictures, and so on.


For in-depth information, see Chapter 9, “Designing Custom Folder Entry Forms,” on page 105.


 Create and manage workflows: As the owner of a workspace or folder, you can create 
workflows that automate otherwise time-consuming manual processes.


For example, as the advertising campaign manager for a new product, you notice that expense 
reporting is taking more time than you want. The current process is for members of your team to 
request an expense reimbursement from you, then for you to send the request to HR, who then 
transfers the request to Finance. To automate this process, you implement a workflow that sends 
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you an e-mail notification requesting your approval when the request is submitted. When you 
give your approval, the workflow is automatically transferred to HR. If HR approves the 
request, then the workflow is transferred to Finance, where the reimbursement is addressed.


For in-depth information, see Chapter 11, “Creating and Managing Workflows,” on page 121.


 Manage remote applications: As the owner of a workspace or folder, you can enable remote 
applications that have been set up by your Vibe administrator.


For in-depth information, see Chapter 12, “Managing Remote Applications,” on page 159.
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2 2Creating and Managing Workspaces


Novell Vibe enables you to create and manage your workspaces in the following ways:


 Section 2.1, “Creating and Managing a Team Workspace,” on page 15


 Section 2.2, “Creating and Managing a Discussions Workspace,” on page 16


 Section 2.3, “Creating and Managing a Basic Workspace,” on page 17


 Section 2.4, “Creating and Managing a Project Management Workspace,” on page 18


 Section 2.5, “Creating and Managing a Team Workspace Root Workspace,” on page 20


 Section 2.6, “Using Global Workspaces,” on page 21


 Section 2.7, “Creating Workspace Hierarchies,” on page 21


 Section 2.8, “Creating Custom Workspace Views,” on page 23


 Section 2.9, “Setting a Maximum Number of File Versions,” on page 23


 Section 2.10, “Setting a File Upload Size Limit,” on page 23


 Section 2.11, “General Workspace Management,” on page 23


2.1 Creating and Managing a Team Workspace
Team workspaces are the key to helping you and your team accomplish tasks and meet objectives, 
together.


As the owner of a workspace, you are primarily responsible for workspace administration. You can 
create other containers for information (sub-workspaces and folders), adjust access control to 
determine who can do what in the workspace, and provide some initial content to assist team 
members with getting started.


For information about how to perform basic management tasks on a team workspace, such as 
creating the workspace, adding team members, and sending e-mail to team members, see “Managing 
a Team Workspace” in the Novell Vibe 3.2 User Guide.


 Section 2.1.1, “Allowing Visitors to Your Team Workspace,” on page 16


 Section 2.1.2, “Using Team Workspaces to Create Hierarchies,” on page 16
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2.1.1 Allowing Visitors to Your Team Workspace


By default, only team members can view and participate in the workspaces and folders contained in 
the team workspace. There might be times when you want to allow other people to visit your team 
workspace (which, by default, means that they can read entries and comment on them, but they 
cannot create entries).


To allow visitors to your team workspace:


1 Navigate to the team workspace where you want to allow visitors.


2 Click Workspace > Access Control.


Novell Vibe displays the Configure Access Control page for the team workspace.


3 Ensure that the workspace is not inheriting its access control settings. Select the no radio button, 
then click Apply.


4 (Conditional) If Visitor is not already a column in the provided table, click Add a Role > Visitor:


5 On the left side of the table, click Add a User, then use the type-to-find functionality to select the 
name of the person you want to add as a visitor to the team workspace.


6 In that new user’s row, select the check box in the Visitor column.


7 Repeat Step 5 and Step 6 until you have added all your visitors.


8 Click Save Changes > Close.


The people who now have the Visitor role can view your team workspace and add comments to 
existing entries. They cannot create new entries.


For more information on managing access control, see Section 4.2, “Managing Access Control for 
Users and Groups,” on page 46.


2.1.2 Using Team Workspaces to Create Hierarchies


Team workspaces in Vibe can be used to organize information inside of existing workspaces, creating 
different levels of hierarchy within a workspace. 


You can also use other types of workspaces to create hierarchies. For information explaining the 
advantages and disadvantages of using each type of workspace, see Section 2.7, “Creating Workspace 
Hierarchies,” on page 21.


2.2 Creating and Managing a Discussions Workspace
The Discussions workspace can be the home page for a set of discussion forums. You can also use the 
Discussions workspace to house other types of folders. 


Discussions workspaces can be particularly useful for site administrators, or other Novell Vibe users 
who are responsible for creating the overall structure of the Vibe site. For example, you can use a 
Discussions workspace to organize a set of company-wide discussions on various topics. This can 
help organize your Vibe site, so users know where they should go if they are looking for a particular 
discussion forum.


 Section 2.2.1, “Creating a Discussions Workspace,” on page 17


 Section 2.2.2, “Using Discussions Workspaces to Create Hierarchies,” on page 17
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2.2.1 Creating a Discussions Workspace


1 Navigate to the place in Vibe where you want to create the Discussions workspace. 


Depending on your rights, you might create this workspace at the Global level, if you are 
creating a company-wide Discussions workspace; or you might create this workspace in a lower-
level workspace, if the Discussions workspace is intended for a smaller number of Vibe users.


2 Click Workspace > New Workspace in the Action toolbar.


The New Workspace page is displayed.


3 In the Workspace Title field, specify a name for the Discussions workspace.


4 In the Workspace section, select Discussions Workspace.


5 In the Workspace Folders section, select Discussion.


You can add additional Discussion folders after the workspace has been created.


6 Click OK.


2.2.2 Using Discussions Workspaces to Create Hierarchies


Discussions workspaces in Novell Vibe can be used to organize information inside of existing 
workspaces, creating different levels of hierarchy within a workspace. 


You can also use other types of workspaces to create hierarchies. For information explaining the 
advantages and disadvantages of using each type of workspace, see Section 2.7, “Creating Workspace 
Hierarchies,” on page 21.


2.3 Creating and Managing a Basic Workspace
Basic workspaces in Novell Vibe can be used to organize information inside of existing workspaces, 
creating different levels of hierarchy within a workspace. 


You can also use other types of workspaces to create hierarchies. For information explaining the 
advantages and disadvantages of using each type of workspace, see Section 2.7, “Creating Workspace 
Hierarchies,” on page 21.


To create a basic workspace:


1 Navigate to the place in Vibe where you want to create the basic workspace. 


2 Click Workspace > New Workspace in the Action toolbar.


The New Workspace page is displayed.


3 In the Workspace Title field, specify a name for the basic workspace.


4 In the Workspace section, select Workspace.


5 In the Workspace Folders section, select the folders that you want the new workspace to contain.


You can add additional folders after the workspace has been created.


6 Click OK.
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2.4 Creating and Managing a Project Management Workspace
Project Management workspaces include special accessories that help leaders track the progress of 
task completion for potentially large projects. Although Project Management workspaces can contain 
any type of folder, they are specifically designed to work in conjunction with Tasks and Milestones 
folders.


 Section 2.4.1, “Creating a Project Management Workspace,” on page 18


 Section 2.4.2, “Managing a Project Management Workspace,” on page 18


 Section 2.4.3, “Understanding Tasks and Milestones,” on page 19


2.4.1 Creating a Project Management Workspace


1 Navigate to the place in Novell Vibe where you want to create the Project Management 
Workspace.


2 Click Workspace > New Workspace in the Action toolbar.


The New Workspace page is displayed.


3 In the Workspace Title field, specify a name for the Project Management workspace.


4 In the Workspace section, select Project Management Workspace.


5 Click OK.


2.4.2 Managing a Project Management Workspace


After you create the Project Management workspace, notice that the workspace contains key folders, 
such as a Tasks folder, Milestones folder, Files folder, and so forth.


The home page of the Project Management workspace provides the following features that enable 
you to better manage your project:


Task Summary Accessory: This accessory lists all of the tasks that exist in the Tasks folder of your 
Project Management workspace.


To modify the information in this accessory, navigate to the Tasks folder of this Project Management 
workspace. For information about Tasks folders, see “Working with Tasks Folders” in the Novell Vibe 
3.2 User Guide.


Project Information Box: Displays the Status, Manager, and Due Date of the project.


To modify this information:


1 Click Workspace > Edit Workspace in the Action toolbar.


2 In the Project Information Box section, modify the Manager, Status, and Due Date fields as needed.


3 Click OK.


Project Statistics: Displays the current task and milestone statistics that are associated with the 
project.
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2.4.3 Understanding Tasks and Milestones


Because tasks and milestones contribute important information to your Project Management 
workspace, it is important that you understand how they work.


 “Understanding Tasks” on page 19


 “Understanding Milestones” on page 19


Understanding Tasks


Tasks folders keep track of the progress made in completing work assignments. For information 
about Tasks folders, see “Working with Tasks Folders” in the Novell Vibe 3.2 User Guide.


Understanding Milestones


The Milestones folder contains the various milestones for a project. Each milestone entry has specific 
Tasks folders that are associated with the milestone. When all of the tasks in the Tasks folders are 
complete, you can mark the milestone that is associated with those tasks as completed.


 “Creating a Milestone” on page 19


 “Using the Milestones Folder” on page 20


 “Modifying a Milestone” on page 20


Creating a Milestone


1 Navigate to the Milestones folder in your Project Management workspace.


2 Click Add Milestone.


The Milestone page is displayed.


3 Specify the following information:


Title: Provide a title for the milestone.


Description: Describe the milestone.


Due Date: Specify when the milestone is due.


Responsible: Specify the users who are responsible for completing the milestone.


Responsible Groups: Specify the groups who are responsible for completing the milestone.


Responsible Teams: Specify the teams who are responsible for completing the milestone.


Send an E-Mail Notification to Responsibles: Select this option if you want Vibe to send an e-
mail notification and iCal task/appointment to all of the users, groups, or teams that you 
associate with the entry.


For more information on iCal functionality in Vibe, see “Synchronizing Tasks and Calendars to a 
Desktop Application” in the Novell Vibe 3.2 User Guide.


Status: Use the drop-down list to specify a status for the milestone (Open, Reopen, Completed).


Task Folders: Use the tree to navigate to and select the Tasks folders that you want to associate 
with the milestone.


The tasks in these Tasks folders must be completed before the milestone can be marked as 
Completed.


Attachments: Attach any appropriate files.
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Subscribe to This Entry: You can configure Vibe to send you notifications when activity takes 
place in this entry. For more information, see “Subscribing to a Folder or Entry” in the Novell Vibe 
3.2 User Guide.


Send E-Mail When Entry is Submitted: To ensure that certain co-workers are aware of your 
entry, you can send them an e-mail directly from Vibe, notifying them that an entry has been 
created. For more information, see “Filling Out the Send E-Mail Page” in the Novell Vibe 3.2 User 
Guide.


Using the Milestones Folder


The Milestones folder contains the following columns that contain information about each milestone:


Name: Displays the name of the milestone.


Responsible: Displays the people who are responsible for the milestone.


Tasks: Displays the Tasks folders that are associated with the milestone.


Mouse over the colors in the bar chart, and Vibe explains the value (needs action, in process, 
completed).


Status: Displays the status of the milestone.


Due date: Displays the due date of the milestone.


Modifying a Milestone


1 In the Milestones folder, click the milestone name in the Name column.


The milestone entry is displayed.


2 In the Entry toolbar, click Modify.


The Milestone page is displayed.


3 Make any modifications, then click OK.


You might need to refresh the page for your changes to be displayed.


2.5 Creating and Managing a Team Workspace Root Workspace
A Team Workspace Root workspace is designed to contain multiple team workspaces. Use this type 
of workspace if you want to create additional team workspaces as sub-workspaces to this workspace. 
When users with appropriate rights view this workspace, they can easily create a new team 
workspace by clicking the Add a Team Workspace button, as described in “Creating a Highly Visible 
Team Workspace” in the Novell Vibe 3.2 User Guide. The Add a Team Workspace button is not displayed 
in regular team workspaces. 


You can control who has access to create workspaces in Team Workspace Root workspaces by 
modifying the access controls, as described in Chapter 4, “Controlling Access,” on page 43.


For more information on organizing team workspaces for a Novell Vibe site, see “Organizing Team 
Workspaces” in the  Novell Vibe 3.2 Administration Guide.
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To create a Team Workspace Root workspace:


1 Navigate to the location where you want to create the Team Workspace Root workspace.


2 Create a regular team workspace, as described in “Creating a Team Workspace inside of an 
Existing Team Workspace” in the Novell Vibe 3.2 User Guide.


3 Navigate to the workspace that you just created in Step 2.


4 Click Workspace > Configure Views, URLs and Controls in the Action toolbar.


5 On the Configure Workspace View tab, in the Default View section, select Team Workspace Root.


6 Click Apply > Close.


2.6 Using Global Workspaces
Global workspaces contain information beyond the scope of teamwork that might be of interest 
broadly across your organization.


Global workspaces can be created only by Novell Vibe administrators. For more information on 
Global workspaces, see “Creating Global Workspaces” in the  Novell Vibe 3.2 Administration Guide.


2.7 Creating Workspace Hierarchies
Creating hierarchies in Novell Vibe is a powerful way to organize workspaces in a meaningful way. 
Hierarchies can make information easier to find and increase effectiveness across the Vibe site.


Vibe provides three types of workspaces that you can use to create hierarchies within existing 
workspaces. Each type of workspace has its advantages and disadvantages for creating workspace 
hierarchies. Depending on your objectives and your environment, you might want to use any of the 
following types of workspaces:


 Section 2.7.1, “Discussions Workspaces,” on page 21


 Section 2.7.2, “Basic Workspaces,” on page 22


 Section 2.7.3, “Team Workspaces,” on page 22


2.7.1 Discussions Workspaces


If you don’t anticipate your workspace having hundreds or thousands of sub-folders, Discussions 
workspaces are recommended over basic workspaces and team workspaces.


The following sections describe the advantages and disadvantages of using a Discussions workspace 
to create hierarchies within existing workspaces:


 “Advantages” on page 21


 “Disadvantages” on page 22


Advantages


 Retains the access control rights of higher-level (parent) workspaces by default


 Lists sub-folders and sub-workspaces on the workspace home page (and displays how many 
items are in each folder)
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Disadvantages


 Does not scale well (if you have hundreds or thousands of sub-folders, you should use a basic 
workspace to improve performance)


2.7.2 Basic Workspaces


The following sections describe the advantages and disadvantages of using a basic workspace to 
create hierarchies within existing workspaces:


 “Advantages” on page 22


 “Disadvantages” on page 22


Advantages


 Retains the access control rights of higher-level (parent) workspaces by default


 Scales well (because basic workspaces do not list sub-folders and sub-workspaces on the 
workspace home page)


Disadvantages


 Does not list sub-folders and sub-workspaces on the workspace home page


2.7.3 Team Workspaces


The following sections describe the advantages and disadvantages of using a Team workspace to 
create hierarchies within existing workspaces:


 “Advantages” on page 22


 “Disadvantages” on page 22


Advantages


 Lists sub-folders and sub-workspaces on the workspace home page (and displays how many 
items are in each folder)


Disadvantages


 Does not retain the access control rights of higher-level (parent) workspaces by default


 Does not scale well (if you have hundreds or thousands of sub-folders, you should use a basic 
workspace to improve performance)
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2.8 Creating Custom Workspace Views
Novell Vibe enables you to create custom workspace views. Workspace views define what is 
displayed on the main page of your workspace. When you create custom workspace views, you can 
configure workspaces to display optional features such as remote applications, attachments, and 
more.


For information on how to create custom workspace views, see Chapter 7, “Creating Custom 
Workspace Views,” on page 85.


2.9 Setting a Maximum Number of File Versions
You can configure folders and workspaces to allow only a certain number of versions for each file 
within the folder or workspace. For more information, see Section 3.4.1, “Automatically Deleting 
Minor File Versions That Exceed the Allowed Maximum,” on page 31.


2.10 Setting a File Upload Size Limit
You can set a limit on the size of files users can upload to your workspaces and folders. For more 
information, see Section 3.5, “Limiting the File Upload Size for Folders and Workspaces,” on page 33.


2.11 General Workspace Management
If you have appropriate rights, you can perform various types of management functions on a 
workspace, such as copying the workspace to another location, moving the workspace, adding 
folders to the workspace, deleting the workspace, and so forth.


For information on how to perform these and other types of management tasks, see “General 
Workspace Management” in the Novell Vibe 3.2 User Guide.
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3 3Managing Folders


Novell Vibe enables you to manage your folders in the following ways:


 Section 3.1, “Managing Folder Views,” on page 25


 Section 3.2, “Working with Folder Entry Types,” on page 26


 Section 3.3, “Enabling Folders to Receive Entries through E-Mail,” on page 29


 Section 3.4, “Limiting File Versions for Folders and Workspaces by Configuring Automatic 
Deletion,” on page 31


 Section 3.5, “Limiting the File Upload Size for Folders and Workspaces,” on page 33


 Section 3.6, “Setting Up a Folder or External E-Mail Address to Receive All Sent E-Mail 
Messages,” on page 33


 Section 3.7, “Configuring Folders to Send E-Mail Notifications to Other Users,” on page 34


 Section 3.8, “Working with Mirrored Folders,” on page 35


 Section 3.9, “Setting Up and Using WebDAV,” on page 38


 Section 3.10, “Viewing Vibe Folders as RSS or Atom Feeds,” on page 41


 Section 3.11, “Applying Landing Page Elements to a Folder,” on page 41


3.1 Managing Folder Views
Novell Vibe enables you to change the way you and other users view your folder. You can change the 
default view, or allow multiple views. 


For example, you might have a Tasks folder where the start date and end date are particularly 
important. You can configure your Tasks folder to be displayed in a Calendar folder view to place 
emphasis on the start and end dates of tasks. You can make this view the default view, or allow users 
to toggle between alternate folder views that you pre-enable.


 Section 3.1.1, “Changing the Default Folder View,” on page 25


 Section 3.1.2, “Enabling Alternate Folder Views,” on page 26


3.1.1 Changing the Default Folder View


Vibe enables you to change the default view of folders for which you have appropriate rights. This 
can be an existing folder view or a custom folder view that you created. For information about how to 
create a custom folder view, see Chapter 8, “Creating Custom Folder Views,” on page 95.


 “Enabling Views to Be Used as the Default View” on page 26


 “Selecting a New Default Folder View” on page 26
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Enabling Views to Be Used as the Default View


Before you can set a view as the default folder view, you need to enable that view


1 Navigate to the folder where you want to change the default view.


2 Click Folder > Configure Views, URLs and Controls in the Action toolbar.


3 On the Folder Views, Entries and Workflows tab, in the Allowed Views section, select the view whose 
look best presents your folder list or workspace.


4 Click Apply.


The folder view has now been added to the Default View section, and can be chosen as the default 
view, as described in “Selecting a New Default Folder View” on page 26.


Selecting a New Default Folder View


1 On the Folder Views, Entries and Workflows tab, in the Default View section, select the folder view 
that you enabled in “Enabling Views to Be Used as the Default View” on page 26.


2 Click Apply > Close.


3.1.2 Enabling Alternate Folder Views


Because only folder owners have rights to set the default view of a folder, Vibe enables folder owners 
to select alternate views that external users of the folder are allowed to use, if they are not satisfied 
with the default view, or feel more comfortable using another view.


1 Navigate to the folder where you want to enable alternate views.


2 Click Folder > Configure Views, URLs and Controls in the Action toolbar.


3 On the Folder Views, Entries and Workflows tab, in the Allowed Views section, select all of the views 
that you want to enable as alternate folder views.


4 Click Apply > Close.


Users can now view the folder in an alternate view.


1 Click Folder > Folder Options in the Action toolbar.


The Folder Options dialog box is displayed.


2 In the View Options section, select the desired alternate view, then click OK.


3.2 Working with Folder Entry Types
 Section 3.2.1, “Enabling Alternate Folder Entry Types,” on page 27


 Section 3.2.2, “Changing the Entry Type for Entries in a Folder,” on page 27


 Section 3.2.3, “Changing the View Definitions for Existing Folders and Folder Entries,” on 
page 28
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3.2.1 Enabling Alternate Folder Entry Types


You can select the types of entries that you want to allow users to create in a certain folder. You can 
configure your folder to allow alternate entry types, or you can change the current default entry type. 
If you enable multiple entry types, users who submit entries into this folder can choose which type of 
entry they want to add, such as a task entry, calendar entry, and so forth.


1 Navigate to the folder where you want to enable alternate entry types.


2 Click Folder > Configure Views, URLs and Controls in the Action toolbar.


3 On the Folder Views, Entries and Workflows tab, in the Default Entry Types section, select the entry 
types that you want to allow users to create in the folder.


4 Click Apply > Close.


If you enable additional entry types, users who submit entries into this folder can click New in the 
Folder Entry toolbar, then use the drop-down list to choose the type of entry they want to add, 
depending on which types of entries you enabled on the folder.


Site administrators and folder owners can use the Form and View Designers functionality to create 
new entry types (custom forms), which then appear in this list. (When folder owners create new 
entry types, those entry types are listed in the Local Definitions section of this list.)


For more information on how to create custom entry types, see Chapter 9, “Designing Custom Folder 
Entry Forms,” on page 105.


3.2.2 Changing the Entry Type for Entries in a Folder


You can change an entry from one type to another type. For example, suppose you are using a 
Discussion entry to discuss the new marketing logo for a product. The discussion results in an action 
item for you to refine the look of the new logo. You can then change the Discussion entry to a Task 
entry for you to keep track of this new action item.


You can change the entry type for a single entry or for every entry of a certain type in a folder.  


If the new entry type that you choose contains elements that were not in the original entry type, the 
new elements are displayed as blank in existing entries. If the new entry type that you choose doesn’t 
have elements that did exist in the original entry type, any information that was in those elements is 
removed from the entries. However, the information is not deleted, and is reinstated if the entry is 
changed back to the original entry type.


 “Changing the Entry Type for All Entries In a Folder” on page 27


 “Changing the Entry Type for a Single Entry” on page 28


Changing the Entry Type for All Entries In a Folder


You can simultaneously change the entry type for all entries of a certain type in a given folder. 
Changing the entry type for entries as described in this section changes the entry form that is used 
when creating an entry.


1 Navigate to the folder that contains the entries that you want to change.


2 Click Folder > Configure Views, URLs and Controls.


3 Click the Entry Type tab.
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4 In the Entry Type To Be Changed drop-down list, select the current entry type for entries in the 
folder that you want to change to a different entry type.


5 In the New Entry Type drop-down list, select the new entry type that you want to convert the 
entries to.


6 Click OK, then click OK again to confirm.


Changing the Entry Type for a Single Entry


1 Navigate to and open the entry that you want to change.


2 Click Actions > Change Entry Type.


3 In the New Entry Type drop-down list, select the entry type for the entry.


4 Click OK.


3.2.3 Changing the View Definitions for Existing Folders and Folder Entries


View definitions affect how a folder or entry is displayed. You can simultaneously change the 
definitions for folders and folder entries that have already been created. You can change all sub-
folders to match the parent folder, and you can change all entries within a given folder to be of a 
specific entry type.


This feature must first be enabled by your Novell Vibe administrator. If it is not enabled, it is not 
visible. For information on how to enable this feature, see “Enabling Folder Administrators to Apply 
Definition Settings to Sub-Folders and Entries” in the  Novell Vibe 3.2 Administration Guide.


 “Applying Definition Settings to All Sub-Folders” on page 28


 “Applying Definition Settings to Existing Entries” on page 28


Applying Definition Settings to All Sub-Folders


You can apply the folder definition settings of a parent folder to all sub-folders. For example, if you 
have a Discussions folder that contains sub-folders, but not all of the sub-folders are Discussions 
folders, you can simultaneously convert all the sub-folders to be displayed as Discussions folders.


1 Navigate to the folder where you want to apply entry definition types to folders or entries that 
have already been created.


2 Click Folder > Configure Views, URLs and Controls in the Action toolbar.


3 On the Folder Views, Entries and Workflows tab, in the Recursively apply section, select Change 
contained folders to inherit this folder’s definitions.


4 Click Apply > Close.


All definition settings on the Folder Views, Entries and Workflows tab are applied to all sub-folders.


Applying Definition Settings to Existing Entries


You can convert all the entries that are contained within a specific folder to be of a single entry type. 
For example, a user might begin a discussion entry in a Discussion folder, then move the entry to the 
Tasks folder after it is decided that something needs to be done in order to resolve the discussion. 
After the discussion entry is added to the Tasks folder, the entry can be converted to a task entry.
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IMPORTANT: Changing entry definition settings as described in this section changes all entries 
within the folder and all sub-folders to be the same entry type. You should not perform the steps in 
this section if you want your folder and sub-folders to contain multiple types of folder entries, as 
described in Section 3.2.1, “Enabling Alternate Folder Entry Types,” on page 27.


To make all folder entries the same within a specific folder:


1 Navigate to the folder where you want to apply entry definition types to folders or entries that 
have already been created.


2 Click Folder > Configure Views, URLs and Controls in the action toolbar.


3 On the Folder Views, Entries and Workflows tab, in the Recursively apply section, select Change 
contained folders to inherit this folder’s definitions, then select Change contained entries to be of the 
following entry type.


4 In the drop-down list, select the entry type that you want to apply to all existing entries in the 
folder.


To add entry types to this drop-down list, select the entry types in the Default Entry Types section, 
then click Apply.


5 Click Apply > Close.


3.3 Enabling Folders to Receive Entries through E-Mail
Novell Vibe enables you to e-mail entries into folders. This is useful if you don’t have access to the 
Vibe site and still want to create an entry. You can also send text messages into folders, so you can still 
capture thoughts and contribute to conversations when you don’t have access to a computer or the 
Internet.


To enable folders to receive entries via e-mail, complete the following sections:


 Section 3.3.1, “Enabling and Configuring the Inbound E-Mail Server,” on page 29


 Section 3.3.2, “Enabling Incoming E-Mail for the Vibe Site,” on page 29


 Section 3.3.3, “Enabling E-Mail Posting with a Simple URL,” on page 30


 Section 3.3.4, “Defining Who Has Access to E-Mail Entries,” on page 30


3.3.1 Enabling and Configuring the Inbound E-Mail Server


The Vibe administrator should have enabled and configured the inbound e-mail server during the 
Vibe installation, as described in “Enabling Inbound E-Mail” in the Novell Vibe 3.2 Installation Guide. 


For information about enabling and configuring inbound e-mail after the Vibe installation, see 
“Reconfiguring the Vibe Site” in the  Novell Vibe 3.2 Administration Guide.


3.3.2 Enabling Incoming E-Mail for the Vibe Site


For folders to be able to receive entries via e-mail, Vibe administrators need to enable the Vibe site to 
allow incoming e-mail.


For information on how to enable Vibe to allow incoming e-mail, see “Disabling/Enabling Inbound E-
Mail Postings” in the  Novell Vibe 3.2 Administration Guide.
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3.3.3 Enabling E-Mail Posting with a Simple URL


When you define a simple URL for a folder, Vibe creates a URL that enables you to quickly navigate 
to the folder, and also creates a corresponding e-mail address that users of the folder can e-mail to.


1 Navigate to the folder where you want to define the URL.


2 Click Folder > Configure Views, URLs and Controls in the Action toolbar.


3 Click the Simple URLs and E-mail Addresses tab.  


4 In the Define a simple URL for this folder or workspace section, specify the URL that you want to use 
to reference the folder.


5 Click Add.


6 Select Allow e-mail posts to this folder via the following addresses.


7 Click Apply, then click Close.


You can now make entries to the folder by e-mail or by text-messaging your entry to the e-mail 
address that you created, as described in “Adding Entries to a Folder Via E-Mail” in the Novell Vibe 
3.2 User Guide.


3.3.4 Defining Who Has Access to E-Mail Entries


By default, only users with rights to create entries in a particular folder can e-mail entries into that 
folder.


Vibe enables you to view who has rights to create entries in a folder, grant rights to other Vibe users, 
or configure the folder to allow all users to create entries by e-mailing into it.


 “Viewing Who Has Rights” on page 30


 “Granting Rights to Other Vibe Users” on page 30


 “Setting Up a Folder That All Users Can Send E-Mail To” on page 31


Viewing Who Has Rights


1 Navigate to the folder where you want to view who currently has rights to create entries in the 
folder.


2 Click View > Who Has Access in the Action toolbar.


3 In the provided table, the Create Entries section lists all of the users who have rights to create 
entries in the folder.


These are the users who have rights to e-mail entries into the folder.


Granting Rights to Other Vibe Users


You can grant other Vibe users rights to create entries in a folder.


For information on how to change access control settings in a folder, see Section 4.2.1, “Controlling 
Access to Workspaces and Folders,” on page 46.

30 Novell Vibe 3.2 Advanced User Guide







Setting Up a Folder That All Users Can Send E-Mail To


You can enable your Vibe folder to receive e-mail entries from all users, regardless of whether they 
have access to create entries in the folder or not.


This enables e-mail entries to be submitted by anybody, inside or outside of the Vibe system. If you 
are worried about receiving spam messages in your folder, do not set up your folder to accept e-mail 
entries in the way described in this section.


1 Navigate to the folder where you want to enable all users to create entries via e-mail.


2 Click Folder > Access Control in the Action toolbar.


3 Ensure that No is selected in the Inherit Role Membership section, then click Apply.


4 In the table, click Add a User.


5 In the provided field, use the type-to-find functionality and specify E-mail Posting Agent.


6 In the E-mail Posting Agent row, select the check box in the Participant column.


7 Click Save Changes > Close.


Now all users can create entries in this folder via e-mail, using the e-mail address that you 
created in Section 3.3.3, “Enabling E-Mail Posting with a Simple URL,” on page 30.


3.4 Limiting File Versions for Folders and Workspaces by 
Configuring Automatic Deletion
Because a significant amount of data can be consumed by old versions of files, you can set file version 
restrictions for workspaces and folders that you own. You might want to do this if the Vibe 
administrator has set a data quota on workspaces and folders throughout the Vibe site, or if you 
simply want to limit the amount of clutter in your folders and workspaces. 


You can configure folders and workspaces to automatically delete minor file versions that exceed the 
maximum number that you set for each file, and you can configure folders to automatically delete 
minor file versions after a specified number of days. Major file versions are never automatically 
deleted.


 Section 3.4.1, “Automatically Deleting Minor File Versions That Exceed the Allowed Maximum,” 
on page 31


 Section 3.4.2, “Automatically Deleting Minor File Versions After a Specified Number of Days,” 
on page 32


3.4.1 Automatically Deleting Minor File Versions That Exceed the Allowed 
Maximum


You can configure folders and workspaces to allow only a certain number of file versions for each file 
version set within the folder or workspace. (A file version set includes the major file version and all 
minor file versions. For more information about major and minor file versions, see “Incrementing the 
Major Version Number of a File” in “Working with Files in a Folder Entry” in the Novell Vibe 3.2 User 
Guide.) 


After the maximum number of versions is reached and a new minor version is created in the file 
version set, the oldest minor version is automatically deleted and cannot be recovered.
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Major versions are never deleted, so if there is a minor version that you want to keep from being 
deleted, you can increment it to a major version, as described in “Incrementing the Major Version 
Number of a File” in “Working with Files in a Folder Entry” in the Novell Vibe 3.2 User Guide.


This setting is inherited by all sub-folders, so any sub-folders are also restricted to the maximum 
number that you set. For example, if you specify a maximum version number of 5 in Folder A, Sub-
Folder B also has a maximum version number of 5. This means that each file in the folder can have a 
maximum of 5 versions associated with it.


The maximum number that you set includes the major file version as well as any minor file versions. 
For example, if you set the maximum version number to be 5, each file version set can have one major 
file version and four minor file versions.


To configure a folder or workspace to have a maximum number of allowed file versions:


1 Navigate to the folder or workspace where you want to set the maximum number of allowed file 
versions.


2 Click Folder > Configure Views, URLs and Controls if you are setting the number on a folder.


or


Click Workspace > Configure Views, URLs and Controls if you are setting the number on a 
workspace.


3 Click the Versioning and Folder Settings tab.


4 Select Enable File Versions if it is not already selected, then specify the maximum number of 
allowed versions in the Maximum Versions field.


5 (Conditional) If the text (Inherited) appears next to the Maximum Versions field, click Stop 
Inheriting from Parent. This configures the folder or workspace to not inherit this setting from a 
higher-level folder or workspace.


6 Click OK.


3.4.2 Automatically Deleting Minor File Versions After a Specified Number of 
Days


You can configure all minor versions of each file to be automatically deleted after a specified number 
of days (major versions are never deleted). When you configure a folder in this way, all versions of 
the document that are not a major version are deleted after the specified number of days. (For more 
information about major and minor versioning, see “Incrementing the Major Version Number of a 
File” in “Working with Files in a Folder Entry” in the Novell Vibe 3.2 User Guide.)


The setting to automatically delete old versions is not inherited by sub-folders; it must be configured 
individually for each folder. Because of this, you can enable this feature only on individual folders, 
and not on the parent workspace. If the Vibe administrator has configured file versions throughout 
the Vibe site to be automatically deleted after a certain number of days, you can either disable the 
automatic deletion or specify a new day limit for each folder.


1 Navigate to the folder where you want to specify the number of days to wait before the excess 
versions are deleted.


2 Click Folder > Configure Views, URLs and Controls.


3 Click the Versioning and Folder Settings tab.


4 Select Enable Version Aging, then specify the number of days in the Delete Old Versions after field.


5 Click OK.
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3.5 Limiting the File Upload Size for Folders and Workspaces
The file upload size limit conserves disk space in your folders and workspaces because it prevents 
users from uploading large files. The default size limit for uploading files into your Vibe site is 2 GB. 
This limit can be increased or decreased by your Vibe administrator. You can change the limit for the 
workspaces and folders that you are the owner of, but you cannot make the limit greater than what is 
set by your Vibe administrator.


This setting is inherited by all sub-folders, so any sub-folders are also restricted to the size limit that 
you set. 


1 Navigate to the folder or workspace where you want to set a limit on the size of files that can be 
uploaded.


2 Click Folder > Configure Views, URLs and Controls if you are setting the limit on a folder.


or


Click Workspace > Configure Views, URLs and Controls if you are setting the limit on a workspace.


3 Click the Versioning and Folder Settings tab.


4 In the File Size Limit section, specify the limit in the Maximum Size field.


5 Click OK.


3.6 Setting Up a Folder or External E-Mail Address to Receive 
All Sent E-Mail Messages
Like a personal e-mail Outbox for the Vibe site, you can configure a folder or any e-mail address to 
receive all e-mail messages that you personally send from the Vibe site. This can help you better track 
your activity.


Vibe administrators might need to enable this functionality, as described in “Enabling Users to 
Configure a Folder or External E-Mail Address to Receive Sent E-Mails” in “Managing E-Mail 
Configuration” in the  Novell Vibe 3.2 Administration Guide.


Actions that cause e-mail messages to be sent from the Vibe site and to be saved in the Vibe folder 
that you designate are:


 Using the E-Mail Team and E-Mail Contributors options, as described in “Informing Others about 
a Folder or Workspace” in the Novell Vibe 3.2 User Guide.


 Using the Share this Entry option, as described in “Sharing an Entry” in the Novell Vibe 3.2 User 
Guide.


 Using the Send E-Mail When Entry is Submitted option, as described in the “Sending an E-Mail 
about an Entry” in the Novell Vibe 3.2 User Guide.


 Filling in the Announcement field when creating or editing a team workspace, as described in 
“Creating a New Workspace” and “Sending E-Mail to Team Members and Announcing the 
Workspace after Its Creation” in the in the Novell Vibe 3.2 User Guide.


NOTE: Certain types of e-mail messages that do not require you to personally add text, such as 
setting digest notifications or workflow notifications, are not saved to the folder that you designate.
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To set up a folder or external e-mail address to receive all e-mail messages that you send from the 
Vibe site:


1 Create a new folder in the workspace where you want the folder to reside.


For information on how to create a folder, see “Creating a New Folder” in the Novell Vibe 3.2 User 
Guide.


2 Define a simple URL for the folder, and allow e-mails to be sent to the folder.


For information on how to define a URL for a folder and allow e-mailing into it, see Section 3.3.3, 
“Enabling E-Mail Posting with a Simple URL,” on page 30.


3 Navigate to your user profile page by clicking My Workspace, then clicking Profile.


The Profile page is displayed.


4 Click Edit.


5 In the BCC Email Address field, specify the e-mail address of the folder or external e-mail address.


If the BCC Email Address field does not exist, contact your Vibe administrator.


The folder e-mail address was created when you defined a simple URL for the folder and 
allowed e-mail posting into the folder, as described in Step 2.


6 Click OK.


3.7 Configuring Folders to Send E-Mail Notifications to Other 
Users
As a folder owner, you can configure Novell Vibe to send other users e-mail notifications, in order to 
inform them of any activity in the folder and any sub-folders of the folder. If a user does not want to 
be informed of activity in the folder, the user can change the notification settings. A user’s individual 
settings override or cancel notifications established by folder owners.


You cannot directly configure a sub-folder to send e-mail notifications; instead, you must configure 
the parent folder.


1 Navigate to the folder from where you want to send the e-mail notifications.


2 Click Folder > E-Mail Settings in the Action toolbar.


The E-Mail Settings page is displayed.


3 In the Select the Type of E-Mail Notification section, select the type of e-mail notification that you 
want to send.


 Digest: Vibe sends one message that summarizes all of the activity in the folder and its sub-
folders (available for folders only). Vibe sends digest notifications at a schedule established 
by your site administrator.


As a folder owner, you can set your own schedule for digest notifications. For more 
information, see Step 5.


 Individual Messages (with Attachments): Vibe sends one message for every new or 
changed entry, and messages include attached files. Vibe sends all types of individual 
notifications every five minutes.


 Individual Messages without Attachments: Vibe sends one message for every new or 
changed entry. The e-mail messages do not include files that might be attached to the new 
or changed entries. Vibe sends all types of individual notifications every five minutes.
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 Message Suitable for Text Messaging: Vibe sends a message suitable for viewing as a text 
message. The content of the message includes only the entry title and a link to the new or 
changed entry. Vibe sends all types of individual notifications every five minutes.


4 Specify the users who you want to receive the e-mail notifications.


You can specify specific e-mail addresses, users, groups, or send the notifications to all team 
members.


5 (Optional) Click Set a Different Schedule for This Folder if you want to set a digest schedule for the 
folder that is different from the digest schedule set by the site administrator.


6 Click Apply > Close.


3.8 Working with Mirrored Folders
A mirrored folder is a library folder within Novell Vibe that is synchronized with a folder located on 
a system drive outside of Vibe. When you perform basic actions (adding subfolders and files, 
modifying files, deleting folders and files) by using the Vibe interface or by accessing the file on the 
drive, the change is reflected in the other interface. The advantage to using mirrored files is that you 
can apply Vibe tools to files on a drive, including tools such as text search, workflow, and discussion 
(in the form of comments applied to the entry in the library folder).


For information about setting up mirrored folders for your Vibe site, see “Configuring Mirrored 
Folder Resource Drivers” in “Advanced Installation and Reconfiguration” in the Novell Vibe 3.2 
Installation Guide.


Vibe supports two types of external folders:


 A directory on a file system


 A folder on a WebDAV server


When you mirror a folder, the action cannot be undone.


 Section 3.8.1, “Prerequisites,” on page 35


 Section 3.8.2, “Creating a Mirrored Folder,” on page 36


 Section 3.8.3, “Deleting a Mirrored Folder,” on page 36


 Section 3.8.4, “Configuring a Mirrored Folder,” on page 36


 Section 3.8.5, “Synchronizing a Mirrored Folder,” on page 37


 Section 3.8.6, “Mirrored Folder Tips,” on page 37


3.8.1 Prerequisites


The following prerequisites apply for setting up mirrored folders.


 An administrator must have enabled mirrored folder functionality during the Vibe installation 
process, as described in “Configuring Mirrored Folder Resource Drivers” in “Advanced 
Installation and Reconfiguration” in the Novell Vibe 3.2 Installation Guide.


 An administrator must have specified which folders on the server can be mirrored.


 The file that you mirror must either be located on the Vibe server, or accessible from the Vibe 
server. (For example, the file can be mapped from the Vibe server.)
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For information on how to modify mirrored folder settings after the Vibe installation, see 
“Reconfiguring the Vibe Site” in the Novell Vibe 3.2 Installation Guide.


3.8.2 Creating a Mirrored Folder


Ensure that you meet the prerequisites discussed in Section 3.8.1, “Prerequisites,” on page 35.


1 Navigate to the workspace where you want to set up the Mirrored Files folder.


2 Click Workspace > New Folder in the Action toolbar.


3 Provide a title for the folder in the Folder Title field.


4 Select Mirrored Files in the Folder section, then click OK.


After you create a Mirrored Files folder, you need to configure it. For information on how to do this, 
see Section 3.8.4, “Configuring a Mirrored Folder,” on page 36.


3.8.3 Deleting a Mirrored Folder


1 Navigate to the Mirrored Files folder that you want to delete.


2 Click Folder > Delete Folder in the Action toolbar.


The Delete This Folder page is displayed.


3 Select Also delete source contents if this folder or any of the sub-folders are mirrored folders.


If you do not select this option, the folder and its contents are removed from Vibe only, and are 
restored in the next synchronization.


4 Click OK.


NOTE: Undeleting files that have been deleted through a mirrored folder is not supported in Vibe. 
Files that are deleted through a mirrored folder cannot be recovered.


For more information on undeleting items in Vibe, see Chapter 14, “Restoring Deleted Items,” on 
page 175.


3.8.4 Configuring a Mirrored Folder


After you create a Mirrored Files folder, you need to configure it.


1 Select the Mirrored Files folder that you created in Section 3.8.2, “Creating a Mirrored Folder,” 
on page 36.


2 Click Folder > Edit Folder in the Action toolbar.


3 Specify the following information:


Resource Driver: Use this drop-down list to select the file on the external file system that you 
want the Mirrored Files folder to mirror.


You can select only files that your Vibe administrator has configured to be used as mirrored files.


Resource Root Path: This is the file path to the folder that you selected in the Resource Driver 
field.
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Resource Path Relative to the Root Path: If you want to display entries in a lower-level folder 
than the folder defined in the Resource Root Path field, use this field to specify the remaining file 
path.


4 Click OK.


3.8.5 Synchronizing a Mirrored Folder


After you have configured your mirrored folder to mirror the appropriate files, as described in 
Section 3.8.4, “Configuring a Mirrored Folder,” on page 36, you need to synchronize the Vibe 
Mirrored Files folder with the external folder that it is mirroring. 


Vibe enables you to manually synchronize your mirrored folder, or set up an automated 
synchronization schedule for it.


 “Manually Synchronizing a Mirrored Folder” on page 37


 “Setting Up a Synchronization Schedule for a Mirrored Folder” on page 37


Manually Synchronizing a Mirrored Folder


1 Navigate to the Mirrored Files folder that you want to synchronize.


2 Click Folder > Manually Synchronize in the Action toolbar.


The Vibe Mirrored Files folder is synchronized with the external folder that it is mirroring.


Setting Up a Synchronization Schedule for a Mirrored Folder


1 Navigate to the Mirrored Files folder that you want to synchronize.


2 Click Folder > Schedule Synchronization in the Action toolbar.


The Schedule Mirrored Folder Synchronization page is displayed.


3 Specify the following information:


Enable Scheduled Synchronization: Select this check box to enable scheduled synchronization. 
If you do not select this check box, the scheduled synchronization is not activated.


Every Day: Select this option if you want your mirrored folder to be synchronized every day.


Weekly: Select the days when you want your mirrored folder to be synchronized. (You can select 
multiple days.)


At Time: Specify the time that you want your mirrored folder to be synchronized.


If you select this option, your mirrored folder is synchronized only once per day.


Repeat Every: Select the hourly interval when you want your mirrored folder to be 
synchronized.


4 Click Apply > Close.


3.8.6 Mirrored Folder Tips


Consider these tips when working with mirrored files:


 When you specify the path to the system folder, specify the full (absolute) path to the folder.


 After creating the mirrored folder, you cannot alter the pathname, and you cannot reconfigure 
the Vibe library folder to be a non-mirrored folder.
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 To initialize the new mirrored folder, click Folder > Edit Folder, and use the Synchronize tool.


 Do not attach additional files to entries in a mirrored folder. Behavior regarding additional 
attachments is unpredictable.


 When you delete a file on the server, Vibe deletes the entire entry in the library folder (not just 
the attached file).


 When you add sub-folders to a mirrored folder in Vibe, sub-folders are added to the folder in the 
other system.


 When a Mirrored Files folder is exported, the content the folder is mirroring is preserved when 
the file is imported. However, the content is no longer mirrored from the original location, but 
rather is stored within the Vibe database as is the case with any other Vibe content. Only Vibe 
administrators can import and export workspaces and folders.


3.9 Setting Up and Using WebDAV
WebDAV is a standard collaborative editing and file management protocol. Novell Vibe supports the 
use of WebDAV tools, and enables you to manage your Vibe files through WebDAV. Vibe utilizes 
WebDAV when editing attached files, and you can also set up WebDAV to view documents in a Vibe 
folder.


If you are using WebDAV on Windows 7, you or your Vibe administrator must ensure that your 
workstation meets all the necessary prerequisites in order to support WebDAV, as described in 
“Configuring Vibe to Support WebDAV on Windows 7” in the  Novell Vibe 3.2 Administration Guide.


If you cannot use WebDAV as described in the following sections, consult your Vibe administrator.


 Section 3.9.1, “Using WebDAV to Edit Individual Files,” on page 38


 Section 3.9.2, “Using WebDAV on a Vibe Folder,” on page 39


3.9.1 Using WebDAV to Edit Individual Files


You can use either of the following methods to edit files through WebDAV:


 “Editing a File Directly from the Vibe Interface” on page 38


 “Using the WebDAV URL to Open the File in a Document Editor” on page 39


Editing a File Directly from the Vibe Interface


When you use the Edit-in-Place functionality to edit a Vibe file, as described in “Editing Files” in the 
Novell Vibe 3.2 User Guide, Vibe uses WebDAV to retrieve, lock, modify, and unlock the file. No special 
setup or configuration is needed in Vibe to use WebDAV in this way.


NOTE: Edit-in-Place functionality is not supported on Mac when you use Microsoft Office as your 
document editor. To use Edit-in-Place functionality on Mac, you must use OpenOffice as your 
document editor.
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Using the WebDAV URL to Open the File in a Document Editor


You can obtain the WebDAV URL for individual files within Vibe, as described in “Obtaining the 
WebDAV URL for a File” in the Novell Vibe 3.2 User Guide.


After you have obtained the WebDAV URL for the file, you can specify the URL in a document editor 
such as Microsoft Office to open the file. Refer to the documentation for your specific document 
editor for instructions on how to accomplish this.


3.9.2 Using WebDAV on a Vibe Folder


When you use WebDAV on a Vibe folder, you can create a mapped drive to a Vibe folder, enabling 
users to browse and navigate the Vibe folder in a WebDAV interface. To manage your Vibe folders 
through a WebDAV interface, you must first configure the Vibe folder to support WebDAV, then 
create a mapped drive to the Vibe folder.


NOTE: Because of limitations with WebDAV on Mac, you cannot use WebDAV to view a Vibe folder 
in a Mac environment.


 “Prerequisite for Windows XP and Windows Vista” on page 39


 “Configuring a Folder to Support WebDAV” on page 39


 “Viewing the Vibe Folder in Your Windows Environment” on page 40


 “Viewing the Vibe Folder in Your Linux Environment” on page 40


Prerequisite for Windows XP and Windows Vista


When you use WebDAV on a Vibe folder on Windows XP or Windows Vista, you must first install the 
Software Update for Web Folders (KB907306). For information on how to perform this installation, 
see “Software Update for Web Folders” (http://www.microsoft.com/downloads/
details.aspx?familyid=17c36612-632e-4c04-9382-987622ed1d64&displaylang=en), and follow the 
provided instructions.


Configuring a Folder to Support WebDAV


When a folder is configured to support WebDAV, Vibe requires that each file added to the folder have 
a unique name. This is because when you view a folder through WebDAV, you see only the files that 
are within the folder and not the entries that contain each file. Some folder types are configured to 
support WebDAV by default, and some are not.


Files folders and Photo Album folders are configured by default to support WebDAV, because they 
require that all files have a unique name.


All other types of Vibe folders, however, must be manually configured to support WebDAV. This is 
because Vibe allows you to add multiple files with the same name to a single folder, if each file is 
added as a separate entry. 


To configure a folder to support WebDAV by requiring that all files uploaded to the folder have a 
unique name:


1 Navigate to the folder that you want to configure to support WebDAV.


2 Click Folder > Edit Folder in the Action toolbar.
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3 Toward the bottom of the page, select Require that all files uploaded into this folder have a unique 
name.


4 Click OK.


For information about what users experience when they try to add a file to a WebDAV-enabled folder 
when the file has the same name as a file that has already been added to the folder, see “Adding Files 
to a Files Folder and Other WebDAV-Enabled Folders” in the Novell Vibe 3.2 User Guide.


Viewing the Vibe Folder in Your Windows Environment


After your Vibe folder has been configured to support WebDAV, as described in “Configuring a 
Folder to Support WebDAV” on page 39, you can view the Vibe folder in your Windows environment 
in either of the following ways:


 “Creating a Mapped Drive to the Vibe Folder” on page 40


 “Adding a Vibe Folder as a Network Place” on page 40


Creating a Mapped Drive to the Vibe Folder


If you are using Windows XP as your client operating system, creating a mapped drive to the Vibe 
folder as described in this section does not work. Instead, add the Vibe folder as a network place, as 
described in “Adding a Vibe Folder as a Network Place” on page 40.


1 Navigate to the folder where you want to create the mapped drive.


2 Click the link in the footer.


3 In the provided table, copy the WebDAV URL.


4 Map a drive to the folder.


You accomplish this by using the Map Network Drive feature for Windows.


5 Specify your Vibe credentials, then complete the setup process.


Adding a Vibe Folder as a Network Place


If you are using Windows Vista as your client operating system, adding a Vibe folder as a network 
place as described in this section does not work. Instead, create a mapped drive to the Vibe folder, as 
described in “Creating a Mapped Drive to the Vibe Folder” on page 40.


1 Navigate to the folder where you want to create the mapped drive.


2 Click the link in the footer.


3 In the provided table, copy the WebDAV URL.


4 Add the folder as a network place.


You accomplish this by using the My Network Places feature for Windows.


Viewing the Vibe Folder in Your Linux Environment


After your Vibe folder has been configured to support WebDAV, as described in “Configuring a 
Folder to Support WebDAV” on page 39, you can view the Vibe folder in your Linux environment.


1 Navigate to the folder where you want to create the mapped drive.


2 Click the link in the footer.


3 In the provided table, copy the WebDAV URL.
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4 Use either Nautilus or Konqueror to access the Vibe folder.


For specific information on how to use Nautilus or Konqueror, consult your Linux 
documentation.


5 Specify your Vibe credentials, then complete the setup process.


3.10 Viewing Vibe Folders as RSS or Atom Feeds
RSS and Atom are Web formats used to publish frequently updated content such as blog entries, 
news headlines, or podcasts. RSS and Atom documents, which are often called feeds, contain either a 
summary or full content from an associated Web site. RSS and Atom make it possible for people to 
keep up with their favorite Web sites in an automated manner that's easier than checking the sites 
manually. RSS and Atom enable you to set up feeds to Novell Vibe folders and view those feeds in 
one convenient location.


You can set up a Vibe folder to be accessed by an RSS or Atom reader. When you do this, the Vibe 
folder sends new or modified folder entries to your RSS or Atom reader. This is an easy way to stay 
informed on activity in a certain folder.


To set up a Vibe folder as an RSS or Atom feed:


1 Navigate to the folder that you want to set up as an RSS or Atom feed.


2 Click the Footer toolbar, located at the bottom of the folder page.


3 If you are setting up an RSS feed, select and copy the RSS URL in the RSS URL section in the 
provided table.


or


If you are setting up an Atom feed, select and copy the Atom URL in the ATOM URL section in 
the provided table.


4 In your RSS reader or Atom reader, create a new RSS or Atom feed, and paste the RSS URL or 
the Atom URL that you copied in Step 3.


The folder is now set up as an RSS or Atom feed, and entries that are created in the folder appear 
in your RSS or Atom reader.


For information on using your Novell GroupWise client as an RSS reader, see “RSS Feeds” in the 
GroupWise 8 Windows Client User GuideGroupWise 8 Windows Client Help. Or, see “RSS Feeds” in the 
GroupWise 8 Mac/Linux Client User GuideGroupWise 8 Linux Client HelpGroupWise 8 Mac Client Help.


3.11 Applying Landing Page Elements to a Folder
Landing pages and landing page elements can enhance the presentation and utility of your Novell 
Vibe folders. You can set up a landing page on your folder, or you can simply apply some key 
landing page elements to the folder, such as hiding the Vibe masthead, the Navigation panel, and so 
forth.


 Section 3.11.1, “Displaying a Landing Page on a Folder,” on page 42


 Section 3.11.2, “Applying Specific Landing Page Elements to a Folder,” on page 42
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3.11.1 Displaying a Landing Page on a Folder


Just as landing pages can enhance the presentation and utility of your Vibe workspaces, they can also 
enhance your Vibe folders.


For information on how you can create a landing page for a folder, see Section 6.12, “Creating a 
Landing Page for a Folder,” on page 82.


3.11.2 Applying Specific Landing Page Elements to a Folder


You can leverage certain landing page elements in your Vibe folder without implementing an actual 
landing page. 


For example, you might want to hide the Navigation panel from your folder in order to create more 
viewing room for users who view the folder.


You can apply the following landing page elements to a folder, without implementing an actual 
landing page:


 Hide the Vibe Masthead


 Hide the Navigation panel


 Hide the Footer toolbar


To make these modifications to your folder without implementing an actual landing page, you need 
to add the Landing Page element to your folder Form definition. For information on how to add the 
Landing Page element to your folder Form definition, see Chapter 8, “Creating Custom Folder 
Views,” on page 95.
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4 4Controlling Access


If you are a Novell Vibe site administrator or a workspace and folder owner, it is your responsibility 
to keep your content safe and your content consumers happy, by making sure they have access to the 
files and folders they depend on. Access control in Vibe is how you accomplish this.


Workspace and folder owners are responsible for controlling user access in their workspaces or 
folders. Site administrators are responsible for controlling user access across the entire site.


 Section 4.1, “Understanding Access Control,” on page 43


 Section 4.2, “Managing Access Control for Users and Groups,” on page 46


 Section 4.3, “Managing Access Control for Remote Applications,” on page 52


4.1 Understanding Access Control
Access control is how you specify which users have the right to perform which tasks in which places.


Novell Vibe uses role-based access control. By default, there are seven roles, and each role contains 
specific rights. If you want a particular user to have certain rights, you can assign that user to the 
appropriate role.


For example, a user who has been assigned to the Participant role in a workspace or folder can add 
comments or replies, create entries, delete his or her own entries, modify his or her own entries, and 
read entries in that folder or workspace.


The following sections help you better understand how access control works in Vibe.


 Section 4.1.1, “Default Access Control Behavior in Workspaces,” on page 43


 Section 4.1.2, “Default User Rights,” on page 44


 Section 4.1.3, “Default Roles,” on page 44


 Section 4.1.4, “Default Users and Groups,” on page 45


4.1.1 Default Access Control Behavior in Workspaces


By default, most places inherit the access settings of their parent. When you establish settings for a 
primary space, all sub-places automatically apply the same settings, saving administration time. 
However, unlike other types of workspaces, Team workspaces do not retain the access control 
settings of higher-level (parent) workspaces by default.


You can change the access control settings of a lower-level workspace and folder to be different from 
its parent workspace or folder. For information on how to do this, see Section 4.2, “Managing Access 
Control for Users and Groups,” on page 46.
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4.1.2 Default User Rights


By default, all Vibe users have rights to perform the following actions:


 Participate in any team workspaces in which they are a member (create folders and entries, 
make comments, etc.)


 Create team workspaces (by default, only members of a team can view and participate in team 
workspaces)


 Visit all personal workspaces (read entries and comment on them)


 Participate in all global workspaces and folders


4.1.3 Default Roles


Vibe includes default roles that you can assign to users and groups. The default roles for workspaces 
and folders are described in “Understanding Default Roles for Workspaces and Folders” on page 45, 
and the default roles for entries are described in “Understanding Default Roles for Entries” on 
page 45. These sections describe the function of each default role, but do not describe all of the rights 
associated with each role. For a complete list of rights, click the name of the role in the table on the 
Configure Access Control page. (In the Action toolbar, click Workspace > Access Control or Folder > 
Access Control.)


For a complete list of roles that site administrators can add, see “Controlling User Access throughout 
the Vibe Site” in the  Novell Vibe 3.2 Administration Guide. For a detailed description of each right that 
can be associated with a given role, see “Understanding the Various Rights for Roles” in the  Novell 
Vibe 3.2 Administration Guide.


Vibe enables site administrators to create their own custom roles, as described in “Defining a New 
Role” in the  Novell Vibe 3.2 Administration Guide. If you have a need for a custom role, consult your 
Vibe administrator.


By default, you can assign users to various roles in workspaces and folders, as well as in entries.


 “Understanding Default Roles for Workspaces and Folders” on page 45


 “Understanding Default Roles for Entries” on page 45
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Understanding Default Roles for Workspaces and Folders


Understanding Default Roles for Entries


4.1.4 Default Users and Groups


As you create users and groups in your Vibe site, you can assign default or custom access control 
roles to them. In addition to the users and groups that you create, Vibe includes four default users 
and groups to which you can assign roles. For information on how to do this, see Section 4.2, 
“Managing Access Control for Users and Groups,” on page 46.


Role Description


Visitor Has read-only and comment-only access.


Participant Can create entries and modify those entries, plus perform tasks associated with 
the Visitor role.


Guest Participant Can read entries, create entries, and add comments.


Team Member Has all the rights of a Participant. In addition, can generate reports and manage 
global tags.


Workspace and Folder 
Administrator


Can create, modify, or delete workspaces or folders; moderate participation (modify 
or delete the entries of others); design entries and workflows; set entry-level 
access controls on entries of others; and can perform tasks associated with the 
Participant and Team Member role.


Workspace Creator Can create sub-workspaces. In Team Workspace Root workspaces, this role 
allows users to create their own team workspaces.


Site Administrator Has all rights associated with access control. Available only to Vibe administrators.


Role Description


Read Can read the entry.


Read and Reply Can read the entry and add comments or replies to the entry.


Write Can read the entry, add comments or replies, and modify the entry.


Delete Can read the entry, add comments or replies, modify, and delete the entry.


Change Access Controls Can read the entry, add comments or replies, modify, and delete the entry. Can 
also modify the access control settings of the entry.
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4.2 Managing Access Control for Users and Groups
When you have appropriate rights, you can control which users have access to workspaces, folders, 
and entries. Furthermore, you can regulate what actions they are allowed to perform. For example, 
you can allow a specific team to view a workspace, but only allow certain members of that team to 
create entries in the workspace.


You can control access to workspaces, folders, and entries.


 Section 4.2.1, “Controlling Access to Workspaces and Folders,” on page 46


 Section 4.2.2, “Controlling Access to Entries,” on page 50


4.2.1 Controlling Access to Workspaces and Folders


 “Accessing the Configure Access Control Page” on page 46


 “Activating the Table” on page 47


 “Adding Roles to the Access Control Table” on page 48


 “Adding Users to the Access Control Table” on page 48


 “Adding Groups to the Access Control Table” on page 49


 “Assigning Roles to Users and Groups” on page 49


 “Using the Configure Access Control Page to Adjust Access Controls” on page 50


 “Creating Access Controls for Remote Applications” on page 50


Accessing the Configure Access Control Page


Novell Vibe provides a table on the Configure Access Control page that enables you to make all of 
your needed access control modifications. You must use this table to perform any access control 
modifications in Vibe.


1 Navigate to the workspace or folder where you want to modify user access rights.


2 Click Workspace > Access Control in the Action toolbar if you want to change the access control 
settings for a workspace.


or


Default User and Group Description


Owner of a Workspace or 
Folder


The person who created the workspace, or the person assigned to be the owner 
of the workspace.


Team Members The individuals who are designated as team members in a given place.


For information about how to add team members, see “Adding Additional Team 
Members to Your Workspace” in the Novell Vibe 3.2 User Guide.


All Users Every person registered within the Vibe site.


Site Administrator The person who has rights to perform any task in any workspace or folder. 
Available only to Vibe administrators.
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Click Folder > Access Control in the Action toolbar if you want to change the access control 
settings for a folder.


The Configure Access Control page is displayed.


Activating the Table


Before you can make modifications to the table on the Configure Access Control page, you need to 
ensure that the folder or workspace does not inherit its access control settings from its parent folder 
or workspace:


1 In the Folder Inheritance section, select no, then click Apply.


You can now make modifications to the table.
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Adding Roles to the Access Control Table


1 Click the Add a Role link at the top of the table.


2 From the drop-down list, select the role that you want to add.


Vibe adds a new column to the table for the new role.


3 Assign the appropriate user or group to this role by selecting the check box in the user’s or 
group’s row, as described in “Assigning Roles to Users and Groups” on page 49.


For information on how to add a new user to the access control table, see “Adding Users to the 
Access Control Table” on page 48.


For information on how to add a new group to the access control table, see “Adding Groups to 
the Access Control Table” on page 49.


4 Click Save Changes.


Adding Users to the Access Control Table


You can individually add users to the Access Control table, or you can add them by using the Vibe 
clipboard.


 “Adding Individual Users” on page 48


 “Adding Users from the Clipboard” on page 49


Adding Individual Users


1 Click the Add a User link in the left column of the table.


2 In the Add a User field, begin typing the name of the user that you want to add, then select that 
user from the provided list.


Vibe adds a new row to the table for the new user.
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3 Assign the user to the appropriate role by selecting the check box in the column of the user’s 
row, as described in “Assigning Roles to Users and Groups” on page 49.


4 Click Save Changes.


Adding Users from the Clipboard


1 In the upper left corner of the Access Control table, click Add User Names from Clipboard.


All of the users who are currently on your clipboard are added to the Access Control table.


For more information on how to use the Vibe clipboard, see “Using the Vibe Clipboard” in the 
Novell Vibe 3.2 User Guide.


2 Assign the users to the appropriate role by selecting the check box in the column of each user’s 
row, as described in “Assigning Roles to Users and Groups” on page 49.


3 Click Save Changes.


Adding Groups to the Access Control Table


1 Click the Add a Group link in the left column of the table. 


2 In the Add a Group field, begin typing the name of the group that you want to add, then select 
that group from the provided list.


Vibe adds a new row to the table for the new group.


3 Assign the group to the appropriate role by selecting the check box in the column of the group’s 
row, as described in “Assigning Roles to Users and Groups” on page 49.


4 Click Save Changes.


Assigning Roles to Users and Groups


A role is a set of privileges. When you assign a user or group to a role, that user or group 
automatically has all the rights associated with that role.


1 Ensure that the user or group and the role that you want to associate with the user or group are 
visible in the Access Control table.


For information on how to add a role or a user or group to the table, see “Adding Roles to the 
Access Control Table” on page 48, “Adding Users to the Access Control Table” on page 48, and 
“Adding Groups to the Access Control Table” on page 49.


2 In the row of the user or group, select the check box that is located in the role column that you 
want to assign to the user or group.


3 Click Save Changes.
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If you want to unassign a role:


1 Deselect the appropriate check box, then click Save Changes.


Using the Configure Access Control Page to Adjust Access Controls


Vibe enables you to adjust the access control settings of any workspace or folder, directly from the 
Configure Access Control page.


1 In the workspace tree at the top of the Configure Access Control page, navigate to the place 
where you want to adjust the access controls.


2 Click the linked title of the place where you want to adjust the access controls.


Vibe displays the Configure Access Control page for the page that you specified.


Creating Access Controls for Remote Applications


Because not all remote applications can be completely trusted, it is often a good idea to limit the 
privileges of the remote application. 


For information on how to do this by using access controls, see Section 12.4, “Managing Access 
Controls for Remote Applications,” on page 164.


4.2.2 Controlling Access to Entries


Vibe enables you to set access controls for an entry that differ from the access controls of the parent 
folder. You might want to do this if you have granted a group of users access to a folder, but only 
want a subset of that group to have access to see certain entries within the folder. Or, you might want 
to set access controls on a particular entry to make that entry visible to users who don’t have access to 
the folder where the entry resides, as described in “Exposing a Vibe Entry to a Wider Audience Than 
the Folder Access Controls Allow” on page 52.


Before you can modify access controls for an entry, you need to ensure that the entry does not inherit 
its access control settings from the parent folder:


To set access controls on an entry:


1 Navigate to the entry where you want to modify user access rights.


2 Click Actions > Access Control in the Entry toolbar.


The Configure Access Control page is displayed.
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3 To set access controls that differ from the access controls of the parent folder, select Specify the 
access controls for this entry, then click Apply.


4 Use the table to modify user access to the entry. 


You can assign various roles to team members, groups, or individual users. 
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For information about the roles that you can assign, see “Understanding Default Roles for 
Entries” on page 45.


For information about how to add users and groups to the access control table, see “Adding 
Users to the Access Control Table” on page 48 and “Adding Groups to the Access Control Table” 
on page 49.


5 (Optional) Select Include the Folder Access Controls if you want to extend the new entry-level 
access controls to include the access controls that are already in place for the folder. Selecting 
this option automatically grants users the same access rights to the entry that they have to the 
folder.


Deselect Include the Folder Access Controls if you want the new entry-level access controls to 
override the folder-level access controls. If you deselect this option, you must use the entry-level 
access controls to specify each user or group that you want to have access to the entry. Users who 
have access to the folder that contains the entry but have not been granted access rights to the 
entry itself do not have access to the entry. 


6 Click Save Changes > Close.


Exposing a Vibe Entry to a Wider Audience Than the Folder Access Controls 
Allow


You can make a Vibe entry visible to a wider audience than is normally allowed for the folder where 
the entry resides. For example, if your folder is visible only to team members, the default access 
controls allow only team members to see all entries that are created in the folder. However, by 
deselecting Include the Folder Access Controls, you can enable a wider audience to view a specific entry. 
You might want to do this if the majority of content in a folder is sensitive and should be restricted to 
a limited audience, but you want to expose a specific entry to a larger audience.


For example, suppose that you are a member of a finance team that is responsible for the accounting 
of your company’s quarterly earnings. All the information in your team’s workspace is confidential. 
However, when it is time to announce the company’s quarterly earnings, you create a Vibe entry that 
contains the earning results, and you modify the access controls of this specific entry to make the 
entry visible to all company employees.


To expose a Vibe entry to a wider audience than is currently allowed in the folder:


1 Modify the entry access controls as described in Section 4.2.2, “Controlling Access to Entries,” 
on page 50.


Ensure that you deselect Include the Folder Access Controls, as described in Step 5 of this section.


NOTE: When you expose a Vibe entry to a wider audience than is currently allowed in the folder, 
users must perform a search in order to locate the entry, or they must have the entry shared with 
them. Users cannot locate the entry by navigating the Workspace tree as described in “Navigating the 
Workspace Tree” in the Novell Vibe 3.2 User Guide.


4.3 Managing Access Control for Remote Applications
Because not all remote applications can be completely trusted, it is often a good idea to limit the 
privileges of the remote application. 


For information on how to do this by using access controls, see Section 12.4, “Managing Access 
Controls for Remote Applications,” on page 164.
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5 5Branding a Folder or Workspace


Branding a folder or workspace is a good way to make the folder or workspace more unique and 
identifiable. When you brand a folder or workspace, the brand is applied to all sub-workspaces and 
sub-folders. However, folder and workspace owners in lower-level folders and workspaces can 
override the higher-level brand settings by adding a workspace brand of their own. For example, the 
Global Workspaces folder can be branded with the company logo and slogan, while a team 
workspace at a lower level in the workspace tree can be branded with a logo for the product that the 
team is responsible for. Members of that team can then override the team brand by branding 
individual folders within the team workspace that they are responsible for.


Novell Vibe administrators can disable this functionality when they create a site-wide brand, as 
discussed in “Creating a Site-Wide Brand” in the  Novell Vibe 3.2 Administration Guide. 


If you are unable to brand a folder or workspace as discussed in this section, contact your Vibe 
administrator.


To brand a folder or workspace:


1 Navigate to the folder or workspace where you want to create the brand.


2 Click Workspace > Brand Workspace if you are branding a workspace.


or


Click Folder > Brand Folder if you are branding a folder.


The Workspace/Folder Branding dialog box is displayed.


3 Specify the following information to create your desired brand:


Use Branding Image: Select this option if you want to use the drop-down list to select an 
existing image, or click the Browse icon  to browse to an image on your computer’s file 
system.
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Use Advanced Branding: Select this option, then click Advanced if you want to create a brand 
that includes advanced features, such as linking to another Vibe page or displaying a YouTube 
video.


You can add a YouTube video in your branding section by clicking the Video icon .


For more information about displaying YouTube videos in Vibe, see “Displaying YouTube 
Videos in a Folder Entry” in the Novell Vibe 3.2 User Guide.


For more information about linking to another Vibe page, see “Linking to a Folder or Folder 
Entry” in the Novell Vibe 3.2 User Guide.


If you add a URL to the advanced branding, the URL cannot contain the 
url_created_by_teaming parameter. If this parameter does exist, delete it before saving your 
brand.


Background Image: Click the Browse icon  to browse to an image on your computer’s file 
system. If you are branding a team workspace, you can use the provided drop-down list to select 
an image that is already attached to the workspace. (For information on how to attach an image 
to a team workspace, see “Modifying a Workspace” in the Novell Vibe 3.2 User Guide.)


This background image is displayed behind your regular branding.


Stretch Image: Stretches the image to occupy the entire branding area.


If you stretch your background image, the image overrides any background color that you have 
set.


Background Color: Adds a background color that occupies the entire branding area. To change 
the background color, click the color name to the right of this field, select the new color, then 
click OK.


If you added a background image and stretched the image, the background color is not 
displayed.


Text Color: Changes the text color of the workspace name in the upper right corner of the 
branding area. To change the text color, click the color name to the right of this field, select the 
new color, then click OK.


Clear branding: Clears all your current branding selections.


4 Click OK.


The folder or workspace now displays the brand that you created.
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6 6Creating and Managing Landing Pages


Landing pages in Novell Vibe can benefit your workspaces and folders in two key ways:


 Improved Customization: Landing pages provide an excellent opportunity to put a custom, 
personal face on workspaces and folders in your Vibe site, while still providing the team-
focused, collaborative functionality that Vibe affords.


 Increased Retrievability: Landing pages increase the accessibility and visibility of the 
information that is most critical to your team or organization. You can bring important entries or 
entire folders to the forefront of workspaces, ensuring that users access the information they 
need in a quick, efficient manner.


For example, a landing page for a city’s public sector might look something like this:


 Section 6.1, “Enabling the Landing Page View for a Workspace,” on page 56


 Section 6.2, “Setting Up Your Landing Page,” on page 57
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 Section 6.3, “Publishing Your Landing Page,” on page 74


 Section 6.4, “Modifying the Contents of Your Landing Page,” on page 74


 Section 6.5, “Changing the Order of Landing Page Elements,” on page 75


 Section 6.6, “Deleting Content from Your Landing Page,” on page 75


 Section 6.7, “Automatically Displaying the Newest Folder Entries on Your Landing Page,” on 
page 76


 Section 6.8, “Adding Accessories to Your Landing Page,” on page 78


 Section 6.9, “Enabling Graphics to Be Used on a Landing Page,” on page 80


 Section 6.10, “Displaying YouTube Videos on a Landing Page,” on page 81


 Section 6.11, “Creating a Landing Page for a Personal Workspace,” on page 82


 Section 6.12, “Creating a Landing Page for a Folder,” on page 82


 Section 6.13, “Downloading Existing Landing Pages,” on page 83


6.1 Enabling the Landing Page View for a Workspace
Before you can create the landing page, you need to enable the landing page view for the workspace.


Novell Vibe includes a default workspace landing page view. The default landing page view contains 
a Landing Page Layout section, a Description section, a Branding section, an Icon section, and an 
Attachments section.


Or, you can create a custom landing page view for a workspace that contains only the sections that 
you choose. For information on how to create a custom landing page view for a workspace, see 
Chapter 7, “Creating Custom Workspace Views,” on page 85.


You can enable the landing page view on an existing workspace, or when you are creating a 
workspace.


 Section 6.1.1, “Enabling the Landing Page View on an Existing Workspace,” on page 56


 Section 6.1.2, “Enabling the Landing Page View on a Workspace You Are Creating,” on page 57


6.1.1 Enabling the Landing Page View on an Existing Workspace


1 Navigate to the workspace where you want to create the landing page.


You can create a landing page for a personal workspace only if your Vibe administrator has 
enabled you to do so. For more information, see Section 6.11, “Creating a Landing Page for a 
Personal Workspace,” on page 82.


2 Click Workspace > Configure Views, URLs and Controls in the Action toolbar.


3 On the Configure Workspace View tab, in the Default View section, select Landing Page.


4 Click Apply > Close.


What was previously displayed on the main page of the workspace is no longer displayed and 
the main page of the workspace is blank.


5 Continue with Section 6.2, “Setting Up Your Landing Page,” on page 57.
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6.1.2 Enabling the Landing Page View on a Workspace You Are Creating


1 Navigate to the workspace where you want to create the new workspace.


2 Click Workspace > New Workspace.


The New Workspace page is displayed.


3 In the Workspace Title field, specify a title for the workspace.


4 In the Workspace section, select Landing Page.


5 Finish creating the workspace, then click OK.


For more information on creating a workspace, see “Creating a New Workspace” in “General 
Workspace Management” in the Novell Vibe 3.2 User Guide.


6 Continue with Section 6.2, “Setting Up Your Landing Page,” on page 57.


6.2 Setting Up Your Landing Page
After you enable a landing page as described in Section 6.1, “Enabling the Landing Page View for a 
Workspace,” on page 56, you need to set it up to display the desired layout options and content, as 
described in the following sections:


 Section 6.2.1, “Choosing Layout Options for Your Landing Page,” on page 57


 Section 6.2.2, “Adding a Background Image or Color to Your Landing Page,” on page 58


 Section 6.2.3, “Adding Content to Your Landing Page,” on page 59


 Section 6.2.4, “Configuring Landing Page Elements,” on page 61


6.2.1 Choosing Layout Options for Your Landing Page


1 Navigate to the landing page that you created in Section 6.1, “Enabling the Landing Page View 
for a Workspace,” on page 56.


2 Click Workspace > Edit Workspace in the Action toolbar.


or


Click Folder > Edit Folder if your landing page is on a folder.
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3 In the Landing Page Layout section, below the workspace Title field, select from the following 
options to modify the display of your landing page:


 Hide the Masthead: Select this option to hide the masthead (Navigation toolbar). This 
hides everything above the Action toolbar.


 Hide the Navigation Panel: Select this option to hide the Navigation panel.


 Hide the Footer: Select this option to hide the Footer toolbar.


 Hide the Menu: Select this option to hide the menu (Action toolbar) from all users who do 
not have rights to edit the workspace. Users who have rights to edit the workspace still see 
the menu.


4 In the Landing Page Style section, select from the following options to modify the style of your 
landing page:


 Light: No background shading is displayed on landing page elements.


 Dark: (Default) Displays a dark background on each element to provide contrast between 
the landing page elements.


5 Click OK to save the layout and style changes.


6.2.2 Adding a Background Image or Color to Your Landing Page


1 Navigate to the landing page that you created in Section 6.1, “Enabling the Landing Page View 
for a Workspace,” on page 56.


2 Click Workspace > Edit Workspace in the Action toolbar.


or


Click Folder > Edit Folder if your landing page is on a folder.


3 In the Landing Page Layout section, in the content editor, click the edit icon  in the upper right 
corner of the landing page element.


The Landing Page Properties dialog box is displayed.
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4 Configure the following options to modify the background image and color:


Background Image: Click the Browse icon  to navigate to and add images to the drop-down 
list. Select the image from the drop-down list.


Background image repeat: In the drop-down list, select whether you want the image to repeat 
horizontally and vertically, only horizontally, only vertically, or not at all.


Background Color: Click the Browse icon  to choose a color from a list of colors.


5 Click OK.


6.2.3 Adding Content to Your Landing Page


1 Navigate to the landing page that you created in Section 6.1, “Enabling the Landing Page View 
for a Workspace,” on page 56.


2 Click Workspace > Edit Workspace in the Action toolbar.


or


If you are creating a landing page for a folder, click Folder > Edit Folder.


3 In the Landing Page Layout section, in the content editor, use the element palette to select the 
landing page element that you want to display on your landing page.
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You can add the following elements:


 Table: Creates a table with the number of columns that you specify. You can add other 
elements inside this table.


 List: Creates a list where you can add other elements.


 Entry: Enables you to reference an entry that has previously been created in Novell Vibe.


The actual content of your landing page is created in entries. The landing page simply 
references entries that have already been created within Vibe.


When you add an entry to the landing page by using the Entry element, only the entry title 
and description can be displayed. If you want to display entry comments, add the 
Enhanced View element to the landing page.


 Folder: Enables you to reference a folder that has previously been created in Vibe. You can 
choose how many entries from the folder that you want to display on your landing page at 
any one time.


 Enhanced View: Enables you to display entries and folders in enhanced ways. The 
following options are available:


 Display an entry: Displays the entry title, description, author, date, and the 10 most 
recent comments.


 Display a full entry: Displays the entry with the full entry view, which includes the 
title, description, author, date, tabs (Comments, Attachments, Entry History, Tags), 
ratings, and so forth.


 Display recent entries: Displays the most recent entries from the specified folder. 
Displays the title, description, author, date, and the 10 most recent comments for each 
entry.


 Display a list of recent entries: Displays a list of the most recent entries from the 
specified folder. Displays the title, author, and date of the entry.


 Display a sorted list of recent entries: Displays a list in alphabetical order of the most 
recent entries from the specified folder. Displays the title, author, and date of the entry.


 Display a sorted list of files: Displays a list in alphabetical order of the files that were 
most recently added to the folder. This includes files that are attached to entries.


 Display calendar: Displays the specified calendar with the full calendar view.
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 Display task folder: Displays the specified task folder with information about each 
task, such as the title, due date, priority, and so forth.


 Display survey: Displays the specified survey in a full, interactive view. Users can 
participate in the survey directly from the landing page.


 Graphic: Enables you to reference a graphic that has previously been added to the 
workspace.


 Link (URL): Enables you to create a link to a Web URL.


 Link to Folder/Workspace: Enables you to add a link to a Vibe folder or workspace.


 Link to Entry: Enables you to add a link to a Vibe entry.


 Utility Element: Enables you to add various utilities, such as the My Workspace link.


 Custom JSP: Enables you to reference a custom JSP file that has previously been created by 
a Vibe administrator.


 HTML: Displays an HTML editor where you can compose messages, create links, upload 
pictures, and more. The information that you create in this HTML editor is displayed on 
your landing page.


 Embedded Web Page: Enables you to reference any Web site and display it on your landing 
page.


4 Drag the element that you want to display on your landing page and drop it onto the landing 
page canvas.


After you drop the element onto the landing page canvas, you are prompted to configure it. 


How you configure a landing page element depends on the type of element that you add. 


5 Configure the landing page element as described in Section 6.2.4, “Configuring Landing Page 
Elements,” on page 61.


6.2.4 Configuring Landing Page Elements


You need to configure the elements of your landing page when you create them, as described in 
Section 6.2.3, “Adding Content to Your Landing Page,” on page 59.


You can also reconfigure the elements of your landing page at any time, as described in Section 6.4, 
“Modifying the Contents of Your Landing Page,” on page 74.
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After you have added and configured the elements of your landing page, you are ready to publish 
the landing page. For information on how to do this, see Section 6.3, “Publishing Your Landing 
Page,” on page 74.


 “Adding a Table” on page 62


 “Adding a List” on page 63


 “Adding an Entry” on page 64


 “Adding a Folder” on page 65


 “Adding an Enhanced View Element” on page 65


 “Adding a Graphic” on page 67


 “Adding a Link (URL)” on page 67


 “Adding a Link to a Folder/Workspace” on page 68


 “Adding a Link to an Entry” on page 69


 “Adding a Utility Element” on page 70


 “Adding a Custom JSP” on page 71


 “Adding an HTML Editor” on page 73


 “Adding an Embedded Web Page” on page 73


Adding a Table


To add a table to the landing page:


1 In the Landing Page Layout section, in the content editor, click Table in the element palette, then 
drag the table into the desired area of the landing page canvas.


2 Set the following configuration options to finish setting up the table:


 Show border: Select this option if you want the border of the table to be visible.


 Number of columns: Specify the number of columns that you want the table to have. You 
can have up to ten columns.


 Column width: Specify the width that you want for each column by either percentage or 
pixel. You can have both percentages and pixels within the same table.
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If your table contains pixels, you must add an additional column to the table that has a 
width of * in order for the columns to stay at their fixed widths. This is an HTML browser 
requirement.


For example, suppose you want a 3-column table with the first column with a width of 450 
pixels, the second column with a width of 150 pixels, and the third column with a width of 
10 percent. For the columns to retain their fixed widths, you must add a fourth column, and 
in the provided field specify *.


3 Click OK.


After you add a table to a landing page, you can add content within the table.


1 Select an element from the element palette and drag and drop it into the location of the table 
where you want to add the content.


Adding a List


To add a list to the landing page:


1 In the Landing Page Layout section, in the content editor, click List in the element palette, then 
drag the list and drop it into the desired area of the landing page canvas.


2 Set the following configuration options to finish setting up the list:


 Title: Specify a title for the list.


 Show border: Select this option if you want the border of the list to be visible.


3 Click OK.
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After you add a list to a landing page, you can add content within the list.


1 Select an element from the element palette and drag and drop it into the location of the list 
where you want to add the content.


Adding an Entry


The actual content of your landing page is created in entries. The landing page simply references 
entries that have already been created within Vibe.


When you use the Entry element to add an entry to the landing page, only the entry title and 
description can be displayed. If you want to display entry comments, add the Enhanced View 
element to the landing page, as described in “Adding an Enhanced View Element” on page 65.


To add an entry to the landing page:


1 In the Landing Page Layout section, in the content editor, click Entry in the element palette, then 
drag the entry into the desired area of the landing page canvas.


2 Click Edit next to the Entry field.


If you are reconfiguring the element, the entry that is being referenced is shown here.


3 Set the following configuration options to finish setting up the entry:


 Find: Select whether you want to search the entire site for the entry or only within the 
current folder or workspace, then use the provided field to specify the entry that you want 
to display on the landing page.


This field uses type-to-find functionality, so Vibe displays the available options as you type. 
Click in the field and press the Spacebar to list all the available options.


 Show Title Bar: Select this option if you want the title bar of the entry to be visible.


4 Click OK.
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Adding a Folder


1 In the Landing Page Layout section, in the content editor, click Folder in the element palette, then 
drag the folder into the desired area of the landing page canvas.


2 Click Edit next to the Folder field.


If you are reconfiguring this element, the folder that is being referenced is shown here.


3 Set the following configuration options to finish setting up the folder:


 Find: Select whether you want to search the entire site for the folder or only within the 
current folder or workspace, then use the provided field to specify the folder that you want 
to display on the landing page.


This field uses type-to-find functionality, so Vibe displays the available options as you type. 
Click in the field and press the Spacebar to list all the available options.


 Number of entries to show: Specify the number of folder entries that you want to be 
displayed at any one time.


 Show Title Bar: Select this option if you want the folder title bar to be displayed.


 Show Folder Description: Select this option if you want the folder description to be 
displayed.


 Show Entries Opened: Select this option if you want opened entries to be displayed.


4 Click OK.


Adding an Enhanced View Element


1 In the Landing Page Layout section, in the content editor, click Enhanced View in the element 
palette, then drag the enhanced view into the desired area of the landing page canvas.

Creating and Managing Landing Pages 65







2 In the Enhanced View drop-down list, select one of the available options.


For more information about each option, see Enhanced View.


3 Set the configuration options that apply to the enhanced view element that you are adding. 
Depending on the option that you selected in Step 2, the following configuration options are 
available:


 Entry: Click Edit. 


If you are reconfiguring this element, the folder that is being referenced is shown here.


 Folder: Click Edit. 


If you are reconfiguring this element, the folder that is being referenced is shown here.


 Find: Select whether you want to search the entire site for the folder or entry, or only within 
the current folder or workspace, then use the provided field to specify the folder or entry 
that you want to display on the landing page.


 Number of entries to show: (Conditional) Specify the number of folder entries that you 
want to be displayed at any one time.


This option is available only when referencing a folder.


 Width: (Conditional) Specify the width that you want the calendar to be on the landing 
page, either by percent or pixels.


This option is available only when you are adding a calendar.


 Height: (Conditional) Specify the height that you want the calendar to be on the landing 
page, either by percent or pixels.


This option is available only when you are adding a calendar.


 Show Title Bar: Select this option if you want the title bar to be displayed.


This option is available depending on what you select in the Enhanced View drop-down list.


4 Click OK.
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Adding a Graphic


Before you can add a graphic to your landing page, you need to attach the graphic to the landing 
page, as described in Section 6.9, “Enabling Graphics to Be Used on a Landing Page,” on page 80.


1 In the Landing Page Layout section, in the content editor, click Graphic in the element palette, then 
drag the graphic into the desired area of the landing page canvas.


2 Set the following configuration options to finish setting up the graphic:


 Graphic: In the Graphic drop-down list, select the graphic that you want to display.


All attachments that are attached to the landing page workspace are displayed in this list. 
Attachments are also displayed in the Current Attached Files section at the bottom of the 
page.


 Show border: Select this option if you want the border of the graphic to be visible.


3 Click OK.


Adding a Link (URL)


1 In the Landing Page Layout section, in the content editor, click Link (URL) in the element palette, 
then drag the link element into the desired area of the landing page canvas.
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2 Set the following configuration options to finish setting up the URL link:


 Title: Specify the title that you want to be displayed.


 URL: Specify the URL that you want to link to.


To link to a URL outside of Vibe, you must include http:// at the beginning of the URL.


To link to a page within Vibe, the best method is to use the Link to Folder/Workspace 
element or the Link to Entry element.


An alternative is to paste a Vibe permalink into this field. To get the permalink URL of a 
Vibe page, simply navigate to the page that you want to link to, click Permalink in the footer 
toolbar, then copy the permalink URL from the Permalink field.


 Open URL in a new window: Select this option if you want to open the URL in a new 
browser window.


3 Click OK.


Adding a Link to a Folder/Workspace


You can create a link to any folder or workspace for which you have appropriate rights.


1 In the Landing Page Layout section, in the content editor, click Link to Folder/Workspace in the 
element palette, then drag the link element into the desired area of the landing page canvas.


2 Click Edit next to the Folder/Workspace field.


If you are reconfiguring the element, the folder or workspace that is being referenced is shown 
here.
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3 Set the following configuration options to finish setting up the link:


 Find: Select whether you want to search the entire site for the folder or only within the 
current folder or workspace, then use the provided field to specify the folder or workspace 
that you want to link to.


This field uses type-to-find functionality, so Vibe displays the available options as you type.


 Title: Specify a title for the link.


 Open the folder/workspace in a new window: Select this option if you want to open the 
folder or workspace in a new browser window.


Adding a Link to an Entry


Enables you to create a link to any entry for which you have appropriate rights.


1 In the Landing Page Layout section, in the content editor, click Link to Entry in the element palette, 
then drag the link element into the desired area of the landing page canvas.


2 Click Edit next to the Entry field.


If you are reconfiguring the element, the entry or workspace that is being referenced is shown 
here.
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3 Set the following configuration options to finish setting up the link:


 Find: Select whether you want to search the entire site for the entry or only within the 
current folder or workspace, then use the provided field to specify the entry that you want 
to link to.


This field uses type-to-find functionality, so Vibe displays the available options as you type.


 Title: Specify a title for the link.


 Open the entry in a new window: Select this option if you want to open the entry in a new 
browser window.


Adding a Utility Element


Most utility elements are options that are normally displayed either in the Vibe masthead or 
Navigation panel; however, because it is often desirable to hide the masthead and Navigation panel 
in order to make more room for information on your landing page, utility elements enable you to 
display important features in a more concise view.


1 In the Landing Page Layout section, in the content editor, click Utility Element in the element 
palette, then drag the utility into the desired area of the landing page canvas.
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2 Select from the following utility elements:


Link to “Follow this folder or workspace”: Displays a Follow This Workspace or Follow This 
Folder link.


Link to “My Workspace”: Displays a link to your personal workspace.


Link to “Share this folder or workspace”: Displays a Share This Workspace or Share This Folder 
link.


Link to “Vibe administration page”: Provides a link to the Vibe Administration page.


This link is visible only to Vibe users who have administrative rights.


Sign-in form: Displays a Sign In form when users are not logged in to Vibe.


3 Click OK.


Adding a Custom JSP


Custom JSP files are stored in the WEB-INF\jsp\custom_jsps directory. If you want to include a 
custom JSP file in your landing page, you must store the file in this directory in order to reference it 
from Vibe.


Typically, only Vibe administrators have access to this directory. If you want to create a custom JSP 
file, consult your Vibe administrator.


After the custom JSP file has been placed in the WEB-INF\jsp\custom_jsps directory:


1 In the Landing Page Layout section, in the content editor, click Custom JSP in the element palette, 
then drag the JSP element into the desired area of the landing page canvas.
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2 In the Custom JSP name field, type the name of the custom JSP file that you want to reference.


You must obtain this filename from your Vibe administrator. Only your Vibe administrator can 
enable JSP files to be used in the Vibe site.


3 Depending on how you want to use this custom JSP file, select either Associate a folder with this 
custom jsp, or Associate an entry with this custom jsp.


For example, if your administrator has enabled a custom JSP file that enhances the way entries 
are displayed on the landing page, and you want to utilize this JSP file for a specific folder, you 
would select Associate a folder with this custom jsp.


4 Click Edit next to the Folder field.


If you are reconfiguring the element, the field displays the folder that the custom JSP file is 
currently associated with. If you are creating a new element, this field is blank.


5 Set the appropriate configuration options to finish setting up the custom JSP:


Find: Select whether you want to search the entire site for the folder or only within the current 
folder or workspace, then use the provided field to specify the folder that you want to associate 
the JSP file with.

72 Novell Vibe 3.2 Advanced User Guide







This field uses type-to-find functionality, so Vibe displays the available options as you type.


Number of entries to show: Specify how many folder entries you want to be displayed on the 
landing page at any one time.


Show Title Bar: Select this option if you want the title bar of the entry to be visible.


6 Click OK.


Adding an HTML Editor


To add content (such as text, links, pictures, and videos) to your landing page by using an HTML 
editor:


1 In the Landing Page Layout section, in the content editor, click HTML in the element palette, then 
drag the HTML element into the desired area of the landing page canvas.


2 Specify content in the HTML editor that you want to be displayed on the landing page. Click the 
Show/Hide icon  to show and hide additional options.


3 Click OK.


Adding an Embedded Web Page


1 In the Landing Page Layout section, in the content editor, click Embedded Web Page in the element 
palette, then drag the page into the desired area of the landing page canvas.
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2 Set the following configuration options to finish setting up the embedded Web page:


 URL: Specify the URL for the embedded Web page that you want to display.


 Name: Specify a name for the page. This name is displayed on the landing page above the 
embedded Web page.


 Height: Specify the height (in pixels) to indicate how much of the page you want to display.


 Width: Specify the width (in pixels) to indicate how much of the page you want to display.


 Show scrollbars: Select whether you want to display scroll bars. Keep the default of Auto if 
you want Vibe to auto detect whether scroll bars are needed.


 Show border: Select whether you want to display a border around the embedded Web 
page.


3 Click OK.


6.3 Publishing Your Landing Page
After you have added elements to your landing page and configured them, you need to publish the 
contents of the landing page.


1 Scroll to the bottom of the page that contains the landing page editor.


2 Click OK.


The landing page is displayed with all of the content that you previously added.


6.4 Modifying the Contents of Your Landing Page
Novell Vibe enables you to modify the elements that have been previously added to your landing 
page.


1 Navigate to the landing page that contains the elements that you want to modify.


For information about each type of element, see Section 6.2.4, “Configuring Landing Page 
Elements,” on page 61.


2 Click Workspace > Edit Workspace in the Action toolbar.


or


If your landing page is on a folder, click Folder > Edit Folder.
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3 In the Landing Page Layout section, in the content editor, click the edit icon  in the upper right 
corner of the landing page element that you want to modify.


The properties dialog box of the element that you are modifying is displayed.


4 Modify the properties of the element, then click OK.


6.5 Changing the Order of Landing Page Elements
Novell Vibe enables you to change the order of elements that have been previously added to your 
landing page.


1 Navigate to the landing that contains the elements that you want to reorder.


For information about each type of element, see Section 6.2.4, “Configuring Landing Page 
Elements,” on page 61.


2 Click Workspace > Edit Workspace in the Action toolbar.


or


If your landing page is on a folder, click Folder > Edit Folder.


3 In the Landing Page Layout section, in the content editor, click the Move icon  in the upper right 
corner of the landing page element that you want to move, then drag the element to the desired 
location on the landing page canvas.


4 Click OK.


6.6 Deleting Content from Your Landing Page
Novell Vibe enables you to delete elements that have previously been added to your landing page.


1 Navigate to the landing page that contains the element that you want to delete.


2 Click Workspace > Edit Workspace in the Action toolbar.


or


If your landing page is on a folder, click Folder > Edit Folder.
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3 In the Landing Page Layout section, in the content editor, click the delete  icon in the upper right 
corner of the landing page element that you want to delete.


4 Click OK to delete the element.


6.7 Automatically Displaying the Newest Folder Entries on 
Your Landing Page
You do not need to manually modify your landing page every time you want to replace an entry. 
Because it can be tedious to delete an entry and then add another one from the Add/Delete form in 
the Edit Workspace page, Novell Vibe enables you to leverage the power of workflows to help keep 
your landing page up-to-date, with minimal manual effort.


For example, suppose that you are the manager of a particular product, and you want to use your 
team landing page to display the product’s earnings for the most recent quarter. You could reference 
a particular entry in the Quarterly Earnings folder, where all of the quarterly earnings for the product 
are stored; however, this would mean that at the end of each quarter you would need to manually 
delete the old entry from your landing page, and then add the new entry for the new quarter. Vibe 
provides an easier way: simply reference the Quarterly Earnings folder from your landing page, and 
at the end of each quarter start the Publish workflow (as described in Section 11.6.1, “Available 
Workflows,” on page 154) on the entry that contains the earning for that quarter. This displays the 
entry that contains the updated quarterly earnings.


 Section 6.7.1, “Pointing to the Folder Where the Entry Resides,” on page 76


 Section 6.7.2, “Using the Publish Workflow to Publish Entries to Your Landing Page,” on page 77


6.7.1 Pointing to the Folder Where the Entry Resides


When you add content to your landing page (as described in Section 6.2.3, “Adding Content to Your 
Landing Page,” on page 59), if you display an entry that you might want to replace in the future, you 
should reference the folder where the entry resides instead of referencing the entry directly.


1 Navigate to your landing page.


2 Click Workspace > Edit Workspace.


or


If your landing page is on a folder, click Folder > Edit Folder.


3 In the Landing Page Layout section, in the content editor, click Folder in the element palette, then 
drag the folder into the desired area of the landing page canvas.

76 Novell Vibe 3.2 Advanced User Guide







4 Set the following configuration options to finish setting up the folder:


 Folder: Click Edit. 


If you have configured this element as described in this section, the folder that is being 
referenced is shown here.


 Find: Specify the folder where the entry that you want to display resides.


This field uses type-to-find functionality, so Vibe displays the available options as you type.


 Number of entries to show: Specify the number of folder entries that you want to be 
displayed at any one time.


 Show Title Bar: Select this option if you want the folder title bar to be displayed.


 Show Folder Description: Select this option if you want the folder description to be 
displayed.


 Show Entries opened: Select this option if you want opened entries to be displayed.


5 Click OK.


6.7.2 Using the Publish Workflow to Publish Entries to Your Landing Page


By default, Vibe includes a workflow called Publish. This workflow can help you more easily manage 
what is displayed on your landing page.


If you are referencing a folder from your landing page (as described in Section 6.7.1, “Pointing to the 
Folder Where the Entry Resides,” on page 76), and you have configured the landing page to display 
just one entry from the folder, you can use the Publish workflow to decide which entry you want to 
display on your landing page.


The most recent entry that you publish is the entry that is displayed on the landing page (published 
to the landing page).


 “Enabling the Publish Workflow on Your Folder” on page 78


 “Publishing a New Entry to Your Landing Page” on page 78
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Enabling the Publish Workflow on Your Folder


1 Navigate to the folder where you want to enable the Publish workflow.


2 Click Folder > Configure Views, URLs and Controls in the Action toolbar.


3 On the Folder Views, Entries and Workflows tab, in the Allowed Workflows section, select Publish 
Workflow.


4 Click Apply > Close.


Publishing a New Entry to Your Landing Page


1 Open the entry that you want to display on your landing page.


2 In the Entry toolbar, click Workflow > Start Workflow: Publish Workflow.


The entry where you most recently started the Publish workflow is now displayed on your 
landing page, replacing the entry that was previously displayed.


6.8 Adding Accessories to Your Landing Page
You can add accessories to a landing page by modifying the view of the standard landing page, or by 
creating a new landing page view. You must be the Vibe administrator to modify the view of the 
standard landing page. If you are not the Vibe administrator, you must create a new landing page 
view.


 Section 6.8.1, “Modifying the Default Landing Page,” on page 78


 Section 6.8.2, “Creating a New Landing Page View,” on page 79


6.8.1 Modifying the Default Landing Page


You can add the Accessory Panel to the default Landing Page view. This means that all landing pages 
that are created in the Vibe site will contain the Accessory Panel.


You must be the Novell Vibe administrator or have administrative rights to modify the default 
Landing Page view.


1 Click the Administration icon  in the upper right corner of the Vibe page.


The administration page is displayed.


2 Under System, click Form/View Designers.


The Form and View Designers page is launched.


3 Expand Workspace view, then click Landing Page.


4 Click Workspace view > Add.


5 In the Standard Form Elements section, click Accessory Panel, then click OK.


The Accessory Panel has now been added to the standard Landing Page view, so users can add 
accessories to their landing pages.
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6.8.2 Creating a New Landing Page View


You can create your own Landing Page view, then add the Accessory Panel element to the view. You 
do not need to be the Vibe administrator to create a new landing page view.


 “Creating the New Landing Page Definition” on page 79


 “Adding the Landing Page Layout Option” on page 79


 “Enabling the New Landing Page” on page 80


 “Modifying the Landing Page After You Have Created It” on page 80


Creating the New Landing Page Definition


1 Navigate to the workspace where you want to create the new Landing Page view.


2 Click Workspace > Form/View Designers in the Action toolbar.


The Form and View Designers page is displayed.


3 Click New > Workspace views.


4 Specify the following information:


Caption: Specify a name for the new landing page.


This is the name that appears in the Vibe interface for users to see when they use this workspace. 
(For example, Custom Landing Page.)


Name: Specify the internal name for the landing page.


The name that you enter in this field is not visible to users who use this workspace. (For 
example, custom_landing_page.)


Family: Select the workspace type that this view is most closely associated with.


Workspace Icons: Select the workspace icon that you want to represent the landing page.


5 Click OK.


The Designer page is launched.


6 Continue with “Adding the Landing Page Layout Option” on page 79.


Adding the Landing Page Layout Option


1 In the Designer page, click Workspace Add/Modify Form > Add.


2 In the Layout Options section, click Landing Page Layout.


3 Specify the following information:


Caption: Specify a name for the Landing Page Layout, or keep the default.


Name: Specify the internal name for the Landing Page Layout.


4 Click OK.


5 Click Workspace view > Add.


6 In the Standard Form Elements section, click Landing Page Layout.


7 For the Caption and Data item name fields, retain the same information that you specified in 
Step 3.


8 Click OK > Close > Close.


9 Continue with “Enabling the New Landing Page” on page 80.
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Enabling the New Landing Page


After you have created the new landing page view, you need to enable it on the workspace.


1 From the workspace where you want to enable the landing page, click Workspace > Configure 
Views, URLs and Controls.


2 On the Configure Workspace View tab, in the Default View section, go to the Local Definitions 
subsection and select the landing page that you created.


3 Click Apply > Close.


The landing page is now displayed when you access the workspace.


4 Continue with “Modifying the Landing Page After You Have Created It” on page 80.


Modifying the Landing Page After You Have Created It


Now that you have created and enabled the new landing page, you can configure the landing page 
layout options, such as hiding the Navigation panel. This can give your landing page a more 
traditional landing page feel.


For information about how to modify the landing page layout options, see Section 6.2.1, “Choosing 
Layout Options for Your Landing Page,” on page 57.


6.9 Enabling Graphics to Be Used on a Landing Page
Before you can add a graphic to a landing page, as described in “Adding a Graphic” on page 67, you 
need to attach the graphic to the workspace or folder, depending on whether your landing page is on 
a workspace or folder.


 Section 6.9.1, “Enabling Graphics to Be Used on a Workspace Landing Page,” on page 80


 Section 6.9.2, “Enabling Graphics to Be Used on a Folder Landing Page,” on page 80


6.9.1 Enabling Graphics to Be Used on a Workspace Landing Page


1 Navigate to the landing page where you want to attach the graphic.


2 Click Workspace > Edit Workspace.


3 In the Attachments section, click Browse, then browse to and select the graphic that you want to 
add.


4 After the file is selected and is displayed in the Attachments field, click OK.


To delete a file from the workspace:


1 In the Current Attached Files section, select the file that you want to delete.


2 Click OK.


6.9.2 Enabling Graphics to Be Used on a Folder Landing Page


 “Adding the Attachment Element to the Folder Form” on page 81


 “Attaching the Graphic to the Folder” on page 81
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Adding the Attachment Element to the Folder Form


You should have already added the Landing Page element to both the folder Form and View in order 
to create a landing page for a folder. (For more information, see Section 6.12, “Creating a Landing 
Page for a Folder,” on page 82.)


To enable graphics to be used on your folder landing page:


1 Add the Attachments element to the folder Form, as described in Section 8.2, “Modifying an 
Existing Folder View,” on page 100.


You do not need to add the Attachments element to the folder View, because this element should 
only be displayed on the folder Form.


2 Continue with “Attaching the Graphic to the Folder” on page 81.


Attaching the Graphic to the Folder


1 Navigate to the landing page where you want to attach the graphic.


2 Click Folder > Edit Folder.


3 In the Attachments section, click Browse, then browse to and select the graphic that you want to 
add.


4 After the file is selected and is displayed in the Attachments field, click OK.


To delete a file from the folder:


1 In the Current Attached Files section, select the file that you want to delete.


2 Click OK.


6.10 Displaying YouTube Videos on a Landing Page
Novell Vibe enables you to display YouTube videos in various sections of a landing page.


 Section 6.10.1, “Displaying Videos in the Branding Section of a Landing Page,” on page 81


 Section 6.10.2, “Displaying Videos in the Main Landing Page Area,” on page 81


6.10.1 Displaying Videos in the Branding Section of a Landing Page


You can add a YouTube video to the Branding section of a landing page, as described in Chapter 5, 
“Branding a Folder or Workspace,” on page 53.


6.10.2 Displaying Videos in the Main Landing Page Area


You can display YouTube videos on a landing page in the following ways:


 By adding an HTML editor, as described in “Adding an HTML Editor” on page 73. Click the 
Expand icon , then click the Video icon .


 By referencing a folder or folder entry that contains a YouTube video, as described in 
Section 6.2.3, “Adding Content to Your Landing Page,” on page 59.
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 For information on how to create a folder entry that contains a YouTube video, see “Displaying 
YouTube Videos in a Folder Entry” in the Novell Vibe 3.2 User Guide.


![01/27/12: In the Discription section of the workspace, as described in “Displaying YouTube 
Videos in a Workspace” in the Novell Teaming 3 User Guide.] 


6.11 Creating a Landing Page for a Personal Workspace
You can create a landing page in a personal workspace only if your Novell Vibe administrator has 
enabled you to do so. If you are unable to create a landing page on your personal workspace as 
described in this section, consult your Vibe administrator.


If you are a Vibe administrator and you want to enable landing page creation for personal 
workspaces, see “Enabling Users to Create Landing Pages on Personal Workspaces” in the  Novell 
Vibe 3.2 Administration Guide.


1 In your personal workspace, click Workspace > Configure Views, URLs and Controls in the Action 
toolbar.


2 On the Configure Workspace View tab, in the Default View section, select the landing page option 
that your administrator added.


3 Click Apply > Close.


4 Continue with Section 6.2, “Setting Up Your Landing Page,” on page 57 to complete the creation 
of your landing page.


6.12 Creating a Landing Page for a Folder
Displaying landing pages at the workspace level makes the workspace home page a quick portal to 
the most important information contained throughout the workspace. In addition to displaying 
landing pages at the workspace level, Novell Vibe also enables you to display landing pages at the 
folder level.


You might want to create a landing page for a folder if your folder contains many sub-folders, is 
frequently visited, and contains a lot of information. Because workspace landing pages are more 
common than folder landing pages, the process for creating a landing page on the folder is more 
complex than creating a landing page for a workspace.


By default, in order to create a landing page for a folder in Vibe, you need to create a new folder view. 
(For example, you might name your folder view “Landing Page.”) You need to populate this folder 
view with the Landing Page Layout layout option in the Folder Form, and the Landing Page Layout 
element in the Folder View. For information on how to create a landing page by creating a new folder 
view, see Chapter 8, “Creating Custom Folder Views,” on page 95.
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After you create the new landing page folder view, continue setting up your landing page by 
following the information in Section 6.2, “Setting Up Your Landing Page,” on page 57.


6.13 Downloading Existing Landing Pages
The Novell Vibe Resource Library provides a collection of existing Vibe folder entry forms, 
workflows, and landing pages that have been designed to solve specific business problems. You can 
easily download the custom forms and workflows, then import them into your Vibe environment. 
You can further customize these forms and workflows to suit your individual business needs.


1 Navigate to the Novell Vibe Resource Library Web site (http://www.novell.com/products/vibe-
onprem/resource-library/).


2 Click the Workspaces tab.


3 Select the custom workspace that you want to use in your Vibe environment.


4 In the Attachment section, click the zip file to download it.


5 Import the file into your Vibe environment and deploy it for use.


For information on how to do this, follow the Novell Vibe Resource Library Deployment 
Instructions (http://www.novell.com/products/vibe-onprem/resource-library/demos/
form_workflow_deployment.html).
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7 7Creating Custom Workspace Views


Novell Vibe enables you to create custom workspace views and to customize existing views. 
Workspace views define what is displayed on the home page of your workspace. When you create 
custom workspace views, you can configure workspaces to display optional features such as remote 
applications, attachments, and more. You can even create a custom workspace landing page.


To create a custom workspace view, you must complete the following sections:


 Section 7.1, “Creating a New Custom Workspace View,” on page 85


 Section 7.2, “Modifying an Existing Workspace View,” on page 90


 Section 7.3, “Enabling the Workspace View,” on page 90


 Section 7.4, “Populating Elements in the Workspace View,” on page 91


 Section 7.5, “Understanding Elements,” on page 91


 Section 7.6, “Understanding Layout Options,” on page 93


7.1 Creating a New Custom Workspace View
To create a new custom workspace, you use the Form and View Designer to create a view, then you 
create a form with the elements and layout options that you want to display in the view. After the 
form is in place, you add the same elements and layout options to the view, then you can add 
optional view elements to create the final view.


You must have both a form and a view in order to display all the elements that you want in a 
workspace. The form and the view must have a common set of elements and layout options, but the 
view can have some additional elements that are not in the form.


 Section 7.1.1, “Creating the View,” on page 86


 Section 7.1.2, “Adding Elements to the Workspace Add/Modify Form,” on page 86


 Section 7.1.3, “Adding Elements to the Workspace View,” on page 88
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7.1.1 Creating the View


1 Navigate to the workspace where you want to create the new view.


2 Click Workspace > Form/View Designers in the Action toolbar.


The Form and View Designers page is launched.


3 Click New > Workspace Views.


The Add a New Definition form is displayed.


4 Specify the following information in the Add a New Definition section:


Caption: Specify the name of the workspace view that you want to appear in the Novell Vibe 
interface. (For example, “Custom Workspace.”)


Name: Specify the internal name of the workspace view. This name is not visible to regular Vibe 
users. (For example, “custom_workspace.”)


Family: Select the workspace type that this view is most closely associated with.


Workspace Icons: Select the icon that you want to represent the workspace. The icon that you 
select is displayed with the name of the workspace in the Navigation panel.


5 Click OK.


6 Continue with Section 7.1.2, “Adding Elements to the Workspace Add/Modify Form,” on 
page 86.


7.1.2 Adding Elements to the Workspace Add/Modify Form


The workspace add/modify form is the form you see when you are creating or modifying the content 
of your workspace home page. This form needs to contain the elements and layout options that you 
want to display in your workspace home page. For example, you might want to display multiple 
remote applications and a two-column table.


After you add elements and layout options to the workspace form, you must then add those same 
elements and layout options to the workspace view in order for the elements and options to be 
displayed in your workspace. For information on how to add features to the workspace view, see 
Section 7.1.3, “Adding Elements to the Workspace View,” on page 88.


1 Under the custom workspace form that you created, expand Workspace Add/Modify Form.


If you are modifying an existing form, all of the elements and layout options that are currently 
applied to your form are displayed.


or


If you are creating a new form, only the default options are displayed.
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2 Add and modify the desired elements and layout options, as described in the following sections:


 “Adding Elements to a Form” on page 87


 “Modifying Elements in a Form” on page 87


 “Deleting Elements in a Form” on page 88


 “Adding Layout Options to a Form” on page 88


Based on the modifications that you make to a form element or option, you might need to make the 
same modifications to the corresponding view element or option.


Adding Elements to a Form


1 Click Workspace Add/Modify Form.


2 In the Workspace Add/Modify Form window on the right side of the page, click Add.


3 In the Standard Form Elements section, click the element that you want to add.


For information on the types of elements that you can add, see Section 7.5.1, “Workspace Form 
Elements,” on page 91.


4 Specify the appropriate information.


5 Click OK.


Modifying Elements in a Form


If you are modifying an existing form, you can modify existing elements.


1 Expand Workspace Add/Modify Form, then click the element that you want to modify.


2 In the window on the right side of the page, click Modify.


3 Make the desired modifications, such as changing the caption or data name, then click OK.
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Deleting Elements in a Form


If you are modifying an existing form, you can delete existing elements.


1 Expand Workspace Add/Modify Form, then click the element that you want to delete.


2 In the window on the right side of the page, click Delete.


3 Click OK.


Adding Layout Options to a Form


1 Click Workspace Add/Modify Form.


2 In the Workspace Add/Modify Form window on the right side of the page, click Add.


3 In the Layout Options section, click the layout option that you want to add.


For information on the types of layout options that you can add, see Section 7.6, “Understanding 
Layout Options,” on page 93.


4 Specify the appropriate information.


5 Click OK.


7.1.3 Adding Elements to the Workspace View


The workspace view is how the information from your workspace add/modify form is displayed to 
users who view your workspace. Every form must have a corresponding view. This view needs to 
contain all of the elements and layout options that you want to display in your workspace home 
page; it is made up of elements from the form.


Vibe provides you with all of the tools necessary to create a workspace view that suits any of the 
purposes that you want to accomplish with your workspace.


Before you can add elements and layout options to the workspace view, you must first add the 
elements and layout options to the workspace form in order for them to be displayed in your 
workspace. (For information on how to add features to the workspace form, see Section 7.1.2, 
“Adding Elements to the Workspace Add/Modify Form,” on page 86.)


To add elements to the views:


1 Under the custom entry form that you created, expand Workspace view.


If you are modifying an existing view, all of the elements and layout options that are currently 
applied to your view are displayed.


or


If you are creating a new view, only the default options are displayed.
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2 Add the desired elements and layout options, as described in the following sections:


 “Adding Elements to a View” on page 89


 “Modifying Elements in a View” on page 89


 “Deleting Elements in a View” on page 89


 “Adding Layout Options to a View” on page 90


Adding Elements to a View


1 Click Workspace view.


2 In the Workspace View window on the right side of the page, click Add.


3 In the Standard Form Elements section, click the element that you want to add.


When you add elements to a view, you add elements that have already been added to the form; 
any form element that you create can be added as a view element.


For information on the types of elements that you can add that are specific to views, see 
Section 7.5.2, “Workspace View Elements,” on page 92.


4 Specify the appropriate information.


5 Click OK.


Modifying Elements in a View


If you are modifying an existing view, you can modify existing elements.


1 Expand Workspace view, then click the element that you want to modify.


2 In the window on the right side of the page, click Modify.


3 Make the desired modifications, such as changing the caption or data name, then click OK.


Deleting Elements in a View


If you are modifying an existing view, you can delete existing elements.


1 Expand Workspace view, then click the element that you want to delete.


2 In the window on the right side of the page, click Delete.


3 Click OK.
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Adding Layout Options to a View


1 Click Workspace view.


2 In the Workspace view window on the right side of the page, click Add.


3 In the Layout Options section, click the layout option that you want to add.


For information on the types of layout options that you can add, see Section 7.6, “Understanding 
Layout Options,” on page 93.


4 Specify the appropriate information.


5 Click OK.


7.2 Modifying an Existing Workspace View
You can also create a custom workspace by modifying an existing workspace view.


1 In the folder or workspace where the custom workspace view was created, click Workspace > 
Form/View Designers.


The Form and View Designers page is launched.


2 Expand Workspace view, then click the custom workspace view that you want to modify.


3 Continue with Section 7.1.2, “Adding Elements to the Workspace Add/Modify Form,” on 
page 86.


7.3 Enabling the Workspace View
After you have created the workspace view, you need to enable it as the default view for the 
workspace.


1 Navigate to the workspace where you want to enable your custom view as the default view.


2 Click Workspace > Configure Views, URLs and Controls in the Action toolbar.


3 On the Configure Workspace View tab, in the Local Definitions section, select the custom view that 
you created.


4 Click Apply > Close.
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7.4 Populating Elements in the Workspace View
After you create a workspace view, you need to populate and customize some of the elements that 
you included in the view. 


For example, if you added a Branding element, you need to create your brand to display in the 
workspace; if you added a Description element, you need to populate the element with a description 
of the workspace; if you added an Attachment element, you need to attach any files that you want to 
display in the workspace, and so forth.


1 After the workspace view has been created and enabled as the default workspace view, as 
described in Section 7.3, “Enabling the Workspace View,” on page 90, navigate to the workspace.


2 Click Workspace > Edit Workspace.


A page with all of the form elements that you added to the workspace view add/modify form is 
displayed. (If you want these elements to be displayed in the workspace, ensure that you have 
also added them to the view form of the workspace view.)


3 Populate the elements with the desired information.


For example, add a workspace description and attach any files.


4 Click OK.


7.5 Understanding Elements
Elements make up the content of your workspace forms and views. 


When you are adding elements to a form, remember that you need to add that same element to the 
view in order for it to be displayed in the workspace.


You can add the following elements:


 Section 7.5.1, “Workspace Form Elements,” on page 91


 Section 7.5.2, “Workspace View Elements,” on page 92


7.5.1 Workspace Form Elements


Attachment(s): Adds a field that enables you to browse for and upload files, making them accessible 
to those who view the workspace.


The files that you upload are displayed in the workspace home page.


Checkbox: Adds a check box that can be selected or deselected.


Date: Adds a field that launches a calendar applet when users click inside it.


Date and Time: Adds two fields. The first field launches a calendar applet, and the second field 
launches a time-selection applet when users click inside.


E-Mail List: Adds a field that enables you to specify e-mail addresses.


Description: Adds an HTML text editor that enables you to specify a description of the workspace.


File Upload: Adds a field that enables users to browse for and upload files.


Group List: Adds an element that enables users to add groups.
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Hidden Field: Adds a hidden element. When you design the custom form, you can use this element 
to add boilerplate text to every entry that is created. This text is “hidden” because it does not appear 
on the entry form when users are creating an entry; however, the text does appear on the entry view 
after the entry is created.


HTML Editor Text Area: Adds an HTML text area where you can compose messages, create links, 
upload pictures, and more. The information that you create in this HTML editor is displayed in your 
folder.


Icon: Enables the workspace owner to choose from a selection of icons to represent the workspace.


Number: Adds a field that requires users to enter a number. Alphabetic characters are rejected.


Picture: Adds a field that enables you to browse for and upload pictures.


Radio Buttons: Enables you to display options that users can select with radio buttons.


Remote Application: Enables you to display certain applications that have been configured by your 
Vibe administrator.


For more information on remote applications, see Chapter 12, “Managing Remote Applications,” on 
page 159.


Selectbox: Enables you to display options that users can select.


Team List: Adds a field that enables users to specify teams.


Text: Adds a field where users can enter text.


Text Area: Adds an expandable field where users can enter text.


Title: Adds a field that enables you to specify a title for the workspace.


URL: Add a field that converts any text into a hyperlink. 


User List: Adds a field that enables you to specify other Vibe users, using type-to-find functionality. 
When you specify a user’s name when you modify the workspace, as described in Section 8.4, 
“Populating Elements in the Folder View,” on page 101, Vibe displays the user’s name on the folder 
home page, with links to his or her personal workspaces.


Users External to Vibe: Vibe uses this option internally when synchronizing tasks and calendars to 
another application through iCal. You should not manually add this element to any form or view.


For more information about iCal in Vibe, see “Synchronizing Tasks and Calendars to a Desktop 
Application” in the Novell Vibe 3.2 User Guide.


7.5.2 Workspace View Elements


Any form element that you create can be added as a view element, if you want it to appear in the 
view. 


The following elements are specific to views; they cannot be added to a form.


Accessory Panel: Displays the Accessory Panel on the workspace home page. Users can use this 
panel to add community or personal accessories, depending on their individual rights.


For more information on accessories, see “Managing Accessories” in the Novell Vibe 3.2 User Guide.


Attachments: Displays all attachments.
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Landing Page Layout: Adds a landing page creation form that enables you to create landing page 
elements to display in your workspace.


You must add the Landing Page Layout layout option in the workspace add/modify form before you 
can add it as a view element.


Title: On the workspace home page, displays the title that you specified for the workspace.


Workspace and Folder List: Displays a workspace tree that contains the workspace and all sub-
workspaces and sub-folders.


7.6 Understanding Layout Options
Layout options can enhance the presentation of your workspace forms and views. 


When you are adding layout options to a form, remember that you need to add the same layout 
options to the view in order for it to be displayed in the workspace.


You can add the following form layout options:


Box: Places a box around the specified elements.


Custom JSP: Enables you to reference a custom JSP from the Vibe directory.


Custom JSPs must be created by Vibe administrators before you can reference them, as described in 
Chapter 10, “Using Custom JSP Files to Enhance Your Vibe Pages,” on page 117.


Divider: Displays a horizontal line between elements.


Expandable Area: Displays an expandable tree element.


Fieldset: Adds a box that can contain other elements.


Use this option if your form is exceptionally long.


HTML: Adds HTML formatting.


Landing Page Layout: (For the View Definition, the Landing Page Layout is in the Elements section) 
Adds a landing page creation form that enables you to create landing page elements that you can 
populate when you modify your workspace.


Three Column Table: Enables you to add elements within a three-column table.


Two Column Table: Enables you to add elements within a two-column table.

Creating Custom Workspace Views 93







94 Novell Vibe 3.2 Advanced User Guide







8 8Creating Custom Folder Views


Novell Vibe enables you to design custom folder views. Folder views define what is displayed on the 
home page of your folder. When you design custom folder views, you can configure folders to 
display optional features such as remote applications, attachments, and more. You can even create a 
folder landing page.


To create a custom folder view, you must complete the following sections:


 Section 8.1, “Creating a New Custom Folder View,” on page 95


 Section 8.2, “Modifying an Existing Folder View,” on page 100


 Section 8.3, “Enabling the Folder View,” on page 101


 Section 8.4, “Populating Elements in the Folder View,” on page 101


 Section 8.5, “Understanding Elements,” on page 101


 Section 8.6, “Understanding Layout Options,” on page 103


8.1 Creating a New Custom Folder View
To create a new custom folder, you use the Form and View Designer to create a view, then you create 
a form with the elements and layout options that you want to display in the view. After the form is in 
place, you add the same elements and layout options to the view, then you can add optional view 
elements to create the final view.


You must have both a form and a view in order to display all the elements that you want in a folder. 
The form and the view must have a common set of elements and layout options, but the view can 
have some additional elements that are not in the form.


 Section 8.1.1, “Creating the View,” on page 95


 Section 8.1.2, “Adding Elements to the Folder Add/Modify Form,” on page 96


 Section 8.1.3, “Adding Elements to the Folder View,” on page 98


8.1.1 Creating the View


1 Navigate to the folder or workspace where you want to create the new view.


If you create a new folder view at the workspace level, the folder view can be enabled on any 
folder within the workspace. If you create the folder view at the folder level, the folder view can 
be enabled only on that folder where the view was created.


2 If you are creating the new folder view at the folder level, click Folder > Form/View Designers in 
the Action toolbar.


or
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If you are creating the new folder view at the workspace level, click Workspace > Form/View 
Designers in the Action toolbar.


The Form and View Designers page is displayed.


3 Click New > Folder Views.


The Add a New Definition form is displayed.


4 Specify the following information in the Add a New Definition section:


Caption: Specify the name of the folder view that you want to appear in the Novell Vibe 
interface. (For example, “Custom Blog.”)


Name: Specify the internal name of the folder view. This name is not visible to regular Vibe 
users. (For example, “custom_blog.”)


Family: Select the folder type that this view is most closely associated with.


Create a File Entry on file drag/drop: Select this option if you want Vibe to create a new file 
entry when you drag and drop a file into the folder by using the Add Files to Folder feature, as 
described in “Adding a File by Dragging and Dropping” in the Novell Vibe 3.2 User Guide.


If you do not select this option, the default entry type for the folder is created when you drag 
and drop a file into the folder using the Add Files to Folder feature, as described in “Dragging 
and Dropping Files” in the Novell Vibe 3.2 User Guide. For example, in a Blog folder, a blog entry 
is created, and the file is added as an entry attachment.


If you are creating a new view for a Files folder, this option has no effect.


Folder Icons: Select the icon that you want to represent the folder. The icon that you select is 
displayed with the name of the folder in the Navigation panel.


5 Click OK.


6 Continue with Section 8.1.2, “Adding Elements to the Folder Add/Modify Form,” on page 96.


8.1.2 Adding Elements to the Folder Add/Modify Form


The Folder Form section in the Form and View Designers tool lets you choose the features you want to 
include in your folder.


After you add elements and layout options to the folder form, you must then add those same 
elements and layout options to the folder view in order for them to be displayed in your folder. For 
information on how to add features to the folder view, see “Adding Elements to a Folder Form” on 
page 97.


Vibe provides you with all of the tools necessary to create a folder form that suits any purpose that 
you want to accomplish with your folder.


1 Expand the custom folder form that you previously defined.
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2 Add, modify, and delete elements and layout options, as described in the following sections:


 “Adding Elements to a Folder Form” on page 97


 “Modifying Elements in a Folder Form” on page 97


 “Deleting Elements in a Folder Form” on page 98


 “Adding Layout Options to a Form” on page 98


Based on the modifications that you make to a form element or option, you might need to make the 
same modifications to the corresponding view element or option.


Adding Elements to a Folder Form


1 Click Folder Form.


2 In the Folder Form window on the right side of the page, click Add.


3 In the Standard Form Elements section, click the element that you want to add.


For information on the types of elements that you can add, see Section 8.5.1, “Folder Form 
Elements,” on page 101.


4 Specify the appropriate information to configure the element.


5 Click OK.


Modifying Elements in a Folder Form


If you are modifying an existing form, you can modify existing elements.


1 Expand Folder Form, then click the element that you want to modify.


2 In the window on the right side of the page, click Modify.


3 Make the desired modifications, such as changing the caption or data name, then click OK.
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Deleting Elements in a Folder Form


If you are modifying an existing form, you can delete existing elements.


1 Expand Folder Form, then click the element that you want to delete.


2 In the window on the right side of the page, click Delete.


3 Click OK.


Adding Layout Options to a Form


1 Click Folder Form.


2 In the Folder Form window on the right side of the page, click Add.


3 In the Layout Options section, click the layout option that you want to add.


For information on the types of layout options that you can add, see Section 8.6, “Understanding 
Layout Options,” on page 103.


4 Specify the appropriate information to configure the layout option.


5 Click OK.


8.1.3 Adding Elements to the Folder View


The folder view is how your folder form is displayed to other users. Every folder form must have a 
view associated with it. This view needs to contain all of the elements that you want to display in 
your folder.


Vibe provides you with all of the tools necessary to create a folder view that suits any purpose that 
you want to accomplish with your folder.


1 Expand the custom folder view that you previously defined, then expand Folder View.


If you are modifying an existing view, all of the elements and layout options that are currently 
applied to the view are displayed.


or


If you are creating a new view, only the default options are displayed.
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2 Add, modify, and delete elements and layout options, as described in the following sections:


 “Adding Elements to a Folder View” on page 99


 “Modifying Elements in a Folder View” on page 99


 “Deleting Elements in a Folder View” on page 100


 “Adding Layout Options to a Folder View” on page 100


Adding Elements to a Folder View


1 Click Folder View.


2 In the Folder View Definition window on the right side of the page, click Add.


3 In the Standard Form Elements section, click the element that you want to add to the view.


For information on the types of elements that you can add, see Section 8.5.2, “Folder View 
Elements,” on page 103.


Before you can add some of these elements to your Folder View, you must first add them to the 
Folder Form. For information on how to do this, see “Adding Elements to a Folder Form” on 
page 97.


4 Specify the appropriate information to configure the element.


5 Click OK.


Modifying Elements in a Folder View


If you are modifying an existing view, you can modify existing elements.


1 Expand Folder View, then click the element that you want to modify.


2 In the window on the right side of the page, click Modify.


3 Make the desired modifications, such as changing the caption or data name, then click OK.
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Deleting Elements in a Folder View


If you are modifying an existing view, you can delete existing elements.


1 Expand Folder View, then click the element that you want to delete.


2 In the window on the right side of the page, click Delete.


3 Click OK.


Adding Layout Options to a Folder View


1 Click Folder View.


2 In the Folder View window on the right side of the page, click Add.


3 In the Layout Options section, click the layout option that you want to add.


For information on the types of layout options that you can add, see Section 8.6, “Understanding 
Layout Options,” on page 103.


4 Specify the appropriate information to configure the layout option.


5 Click OK.


8.2 Modifying an Existing Folder View
In addition to creating a new custom folder view as described in Section 8.1, “Creating a New 
Custom Folder View,” on page 95, you can create a custom folder by modifying an existing folder 
view.


1 In the folder or workspace where the custom folder view was previously defined, click Folder > 
Form/View Designers.


The Form and View Designers page is launched.


2 Expand Folder Views, then click the custom folder view that you want to modify.


3 Continue with Section 8.1.2, “Adding Elements to the Folder Add/Modify Form,” on page 96.
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8.3 Enabling the Folder View
After you have defined and designed the folder view, you need to enable it to be viewed by those 
who will use the folder.


You can enable the folder view to be the default folder view for a folder, or to be an alternate folder 
view.


For information on how to do this, see Section 3.1, “Managing Folder Views,” on page 25.


8.4 Populating Elements in the Folder View
After you create and enable a folder view, you need to populate and customize some of the elements 
that you included in the view. 


For example, if you added a Branding element, you need to create your brand to display in the folder; 
if you added a Description element, you need to populate the element with a description of the 
folder; if you added an Attachment element, you need to attach any files that you want to display in 
the folder, and so forth.


1 Ensure that the folder view has been created and enabled as the default folder view, as described 
in Section 8.1, “Creating a New Custom Folder View,” on page 95 and Section 8.3, “Enabling the 
Folder View,” on page 101.


2 Navigate to the folder where you enabled the folder view.


3 Click Folder > Edit Folder in the Action toolbar.


A page with all of form elements that you added to the folder form is displayed. (If you want 
these elements to be displayed in the folder, ensure that you have also added them to the folder 
view, as described in Section 8.1.3, “Adding Elements to the Folder View,” on page 98.)


4 Populate the elements with the desired information.


For example, create your folder brand, add a folder description, attach any files, and so forth.


5 Click OK.


8.5 Understanding Elements
Elements make up the content of your forms and views. Some elements can be used only once. 


When you are adding elements, remember that when you add an element to a form, you need to add 
that same element to the view in order for it to be displayed in the folder.


You can add the following elements:


 Section 8.5.1, “Folder Form Elements,” on page 101


 Section 8.5.2, “Folder View Elements,” on page 103


8.5.1 Folder Form Elements


Attachments: Enables you to display uploaded files as an attachment.


Attachments include a thumbnail, and details about the document, such as file size and author.
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Checkbox: Adds a check box that can be selected or deselected.


Date: Adds a field that launches a calendar applet when users click inside it.


Date and Time: Adds two fields. The first field launches a calendar applet, and the second field 
launches a time-selection applet when users click inside.


E-Mail Address List: Adds a field that enables you to specify e-mail addresses.


Description: Adds an HTML text editor that enables you to provide a description of the folder.


File Upload: Enables you to upload files.


Group List: Adds an element that enables users to add groups.


Hidden Field: Adds a hidden element. When you design the custom form, you can use this element 
to add boilerplate text to every entry that is created. This text is “hidden” because it does not appear 
on the entry form when users are creating an entry; however, the text does appear on the entry view 
after the entry is created.


HTML Editor Text Area: Adds an HTML text editor where you can compose messages, create links, 
upload pictures, and more. The information that you create in this HTML editor is displayed in your 
folder.


Icon: Enables you to change the folder icon that is displayed in the Navigation panel.


Number: Adds a field that requires users to enter a number. Alphabetic characters are rejected.


Picture: Adds a field that enables you to upload a picture to display in your folder.


Radio Buttons: Enables you to display options that users can select with radio buttons.


Remote Application: Enables you to display certain applications that have been configured by your 
Vibe administrator.


For more information on remote applications, see Chapter 12, “Managing Remote Applications,” on 
page 159.


Selectbox: Enables you to display options that users can select.


Team List: Adds a field that enables users to specify teams.


Text: Adds a field where users can enter text.


Text Area: Adds an expandable field where users can enter text.


Title: Adds a field that enables you to specify a title for the workspace.


URL: Add a field that converts any text into a hyperlink. 


User List: Adds a field that enables you to specify other Vibe users, using type-to-find functionality. 
When you specify a user’s name when you modify the workspace, as described in Section 8.4, 
“Populating Elements in the Folder View,” on page 101, Vibe displays the user’s name on the folder 
home page, with links to his or her personal workspaces.


Users External to Vibe: Vibe uses this option internally when synchronizing tasks and calendars to 
another application through iCal. You should not manually add this element to any form or view.


For more information about iCal in Vibe, see “Synchronizing Tasks and Calendars to a Desktop 
Application” in the Novell Vibe 3.2 User Guide.
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8.5.2 Folder View Elements


Any form element that you create can be added as a view element, if you want it to show up in the 
view. 


The following elements are specific to views; they cannot be added to a form.


Accessory Panel: Displays the Accessory Panel on the workspace home page. Users can use this 
panel to add community or personal accessories, depending on their individual rights.


For more information on Accessories, see “Managing Accessories” in the Novell Vibe 3.2 User Guide.


Discussion Folder: Displays folder entries in the Discussion folder view.


Entry Creation Date: Displays the date and time that an entry was created.


Entry Creator: Displays the creator of an entry.


Entry Creator and Creation Date: Displays who created the entry and when they created it.


Landing Page Layout: Adds a landing page creation form that enables you to create landing page 
elements to display in your folder.


You must add the Landing Page Layout layout option in the folder form before you can add it as a 
view element.


Title: Adds a field that enables you to specify a title for the workspace.


8.6 Understanding Layout Options
Layout options can enhance the presentation of your folder forms and views in Novell Vibe. 


When you are adding layout options to a form, remember that you need to add that same layout 
options to the view in order for it to be displayed in the folder.


You can add the following layout options:


Box: Places a box around the specified elements.


Custom JSP: Enables you to reference a custom JSP from the Vibe directory.


Custom JSPs must be created by Vibe administrators before you can reference them, as described in 
Chapter 10, “Using Custom JSP Files to Enhance Your Vibe Pages,” on page 117.


Divider: Displays a horizontal line between elements.


Expandable Area: Displays an expandable tree element.


Use this option if your form is exceptionally long.


Fieldset: Adds a box that can contain other elements.


HTML: Adds HTML formatting.


Landing Page Layout: (For the View Definition, the Landing Page Layout is in the Elements section) 
Adds a landing page creation form that enables you to create landing page elements that you can 
populate when you modify your workspace.


Three Column Table: Enables you to add elements within a three-column table.
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Two Column Table: Enables you to add elements within a two-column table.
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9 9Designing Custom Folder Entry Forms


Folder Entry forms in Novell Vibe can be customized to suit your precise business needs. You can 
create your own custom entry forms and views by using the Vibe Form and View Designers tool, or 
you can download existing custom entry forms from the Novell Vibe Resource Library.


 Section 9.1, “Downloading Existing Custom Forms and Workflows,” on page 105


 Section 9.2, “Creating a Custom Folder Entry Form,” on page 105


 Section 9.3, “Modifying an Existing Entry Form,” on page 112


 Section 9.4, “Understanding Elements,” on page 113


 Section 9.5, “Understanding Layout Options,” on page 115


9.1 Downloading Existing Custom Forms and Workflows
The Novell Vibe Resource Library provides a collection of existing Novell Vibe folder entry forms 
and workflows that have been designed to solve specific business problems. You can easily 
download the custom forms and workflows, then import them into your Vibe environment. You can 
further customize these forms and workflows to suit your individual business needs.


1 Go to the Novell Vibe Resource Library Web site (http://www.novell.com/products/vibe-
onprem/resource-library/).


2 Click Forms and Workflows.


3 Select the custom form or workflow that you want to use in your Vibe environment.


4 In the Attachment section, click the zip file to download it.


5 Import the file into your Vibe environment and deploy it for use.


For information on how to do this, follow the Novell Vibe Resource Library Deployment 
Instructions (http://www.novell.com/products/vibe-onprem/resource-library/demos/
form_workflow_deployment.html).


9.2 Creating a Custom Folder Entry Form
Novell Vibe enables you to create custom folder entry forms. For example, you can create a custom 
entry form for an expense report.
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To create a new custom workspace, you use the Form and View Designer to create a view, then you 
create a form with the elements and layout options that you want to display in the view. After the 
form is in place, you add the same elements and layout options to the view, then you can add 
optional view elements to create the final view.


You must have both a form and a view in order to display all the elements that you want in a 
workspace. The form and the view must have a common set of elements and layout options, but the 
view can have some additional elements that are not in the form.


 Section 9.2.1, “Creating the Folder Entry Form,” on page 106


 Section 9.2.2, “Adding Elements to the Entry Form Definition,” on page 107


 Section 9.2.3, “Adding Elements to the Entry View Definition,” on page 109


 Section 9.2.4, “Adding Elements to the Summary View,” on page 111


9.2.1 Creating the Folder Entry Form


1 Navigate to the folder or workspace where you want to create the custom entry form.


If you create the entry form in a folder, the form can be applied only to entries in that folder. If 
you create the entry form in a workspace, the form can be applied to entries in any folder in the 
workspace.


2 If you are creating the entry form at the folder level, click Folder > Form/View Designers in the 
Action toolbar.


or


If you are creating the entry form at the workspace level, click Workspace > Form/View Designers in 
the Action toolbar.
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The Form and View Designers page is displayed.


3 Click New > Entry Definitions.


The Add a New Definition form is displayed.


4 Specify the following information in the Add a New Definition section:


Caption: Specify a name for the folder entry.


This is the name that appears in the Vibe interface. Users see it when they create an entry of this 
type. (For example, “Expense Report.”)


Name: Specify the internal name for the folder entry.


The name that you enter in this field is not visible to users who create this type of entry. (For 
example, “expense_report.”)


Family: Select the item type that is closest to the function of the item you are creating. Users can 
use the family type when performing filtered searches.


Allowed Comments/Reply Types: Select all of the comments or reply types that you want to 
allow on the entry.


When users comment on this type of entry, they can choose from the options that you specify in 
this section.


To select multiple options, hold the Ctrl key while selecting the comment or reply types.


5 Click OK.


6 Continue with Section 9.2.2, “Adding Elements to the Entry Form Definition,” on page 107.


9.2.2 Adding Elements to the Entry Form Definition


The entry form is what users see when they are creating a new entry. This form needs to contain all of 
the fields necessary for users to create this type of entry. For example, an Expense Report form needs 
to contain the expense code, the purpose for the expense, the cost of the expense, and so forth.


After you add elements and layout options to the entry form, you must then add all of the elements 
and layout options to the entry view in order for them to be displayed when users view the entry. 
(For information on how to add elements to the entry view, see Section 9.2.3, “Adding Elements to the 
Entry View Definition,” on page 109.)


To add elements to the form:


1 Under the custom entry form that you created, expand Entry Form Definition, then expand Form.


All of the elements and layout options that are currently applied to your form are displayed.
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2 Add, modify, and delete the desired elements and layout options, as described in the following 
sections:


 “Adding Elements to a Form” on page 108


 “Modifying Elements in a Form” on page 108


 “Deleting Elements in a Form” on page 109


 “Adding Layout Options to a Form” on page 109


Based on the modifications that you make to a form element or option, you might need to make the 
same modifications to the corresponding view element or option.


Adding Elements to a Form


1 Click Form.


2 In the Form window on the right side of the page, click Add.


3 In the Standard Form Elements section, click the element that you want to add.


For information on the types of elements that you can add, see Section 9.4.1, “Entry Form 
Elements,” on page 113.


4 Specify the appropriate information to configure the element.


5 Click OK.


Modifying Elements in a Form


1 Expand Form, then click the element that you want to modify.


2 In the window on the right side of the page, click Modify.


3 Make the desired modifications, such as changing the caption or data name, then click OK.
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Deleting Elements in a Form


1 Expand Form, then click the element that you want to delete.


2 In the window on the right side of the page, click Delete.


3 Click OK.


Adding Layout Options to a Form


1 Click Form.


2 In the Form window on the right side of the page, click Add.


3 In the Layout Options section, click the layout option that you want to add.


For information on the types of layout options that you can add, see Section 9.5, “Understanding 
Layout Options,” on page 115.


4 Specify the appropriate information to configure the element.


5 Click OK.


9.2.3 Adding Elements to the Entry View Definition


The entry view is how the information from your entry form is displayed to users who view your 
entry. Every form must have a corresponding view. This view needs to contain all of the fields 
necessary for users to get the information they need when viewing the entry; it is made up of 
elements from the form.


Before you can add elements and layout options to the entry view, you must first add those same 
elements and layout options to the entry form in order for them to be displayed in your entry. (For 
information on how to add features to the entry form, see Section 9.2.2, “Adding Elements to the 
Entry Form Definition,” on page 107.)


To add elements to the view:


1 Under the custom entry form that you created, expand Entry View Definition.
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2 Add, modify, and delete the desired elements and layout options, as described in the following 
sections:


 “Adding Elements to an Entry View Definition” on page 110


 “Modifying Elements in an Entry View Definition” on page 110


 “Deleting Elements in an Entry View Definition” on page 111


 “Adding Layout Options to an Entry View Definition” on page 111


Adding Elements to an Entry View Definition


1 Click Entry View Definition.


2 In the Entry View Definition window on the right side of the page, click Add.


3 In the Standard Form Elements section, click the element that you want to add.


For information on the types of elements that you can add, see Section 9.4.2, “Entry View 
Elements,” on page 115.


4 Specify the appropriate information to configure the element.


5 Click OK.


Modifying Elements in an Entry View Definition


1 Expand Entry View Definition, then click the element that you want to modify.


2 In the window on the right side of the page, click Modify.


3 Make the desired modifications, then click OK.
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Deleting Elements in an Entry View Definition


1 Expand Entry View Definition, then click the element that you want to delete.


2 In the window on the right side of the page, click Delete.


3 Click OK.


Adding Layout Options to an Entry View Definition


1 Click Entry View Definition.


2 In the Entry View Definition window on the right side of the page, click Add.


3 In the Layout Options section, click the layout option that you want to add.


For information on the types of layout options that you can add, see Section 9.5, “Understanding 
Layout Options,” on page 115.


4 Specify the appropriate information to configure the element.


5 Click OK.


9.2.4 Adding Elements to the Summary View


The summary view is used to display entries in a folder before the entries are opened.


To add elements to the summary view:


1 Under the custom entry form that you created, expand Summary View.


2 Add, modify, and delete the desired elements and layout options, as described in the following 
sections:


 “Adding Elements to a Summary View” on page 112


 “Modifying Elements in an Summary View Definition” on page 112


 “Deleting Elements in an Summary View Definition” on page 112


 “Adding Layout Options to a Summary View” on page 112
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Adding Elements to a Summary View


1 Click Summary View.


2 In the Summary View window on the right side of the page, click Add.


3 In the Standard Form Elements section, click the element that you want to add.


For information on the types of elements that you can add, see Section 9.4.2, “Entry View 
Elements,” on page 115.


4 Specify the appropriate information to configure the element.


5 Click OK.


Modifying Elements in an Summary View Definition


1 Expand Summary View, then click the element that you want to modify.


2 In the window on the right side of the page, click Modify.


3 Make the desired modifications, then click OK.


Deleting Elements in an Summary View Definition


1 Expand Summary View, then click the element that you want to delete.


2 In the window on the right side of the page, click Delete.


3 Click OK.


Adding Layout Options to a Summary View


1 Click Summary View.


2 In the Summary View window on the right side of the page, click Add.


3 In the Layout Options section, click the layout option that you want to add.


For information on the types of layout options that you can add, see Section 9.5, “Understanding 
Layout Options,” on page 115.


4 Specify the appropriate information to configure the element.


5 Click OK.


9.3 Modifying an Existing Entry Form
1 Navigate to the folder or workspace where the custom folder entry was created.


2 If the folder entry was created at the folder level, click Folder > Form/View Designers in the Action 
toolbar.


or


If the folder entry was created at the at the workspace level, click Workspace > Form/View 
Designers in the Action toolbar.


The Form and View Designers page is displayed.
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3 Expand Entry Definitions, then click the custom entry that you want to modify.


4 Continue with Section 9.2.2, “Adding Elements to the Entry Form Definition,” on page 107.


9.4 Understanding Elements
Elements make up the content of your forms and views. 


When you are adding elements, remember that when you add an element to a form, you need to add 
that same element to the view in order for it to be displayed in the custom form.


You can add the following elements:


 Section 9.4.1, “Entry Form Elements,” on page 113


 Section 9.4.2, “Entry View Elements,” on page 115


9.4.1 Entry Form Elements


Cancel Button: Adds the Cancel button.


Checkbox: Adds a check box that can be selected and deselected.


Date: Adds a field that launches a calendar applet when users click inside it.


Date and Time: Adds two fields. The first field launches a calendar applet, and the second field 
launches a time-selection applet when users click inside.


E-Mail Address List: Adds a field that enables you to specify e-mail addresses.


Event: Adds fields that enable users to specify the start time and end time of an event.


File Upload: Adds a field that enables users to browse for and upload files.


Form: This element is for internal use and is required on the entry form.


Form Buttons: Adds the OK and Cancel buttons.
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Group List: Adds a type-to-find field that enables users to find and select Vibe groups.


Guest User Name: Adds a field where users who are logged in to the Vibe site as Guest can specify 
their name. This field is displayed on the entry form only when the Guest user is viewing the form.


HTML Editor Text Area: Adds an HTML text area where users can compose messages, create links, 
upload pictures, and more.


Hidden Field: Adds a hidden element. When you design the custom form, you can use this element 
to add boilerplate text to every entry that is created. This text is “hidden” because it does not appear 
on the entry form when users are creating an entry; however, the text does appear on the entry view 
after the entry is created.


Icon: Enables the workspace owner to choose an icon to represent the workspace.


Number: Adds a field that requires users to enter a number. Alphabetic characters are rejected.


Picture: Adds a field that enables users to browse for and upload pictures.


Places: Adds a workspace tree that enables users to browse to and select folders.


Radio Buttons: Enables you to display options that users can select with radio buttons.


Remote Application: Enables you to choose a remote application to display.


Remote applications must be created and enabled for use by the Vibe administrator.


Selectbox: Enables you to display options that users can select.


Send E-Mail When Entry is Submitted: Adds an option that enables users to automatically send an 
e-mail to other Vibe users, after the entry is submitted.


Show Only When In Workflow States: Enables you to hide elements from being displayed on the 
entry form unless the entry is in a designated state of a workflow.


Subscribe to This Entry: Adds an option that enables users to subscribe to the entry.


Survey: Adds options that enable users to create a survey.


Team List: Adds a field that enables users to specify teams.


Text: Adds a field where users can enter text.


Text Area: Adds an expandable field where users can enter text.


Title: Adds a field where users can enter a title for the entry.


URL: Add a field that converts any text into a hyperlink. 


User List: Adds a field that enables users to use the type-to-find functionality to specify other Vibe 
users.


User List Selectbox: Adds a list of users that you can choose from in the entry form. This list is 
populated from the User List element that is defined on the folder view of the parent folder (for more 
information about how to add a User List element to a custom folder view by either creating a new 
folder view or modifying an existing folder view, see Chapter 8, “Creating Custom Folder Views,” on 
page 95). You need to reference this User List element by specifying the element’s data name in the 
Source User List Element from the Parent Folder when creating the User List Selectbox element.


Users External to Vibe: Vibe uses this option internally when synchronizing tasks and calendars to 
another application by using iCal. You should not manually add this element to any form or view.
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For more information about iCal in Vibe, see “Synchronizing Tasks and Calendars to a Desktop 
Application” in the Novell Vibe 3.2 User Guide.


9.4.2 Entry View Elements


Any form element that you create can be added as a view element, if you want it to appear in the 
view. 


The following elements are specific to views; they cannot be added to a form.


Attachments: Displays all attachments.


Comments: Displays all comments.


Comments and Attachments Tabs: Displays the Comments and Attachments tabs. Also, where 
applicable, it displays the Entry History and File Versions tabs.


Description: Displays the entry description.


Entry Creation Date: (Not available with a Summary View) Displays the date that the entry was 
created.


Entry Creator: (Not available with a Summary View) Displays who created the entry.


Entry Creator and Creation Date: (Not available with a Summary View) Displays who created the 
entry and when they created it.


Entry Workflow: Displays the workflow process, the state of the workflow process, and any actions 
to be performed on the workflow.


Remote Application: (Not available with a Summary View) Enables you to add custom applications 
that are running on a separate server.


For more information on remote applications, see Chapter 12, “Managing Remote Applications,” on 
page 159.


Replies: All replies to an entry are listed here. You can move this section to another location in the 
entry view by moving this element.


Show Only When In Workflow States: Enables you to hide elements from being displayed on the 
entry view unless the entry is in a designated state of a workflow.


Title: Displays the title of the entry.


9.5 Understanding Layout Options
Layout options can enhance the presentation of your forms and views. 


When you are adding layout options, remember that when you add layout options to a form, you 
need to add the same layout options to the view in order for it to be displayed in the custom form.


You can add the following layout options:


Box: Places a box around the specified elements.


Custom JSP: Enables you to reference a custom JSP from the Vibe directory.

Designing Custom Folder Entry Forms 115







Custom JSPs must be created by Vibe administrators before you can reference them, as described in 
Chapter 10, “Using Custom JSP Files to Enhance Your Vibe Pages,” on page 117.


Divider: Displays a horizontal line between elements.


Expandable Area: Displays an expandable tree element.


Use this option if your form is exceptionally long.


Fieldset: Adds a box that can contain other elements.


HTML: Adds HTML formatting.


Three Column Table: Enables you to add elements within a three-column table.


Two Column Table: Enables you to add elements within a two-column table.
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10 10Using Custom JSP Files to Enhance 
Your Vibe Pages


Novell Vibe supports the use of custom JavaServer Pages (JSPs) that can help you modify the 
behavior of certain areas in your Vibe site. For example, your Vibe administrator might enable a 
custom JSP file that enhances the functionality of Vibe landing pages by enabling users to participate 
in a survey directly from a workspace landing page.


Before you can leverage the functionality of custom JSP files, your Vibe administrator must first make 
the files available. Your Vibe administrator will inform you about the names of the files and what 
they can be used for.


Some areas of Vibe, such as landing pages, enable you to add custom JSP files by default. Other areas, 
such as folder and workspace forms and views, first require you to do some additional steps, as 
described in the following sections:


 Section 10.1, “Applying JSP Files to a Landing Page,” on page 117


 Section 10.2, “Enabling Vibe Forms and Views to Reference JSP Files,” on page 117


10.1 Applying JSP Files to a Landing Page
Landing pages can enhance the presentation of your workspaces and folders and increase the 
accessibility of the information they contain. For more information about landing pages, see 
Chapter 6, “Creating and Managing Landing Pages,” on page 55.


By default, JSP files can be applied to your Novell Vibe landing page. For information on how to 
reference a JSP file from a landing page, see “Adding a Custom JSP” on page 71.


10.2 Enabling Vibe Forms and Views to Reference JSP Files
 Section 10.2.1, “Applying JSP Files to a Folder Entry Form and View,” on page 118


 Section 10.2.2, “Applying JSP Files to a Folder or Workspace View,” on page 119
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10.2.1 Applying JSP Files to a Folder Entry Form and View


Folder entry forms are used to add folder entries to all types of Novell Vibe folders. Folder entry 
views are used to display folder entries in all types of Vibe folders. You can create your own folder 
entry forms and views, or modify existing forms and views. For more information, see Chapter 9, 
“Designing Custom Folder Entry Forms,” on page 105.


To enable a folder entry form and view to reference a custom JSP file:


1 Create a new custom folder entry form and view, as described in Section 8.1, “Creating a New 
Custom Folder View,” on page 95.


or


Modify an existing folder entry form and view, as described in Section 9.3, “Modifying an 
Existing Entry Form,” on page 112.


Only Vibe administrators have the ability to modify default folder entry forms.


2 Add a JSP layout option and element to the folder entry form, as described in Section 8.1.2, 
“Adding Elements to the Folder Add/Modify Form,” on page 96.


3 Specify the following information:


Caption: Specify a name for the custom JSP.


Data Name: Specify an internal name for the custom JSP.


Custom Form JSP: Specify the filename of the custom JSP file.


You must obtain this filename from your Vibe administrator. Only your Vibe administrator can 
make JSP files available to be used in the Vibe site.


4 Click OK.
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10.2.2 Applying JSP Files to a Folder or Workspace View


Vibe enables you to create custom folder and workspace views. Folder and workspace views define 
what is displayed on the home page of your folder or workspace. When you create custom folder or 
workspace views, you can display optional features such as remote applications, attachments, and 
you can also reference JSP files. For more information, see Chapter 8, “Creating Custom Folder 
Views,” on page 95, and Chapter 7, “Creating Custom Workspace Views,” on page 85.


To enable a folder or workspace view to reference a custom JSP file:


1 Create a new custom folder or workspace view, as described in Section 7.1, “Creating a New 
Custom Workspace View,” on page 85.


or


Modify an existing folder or workspace view, as described in Section 7.2, “Modifying an Existing 
Workspace View,” on page 90.


Only Vibe administrators have the ability to modify default folder and workspace views.


2 Add a JSP layout option and element to the folder or workspace view, as described in 
Section 8.1.3, “Adding Elements to the Folder View,” on page 98 or Section 7.1.3, “Adding 
Elements to the Workspace View,” on page 88, depending on whether you are working with a 
folder or workspace view.


3 Specify the following information:


Caption: Specify a name for the custom JSP.


Data Name: Specify an internal name of the custom JSP.


Custom Form JSP: Specify the filename of the custom JSP file.


You must obtain this filename from your Vibe administrator. Only your Vibe administrator can 
make JSP files available to be used in the Vibe site.


4 Click OK.
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11 11Creating and Managing Workflows


Novell Vibe enables you to create custom workflows to streamline important business processes. 
Vibe administrators can create workflows and implement them across the entire site, and individual 
folder and workspace owners can create workflows to be used in their respective folders and 
workspaces.


After you have created a workflow, you can perform the management functions that are described in 
this section. You can enable workflows to automatically start when certain types of entries are created 
in the folder, when users comment on or reply to an entry, or you can configure them to be manually 
started by users who view the entry.


Examples of workflows include approving documents, ordering supplies, hiring new employees, 
requesting paid time off, and getting expense reimbursements.


 Section 11.1, “Creating a Simple Workflow,” on page 121


 Section 11.2, “Creating an Advanced Workflow,” on page 129


 Section 11.3, “Visually Representing a Workflow,” on page 146


 Section 11.4, “Adding Access Controls to a Workflow,” on page 147


 Section 11.5, “Downloading Existing Custom Forms and Workflows,” on page 154


 Section 11.6, “Workflows Included with Vibe,” on page 154


 Section 11.7, “Enabling Workflows,” on page 155


 Section 11.8, “Testing A Workflow,” on page 157


 Section 11.9, “Importing and Exporting a Workflow,” on page 157


11.1 Creating a Simple Workflow
If you have a straightforward business process that you think might benefit from a workflow, you can 
create a simple workflow to help automate that process, and you don’t need in-depth workflow 
training to do it.


For example, you might want to create a workflow that automates the review process of articles for 
the company magazine. To create a simple workflow such as this, complete the following sections:


 Section 11.1.1, “Creating the Workflow Definition,” on page 122


 Section 11.1.2, “Adding Workflow States,” on page 122


 Section 11.1.3, “Adding Workflow Start and End States,” on page 124


 Section 11.1.4, “Adding Manual Transitions,” on page 125


 Section 11.1.5, “Sending E-Mail Notifications,” on page 127


 Section 11.1.6, “Enabling Your Workflow for Use,” on page 129
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11.1.1 Creating the Workflow Definition


1 Navigate to the workspace or folder where you want to create the workflow.


You can create workflows at the workspace level or at the folder level. If you create a workflow 
at the workspace level, the workflow can be applied to all sub-folders and sub-workspaces. If 
you create a workflow at the folder level, the workflow can be applied only to that folder, and to 
the folder’s sub-folders.


2 If you are creating the workflow at the folder level, click Folder > Form/View Designers in the 
Action toolbar.


or


If you are creating the workflow at the workspace level, click Workspace > Form/View Designers in 
the Action toolbar.


The Form and View Designers page is displayed.


3 In the Form and View Designers page, click New > Workflow Processes.


The Add a New Definition form is displayed.


4 Specify the following information:


Caption: Specify a name for the workflow process.


This is the name that appears in the Vibe interface. Users see it when they use this workflow. 
(For example, “Article Production.”)


Name: Specify the internal name for the workflow process.


The name that you enter in this field is not visible to users who use this workflow. (For example, 
“article_production.”)


5 Click OK.


6 Continue with Section 11.1.2, “Adding Workflow States,” on page 122.


11.1.2 Adding Workflow States


Workflow states are the phases that a workflow goes through as it completes the business process. 


For example, the Article Production workflow contains five states: Article Composition, Peer Review, 
Edit, Manager Approval, Publish.


1 In the Designer page, expand the workflow definition that you created in Section 11.1.1, 
“Creating the Workflow Definition,” on page 122.


2 Click Workflow Process.


3 Click Add.
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4 Click State.


5 Specify the following information:


Caption: Specify a name for the workflow state.


This is the name that appears in the Vibe interface. Users see it when they use this workflow. 
(For example, “Article Composition.”)


Name: Specify the internal name for the workflow state.


The name that you enter in this field is an internal-use database name. Names for elements in a 
definition must be unique. The first character must be an alphabetic character (a-z, A-Z). For the 
rest, you can use alphanumeric characters (a-z, A-Z, 0-9), hyphens (-), and underscores (_).


Description: Describe the function of the state.


6 Click OK.


7 Repeat Step 2 through Step 6 to add additional workflow states.


The new states are added to the workflow and appear in the Workflow Preview section at the 
bottom part of the window.


For more information on the Workflow Preview section, see Section 11.3, “Visually Representing a 
Workflow,” on page 146.


8 Continue with Section 11.2.3, “Adding Workflow Start and End States,” on page 132 for 
information on how you can define start and end states for your workflow.
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11.1.3 Adding Workflow Start and End States


Vibe enables you to add a Start and End state to your workflow. This is important, because without 
an End state, a workflow does not officially stop unless you manually stop it. Adding an End state to 
a workflow automatically stops the workflow when it reaches the final state.


1 Click Workflow Process.


2 In the Workflow process window, click Modify. 


3 Specify the following information:


Initial State: Select the Start state of the workflow process.


End State: Select the End (final) state of the workflow process.


You can select multiple End states by holding the Ctrl key while clicking additional states.


Background Actions Will Run in the Context Of: Select either Entry Owner or Folder Owner.


This option defines the level of access control that the workflow uses. Typically the folder owner 
has more access control rights than the entry owner. Certain workflow operations require the 
appropriate access controls to complete, so selecting Entry Owner might not provide the 
workflow with sufficient access controls. For example, suppose your workflow moves the entry 
to a different folder. If you select to run background actions in the context of the entry owner and 
the user who is running the workflow at the time the entry is to be moved does not have rights 
to create entries in the target folder, the workflow cannot complete. If the folder owner has rights 
to create entries in the target folder, selecting to run background actions in the context of the 
folder owner allows the workflow to complete as designed.


4 Click OK.


In the Workflow Preview section, the Start state is marked with yellow, and the End state is 
marked with red.


For more information on the Workflow Preview section, see Section 11.3, “Visually Representing a 
Workflow,” on page 146.
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5 Continue with Section 11.1.4, “Adding Manual Transitions,” on page 125 for information on how 
you can create transitions that move an entry from one workflow state to the next.


11.1.4 Adding Manual Transitions


After you have defined the workflow states, you need to create transitions that move an entry from 
one state to the next. The easiest kind of transitions to implement are manual transitions. 


Manual transitions provide a drop-down list in the entry that allows the user to choose when to 
transition the entry. The workflow creator decides which workflow states the user can select in the 
drop-down list.


For example, from the “Article Composition” state, the workflow creator might allow the user to 
transition the entry to either the “Peer Review” or the “Edit” state.


To create manual transitions from one workflow state to the next workflow state:


1 Expand Workflow Process, then expand the workflow state where you want to transition the entry 
from.


For this example, expand the “Article Composition” state.
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2 Click Transitions, then click Add in the Transitions box in the right section of the Designer page.


3 Click Manual Transition.


For information regarding the other transition types, see Section 11.2.4, “Adding Transitions,” on 
page 132.


4 In the To State select box, select the next state in the workflow.


This is the state that users will be allowed to transition the entry to.


5 Click OK.


Repeat Step 2 through Step 5 if you want to allow users to select from multiple states.


6 Repeat this procedure for all other states in the workflow.


In the Workflow Preview section, you see a diagram representing all of your workflow states 
(circles) and transitions (arrows).


For more information on the Workflow Preview section, see Section 11.3, “Visually Representing a 
Workflow,” on page 146.
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7 Continue with Section 11.1.5, “Sending E-Mail Notifications,” on page 127.


11.1.5 Sending E-Mail Notifications


Now that you have added your workflow states and specified how the entry will transition through 
those states, you need to set up notifications that inform Vibe users when they need to take action on 
the entry as it moves into a state corresponding with their area of expertise.


For example, Julio composes an article for the company magazine. After he composes the article, he 
transitions the entry to the next workflow state, Peer Review. Anne, Julio’s co-worker, then receives 
an e-mail message notifying her that an article is ready for her to review. After Anne reviews the 
article, she transitions it to the next workflow state, Edit, and so forth.


1 Expand the workflow definition, then click the workflow state where you want the notification 
to be sent.


For example, click Peer Review.


2 Click Add.


3 Click On Entry.


4 In the On Entry box, click OK.


5 Click On Entry. (This is located underneath the workflow state where you just created it.)


In the On Entry box, you can select from many options. These are actions that you can choose to 
perform when the entry enters this workflow state, such as moving the entry to another location, 
copying the entry, or sending notifications. For this basic workflow example, simply select to 
send e-mail notifications. 


For information about all of the options that you can choose to perform when an entry enters a 
workflow state, see Section 11.2.6, “Adding On-Entry or On-Exit Events,” on page 138.


6 Click Add > Notifications.


7 In the Notifications box, specify the following information:
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Entry Creator: Select this option if you want to send a notification to the user who created the 
entry.


Team: Select this option if you want to send a notification to the entire team.


Users: Specify individual users to whom you want to send a notification.


Groups: Specify groups to whom you want to send a notification.


Additional E-Mail Addresses to Notify: Specify an e-mail address where you want a 
notification to be sent.


Select an Entry Type: Use the drop-down list to select the type of entry that most closely 
represents the type of entry that is going through the workflow. Some entry types have user lists, 
group lists, and team lists that are available in the entry type. For example, if you select Task 
Entry, you can select Assigned to, Assigned to Groups, and Assigned to Teams and have notifications 
sent to those users.


Text to be Put in the Notification Subject Line: Specify the text that you want to appear in the 
subject line of the notification that is sent.


For example, Peer Review Needed.


You can use certain HTML constructs to provide specific information about the entry that is 
transitioning through the workflow. For example, you can populate the Notification Subject Line 
with the entry title and who last modified the entry: Workflow notification for 
{{vibe:title}} from {{vibe:modifiedBy}}.


For more information about all the HTML constructs you can use, see Appendix B, “Using 
HTML Markup in Vibe,” on page 201.


Append the Entry Title: (Optional) Select this option if you want the entry title to appear after 
the text in the subject line.


Append a Link to the Entry: Displays a link to the entry in the e-mail notification. This option is 
enabled by default. If you do not want a link to the entry in your e-mail notification, you must 
deselect this option.


Text to be Put in the Notification Body: Specify text that you want to appear in the main body 
of the e-mail notification. You can also select Append the Entry Body if you want the main body of 
the entry to display with the e-mail notification message.


Any text formatting that you use in this field needs to be done in the HTML format. Following 
are some examples of HTML formatting:


 <i></i> for italics


 <b></b> for bold


 <br> for a break (return/enter)


 <p></p> for a new paragraph


<a href=“www.example.com”></a> for links to URLs


You can use certain HTML constructs to provide specific information about the entry that is 
transitioning through the workflow. For example, you can populate the Notification Body with 
the name of the user who last modified the entry: This entry was last modified by 
{{vibe:modifiedBy}}.


For more information about all the HTML constructs you can use, see Appendix B, “Using 
HTML Markup in Vibe,” on page 201.


Append the Entry Description: (Optional) Select this option if you want the main body of the 
entry to display with the e-mail notification message.
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8 Click OK.


9 Repeat this process for every workflow state that needs an e-mail notification message.


11.1.6 Enabling Your Workflow for Use


Now that you have created your workflow, you need to enable it. For information on how to do this, 
see Section 11.7, “Enabling Workflows,” on page 155.


11.2 Creating an Advanced Workflow
This section expands the workflow design presented in Section 11.1, “Creating a Simple Workflow,” 
on page 121. 


For example, you might want to create a workflow that automates the expense reporting process for 
your department.


Figure 11-1   Advanced Workflow Example


To create this and other advanced workflows, complete the following sections:


 Section 11.2.1, “Creating the Workflow Definition,” on page 130


 Section 11.2.2, “Adding Workflow States,” on page 130


 Section 11.2.3, “Adding Workflow Start and End States,” on page 132


 Section 11.2.4, “Adding Transitions,” on page 132


 Section 11.2.5, “Setting Up Transition Types,” on page 134


 Section 11.2.6, “Adding On-Entry or On-Exit Events,” on page 138


 Section 11.2.7, “Setting Up On-Entry and On-Exit Events,” on page 139


 Section 11.2.8, “Adding a Parallel Workflow Thread,” on page 142


 Section 11.2.9, “Chaining Workflows,” on page 142


 Section 11.2.10, “Adding a Question to a Workflow,” on page 142


 Section 11.2.11, “Enabling Your Workflow for Use,” on page 146
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11.2.1 Creating the Workflow Definition


1 Navigate to the workspace or folder where you want to create the workflow.


You can create workflows at the workspace level or at the folder level. If you create a workflow 
at the workspace level, the workflow can be applied to any folder or workspace included in the 
workspace. If you create a workflow at the folder level, the workflow can be applied only to that 
folder, and to the folder’s sub-folders.


2 If you are creating the workflow at the folder level, click Folder > Form/View Designers in the 
Action toolbar.


or


If you are creating the workflow at the workspace level, click Workspace > Form/View Designers in 
the Action toolbar.


The Form and View Designers page is displayed.


3 In the Form and View Designers page, click New > Workflow Processes.


The Add a New Definition form is displayed.


4 Specify the following information:


Caption: Specify a name for the workflow process.


This is the name that appears in the Vibe interface. Users see it when they use this workflow. 
(For example, “Expense Report Workflow.”)


Name: Specify the internal name for the workflow process.


The name that you enter in this field is not visible to users who use this workflow. (For example, 
“expense_report_workflow.”)


5 Click OK.


6 After you define a workflow, you need to add states to your workflow. For information on how 
to do this, continue with Section 11.2.2, “Adding Workflow States,” on page 130.


11.2.2 Adding Workflow States


Workflow states are the phases that a workflow goes through as it completes the business process. 


For example, the Expense Report workflow contains six states: Submit Expense Report, Finance 
Department, Needs Attention, Report Processed, Statistics Department, and Records Department.


1 In the Designer page, expand the workflow definition that you created in Section 11.2.1, 
“Creating the Workflow Definition,” on page 130.


2 Click Workflow Process.
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3 Click Add.


4 Click State.


5 Specify the following information:


Caption: Specify a name for the workflow state.


This is the name that appears in the Vibe interface. Users see it when they use this workflow. 
(For example, “Article Composition.”)


You can use alphanumeric characters (a-z, A-Z, 0-9), dashes (-), underscores (_), and spaces.


Name: Specify the internal name for the workflow state.


The name that you enter in this field is an internal-use database name. Names for elements in a 
definition must be unique. The first character must be an alphabetic character (a-z, A-Z). For the 
rest, you can use alphanumeric characters (a-z, A-Z, 0-9), hyphens (-), and underscores (_).


Description: Describe the function of the state.


6 Click OK.


7 Repeat Step 2 through Step 6 to add additional workflow states.


The new states are added to the workflow and appear in the Workflow Preview section located in 
the bottom part of the window.


For more information on the Workflow Preview section, see Section 11.3, “Visually Representing a 
Workflow,” on page 146.


8 After you have added states to your workflow, you need to define the Start and End states. For 
information on how to do this, see Section 11.2.3, “Adding Workflow Start and End States,” on 
page 132.

Creating and Managing Workflows 131







11.2.3 Adding Workflow Start and End States


Vibe enables you to add Start and End states to your workflow. This is important, because without an 
End state, a workflow does not officially stop unless you manually stop it. Adding an End state to a 
workflow automatically stops the workflow when it reaches the final state.


1 Click Workflow Process.


2 In the Workflow process window, click Modify.


3 Specify the following information:


Initial State: Select the Start state of the workflow process.


End State: Select the End (final) state of the workflow process.


You can select multiple End states by holding the Ctrl key while clicking additional states.


Background Actions Will Run in the Context Of: Select either Entry Owner or Folder Owner.


4 Click OK.


In the Workflow Preview section, Start states are marked with yellow, and End states are marked 
with red.


For more information on the Workflow Preview section, see Section 11.3, “Visually Representing a 
Workflow,” on page 146.


5 Continue with Section 11.2.4, “Adding Transitions,” on page 132 for information on how to 
create transitions that move an entry from one state to the next.


11.2.4 Adding Transitions


After you have defined the workflow states, you need to create transitions that move an entry from 
one workflow state to the next.


1 Expand Workflow Process, then expand the workflow state that you want to transition the entry 
from.


For this example, expand the “Submit Expense Report” state.
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2 Click Transitions, then click Add in the Transitions box in the right section of the Designer page.


3 Click the type of transition that you want to add.


Custom Transition: Use this transition if you want to integrate an external process with a Vibe 
workflow. To do this, consult with your Vibe administrator.


For example, you might want to synchronize a Vibe workflow with an external workflow. You 
can write some custom Java code and use a custom transition to accomplish this. 


Immediate Transition: The entry is immediately transitioned.


Manual Transition: Provides a drop-down list in the entry that allows the user to choose when 
to transition the entry. The workflow creator decides which workflow states the user can select 
in the drop-down list.


Transition After Time Elapsed: The entry is transitioned to the next workflow state after a 
specified amount of time.


Transition on Comment or Reply: The entry is transitioned to the next workflow state after a 
user makes a comment or a reply on the entry.


Transition on Entry Data Values: The entry is transitioned to a new state based on the value that 
a user specifies for a custom element in the entry.


For example:


 If you want to assign an entry to a specific state based on a value the user selects, you define 
a custom element with multiple values from which a user can make a selection (from a 
drop-down list on the form). Map each of these values to specific states in the initial 
workflow state by using the Transition on Entry Data Values option. This option is useful for 
assigning help tickets in a help desk, assigning entries to the appropriate review contact, 
and so on.


 If you want to transition an entry at a specific time, you can transition the entry based on a 
custom date element.


Transition on Modify: The entry is transitioned to a new state when it is modified.


This can be useful for review purposes.


Transition on Response: Allows you to transition an entry to a new state based on a response to 
a question in the entry. Map each possible answer to a workflow question to one of these 
transitions by using the Data name for each Workflow response. 


For specific instructions on how to do this, see Section 11.2.10, “Adding a Question to a 
Workflow,” on page 142.
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Transition on a Variable: You can make decisions based on the value of a variable that you set. 
For example, you could have a process that sends e-mail notifications when it enters a state. The 
process re-enters that same state later in the process, but you do not want to send the 
notifications more than once. Set up that first state so that it sends notifications only if the “sent 
notifications” variable is not true.


Wait for Parallel Thread(s) to End: Allows you to transition an entry to a new state when one or 
more specified parallel workflow threads end.


4 Specify setup options.


After you select a transition type in Step 3, you must set up the transition. Each transition type 
requires you to specify different setup options.


For specific information regarding the information that you need to specify for the individual 
fields, see “Setting Up Transition Types” on page 134.


5 Click OK.


6 Repeat Step 1 through Step 5 for all other states in the workflow.


In the Workflow Preview section, you see a diagram representing all of your workflow states 
(circles) and transitions (arrows).


For more information on the Workflow Preview section, see Section 11.3, “Visually Representing a 
Workflow,” on page 146.


7 After you have set up how entries transition from one workflow state to another in your 
workflow, you can set up events to occur when the entry enters or exits particular workflow 
states. For information on how to do this, as well as the kinds of entry and exit events that you 
can set up, see Section 11.2.6, “Adding On-Entry or On-Exit Events,” on page 138.


11.2.5 Setting Up Transition Types


When you choose a specific type of transition, you might need to provide specific information 
regarding the type of transition that you selected.


Following are the types of transitions that you can choose from, and information describing the fields 
that you must complete in order to set up each type of transition:


 “Custom Transition” on page 135


 “Immediate Transition” on page 135


 “Manual Transition” on page 135
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 “Transition After Time Elapsed” on page 135


 “Transition on Comment or Reply” on page 136


 “Transition on Entry Data Values” on page 136


 “Transition on Modify” on page 136


 “Transition on Response” on page 136


 “Transition on a Variable” on page 137


 “Wait for Parallel Thread(s) to End” on page 137


Custom Transition


After you begin creating the Custom Transition as described in Section 11.2.4, “Adding Transitions,” 
on page 132, you see the following options:


Condition Class Name: Specify the Java filename where your Vibe administrator created the custom 
transition.


Consult with your Vibe administrator to get the name of this file.


To State: Select the state where you want to transition the entry.


Immediate Transition


After you begin creating the Immediate Transition as described in Section 11.2.4, “Adding 
Transitions,” on page 132, you see the following options:


To State: Select the state where you want to immediately transition the entry.


Manual Transition


After you begin creating the Manual Transition as described in Section 11.2.4, “Adding Transitions,” 
on page 132, you see the following options:


To State: Select the state where you want to allow users to transition the entry.


After you create the transition, repeat Step 2 on page 133 through Step 5 on page 134 if you want to 
allow users to select from multiple states.


You can set access controls on the manual transition to allow only certain users to transition the entry. 
If you do not set any access controls, the default is to allow all users who have Write access to the 
entry to transition the entry. For more information about how to set access controls on the manual 
transition, see Section 11.4.3, “Setting Access Controls on a Manual Transition,” on page 152.


Transition After Time Elapsed


After you begin creating the Transition After Time Elapsed transition as described in Section 11.2.4, 
“Adding Transitions,” on page 132, you see the following options:


Numbers entered in the following fields must be whole values. Decimal points and fractions are not 
valid.


Days: Specify how many days to wait before the transition.


Hours: Specify how many hours to wait before the transition.
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Minutes: Specify how many minutes to wait before the transition.


To State: Select the state where you want to transition the entry after the elapsed time that you 
specified.


Transition on Comment or Reply


After you begin creating the Transition on Comment or Reply transition as described in 
Section 11.2.4, “Adding Transitions,” on page 132, you see the following options:


To State: Select the state where you want to transition the entry after a user comments on or replies to 
the entry.


Transition on Entry Data Values


After you begin creating the Transition on Entry Data Values transition as described in Section 11.2.4, 
“Adding Transitions,” on page 132, you see the following options:


Match Entry Data Values: Select Match Any if only one condition must be met for the entry to 
transition. Select Match All if all conditions must be met before the entry transitions.


To State: Select the state where you want to transition the entry.


Transition on Modify


After you begin creating the Transition on Modify transition as described in Section 11.2.4, “Adding 
Transitions,” on page 132, you see the following options:


To State: Select the state where you want to transition the entry when the entry is modified.


When you are working with a File entry, modifications made to the file also cause the workflow to be 
transitioned. Modifications to a file include setting the status of the file, incrementing the major 
version, editing the file note, reverting to a previous version, and deleting the file. For more 
information about working with File entries, see “Working with Files in a Folder Entry” in the Novell 
Vibe 3.2 User Guide


Transition on Response


After you begin creating the Transition on Response transition as described in Section 11.2.4, “Adding 
Transitions,” on page 132, you see the following options:


Workflow Question: Specify the Data Name for the workflow question that you have previously 
defined.


For information on how to create a workflow question, see “Creating a Workflow Question” on 
page 143.


Workflow Response: Specify the Data Name for the workflow response that you have previously 
defined.


For information on how to create a workflow response, see “Creating Answers to a Workflow 
Question” on page 144.


To State: Select the state where you want to transition the entry after a user responds to the workflow 
question.
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The Transition Occurs When: 


 As Soon As One Person Answers With This Response: Transitions the entry immediately after 
one person responds to the workflow question with the value that is in the Workflow Response 
field in the Transition on Response dialog box.


 As Soon As A Majority Have Answered With This Response: Transitions the entry 
immediately after a majority of people respond to the workflow question with the value that is 
in the Workflow Response field in the Transition on Response dialog box.


 After Everyone Has Responded and All Have Answered With This Response: Transitions the 
entry after all responders have responded to the workflow question and all people respond with 
the value that is in the Workflow Response field in the Transition on Response dialog box.


 After Everyone Has Responded and Somebody Answered With This Response: Transitions 
the entry after all responders have responded to the workflow question and at least one person 
responds with the value that is in the Workflow Response field in the Transition on Response 
dialog box.


 After Everyone Has Responded and Not All Have Answered With This Response: Transitions 
the entry after all responders have responded to the workflow question and at least one person 
responds with a value that is not in the Workflow Response field in the Transition on Response 
dialog box.


 After Everyone Has Responded and a Majority Answered With This Response: Transitions 
the entry after all responders have responded to the workflow question and the majority of 
people respond with the value that is in the Workflow Response field in the Transition on 
Response dialog box.


For more information about how to designate specific users to respond to the question, see 
“Designating Specific Users to Respond to a Workflow Question” on page 144


Transition on a Variable


After you begin creating the Transition on a Variable transition as described in Section 11.2.4, 
“Adding Transitions,” on page 132, you see the following options:


Variable Name: Specify the name of the workflow variable that you want to activate the transition.


You must have already created a workflow variable. You create a workflow variable as an On Entry 
or On Exit event, as described in Section 11.2.6, “Adding On-Entry or On-Exit Events,” on page 138.


Variable Value: Specify the value of the workflow variable that you want to activate the transition.


You must have already created a workflow variable. You create a workflow variable as an On Entry 
or On Exit event, as described in Section 11.2.6, “Adding On-Entry or On-Exit Events,” on page 138.


To State: Select the state where you want to transition the entry.


Wait for Parallel Thread(s) to End


After you begin creating the Wait for Parallel Thread(s) to End transition as described in 
Section 11.2.4, “Adding Transitions,” on page 132, you see the following options:


Parallel Thread Name: Select the parallel thread that you want to wait for.


Transition to State: Select the state where you want to transition the entry after all selected threads 
have ended.
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11.2.6 Adding On-Entry or On-Exit Events


You can take action when a process enters or exits a workflow state. For example, when an entry 
enters (or exits) a workflow state, you can send a notification, begin or end a parallel process, set a 
variable, modify an element within the entry, and more.


1 Navigate to and click the workflow state where you want to set up an event to occur when the 
entry enters or exits the state.


2 Click Add.


3 Click On Entry or On Exit, depending on whether you want the event to occur when the entry 
enters or exits the state.


4 In the On Entry (or On Exit) box, click OK.


5 Click On Entry or On Exit, depending on whether you are adding an On Entry or On Exit event. 
(This is located underneath the workflow state where you just created it.)


6 Click Add.


7 Click the type of event that you want to add.


Copy Entry: Allows you to copy an entry to a new location in Vibe when it enters or exits a 
specific state.


Custom Action: Use the custom action if you want to integrate an external process (usually 
contained within a JAR file) with a Vibe workflow. To do this, consult with your Vibe 
administrator.


For more information about how Vibe administrators can enable JAR files to be used as custom 
workflow actions, see “Enabling Custom JAR Files to Be Used on Your Vibe Site” in the  Novell 
Vibe 3.2 Administration Guide.


Move Entry: Allows you to move an entry to a new location in Vibe when it enters or exits a 
specific state.


Notifications: Allows you to notify specific users or groups about an entry when it enters or 
exits the state.


Remote Application: Remote applications communicate with a third-party online application, 
and send information from that third-party application back into Vibe. You can enable a remote 
application to start when entries enter or exit a workflow state.


Remote applications need to be set up and configured by your Vibe administrator before you 
can add them.


Set Entry Data: Enables you to automatically modify an element within an entry when the entry 
enters or exits a workflow state.


Set a Workflow Variable: Defines a variable to be used when transitioning a workflow.


This workflow variable is referenced with the Transition On a Variable transition, as described in 
Section 11.2.4, “Adding Transitions,” on page 132.


Start a Parallel Workflow Thread: Allows you to start a parallel workflow when an entry enters 
or exits a specific state. Parallel workflows are useful if two or more processes need to occur 
simultaneously. Only when the parallel thread is finished can the main workflow thread 
proceed.


Before you can start a parallel workflow thread, you first need to create it. For information on 
how to create a parallel workflow thread, see Section 11.2.8, “Adding a Parallel Workflow 
Thread,” on page 142.
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Start a Workflow Process: Vibe enables you to chain workflows together. When you are creating 
a workflow (or modifying an existing workflow), you can start an existing workflow process on 
the workflow you are creating (or modifying). This can speed up the workflow creation process 
by helping you make use of existing workflows.


Starting an existing workflow process is not the same as starting a parallel workflow thread. 
Unlike a parallel workflow thread, when you chain workflows together by starting an existing 
workflow process, there is no way to share variables or states between the two workflows; in 
other words, there is no physical connection between the two workflows.


Stop a Workflow Thread: Allows you to stop a parallel workflow when an entry enters or exits 
a specific state.


8 Set up the event you selected in Step 7. Each event type requires you to specify different setup 
options.


For information on what to specify for the individual fields, see Section 11.2.7, “Setting Up On-
Entry and On-Exit Events,” on page 139.


9 Click OK.


10 Repeat this procedure for all other states in the workflow where you want to set up on-entry or 
on-exit events.


11 Set up access controls on the workflow. For information on how to do this, see Section 11.4, 
“Adding Access Controls to a Workflow,” on page 147.


11.2.7 Setting Up On-Entry and On-Exit Events


After you add an on-entry or on-exit event to a workflow as described in Section 11.2.6, “Adding On-
Entry or On-Exit Events,” on page 138, you need to provide information to set up the event.


 “Copy Entry” on page 139


 “Custom Action” on page 139


 “Move Entry” on page 140


 “Notifications” on page 140


 “Remote Applications” on page 140


 “Set Entry Data” on page 141


 “Set a Workflow Variable” on page 141


 “Start a Parallel Workflow Thread” on page 141


 “Start a Workflow Process” on page 141


 “Stop a Workflow Thread” on page 141


Copy Entry


Select the Destination Folder: Select the folder to copy the entry to.


Selected Folder: Displays the destination folder that you selected.


Custom Action


Action Class Name: Specify the name of the custom action that your Vibe administrator has set up.


Work with your Vibe administrator for information on what you should put in this field.
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For more information about how Vibe administrators can enable JAR files to be used as custom 
workflow actions, see “Enabling Custom JAR Files to Be Used on Your Vibe Site” in the  Novell Vibe 
3.2 Administration Guide.


Move Entry


Select the Destination Folder: Select the folder to move the entry to.


Selected Folder: Displays the destination folder that you selected.


Notifications


Entry Creator: Select this option if you want to send a notification to the user who created the entry.


Team: Select this option if you want to send a notification to the entire team.


Users: Specify individual users to whom you want to send a notification.


Groups: Specify groups to whom you want to send a notification.


Select an Entry Type: Use the drop-down list to select the type of entry that most closely represents 
the type of entry that is going through the workflow.


Text to be Put in the Notification Subject Line: Specify the text that you want to appear in the 
subject line of the notification that is sent.


For example, Peer Review Needed.


Append the Entry Title: (Optional) Select this option if you want the entry title to appear after the 
text in the subject line.


Text to be Put in the Notification Body: Specify text that you want to appear in the main body of the 
e-mail notification. You can also select Append the Entry Body if you want the main body of the entry 
to display with the e-mail notification message.


Any text formatting that you use in this field needs to be done in the HTML format. Following are 
some examples of HTML formatting:


 <i></i> for italics


 <b></b> for bold


 <br> for a break (return/enter)


 <p></p> for a new paragraph


<a href=“www.example.com”></a> for links to URLs


Append the Entry Body: (Optional) Select this option if you want the main body of the entry to 
display with the e-mail notification message.


Remote Applications


Remote Application: From the drop-down list, select the remote application.


Remote applications need to be set up and enabled by your Vibe administrator before you can use 
them. For more information about remote applications, see Chapter 12, “Managing Remote 
Applications,” on page 159.
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Variable Name: Specify the name of the variable to contain the results that are returned by the 
remote application.


Execute Action in the Context Of: Select who you want the remote application to be in relation to: 
Active User, Entry Owner, or Folder Owner.


Set Entry Data


Select an Entry Type: Select the entry type that you want to associate the workflow with.


Select an Element within the Entry: Select the element in the entry that you want to be automatically 
modified.


Select the Operation: Depending on the type of element that you selected, you have various 
modification options that you can perform. Possible operations include:


 Set: Provides another drop-down list whereby you can select the action that you want to 
perform on the element. If it is a text element, you can specify text to be added to the element.


 Set to Now:  Resets the date of the element to the current day and time.


 Increment Date: Increments the date of the element by a specified number of minutes, hours, or 
days.


 Decrement Date: Decrements the date of the element by a specified number of minutes, hours, 
or days.


 Set to Now: Resets the date of the element to the current day and time.


Select the New Value: This is the new value for the element that you are modifying. The options in 
this list are based on the operation that you previously selected.


Set a Workflow Variable


Variable Value: Specify the name of the workflow variable.


Variable Name: Specify the value of the workflow variable. This is the name that is referenced 
internally.


Start a Parallel Workflow Thread


Parallel Thread Name: Select the parallel workflow thread that you want to start.


You must have already created the parallel workflow thread in order for it to be displayed in this list.


For information on how to create a parallel workflow thread, see Section 11.2.8, “Adding a Parallel 
Workflow Thread,” on page 142.


Start a Workflow Process


Workflow Process: From the drop-down list, select the workflow process that you want to start.


Stop a Workflow Thread


Parallel Thread Name: Select the workflow thread that you want to stop.
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11.2.8 Adding a Parallel Workflow Thread


Vibe workflows support parallel workflow threads, which enable you to start a second workflow 
inside of an existing workflow. Parallel workflows are useful if two or more processes need to occur 
simultaneously. The main workflow is dependent on the parallel workflow thread; only when the 
parallel thread is finished can the main workflow thread proceed.


To create a parallel workflow thread:


1 Click Workflow Process.


2 Click Add > Parallel Workflow Thread.


3 Specify the following information:


Caption: Specify a name for the parallel workflow thread.


This is the name that appears in the Vibe interface, that users see when they use this workflow 
thread.


Data Name: Specify the internal name for the parallel workflow thread.


The name that you enter in this field is not visible to users who use this workflow thread.


Start State: Select the first state in the parallel workflow thread.


End State: Select the last state in the parallel workflow thread.


4 Click OK.


For information on how to start and stop a parallel workflow thread after you have created it, see 
Section 11.2.6, “Adding On-Entry or On-Exit Events,” on page 138.


11.2.9 Chaining Workflows


Vibe enables you to chain workflows together by starting a workflow process inside of a workflow 
that you are creating (or modifying). This can speed up the workflow creation process by helping you 
make use of existing workflows.


Starting an existing workflow process is not the same as starting a parallel workflow thread. Unlike a 
parallel workflow thread, when you chain workflows together by starting an existing workflow 
process, there is no way to share variables or states between the two workflows; in other words, there 
is no physical connection between the two workflows.


You chain workflows by adding an On Entry or On Exit option to the workflow state where you want 
to add the existing workflow process. Use the On Entry or On Exit option to add the existing 
workflow process, as described in Section 11.2.6, “Adding On-Entry or On-Exit Events,” on page 138.


11.2.10 Adding a Question to a Workflow


Workflow questions can enhance the ease and usability of workflows. For example, imagine a Time-
Off Request workflow where a manager can respond to a request by simply selecting Yes or No in the 
workflow. 


In the following example, if the manager selects Yes, the workflow is transferred to the next state of 
the workflow, HR Approval. If the manager selects No, the request is denied and the workflow is 
ended.
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Figure 11-2   Workflow Question Layout


 “Creating a Workflow Question” on page 143


 “Creating Answers to a Workflow Question” on page 144


 “Designating Specific Users to Respond to a Workflow Question” on page 144


 “Creating Transitions” on page 145


 “Setting Access Controls on a Workflow Question” on page 146


Creating a Workflow Question


1 Click the workflow state where you want to add the workflow question.


A workflow question can be specific to a single state (each state can have only one associated 
question), or you can define a global question, which you can then associate with any number of 
states. Global questions are useful when multiple states require the same question and answer 
set.


2 Click Add > Workflow Question.


3 Specify the following information:


Question Text: Specify the question that you want to appear in the workflow.


For example, Approve time-off request?


Data Name: Specify the internal name for the workflow question.


This name must be unique because it is the name that you use to refer to the workflow question 
in future steps. For example, approve_timeoff_request.


4 Click OK.


5 Continue with “Creating Answers to a Workflow Question” on page 144.
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Creating Answers to a Workflow Question


1 Click Workflow Question.


This is the question that you created in “Creating a Workflow Question” on page 143.


2 Click Add > Workflow Response.


3 Specify the following information:


Response Text: Specify a single response option.


For example, Yes.


Data Name: Specify the internal name for the workflow response.


For example, yes.


4 Click OK.


5 Repeat Step 1 through Step 4 to create multiple answers to the same workflow question.


Users using this workflow can choose from the answers that you create.


You can designate specific users as responders to the workflow question, as described in 
“Designating Specific Users to Respond to a Workflow Question” on page 144.


Designating Specific Users to Respond to a Workflow Question


When you designate specific users as responders to a workflow question, you can configure the 
workflow to transition only after all responders have answered the workflow question, or only after 
all responders have answered the workflow question correctly. For more information, see “Transition 
on Response” on page 136. 


1 Click Workflow Question.


This is the question that you created in “Creating a Workflow Question” on page 143.
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2 Click Add > Responders.


The Responders dialog box is displayed.


3 In the provided form, specify which users or groups of users you want to specify as responders 
to the workflow question:


Folder Default Access: Select this option to specify all users who have access to the folder as 
responders.


Entry Creator: Select this option to specify the user who created the entry as a responder.


Team: Select this option to specify the team as responders.


Users: Specify individual users as responders.


Groups: Specify groups as responders.


Select an Entry Type: Select the type of entry that most closely represents the type of entry that 
is going through the workflow.


Select Elements within the Entry: Enables you to select elements that are contained in the entry. 
Users associated with that element are granted access.


For example, if you select Task Entry in the Select an Entry Type drop-down list, the options that 
you can select in the Select Elements within the Entry are Assigned to, Assigned to Groups, Assigned 
to Teams.


4 Click OK.


Creating Transitions


Now that you have created the workflow question and workflow answers, you need to create 
transitions that correspond to the answers that you created. This kind of transition is called 
“Transition on Response.” 


For information on how to create a Transition on Response, see Section 11.2.4, “Adding Transitions,” 
on page 132.
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Setting Access Controls on a Workflow Question


If you want to add access controls to this workflow question, you must use the Transition Out of This 
State access control setting. For more information, see Section 11.4, “Adding Access Controls to a 
Workflow,” on page 147.


11.2.11 Enabling Your Workflow for Use


Now that you have created your workflow, you need to enable it. For information on how to do this, 
see Section 11.7, “Enabling Workflows,” on page 155.


11.3 Visually Representing a Workflow
Novell Vibe enables you to view a visual representation of your workflow, which makes the creation 
process easier by allowing you to envision the workflow in every step of its development.


As you create your workflow in the Designer section, the changes you make are automatically added 
to the Workflow Preview section.


Figure 11-3   Workflow Preview Section


You can modify the workflow layout in the Workflow Preview section. You must save the layout after 
you have modified it.


 Section 11.3.1, “Modifying a Workflow Layout,” on page 147


 Section 11.3.2, “Saving a Workflow Layout,” on page 147
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11.3.1 Modifying a Workflow Layout


You can easily modify the visual representation of a workflow. Modifying the workflow layout can 
make it easier to understand how a workflow process operates because it enables you to better 
visualize the process.


1 In the Workflow Preview section, click a workflow state and drag the state to the desired location.


Transition arrows automatically adjust to the new locations of the workflow states.


11.3.2 Saving a Workflow Layout


By default, every time you make a change in the Designer section when you create a workflow, any 
changes that you previously made in the Workflow Preview section are reverted to the state when you 
last saved.


To save your layout in the Workflow Preview section:


1 Click Save Layout after you have modified your workflow layout.


Now, when you make changes in the Designer section, the changes that you previously made to 
your workflow layout in the Workflow Preview section are retained.


11.4 Adding Access Controls to a Workflow
Novell Vibe enables you to set access controls on workflows that you create. You can set access 
controls on an entire workflow, or on the individual states of a workflow.


 Section 11.4.1, “Setting Access Controls on an Entire Workflow,” on page 147


 Section 11.4.2, “Setting Access Controls on Individual States of a Workflow,” on page 150


 Section 11.4.3, “Setting Access Controls on a Manual Transition,” on page 152


11.4.1 Setting Access Controls on an Entire Workflow


1 In the Designer page, expand the workflow definition that you created in Section 11.2.1, 
“Creating the Workflow Definition,” on page 130.


2 Click Workflow Process.


3 Click Add > Access controls.


4 Click OK.


5 Expand Workflow Process, then click Access controls.
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6 Click Add.


7 Click the access control setting that you want to add.


Delete Access: Enables you to grant specific users rights to delete entries as they transition 
through the workflow process.


Modify Access: Enables you to grant specific users rights to modify entries as they transition 
through the workflow process.


Modify Specified Fields: Enables you to grant specified users or groups rights to modify 
specific fields within an entry as the entry transitions through the workflow. 


Field elements must first be configured to allow field-level modifications. You designate which 
fields have the field-level modification access control by selecting the Allow field level modification 
option when you are creating or modifying an element within the entry form, as described in 
“Adding Elements to a Form” on page 108 and “Modifying Elements in a Form” on page 108. 
The elements that have been configured to allow field-level modifications can be modified only 
by the users that you specify in the Modify Specified Fields access control, and only in the 
workflow state where this access control exists.


Read Access: Enables you to grant specific users rights to read entries as they transition through 
the workflow process. Furthermore, you can choose whether or not users are allowed to 
comment or reply to the entries.


Transition Into This State: Enables you to grant specific users rights to transition entries into 
any state in the workflow.


Transition Out of This State: Enables you to grant specific users rights to transition entries out 
of any state in the workflow.


This is the access control setting that determines who can see a workflow question. If you are 
adding a workflow question to your workflow or to an individual state, as described in 
Section 11.2.10, “Adding a Question to a Workflow,” on page 142, and you want to add access 
controls to determine who sees the question, you must use this access control setting.


8 Define the access control setting that you added in Step 7 by specifying the following 
information in the provided form:
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Folder Default Access: Select this option to grant access to all users who have access to the 
folder.


Entry Creator: Select this option to grant access to the user who created the entry.


Team: Select this option to grant access to the team.


Users: Specify individual users to whom you want to grant access.


Groups: Specify groups to whom you want to grant access.


Select an Entry Type: Select an entry type that contains a user list. Users who are in the user list 
that you select in the Select Elements within the Entry field are granted access.


Select Elements within the Entry: Select the user list fields that are contained within the 
selected entry type that contain users who you want to grant access.


Access control rights can be granted only for the User List, Group List, and List elements. By 
default, only calendar entry types and task entry types contain these elements. For Calendars, 
this is the Attendee, Attendee Groups, and Attendee Teams fields. For tasks, this is the Assigned to, 
Assigned to Groups, and Assigned to Teams fields.


For information about how to add these elements to existing entry types, or how to create your 
own custom entry types where you can add these elements, see Chapter 9, “Designing Custom 
Folder Entry Forms,” on page 105.


9 Click OK.
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11.4.2 Setting Access Controls on Individual States of a Workflow


1 In the Designer page, expand the workflow definition that you created in Section 11.2.1, 
“Creating the Workflow Definition,” on page 130.


2 Expand Workflow Process, then click the state where you want to add the access controls.


3 Click Add > Access controls.


4 Click OK.


5 Expand the state where you just added the access controls, then click Access controls.


6 Click Add.


7 Click the access control setting that you want to add.


Delete Access: Enables you to grant specific users rights to delete entries when they are in this 
workflow state.


Modify Access: Enables you to grant specific users rights to modify entries when they are in this 
workflow state.


Modify Specified Fields: Enables you to grant specified users or groups rights to modify 
specific fields within an entry as the entry transitions through the workflow. 


Field elements must first be configured to allow field-level modifications. You designate which 
fields have the field-level modification access control by selecting the Allow field level modification 
option when you are creating or modifying an element within the entry form, as described in 
“Adding Elements to a Form” on page 108 and “Modifying Elements in a Form” on page 108. 
The elements that have been configured to allow field-level modifications can be modified only 
by the users that you specify in the Modify Specified Fields access control, and only in the 
workflow state where this access control exists.


Read Access: Enables you to grant specific users rights to read entries when they are in this 
workflow state. Furthermore, you can choose whether or not users are allowed to comment or 
reply to the entries.


Transition Into This State: Enables you to grant specific users rights to transition entries into 
this state.
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This setting is relevant only when a manual transition is defined involving this state.


Transition Out of This State: Enables you to grant specific users rights to transition entries out 
of this state.


This setting is relevant only when a manual transition is defined involving this state.


8 Define the access control setting that you added in Step 7 by specifying the following 
information in the provided form:


Folder Default Access: Select this option to grant access to users who have access to the folder.


Entry Creator: Select this option to grant access to the user who created the entry.


Team: Select this option to grant access to the team.


Users: Specify individual users to whom you want to grant access.


Groups: Specify groups to whom you want to grant access.


Select an Entry Type: Select an entry type that contains a user list. Users who are in the user list 
that you select in the Select Elements within the Entry field are granted access.


Select Elements within the Entry: Select the user list fields that are contained within the 
selected entry type that contain users who you want to grant access.
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Access control rights can be granted only for the User List, Group List, and List elements. By 
default, only calendar entry types and task entry types contain these elements. For Calendars, 
this is the Attendee, Attendee Groups, and Attendee Teams fields. For tasks, this is the Assigned to, 
Assigned to Groups, and Assigned to Teams fields.


For information about how to add these elements to existing entry types, or how to create your 
own custom entry types where you can add these elements, see Chapter 9, “Designing Custom 
Folder Entry Forms,” on page 105.


9 Click OK.


11.4.3 Setting Access Controls on a Manual Transition


1 In the Designer page, expand the workflow definition that you created in Section 11.2.1, 
“Creating the Workflow Definition,” on page 130.


2 Expand Workflow Process, expand the state that contains the manual transition where you want 
to set the access controls, expand Transitions, then click Manual Transition.


3 Click Add > Manual Transition Access Controls.
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4 In the provided form, specify which users or groups of users who you want to grant access to 
transition the entry:


Folder Default Access: Select this option to grant access to users who have access to the folder.


Entry Creator: Select this option to grant access to the user who created the entry.


Team: Select this option to grant access to the team.


Users: Specify individual users to whom you want to grant access.


Groups: Specify groups to whom you want to grant access.


Select an Entry Type: Select an entry type that contains a user list. Users who are in the user list 
that you select in the Select Elements within the Entry field are granted access.


Select Elements within the Entry: Select the user list fields that are contained within the 
selected entry type that contain users who you want to grant access.


Access control rights can be granted only for the User List, Group List, and List elements. By 
default, only calendar entry types and task entry types contain these elements. For Calendars, 
this is the Attendee, Attendee Groups, and Attendee Teams fields. For tasks, this is the Assigned to, 
Assigned to Groups, and Assigned to Teams fields.
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For information about how to add these elements to existing entry types, or how to create your 
own custom entry types where you can add these elements, see Chapter 9, “Designing Custom 
Folder Entry Forms,” on page 105.


5 Click OK.


11.5 Downloading Existing Custom Forms and Workflows
The Novell Vibe Resource Library provides a collection of existing Vibe folder entry forms and 
workflows that have been designed to solve specific business problems. You can easily download the 
custom forms and workflows, then import them into your Vibe environment. You can further 
customize these forms and workflows to suit your individual business needs.


1 Navigate to the Novell Vibe Resource Library Web site (http://www.novell.com/products/
teaming/resource-library/).


2 In the Forms and Workflows tab, select the custom form or workflow that you want to use in your 
Vibe environment.


3 In the Attachment section, click the zip file to download it.


4 Import the file into your Vibe environment and deploy it for use.


For information on how to do this, follow the Novell Vibe Resource Library Deployment 
Instructions (http://www.novell.com/products/vibe-onprem/resource-library/demos/
form_workflow_deployment.html).


11.6 Workflows Included with Vibe
Novell Vibe includes three predefined workflows. One is available for you to enable and use; the 
others are used within Vibe.


 Section 11.6.1, “Available Workflows,” on page 154


 Section 11.6.2, “Internal Workflows,” on page 155


11.6.1 Available Workflows


Vibe currently includes the Publish workflow, which is functional as soon as you enable it, as 
described in Section 11.7, “Enabling Workflows,” on page 155.


You can use the Publish workflow in the following ways:


Publish Entries to a Landing Page: You can use the Publish workflow to publish entries to a landing 
page, without manually modifying the contents of the landing page.


For more information, see Section 6.7, “Automatically Displaying the Newest Folder Entries on Your 
Landing Page,” on page 76.


Keep Entries Private: You can use the Publish workflow to keep entries private until you are ready to 
publish them for other Vibe users to read.


For example, you can associate the Publish workflow with a certain entry type in a folder (see 
Section 11.7.1, “Enabling Workflows to Start When an Entry Is Created,” on page 156 for more 
information). When you create an entry in the folder, the entry is created as Private. When you are 
ready for other Vibe users to view the entry, you can change the workflow status to Publish. 
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To transition the workflow status of an entry from Private to Publish:


1 Open the entry, and in the Transition to field, select Publish in the drop-down list.


2 Click OK.


To make the workflow status of the entry Private again:


1 Open the entry where you want to change the workflow status.


2 In the Entry toolbar, click Workflow > Stop Workflow: Publish Workflow, then click OK when you 
are asked if you really want to stop the workflow.


3 In the Entry toolbar, click Workflow > Start Workflow: Publish Workflow, then click OK when you 
are asked if you really want to start the workflow.


The workflow status of the entry is now Private.


11.6.2 Internal Workflows


Vibe includes two workflows that are used internally.


 “Task Workflow” on page 155


 “Calendar Workflow” on page 155


Task Workflow


Vibe uses the Task workflow internally to allow all users who are assigned to a particular task to 
make modifications to the task, if they are not members of the workspace where the task resides.


This workflow should not be manually added to any workspace or folder.


Calendar Workflow


Vibe uses the Calendar workflow internally to allow all users who are attendees in an event to make 
modifications to the calendar event, if they are not members of the workspace where the event 
resides.


This workflow should not be manually added to any workspace or folder.


11.7 Enabling Workflows
After a workflow is created, you can enable the workflow to automatically start when certain types of 
entries are created in the folder, or when users comment on or reply to entries. Or, you can enable 
users to manually start workflows when they view the entry.


Before you can enable a workflow, the workflow must first be created. For information on how to 
create a workflow, see either Section 11.1, “Creating a Simple Workflow,” on page 121 or Section 11.2, 
“Creating an Advanced Workflow,” on page 129, depending on the type of workflow that you want 
to create.
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You can enable workflows only in folders for which you have appropriate rights. When you enable a 
workflow in a folder, it is automatically enabled on all sub-folders and sub-workspaces, and can be 
applied to all entries that are created in that folder and its sub-folders.


 Section 11.7.1, “Enabling Workflows to Start When an Entry Is Created,” on page 156


 Section 11.7.2, “Enabling Workflows to Start When Users Comment on or Reply to an Entry,” on 
page 156


 Section 11.7.3, “Allowing Users to Manually Start Workflows,” on page 157


11.7.1 Enabling Workflows to Start When an Entry Is Created


You can enable a workflow to automatically start on all entries that are created in a specific folder, 
whenever an entry is created. This is called “associating workflows with entries.”


1 Navigate to the folder where you want to enable the workflow.


2 Click Folder > Configure Views, URLs and Controls in the Action toolbar.


3 On the Folder Views, Entries and Workflows tab, in the Workflow Associations section, click the drop-
down list next to the entry type that you want to associate the workflow with, then select the 
desired workflow.


To add workflows to this drop-down list, you need to create them. After workflows have been 
created at this folder level, or at a higher workspace level, they appear in this list. For 
information on how to create workflows, see either Section 11.1, “Creating a Simple Workflow,” 
on page 121 or Section 11.2, “Creating an Advanced Workflow,” on page 129, depending on the 
type of workflow that you want to create.


4 Click Apply > Close.


Now, when this type of entry is created in this folder, Vibe automatically starts the workflow by 
placing the entry in the initial state of the workflow process that you specified.


When you enable a folder to support multiple entry types, you can associate workflows to the 
specific types of entries. For example, if you have a folder that supports both file entries and calendar 
entries, you can have one kind of workflow start when you create a file entry, and another kind of 
workflow start when you create a Calendar entry. For information on how to enable multiple entry 
types in a single folder, see Section 3.2.1, “Enabling Alternate Folder Entry Types,” on page 27.


11.7.2 Enabling Workflows to Start When Users Comment on or Reply to an 
Entry


You can enable a workflow to automatically start when users comment on or reply to an entry. This is 
called “associating workflows with comments or replies.”


1 Navigate to the folder where you want to enable the workflow.


2 Click Folder > Configure Views, URLs and Controls in the Action toolbar.


3 On the Folder Views, Entries and Workflows tab, in the Workflow Associations section, click the drop-
down list next to the comment or reply type that you want to associate the workflow with, then 
select the desired workflow.
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To add workflows to this drop-down list, you need to create them. After workflows have been 
created at this folder level, or at a higher workspace level, they appear in this list. For 
information on how to create workflows, see either Section 11.1, “Creating a Simple Workflow,” 
on page 121 or Section 11.2, “Creating an Advanced Workflow,” on page 129, depending on the 
type of workflow that you want to create.


4 Click Apply > Close.


Now, when this type of comment or reply is made to an entry in this folder, Vibe automatically 
starts the workflow by placing the entry in the initial state of the workflow process that you 
specified.


11.7.3 Allowing Users to Manually Start Workflows


You can allow users to decide if they want to start a workflow on an entry, and if they do, at what 
point they want to start the workflow. Also, you can give users the option to choose among multiple 
workflows for each entry.


1 Navigate to the folder where you want to enable users to start the workflows.


2 Click Folder > Configure Views, URLs and Controls in the Action toolbar.


3 On the Folder Views, Entries and Workflows tab, in the Allowed Workflows section, select the 
workflows that you want to allow users to choose from.


The Local Definitions section in the Allowed Workflows section displays all of the workflows that 
you have created locally. The other workflows listed in the Allowed Workflows section were either 
created by your Vibe administrator, by another user at a higher level in the workspace tree, or 
are included with the Vibe product.


4 Click Apply > Close.


Now, when users create entries in this folder, they can start and stop workflows as they desire. 
For information on how to start and stop a workflow, see “Using Workflows” in the Novell Vibe 
3.2 User Guide.


11.8 Testing A Workflow
To test a workflow, simply create the workflow in a testing workspace and ensure that it works 
according to your specifications. When the workspace is ready to be deployed in a production 
environment, export the workflow, then import it into the production workspace where you want to 
deploy it.


For information on how to import and export a workflow, see Section 11.9, “Importing and Exporting 
a Workflow,” on page 157.


11.9 Importing and Exporting a Workflow
Novell Vibe enables you to import and export workflows into and out of Vibe.


 Section 11.9.1, “Importing a Workflow,” on page 158


 Section 11.9.2, “Exporting a Workflow,” on page 158
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11.9.1 Importing a Workflow


1 Navigate to the workspace where you want to import the workflow.


2 Click Workspace > Form/View Designers in the Action toolbar.


3 Click Import.


The Import Definitions page is displayed.


4 Click Browse.


5 Browse for and select the workflow that you want to import.


6 Click OK > Close.


11.9.2 Exporting a Workflow


1 Navigate to the workspace where you created the workflow.


2 Click Workspace > Form/View Designers.


3 Click Export.


The Export Definitions page is launched.


4 Expand Workflow Processes, then select the workflow that you want to export.


5 Click OK.


6 Select the location where you want to save the workflow, then save it.
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12 12Managing Remote Applications


Remote applications communicate with a third-party, online application, and send information from 
the third-party application back into Novell Vibe. 


For example, your Vibe administrator could create a remote application for Twitter that displays all 
of your Twitter entries in Vibe. 


Remote applications are vastly customizable, and are set up by your Vibe administrator. Talk with 
your Vibe administrator if you have a request for a new remote application.


This section describes how to set up remote applications after they have already been created and 
enabled by your Vibe administrator. 


 Section 12.1, “Adding Remote Applications to Views and Forms,” on page 159


 Section 12.2, “Setting Up a Remote Application,” on page 160


 Section 12.3, “Setting Up Multiple Remote Applications on a Single Page,” on page 162


 Section 12.4, “Managing Access Controls for Remote Applications,” on page 164


12.1 Adding Remote Applications to Views and Forms
Novell Vibe enables you to add a Remote Application element to a folder or workspace view or a 
custom form. The Remote Application element is a drop-down list that enables users of the view or 
form to select from a list of remote applications. This is useful if the current view or form does not 
allow you to select a remote application to run; it is also useful if you want to run multiple remote 
applications in a single view or form. (For specific information on configuring a view or form to run 
multiple remote applications, see Section 12.3, “Setting Up Multiple Remote Applications on a Single 
Page,” on page 162.)


Unless you are the Vibe administrator, you can perform the following procedure only on custom 
views and forms for which you have appropriate rights. You can create custom views and forms for 
workspaces, folders, or entries, as described in Chapter 7, “Creating Custom Workspace Views,” on 
page 85, Chapter 8, “Creating Custom Folder Views,” on page 95, and Chapter 9, “Designing Custom 
Folder Entry Forms,” on page 105.


To add a Remote Application element to a view or form:


1 Navigate to the workspace or folder where you want to add the Remote Application element.


If you want to add the Remote Application element to a form, navigate to the workspace or 
folder where the form was created.


2 Click Workspace > Form/View Designers if the form was created at the workspace level.


or


Click Folder > Form/View Designers if the form was created at the folder level.


The Form and View Designers page is displayed.
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3 Click the entry definition, folder view, or workspace view where you want to add the Remote 
Application element.


4 Add the Remote Application element to the desired folder view, workspace view, or entry 
definition, as described in the following sections:


Folder View: Section 8.1.2, “Adding Elements to the Folder Add/Modify Form,” on page 96.


Workspace View: Section 7.1.2, “Adding Elements to the Workspace Add/Modify Form,” on 
page 86.


Entry Definition (Form): Section 9.2.2, “Adding Elements to the Entry Form Definition,” on 
page 107.


12.2 Setting Up a Remote Application
 Section 12.2.1, “Setting Up a Remote Application in a Workspace,” on page 160


 Section 12.2.2, “Setting Up a Remote Application as an Accessory,” on page 161


12.2.1 Setting Up a Remote Application in a Workspace


1 Navigate to the workspace or folder where you want to display the remote application.


2 Click Workspace > Edit Workspace, or Folder > Edit Folder.


3 In the Remote Application section, click the drop-down list and select the remote application that 
you want to enable.


4 Click OK.


The remote application is displayed at the top of the folder or workspace.
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12.2.2 Setting Up a Remote Application as an Accessory


Novell Vibe allows you to set up remote applications as accessories. You might want to do this if you 
want to view more than one remote application on a single Vibe page.


1 Navigate to the page where you want to create the Remote Application accessory.


2 Locate the Accessory Panel, then click Accessory Panel.


3 Click Add an Accessory.


4 Select the scope of the accessory you want to create, then select Remote Application.


5 Click OK.
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6 Specify a title for the accessory, then use the Remote Application drop-down menu to select the 
remote application that you want to add.


7 Click Apply > Close.


The new accessory is displayed.


12.3 Setting Up Multiple Remote Applications on a Single Page
You can use either of the following methods to set up multiple remote applications on a single 
Workspace or Folder.


 Section 12.3.1, “Launching a Remote Application as an Accessory,” on page 162


 Section 12.3.2, “Creating a New Workspace or Folder View That Supports Multiple Remote 
Applications,” on page 163


12.3.1 Launching a Remote Application as an Accessory


If you want to view more than one remote application on a single Novell Vibe page, you can set up 
one remote application in your workspace, and then you can view subsequent remote applications as 
accessories.


For more information on viewing remote applications as accessories, see Section 12.2.2, “Setting Up a 
Remote Application as an Accessory,” on page 161.
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12.3.2 Creating a New Workspace or Folder View That Supports Multiple 
Remote Applications


If you don’t want your remote application to be displayed as an accessory, but you still want to enable 
multiple remote applications on a single page, you can accomplish this by creating a new view for the 
workspace or folder where you want the remote applications to be displayed, and then configuring 
the workspace or folder to support the new view.


 “Creating the New View” on page 163


 “Configuring the Workspace or Folder to Support the New View” on page 163


 “Using the New View to Enable a Remote Application” on page 164


Creating the New View


1 In the Workspace or Folder where you want to enable additional remote applications, click 
Workspace > Form/View Designers or Folder > Form/View Designers.


The Form and View Designers page is launched.


2 Click New > Folder Views or Workspace Views, depending on whether you are working in a 
workspace or folder.


3 Provide a caption and a name for the new definition. 


4 Select the type of workspace for which you want to create the new definition.


5 Click OK.


6 Click the Workspace Add/Modify Form link.


7 In the box on the right side of the page, click Add.


8 In the Form Elements section, click Remote Application.


9 Provide a caption and a name for the new remote application field that you’re creating.


The text that you enter in the Caption field is what the remote application field is called in the 
workspace or folder form.


10 Click OK.


11 Click Close to exit the Form and View Designer.


Configuring the Workspace or Folder to Support the New View


 “Configuring a Workspace to Support the New View” on page 163


 “Configuring a Folder to Support the New View” on page 163


Configuring a Workspace to Support the New View


For information on how to configure the workspace to support the new view that you created in 
“Creating the New View” on page 163, see Section 7.3, “Enabling the Workspace View,” on page 90.


Configuring a Folder to Support the New View


For information on how to configure the workspace to support the new view that you created in 
“Creating the New View” on page 163, see Section 3.1.1, “Changing the Default Folder View,” on 
page 25.
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Using the New View to Enable a Remote Application


Now that you have created the new definition and configured the workspace or folder to support it, 
you need to enable the additional remote application.


To enable the additional remote application, see Section 12.2, “Setting Up a Remote Application,” on 
page 160.


12.4 Managing Access Controls for Remote Applications
Because not all remote applications can be completely trusted, it is often a good idea to limit the 
privileges of the remote application. Because Novell Vibe administrators are responsible for creating 
and enabling the remote application for the Vibe site, they are also responsible for setting up access 
controls on the remote application.


Before you modify the access control settings of remote applications for a specific workspace or 
folder, you should consult with your Vibe administrator to ensure that what you plan to do is safe.


When an application is restricted to a specific role, the application can use Web services to perform 
only those tasks that are allowed for that role. For example, the Participant role can create new 
entries, modify entries that the user created, add comments to entries, and so on. Participants cannot 
perform system administration tasks and cannot modify other users’ entries.


To limit the remote application to privileges assigned to a specific role:


1 Navigate to the folder or workspace where you want to set the access control settings on the 
remote application.


2 Click Workspace > Access Control or Folder > Access Control.


3 On the Configure Access Control page, click Add an Application.


4 In the Add an Application field, use type-to-find functionality to specify and select the application 
that you want to add.


5 Close the Add an Application panel by clicking the X in the upper right corner.


6 In the access control table, select the check box that is located in the row of the remote 
application that you just added, and the column of the role that you want to assign to the 
application.
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7 Click Save Changes > Close.


The application that you added is now restricted to those operations allowed for the role that you 
selected. For example, if you assigned the Participant role to the remote application, then the 
inheritance of workspace and folder access controls means that it is very likely that most workspaces 
and folders inherit this setting. Assuming that all places inherited this setting, the most powerful role 
the remote application can assume within the installation is that of a Participant.


If you are not sure what access control settings to assign to a particular remote application, consult 
with your Vibe administrator.


If your Vibe administrator has enabled multiple applications for your site, some of these applications 
might be grouped together in an Application Group. Application Groups are similar to groups that 
contain usernames. Application groups contain the names of registered applications. After your Vibe 
administrator defines application groups, you as a workspace and folder owner can assign access-
control roles to groups of applications instead of assigning roles to one application at a time.
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13 13Managing Your Data Quota


Data quotas can be enabled by your Novell Vibe administrator in order to limit the amount of data 
that is stored on the Vibe site. For information on how the Vibe administrator can enable data quotas, 
see “Managing Disk Space Usage with Data Quotas and File Restrictions” in the  Novell Vibe 3.2 
Administration Guide.


If data quotas have been enabled on your Vibe site, you need to understand what counts toward your 
data quotas, the different kinds of data quotas that exist, and how you can view the current data 
usage so you can know when you are approaching the allotted data quota. If you meet your allotted 
quota, Vibe enables you to purge files and attachments that you have previously deleted.


 Section 13.1, “Understanding Data Quotas,” on page 167


 Section 13.2, “Viewing Your Data Quota,” on page 168


 Section 13.3, “Setting a Data Quota for Workspaces and Folders,” on page 170


 Section 13.4, “Adding Files and Attachments to the Vibe Site When You Are Over Your Quota,” 
on page 171


 Section 13.5, “E-Mailing Files and Attachments to the Vibe Site When You Are Over Your 
Quota,” on page 171


 Section 13.6, “Using Mirrored Folders When You Are Restricted by a Data Quota,” on page 171


 Section 13.7, “Adding Files Through WebDAV When You Are Restricted by a Data Quota,” on 
page 171


 Section 13.8, “Working with File Versions When You Are Restricted by a Data Quota,” on 
page 172


 Section 13.9, “Making Disk Space Available by Purging Deleted Items,” on page 172


13.1 Understanding Data Quotas
Only files and attachments count toward your data quota. Workspaces, folders, and entries that do 
not contain files and attachments do not count toward your data quota. Files and attachments must 
be deleted and purged in order to make more disk space available.


The Novell Vibe administrator can enable two kinds of data quotas:


 User data quotas


 Workspace and folder data quotas


The administrator can enable one of these quotas, or both of them.


 Section 13.1.1, “Understanding User Data Quotas,” on page 168


 Section 13.1.2, “Understanding Workspace and Folder Data Quotas,” on page 168
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13.1.1 Understanding User Data Quotas


User data quotas limit the amount of data individual users can add to the Vibe site. Any files and 
attachments that you add to the Vibe site counts toward your data quota, regardless of the folders or 
workspaces where you add them.


13.1.2 Understanding Workspace and Folder Data Quotas


Workspace and folder quotas limit the amount of data that can be stored in individual workspaces 
and folders.


Sub-workspaces and sub-folders that have a data quota are subject to their own data quota as well as 
any data quotas that exist on parent folders and workspaces. For example, consider a workspace that 
has a data quota of 50 MB. The workspace contains two sub-workspaces: Workspace A and 
Workspace B. Users cannot upload data that is in excess of 50 MB into either of these sub-workspaces. 
Furthermore, users cannot upload data into both of these sub-workspaces that is in excess of 50 MB 
(for example, users cannot upload data that is in excess of 30 MB into both sub-workspace, because 
the amount of combined data for both sub-workspaces is greater than 50 MB).


13.2 Viewing Your Data Quota
Data quotas might or might not be in use on your Vibe site. If you are unable to view your data 
quotas as described in this section, your Vibe administrator has not yet restricted the amount of data 
that can be added to the Vibe site.


If you have exceeded your allotted data quota, you should purge items that you have previously 
deleted, as discussed in Section 13.9, “Making Disk Space Available by Purging Deleted Items,” on 
page 172.


 Section 13.2.1, “Viewing Your User Data Quota,” on page 168


 Section 13.2.2, “Viewing Your Workspace or Folder Data Quota,” on page 169


13.2.1 Viewing Your User Data Quota


If your administrator has set a user data quota and if you are an active contributor to your Novell 
Vibe site, you might want to periodically view your current data quota to ensure that you are not 
approaching the user limit.


To view your current data quota and how much you are currently using:


1 Navigate to the home page of your personal workspace.


2 Click the Profile link, located next to your name.
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3 Your data quota is displayed in the upper right corner of the Profile page, along with the amount 
you are currently using.


13.2.2 Viewing Your Workspace or Folder Data Quota


The Vibe administrator can set a data quota on your workspaces and folders, or the administrator can 
allow you to set your own data quotas on your own workspaces and folders.


You must be an administrator for the workspace or folder in order to view data quotas.


To view your current workspace or folder quota:


1 Navigate to the workspace or folder where you want to view the quota.


2 Click Workspace > Configure Views, URLs and Controls if you want to view the quota for a 
workspace.


or


Click Folder > Configure Views, URLs and Controls if you are managing the quota for a folder.


3 Click the Quotas tab.
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The following data quota information is displayed for the workspace or folder:


 Workspace/Folder Disk Space Used: The amount of disk space the workspace or folder is 
currently using. This does not include disk space that is being used by sub-workspaces and 
sub-folders.


 Workspace and Children Disk Space Used/Folder and Sub-Folder Disk Space UsedDisk 
Space Used: The amount of disk space that is being used by the workspace or folder and all 
of its sub-workspaces and sub-folders.


 Lowest Quota on Parent Workspaces or Folders: The lowest quota that exists on any 
workspace or folder that is higher in the folder hierarchy than the workspace or folder that 
you are currently viewing.


Sub-workspaces and sub-folders that have a data quota are subject to their own data quota 
as well as any data quotas that exist on parent folders and workspaces. For more 
information, see Section 13.1.2, “Understanding Workspace and Folder Data Quotas,” on 
page 168.


 Current Quota: The current data quota that exists on the workspace or folder.


 Set a Quota: Enables you to change the data quota for the workspace or folder.


13.3 Setting a Data Quota for Workspaces and Folders
The Vibe administrator can allow you to set your own data quotas for your workspaces and folders. 
If you cannot set a data quota as described in this section, your administrator has not allowed this 
capability.


If workspace and folder administrators have set data quotas at higher-level workspaces, your 
workspaces and folders are subject to any quotas that are set on the higher-level workspaces. For 
example, suppose you are the administrator of a team workspace called “Online Marketing”. This 
team workspace is a sub-workspace to a workspace called “Marketing”. If the workspace 
administrator for the Marketing workspace has set a data quota of 100 MB, users in your workspace 
and in other sub-workspaces to the Marketing workspace cannot upload more than 100 MB of 
collective data to the sub-workspaces, regardless of what is set as the data quota for the sub-
workspaces. For more information, see Section 13.1.2, “Understanding Workspace and Folder Data 
Quotas,” on page 168.
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To set a data quota for workspaces and folders:


1 Navigate to the workspace or folder where you want to view the quota.


2 Click Workspace > Configure Views, URLs and Controls if you are managing the quota for a 
workspace.


or


Click Folder > Configure Views, URLs and Controls if you are managing the quota for a folder.


3 Click the Quotas tab.


4 In the Set a Quota field, specify the new data quota for the workspace or folder, then click OK.


13.4 Adding Files and Attachments to the Vibe Site When You 
Are Over Your Quota
If you have exceeded your data quota but you still need to add files and attachments to the Novell 
Vibe site, you need to decrease your disk usage by purging files and attachments that you have 
previously deleted.


For information on how to purge deleted items, see Section 13.9, “Making Disk Space Available by 
Purging Deleted Items,” on page 172.


13.5 E-Mailing Files and Attachments to the Vibe Site When You 
Are Over Your Quota
Novell Vibe enables you to add files and entry attachments to the Vibe site via e-mail, as described in 
“Adding Entries to a Folder Via E-Mail” in the Novell Vibe 3.2 User Guide. However, if you have met 
your data quota, you are unable to e-mail entries to Vibe if they include attachments.


If you have exceeded your allotted data quota, you should purge the items that you have previously 
deleted, as discussed in Section 13.9, “Making Disk Space Available by Purging Deleted Items,” on 
page 172.


13.6 Using Mirrored Folders When You Are Restricted by a Data 
Quota
Files stored in mirrored file folders do not count against your data quota because they are not 
uploaded into the Novell Vibe site.


For more information on mirrored folders, see Section 3.8, “Working with Mirrored Folders,” on 
page 35.


13.7 Adding Files Through WebDAV When You Are Restricted by 
a Data Quota
When you add files to the Novell Vibe site through WebDAV, the files still count against your data 
quota, just as if you had added the files through the regular Vibe interface.
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13.8 Working with File Versions When You Are Restricted by a 
Data Quota
Novell Vibe enables you to create multiple versions of the same file, as described in “Using Version 
Control with Files” in the Novell Vibe 3.2 User Guide.


When you edit a document in Vibe, Vibe creates a new version of the file. This new version counts 
against the data quota of the user who edited the file; it does not count against the quota of the user 
who originally posted the file. File versions also count against the data quota of individual 
workspaces and folders.


You can manage your data quota by deleting previous versions of a file that you no longer need. For 
information about how to delete previous file versions, see “Deleting Existing Versions of a File” in 
the Novell Vibe 3.2 User Guide.


IMPORTANT: When you use OpenOffice to edit a document in Vibe, a new version of the document 
is created each time you click Save. Because each version of a document counts against your data 
quota, you should save the document only once if you are using OpenOffice as an editor.


When you use Microsoft Office, Vibe creates only one version when you save the document. Clicking 
Save multiple times does not create multiple versions, as is the case when you edit documents with 
OpenOffice.


13.9 Making Disk Space Available by Purging Deleted Items
Files and attachments that have been deleted but not yet purged still count toward your data quota. 
Workspaces, folders, and entries that do not contain files and attachments do not count toward your 
data quota. If you have reached your allotted data quota, you need to purge deleted files and 
attachments.


You can purge any item that you have rights to delete.


NOTE: Purged items cannot be recovered. When you purge items from the Vibe site, remember the 
following:


 Purging an entry also purges all attached files, comments, and replies.


 Purging a folder also purges all entries and sub-folders that are associated with that folder.


 Purging a workspace also purges all folders, sub-folders, and entries that are associated with 
that workspace.


1 Navigate to the folder or workspace where the deleted item that you now want to purge 
previously resided.


For example, if you want to purge a file entry that was in your personal Files folder, navigate to 
the Files folder in your personal workspace.


If you want to see everything that has been deleted in the Vibe site, navigate to the highest level 
workspace. (By default this is the Home Workspace directory.)


2 Click the Trash icon , located in the Navigation panel.


The Trash page displays all workspaces, folders, and entries that have been deleted in or below 
the current workspace or folder.
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3 Select the file entry or any other type of entry that contains an attachment that you want to 
purge.


4 Click Purge > OK.


The item is purged from the Vibe site.
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14 14Restoring Deleted Items


Novell Vibe enables you to undelete a workspace, folder, or entry that you previously deleted, 
restoring it to its previous location. When you undelete an entry, all associated attachments, 
comments, and replies are also undeleted.


You cannot undelete an item that has been purged.


 Section 14.1, “Rights Associated with Undeletion,” on page 175


 Section 14.2, “Undeleting Workspaces, Folders, and Entries,” on page 175


 Section 14.3, “Undeleting Mirrored Files,” on page 176


 Section 14.4, “Undeleting Items That Contain Workflows,” on page 176


 Section 14.5, “Locating Deleted Items,” on page 176


14.1 Rights Associated with Undeletion
As a general rule, if you have rights to delete an item in Novell Vibe, you also have rights to undelete 
that item.


Remember the following when undeleting:


 You can undelete an item that another user deleted, if you have appropriate rights.


 If you have rights to undelete an entry, but do not have rights to undelete the folder that contains 
the entry, you cannot undelete the entry.


 If you have rights to undelete a folder, but do not have rights to undelete the workspace that 
contains the folder, you cannot undelete the folder.


 When you undelete a folder, the contents of the folder are not automatically undeleted. You need 
to undelete the contents of the folder separately.


 When you undelete an entry in a deleted folder, the folder is automatically undeleted. However, 
if you do not have rights to undelete the folder, you cannot undelete the entry.


14.2 Undeleting Workspaces, Folders, and Entries
If you have the appropriate rights, you can undelete any workspace, folder, or entry and restore it to 
its previous location.


1 Navigate to the folder or workspace where the deleted workspace, folder, or entry previously 
resided.


For example, if you want to restore a Blog folder that was in your personal workspace, navigate 
to your personal workspace.
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If you want to see everything that has been deleted in the Novell Vibe site, navigate to the 
highest level workspace. (By default this is the Home Workspace directory.)


2 Click the Trash icon , located in the Navigation panel.


The Trash page displays all workspaces, folders, and entries that have been deleted in or below 
the current workspace or folder.


3 Select the workspace, folder, or entry that you want to undelete.


4 Click Restore.


The workspace, folder, or entry is restored to its previous location.


14.3 Undeleting Mirrored Files
Undeleting files that have been deleted through a mirrored folder is not supported in Novell Vibe. 
Files that are deleted through a mirrored folder cannot be recovered.


14.4 Undeleting Items That Contain Workflows
When you undelete a workspace or folder where a workflow has been created, the workflow is also 
restored with the workspace or folder. 


When you undelete a folder entry where a workflow has been enabled, the entry is restored with the 
workflow still enabled. The entry is in the same workflow state as it was when it was deleted.


14.5 Locating Deleted Items
If you cannot find an item in your Novell Vibe site that you know was there previously, it has 
probably been deleted.


To locate the deleted item, you can do either of the following:


 Perform a search for the deleted item, as described in “Searching for Deleted Items” in the Novell 
Vibe 3.2 User Guide.


 Navigate to the folder or workspace where the item previously resided, and click the Trash icon 
 located in the Navigation panel, as described in Section 14.2, “Undeleting Workspaces, 


Folders, and Entries,” on page 175.
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15 15Using Vibe on Your Mobile Phone


Mobile access to the Novell Vibe site can be deactivated by your Vibe administrator. If you are unable 
to access the Vibe mobile interface as described in this section, consult your Vibe administrator.


You can download a native application for your iPhone or Android device. These applications have a 
more polished user interface and don’t require you to sign in each time you access Vibe. However, the 
mobile app for Vibe does not store information on your device; information can be viewed only when 
you have an Internet connection. 


Other devices can access the Vibe mobile interface by using a mobile browser that meets the 
requirements listed in Section 15.2, “Browser Requirements,” on page 178.


 Section 15.1, “Supported Mobile Devices,” on page 177


 Section 15.2, “Browser Requirements,” on page 178


 Section 15.3, “Getting Started,” on page 178


 Section 15.4, “Supported Features,” on page 182


 Section 15.5, “Features that Are Not Supported in the Vibe Mobile Interface,” on page 191


 Section 15.6, “Security Considerations,” on page 191


 Section 15.7, “Troubleshooting Your Mobile Device,” on page 191


15.1 Supported Mobile Devices
The Novell Vibe mobile interface is supported on the following mobile devices:


 iPhone (native application is available for a free download in the Apple App Store for iOS 3.2 or 
later)


 Android (native application is available for a free download in the Android Market for Android 
2.2 or later)


 BlackBerry


 Any other mobile device that provides an HTTP/HTML-based interface


Ensure that your device’s browser meets the requirements that are discussed in Section 15.2, 
“Browser Requirements,” on page 178.


For tablet devices such as the iPad, the default interface is the same as when you access Vibe from 
your workstation.
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15.2 Browser Requirements
To use Novell Vibe from a mobile device, your device’s browser must support: 


 HTML 4


 JavaScript


15.3 Getting Started
 Section 15.3.1, “Getting Started with iPhone or Android Devices,” on page 178


 Section 15.3.2, “Getting Started with Other Devices,” on page 181


15.3.1 Getting Started with iPhone or Android Devices


 “Connecting to an Initial Vibe Site” on page 178


 “Connecting to Additional Vibe Sites” on page 179


 “Switching from One Vibe Site to Another” on page 180


 “Modifying the Configuration Settings for a Vibe Site” on page 180


 “Deleting the Configuration Settings for a Vibe Site” on page 181


Connecting to an Initial Vibe Site


When you first set up the application, you need to specify information for just one Vibe site. After 
you have performed the initial setup as described in this section, launching the Vibe application 
automatically connects you and authenticates you to your Vibe server.


1 Download the Vibe mobile application from either the Apple App Store or from the Android 
Market.


2 Launch the Vibe mobile application on your iPhone or Android device.


3 Accept the Vibe license agreement.


4 On the New Site page, specify the following information:


Site Name: Specify a name for your Vibe site. This is the name that appears at the top of the 
home page.


URL:  Specify the URL for the Vibe site. For example, http://vibesite.com.


Make Primary Site: Select this option if you have configured or are planning to configure 
multiple Vibe sites and you want this site to be displayed when you first launch the application. 


Login Name: Specify the login name that you use to log in to the Vibe site.


Password: Specify the password that you use to log in to the Vibe site.


Save Password: Select this option if you want your password to be securely stored on your 
device so that you can automatically be signed in to the Vibe site when you launch the Vibe 
application.


5 Click Login or Done.
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The home page is displayed. If it is not, tap the site on the site page to connect to the site.


Connecting to Additional Vibe Sites


You can configure the Vibe mobile application to connect to multiple Vibe sites. 


1 Launch the Vibe mobile application on your iPhone or Android device.


2 Tap the Menu button on your device.


3 For iPhone devices, on the Vibe Sites page, tap the Plus icon.


or


For Android devices, tap Select a Site, then on the Site List page, tap New Site.


4 Specify the following information


Site Name: Specify a name for your Vibe site. This is the name that appears at the top of the 
home page. Give the site a unique name to differentiate it from other Vibe sites that you have 
configured.


URL:  Specify the URL for the Vibe site. For example, http://vibesite.com.


Make Primary Site: Select this option if you have configured or are planning to configure 
multiple Vibe sites and you want this site to be displayed when you first launch the application. 


Login Name: Specify the login name that you use to log in to the Vibe site.


Password: Specify the password that you use to log in to the Vibe site.


Save Password: Select this option if you want your password to be securely stored on your 
device so that you can automatically be signed in to the Vibe site when you launch the Vibe 
application.


5 Click Login or Done.
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The home page is displayed. If it is not, tap the site on the site page to connect to the site.


Switching from One Vibe Site to Another


If you have configured multiple Vibe sites as described in “Connecting to Additional Vibe Sites” on 
page 179, you can easily leave one Vibe site to view information on another Vibe site.


1 Tap the Menu button on your device.


2 For iPhone devices, on the Vibe Sites page, tap the site that you want to connect to.


or


For Android devices, tap Select a Site, then on the Site List page, tap the site that you want to 
connect to.


Modifying the Configuration Settings for a Vibe Site


You can modify the configuration settings for a Vibe site after you have already configured it in the 
Vibe application. For example, you can modify your username, password, or site name.


1 Tap the Menu button on your device.


2 For iPhone devices, on the Vibe Sites page, tap the Configure icon next to the site that you want to 
modify.


or


For Android devices, tap Select a Site, then on the Site List page, tap the Configure icon next to the 
site that you want to modify.


3 Make the desired modifications, then tap Save or Done.
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Deleting the Configuration Settings for a Vibe Site


You can modify the configuration settings for a Vibe site after you have already configured it in the 
Vibe application. 


1 Tap the Menu button on your device.


2 For iPhone devices, on the Vibe Sites page, tap the Configure icon next to the site that you want to 
delete.


or


For Android devices, tap Select a Site, then on the Site List page, tap the Configure icon next to the 
site that you want to delete.


3 Scroll to the bottom of the page, then click Delete Site or Delete, then click Delete or Yes to confirm 
the deletion.


15.3.2 Getting Started with Other Devices


Use the following information to help you access Novell Vibe from your mobile device, and learn 
basic navigation:


1 On your mobile device, launch a Web browser such as Mozilla Firefox or Internet Explorer.


2 Specify the URL of your corporation’s Vibe site.


For example, http://host:port.


Vibe automatically detects that you are using a mobile device, and directs you to the Vibe mobile 
interface.


If Vibe displays the regular Vibe interface instead of the mobile interface, add /mobile to the 
end of the Vibe URL, as discussed in “Your Browser Does Not Automatically Direct You to the 
Mobile Interface” in “Troubleshooting” in the Novell Vibe 3.2 User Guide.


3 Specify your username and password, then tap Login.
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The home page is displayed.


15.4 Supported Features
 Section 15.4.1, “Navigating to the Home Page of the Mobile Interface,” on page 183


 Section 15.4.2, “Searching the Mobile Interface,” on page 183


 Section 15.4.3, “Viewing Your Teams,” on page 185


 Section 15.4.4, “Viewing Your Favorite Places,” on page 185


 Section 15.4.5, “Viewing Your Recent Places,” on page 185


 Section 15.4.6, “Viewing File Entries and Attachments,” on page 185


 Section 15.4.7, “Viewing YouTube Videos,” on page 185


 Section 15.4.8, “Viewing What’s New,” on page 186


 Section 15.4.9, “Viewing What’s Unread,” on page 187


 Section 15.4.10, “Viewing the Workspace Tree,” on page 187


 Section 15.4.11, “Viewing Profile Information,” on page 188


 Section 15.4.12, “Creating a Folder Entry,” on page 188


 Section 15.4.13, “Commenting on a Folder Entry,” on page 188


 Section 15.4.14, “Deleting a Folder Entry,” on page 189


 Section 15.4.15, “Calling Vibe Users with One Click (iPhone and Android Only),” on page 189


 Section 15.4.16, “Sending E-Mail,” on page 189


 Section 15.4.17, “Following People and Places of Interest,” on page 190


 Section 15.4.18, “Transitioning Entries from One Workflow State to Another,” on page 190


 Section 15.4.19, “Using Folders,” on page 190
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15.4.1 Navigating to the Home Page of the Mobile Interface


Regardless of where you are in the Vibe mobile interface, you can easily navigate to the home page.


1 Tap the Home icon  in the Navigation toolbar at the top of the mobile interface.


The home page is displayed.


15.4.2 Searching the Mobile Interface


The Novell Vibe mobile interface enables you to search for people, places, entries, and attachments.


Advanced Search is not supported in the mobile interface. However, you can save an advanced 
search when you access Vibe from your workstation, then use it on your mobile device.


 “Performing a Basic Search” on page 183


 “Using a Saved Search” on page 184


Performing a Basic Search


To perform a basic search in the Vibe mobile interface:


1 Tap the Search icon  in the Navigation toolbar at the top of the mobile interface.


The Search drop-down menu is displayed.
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2 In the drop-down list, select the category for which you want to search.


You can search for People, Places, or All.


3 Select whether you want to search the entire Vibe site, or only the workspace that you currently 
are in.


4 Specify the words or phrases that you want to search for, then tap OK.


The Search Results page is displayed.


Using a Saved Search


Vibe enables you to perform saved searches that you have previously created and saved when you 
accessed the Vibe site from your workstation.


TIP: Even though the Vibe mobile interface does not have an Advanced search, you can create and 
save an Advanced search when you access the Vibe site from your workstation. You can then use the 
saved search on your mobile device.


For information on how to create a saved search, see “Saving and Reusing Searches” in the Novell Vibe 
3.2 User Guide.


For information on how to save an Advanced Search when accessing the Vibe site from your 
workstation, see “Using Advanced Search” in the Novell Vibe 3.2 User Guide.


To access and use a saved search from the Vibe mobile interface:


1 Tap the Search icon  in the Navigation toolbar at the top of the mobile interface.


2 In the Saved Searches section, tap the saved search that you want to run.


The Search Results page displays the results for your saved search.
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15.4.3 Viewing Your Teams


You can quickly view all the teams of which you are a member.


1 On the home page, tap My Teams.


15.4.4 Viewing Your Favorite Places


You can quickly view your favorite places. 


1 On the home page, tap My Favorites.


To add or delete favorites, you must access the Vibe site from your workstation. For more 
information, see “Managing Your Favorite Places” in the Novell Vibe 3.2 User Guide.


15.4.5 Viewing Your Recent Places


The Vibe mobile interface enables you to quickly view workspaces and folders that you have visited 
since you last logged in to the current Vibe session.


1 On the home page, tap Recent Places.


or


From any other page, tap Actions > Recent Places.


15.4.6 Viewing File Entries and Attachments


The Vibe mobile interface enables you to view file entries as well as documents that have been 
attached to entries.


1 Navigate to and open the entry that contains the document that you want to view.


2 In the Attachments section, tap the name of the document that you want to view.


TIP: If your mobile device is capable of viewing the file in its native format, you can simply tap the 
file link to view the file.


For example, when you use an iPhone, you can tap the file link to view Microsoft Word files, PDF 
files, and Microsoft Excel files.


15.4.7 Viewing YouTube Videos


The Vibe mobile interface enables you to view YouTube videos that are posted in your Vibe site. 
However, you cannot use a mobile device to view YouTube videos that are posted in the Branding 
section of workspaces or folders; the video must be posted within a folder entry or in the Description 
section of the folder or workspace.


Your BlackBerry or other mobile device might not be properly set up to view YouTube videos. If you 
are having difficulty viewing YouTube videos from your mobile device, follow the instructions in 
“You Are Unable to View YouTube Videos from Your Mobile Device” in the Novell Vibe 3.2 User Guide.
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To view a YouTube video from the Vibe mobile interface:


1 Navigate to and open the entry that contains the YouTube video that you want to view.


2 Tap the YouTube icon .


You are directed to the mobile YouTube site to view the video.


To post YouTube videos, you must access the Vibe site from your workstation. For more information, 
see “Displaying YouTube Videos in a Folder Entry” in the Novell Vibe 3.2 User Guide.


15.4.8 Viewing What’s New


The Vibe mobile interface enables you to see new entries that have been added to the Vibe site.


 “Viewing What’s New in Your Teams” on page 186


 “Viewing What’s New in Your Followed Places” on page 186


 “Viewing What’s New in Your Favorite Places” on page 186


 “Viewing What’s New Across the Entire Site” on page 186


 “Viewing the Newest Micro-Blog Entries of People You’re Following” on page 186


 “Viewing What’s New in a Folder” on page 187


 “Viewing What’s New in a Workspace” on page 187


Viewing What’s New in Your Teams


1 On the home page, tap What’s New.


2 From the What’s New drop-down list on the home page, tap My Teams.


Viewing What’s New in Your Followed Places


1 On the home page, tap What’s New.


2 From the What’s New drop-down list on the home page, tap All Followed.


Viewing What’s New in Your Favorite Places


1 On the home page, tap What’s New.


2 From the What’s New drop-down list on the home page, tap Favorites.


Viewing What’s New Across the Entire Site


1 On the home page, tap What’s New.


2 From the What’s New drop-down list on the home page, tap Site Wide.


Viewing the Newest Micro-Blog Entries of People You’re Following


1 On the home page, tap What’s New.


2 From the What’s New drop-down list on the home page, tap Micro-Blogs.
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Viewing What’s New in a Folder


1 Navigate to the folder where you want to see new items.


2 Tap Actions > New in This Folder.


Viewing What’s New in a Workspace


1 Navigate to the workspace where you want to see new items.


2 Tap Actions > New in This Workspace.


15.4.9 Viewing What’s Unread


The Vibe mobile interface enables you to see which entries have not yet been read.


 “Viewing What’s Unread in a Folder” on page 187


 “Viewing What’s Unread in a Workspace” on page 187


 “Viewing What’s Unread across the Entire Site” on page 187


Viewing What’s Unread in a Folder


1 Navigate to the folder where you want to see new items.


2 Tap Actions > Unread in This Folder.


Viewing What’s Unread in a Workspace


1 Navigate to the workspace where you want to see new items.


2 Tap Actions > Unread in This Workspace.


Viewing What’s Unread across the Entire Site


1 On the home page, tap Actions > Unread Site Wide.


15.4.10 Viewing the Workspace Tree


The Vibe mobile interface enables you to view the Workspace tree, so you can see the hierarchy of 
where you currently are and quickly navigate to a different workspace or folder.


1 Tap the Tree icon .
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The Workspace tree is displayed.


15.4.11 Viewing Profile Information


You can view the complete user profile information for yourself or for other users. 


 “Viewing Your Own User Profile Information” on page 188


 “Viewing Another User’s Profile Information” on page 188


Viewing Your Own User Profile Information


1 From the home page, tap My Profile.


All your profile information is displayed.


To edit your profile information, access Vibe from your workstation, then follow the steps in 
“Modifying Your Profile” in the Novell Vibe 3.2 User Guide.


Viewing Another User’s Profile Information


1 Search for the person whose profile you want to view, as described in “Performing a Basic 
Search” on page 183.


2 Tap the name of the user whose profile information you want to view.


The user’s profile is displayed.


15.4.12 Creating a Folder Entry


1 Navigate to the folder where you want to create the entry.


2 Tap New.


If you do not have rights to create an entry in this folder, this option is not displayed


3 Specify the appropriate information for the entry, such as a title and description, then tap OK.


15.4.13 Commenting on a Folder Entry


1 Navigate to and open the entry that you want to comment on.


2 Tap Comment.


3 Specify your comment, then tap OK.
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15.4.14 Deleting a Folder Entry


1 Navigate to and open the entry that you want to delete.


2 Tap Delete.


If you do not have rights to delete the entry, this option is not displayed.


3 Tap OK when asked if you really want to delete the entry.


15.4.15 Calling Vibe Users with One Click (iPhone and Android Only)


When you use Vibe from your iPhone or Android device, you can call other Vibe users with just one 
click.


1 Navigate to the personal workspace of the user whom you want to call.


You can navigate to a user’s personal workspace by tapping the user’s linked name that appears 
next to any entry that user has posted. Or, you can search for the user as described in 
Section 15.4.2, “Searching the Mobile Interface,” on page 183.


2 Tap the user’s linked phone number.


A call is made to the user.


15.4.16 Sending E-Mail


The Vibe mobile interface enables you to quickly send e-mail to other Vibe users.


1 Navigate to the personal profile of the user to whom you want to send an e-mail.


You can navigate to a user’s personal profile by tapping the user’s linked name that appears next 
to any entry that user has posted. Or, you can search for the user as described in Section 15.4.2, 
“Searching the Mobile Interface,” on page 183.


2 Tap the user’s linked e-mail address.

Using Vibe on Your Mobile Phone 189







15.4.17 Following People and Places of Interest


The Vibe mobile interface enables you to follow places or people. You can easily see activity 
generated in the specific place that you are following, or by the specific person that you are following.


 “Configuring Vibe to Follow Workspaces, Folders, and People” on page 190


 “Viewing Your Followed Workspaces, Folders, and People of Interest” on page 190


 “Unfollowing Workspaces, Folders, or People” on page 190


Configuring Vibe to Follow Workspaces, Folders, and People


1 Navigate to the workspace or folder that you want to follow. If you want to follow a person, 
navigate to the user’s personal workspace.


2 Tap Actions > Follow this Folder, Follow this Workspace, or Follow this Person, depending on what 
you want to follow.


Viewing Your Followed Workspaces, Folders, and People of Interest


If you are currently following a workspace, folder, or person, Vibe enables you to easily see activity 
generated in the specific place that you are following, or by the specific person that you are following.


For more information, see “Viewing What’s New in Your Followed Places” on page 186.


Unfollowing Workspaces, Folders, or People


If you are currently following someone or some place in Vibe, you can unfollow that person or place 
in the Vibe mobile interface.


1 Navigate to the workspace or folder that you want to stop following. If you want to stop 
following a Vibe user, navigate to that user’s personal workspace.


2 Tap Actions > Stop Following this Workspace, Stop Following this Folder, or Stop Following this Person, 
depending on what you want to stop following.


15.4.18 Transitioning Entries from One Workflow State to Another


The Vibe mobile interface enables you to transition entries from one workflow state to another.


For information on how to create a workflow, see Chapter 11, “Creating and Managing Workflows,” 
on page 121.


To transition entries to another workflow state in the Vibe mobile interface:


1 Navigate to and open the entry that you want to transition to a new workflow state.


2 In the Workflow section, tap the new workflow state in the drop-down list, then tap OK.


15.4.19 Using Folders


The Vibe mobile interface enables you to use most types of Vibe folders. However, not all folder types 
support the full functionality that is available when accessing the Vibe site from your workstation. 
For more information, see Section 15.5, “Features that Are Not Supported in the Vibe Mobile 
Interface,” on page 191.
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15.5 Features that Are Not Supported in the Vibe Mobile 
Interface
The following Novell Vibe features are not supported when you access Vibe from the mobile 
interface. If you want to use any of these features, you must access Vibe from your workstation:


 “Using Advanced Search” in the Novell Vibe 3.2 User Guide


You cannot create an advanced search in the mobile interface, but you can access a saved search, 
as described in “Using a Saved Search” on page 184.


 “Viewing and Revisiting Recent Entries” in the Novell Vibe 3.2 User Guide


 “Adding a Favorite Place” and “Editing Your Favorite Places” in the Novell Vibe 3.2 User Guide


 “Creating a New Folder” in the Novell Vibe 3.2 User Guide


  “Working with Surveys Folders” in the Novell Vibe 3.2 User Guide


You can use the Vibe mobile interface to view Surveys folders and see the titles of the individual 
surveys that the folders contain, but you cannot view the survey itself or participate in it.


 “Viewing Your Tasks in a Full Interactive View” in the Novell Vibe 3.2 User Guide


 Chapter 5, “Branding a Folder or Workspace,” on page 53


You cannot use the Vibe mobile interface to brand a workspace or folder, or view branding that 
has already been created on a workspace or folder.


 “Editing Files” in the Novell Vibe 3.2 User Guide


 “Attaching Files to a Folder Entry” in the Novell Vibe 3.2 User Guide


15.6 Security Considerations
When you access Novell Vibe from your mobile device, you enjoy the same security as when you 
access Vibe from your workstation. Security features include:


 Secure access via SSL.


 All previously established access control settings are preserved in the mobile interface.


However, you cannot set new access control settings in the mobile interface. For information on 
how to set new access control settings when you access the Vibe site from your workstation, see 
Chapter 4, “Controlling Access,” on page 43.


15.7 Troubleshooting Your Mobile Device
If you encounter difficulties when accessing Novell Vibe from your mobile device, see 
“Troubleshooting Your Mobile Device” in the Novell Vibe 3.2 User Guide.
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16 16Using Novell Vibe with Novell 
GroupWise


You can configure your Novell GroupWise client to work with Novell Vibe in various ways.


 Section 16.1, “Displaying Live Vibe Feeds in GroupWise,” on page 193


 Section 16.2, “Accessing Vibe from a GroupWise Web Panel,” on page 193


 Section 16.3, “Accessing Vibe through the Novell Vibe Folder,” on page 193


16.1 Displaying Live Vibe Feeds in GroupWise
You can display your Novell Vibe feed in the GroupWise client. This enables you to keep up with the 
latest Vibe additions without leaving GroupWise.


For information on how to do this, see:


  “Creating a New Panel” in “Getting Organized” in the GroupWise 8 Windows Client User Guide


 “Creating a New Panel” in “Getting Organized” in the GroupWise 8 Linux/Mac Client User Guide


16.2 Accessing Vibe from a GroupWise Web Panel
You can set up Novell Vibe to display inside a GroupWise Web panel, so you can access Vibe without 
leaving the GroupWise interface.


For information on how to access Vibe from a GroupWise Web panel, see “Accessing Vibe from a 
GroupWise Web Panel” in the GroupWise 8 Windows Client User Guide.


16.3 Accessing Vibe through the Novell Vibe Folder
For information on how to access Novell Vibe through the Novell Vibe folder, see “Accessing Vibe 
through the Novell Vibe OnPrem Folder or the Novell Teaming Folder” in the GroupWise 8 Windows 
Client User Guide.


NOTE: Before you can access Vibe through GroupWise as discussed in this section, your GroupWise 
administrator must set up the integration, as described in “Enabling GroupWise/Vibe Integration for 
GroupWise Windows Client Users” in “Configuring GroupWise for Use with Novell Vibe OnPrem” 
in the GroupWise 8 Interoperability Guide.
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A AWhat’s New in Vibe 3.x


In Novell Vibe 3x you’ll find new features, a fresh user interface, and significant updates. 


The following list is an overview of the new features in Vibe for advanced users.


 Section A.1, “Versioning Enhancements (v3.2),” on page 195


 Section A.2, “Limiting the File Upload Size (v3.2),” on page 196


 Section A.3, “Entry Type Modifications (v3.2),” on page 196


 Section A.4, “Mobile Applications (v3.2),” on page 196


 Section A.5, “Workflow Enhancements (v3.2, v3.1),” on page 196


 Section A.6, “Landing Page Enhancements (v3.2, v3.1),” on page 197


 Section A.7, “HTML Markup Language (v3.1),” on page 198


 Section A.8, “Workspace and Folder Data Quotas (v3.1),” on page 198


 Section A.9, “Custom Digest Notifications (v3.1),” on page 198


 Section A.10, “Capture E-Mail You Send from the Vibe Site in One Location (v3.1),” on page 198


 Section A.11, “Mobile Enhancements (v3.1),” on page 198


 Section A.12, “Improved Folder and Workspace Branding (v3),” on page 199


 Section A.13, “Entry-Level Access Controls (v3),” on page 199


 Section A.14, “Presence Integrations with Novell Messenger (v3),” on page 199


A.1 Versioning Enhancements (v3.2)
 Section A.1.1, “Configure a Folder to Delete Excess Versions,” on page 195


 Section A.1.2, “Configure a Folder to Delete Versions after a Specified Number of Days,” on 
page 195


A.1.1 Configure a Folder to Delete Excess Versions


Novell Vibe 3.2 enables workspace and folder owners to set a limitation on the number of versions of 
a single file that are allowed to exist. For more information, see Section 3.4.1, “Automatically Deleting 
Minor File Versions That Exceed the Allowed Maximum,” on page 31.


A.1.2 Configure a Folder to Delete Versions after a Specified Number of Days


You can configure all but the top version of each file to be automatically deleted after a specified 
number of days. For more information, see Section 3.4.2, “Automatically Deleting Minor File Versions 
After a Specified Number of Days,” on page 32.
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A.2 Limiting the File Upload Size (v3.2)
Workspace and folder owners can set a limit on the size of files that can be uploaded to the folder or 
workspace. For more information, see Section 3.5, “Limiting the File Upload Size for Folders and 
Workspaces,” on page 33.


A.3 Entry Type Modifications (v3.2)
Novell Vibe 3.2 enables you to change the entry type for a single entry or for ever entry of a certain 
type in a folder. For more information, see Section 3.2.2, “Changing the Entry Type for Entries in a 
Folder,” on page 27.


A.4 Mobile Applications (v3.2)
Novell Vibe 3.2 provides native applications for iPhone and Android devices. These applications 
have a more polished user interface and don’t require you to sign in each time you access Vibe.


For more information, see Section 15.3.1, “Getting Started with iPhone or Android Devices,” on 
page 178.


A.5 Workflow Enhancements (v3.2, v3.1)
 Section A.5.1, “Workflow Enhancements in Vibe 3.2,” on page 196


 Section A.5.2, “Workflow Enhancements in Vibe 3.1,” on page 196


A.5.1 Workflow Enhancements in Vibe 3.2


Novell Vibe 3.2 provides new workflow capabilities. These capabilities include: 


 Automatically modify an element within an entry when the entry enters or exits a workflow 
state, as described in Section 11.2.6, “Adding On-Entry or On-Exit Events,” on page 138 and 
Section 11.2.7, “Setting Up On-Entry and On-Exit Events,” on page 139.


 Restrict users from commenting or replying to entries in a workflow when the Read Access 
access control setting is enabled on the workflow, as described in Section 11.4, “Adding Access 
Controls to a Workflow,” on page 147.


 Show a link to the entry within a workflow notification, as described in Section 11.1.5, “Sending 
E-Mail Notifications,” on page 127.


A.5.2 Workflow Enhancements in Vibe 3.1


Novell Vibe 3.1 provides new workflow capabilities. These capabilities include:


 Controlling which users can manually transition workflows


For more information, see Section 11.4.3, “Setting Access Controls on a Manual Transition,” on 
page 152.


 Transitioning the workflow after users have responded
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For more information, see “Designating Specific Users to Respond to a Workflow Question” on 
page 144.


 Specifying e-mail addresses for workflow notifications


For more information, see Section 11.1.5, “Sending E-Mail Notifications,” on page 127.


A.6 Landing Page Enhancements (v3.2, v3.1)
 Section A.6.1, “Landing Page Enhancements in Vibe 3.2,” on page 197


 Section A.6.2, “Landing Page Enhancements in Vibe 3.1,” on page 197


A.6.1 Landing Page Enhancements in Vibe 3.2


 “Adding a Background Image or Color to a Landing Page” on page 197


 “Hiding the Action Toolbar on a Landing Page” on page 197


 “Configuring Column Widths by Pixel in a Table” on page 197


Adding a Background Image or Color to a Landing Page


Novell Vibe 3.2 enables you to add a background image or background color to your landing page. 
For more information, see Section 6.2.2, “Adding a Background Image or Color to Your Landing 
Page,” on page 58.


Hiding the Action Toolbar on a Landing Page


Novell Vibe 3.2 enables you to hide the Action toolbar on the landing page. For more information, see 
Section 6.2.1, “Choosing Layout Options for Your Landing Page,” on page 57.


Configuring Column Widths by Pixel in a Table


Novell Vibe 3.2 enables you to configure column widths by pixels as well as by percent for tables in 
your landing page. For more information, see Section 6.2.3, “Adding Content to Your Landing Page,” 
on page 59.


A.6.2 Landing Page Enhancements in Vibe 3.1


 “Changing the Order of Content on a Landing Page” on page 197


 “Adding HTML Content to a Landing Page” on page 198


 “Adding Extensions to a Landing Page” on page 198


Changing the Order of Content on a Landing Page


Novell Vibe 3.1 enables you to reorder content on your landing page. For more information, see 
Section 6.5, “Changing the Order of Landing Page Elements,” on page 75.
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Adding HTML Content to a Landing Page


Novell Vibe 3.1 enables you to add an HTML editor to your landing page. For more information, see 
Section 6.2.3, “Adding Content to Your Landing Page,” on page 59.


Adding Extensions to a Landing Page


Novell Vibe 3.1 enables you to add extensions to your landing page. For more information, see 
Section 6.2.3, “Adding Content to Your Landing Page,” on page 59.


A.7 HTML Markup Language (v3.1)
Novell Vibe 3.1 enables you to add HTML markup into any HTML editor, such as in the Description 
section of entries, folders, and workspaces. For more information, see Appendix B, “Using HTML 
Markup in Vibe,” on page 201.


A.8 Workspace and Folder Data Quotas (v3.1)
If your Vibe administrator has enabled this functionality, you can set data quotas on workspaces and 
folders that you are manage. For more information, see Section 13.3, “Setting a Data Quota for 
Workspaces and Folders,” on page 170.


A.9 Custom Digest Notifications (v3.1)
Novell Vibe 3.1 enables you to set custom digest notifications on your folders, rather than accepting 
the default digest notification that is set up by your Vibe administrator.


For more information, see Section 3.7, “Configuring Folders to Send E-Mail Notifications to Other 
Users,” on page 34.


A.10 Capture E-Mail You Send from the Vibe Site in One Location 
(v3.1)
Like a personal e-mail Outbox for the Vibe site, you can configure a folder or any e-mail address to 
receive all e-mail messages that you personally send from the Vibe site. 


For more information, see Section 3.6, “Setting Up a Folder or External E-Mail Address to Receive All 
Sent E-Mail Messages,” on page 33.


A.11 Mobile Enhancements (v3.1)
Novell Vibe 3.1 enables you to delete folder entries from the mobile interface. For more information, 
see Section 15.4.14, “Deleting a Folder Entry,” on page 189.


You can also add users, groups, and teams to calendar and task entries that you create from the 
mobile interface.
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A.12 Improved Folder and Workspace Branding (v3)
Adding a personal brand to your workspace or folder is easier than ever before with Novell Vibe 3. 
For information about how you can quickly create a personal brand, see Chapter 5, “Branding a 
Folder or Workspace,” on page 53.


A.13 Entry-Level Access Controls (v3)
You can now set access controls on individual entries that differ from those set on the parent folder. 
For more information, see Section 4.2.2, “Controlling Access to Entries,” on page 50.


A.14 Presence Integrations with Novell Messenger (v3)
Novell Vibe 3 provides tight integrations with Novell Messenger, which allows you to see in Vibe 
who is currently online. Presence icons  are located next to users’ names in folder entries. Click a 
user’s Presence icon to see information about that user, view the user’s micro-blog or workspace, 
follow the user, and more. 
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B BUsing HTML Markup in Vibe


Vibe enables you to add HTML markup into the following locations of the Vibe interface:


 Any HTML editor, such as in the Description section of entries, folders, and workspaces.


For more information, see “Modifying the Description Section of an Entry”, “Modifying a 
Folder”, and “Modifying a Workspace” in the Novell Vibe 3.2 User Guide.


 The Subject Line and Notification Body of workflow notification messages.


For more information, see Step 7 in Section 11.1.5, “Sending E-Mail Notifications,” on page 127.


You can add the following HTML markup items:


Markup Text Function


{{vibe:title}} Displays the title of the entry, folder, or workspace.


{{vibe:user}} Displays the name of the user who is viewing the entry, folder, or workspace.


{{vibe:user|name}} Displays the user ID of the user who is currently viewing the entry, folder, or 
workspace.


{{vibe:createdBy}} Displays the name of the user who created the entry, folder, or workspace.


{{vibe:createdBy|name}} Displays the user ID of the user who created the entry, folder, or workspace.


{{vibe:createdOn}} Displays the date the entry, folder, or workspace was created.


{{vibe:modifiedBy}} Displays the name of the user who last modified the entry, folder, or 
workspace.


{{vibe:modifiedBy|name}} Displays the user ID of the user who last modified the entry, folder, or 
workspace.


{{vibe:modifiedOn}} Displays the date the entry, folder, or workspace was last modified.


{{vibe:data|dataName}} Displays the value of the specified data item. Data items are elements that 
have been added to the form or view definition by using the Form and View 
Designer. Replace dataName with the data name of the element that you want 
to show.


For a list of elements, see Section 9.4, “Understanding Elements,” on 
page 113.


For more information about how to use the Form and View Designer to create 
custom forms and views, see Chapter 7, “Creating Custom Workspace Views,” 
on page 85, Chapter 8, “Creating Custom Folder Views,” on page 95, and 
Chapter 9, “Designing Custom Folder Entry Forms,” on page 105.

Using HTML Markup in Vibe 201







{{vibe:permalink | link}} Displays a permalink to the current entry, folder, or workspace. Replace link 
with the permalink of the entry, folder, or workspace.


This markup option is most useful when it is used in the Subject line of a 
workflow notification e-mail. For example, the Subject line might read, A 
workflow changed occurred in entry. The user can then click entry in 
the Subject line of the notification to be taken directly to the entry.


To get the permalink URL of a Vibe page, simply navigate to the page that you 
want to link to, click Permalink in the footer toolbar, then copy the permalink 
URL from the Permalink field.


{{vibe:image | imageName | 
alt=... | height=... | width=... | 
border=0 or 1}}


Displays the image that you specify. Replace imageName with the filename of 
the image that you want to display. Images must be attached to the entry, 
folder, or workspace.


For information on how to attach entries, see “Attaching Files to a Folder 
Entry”, “Modifying a Folder”, and “Modifying a Workspace” in the Novell Vibe 
3.2 User Guide.


If you want to specify a custom size, you can add the alt, height, and width 
arguments. These arguments are not required.


{{vibe:file | filename | title}} Displays a link to a file. File must be attached to the entry, folder, or workspace.


For information on how to attach entries, see “Attaching Files to a Folder 
Entry”, “Modifying a Folder”, and “Modifying a Workspace” in the Novell Vibe 
3.2 User Guide.


For example, {{vibe:file | tree.jpg | tree}} outputs the word tree as a link to the 
tree.jpg file.


[[entry title]] Creates a link to the entry that you specify. You must specify the exact name of 
the entry.


For more information about creating links in Vibe, see “Linking to a Folder or 
Folder Entry” in the Novell Vibe 3.2 User Guide.


Markup Text Function
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Novell®

Novell Vibe Desktop Readme (Public 
Preview)
February 2012

This Vibe Desktop public preview release should be installed in a testing environment.


1 Product Overview
Vibe Desktop enables you to synchronize your Novell Vibe files with the file system on your 
computer, then modify the files without accessing the Vibe site directly. Additions and modifications 
are synchronized between Vibe and your computer.


2 Vibe Desktop System Requirements
Vibe Desktop is supported with the following versions of the Windows operating system:


 Windows XP SP3 32-bit or later


 Windows Vista SP2 32-bit or 64-bit or later


 Windows 7 SP1 32-bit or 64-bit or later


The Vibe system that you connect to must be Novell Vibe 3.2 or later.


3 Vibe Desktop Issues
 Section 3.1, “Vibe Desktop Cannot Connect to a Double-Byte Windows 2008 System,” on page 1


 Section 3.2, “Home Folder Cannot Be on a Network Drive,” on page 1


3.1 Vibe Desktop Cannot Connect to a Double-Byte Windows 2008 
System
Vibe Desktop cannot connect to the Vibe server if Vibe is running on a double-byte Windows 2008 
operating system (Chinese or Japanese).


To fix this problem, upgrade your Vibe site to Vibe 3.2 HP 2 or later.


3.2 Home Folder Cannot Be on a Network Drive
If a user’s home folder is set up to be on a network drive, that user cannot use Vibe Desktop from 
multiple workstations.


For example if John Smith’s home folder (jsmith) is located on a network drive, he cannot access Vibe 
files through Vibe Desktop from both is office computer and his home computer.
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4 Vibe Desktop Documentation
For information on how to install, configure, and use Vibe Desktop on your computer, see the Vibe 
Desktop Quick Start (http://www.novell.com/documentation/vibe32/vibe32_qs_desktop/data/
vibe32_qs_desktop.html).


For information on how to enable or disable Vibe Desktop, as well as perform other administrative 
functions, see “Configuring Vibe Desktop and the Microsoft Office Add-In” in the  Novell Vibe 3.2 
Administration Guide.


5 Open Source Code
Novell, hereby, offers to give any third party a complete machine-readable copy of the source code of  
which is delivered as part of , under the terms of Sections 1 and 2 of version 2 of the GNU General 
Public License as published by the Free Software Foundation, on a medium customarily used for 
software interchange. Please contact Novell Developer Services or visit  if you require a copy of the 
same.


6 Legal Notices
Novell, Inc. makes no representations or warranties with respect to the contents or use of this 
documentation, and specifically disclaims any express or implied warranties of merchantability or 
fitness for any particular purpose. Further, Novell, Inc. reserves the right to revise this publication 
and to make changes to its content, at any time, without obligation to notify any person or entity of 
such revisions or changes.


Further, Novell, Inc. makes no representations or warranties with respect to any software, and 
specifically disclaims any express or implied warranties of merchantability or fitness for any 
particular purpose. Further, Novell, Inc. reserves the right to make changes to any and all parts of 
Novell software, at any time, without any obligation to notify any person or entity of such changes.


Any products or technical information provided under this Agreement may be subject to U.S. export 
controls and the trade laws of other countries. You agree to comply with all export control 
regulations and to obtain any required licenses or classification to export, re-export, or import 
deliverables. You agree not to export or re-export to entities on the current U.S. export exclusion lists 
or to any embargoed or terrorist countries as specified in the U.S. export laws. You agree to not use 
deliverables for prohibited nuclear, missile, or chemical biological weaponry end uses. Please refer to 
the Novell International Trade Services Web page (http://www.novell.com/info/exports/) for more 
information on exporting Novell software. Novell assumes no responsibility for your failure to obtain 
any necessary export approvals.


Copyright © 2011-2012 Novell, Inc. All rights reserved. No part of this publication may be 
reproduced, photocopied, stored on a retrieval system, or transmitted without the express written 
consent of the publisher.


For Novell trademarks, see the Novell Trademark and Service Mark list (http://www.novell.com/
company/legal/trademarks/tmlist.html).


All third-party trademarks are the property of their respective owners.
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Novell®

Novell Vibe Add-In Readme (Public 
Preview)
February 2012

This Vibe Add-in public preview release should be installed in a testing environment.


1 Product Overview
The Novell Vibe Add-in for Microsoft Office enables you to work with documents on the Vibe site 
without ever leaving Microsoft Office. You can easily browse to a document that is located on the 
Vibe site, open the document, edit it, then save it back to the Vibe site, directly from Microsoft Office.


You can work directly from Microsoft Word, Excel, or PowerPoint documents.


2 Vibe Add-in System Requirements
 Section 2.1, “Office Requirements,” on page 1


 Section 2.2, “Operating System Requirements,” on page 1


 Section 2.3, “Vibe Requirements,” on page 1


2.1 Office Requirements


The Novell Vibe Add-in is supported with the following versions of Microsoft Office:


 Microsoft Office 2010, with the latest support pack


 Microsoft Office 2007, with the latest support pack


2.2 Operating System Requirements


The Novell Vibe Add-in is supported with the following versions of the Windows operating system:


 Windows XP SP3 32-bit or later


 Windows Vista SP2 32-bit or 64-bit or later


 Windows 7 SP1 32-bit or 64-bit or later


2.3 Vibe Requirements


The Vibe system that you connect to must be Novell Vibe 3.2 or later.


3 Vibe Add-In Issues
 Section 3.1, “Installer Does Not Automatically Restart after .NET Framework is Installed,” on 


page 2


 Section 3.2, “Ctrl+S Does Not Save the Document to Vibe in Microsoft Excel,” on page 2
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 Section 3.3, “Embedded Images in Entry Descriptions Are Not Displayed,” on page 2


 Section 3.4, “Performing Actions on Previous Versions Occasionally Fails,” on page 2


3.1 Installer Does Not Automatically Restart after .NET Framework is 
Installed


If the .NET Framework is not already installed on your workstation, the Vibe Add-in installation 
program installs it for you. Installation of the .NET Framework requires that your workstation is 
rebooted. After your workstation reboots, you need to manually restart the Vibe Add-in installation 
program:


1 Navigate to the location where the VibeAddinSetup.exe file was downloaded.


2 Run the VibeAddinSetup.exe file.


3.2 Ctrl+S Does Not Save the Document to Vibe in Microsoft Excel


Pressing Ctrl+S to save a document to the Vibe site from a Microsoft Excel document does not save 
the document to Vibe. Instead, the document is saved to your local directory.


To save a document to the Vibe site from Microsoft Excel, click the Vibe tab, then click Save.


3.3 Embedded Images in Entry Descriptions Are Not Displayed


Images that are embedded in the Description section of an entry are displayed as broken when 
viewing the entry from Microsoft Office with the Vibe Add-in. However, you are still able to edit the 
text of the entry description from Microsoft Office with the Vibe Add-in.


3.4 Performing Actions on Previous Versions Occasionally Fails


When you perform actions on previous versions of a Vibe document in Microsoft Office (such as 
opening a previous version or viewing and editing a note of a previous version), the action 
occassionaly fails.


For more information about performing actions on previous versions of a Vibe document in 
Microsoft Office, see “Working with Previous Versions of a Document” in the Novell Vibe Add-in 
Quick Start (http://www.novell.com/documentation/vibe32/vibe32_qs_office/data/
vibe32_qs_office.html).


4 Vibe Add-In Documentation
For information about how to install, configure, and use the Novell Vibe Add-in, see the Novell Vibe 
Add-in Quick Start (http://www.novell.com/documentation/vibe32/vibe32_qs_office/data/
vibe32_qs_office.html).


For information on how to enable users to edit Vibe documents with the Novell Vibe Add-in, see 
“Configuring Vibe Desktop and the Microsoft Office Add-In” in the  Novell Vibe 3.2 Administration 
Guide.

2 Novell Vibe Add-In Readme (Public Preview)
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5 Open Source Code
Novell, hereby, offers to give any third party a complete machine-readable copy of the source code of 
which is delivered as part of , under the terms of Sections 1 and 2 of version 2 of the GNU General 
Public License as published by the Free Software Foundation, on a medium customarily used for 
software interchange. Please contact Novell Developer Services or visit  if you require a copy of the 
same.


6 Legal Notices
Novell, Inc. makes no representations or warranties with respect to the contents or use of this 
documentation, and specifically disclaims any express or implied warranties of merchantability or 
fitness for any particular purpose. Further, Novell, Inc. reserves the right to revise this publication 
and to make changes to its content, at any time, without obligation to notify any person or entity of 
such revisions or changes.


Further, Novell, Inc. makes no representations or warranties with respect to any software, and 
specifically disclaims any express or implied warranties of merchantability or fitness for any 
particular purpose. Further, Novell, Inc. reserves the right to make changes to any and all parts of 
Novell software, at any time, without any obligation to notify any person or entity of such changes.


Any products or technical information provided under this Agreement may be subject to U.S. export 
controls and the trade laws of other countries. You agree to comply with all export control 
regulations and to obtain any required licenses or classification to export, re-export, or import 
deliverables. You agree not to export or re-export to entities on the current U.S. export exclusion lists 
or to any embargoed or terrorist countries as specified in the U.S. export laws. You agree to not use 
deliverables for prohibited nuclear, missile, or chemical biological weaponry end uses. Please refer to 
the Novell International Trade Services Web page (http://www.novell.com/info/exports/) for more 
information on exporting Novell software. Novell assumes no responsibility for your failure to obtain 
any necessary export approvals.


Copyright © 2011-2012 Novell, Inc. All rights reserved. No part of this publication may be 
reproduced, photocopied, stored on a retrieval system, or transmitted without the express written 
consent of the publisher.


For Novell trademarks, see the Novell Trademark and Service Mark list (http://www.novell.com/
company/legal/trademarks/tmlist.html).


All third-party trademarks are the property of their respective owners.
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About This Guide


The Novell Vibe 3.2 Administration Guide provides administration information for Novell Vibe 3.2.


 Part I, “Site Setup,” on page 13
 Part II, “Site Maintenance,” on page 147
 Part III, “Interoperability,” on page 233
 Part IV, “Site Security,” on page 251


Audience


This guide is intended for Novell Vibe administrators.


Feedback


We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comments feature at the bottom of each page of the 
online documentation.


Documentation Updates


For the most recent version of the Novell Vibe 3.2 Administration Guide and other documentation, visit 
the Novell Vibe 3.2 Documentation Web site (http://www.novell.com/documentation/vibe32).


Additional Documentation


You can find more information in the Novell Vibe documentation, which is accessible from the 
Novell Vibe 3.2 Documentation Web site (http://www.novell.com/documentation/vibe32).


To access the Novell Vibe 3.2 User Guide from within Vibe, click the Help icon (question mark).
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I ISite Setup


 Chapter 1, “Logging In as the Vibe Site Administrator,” on page 15
 Chapter 2, “Planning and Controlling User Access to Workspaces and Folders,” on page 19
 Chapter 3, “Setting Up Initial Workspaces,” on page 39
 Chapter 4, “Setting Up Site-Wide Customizations,” on page 61
 Chapter 5, “Setting Up User Access to the Vibe Site,” on page 89
 Chapter 6, “Allowing Access to the Vibe Site through Novell Access Manager,” on page 99
 Chapter 7, “Configuring Vibe to Support WebDAV on Windows 7,” on page 105
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 Chapter 11, “Enabling Custom JSPs to Be Used on Your Vibe Site,” on page 117
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 Chapter 14, “Using Remote Applications on Your Vibe Site,” on page 127
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 Chapter 16, “Setting Up Zones (Virtual Vibe Sites),” on page 139
 Chapter 17, “Managing a Multiple-Language Vibe Site,” on page 143
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1 1Logging In as the Vibe Site 
Administrator


After logging in to the Novell Vibe site, you should reset the Vibe administrator’s password. Also, 
you might want to create additional Vibe administrators.


 Section 1.1, “Resetting the Vibe Administrator Password,” on page 15
 Section 1.2, “Creating Additional Vibe Administrators,” on page 16


1.1 Resetting the Vibe Administrator Password
When you first install Novell Vibe, the Vibe administrator username is admin and the password is 
admin. When you first log in to the Vibe site as the administrator, you should change the 
administrator password from the default password to a secure password of your own choosing. If 
you followed the instructions in “Accessing Your Basic Vibe Site as the Site Administrator” in “Basic 
Installation” in the Novell Vibe 3.2 Installation Guide, you have already completed this very important 
task.


If you have not already reset the Vibe administrator password:


1 In your Web browser, specify one of the following URLs, depending on whether or not you are 
using a secure SSL connection:


http://vibe_hostname
https://vibe_hostname


Replace vibe_hostname with the hostname or fully qualified domain name of the Vibe server 
that you have set up in DNS. If you configured the HTTP ports correctly during installation, you 
do not need to include the port number in the Vibe URL.


2 Log in using admin as the login name and admin as the password.
3 Click My Workspace in the Action toolbar.


The Vibe administrator’s personal workspace displays.
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4 Change the default administrator password to a secure password:
4a Click Profile, then click Edit in the upper right corner of the Profile page.
4b Specify your own password for the Vibe administrator in the New Password and Confirm 


New Password fields.
4c (Optional) Provide useful information in the additional fields of the Vibe administrator’s 


profile.
4d Click OK to return to the administrator’s profile.


1.2 Creating Additional Vibe Administrators
You might want to create additional Vibe administrators just in case the primary Vibe administrator 
is unable to access his or her account. Creating additional Vibe administrators is a safe way to ensure 
that the right people are able to access the Vibe site in an administrative capacity if the need arises.


To minimize the time-consuming indexing of the Vibe site, it is most effective to create a group that 
has administrative rights, then assign users to that group as needed.


NOTE: Because Vibe users can change the access control settings on individual workspaces where 
they have sufficient rights, additional Vibe administrators who are granted administrative access to 
the Vibe site in this way might not always have access to everything in the Vibe site. Only the original 
Vibe administrator always has rights to everything in the Vibe site.


 Section 1.2.1, “Creating an Administration Group,” on page 16
 Section 1.2.2, “Assigning Administrative Rights to the Administration Group,” on page 17


1.2.1 Creating an Administration Group


To create a new group for administrators in your Vibe site, follow the steps in Section 5.2, “Creating 
Groups of Users,” on page 89, then continue with Section 1.2.2, “Assigning Administrative Rights to 
the Administration Group,” on page 17.

16  Novell Vibe 3.2 Administration Guide







1.2.2 Assigning Administrative Rights to the Administration Group


After you create a group for your Vibe administrators, as described in Section 5.2, “Creating Groups 
of Users,” on page 89, you need to assign administrative rights to the group.


1 Log in to the Vibe site as the Vibe administrator.
2 Grant administration rights to the administration group for the Vibe site:


2a Click the Settings icon  in the upper right corner of the page, then click the 


Administration Console icon .
The Administration page is displayed.


2b Under System, click Access Control for Zone Administration.


2c Click Add a Group, then in the Add a Group field, specify the name of the group that you 
created for users with administrative rights. Click the name when it appears in the drop-
down list.


2d In the access control table, select the check box in the Zone Administration column for the 
group that you added in Step 2c.


2e Click Save Changes, then click Close.
3 Grant administration rights to the administration group at the top-level workspace.


3a Navigate to the highest level workspace.
By default, this is the Home Workspace workspace.


3b Click Workspace > Access Control in the Action toolbar.
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3c Click Add a Group, then in the Add a Group field, specify the name of the group that you 
created for users with administrative rights. Click the name when it appears in the drop-
down list.


3d In the access control table, select the check box in the Workspace and Folder Administrator 
column for the group that you added in Step 3c.


3e Click Save Changes, then click Close.
4 (Conditional) If the Global Workspaces, Personal Workspaces, and Team Workspaces directories 


beneath the Home Workspace directory are not inheriting their access controls from the Home 
Workspace directory, you need to change the access control settings for each one of these 
directories, just like you did for the Home Workspace directory, as described in Step 3.
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2 2Planning and Controlling User Access to 
Workspaces and Folders


As the administrator for the Novell Vibe site, you are responsible for setting up and controlling user 
access across the entire site. Even though workspace and folder owners are responsible for 
controlling user access in their individual workspaces and folders, you as the Vibe administrator 
have the ability to create new roles, modify existing roles, and change default access control settings 
for all types of workspaces and for all types of functions across the Vibe site.


 Section 2.1, “Understanding Access Control,” on page 19
 Section 2.2, “Controlling User Access in Workspaces,” on page 20
 Section 2.3, “Controlling User Access throughout the Vibe Site,” on page 24
 Section 2.4, “Managing Roles to Refine Access Control,” on page 27
 Section 2.5, “Restricting Access Rights of Users Outside the Firewall,” on page 32
 Section 2.6, “Enabling Users to Send Messages to All Users,” on page 35
 Section 2.7, “Enabling Users to Import and Export Workspaces, Folders, and Entries,” on 


page 36
 Section 2.8, “Enabling Users to Access Entries via the Workspace Tree When They Do Not Have 


Access to the Parent Folder or Workspace,” on page 36
 Section 2.9, “Enabling Folder Administrators to Apply Definition Settings to Sub-Folders and 


Entries,” on page 37


2.1 Understanding Access Control
Before you begin configuring access control settings for your Novell Vibe site, it is important that you 
understand how access control works in Vibe.


For background information about Vibe access control, see “Controlling Access” in the Novell Vibe 3.2 
Advanced User Guide.


In simplest terms, access control settings determine what users can see and do in each workspace or 
folder. However, because your Novell Vibe site is a hierarchy of workspaces and folders and because 
access control settings can be inherited (or not), access control settings affect a variety of Vibe 
features:


 Section 2.1.1, “Inheritance,” on page 20
 Section 2.1.2, “Navigation,” on page 20
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2.1.1 Inheritance


When you create a new workspace, it defaults to the inheritance setting of its parent workspace.


 If you create a new workspace under an existing workspace that is inheriting its access control 
settings from its parent, the new workspace continues the inheritance chain. If you change any 
access control settings above the new workspace at a later time, the access control settings for the 
new workspace also change. Global workspaces inherit access control settings from the parent 
workspace by default.


 If you create a new workspace under an existing workspace that has locally defined access 
control settings, the new workspace retains the locally defined settings.


 If you move a workspace that is inheriting its access control settings from its original parent 
workspace, it inherits the access control settings of the new parent workspace into which it is 
moved. If the new parent workspace has different settings than the original parent workspace, 
the access control settings for the moved workspace change accordingly.


2.1.2 Navigation


Sub-workspaces and sub-folders should not permit access to users or groups that do not have access 
to the higher-level workspaces, for the following reasons:


 Users cannot see the workspace, even though they have appropriate rights.


Users browsing in the Workspace tree (or in a Workspace Tree accessory) for the sub-workspace 
or sub-folder that they have been granted access to are not able to see the workspace, because 
Vibe does not permit them to see a parent workspace that they do not have access to. Users can 
still access the workspace using the Find or Search feature.


 Users can see the name of a higher-level workspace, even though they do not have appropriate 
rights.
Users who use the Find or Search feature to locate the sub-workspace or sub-folder that they 
have been granted access to, then view the sub-workspace or sub-folder, are then able to see the 
name of the parent workspace, which they would otherwise not be able to see. However, they 
can see only the workspace name, not the contents of the workspace.


2.2 Controlling User Access in Workspaces
The access control settings on each Novell Vibe workspace determine who can see the workspace and 
how different types of users can participate in each workspace. 


 Section 2.2.1, “Controlling User Access to Personal Workspaces,” on page 20
 Section 2.2.2, “Controlling User Access to Team Workspaces,” on page 22
 Section 2.2.3, “Controlling User Access to Global Workspaces,” on page 23


2.2.1 Controlling User Access to Personal Workspaces


 “Default Access Controls” on page 21
 “Restricting Access to Personal Workspaces throughout the Vibe Site” on page 21
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Default Access Controls


By default, personal workspaces are created with the following access:


Restricting Access to Personal Workspaces throughout the Vibe Site


You might want to set up your Vibe site so users’ personal workspaces remain hidden and 
confidential. 


IMPORTANT: If you configure your Vibe site to hide users’ personal workspaces as described in this 
section, the following side effects occur:


 Users cannot follow one another
 Users are not displayed in the Personal Workspaces workspace
 Users are not displayed under Personal Workspaces in the Workspace tree


When you configure your Vibe site as described in this section, you should make these configuration 
changes before any users are added to your Vibe system. If users are added to your Vibe system 
before you make these configuration changes, you must manually adjust the access control settings 
for each user workspace, as described in “Controlling Access” in the Novell Vibe 3.2 Advanced User 
Guide.


1 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
2 Under Management, click Workspace and Folder Templates.


3 Click User Workspace.
4 Click Manage This Target > Access Control.


The Configure Access Control page is displayed.
5 In the access control table, in the All Users row, deselect the check box in the Visitor column.


User or Group Access Role Role Description


Workspace Owner 
(user)


Administrator Can create, modify, or delete workspaces or folders; moderate 
participation (modify or delete the entries of others); design entries and 
workflows; and can perform Participant tasks.


All Users group Participant Can create and modify entries, plus perform the Visitor tasks.


Visitor Has read-only and comment-only access.
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6 Click Save Changes.
7 Verify access before you start adding users to your Vibe system:


 Create a test user in the Vibe system, navigate to this user’s personal workspace, then click 
Workspace > Access Controls. Ensure that no check boxes are selected in the All users row.


 Navigate to the Personal Workspaces workspace by clicking the Workspace tree icon  in 
the Action toolbar, then clicking Personal Workspaces. Click Workspace > Access Controls, then 
ensure that in the All users row the check box is selected in the Visitor column. If this check 
box is not selected, users cannot search for other users in the Vibe system.


For information on how to add users to your Vibe system, see Section 5.1, “Adding New Users to 
Your Vibe Site,” on page 89.


Vibe users can adjust the access control for their personal workspaces, as described in  “Controlling 
Access” in the Novell Vibe 3.2 Advanced User Guide.


2.2.2 Controlling User Access to Team Workspaces


By default, new team workspaces created under the main Team Workspaces directory are visible only 
to members of the team workspace. Following are some of the default access control options:


After you create a new team workspace, you can configure different access control settings for it.


1 Navigate to the new team workspace, then click Workspace > Access Control.
2 Select No in the Inheritance box.


3 Click Apply to activate the Access Control table:


User or Group Access Role Role Description


Workspace Owner 
(team creator)


Administrator Can create, modify, or delete workspaces or folders; moderate 
participation (modify or delete the entries of others); design entries and 
workflows; and can perform Participant tasks.


All Users group Participant Can create and modify entries, plus perform the Visitor tasks.


Visitor Has read-only and comment-only access.
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4 Adjust the access control settings for the new team workspace as needed, as described in  
“Controlling Access” in the Novell Vibe 3.2 Advanced User Guide.


5 Click Save Changes > Close.


2.2.3 Controlling User Access to Global Workspaces


By default, the Global Workspace directory immediately under the Home Workspace inherits the 
access control settings of the Home Workspace:


When you create a new global workspace under the main Global Workspaces directory, the new 
global workspace by default inherits the access control settings of the main Global Workspaces 
directory, as listed above. After you create a new global workspace, you can configure different 
access control settings for it.


1 Navigate to the new global workspace, then click Workspace > Access Control.
2 Select No in the Inheritance box.


3 Click Apply to activate the Access Control table:


User or Group Access Role Role Description


Workspace Owner 
(admin)


Administrator Can create, modify, or delete workspaces or folders; moderate 
participation (modify or delete the entries of others); design entries and 
workflows; and can perform Participant tasks.


All Users group Participant Can create and modify entries, plus perform the Visitor tasks.


Visitor Has read-only and comment-only access.


All Applications 
group


Visitor Has read-only and comment-only access. For information about 
application groups, see “Managing Remote Applications” in the Novell 
Vibe 3.2 Advanced User Guide.
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4 Adjust the access control settings for the new global workspace as needed, as described in  
“Controlling Access” in the Novell Vibe 3.2 Advanced User Guide.


5 Click Save Changes > Close.


2.3 Controlling User Access throughout the Vibe Site
By assigning users to access control roles for the Novell Vibe site, you can give users additional 
rights, or restrict current rights.


 Section 2.3.1, “Understanding Default Roles,” on page 24
 Section 2.3.2, “Assigning a User to a Role,” on page 26


2.3.1 Understanding Default Roles


By default, you can assign users to various roles in workspaces and folders, as well as in entries.


 “Understanding Default Workspace and Folder Roles” on page 24
 “Understanding Default Entry Roles” on page 25


Understanding Default Workspace and Folder Roles


Role Description


Participant Can create entries and modify those entries, plus perform tasks associated with 
the Visitor role.


Allow Adding Guest 
Access


Can make Vibe workspaces and folders available to Guest users in Vibe.


By default, Guest users can access only the Guest user personal workspace, as 
well as any workspace or folder that the Vibe administrator has granted them rights 
to access. 


For more information, see Section 5.4.4, “Enabling Individual Users to Grant Guest 
Access throughout the Vibe Site,” on page 96.


Can Only See Members 
Of Groups I Am In


Removes a user’s ability to view other Vibe users who are not members of a group 
that he or she belongs to.
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Understanding Default Entry Roles


Guest Participant Can read entries, create entries, and add comments.


Override “Can Only See 
Members Of Groups I Am 
In”


Overrides the Can Only See Members Of Groups I Am In role. This can simplify the 
administration of the Can Only See Members Of Groups I Am In role. 


For example, you might assign the Can Only See Members Of Groups I Am In role 
to a group, but at the same time you want to allow certain members of the group to 
retain their ability to see users that belong to groups outside of their own. In this 
circumstance, you can assign the Override “Can Only See Members Of Groups I 
Am In” role to the members who you want to retain their ability to see users outside 
of their own groups.


Team Member Has all the rights of a Participant. In addition, can generate reports and manage 
community tags.


Token Requester Can make Web service calls on behalf of another Vibe user.


This functionality can enable administrators to perform proxy functions for 
individual Vibe users without logging in as the Vibe user. This means that the Web 
services application does not cache individual users’ credentials in order to 
perform operations.


This role should not be assigned to a Vibe user, but rather to a system-level (agent) 
account that you want to be responsible for executing Web service operations on 
behalf of one or more regular Vibe users.


For more information about the Web services operations that support the Token 
Requester role, see “admin_getApplicationScopedToken” and 
“admin_destroyApplicationScopedToken” in the Novell Vibe 3.2 Developer Guide.


Visitor Has read-only and comment-only access.


Workspace and Folder 
Administrator


Can create, modify, or delete workspaces or folders; moderate participation (modify 
or delete the entries of others); design entries and workflows; set entry-level 
access controls on entries of others; and can perform tasks associated with the 
Participant and Team Member role.


Workspace Creator Can create sub-workspaces. In Team Workspace Root workspaces, this role 
allows users to create their own team workspaces.


Zone Administration Has all rights associated with access control.


Role Description


Read Can read the entry.


Read and Reply Can read the entry and add comments or replies to the entry.


Write Can read the entry, add comments or replies, and modify the entry.


Delete Can read the entry, add comments or replies, modify, and delete the entry.


Change ACL Can read the entry, add comments or replies, modify, and delete the entry. This role 
can also modify the access control settings of the entry.


Role Description
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2.3.2 Assigning a User to a Role


To assign a user to a particular role for every place on the Vibe site:


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
The Administration page is displayed.


3 Under System, click Access Control for Zone Administration.


A basic Vibe site consists of a single zone. Novell Vibe allows you to set up multiple zones in a 
single Vibe site. For more information about creating multiple zones, see Chapter 16, “Setting 
Up Zones (Virtual Vibe Sites),” on page 139. 


4 Add the user to whom you want to grant the site-wide role to the Access Control table.
For information on how to add users to the Access Control table, see “Adding Users to the 
Access Control Table” in the Novell Vibe 3.2 Advanced User Guide.


5 Add the role that you want to grant to the Access Control table.
For information on how to add roles to the Access Control table, see “Adding Roles to the 
Access Control Table” in the Novell Vibe 3.2 Advanced User Guide.


6 Click Save Changes, then click Close.
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2.4 Managing Roles to Refine Access Control
Novell Vibe uses role-based access control. Each default role contains specific rights. If you want a 
particular user to have certain rights, you can assign that user to the appropriate role. For a list of all 
the default access roles that are included in Vibe, see “Default Roles” in the Novell Vibe 3.2 Advanced 
User Guide.


If you find that the existing roles do not meet the needs of your organization, you can modify them or 
create new ones. This can be particularly useful if you want to delegate the administration of sub-
workspaces and sub-folders, and if you do not want to grant all of the privileges that come with the 
Workspace and Folder Administration role.


Vibe also enables you to delete roles that are no longer useful to your organization.


 Section 2.4.1, “Defining a New Role,” on page 27
 Section 2.4.2, “Modifying Existing Roles,” on page 30
 Section 2.4.3, “Deleting Existing Roles,” on page 30
 Section 2.4.4, “Understanding the Various Rights for Roles,” on page 31


2.4.1 Defining a New Role


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
The Administration page is displayed.


3 Under System, click Configure Role Definitions.
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4 Click Add a New Role.
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5 In the Role Name field, specify a name for the new role, then select all of the rights that you want 
members of this role to be able to perform.


6 In the Role Scope drop-down list, select whether you want this new role to be available for 
workspaces or folders, or for entries. 


7 (Optional) In the Role Conditions field, select the role condition that you want to associate with 
this role.
Role conditions enable you to restrict what information users can access when they are outside 
your corporate firewall. For more information, see Section 2.5, “Restricting Access Rights of 
Users Outside the Firewall,” on page 32.


8 Select the rights that you want to be associated with this role.
For information about each right that you can select, see Section 2.4.4, “Understanding the 
Various Rights for Roles,” on page 31.


9 Click Add, then click Close.
The role is added to the list of existing roles. If you added this role to control access to entries, 
the role is automatically made available on the access control page. If you added this role to 
control access to workspaces and folders, Vibe users can now add this role to the Access Control 
table, as described in “Adding Roles to the Access Control Table” in the Novell Vibe 3.2 Advanced 
User Guide.
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2.4.2 Modifying Existing Roles


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
The Administration page is displayed.


3 Under System, click Configure Role Definitions.


4 In the Currently Defined Roles section, click the role that you want to modify.
5 Select the rights that you want members of this role to be able to perform, and deselect the rights 


that you don’t want them to be able to perform.
For information about each right that you can select, see Section 2.4.4, “Understanding the 
Various Rights for Roles,” on page 31.


6 Click Apply, then click Close.


2.4.3 Deleting Existing Roles


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
The Administration page is displayed.


3 Under System, click Configure Role Definitions.
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4 In the Currently Defined Roles section, click the role that you want to delete.
5 Click Delete, then click Close.


2.4.4 Understanding the Various Rights for Roles


Roles are made up of various rights. Default roles have a set of default rights that are associated with 
them. When you modify a default role, you remove existing rights and add other rights. When you 
create a custom role, you create a new name for a role and then associate rights with the new role.


Some rights apply only to workspaces and folders, and some apply only to entries. If you associate a 
right with a role, and then assign users to that role in a workspace, then by default that role applies to 
all folders and entries in the workspace. For example, if you associate the Delete Entries right with a 
role in a workspace and assign that role to all users, then all users can delete any entry in the 
workspace.


Following is the list of rights you can choose from when modifying or creating a role. You cannot 
create new rights in Vibe.


Right Function


Add Comments or Replies Can add comments or replies to entries.


Add Folders Can add folders to workspaces and folders.


Add Workspaces Can add workspaces to existing workspaces.


Change Access Control Can modify the access control settings of workspaces, folders, or entries.


Create Entries Can create entries.
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2.5 Restricting Access Rights of Users Outside the Firewall
Vibe enables you to restrict what information users can access when they are outside your corporate 
firewall.


If your Vibe site contains sensitive data, and users access the site from non-secure locations, you 
might want to consider restricting users to certain workspaces and folders when they are not 
accessing Vibe from inside the corporate firewall.


Create Entry-Level Access 
Controls


Can change access control settings for all entries that are contained in a 
workspace or folder.


Delete Entries Can delete entries.


Delete Owned Entries Users can delete only the entries they own in a workspace or folder.


Design Entries Users can design their own custom entries by using the Form and View 
Designers tool, as described in “Designing Custom Folder Entry Forms” in the 
Novell Vibe 3.2 Advanced User Guide.


Design Workflows Users can design their own custom workflows by using the Form and View 
Designers tool, as described in “Creating and Managing Workflows” in the 
Novell Vibe 3.2 Advanced User Guide.


Generate Reports Users can generate reports. For more information about generating reports  in 
Vibe, see “Generating Activity Reports for a Workspace”, “Generating an 
Activity Report on a Folder”, and “Generating Reports about a Folder Entry” in 
the Novell Vibe 3.2 User Guide.


Manage Global Tags Users can manage community tags, as described in “Using Tags” in the Novell 
Vibe 3.2 User Guide.


Modify Entries Can modify entries.


Modify Entry Fields Users can modify only a specific field in an entry. This is useful if you have an 
entry that is associated with a workflow, and you want only certain users to 
modify certain fields in the entry.


Modify Owned Entries Users can modify only the entries they own in a workspace or folder.


Modify, Move, or Delete 
Folders and Workspaces


Users can modify, move, or delete a folder or workspace.


Owner Create Entry-Level 
Access Controls


Users can change the access control settings only for the entries they own in a 
workspace or folder.


Read Entries Can read entries.


Read Owned Entries Users can read only the entries they own in a workspace or folder.


View Binder Title Enables users who have access to an entry, but do not have access to the 
parent workspace or folder, to navigate to the entry by using the Workspace 
tree, as described in “Navigating the Workspace Tree” in the Novell Vibe 3.2 
User Guide. 


This right is disabled by default, and is not available to assign to any role. For 
information on how to enable this right and make it available, see Section 2.8, 
“Enabling Users to Access Entries via the Workspace Tree When They Do Not 
Have Access to the Parent Folder or Workspace,” on page 36.


Right Function
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For example, a user accessing the Vibe system from a public kiosk increases the risk of sensitive data 
being inappropriately exposed.


To restrict access for users who are outside the corporate firewall, you must create a condition that 
contains one or more IP addresses (or range of IP addresses), associate this condition with an existing 
role, then assign the role to users and groups in the workspaces, folders, or entries where you want to 
allow access.


 Section 2.5.1, “Creating a New Role Condition,” on page 33
 Section 2.5.2, “Associating the Role Condition with a New or Existing Role,” on page 34
 Section 2.5.3, “Assigning the Role Condition to Users and Groups,” on page 34
 Section 2.5.4, “Example,” on page 35


2.5.1 Creating a New Role Condition


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
The Administration page is displayed.


3 Under System, click Configure Role Definitions.
4 Click the Define Role Conditions tab.
5 Click Add a New IP Address Condition.


6 Provide the following information for the new condition:
Title: Specify a title for the condition.
Description: Specify a description for the role condition.
IP Address: Specify the IP address that you want to associate with this condition.
You can mask your IP address by using asterisks. For example, 155.5.*.* 
Allow: Select this option to allow access from the specified IP address. There must be at least 
one IP Address field with Allow selected. 
Deny: Select this option to deny access from the specified IP address. Select this option only if 
you have multiple IP Address fields, and one of these fields has Allow selected.
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If you are masking an IP address, such as 155.5.*.*, you can exclude an IP address within the 
range that you are masking. For example, in the first IP Addresses field you specify 155.5.*.*, 
then select Allow. You then add a second IP Address field by clicking Add Another IP Address, then 
specifying an IP address that is within the range of your masked IP address. In your second IP 
Address field, you specify 155.5.4.*, then select Deny. This denies access to users who are using 
an IP address within the range 155.5.4.*, but allows access to users using any other IP address 
within the range 155.5.*.*. 


7 (Optional) Click Add Another IP Address to associate multiple IP addresses with this condition. 
You can also add multiple IP addresses if you want to deny access to a specific IP address that is 
included within a range of IP addresses that you are allowing.


8 Click Add.
9 Continue with Section 2.5.2, “Associating the Role Condition with a New or Existing Role,” on 


page 34.


2.5.2 Associating the Role Condition with a New or Existing Role


You must associate the role condition that you created in Section 2.5.1, “Creating a New Role 
Condition,” on page 33 with a new or existing role.


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
The Administration page is displayed.


3 Under System, click Configure Role Definitions.
4 On the Configure Role Definitions tab, click Add a New Role.


or
Click an existing role in the Currently Defined Roles section.
For more information about managing roles, see Section 2.4, “Managing Roles to Refine Access 
Control,” on page 27.


5 In the Role Conditions drop-down list, select the role condition that you want to associate to the 
role.


6 Click Apply.
7 Continue with Section 2.5.3, “Assigning the Role Condition to Users and Groups,” on page 34.


2.5.3 Assigning the Role Condition to Users and Groups


After you have completed Section 2.5.1, “Creating a New Role Condition,” on page 33 and 
Section 2.5.2, “Associating the Role Condition with a New or Existing Role,” on page 34, you need to 
assign the role that contains the new role condition to users and groups. You accomplish this in one 
of two ways, depending on whether you associated the role condition to a new role or an existing role 
(as described in Section 2.5.2, “Associating the Role Condition with a New or Existing Role,” on 
page 34):


 “Assigning the New Role to Users and Groups” on page 35
 “Assigning an Existing Role to Users and Groups” on page 35
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Assigning the New Role to Users and Groups


To assign the role that contains the new role condition to users and groups:


1 Add the role to the Access Control table for the workspaces, folders, or entries where you want 
to grant users access rights, as described in “Controlling Access to Workspaces and Folders” in 
the Novell Vibe 3.2 Advanced User Guide.


2 Assign the roles to the users and groups who you want to be granted access rights, as described 
in “Controlling Access to Workspaces and Folders” in the Novell Vibe 3.2 Advanced User Guide.


Assigning an Existing Role to Users and Groups


If you associated the role condition with an existing role, the role is automatically applied to users 
and groups in workspaces, folder, and entries where this role is already assigned.


2.5.4 Example


The following example shows how to restrict access to users outside the firewall by using role 
conditions:


1. Set up a proxy server (such as Novell Access Manager) that is external to the firewall.
2. Define a role condition that includes only a range of IP addresses that are internal to the firewall.
3. Associate this role condition to all or some existing Vibe roles.


If you associate this role condition to all roles except the Workspace and Folder Administrator 
role, only users who are workspace and folder administrators are able to access workspaces and 
folders from outside the firewall. Users who are not workspace and folder administrators do not 
have access.


2.6 Enabling Users to Send Messages to All Users
By default, Novell Vibe allows only the Vibe administrator to send e-mail messages to the All Users 
group. If you want to change this functionality to allow anyone to send messages to the All Users 
group:


1 Change to the following directory:


2 Make a backup copy of the ssf-ext.properties file, which is located in the same directory as 
the ssf.properties file.


3 Open the ssf.properties file in a text editor.
4 Search for the following line:


mail.allowSendToAllUsers=false


5 Open the ssf-ext.properties file in a text editor.
6 Copy the mail.allowSendToAllUsers=false line from the ssf.properties file to the bottom 


of the ssf-ext.properties file.


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/WEB-INF/classes/config


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF\classes\config
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7 Change false to true, so that the line now reads mail.allowSendToAllUsers=true.
8 Save and close the ssf-ext.properties file.
9 Close the ssf.properties file without saving it.


10 Stop and restart Vibe to enable users to send messages to the All Users group in your Vibe site.


2.7 Enabling Users to Import and Export Workspaces, Folders, 
and Entries
By default, only the Vibe administrator can import and export workspaces, folders, and entries, as 
described in Section 19.1, “Exporting/Importing Workspaces, Folders, and Entries,” on page 163. You 
can enable all workspace and folder owners to import and export workspaces, folders, and entries. 


To configure Vibe to allow workspace and folder owners to import and export workspaces, folders, 
and entries:


1 Change to the following directory:


2 Make a backup copy of the ssf-ext.properties file, which is located in the same directory as 
the ssf.properties file.


3 Open the ssf.properties file in a text editor.
4 Search for the following line:


export.availableToBinderOwners=false


5 Open the ssf-ext.properties file in a text editor.
6 Copy the export.availableToBinderOwners=false line from the ssf.properties file to the 


bottom of the ssf-ext.properties file.
7 Change false to true, so that the line now reads export.availableToBinderOwners=true.
8 Save and close the ssf-ext.properties file.
9 Close the ssf.properties file without saving it.


10 Stop and restart Vibe to enable all workspace and folder owners to import and export 
workspaces, folders, and entries.


2.8 Enabling Users to Access Entries via the Workspace Tree 
When They Do Not Have Access to the Parent Folder or 
Workspace
You can enable users who have access to an entry, but do not have access to the parent workspace or 
folder, to navigate to the entry by using the Workspace tree, as described in “Navigating the 
Workspace Tree” in the Novell Vibe 3.2 User Guide. 


Users who do not have this right must either perform a search to locate the entry, or they must have 
the entry shared with them as described in “Sharing Entries” in the Novell Vibe 3.2 User Guide.


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/WEB-INF/classes/config


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF\classes\config
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For information about how users can grant other Vibe users access to an entry even when users don’t 
have access to the parent workspace or folder, see “Exposing a Vibe Entry to a Wider Audience Than 
the Folder Access Controls Allow” in the Novell Vibe 3.2 Advanced User Guide.


To enable users to access entries via the Workspace tree when users do not have access rights to the 
parent folder or workspace:


1 Change to the following directory:


2 Make a backup copy of the ssf-ext.properties file, which is located in the same directory as 
the ssf.properties file.


3 Open the ssf.properties file in a text editor.
4 Search for the following line:


accessControl.viewBinderTitle.enabled=false


5 Open the ssf-ext.properties file in a text editor.
6 Copy the accessControl.viewBinderTitle.enabled=false line from the ssf.properties 


file to the bottom of the ssf-ext.properties file.
7 Change false to true.
8 Save and close the ssf-ext.properties file.
9 Close the ssf.properties file without saving it.


10 Stop and restart Vibe.


2.9 Enabling Folder Administrators to Apply Definition Settings 
to Sub-Folders and Entries
You can enable folder owners to apply entry definition types to folders or entries that have already 
been created. This enables users to apply all definition settings of a parent folder to all subfolders. 
Also, this enables users to change the definition settings to make all folder entries the same. For 
example, a user might begin a discussion entry in a Discussion folder, then move the entry to the 
Tasks folder after it is decided that something needs to be done in order to resolve the discussion. 
After the discussion entry is added to the Tasks folder, the entry can be converted to a task entry. For 
more information, see “Changing the View Definitions for Existing Folders and Folder Entries” in the 
Novell Vibe 3.2 Advanced User Guide.


1 Change to the following directory:


2 Make a backup copy of the ssf-ext.properties file, which is located in the same directory as 
the ssf.properties file.


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/WEB-INF/classes/config


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF\classes\config


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/WEB-INF/classes/config


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF\classes\config

Planning and Controlling User Access to Workspaces and Folders 37







3 Open the ssf.properties file in a text editor.
4 Search for the following line: 


ssf.allowFolderDefinitionFixups=false


5 Open the ssf-ext.properties file in a text editor.
6 Copy the appropriate line from the ssf.properties file to the bottom of the ssf-


ext.properties file.
7 Change false to true, so that the line now reads ssf.allowFolderDefinitionFixups=true.
8 Save and close the ssf-ext.properties file.
9 Close the ssf.properties file without saving it.


10 Stop and restart Vibe.
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3 3Setting Up Initial Workspaces


Proper organization of workspaces is critical to building an effective Novell Vibe site. 


 Section 3.1, “Understanding Workspaces,” on page 39
 Section 3.2, “Setting Up Users’ Personal Workspaces,” on page 40
 Section 3.3, “Organizing Team Workspaces,” on page 51
 Section 3.4, “Creating Global Workspaces,” on page 52
 Section 3.5, “Using Workspace and Folder Templates,” on page 53
 Section 3.6, “Importing Workspaces,” on page 59


See also Chapter 19, “Managing Workspaces,” on page 163.


3.1 Understanding Workspaces
Your Novell Vibe site consists of seven types of workspaces:


 Personal workspaces: When you add users to your Vibe site, as described in “Adding Users to 
Your Vibe Site” in “Basic Installation” in the Novell Vibe 3.2 Installation Guide, a personal 
workspace is established for each user. Users can customize their personal workspaces, as 
described in “Setting Up Your Personal Workspace” in “Getting Started” in the Novell Vibe 3.2 
User Guide.


 Team workspaces: Vibe users, along with you as the Vibe administrator, can create team 
workspaces for groups of people who work together regularly, as described in “Setting Up Your 
Personal Workspace” in “Getting Started” in the Novell Vibe 3.2 User Guide. You, as the Vibe 
administrator, need to decide how you want to organize team workspaces before you let users 
start creating them.


 Team Workspace Root workspaces: Team Workspace Root workspaces are the optimal type of 
workspace if you want to create a library of team workspaces as sub-workspaces.
For more information on Team Workspace Root workspaces, see “Creating and Managing a 
Team Workspace Root Workspace” in the Novell Vibe 3.2 Advanced User Guide.


 Project Management Workspaces: Project Management workspaces include special accessories 
that help leaders track the progress of task completion for potentially large projects. Project 
Management workspaces focus on project completion.
For more information on Project Management workspaces, see “Creating and Managing a 
Project Management Workspace” in the Novell Vibe 3.2 Advanced User Guide.


 Discussions workspaces: The Discussions workspace can be the home page for a set of 
discussion forums. You can also use the Discussions workspace to house other types of folders. 
Discussions workspaces can be particularly useful for site administrators who are responsible 
for creating the overall structure of the Vibe site. 
For more information on how you can use Discussions workspaces, see “Creating and Managing 
a Discussions Workspace” in the Novell Vibe 3.2 Advanced User Guide.
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 Basic workspaces: Like other types of Vibe workspaces, basic workspaces in Vibe can be used to 
organize information inside of existing workspaces, creating different levels of hierarchy within 
a workspace. 
For more information on basic workspaces, see “Creating and Managing a Basic Workspace” in 
the Novell Vibe 3.2 Advanced User Guide.


 Global workspaces: Global workspaces contain information that is of interest to all Vibe users. 
You, as the Vibe administrator, decide what type of information needs to be globally available on 
your Vibe site. 
For more information on Global workspaces, see Section 3.4, “Creating Global Workspaces,” on 
page 52.


3.2 Setting Up Users’ Personal Workspaces
 Section 3.2.1, “Understanding Personal Workspaces,” on page 40
 Section 3.2.2, “Customizing the Default Personal Workspace View,” on page 42
 Section 3.2.3, “Enabling Users to Create Landing Pages on Personal Workspaces,” on page 44
 Section 3.2.4, “Customizing the Default User Profile View,” on page 45
 Section 3.2.5, “Adding LDAP Elements to the User Profile View,” on page 49
 Section 3.2.6, “Customizing the Default Profile Quick View,” on page 49


See also Section 2.2.1, “Controlling User Access to Personal Workspaces,” on page 20.


3.2.1 Understanding Personal Workspaces


When you create your Novell Vibe site, a workspace named Personal Workspaces is automatically 
created.


Initially, clicking the Workspace tree icon  and expanding Personal Workspaces lists only two 
personal workspaces, even after you have created Vibe users, as described in “Adding Users to Your 
Vibe Site” in “Basic Installation” in the Novell Vibe 3.2 Installation Guide.


Users’ workspaces appear in the Workspace tree after the users log in for the first time. To see a list of 
all users in the Vibe system regardless of whether they have logged in, click Personal Workspaces. 
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You can manually add Vibe users from this user list, as described in Section 18.3, “Listing Vibe 
Users,” on page 152.


You can also create new Vibe users by using the method described in “Creating a User” in “Basic 
Installation” in the Novell Vibe 3.2 Installation Guide.


As the Vibe administrator, you can access any user’s personal workspace by clicking it in the user list. 


Before the user has logged in, the user’s personal workspace includes only very basic information.


After the user has logged in, more information displays in the personal workspace; it is ready for the 
user to personalize.

Setting Up Initial Workspaces 41







For information on how users can customize and populate their personal workspaces, see “Setting 
Up Your Personal Workspace” in the Novell Vibe 3.2 User Guide.


3.2.2 Customizing the Default Personal Workspace View


As a Vibe administrator, you have the ability to customize the default view for all personal 
workspaces in your Vibe site.


 “Customizing the Default View for Existing and Future Personal Workspaces” on page 42
 “Customizing the Default View for Future Personal Workspaces” on page 43


Customizing the Default View for Existing and Future Personal Workspaces


1 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
The Administration page is displayed.


2 Under System, click Form/View Designers.
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3 Expand User Workspace View, then click User Workspace.


4 Add the form and view elements that you want your existing and future personal workspaces to 
contain by default.
For information on the kinds of elements that you can add and how to add them, see “Adding 
Elements to the Workspace Add/Modify Form” in the Novell Vibe 3.2 Advanced User Guide.


Customizing the Default View for Future Personal Workspaces


The procedure in this section affects only future personal workspaces (workspaces that have not yet 
been created). For information on how to change the default view for existing workspaces as well as 
future workspaces, see “Customizing the Default View for Existing and Future Personal 
Workspaces” on page 42.


1 Log in as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
The Administration page is displayed.


3 Under Management, click Workspace and Folder Templates.


4 Click User workspace.
5 Modify the settings.


For information on the types of modifications that you can make to the User Workspace 
template, see Section 21.2, “Modifying Workspace and Folder Templates,” on page 187.
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3.2.3 Enabling Users to Create Landing Pages on Personal Workspaces


By default, Vibe users cannot create a landing page on their personal workspaces. However, as a Vibe 
administrator, you can enable landing page creation on personal workspaces.


1 Log in as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
The Administration page is displayed.


3 Under System, click Form/View Designers.
The Form and View Designers page is displayed.


4 Click New > User Workspace View.
5 Specify the following information:


Caption: Specify a name for the new user workspace landing page view.
This is the name that appears in the Vibe interface that users see when they use this view. (For 
example, User Landing Page.)
Name: Specify the internal name for the new user workspace landing page view.
The name that you enter in this field is not visible to users who use this view. (For example, 
user_landing_page.)
Family: Ensure User is selected in the drop-down list.


6 Click OK.
The Designer page is displayed.


7 Click Workspace Add/Modify Form.
8 Click Add in the Workspace Add/Modify Form window.
9 Click Landing Page Layout in the Layout Options section.


10 Specify the appropriate information, then click OK.
11 Click User Workspace View.
12 Click Add in the User Workspace View window.
13 Click Landing Page Layout in the Standard Form Elements section.
14 Specify the appropriate information, then click OK.


Vibe users can now enable this landing page on their personal workspaces, as described in 
“Creating a Landing Page for a Personal Workspace” in the Novell Vibe 3.2 Advanced User Guide.


For information on how to add other elements and layout options to this user workspace landing 
page view, see “Creating Custom Folder Views” in the Novell Vibe 3.2 Advanced User Guide.

44  Novell Vibe 3.2 Administration Guide







3.2.4 Customizing the Default User Profile View


The default user profile view is the view that appears in a user’s profile in the personal workspace. 
When you customize the default user profile view, you modify the information that is displayed in all 
user profiles.


The default user profile view was expanded in Vibe 3 to rival other professional knowledgebases 
such as LinkedIn. Users can include more information to share with their colleagues, such as 
education, qualifications, and competencies.


If you are updating your Vibe site from a version prior to Vibe 3 to Vibe 3 or later and you modified 
the user profile definition in your previous Vibe version, you do not see the new user profile when 
you upgrade to Vibe 3 or later. In order to see the new user profile, you need to reset your profile user 
definition. For information about how to reset your definitions, see “Resetting Your Definitions” in 
“Update” in the Novell Vibe 3.2 Installation Guide.


You can customize the default user profile view to include custom fields. If you want to customize the 
user profile view, then you must also customize the user profile form. The view is what users see 
when they view a user profile; the form is what users fill out when they edit their user profiles. You 
must design both the form and view of the user profile in order for the elements to be displayed in 
the user profile view.


 “Designing the User Profile Form” on page 45
 “Designing the User Profile View” on page 47


Designing the User Profile Form


The user profile form is what a users see when they edit their user profile in Vibe. For example: 
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To modify the information that is displayed in the user profile form that users fill out when they edit 
a user profile:


1 Log in as the Vibe administrator.


2 Click the Administration icon  in the upper right corner of the page.
The Administration page is displayed.


3 Under System, click Form/View Designers.


4 Expand Profile View, then click User.
5 Expand Profile Form Definition, then click Form.
6 Click Modify.
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7 In the Form Name field, provide a name for the form.
8 In the Type field, select Profile Form with Nothing Included.


This allows you to add elements anywhere inside the view. If you do not select this option, you 
can add elements only after the last element in the default view.


9 Click OK.
10 Expand Profile Form Definition, then click Form.
11 Depending on how you want to modify the profile form, continue with one of the following 


sections:


 “Adding Elements to the Form” on page 47
 “Modifying Elements within the Form” on page 47


Adding Elements to the Form


1 Expand Profile Form Definition, then click Form.
2 In the Form dialog box, click Add to add an element or layout option to the view.


You can add any of the elements and layout options that are described in “Workspace Form 
Elements” and “Understanding Layout Options” in the Novell Vibe 3.2 Advanced User Guide.


3 Continue with “Designing the User Profile View” on page 47 to create the user profile view that 
users will see when they view a user profile.


Modifying Elements within the Form


1 Expand Profile Form Definition, then expand Form.
2 Click the element that you want to modify.


Depending on the element that you click, you can copy, delete, modify, or move the element. You 
can also add sub-elements.


3 In the dialog box on the right side of the page, click the action that you want to perform, then 
follow the on-screen instructions.


4 Continue with “Designing the User Profile View” on page 47 to create the user profile view that 
users will see when they view a user profile.


Designing the User Profile View


After you have designed the user profile form, as described in“Designing the User Profile Form” on 
page 45, you can modify the user profile view. The user profile view is what a user sees when the user 
views a user profile in Vibe. For example: 
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To modify the information that is displayed in the user profile view that users see when they view a 
user profile:


1 Log in as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
The Administration page is displayed.


3 Under System, click Form/View Designers.


4 Expand Profile View, then click User.
The User Designer page is displayed.
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5 Expand Profile Standard View to view a list of all the elements and layout options that currently 
exist in the view.


6 Depending on how you want to modify the profile view, continue with one of the following 
sections:


 “Adding Elements to the View” on page 49
 “Modifying Elements within the View” on page 49


Adding Elements to the View


1 Click Profile Standard View.
2 In the Profile Standard View dialog box, click Add to add an element or layout option to the 


view.
You can add any of the elements and layout options that are described in “Workspace View 
Elements” and “Understanding Layout Options” in the Novell Vibe 3.2 Advanced User Guide.


Modifying Elements within the View


1 Click the element that you want to modify.
You can copy, delete, modify, or move the element. You can also add sub-elements.


2 In the dialog box on the right side of the page, click the action that you want to perform, then 
follow the on-screen instructions.


3.2.5 Adding LDAP Elements to the User Profile View


If there is information in your LDAP source that does not have a corresponding element in Vibe, and 
you want that information to be displayed in the Vibe user profile view, you can create an element in 
the profile view as described in Section 3.2.4, “Customizing the Default User Profile View,” on 
page 45. After you have created the element, you can synchronize it with the corresponding 
information from LDAP, as described in Section 18.1.2, “Synchronizing Additional LDAP 
Attributes,” on page 149.


3.2.6 Customizing the Default Profile Quick View


The Profile Quick View is displayed when you click a user’s Presence icon  in Vibe.


 Presence is displayed in the following locations in Vibe:


 In a folder entry next to a user’s name

Setting Up Initial Workspaces 49







 In a user’s profile
 In the home page of a user’s personal workspace


To modify the information that is displayed in the Profile Quick View:


1 Log in as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
The Administration page is displayed.


3 Under System, click Form/View Designers.


4 Expand Profile View, then click User.
The User Designer page is displayed.


5 Expand Profile Quick View, then click Quick View Elements.
6 In the Quick View Elements window, click Modify.
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7 Press and hold the Ctrl key to select and deselect elements that you want to include in the Profile 
Quick View or exclude from the Profile Quick View.
If the element you want to add is not available in the list, click Quick View Elements, then in the 
Quick View Elements window, click Add. Select the element from the list, then click OK.


8 Click OK.


3.3 Organizing Team Workspaces
 Section 3.3.1, “Understanding Team Workspaces,” on page 51
 Section 3.3.2, “Creating a Team Workspace Root Workspace,” on page 52
 Section 3.3.3, “Creating a Team Workspace,” on page 52


See also Chapter 19, “Managing Workspaces,” on page 163.


3.3.1 Understanding Team Workspaces


When you create your Novell Vibe site, a workspace named Team Workspaces is automatically 
created.


As the Vibe administrator, you are responsible to determine how team workspaces should be 
organized. Without guidance, Vibe users will inevitably create chaos under the Team Workspaces 
directory.


You might want to organize team workspaces to parallel your business organization. If appropriate, 
you might have a level for geographical areas. You would typically want a level for departmental 
areas, and perhaps even for projects within departments. In addition, you must decide which Vibe 
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users need what kind of access to which teams. Creating groups, as described in Section 5.2, 
“Creating Groups of Users,” on page 89, facilitates creating teams because you do not need to 
individually add users to teams.


In the Team Workspaces directory that is automatically created when you install Vibe, you can create 
other Team Workspace Root workspaces. A Team Workspace Root workspace is designed to contain 
multiple team workspaces, so use this type of workspace if you want to create additional team 
workspaces as sub-workspaces to this workspace.


3.3.2 Creating a Team Workspace Root Workspace


After you have planned the hierarchical organization of the team workspaces for your Vibe site, you 
can start to implement it by creating Team Workspace Root workspaces, as described in “Creating 
and Managing a Team Workspace Root Workspace” in the Novell Vibe 3.2 Advanced User Guide.


3.3.3 Creating a Team Workspace


In the Team Workspaces directory, or in the Team Workspace Root workspaces that you have created:


1 Create each team workspace, as described in “Creating a Team Workspace” in “Getting Started” 
in the Novell Vibe 3.2 User Guide.


2 Set the access controls on the team workspace, as described in Section 2.2.2, “Controlling User 
Access to Team Workspaces,” on page 22.


3.4 Creating Global Workspaces
A Global workspace is intended to present very high-level information that would be of interest to all 
Novell Vibe users. It might include a Frequently Asked Questions (FAQ) workspace to help new Vibe 
users find their way around in the organization of team workspaces that you have set up. It might 
provide a place to post company-wide news. All Global workspaces must be created under Home 
Workspace > Global Workspaces on the Vibe site.


You might want to use geography to organize your company’s global information, and then use 
departmental categories (Engineering, Human Resources, Marketing) to further organize the 
information. Or, depending on your organization, you might want to reverse the order (function 
followed by geography), or use some other organizational scheme.


We strongly recommend that you limit the creation of Global workspaces. First, organic team 
creation is the more effective use model for this product. Second, we have worked with a significant 
number of customers who duplicated complex organizational charts in the structure of Global 
workspaces, and users found them to be confusing and unusable. Instead, populate the global area 
with a minimal amount of information, and let users guide you in developing a useful structure and 
content in this area.
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3.5 Using Workspace and Folder Templates
Templates in Novell Vibe are a powerful way to create consistent custom folders and workspaces. If 
you are not satisfied with the way default workspaces and folders behave, you can either modify the 
current templates, or create new templates.


 Section 3.5.1, “Understanding Templates,” on page 53
 Section 3.5.2, “Understanding Default Workspace and Folder Templates,” on page 54
 Section 3.5.3, “Creating Workspace and Folder Templates,” on page 56


3.5.1 Understanding Templates


Workspace and Folder templates are a powerful and efficient way to manage your Vibe site. They 
enable you to customize the default features, default layout, and default access control settings of the 
workspaces and folders throughout your Vibe site. 


For example, the Team Workspaces template is used when any team workspace is created. By default, 
the access control settings for the Team Workspaces template specify that only team members are 
able to view the team workspace. However, if you want to run a more relaxed Vibe site and allow all 
Vibe users to view any team workspace, you can simply modify the access control settings for the 
Team Workspaces template.


For information about the specific access control roles that you can assign to various users in Vibe, 
see “Understanding Access Control” in the Novell Vibe 3.2 Advanced User Guide.


 “Creating Templates or Modifying Existing Templates” on page 53
 “Templates vs. Form and View Designers” on page 53


Creating Templates or Modifying Existing Templates


You can modify existing templates, like the Team Workspaces template, or you can create your own 
custom templates. When you create a new template, all Vibe users have access to that template when 
they create new workspaces or folders. When you modify existing templates, users who create new 
workspaces and folders see only the modified template.


For more information on the default templates that are included in Vibe, see Section 3.5.2, 
“Understanding Default Workspace and Folder Templates,” on page 54.


Templates vs. Form and View Designers


Vibe provides two methods of customizing the default features and default layout of workspaces and 
folders in your Vibe site.


 Templates: If users have not yet started using your Vibe site, use templates to create and modify 
custom folder and workspace views. Typically, templates are easier to work with than the Form 
and View Designers tool; however, changes that you make to templates affect only those 
workspaces and folders that are created after the template was modified.
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 Form and View Designers Tool: If users have already started using your Vibe site, you might 
want to use the Form and View Designers tool to create and modify folder and workspace 
views. When you modify folder and workspace views by using the Form and View Designers 
tool, all modifications are displayed in existing workspaces and folders.
For information on using the Form and View Designers tool to create new workspace and folder 
views, see “Creating Custom Workspace Views” and “Creating Custom Folder Views” in the 
Novell Vibe 3.2 Advanced User Guide.


3.5.2 Understanding Default Workspace and Folder Templates


By default, Vibe provides basic default templates for various types of workspaces and folders. If the 
default workspace and folder templates are not sufficient for your needs, you can either modify these 
templates, as described in Section 21.2, “Modifying Workspace and Folder Templates,” on page 187, 
or create new templates, as described in Section 3.5.3, “Creating Workspace and Folder Templates,” 
on page 56.


The following sections outline the default workspace and folder templates that are provided in Vibe:


 “Default Workspace Templates” on page 54
 “Default Folder Templates” on page 55


Default Workspace Templates


 Discussions Workspace
 Project Management Workspace
 Team Workspace
 Workspace (Basic)
 Landing Page
 User Workspace


Following are some examples of default workspace templates:


 “Team Workspace” on page 55
 “User Workspace” on page 55
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Team Workspace


User Workspace


Default Folder Templates


 Discussion
 Blog
 Calendar
 Guestbook
 Files
 Milestones
 Micro-Blog
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 Mirrored Files
 Photo Album
 Surveys
 Tasks
 Wiki


Following are some examples of default folder templates:


 “Discussion Folder” on page 56
 “Calendar Folder” on page 56


Discussion Folder


Calendar Folder


3.5.3 Creating Workspace and Folder Templates


Novell enables you to create templates based on existing workspaces and folders; or, you can create 
new templates. You can also modify existing templates.


 “Creating Templates Based on Existing Workspaces and Folders” on page 57
 “Creating New Templates” on page 58
 “Modifying Existing Templates” on page 59
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Creating Templates Based on Existing Workspaces and Folders


You can create templates based on existing workspaces and folders only if the workspaces and 
folders do not contain local definitions. For example, if a workspace contains a custom form that is 
being used for the Discussion folder, you cannot create a template based on this workspace. 


To find out if a workspace or folder contains local definitions, navigate to the workspace or folder, 
then click Workspace > Form/View Designers (or Folder > Form/View Designers if you are in a folder).


To create a template based on an existing workspace or folder:


1 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
The Administration page is displayed.


2 Under Management, click Workspace and Folder Templates.


3 Click New > Create a New Template from an Existing Workspace or Folder.


4 Use the Workspace tree to navigate to and select the folder or workspace whose template you 
want to modify.


5 Click Add.

Setting Up Initial Workspaces 57







6 Modify the template as desired.
For information on how to modify a template after you have created it, see Section 21.2, 
“Modifying Workspace and Folder Templates,” on page 187.


Creating New Templates


Vibe enables you to design completely new custom workspace or folder templates.


1 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
The Administration page is displayed.


2 Under Management, click Workspace and Folder Templates.


3 Click New > Folder or Workspace, depending on which type of template you want to create.
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4 Fill in the following fields:
Name: Internal name of the template
For example, custom_template.
Template Title: Visible name of the template.
For example, Custom Template.
Description: Description of the template.


5 Click Add > OK.
The template is created.


6 Set up the template as desired.
For information on how to set up a template after you have created it, see Section 21.2, 
“Modifying Workspace and Folder Templates,” on page 187.


Modifying Existing Templates


Vibe enables you to modify default templates or custom templates that you have created.


For information on how to modify existing templates, see Section 21.2, “Modifying Workspace and 
Folder Templates,” on page 187.


3.6 Importing Workspaces
Novell Vibe data can be transferred from one Vibe site to another by exporting it and then importing 
it. If you have data to import into your Vibe site, see Section 19.1, “Exporting/Importing Workspaces, 
Folders, and Entries,” on page 163.
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4 4Setting Up Site-Wide Customizations


 Section 4.1, “Creating High-Level Landing Pages,” on page 61
 Section 4.2, “Creating a Site-Wide Brand,” on page 62
 Section 4.3, “Setting a Default Home Page,” on page 63
 Section 4.4, “Re-Branding the Login Dialog Box,” on page 67
 Section 4.5, “Enabling User ID Auto-Completion for the Login Dialog Box,” on page 68
 Section 4.6, “Customizing Vibe Styles,” on page 68
 Section 4.7, “Customizing Icons on Your Vibe Site,” on page 71
 Section 4.8, “Configuring How Items Are Displayed in the What’s New Page,” on page 73
 Section 4.9, “Sorting Names throughout the Vibe Site by Last Name,” on page 75
 Section 4.10, “Changing the Number of Recent Places That Are Displayed,” on page 76
 Section 4.11, “Changing Global File Associations for Edit in Place Applications,” on page 77
 Section 4.12, “Understanding and Configuring Search Functionality,” on page 78
 Section 4.13, “Understanding and Configuring Document Conversions with Stellent,” on 


page 85
 Section 4.14, “Enabling ZIP Files That Contain Extended or Double-Byte Characters in the 


Filename to Be Downloaded,” on page 87


4.1 Creating High-Level Landing Pages
Landing pages are a good way to put a custom face on your Novell Vibe site while at the same time 
providing easier access to your site’s most important information.


You might want to create landing pages at high-level workspaces, such as the Home Workspace 
workspace, which is the default name of the top-level workspace.


For information on how to create a landing page, see “Creating and Managing Landing Pages” in the 
Novell Vibe 3.2 Advanced User Guide.
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4.2 Creating a Site-Wide Brand
You can brand your Novell Vibe site to match your corporate brand. When you add a site-wide brand 
to your Vibe site, the brand is displayed on every Vibe page. However, this does not include the 
Guest User workspace. To display the brand on the Guest User workspace, you must manually add 
it, as described in “Branding a Folder or Workspace” in the Novell Vibe 3.2 Advanced User Guide.


By default, users can create their own brands for their individual workspaces, team workspaces, and 
folders. When you create a site-wide brand, you can disable this functionality. For more information, 
see Branding Rules in Step 4.


1 Sign in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
The Administration page is displayed.


3 In the System section, click Site Branding.
The Workspace/Folder Branding dialog box is displayed.


4 Specify the following information to create your desired brand:
Use Branding Image: Select this option if you want to use the drop-down list to select an 


existing image, or click the Browse icon  to browse to an image on your computer’s file 
system.
Use Advanced Branding: Select this option, then click Advanced if you want to create a brand 
that includes advanced features in your brand, such as a YouTube video.
Background Image: Use the drop-down list to select an existing image, or click the Browse icon 


 to browse to an image on your computer’s file system.
The background image is displayed behind your regular branding.
Stretch Image: Stretches the image to occupy the entire branding area.
If you stretch your background image, the image overrides any background color that you have 
set.
Background Color: Adds a background color that occupies the entire branding area. To change 
the background color, click the color name to the right of this field, select the new color, then 
click OK.
If you added a background image and stretched the image, the background color is not 
displayed.
Text Color: Changes the text color of the workspace name in the upper right corner of the 
branding area. To change the text color, click the color name to the right of this field, select the 
new color, then click OK.
Branding Rules: Select from the following:
 Display site branding only: Displays only the site-wide branding on all Vibe pages. Vibe 


users cannot create their own brands for workspaces and folders.
 Display both site and workspace branding: Enables Vibe users to create their own brands 


for workspaces and folders. Both the site-wide brand and the workspace or folder brand are 
displayed.


 Workspace branding overrides site branding: Enables Vibe users to create their own 
brands for workspaces and folders. Workspace and folder brands override the site-wide 
brand.


Clear branding: Click this option to clear all your current branding selections.

62  Novell Vibe 3.2 Administration Guide







5 Click OK.
The Vibe site now displays the brand that you created.


For more information about creating brands in Vibe, see “Branding a Folder or Workspace” in the 
Novell Vibe 3.2 Advanced User Guide.


4.3 Setting a Default Home Page
By default, all users who log in to the Novell Vibe site are first taken to the What’s New page. 
However, you can change this default behavior to have all users taken to a different home page of 
your choosing. This might be a corporate landing page that provides links to important places on the 
Vibe site.


You can also configure Vibe so that users are taken to their personal workspaces when they first log 
in to the Vibe site. For information on how to configure Vibe in this way, see “Restricting the What’s 
New Page from Being Displayed When Users First Log In” on page 74.


 Section 4.3.1, “Setting a Default Home Page for All Licensed Vibe Users,” on page 63
 Section 4.3.2, “Setting a Default Home Page for Guest Users,” on page 64
 Section 4.3.3, “Removing the Default Home Page,” on page 66


4.3.1 Setting a Default Home Page for All Licensed Vibe Users


1 Log in to the Vibe site as the Vibe administrator.
2 Create a landing page on the workspace that you want to set as the new default home page for 


all registered users.
For example, you might navigate to the Global Workspaces directory and create a landing page on 
this workspace.
For information on how to create a landing page, see “Creating and Managing Landing Pages” 
in the Novell Vibe 3.2 Advanced User Guide.


3 Set the access control for the workspace to allow all users to be visitors to the workspace, if it is 
not set already:
3a Click Workspace > Access Control in the Action toolbar.
3b In the Inherit role membership section, select no, then click Apply.
3c In the All Users row, ensure that the box is selected in the Visitor column.
3d Click Save Changes > Close.


4 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
5 Under System, click Configure Default Landing Pages.
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6 In the Select the Folder or Workspace to be the Default Home Page for this Zone field, begin typing the 
name of the folder or workspace that you want to set as the default home page for all licensed 
users, then click it when it appears in the drop-down list.


7 Click OK.


If you want users to be automatically taken to this page before they log in, and if you want people 
who do not have a user account to have access to the page, see “Making the Guest User Default 
Home Page the Same as the Home Page for Licensed Users” on page 64.


4.3.2 Setting a Default Home Page for Guest Users


When you allow people who do not have a user account to access the Vibe site as a guest user, as 
described in Section 5.4.2, “Setting Up Guest Access for the Vibe Site,” on page 93, then by default 
they are taken to the Guest User workspace when they access Vibe. If you want guest users to be 
taken to a workspace other than the Guest User workspace, you can set a default home page for guest 
users that is different from the Guest User workspace. The default home page can be the same default 
home page that you have set up for your licensed Vibe users, or it can be a different page.


 “Making the Guest User Default Home Page the Same as the Home Page for Licensed Users” on 
page 64


 “Setting Up a Default Home Page Specifically for Guest Users” on page 65


Making the Guest User Default Home Page the Same as the Home Page for 
Licensed Users


If you have already set up a default home page for your licensed Vibe users, as described in 
Section 4.3.1, “Setting a Default Home Page for All Licensed Vibe Users,” on page 63, you can 
configure Vibe to allow guest users who access the Vibe site to be taken to the same home page. If 
you configure Vibe in this way, everyone who accesses the Vibe site is taken directly to the default 
home page without logging in.


1 Follow the steps in Section 4.3.1, “Setting a Default Home Page for All Licensed Vibe Users,” on 
page 63.


2 Navigate to the workspace that you want to set as the default home page for guest users, which 
is the workspace that you already set as the default home page for licensed Vibe users in 
Section 4.3.1, “Setting a Default Home Page for All Licensed Vibe Users,” on page 63.


3 Click Workspace > Access Control in the Action toolbar.
The Configure Access Control page is displayed.
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4 Click Add User, start typing Guest in the Add a User field, then click Guest when it appears in the 
drop-down list.
This adds Guest as a new row in the Access Control table.


5 In the Guest row, ensure that the box is selected in the Visitor column.
6 Click Save Changes > Close.


Setting Up a Default Home Page Specifically for Guest Users


You might want guest users who access the Vibe site to be taken to a workspace that is designated 
specifically for guest users. 


1 Log in to the Vibe site as the Vibe administrator.
2 Create a landing page on the workspace that you want to set as the new default home page for 


guest users.
For information on how to create a landing page, see “Creating and Managing Landing Pages” 
in the Novell Vibe 3.2 Advanced User Guide.


3 Set the access control for the workspace to allow guest users to be visitors to the workspace.
3a Click Workspace > Access Control in the Action toolbar.
3b In the Inherit role membership section, select no, then click Apply.
3c Click Add User, start typing Guest in the Add a User field, then click Guest when it appears in 


the drop-down list.
This adds Guest as a new row in the Access Control table.
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3d In the Guest row, ensure that the box is selected in the Visitor column.
3e Click Save Changes > Close.


4 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
5 Under System, click Configure Default Landing Pages.


6 In the Select the Folder or Workspace to be the Default Home Page for Guest Users field, begin typing 
the name of the folder or workspace that you want to set as the default home page for guest 
users, then click it when it appears in the drop-down list.


7 Click OK.


4.3.3 Removing the Default Home Page


If you remove the default home page, users are taken to their individual workspaces when they first 
access the Vibe site.


1 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
2 Under System, click Configure Default Landing Pages.
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3 Beneath The current home page is, select Delete.


4 Click OK.


4.4 Re-Branding the Login Dialog Box
You can change the image that is used in the login dialog box that users see before they log in to the 
Novell Vibe site.


To re-brand the login dialog box to contain a custom image:


1 Navigate to each of the following three directories for your operating system:


Linux: /opt/novell/teaming/apache-tomcat/webapps/ssf/static/
build_number/i/iccg/pics/Login


/opt/novell/teaming/apache-tomcat/webapps/ssf/static/
build_number/i/icib/pics/Login


/opt/novell/teaming/apache-tomcat/webapps/ssf/static/
build_number/i/icwg/pics/Login
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2 Replace the novell_graphic.png file in each of the directories with the file that contains the 
image that you want to display in the login dialog box.


3 Stop and restart the Vibe server.


4.5 Enabling User ID Auto-Completion for the Login Dialog Box
You can enable auto-completion for the User ID field in the login dialog box for your Novell Vibe site. 
When you enable auto-completion, each user in your Vibe site can start typing his or her user ID and 
then select it from a drop-down list when it appears.


To enable auto-completion for your Vibe site:


1 Change to the following directory:


2 Open the ssf-ext.properties file in a text editor.
3 Scroll to the bottom of the ssf-ext.properties file, then add the following line:


enable.login.autocomplete=true


4 Save and close the ssf-ext.properties file.
5 Stop and restart Vibe.


4.6 Customizing Vibe Styles
You can customize colors, background images, and fonts throughout the Vibe interface. You might 
want to do this if you want to change the default Vibe styles to better match your corporate theme.


You must have knowledge of CSS styling to successfully customize styles in your Vibe site. When 
customizing styles, you need to either add a style, change an existing style, or delete a style.


For information about how to customize icons throughout the Vibe site, see “TID 7007607: Modifying 
the Default Vibe Icons” in the Novell Support Knowledgebase (http://www.novell.com/support).


IMPORTANT: As you customize styles on the Vibe server, back up the changes you are making and 
record where you are making them. This is because when you upgrade your Vibe system to a new 
version, any style changes that you have made could be overwritten. You might need your backups 
and detailed notes in order to re-create your customized Vibe styles after an upgrade.


Windows: c:\Program Files\Novell\Teaming\
                apache-tomcat\webapps\ssf\static\


build_number\i\iccg\pics\Login


c:\Program Files\Novell\Teaming\
                apache-tomcat\webapps\ssf\static  


  build_number\i\icib\pics\Login


c:\Program Files\Novell\Teaming\
                apache-tomcat\webapps\ssf\static\


build_number\i\icwg\pics\Login


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/WEB-INF/classes/config


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF\classes\config
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Figure 4-1   Default Vibe Style


Most style customizations in Vibe are accomplished through the modification of CSS style sheets. 
Some style settings in the Vibe interface are contained within JSP files. 


Figure 4-1shows the various areas of the Vibe interface. The type of files that you need to modify in 
order to affect Vibe styles depends on the area of the Vibe interface that you want to customize, as 
shown in the following table.


Table 4-1   CSS Style Locations


Area of Vibe 
Interface Type of File to Modify Location on the Vibe Server


Masthead CSS style sheet apache-tomcat/webapps/ssf/static/version/js/
gwt/gwtteaming/GwtTeaming.css


Navigation Panel CSS style sheet apache-tomcat/webapps/ssf/static/version/js/
gwt/gwtteaming/GwtTeaming.css


Action Toolbar CSS Style Sheet apache-tomcat/webapps/ssf/static/version/js/
gwt/gwtteaming/GwtTeaming.css


User Profile Page CSS Style Sheet apache-tomcat/webapps/ssf/static/version/js/
gwt/gwtteaming/GwtProfile.css


Content Area JSP file apache-tomcat/webapps/ssf/WEB-INF/jsp/common
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To customize styles for your Vibe system:


1 Find the CSS selector name for the area of the interface for which you want to customize the 
style setting.
For example, suppose you want to modify the color or font of the Action toolbar for your Vibe 
site. You use Firebug on Firefox to find the selector name for the Action toolbar, which is 
mainMenuControl.


2 On the Vibe server, navigate to the directory where the style that you want to modify is located.
See Table 4-1 for the file location on the Vibe server.
For example, Table 4-1 shows that the mainMenuControl selector for the Action toolbar is 
located in the apache-tomcat/webapps/ssf/static/version/js/gwt/gwtteaming directory, 
in the GwtTeaming.css file.


3 Open the appropriate file in an editor, then search for the selector name.
For example, to customize the color of the Action toolbar, open the GwtTeaming.css file, then 
search for mainMenuControl.
If the appropriate file is a JSP file, you first need to locate the appropriate JSP file.


4 Make your desired style modifications in one of the following ways:
 In the CSS style sheet, modify the value of the CSS definition that you want to customize, 


add a new CSS definition, or delete an existing CSS definition.
 Modify any images that are referenced in the CSS style sheet by navigating to the directory 


where the images reside and making changes there.
If you modify an image that is not referenced in the CSS style sheet, your modifications are 
not reflected in the Vibe interface.
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5 Save your changes on the Vibe server, then clear the browser cache and refresh the browser to 
see the changes.
Following are examples of color and font changes to the Action toolbar:
The Action toolbar has been changed to red.


The font of the Action toolbar has been changed.


4.7 Customizing Icons on Your Vibe Site
 Section 4.7.1, “Replacing Existing Icons,” on page 71
 Section 4.7.2, “Adding New Icons,” on page 72


4.7.1 Replacing Existing Icons


You can customize your Novell Vibe site by replacing standard icons with icons of your own 
choosing.


1 Change to the following directory:


2 Open the ssf.properties file in a text editor.
3 Search for icons in order to move to the section that defines the Vibe icons.


Four types of icons are listed:


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/WEB-INF/classes/config


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF\classes\config
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icons.workspace=
icons.folder=
icons.profileList=
icons.entry=


These icons are stored in the following directory:


4 Replace standard image files with your own image files with the same filenames.
This replaces the standard Vibe icons with your own customized icons. The next time you access 
the Vibe site, your customized icons display instead of the standard Vibe icons.


4.7.2 Adding New Icons


You can add icons to your Vibe site for use in areas of the Vibe site that you are customizing on a 
significant scale.


1 Change to the following directory:


2 Open the ssf.properties file in a text editor.
3 Search for icons in order to move to the section that defines the Vibe icons.


Four types of Vibe icons are listed:


icons.workspace=
icons.folder=
icons.profileList=
icons.entry=


These Vibe icons are stored in the following directory:


4 Make a backup copy of the ssf-ext.properties file, located in the same directory with the 
ssf.properties file.


5 Open the ssf-ext.properties file in a text editor.
6 Copy the Icons section from the ssf.properties file to the bottom of the ssf-


ext.properties file.
7 List additional image files for each icon type as needed.
8 Add the new image files to the appropriate subdirectory under the icons directory where the 


existing Vibe icons are stored.


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/images/icons


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\images\icons


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/WEB-INF/classes/config


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF\classes\config


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/images/icons


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\images\icons
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9 Save and close the ssf-ext.properties file.
10 Close the ssf.properties file without saving it.
11 Stop and restart Vibe to make the new icons available on your Vibe site.


4.8 Configuring How Items Are Displayed in the What’s New 
Page
Novell Vibe users can view what’s new in Vibe by using the What’s New page. Users can quickly see 
what’s new in their teams, favorite places, and more. For more information on how users can view 
what’s new in Vibe, see “Finding What’s New” in the Novell Vibe 3.2 User Guide.


As the Vibe administrator, you can control various aspects of the What’s New page by modifying 
Vibe configuration settings. 


 Section 4.8.1, “Understanding the Configuration Settings You Can Customize for the What’s 
New Page,” on page 73


 Section 4.8.2, “Changing the Configuration Settings for the What’s New Page,” on page 75


4.8.1 Understanding the Configuration Settings You Can Customize for the 
What’s New Page


The tables in the following sections describe configuration settings for the What’s New page that the 
Vibe administrator can customize, the system default for the setting, and the line in the ssf-
ext.properties file that controls the setting:


 “Customizing the Number of Comments That Can Be Displayed for Each Entry on the What’s 
New Page” on page 73


 “Customizing the Number of Words That Are Displayed for Each Item on the What’s New Page” 
on page 74


 “Customizing How Often the What’s New Page Is Updated” on page 74
 “Customizing the Number of Items That Are Returned When the What’s New Page Is Updated” 


on page 74
 “Restricting the What’s New Page from Being Displayed When Users First Log In” on page 74


Customizing the Number of Comments That Can Be Displayed for Each Entry on 
the What’s New Page


Configuration Setting System 
Default


Line in the ssf-ext.properties File


The maximum number of 
comments that are displayed for 
any given entry.


2 comments activity.stream.active.comments
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Customizing the Number of Words That Are Displayed for Each Item on the 
What’s New Page


Customizing How Often the What’s New Page Is Updated


NOTE: Adjusting this setting to update the What’s New page more frequently than the system 
default (60 seconds) can result in inadequate system performance. However, depending on how 
many users access your Vibe system and your current configuration, a more frequent or less frequent 
update cycle might be appropriate.


Customizing the Number of Items That Are Returned When the What’s New Page 
Is Updated


Restricting the What’s New Page from Being Displayed When Users First Log In


Configuration Setting System 
Default Line in the ssf-ext.properties File


The maximum number of words 
that are displayed for each item on 
the What’s New page.


-1 (The first 
several lines of 
an item are 
displayed)


activity.stream.display.words


Configuration Setting System 
Default


Line in the ssf-ext.properties File


How often the What’s New page is 
updated to display the most recent 
posts.


60 seconds activity.stream.interval.refresh.client


Configuration Setting System 
Default


Line in the ssf-ext.properties File


The maximum number of new or 
modified items that are returned by 
the search (includes entries and 
comments).


1000 items activity.stream.maxhits


Configuration Setting System 
Default


Line in the ssf-ext.properties File


Defines whether the What’s New 
page is displayed when users first 
log in to the Vibe site. If the value of 
this line is true, the What’s New 
page is displayed. If the value is 
false, users see their personal 
workspaces when they first log in to 
the Vibe site.


true (The 
What’s New 
page is 
displayed when 
users first log 
in)


activity.stream.on.login
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IMPORTANT: If you have specified a default home page for you Vibe site, as described in 
Section 4.3, “Setting a Default Home Page,” on page 63, users are taken to that home page when they 
first log in to the Vibe site, regardless of this setting.


4.8.2 Changing the Configuration Settings for the What’s New Page


To change the configuration settings of the What’s New page:


1 Change to the following directory:


2 Make a backup copy of the ssf-ext.properties file, which is located in the same directory as 
the ssf.properties file.


3 Open the ssf.properties file in a text editor.
4 Search for the appropriate line that represents the configuration setting that you want to 


customize for the What’s New page. 
See the table in Section 4.8.1, “Understanding the Configuration Settings You Can Customize for 
the What’s New Page,” on page 73 to find the line in the ssf-ext.properties file that controls 
the setting that you want to customize.
For example, if you want to change the number of words that are displayed for each item on the 
What’s New page, search for the line activity.stream.display.words=-1, then change the 
value to the number of words that you want to be displayed. For example, 
activity.stream.display.words=25.


5 Open the ssf-ext.properties file in a text editor.
6 Copy the appropriate line from the ssf.properties file to the bottom of the ssf-


ext.properties file.
7 Change the default value of the line to the value that you want.
8 Save and close the ssf-ext.properties file.
9 Stop and restart Vibe.


4.9 Sorting Names throughout the Vibe Site by Last Name
By default, where lists of users are displayed in Vibe, names are sorted by first name (for example, 
Anne Marie Hall), rather than by last name (for example, Hall, Anne Marie). 


A list of users in your Vibe system are displayed in the following locations:


 Navigation Panel in the Personal Workspaces workspace.


You access the Personal Workspaces workspace by clicking the Workspace tree icon , 
expanding Home Workspace, then clicking Personal Workspaces.


 Workspace tree in the Action toolbar.


You access the Workspace tree by clicking the Workspace tree icon  in the Action toolbar.


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/WEB-INF/classes/config


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF\classes\config
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 Workspace tree in other areas throughout the Vibe site.
The workspace tree appears in other locations throughout Vibe, such as in the Search Index.


The following figure shows names in the Navigation panel sorted by first name.


To configure the Vibe site to sort names by last name:


1 Change to the following directory:


2 Make a backup copy of the ssf-ext.properties file, which is located in the same directory as 
the ssf.properties file.


3 Open the ssf.properties file in a text editor.
4 Search for the following line: 


wsTree.titleFormat=0


5 Open the ssf-ext.properties file in a text editor.
6 Copy the appropriate line from the ssf.properties file to the bottom of the ssf-


ext.properties file.
7 Change 0 to 1, so that the line now reads wsTree.titleFormat=1.
8 Save and close the ssf-ext.properties file.
9 Close the ssf.properties file without saving it.


10 Stop and restart Vibe.


4.10 Changing the Number of Recent Places That Are Displayed
You can modify how many recent places are displayed in the Recent Places menu in the Action 
toolbar. By default, a user’s 20 most recently visited places are displayed. (For more information, see 
“Viewing and Revisiting Recent Places”in the Novell Vibe 3.2 User Guide.)


To change the number of recently visited places that are displayed for each user:


1 Change to the following directory:


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/WEB-INF/classes/config


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF\classes\config
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2 Make a backup copy of the ssf-ext.properties file, which is located in the same directory as 
the ssf.properties file.


3 Open the ssf.properties file in a text editor.
4 Search for the following line:


recent-places-depth=20


5 Open the ssf-ext.properties file in a text editor.
6 Copy the recent-places-depth=20 line from the ssf.properties file to the bottom of the 


ssf-ext.properties file.
7 Change 20 to the number that represents how many recent entries you want to be displayed for 


each user. For example, if you want only 10 recently visited entries to be displayed, the line 
would now read recent-places-depth=10.


8 Save and close the ssf-ext.properties file.
9 Close the ssf.properties file without saving it.


10 Stop and restart Vibe.


4.11 Changing Global File Associations for Edit in Place 
Applications
When calling applications with the Edit in Place feature, Novell Vibe uses standard file associations. 
If your organization uses different file associations, you can reconfigure Vibe to use the preferred file 
associations.


1 Change to the following directory:


2 Make a backup copy of the ssf-ext.properties file, which is located in the same directory as 
the ssf.properties file.


3 Open the ssf.properties file in a text editor.
4 Search for Edit in place to move to the block of lines that control the Edit in Place feature.
5 Review the subsequent comment lines to become more familiar with how the Edit in Place 


feature works.
6 Scroll down to locate the lines for the file associations that you want to change.
7 Copy the lines to the clipboard of your text editor.


For example, if you want to change the default editor for .doc files for Mac users to be Microsoft 
Word (rather than OpenOffice), copy the line that contains the .doc file extension:


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/WEB-INF/classes/config


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF\classes\config


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/WEB-INF/classes/config


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF\classes\config
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edit.in.place.mac.editor.doc=/Applications/OpenOffice.org.app/Contents/MacOS/
Office


8 Open the ssf-ext.properties file.
9  Scroll to the end of the ssf-ext.properties file, then paste the line you copied in Step 7.


10 Edit the file association as needed.
For example, if you want to change the default editor for .doc files on the Mac operating system 
to be Microsoft Word (rather than OpenOffice), modify the line that you copied in Step 7 as 
follows:


edit.in.place.mac.editor.doc=/Applications/Microsoft\\Office\\ 2008/
Microsoft\\ Word.app/Contents/MacOS/Microsoft\\ Word


Use double backslashes for Mac or Linux systems when you need to include a space in the path, 
as shown in the above example.


11 (Optional) Copy additional lines from the ssf.properties file to the ssf-ext.properties file 
as needed.


12 Save and close the ssf-ext.properties file.
13 Close the ssf.properties file without saving it.
14 Stop and restart Vibe to put the modified file associations into affect for your Vibe site.


4.12 Understanding and Configuring Search Functionality
Novell Vibe contains various features that control how items are indexed and how searches are 
executed on the Vibe site. As the Vibe administrator, you can configure the settings for these features. 
The default configurations are optimal for most Vibe sites.


These features are supported only with Vibe folder entries that contain English or other Western 
European languages. (For a list of supported languages, see Section 4.12.6, “Supported Languages for 
Indexing and Searching for the Root Form of Words,” on page 84.)


 Section 4.12.1, “Removing Frequently Used Words That Have No Inherent Meaning,” on 
page 78


 Section 4.12.2, “Searching for Various Forms of the Same Word,” on page 79
 Section 4.12.3, “Searching for Words That Contain Accents,” on page 79
 Section 4.12.4, “Increasing the Number of Words That Are Indexed for Each Document,” on 


page 79
 Section 4.12.5, “Modifying Configuration Settings,” on page 79
 Section 4.12.6, “Supported Languages for Indexing and Searching for the Root Form of Words,” 


on page 84


4.12.1 Removing Frequently Used Words That Have No Inherent Meaning


Vibe removes frequently used words that have no inherent meaning when items are indexed and 
when users perform a search. Examples of such words are a, an, the, in, on, the, and so forth.


This includes when users perform a search with quotation marks. For example, “sell the 
products” would return all of the following: sell their products, sell with products, sell 
the products, and so forth. However, it would not return sell products.


You can customize the words that Vibe considers to have no inherent meaning. For more 
information, see “lucene.indexing.stopwords.file.path” on page 81.
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This functionality is enabled by default. For information on how to modify the default settings, see 
Section 4.12.5, “Modifying Configuration Settings,” on page 79.


4.12.2 Searching for Various Forms of the Same Word


When Vibe indexes a word, it indexes the root form of the word. Likewise, when users perform a 
search for a word, Vibe searches for the root form of the word and returns all matches. For example, 
performing a search on the word research returns all forms of the word, including researching, 
researched, and researches. Likewise, searching for the word researching returns results for 
research, researches, and so forth.


This functionality is enabled by default. For information on how to modify the default settings, see 
Section 4.12.5, “Modifying Configuration Settings,” on page 79.


4.12.3 Searching for Words That Contain Accents


When Vibe indexes a word, it indexes the word without accents, regardless of whether the word 
originally contains accents. Likewise, when users perform a search for a word, Vibe searches for the 
word without accents, regardless of whether the user uses accents during the search. This means that 
when a user performs a search on the word cliché, Vibe returns results for the word cliché and 
cliche. Vibe also returns both forms of the word if the user performs a search on the word cliche.


This functionality is enabled by default. For information on how to modify the default settings, see 
Section 4.12.5, “Modifying Configuration Settings,” on page 79.


4.12.4 Increasing the Number of Words That Are Indexed for Each Document


Vibe indexes all the words (and their variations) in documents that are uploaded to the Vibe site. In 
most cases, the default settings are sufficient to index documents that contain tens of pages.


If you have very large documents (hundreds or thousands of pages per document) that are stored on 
your Vibe site, you might encounter problems with parts of the document not being returned in 
search results. This can be due to the fact that the document is not being indexed in its entirety, 
because the document is too large. In this case, you might want to increase the number of words that 
are indexed for each document. Be aware that increasing the number of words that are indexed uses 
more system resources (RAM and disk space).


You can increase the number of words that are indexed for each document that is added to the Vibe 
site. For information on how to do this, see Section 4.12.5, “Modifying Configuration Settings,” on 
page 79.


4.12.5 Modifying Configuration Settings


The location of the configuration file on the Vibe server depends on whether you have a single 
Lucene Index Server that is located on the same server as Vibe, or if your Lucene Index Server is 
located on a remote server or you have multiple Lucene Index Servers. 


For more information about the various ways that you can set up the Lucene Index Server, see 
“Changing Your Lucene Index Server Configuration” in the Novell Vibe 3.2 Installation Guide.


To modify configuration settings for the Search feature:


1 Change to the following directory:
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2 Open the ssf.properties file in a text editor if you have a single Lucene Index Server that is 
located on the same server as Vibe.
or
Open the lucene-server.properties file in a text editor if your Lucene Index Server is located 
on a remote server or you have multiple Lucene Index Servers.


3 Scroll down to locate the line for the search functionality that you want to change.
For information on each configuration setting that you can modify for searching on the Vibe site, 
see “Configuration Settings for Search Features” on page 80.


4 Copy that line to the clipboard of your text editor.
5 Depending on which file you are modifying (as described in Step 2), make a backup copy of the 


corresponding ssf-ext.properties file or lucene-server-ext.properties file, which are 
located in the same directory as the ssf.properties file and the lucene-server.properties 
file.


6 Open either the ssf-ext.properties file or the lucene-server-ext.properties file.
7  Scroll to the end of the ssf-ext.properties file or the lucene-server-ext.properties file, 


then paste the line you copied.
8 Edit the setting for the appropriate search functionality as needed.
9 Save and close the ssf-ext.properties file or the lucene-server-ext.properties file.


10 Close the ssf.properties file or the lucene-server.properties without saving.
11 Stop and restart Vibe to put the modified search customizations into affect for your Vibe site.
12 Re-index the Vibe site, as described in Section 24.4, “Rebuilding the Lucene Index,” on page 205.


Configuration Settings for Search Features


The following tables show the configuration settings that you can modify for the various search 
features. Each configuration setting has a lucene.indexing setting and a corresponding 
lucene.searching setting. Both setting must be configured in order to produce the desired 
functionality.


 Table 4-2, “Removing Frequently Used Words,” on page 81
 Table 4-3, “Searching for Various Forms of the Same Word,” on page 82
 Table 4-4, “Searching for Words That Contain Accents,” on page 83
 Table 4-5, “Increasing the Number of Words That Are Indexed for Each Document,” on page 83


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/WEB-INF/classes/config


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF\classes\config
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Table 4-2   Removing Frequently Used Words


Setting Function


lucene.indexing.stopwords.enable Enables or disables the functionality that removes 
frequently used words that have no inherent 
meaning when items are added to the index. For 
more information, see Section 4.12.1, “Removing 
Frequently Used Words That Have No Inherent 
Meaning,” on page 78.


By default, the value is true (enabled).


lucene.indexing.stopwords.file.charset If you have provided your own file that contains 
frequently used words that you want to be ignored 
(as described in 
“lucene.indexing.stopwords.file.path” on page 81), 
you can change the default character encoding of 
the file that contains the new words.


By default, the value is UTF-8.


lucene.indexing.stopwords.file.path Enables you to point to a file that you create that 
contains your own list of words that you want Vibe to 
ignore when items are added to the index. This file 
should be in a directory where it does not get 
overwritten or removed during an upgrade. If you are 
running Vibe in a clustered environment, this should 
be a directory that is accessible to and shared by all 
Vibe nodes.


You must specify the full path to the file.


Each line of the file should contain only one word.


All words in the file must be in lowercase.


By default, there is no file path specified, and Vibe 
defaults to a list of common words that are not 
normally useful when performing a search, such as 
a, in, this, and so forth.


lucene.searching.stopwords.enable Enables or disables the functionality that removes 
frequently used words that have no inherent 
meaning when users perform a search. For more 
information, see Section 4.12.1, “Removing 
Frequently Used Words That Have No Inherent 
Meaning,” on page 78.


By default, the value is true (enabled).


lucene.searching.stopwords.file.charset If you have provided your own file that contains 
frequently used words that you want to be ignored 
(as described in 
“lucene.indexing.stopwords.file.path” on page 81), 
you can change the default character encoding of 
the file that contains the new words.


By default, the value is UTF-8.
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Table 4-3   Searching for Various Forms of the Same Word


lucene.searching.stopwords.file.path Enables you to point to a file that you create that 
contains your own list of words that you want Vibe to 
ignore when performing a search. This file should be 
in a directory where it does not get overwritten or 
removed during an upgrade. If you are running Vibe 
in a clustered environment, this should be a directory 
that is accessible to and shared by all Vibe nodes.


You must specify the full path to the file.


Each line of the file should contain only one word.


All words in the file must be in lowercase.


By default, there is no file path specified, and Vibe 
defaults to a list of common words that are not 
normally useful when performing a search, such as 
a, in, this, and so forth.


If you leave all three search features enabled 
(removing frequently used words, searching for 
various forms of the same word, and searching for 
words that contain accents), and you want to specify 
words to ignore that contain accents, you must 
specify both forms of the word (with and without the 
accents).


Setting Function


lucene.indexing.stemming.enable Enables or disables the functionality that indexes 
various forms of the same word. For more 
information, see Section 4.12.2, “Searching for 
Various Forms of the Same Word,” on page 79.


By default, the value is true (enabled).


lucene.indexing.stemming.stemmer.names Allows you to specify the language that you want 
Vibe to use when indexing the root form of words. 
For more information, see Section 4.12.2, 
“Searching for Various Forms of the Same Word,” on 
page 79.


By default, the language is English.


For information about which languages are 
available, see Section 4.12.6, “Supported 
Languages for Indexing and Searching for the Root 
Form of Words,” on page 84.


lucene.searching.stemming.enable Enables or disables the functionality that allows 
users to search for various forms of the same word. 
For more information, see Section 4.12.2, 
“Searching for Various Forms of the Same Word,” on 
page 79.


By default, the value is true (enabled).


Setting Function
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Table 4-4   Searching for Words That Contain Accents


Table 4-5   Increasing the Number of Words That Are Indexed for Each Document


lucene.searching.stemming.stemmer.names Allows you to specify the language that you want 
Vibe to use when searching for the root form of 
words. For more information, see Section 4.12.2, 
“Searching for Various Forms of the Same Word,” on 
page 79.


By default, the language is English.


For information about which languages are 
available, see Section 4.12.6, “Supported 
Languages for Indexing and Searching for the Root 
Form of Words,” on page 84.


Setting Function


lucene.indexing.asciifolding.enable Enables or disables the functionality that indexes 
words with accents as well as the same word without 
the accents. For more information, see 
Section 4.12.3, “Searching for Words That Contain 
Accents,” on page 79.


By default, the value is true (enabled).


lucene.searching.asciifolding.enable Enables or disables the functionality that allows 
users to search for words with accents as well as the 
same word without the accents. For more 
information, see Section 4.12.3, “Searching for 
Words That Contain Accents,” on page 79.


By default, the value is true (enabled).


Setting Function


lucene.max.fieldlength Designates the maximum number of terms that are 
indexed for each document that is uploaded to Vibe. 
Be aware that the number of terms per document 
can be much higher than the number of words in the 
document (because stemming and ascii folding 
capabilities enable various forms of each word in the 
document to be indexed). Only terms that are 
indexed appear in search results. For more 
information, see Section 4.12.4, “Increasing the 
Number of Words That Are Indexed for Each 
Document,” on page 79.


By default, the value is 100000.


Setting Function
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4.12.6 Supported Languages for Indexing and Searching for the Root Form of 
Words


By default, when Vibe indexes a word, it indexes the root form of the word. Likewise, when users 
perform a search for a word, Vibe searches for the root form of the word and returns all matches. (For 
more information, see Section 4.12.2, “Searching for Various Forms of the Same Word,” on page 79.)


The default language of the Vibe site is irrelevant in regards to indexing and searching for the root 
form of words; Vibe detects the language for each individual entry when it performs the indexing 
and search. 


You can configure Vibe to use any of the following languages when indexing and searching for the 
root form of words (the default is English):


 Danish
 Dutch
 English
 Finnish
 French
 German
 German2 (This is a modified version of German that handles umlaut characters differently. 


Appends an e after vowels that would otherwise have an umlaut. For example, ä becomes ae, ë 
becomes oe, and ü becomes ue.) 


 Hungarian
 Italian
 Norwegian


doc.conversion.size.threshold Depending on your specific environment and need, 
you might need to modify this setting in addition to 
the lucene.max.fieldlength setting.


Designates the size of the document that can be 
indexed in the Vibe site. For more information, see 
Section 4.12.4, “Increasing the Number of Words 
That Are Indexed for Each Document,” on page 79.


By default, the value is 31457280.


doc.max.text.extraction.size.threshold Depending on your specific environment and need, 
you might need to modify this setting in addition to 
the lucene.max.fieldlength setting.


Designates the maximum size of a document that 
can be indexed in the Vibe site after the document 
has undergone file conversion. For more 
information, see Section 4.12.4, “Increasing the 
Number of Words That Are Indexed for Each 
Document,” on page 79.


By default, the value is 1048576 (about 1MB).


Setting Function
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 Porter (This is for the English language; this option simply indexes and searches in a different 
way.)


 Portuguese
 Romanian
 Russian
 Spanish
 Swedish
 Turkish


4.13 Understanding and Configuring Document Conversions 
with Stellent
Novell Vibe uses Stellent to perform document conversions. Documents undergo two types of 
conversions:


 Word conversion when they are first added to the Vibe site
 HTML conversion when they are viewed as HTML from the Vibe site


You can enable additional file formats to be indexed or viewed as HTML.


If Stellent is crashing with certain file types during either of the conversion processes, you can 
exclude the problematic file types from being indexed to the Vibe site or viewed as HTML from the 
Vibe site.


 Section 4.13.1, “Configuring Which File Formats Can Be Viewed as HTML,” on page 85
 Section 4.13.2, “Excluding File Types from Being Indexed or Displaying as HTML,” on page 86


4.13.1 Configuring Which File Formats Can Be Viewed as HTML


Many file formats in Novell Vibe can be viewed as HTML by default, as described in “Viewing the 
File in HTML Format” in “Working with Folder Entries” in the Novell Vibe 3.2 User Guide. Examples of 
file formats that can be viewed as HTML by default are .doc, .docx, .txt, and so forth. (A complete 
list is given in the ssf.properties file, as described later in this section.)


Some file formats, such as .pdf files, cannot be viewed as HTML by default. This is because the 
quality of these files is lessened when viewed as HTML. However, if you choose, you can enable non-
default file formats, such as .pdf files, to be viewed as HTML.


Not all file formats can be enabled to be viewed as HTML in Vibe, but many can be. If you are unsure 
whether Vibe supports a particular file format to be viewed as HTML, try it and see. 


1 Change to the following directory:


2 Make a backup copy of the ssf-ext.properties file, which is located in the same directory as 
the ssf.properties file.


3 Open the ssf.properties file in a text editor.


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/WEB-INF/classes/config


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF\classes\config
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4 Search for the following line:


view.as.html.file.stellent.extensions=


5 Open the ssf-ext.properties file in a text editor.
6 Copy the view.as.html.file.stellent.extensions= line from the ssf.properties file to 


the bottom of the ssf-ext.properties file.
Ensure that you also copy all of the values of this line. For example, .123, .bmp, .db, and so 
forth. These are the file formats that can be viewed as HTML by default.


7 Add the file extension that you want to enable to be viewed as HTML to the list of existing file 
extensions, or remove the file extension that you want to exclude from being viewed as HTML 
from the list of existing file extensions. 


8 Save and close the ssf-ext.properties file.
9 Close the ssf.properties file without saving it.


10 Stop and restart Vibe.


4.13.2 Excluding File Types from Being Indexed or Displaying as HTML


If Stellent is crashing with certain file types during either of the conversion processes, you can restrict 
the problematic file types from being converted.


In order to determine if Stellent is crashing during word conversion or HTML conversion, you need 
to carefully examine the server log file. After you determine where Stellent is crashing, continue with 
the appropriate section:


 “Excluding File Types from Being Indexed to the Vibe Site” on page 86
 “Excluding File Types from Being Displayed in HTML” on page 87


Excluding File Types from Being Indexed to the Vibe Site


If you are experiencing crashes during this HTML conversion process with certain files, you can 
exclude the problematic file types from being converted. These file types can then no longer be 
viewed in HTML.


IMPORTANT: Performing the following procedure causes the file types that you specify to be 
excluded from searches performed in Vibe.


1 Change to the following directory:


2 Open the ssf.properties file in a text editor.
3 Search for the following line:


exclude.from.stellent.indexing.extensions=


4 Make a backup copy of the ssf-ext.properties file, which is located in the same directory as 
the ssf.properties file.


5 Open the ssf-ext.properties file in a text editor.


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/WEB-INF/classes/config


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF\classes\config
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6 Copy the exclude.from.stellent.indexing.extensions= line from the ssf.properties file 
to the bottom of the ssf-ext.properties file.


7 Add the file types that are causing OpenOffice to crash to be the value of this property. For 
example, exclude.from.stellent.indexing.extensions=.pptx,.odf


8 Save and close the ssf-ext.properties file.
9 Close the ssf.properties file without saving it.


10 Stop and restart Vibe.


Excluding File Types from Being Displayed in HTML


You can display files in HTML view as described in “Viewing the File in HTML Format” in “Working 
with Folder Entries” in the Novell Vibe 3.2 User Guide. If OpenOffice crashes during this HTML 
conversion process with certain files, you can exclude the problematic file types from being 
converted. These file types can then no longer be viewed in HTML. For information on how to 
exclude file types from displaying in HTML, see Section 4.13.1, “Configuring Which File Formats 
Can Be Viewed as HTML,” on page 85.


4.14 Enabling ZIP Files That Contain Extended or Double-Byte 
Characters in the Filename to Be Downloaded
By default, when Vibe 3 or later is used to create a ZIP file with files that contain double-byte 
characters in the filename, the filenames for the downloaded files are displayed as _file1, _file2, 
_file3, etc. This is because the Java ZIP file facility is not capable of creating filenames that contain 
double-byte characters.


The files within Vibe remain unchanged.


To help fix this issue, you can leverage the org.apache.tools.zip facility by modifying settings on your 
Vibe server that determine the character encodings that Vibe uses when files are downloaded.


NOTE: This workaround is effective only when the following conditions are met:


 The system encoding of both the Vibe server and the client system are the same. For example, 
both are UTF-8.


 The unzip utility used to unzip the file uses the same encoding that was used to zip the file. For 
example, on SLES 11, you must use the unzip -S command to unzip the file.


To modify the necessary settings on your Vibe server:


1 Change to the following directory:


2 Open the ssf.properties file in a text editor.
3 Search for the following line:


encode.zip.download.filenames=false


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/WEB-INF/classes/config


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF\classes\config
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4 Make a backup copy of the ssf-ext.properties file, which is located in the same directory as 
the ssf.properties file.


5 Open the ssf-ext.properties file in a text editor.
6 Copy the encode.zip.download.filenames=false line from the ssf.properties file to the 


bottom of the ssf-ext.properties file.
7 Change the value of this property from false to true, so that it now reads as follows:


encode.zip.download.filenames=true


8 Open the ssf.properties file in a text editor if it is not already.
9 Search for the following line:


encode.zip.download.filename.encoding=cp437


10 Copy the encode.zip.download.filename.encoding=cp437 line from the ssf.properties 
file to the bottom of the ssf-ext.properties file.


11 Change the value of this property from cp437 to whatever type of encoding is used by your 
operating system. For example, utf-8. The line should now read as follows:


encode.zip.download.filename.encoding=encoding


12 Save and close the ssf-ext.properties file.
13 Close the ssf.properties file without saving it.
14 Stop and restart Vibe.
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5 5Setting Up User Access to the Vibe Site


Adding existing users to your new Novell Vibe site was part of the installation process, as described 
in “Adding Vibe Users from Your LDAP Directory” in “Basic Installation” in the Novell Vibe 3.2 
Installation Guide.


However, as time passes, you need to add new users. Depending on the needs of your Vibe site, you 
might want to allow people to access the site even if they do not have Vibe user accounts in the Vibe 
system. 


 Section 5.1, “Adding New Users to Your Vibe Site,” on page 89
 Section 5.2, “Creating Groups of Users,” on page 89
 Section 5.3, “Restricting Groups of Users from Seeing One Another,” on page 91
 Section 5.4, “Allowing Guest Access to Your Vibe Site,” on page 92
 Section 5.5, “Allowing Users Limited External Access to Your Vibe Site,” on page 97
 Section 5.6, “Allowing Web Crawler Access to Your Vibe Site,” on page 97
 Section 5.7, “Managing Mobile Device Access to Your Vibe Site,” on page 97


5.1 Adding New Users to Your Vibe Site
You can add new users to your Vibe site in any of the following ways:


 Synchronizing from an LDAP directory, as described in Section 18.1, “Synchronizing Users and 
Groups from an LDAP Directory,” on page 149.


 Manually adding local users, as described in Section 5.1, “Adding New Users to Your Vibe Site,” 
on page 89.


 Importing profile files for local users, as described in Section 18.7, “Managing Local Users and 
Groups by Importing Profile Files,” on page 158.


5.2 Creating Groups of Users
You might have chosen to synchronize groups of users from your LDAP directory to your Novell 
Vibe site, as described in “User Synchronization Options” in “Basic Installation” in the Novell Vibe 3.2 
Installation Guide.


You can use existing groups or create additional groups within Vibe to facilitate access control on 
your Vibe site. For background information on access control, see “Controlling Access” in the Novell 
Vibe 3.2 Advanced User Guide. 


In addition to creating groups to assist with access control, you might want to create groups for any 
of the following reasons:


 To facilitate team creation, as described in “Creating a Team Workspace” in “Getting Started” in 
the Novell Vibe 3.2 User Guide.
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 To facilitate managing data quotas, as described in Section 20.4, “Managing User Data Quotas,” 
on page 173.


 To facilitate user visibility restrictions, as described in Section 5.3, “Restricting Groups of Users 
from Seeing One Another,” on page 91.


 To create multiple Vibe administrators, as described in Section 1.2, “Creating Additional Vibe 
Administrators,” on page 16.


Users are responsible for access control in their personal workspaces and any team workspaces that 
they create. As the Vibe site administrator, you are responsible for access control in public locations 
such as global workspaces. By creating groups of users who have attributes in common, you and 
other Vibe users can set access controls and create teams without listing users individually. Groups 
can be nested within groups, so create small groups first, then build larger groups from your smaller 
groups.


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 Under Management, click Groups then click Add a New Group.


4 Fill in the fields:
Group Name: Specify the unique name under which the group is stored in the Vibe database. 
The first character must be an alphabetic character (a-z, A-Z). For the rest of the name, you can 
use alphanumeric characters (a-z, A-Z, 0-9), hyphens (-), and underscores (_). 
Group Title: Specify the group name that displays to users on the Vibe site. This string can 
include any characters that you can type.
Group Description: Describe what the members of this group have in common.


5 Click Add to create the group.
6 Click the new group in order to add users to it.
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7 In the Users field, start typing the first or last name of a user.
A drop-down list displays possible matches.


8 Click a user to add the user to the group.
9 Repeat Step 7 and Step 8 for each user you want to add to the group.


After you have created one or more small groups, you can use the Groups field to create larger 
groups from smaller groups. Also, if there’s a place in your Vibe site that displays users that you 
want to create a group for, you can collect the users on the Vibe clipboard, as described in 
“Using the Vibe Clipboard” in “Connecting With Your Co-Workers” in the Novell Vibe 3.2 User 
Guide, then use Clipboard User Names to add the users on the Vibe clipboard to the group that you 
are creating.


10 When you are finished adding users to the group, click Apply > Close.


5.3 Restricting Groups of Users from Seeing One Another
If your Novell Vibe site has multiple sets of users who need to remain hidden from each other, you 
can use access controls to restrict users who belong to a specific group from seeing users who do not 
belong to the group. For example, you might want to do this if your Vibe site contains users from 
more than one company and you want users to see only the users who belong to the same company.


You accomplish this by setting zone-level access controls on individual users or groups of users, 
limiting them to seeing only those users with whom they share a common group.


When you restrict groups of users from seeing one another in your Vibe site, you see the following 
behaviors:


 When users search for people in the Vibe site, they do not see the users they are restricted from 
seeing.


 By default, users cannot see the personal workspaces of users they are restricted from seeing. 
However, individual users can modify the access control settings of their personal workspaces to 
grant access to users who are restricted from seeing them. Users can do this by granting access to 
other groups.


 The Vibe site might contain folders and entries that are open to a wider audience, such as in a 
global workspace. If a restricted user has access to one of these folders, and an entry is posted by 
someone the user is not allowed to see, the name of the entry creator is hidden. The name is also 
hidden from the restricted user wherever else it might appear, such as in the Left Navigation 
pane or on the Search Results page.
For example, User B is restricted from seeing User A. when User A posts an entry in a global 
workspace, User B can see the entry but cannot see User B’s name on the entry.

Setting Up User Access to the Vibe Site 91







To restrict groups of users from seeing one another:


1 Create a group for each set of users that you want to keep separate. For example, create groups 
called Company A, Company B, and Company C. 
For information about how to create a group, see Section 5.2, “Creating Groups of Users,” on 
page 89.


2 Populate each group with the appropriate users.
For information about how to populate groups with users, see Section 5.2, “Creating Groups of 
Users,” on page 89.


3 Navigate to the Administration page and add the groups to the Can Only See Members of Groups I 
Am In role.
If you want to allow certain members of a group to retain their ability to see users that belong to 
groups outside of their own, you can add these specific users to the Override “Can Only See 
Members of Groups I Am In” role.
For more information about these roles as well as other roles, see “Understanding Default 
Workspace and Folder Roles” on page 24.
For information about how to add users and groups to a specific role, see Section 2.3.2, 
“Assigning a User to a Role,” on page 26.


IMPORTANT: Do not create a group that contains users who you want to hide from each other. For 
example, if your Vibe site has users from Company A and Company B, you should not create a single 
group that contains users from both Company A and Company B. Users who belong to a common 
group are able to see each other, regardless of any access controls that are set on other groups. If you 
must create a single group of users from multiple companies, first create a sub-group for each 
company so you can keep users’ names separate from each other.


5.4 Allowing Guest Access to Your Vibe Site
When a person arrives at the Novell Vibe site URL, the person is considered to be a Guest user on the 
site, as indicated by the username displayed in the upper right corner of the page:


This page is also the main Vibe login page. Users with Vibe usernames can log in to their personal 
workspaces, and from there they can access any other locations where they have been granted access. 


NOTE: Guest access is not possible if you are using Novell Access Manager to provide single sign-on 
functionality. For more information about Novell Access Manager, see “Configuring Single Sign-On 
with Novell Access Manager” in “Advanced Installation and Reconfiguration” in the Novell Vibe 3.2 
Installation Guide.


 Section 5.4.1, “Understanding the Guest User,” on page 93
 Section 5.4.2, “Setting Up Guest Access for the Vibe Site,” on page 93
 Section 5.4.3, “Configuring Any Workspace to Be the Default Home Page for Guest Users,” on 


page 95
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 Section 5.4.4, “Enabling Individual Users to Grant Guest Access throughout the Vibe Site,” on 
page 96


 Section 5.4.5, “Monitoring Guest User Access,” on page 96


5.4.1 Understanding the Guest User


As the administrator, you can choose whether you want people who do not have Vibe usernames to 
be able to access information on the Vibe site as the Guest user. 


For example, a government organization such as a city might give Vibe user accounts only to key city 
knowledge workers. However, it is critical that other city workers and regular citizens also access the 
site to see a listing of upcoming events, read city news, report complaints, and so forth. As a Vibe 
administrator, you can use the Guest User workspace as a place to present information to non-
registered Vibe users.


When people visit your Vibe site as the Guest user, they can have some or all of the following 
experiences, depending on the access controls that you set for the Guest user:


 Any user who knows the Vibe site URL can access the Guest workspace.
 The Relevance Dashboard in the Guest workspace displays only the information that the Guest 


user has been specifically granted access to see.
 A Guest user can find out what is accessible on the Vibe site by clicking the Search Options icon 


, selecting Places, then pressing the Spacebar.
 If a Guest user uses the Search feature, the only information returned is information that the 


Guest user has been granted access to see.
 When a Guest user adds a folder entry, the entry form requests the user’s name and e-mail 


address. This information is displayed like a signature when the folder entry is viewed. 
Providing the name and e-mail address is optional.


 If you grant Participant rights to the Guest user, people who access the Vibe site as the Guest 
user can modify and delete entries and comments posted by other people who have accessed the 
Vibe site as the Guest user.


5.4.2 Setting Up Guest Access for the Vibe Site


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 Under System, click Configure Guest Access.


4 Make sure that Allow Guest Access is selected, then click Close.
Even though this option is selected by default, the Guest workspace is initially inaccessible 
because the default user access control settings do not allow access. 
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5 Click Close again to close the Administration page.
6 Click the Workspace tree icon, expand Home Workspaces, then click Personal Workspaces.
7 Begin typing Guest in the Entry field, then click it in the drop-down list.


The Guest user’s personal workspace is displayed.
8 Set the user access control settings on the Guest user’s workspace:


8a Click Workspace > Access Control.


8b Change the user access control settings as needed:
Workspace Owner: By default, the Vibe site administrator owns the Guest user’s 
workspace. Click Edit to specify a new owner, select whether this change applies to folders 
under the Guest user’s workspace, then click OK.
Role Membership Inheritance By default, role membership is not inherited. Keep this 
setting.


9 Add the roles that you want the Guest user to be able to perform in the Guest workspace:
9a Click Add a User, start typing Guest in the Add a User field, then click Guest when it appears 


in the drop-down list.
This adds Guest as a new row in the Access Control table.


9b Select one or more roles that you want the Guest user to be able to perform on the Guest 
User workspace. For example:
Visitor: The Guest user can read entries and add comments or replies in folders in the 
Guest user workspace.
Participant: In addition to Visitor activities, the Guest user can also create new entries, and 
modify or delete his or her own entries.
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For more information about the additional access control options, see “Controlling Access” 
in the Novell Vibe 3.2 Advanced User Guide.


9c Click Save Changes, then click Close.
Now, when people access the Vibe site who do not have usernames, they are admitted as a 
Guest user and see the What’s New page (only items that the Guest user has access to see 
are visible). Guest users can also access the Guest User workspace by clicking My 
Workspace.


10 Set up the Guest user’s personal workspace with whatever information you want to present to 
people who visit your Vibe site without logging in.
For general suggestions on creating useful workspaces, see “Creating Custom Workspace 
Views” in the Novell Vibe 3.2 Advanced User Guide.


11 (Conditional) If you want the Guest user to be able to access content elsewhere on the Vibe site, 
add the Guest user to the Configure Access Control page for those workspaces or folders.
You can also enable specific Vibe users in addition to the Vibe administrator to grant Guest 
access to locations in your Vibe site, as described in Section 5.4.4, “Enabling Individual Users to 
Grant Guest Access throughout the Vibe Site,” on page 96.


12 Notify people who might be interested in accessing your Vibe site about your Vibe site URL.
13 (Conditional) If you want information on your Vibe site to be searchable on the Internet, see 


Section 5.6, “Allowing Web Crawler Access to Your Vibe Site,” on page 97.


5.4.3 Configuring Any Workspace to Be the Default Home Page for Guest 
Users


If you’re not satisfied with the What’s New page being the default home page for guest users, you can 
configure the Guest User workspace or a different workspace to be the default home page, giving you 
complete control over what guest users see when they first access the Vibe site.


For information on how to change the default home page for guest users, see Section 4.3.2, “Setting a 
Default Home Page for Guest Users,” on page 64.
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5.4.4 Enabling Individual Users to Grant Guest Access throughout the Vibe 
Site


If you want users in addition to the Vibe administrator to be able to grant Guest access to locations in 
your Vibe site:


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 Under System, click Access Control for Zone Administration.


A basic Vibe site consists of a single zone. Novell Vibe allows you to set up multiple zones in a 
single Vibe site. This feature is not available in Kablink Vibe. For more information about zones, 
see Chapter 16, “Setting Up Zones (Virtual Vibe Sites),” on page 139. 


4 Click Add a User, start typing the user’s name, then select the user from the drop-down list to 
add the user to the Access Control table.


5 Select the check box in the Allow Adding Guest Access column.
6 Repeat Step 4 and Step 5 for each user who you want to be able to grant Guest access to locations 


on your Vibe site.
7 Click Save Changes, then click Close.
8 Notify the users who are allowed to grant Guest access.


5.4.5 Monitoring Guest User Access


As the Vibe site administrator, you can create a report of all locations on the Vibe site that the Guest 
user can access. For instructions, see Section 26.2.3, “User Access Report,” on page 219.
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5.5 Allowing Users Limited External Access to Your Vibe Site
Vibe enables you to restrict what information users can access when they are outside your corporate 
firewall. For more information, see Section 2.5, “Restricting Access Rights of Users Outside the 
Firewall,” on page 32.


5.6 Allowing Web Crawler Access to Your Vibe Site
If you allow Guest access to your Novell Vibe site, as described in Section 5.4, “Allowing Guest 
Access to Your Vibe Site,” on page 92, you can provide Internet search engines (such as Google) with 
the Vibe permalinks for workspaces and folders that you want to make publicly available on the 
Internet. A Vibe permalink is the complete URL that someone outside of your Vibe site and outside of 
your organization, such as a Web crawler (http://en.wikipedia.org/wiki/Web_crawler), could use to 
access a specific location on your Vibe site. 


1 To determine the permalink of a workspace, click Workspace Permalinks at the bottom of a 
workspace page.
or
To determine the permalink of a folder, click Folder Permalinks at the bottom of a folder page.


5.7 Managing Mobile Device Access to Your Vibe Site
By default, your Novell Vibe site allows mobile device access at one of the following URLs, 
depending on whether or not you are using a secure SSL connection:


http://vibe_hostname/mobile
https://vibe_hostname/mobile


In these URLs, vibe_hostname is the hostname or fully qualified domain name of the Vibe server 
that you have set up in DNS.


For a list of supported mobile devices, see “Supported Mobile Devices” in “Using Vibe on Your 
Mobile Phone” in the Novell Vibe 3.2 Advanced User Guide.


For instructions on using the mobile device interface to the Vibe site, see “Using Vibe on Your Mobile 
Phone” in the Novell Vibe 3.2 Advanced User Guide.


 Section 5.7.1, “Restricting Mobile Device Access to Your Vibe Site,” on page 97
 Section 5.7.2, “Configuring Mobile Device Access with Novell Access Manager,” on page 98


5.7.1 Restricting Mobile Device Access to Your Vibe Site


As the Vibe administrator, you can prevent mobile device access to your Vibe site if necessary.


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 Under System, click Configure Mobile Access.
4 Deselect Enable Mobile Access.
5 Click Apply, then click Close.
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5.7.2 Configuring Mobile Device Access with Novell Access Manager


To allow mobile device access to Vibe through Novell Access Manager, you need to modify your 
protected resource in Novell Access Manager to allow a non-redirected login and to redirect the 
identity server when no authentication header is provided.


Follow the steps in “Configuring an Authentication Procedure for Non-Redirected Login” in 
“Configuring the Access Gateway to Protect Web Resources” in the Novell Access Manager 3.1 SP3 
Access Gateway Guide.


When specifying the method for obtaining credentials, ensure that Non-Redirected Login and Redirect 
to Identity Server When No Authentication Header Is Provided are selected.
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6 6Allowing Access to the Vibe Site through 
Novell Access Manager


To allow access to the Vibe site through Novell Access Manager, you need to make configuration 
changes in Novell Access Manager to configure a protected resource for a Novell Vibe server as 
described in Section 6.1, “Configuring a Protected Resource for a Novell Vibe Server,” on page 99.


6.1 Configuring a Protected Resource for a Novell Vibe Server


NOTE: The instructions in this section assume that you are using Novell Access Manager 3.1 and 
Novell Vibe 3.2 with the latest support packs. Future versions of Novell Access Manager and Novell 
Vibe will require different configuration settings than described in this section.


The following sections explain how to configure the Access Gateway with a domain-base multi-
homing service. The instructions assume that you have a functioning Novell Vibe server on Linux 
and a functioning Access Manager system with a reverse proxy configured for SSL communication 
between the browsers and the Access Gateway.


The Vibe server needs to be configured to trust the Access Gateway to allow single sign-on with 
Identity Injection and to provide simultaneous logout. You also need to create an Access Gateway 
proxy service and configure it. 


 Section 6.1.1, “Configuring the Novell Vibe Server to Trust the Access Gateway,” on page 99
 Section 6.1.2, “Configuring a Domain-Based Multi-Homing Service for Novell Vibe,” on 


page 101


For information on other possible Access Gateway configurations, see “Teaming 2.0: Integrating with 
Linux Access Gateway” (http://www.novell.com/communities/node/9580/teaming-20-integration-
linux-access-gateway).


6.1.1 Configuring the Novell Vibe Server to Trust the Access Gateway


To use Novell Vibe as a protected resource of an Access Gateway and to use Identity Injection for 
single sign-on, the Vibe server needs a trusted relationship with the Access Gateway. With a trusted 
relationship, the Vibe server can process the authorization header credentials. The Vibe server 
accepts only a simple username (such as user1) and password in the authorization header.


This section explains how to set up the trusted relationship and how to enable simultaneous logout, 
so that when the user logs out of Vibe, the user is also logged out of the Access Gateway.


To configure the trusted relationship:


1 Log in to the Vibe server.
2 Stop the Vibe server with the following command:
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/etc/init.d/teaming stop


3  Run the installer-teaming.linux script.
4 Accept the license agreement, then select Reconfigure settings, then click Next.
5 Confirm that your Vibe server is shut down, then select Advanced installation, then click Next.
6 Continue through the installation program until you reach the Network Information page. 


Ensure that you have a valid Host name specified. You will need this later in the installation.


7 Continue through the installation program until you reach the Reverse Proxy Configuration 
page. Specify the following configuration options:
Enable Access Gateway: Select this option to enable the reverse proxy access gateway.
Access Gateway address(es): Specify the IP address of the Access Gateway that is used for the 
connection to the Vibe server.
If the Access Gateway is part of a cluster, add the IP address for each cluster member. Wildcards 
such as 164.99.*.* are allowed. 
When you specify IP addresses in this option, Vibe logins are allowed only from the specified 
addresses. Also, if Authorization header credentials are not present or are incorrect, the user is 
prompted for login using Basic Authentication.
Logout URL: Specify the URL of the published DNS name of the reverse proxy that you have 
specified for the ESP, plus /AGLogout.
You can find the domain used for the ESP by editing the LAG/MAG cluster configuration, then 
clicking Reverse Proxy / Authentication.
For example, if the published DNS name of the proxy service that you have specified for the ESP 
is esp.yoursite.com, specify the following URL:


https://esp.yoursite.com/AGLogout


Use Access Gateway for WebDAV connections: Leave this option unselected.
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8 Continue through the installation program to complete the reconfiguration process.
9 Start the Vibe server with the following command:


/etc/init.d/teaming start


10 Continue with “Configuring a Domain-Based Multi-Homing Service for Novell Vibe” on 
page 101.


6.1.2 Configuring a Domain-Based Multi-Homing Service for Novell Vibe


The following instructions describe how to set up a domain-based service to protect the Novell Vibe 
server. In this example, the published DNS name of the service is vibe.novell.com. Users would 
access the Vibe server with a URL similar to http://vibe.novell.com/vibe. The /vibe path is the 
default access path for the Vibe application.


To configure a domain-based service for Vibe, complete the following tasks:


 “Creating a New Reverse Proxy” on page 101
 “Configuring the Domain-Based Proxy Service” on page 102
 “Configuring Protected Resources” on page 102
 “Configuring a Rewriter Profile” on page 104


Creating a New Reverse Proxy


Before you can configure the domain-based proxy service, you need to create a new reverse proxy. 
For information on how to create a reverse-proxy, see “Managing Reverse Proxies and 
Authentication” in “Configuring the Access Gateway to Protect Web Resources” in the Novell Access 
Manager 3.1 SP3 Access Gateway Guide.
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Configuring the Domain-Based Proxy Service


1 In the Administration Console, click Devices > Access Gateways > Edit, then click the name of the 
reverse proxy that you created in “Creating a New Reverse Proxy” on page 101.


2 In the Reverse Proxy List, click New, then fill in the following fields:
Proxy Service Name: Specify a display name for the proxy service that the Administration 
Console uses for its interfaces.
Multi-Homing Type: Select Domain-Based. 
Published DNS Name: Specify the DNS name you want the public to use to access your site. 
This DNS name must resolve to the IP address you set up as the listening address. For example, 
vibe.novell.com.
Web Server IP Address: Specify the IP address of the Vibe server.
Host Header: Select the Forward received host name.
Web Server Host Name: Because of your selection in the Host Header field, this option is 
dimmed.


3 Click OK.
4 Click the newly added proxy service, then select the Web Servers tab.
5 Change the Connect Port to 8080.


If the Vibe server has port forwarding enabled, you do not need to change from the default port 
80.


6 Click TCP Connect Options.
7 Change the value of Data Read Timeout option to 300 seconds (5 minutes). 
8 Click OK.
9 Continue with “Configuring Protected Resources” on page 102.


Configuring Protected Resources


You need to create two protected resources, one for HTML content and one for WebDAV and AJAX 
content.


1 In the Administration Console, click Policies > Policies. 
2 Select the policy container, then click New.
3 Specify a name for the policy, select Access Gateway: Identity Injection for the type, then click OK.
4 (Optional) Specify a description for the injection policy. This is useful if you plan to create 


multiple policies to be used by multiple resources.
5 In the Actions section, click New, then select Inject into Authentication Header.
6 Fill in the following fields: 


User Name: Select Credential Profile > LDAP User Name. 
Password: Select Credential Profile > LDAP Password.


7 Click OK.
8 To save the policy, click OK, then click Apply Changes.


For more information on creating such a policy, see “Configuring an Authentication Header 
Policy” in the Novell Access Manager 3.1 SP4 Policy Guide.
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9 Assign this policy to the protected resources:
9a Click Access Gateways > Edit > [Name of Reverse Proxy] > [Name of Proxy Service] > Protected 


Resources.
9b For each Vibe protected resource, click the Identity Injection link, select the Identity Injection 


policy, click Enable, then click OK.
9c Click OK.
9d To save the configuration changes, click Devices > Access Gateways, then click Update.


10 Create a protected resource for HTML content:
10a In the Protected Resource List, click New, specify a name, then click OK.
10b (Optional) Specify a description for the protected resource. You can use it to briefly describe 


the purpose for protecting this resource.
10c Specify a value for Authentication Procedure. For example, select the Secure Name/Password - 


Form contract.
10d Click OK.


11 Create a protected resource for WebDAV and AJAX content:
11a In the Protected Resource List, click New, specify a unique name, then click OK.
11b (Optional) Specify a description for the protected resource. You can use it to briefly describe 


the purpose for protecting this resource.
11c Click the Edit Authentication Procedure icon. 
11d In the Authentication Procedure List, click New, specify a name, then click OK.
11e Fill in the following fields:


Contract: Select the Secure Name/Password - Form contract, which is same contract that you 
selected for the HTML content protected resource.
Non-Redirected Login: Select this option.
Realm:  Specify a name that you want to use for the Vibe server. This name does not 
correspond to a Vibe configuration option. It appears when the user is prompted for 
credentials.
Redirect to Identity Server When No Authentication Header is Provided: Select this 
option.


11f Click OK twice.
11g For the Authentication Procedure, select the procedure you just created.
11h In the URL Path List, remove the /* path and add the following paths:


/ssfs/*
/ssf/atom/*
/ssf/ical/*
/ssf/ws/*
/ssf/rss/*
/ssr/* 
/rest/*


The /ssfs/* path is for WebDAV content and the /ssf/rss/* path enables non-
redirected login for RSS reader connections. Vibe provides authentication for all of the 
paths listed above.


11i Click OK.
12 In the Protected Resource List, ensure that the protected resources you created are enabled.
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13 To apply your changes, click Devices > Access Gateways, then click Update.
14 Continue with “Configuring a Rewriter Profile” on page 104.


Configuring a Rewriter Profile


1 In the Administration Console, click Devices > Access Gateways > Edit > [Name of Reverse Proxy] > 
[Name of Proxy Service] > HTML Rewriting.


2 In the HTML Rewriter Profile List, click New.
3 Specify a name for the profile, select Word as the search boundary, then click OK.
4 In the And Document Content-Type Header Is section, click New, then specify the following type:


application/rss+xml


5 In the Variable or Attribute Name to Search for Is section, click New, then specify the following as 
the variable to search for:


value


6 Click OK.
7 Make sure that Enable Rewrite Actions remains selected. 
8 Click OK.
9 In the HTML Rewriter Profile List, move the Word profile you created to be the first profile in the 


list, and move the default profile to be the second profile in the list.
10 Click OK.
11 To apply your changes, click Devices > Access Gateways, then click Update.
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7 7Configuring Vibe to Support WebDAV on 
Windows 7


WebDAV is a standard collaborative editing and file management protocol. Novell Vibe relies on the 
WebDAV protocol to operate two key features:


 Edit-in-Place functionality for files by using tools such as OpenOffice and Microsoft Office, as 
described in “Using WebDAV to Edit Individual Files” in the Novell Vibe 3.2 Advanced User Guide.


 Map Vibe folders as a Web folder on the client computer, which allows access to Vibe files from 
a WebDAV-compliant file navigation tool such as Windows Explorer or Nautilus, as described in 
“Creating a Mapped Drive to the Vibe Folder” in the Novell Vibe 3.2 Advanced User Guide.


If your Vibe users are running a supported client operating system other than Windows 7, features 
that are supported by WebDAV already work as described in “Setting Up and Using WebDAV” in the 
Novell Vibe 3.2 Advanced User Guide without any additional configuration.


The information in this section assumes that your environment requires the use of Microsoft Office. If 
your environment does not require the use of Microsoft Office, see Section 7.1.4, “Using OpenOffice 
as Your Document Editor for WebDAV,” on page 107.


 Section 7.1, “Planning Your WebDAV Implementation,” on page 105
 Section 7.2, “Editing Files with Edit-in-Place Functionality,” on page 107
 Section 7.3, “Mapping a Vibe Folder as a WebDAV Folder,” on page 107
 Section 7.4, “Configuring Windows 7 to Use a Self-Signed Certificate with Vibe,” on page 108
 Section 7.5, “Allowing Basic Authentication over an HTTP Connection on Windows 7,” on 


page 109


7.1 Planning Your WebDAV Implementation
 Section 7.1.1, “Understanding the Different Types of WebDAV Authentication Methods,” on 


page 105
 Section 7.1.2, “Using WebDAV When Vibe Is Fronted by Novell Access Manager or IIS,” on 


page 106
 Section 7.1.3, “Meeting Vibe Certificate Requirements on Windows 7,” on page 106
 Section 7.1.4, “Using OpenOffice as Your Document Editor for WebDAV,” on page 107


7.1.1 Understanding the Different Types of WebDAV Authentication Methods


Novell Vibe supports the following WebDAV authentication methods:


 Basic Authentication: Username and password are encoded with the Base64 algorithm. The 
Base64-encoded string is unsafe if transmitted over HTTP, and therefore should be combined 
with SSL/TLC (HTTPS).
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For more information, see “Choosing Basic Authentication” in the Novell Vibe 3.2 Installation 
Guide.


If you plan to use Basic authentication over a non-secure connection (HTTP), you need to modify 
the registry on each Windows 7 client workstation, as described in Section 7.5, “Allowing Basic 
Authentication over an HTTP Connection on Windows 7,” on page 109. The registry 
modification allows users to use WebDAV with Microsoft Office 2007. However, Microsoft 
Office 2010 is not supported.


 Digest Authentication: Applies MD5 cryptographic, one-way hashing with usage of nonce 
values to a password before sending it over the network. This option is more safe than Basic 
Authentication when used over HTTP.
For more information, see “Choosing Digest Authentication” in the Novell Vibe 3.2 Installation 
Guide.


 Windows Authentication: Provides Windows users with a single sign-on experience, enabling 
users to automatically authenticate to Vibe after they are logged in to their individual 
workstations. Internet Information Services (IIS) provides this capability.
For more information, see “Choosing Windows Authentication” in the Novell Vibe 3.2 Installation 
Guide.


7.1.2 Using WebDAV When Vibe Is Fronted by Novell Access Manager or IIS


If your Vibe system is fronted by either Novell Access Manager or Internet Information Services (IIS), 
you must use the designated WebDAV authentication method:


7.1.3 Meeting Vibe Certificate Requirements on Windows 7


If you are using WebDAV functionality (either Edit-in-Place or mapping a Vibe folder) with Vibe on 
Windows 7 with a secure (HTTPS) connection, you need to ensure that the Vibe server certificate 
requirements are met. If all of the requirements are not met, various Windows 7 services fail.


The Vibe server certificate requirements are:


 You must use a trusted server certificate that is accepted by Windows 7. This server certificate 
must be signed by a trusted certificate authority (CA) such as VeriSign or Equifax.


Product Fronting Vibe Designated Authentication Method


Novell Access Manager If your Vibe installation is fronted by Novell Access Manager, as 
described in “Configuring Single Sign-On with Novell Access 
Manager” in the Novell Vibe 3.2 Installation Guide, you must use 
basic authentication for your WebDAV implementation


In the Vibe installation program, select basic on the WebDAV 
Authentication Method page.


Internet Information Services (IIS) If your Vibe installation is fronted by IIS, as described in “Configuring 
Single Sign-On with Internet Information Services for Windows” in 
the Novell Vibe 3.2 Installation Guide, you must use Windows 
authentication for your WebDAV implementation.
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NOTE: You can use a self-signed certificate only if the certificate is imported into the Trusted 
Root Certification Authorities store on each Windows 7 client computer. For specific information 
on how to accomplish this, see Section 7.4, “Configuring Windows 7 to Use a Self-Signed 
Certificate with Vibe,” on page 108


 The trusted server certificate must be issued to a name that exactly matches the domain name of 
the URL that you are using it for. This means that it must match the URL of your Vibe site.


 The date range for the trusted server certificate must be valid. You cannot use an expired server 
certificate.


7.1.4 Using OpenOffice as Your Document Editor for WebDAV


If your environment does not require the use of Microsoft Office, you might consider migrating users 
to OpenOffice 3.1 or later as their document editor. Using OpenOffice 3.1 or later provides seamless 
integration between the WebDAV server and Vibe, regardless of which operating system is being 
used.


7.2 Editing Files with Edit-in-Place Functionality
You can leverage Edit-in-Place functionality to edit files by using tools such as OpenOffice and 
Microsoft Office. For information on how to edit files in Vibe with Edit-in-Place functionality, see 
“Using WebDAV to Edit Individual Files” in the Novell Vibe 3.2 Advanced User Guide.


If you are using Edit-in-Place functionality over HTTP, no additional setup is required. However, if 
you are using Edit-in-Place functionality over HTTPS on Windows 7, ensure that you have met the 
Vibe server certificate requirements, as described in Section 7.1.3, “Meeting Vibe Certificate 
Requirements on Windows 7,” on page 106.


7.3 Mapping a Vibe Folder as a WebDAV Folder
Mapping a Novell Vibe folder as a WebDAV folder on the client computer allows access to Vibe files 
from a WebDAV-compliant file navigation tool such as Windows Explorer or Nautilus. For 
information on how to map a Vibe folder, see “Creating a Mapped Drive to the Vibe Folder” in the 
Novell Vibe 3.2 Advanced User Guide.


When you map a Vibe folder as a WebDAV folder on Windows 7, consider the following:


 Successfully mapping a Vibe folder does not ensure that the Edit-in-Place feature on single files 
also works, as described in “Using WebDAV to Edit Individual Files” in the Novell Vibe 3.2 
Advanced User Guide.


For example, if you map a Vibe folder using Basic Authentication over HTTP (with the required 
registry change to the client computer), then attempt to edit a file in Microsoft Office 2010, it fails 
to open the file because Microsoft Office 2010 does not work with Basic Authentication over 
HTTP.


 When you map a Vibe folder and your Vibe server is configured with Windows Authentication, 
you expect the client computer to automatically supply your Windows login credentials to the 
server. However, because of a problem in Windows 7, users might be prompted to enter their 
credentials when accessing the Vibe server.
To fix this problem, modify the registry on each Windows 7 client computer, as instructed in an 
article on the Microsoft Support Page (http://support.microsoft.com/Default.aspx?id=943280).
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 When you map a Vibe folder and your Vibe server is configured with Windows Authentication, 
an error might occur saying that there’s been a problem with Windows Shell Web services, and 
the process fails.
To fix this problem, modify the registry on each Windows 7 client computer, as instructed in an 
article on the Microsoft Support Page (http://support.microsoft.com/Default.aspx?id=943280).


 When mapping a Vibe folder over HTTPS, you must ensure that all Vibe server certificate 
requirements are met, as described in Section 7.1.3, “Meeting Vibe Certificate Requirements on 
Windows 7,” on page 106.


7.4 Configuring Windows 7 to Use a Self-Signed Certificate 
with Vibe
Configuring Windows 7 to use a self-signed certificate with Novell Vibe is a two-step process. The 
first step is accomplished by the Vibe administrator on the Vibe server, and the second step is 
accomplished by each Vibe user on his or her Windows 7 workstation.


 Section 7.4.1, “Administrator Configuration Responsibilities,” on page 108
 Section 7.4.2, “User Configuration Responsibilities,” on page 108


7.4.1 Administrator Configuration Responsibilities


1 Ensure the following prerequisites are met in order to configure Windows 7 to use a self-signed 
certificate with Vibe:
 The self-signed server certificate must be issued to a name that exactly matches the domain 


name of the URL that you use it for. This means that it must match the URL of your Vibe 
site. If you are generating a self-signed certificate using the keytool, as described 
“Importing the Certificate Files into the Vibe Keystore” on page 260, you must enter the 
Vibe domain name when prompted for your first and last name.


 The date range for the trusted server certificate must be valid. You cannot use an expired 
server certificate.


7.4.2 User Configuration Responsibilities


Each user on his or her Windows 7 workstation must import the self-signed certificate of the Vibe 
server into the Trusted Root Certification Authorities store.


In a controlled corporate environment where the system administrator sets up each client 
workstation before use, this certificate can be preinstalled on each Windows 7 workstation. This can 
minimize end-user error and frustration.


1 Launch the Internet Explorer browser.
2 Click Tools > Internet Options to display the Internet Options dialog box.
3 Click the Security tab, then select Trusted sites.
4 Click Sites.
5 In the Add this website to the zone field, specify the URL of the Vibe Web site, then click Add > 


Close.
6 Browse to your Vibe site.
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7 (Conditional) If a prompt displays indicating that there is a problem with this Web site’s security 
certificate, complete the following steps: 
7a Click Continue to this website (not recommended).
7b Click Certificate Error at the right of the address bar, then click View certificates.
7c Click Install Certificate, then click Next in the wizard.
7d Select Place all certificates in the following store.
7e Click Browse, browse to and select Trusted Root Certification Authorities, then click OK.
7f In the wizard, click Next, then click Finish.


7g (Conditional) If a Security Warning dialog box displays, click Yes.
7h Click OK to close the Certificate Import Wizard.
7i Click OK to close the Certificate window.
7j Shut down all instances of the Internet Explorer browser, then restart the browser.


7k Browse to the Vibe site. You should no longer see the certificate error message.
If you continue to see the certificate error message, the server’s self-signed certificate might 
not match the site URL, as described in Section 7.4.1, “Administrator Configuration 
Responsibilities,” on page 108.


7.5 Allowing Basic Authentication over an HTTP Connection on 
Windows 7
You can modify the Windows registry to allow Basic authentication to WebDAV over an HTTP 
connection. This registry change allows users to use Microsoft Office 2007 on the Windows 7 
operating system, but does not allow them to use Microsoft Office 2010. Microsoft Office 2010 is not 
supported with Basic Authentication over an HTTP connection.


To modify the Windows registry:


1 On each Windows 7 workstation, click Start > Run, then specify regedit in the Open field.
2 Click OK.
3 In the Registry Editor window, navigate to the following registry entry:


\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlset\services\WebClient\Parameters\Bas
icAuthLevel


4 Change the value of this registry entry to 2.
5 Navigate to the Services interface, then restart the WebClient service.
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8 8Configuring E-Mail Integration


Initial e-mail configuration is performed when you install Novell Vibe. Additional aspects of e-mail 
handling are configured on the Vibe site. For information about how to further configure e-mail 
settings beyond what is covered in this section, see Chapter 23, “Managing E-Mail Configuration,” 
on page 197.


 Section 8.1, “Enabling/Disabling Outbound E-Mailing of Folder Digests,” on page 111
 Section 8.2, “Disabling/Enabling Inbound E-Mail Postings,” on page 112


8.1 Enabling/Disabling Outbound E-Mailing of Folder Digests
During installation, you configured Novell Vibe to communicate with your e-mail system, as 
described in “Gathering Outbound E-Mail Information” in “Basic Installation” in the Novell Vibe 3.2 
Installation Guide. As a result, Vibe users can send e-mail messages to other Vibe users and to anyone 
whose e-mail address they know. They can also send e-mail notifications when they create 
workspaces, add folder entries, and so on.


In addition to this basic e-mail functionality, you can configure your Vibe site so that users can 
receive folder digests of site activity that are created and sent to the users who have subscribed to the 
folders.


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Administration icon  in the upper right corner of the page.
3 Under System, click Configure E-Mail.
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4 Select Enable Outgoing E-Mail.
By default, folder digests are compiled and sent daily at fifteen minutes after midnight.


5 Adjust the schedule as needed to meet the needs of the majority of your Vibe users.
Users can turn the digests on and off for individual folders, but they cannot change the e-mail 
schedule that you establish.


6 Click Apply to save the settings, then click Close.


For information about the options that users have for receiving e-mail notifications, see “Subscribing 
to a Folder or Entry” in “Getting Informed” in the Novell Vibe 3.2 User Guide.


8.2 Disabling/Enabling Inbound E-Mail Postings
During installation, you configured Novell Vibe to include an internal SMTP mail host for receiving 
e-mail postings to folders, as described in “Enabling Inbound E-Mail” in “Basic Installation” in 
theNovell Vibe 3.2 Installation Guide. Your selection during installation carries over into the 
configuration of your Vibe site. Therefore, you can disable incoming e-mail if necessary, and then 
enable it again on the Vibe site. Relaying is permanently disabled on the internal SMTP mail host.


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 Under System, click Configure E-Mail.


4 Select or deselect Enable Incoming E-Mail Using the Embedded E-Mail Server and Simple URLs.
5 Click Apply > Close to save the setting.


For information about how to configure folders to receive e-mail postings, see “Enabling Folders to 
Receive Entries through E-Mail” in “Managing Folders” in the Novell Vibe 3.2 Advanced User Guide. 
Failed e-mail postings are listed in the Tomcat log file. For background information about the Tomcat 
log file, see Section 26.3.2, “Tomcat Log File,” on page 228.
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9 9Configuring Weekends and Holidays


You can configure Novell Vibe to recognize weekends and holidays. Currently, the weekend and 
holiday schedule is used only in relation to task durations. If you have designated weekends and 
holidays as discussed in this section, task durations exclude these days when calculating task due 
dates. For example, a task with a duration of 10 days translates into two full weeks (assuming a two-
day weekend for each week). For more information about task durations, see “Working with Tasks 
Folders” in the Novell Vibe 3.2 User Guide.


NOTE: Configuring a weekend and holiday schedule or changing an existing weekend and holiday 
schedule does not immediately affect the due dates of existing tasks. Existing tasks are affected only 
after the due dates are recalculated, such as when a new task (that includes a task duration) is added 
to the Tasks folder where the existing tasks are located.


To configure weekends and holidays for your Vibe site:


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 Under System, click Configure Weekends and Holidays.


4 In the Weekend Days section, select the days that you want to designate as the weekend.
Days left unselected are considered regular workdays.


5 In the Holidays section, click in the field on the right, select the date that you want to make a 
holiday, then click Add.
To remove a date as a holiday, select the date in the field on the left, then click Delete.


6 Click Apply > Close.
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10 10Configuring Real-Time Communication 
Tools


From the Novell Vibe site, Vibe users can communicate with each other in various ways.


 Section 10.1, “Integrating Messenger with Vibe,” on page 115
 Section 10.2, “Integrating Skype with Vibe,” on page 116


10.1 Integrating Messenger with Vibe
Novell Vibe 3 and later enables you to integrate with Novell Messenger 2.2 and later. This integration 
displays a user’s Messenger presence information within Vibe. For information about where presence 
information is displayed in Vibe, see “Sending an Instant Message from within Vibe” in the Novell 
Vibe 3.2 User Guide.


When you click a user’s presence icon, the Profile Quick View is displayed, which enables you to 
send an instant message to the user, view the user’s personal workspace, follow the user, and more.


To successfully integrate Novell Messenger with Novell Vibe, you must complete the following tasks: 


 Section 10.1.1, “Defining an Allowed Service User in ConsoleOne,” on page 115
 Section 10.1.2, “Configuring Messenger Integrations in the Vibe Installation Program,” on 


page 115
 Section 10.1.3, “Configuring Presence,” on page 116


10.1.1 Defining an Allowed Service User in ConsoleOne


The Allowed Service User’s function is to log in to the Messenger system and retrieve presence 
information, which is then displayed in Vibe.


For information about how to create an Allowed Service User in ConsoleOne, see “Integrating Novell 
Vibe OnPrem with Novell Messenger” in the Novell Messenger 2.2 Administration Guide.


10.1.2 Configuring Messenger Integrations in the Vibe Installation Program


After you have defined an Allowed Service User in ConsoleOne, as described in “Integrating Novell 
Vibe OnPrem with Novell Messenger” in the Novell Messenger 2.2 Administration Guide, you need to 
run the Vibe installation program and configure Messenger.


For information about the presence configuration page in the Vibe installation program, see 
“Configuring Presence” in the Novell Vibe 3.2 Installation Guide.
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10.1.3 Configuring Presence


You should use LDAP to sync users with a directory service such as eDirectory in order to populate 
the Presence ID field in Vibe.


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 Under System, click Configure LDAP.
4 In the Users section, map the identifier presenceID to the LDAP attribute that identifies the user. 


For example, presenceID=cn.
5 Click Apply > Close.


10.2 Integrating Skype with Vibe
Novell Vibe enables Vibe users to use Skype to contact other Vibe users directly from the Vibe 
interface.


This functionality is enabled on a system level by default. For more information on how Vibe users 
can use Skype to contact other Vibe users from inside Vibe, see “Using Skype From within Vibe” in 
“Connecting With Your Co-Workers” in the Novell Vibe 3.2 User Guide .
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11 11Enabling Custom JSPs to Be Used on 
Your Vibe Site


Novell Vibe supports the use of custom JavaServer Pages (JSP) files. As a Vibe administrator, you can 
work with Vibe developers to write custom JSP files that enhance the appearance and functionality of 
your Vibe site.


Before you can enable a JSP file to be used in your Vibe site, the file must first be created. For 
information on how to create a custom JSP file, see “Creating JavaServer Pages (JSPs)” in the Novell 
Vibe 3.2 Developer Guide.


 Section 11.1, “Enabling JSP Files to Be Used on Your Vibe Site,” on page 117
 Section 11.2, “Using Sample Custom JSPs to Modify the Behavior of a Landing Page,” on 


page 118


11.1 Enabling JSP Files to Be Used on Your Vibe Site
After a JSP file has been created, you need to make it available to users in your Vibe site.


1 On the Vibe server, locate the JSP file that you want to make available to users.
2 Place the JSP file in the /WEB-INF/jsp/custom_jsps directory.


Users need to reference this file by name in order to use it, so make sure that the name of the file 
is intuitive and easy to remember.


TIP: You might want to create separate folders for each custom JSP file inside the custom_jsps 
directory. This can make managing your custom JSP files more simple. However, users who 
leverage these sample JSP files from the Vibe site will need to enter the relative path to the file. 
For example: new_folder/custom_jsp_landing_page_entry.jsp.


3 Stop and Restart the Vibe server.
or
If you are running Vibe in a non-production environment, you can configure Vibe to 
automatically update a all JSP changes that you make on the Vibe server, without stopping and 
restarting the Vibe server. For more information, see Section 11.1.1, “Dynamically Updating JSP 
Files by Running Vibe in Development Mode,” on page 117.


11.1.1 Dynamically Updating JSP Files by Running Vibe in Development 
Mode


If you are testing JSP files on a non-production system and you want all JSP changes that you make 
on the Vibe server to be automatically available on the Vibe server without stopping and restarting 
the Vibe server, you can run Vibe in development mode.
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IMPORTANT: Running Vibe in development mode significantly decreases the performance of your 
Vibe server and should not be used on a production system.


To run Vibe in development mode:


1 Open the web.xml file in a text editor. 
The web.xml file is located in the following directory:


2 Search for the development parameter, then change the value of this parameter from false to 
true.


3 Save and close the web.xml file.


11.2 Using Sample Custom JSPs to Modify the Behavior of a 
Landing Page


NOTE: While the information in this section is still valid, users can achieve the same results (and 
more) with Vibe 3.1 and later by adding an Enhanced View element to the landing page. For more 
information, see “Enhanced View:” in “Adding Content to Your Landing Page” in the Novell Vibe 3.2 
Advanced User Guide. 


Novell Vibe includes sample custom JSP files that enable you to modify the behavior of Vibe landing 
pages. Before you implement the sample JSP files that are described in this section, you might want to 
further customize them to suit your specific needs, as described in “Creating JavaServer Pages (JSPs)” 
in the Novell Vibe 3.2 Developer Guide.


For information on how users can add these custom JSP files to their individual landing pages after 
the JSP files have been enabled for use, see “Adding Content to Your Landing Page” in “Creating and 
Managing Landing Pages” in the Novell Vibe 3.2 Advanced User Guide.


 Section 11.2.1, “Listing Folder Entry Titles in a Bulleted List,” on page 118
 Section 11.2.2, “Displaying Entry Replies on a Landing Page,” on page 119
 Section 11.2.3, “Enabling Users to Take a Survey Directly from a Landing Page,” on page 119


11.2.1 Listing Folder Entry Titles in a Bulleted List


To activate the sample JSP file that enables Vibe users to list entries in a bulleted list for any given 
folder:


1 In the Vibe source files, navigate to the \WEB-INF\jsp\custom_jsp\samples directory.
2 Select and copy the custom_jsp_landing_page_folder_list.jsp file, then paste it into the 


\WEB-INF\jsp\custom_jsp directory.


Platform Default Location


Linux: /opt/novell/teaming/apache-tomcat/conf


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\conf
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TIP: You might want to create separate folders for each custom JSP file inside the custom_jsps 
directory. This can make managing your custom JSP files more simple. However, users who 
leverage these sample JSP files from the Vibe site need to enter the relative path to the file. For 
example: new_folder/custom_jsp_landing_page_entry.jsp.


11.2.2 Displaying Entry Replies on a Landing Page


You can display replies for a single entry, or for all entries that are contained in a folder.


 “Displaying Entry Replies for a Single Entry” on page 119
 “Displaying Entry Replies for All Entries in a Folder” on page 119


Displaying Entry Replies for a Single Entry


To activate the sample JSP file that allows Vibe users to display entry replies on a landing page when 
referencing a folder entry:


1 In the Vibe source files, navigate to the \WEB-INF\jsp\custom_jsp\samples directory.
2 Select and copy the custom_jsp_landing_page_entry.jsp file, then paste it into the \WEB-


INF\jsp\custom_jsp directory.


TIP: You might want to create separate folders for each custom JSP file inside the custom_jsps 
directory. This can make managing your custom JSP files more simple. However, users who 
leverage these sample JSP files from the Vibe site need to enter the relative path to the file. For 
example: new_folder/custom_jsp_landing_page_entry.jsp.


Displaying Entry Replies for All Entries in a Folder


To activate the sample JSP file that allows Vibe users to display entry replies on a landing page when 
referencing a folder:


1 In the Vibe source files, navigate to the \WEB-INF\jsp\custom_jsp\samples directory.
2 Select and copy the custom_jsp_landing_page_folder.jsp file, then paste it into the \WEB-


INF\jsp\custom_jsp directory.


TIP: You might want to create separate folders for each custom JSP file inside the custom_jsps 
directory. This can make managing your custom JSP files more simple. However, users who 
leverage these sample JSP files from the Vibe site need to enter the relative path to the file. For 
example: new_folder/custom_jsp_landing_page_entry.jsp.


11.2.3 Enabling Users to Take a Survey Directly from a Landing Page


To activate the sample JSP file that enables Vibe users to participate in a survey directly from a 
landing page:


1 In the Vibe source files, navigate to the \WEB-INF\jsp\custom_jsp\samples directory.
2 Select and copy the custom_jsp_landing_page_survey_entry.jsp file, then paste it into the 


\WEB-INF\jsp\custom_jsp directory.
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12 12Enabling Custom JAR Files to Be Used 
on Your Vibe Site


Novell Vibe supports the use of custom Java Archive (JAR) files. JAR files are one way that you can 
incorporate custom functionality to Vibe workflows. 


As a Vibe administrator, you can work with Vibe developers to write custom JAR files that enhance 
the functionality of workflows on your Vibe site.


Before you can enable a JAR file to be used in a workflow, the file must first be created. (The Vibe 
documentation does not describe how to create a JAR file.)


After the code has been written to accomplish a specific workflow action and then packaged into a 
JAR file, you need to make that JAR file available to Vibe users who are creating workflows.


When you customize workflows by using JAR files as described in this section, the JAR file can be 
referenced from any zone within your Vibe system. If you want customizations to be available to only 
one particular zone, you can instead add the customizations by adding an extension, as described in 
Chapter 13, “Adding Software Extensions to Your Vibe Site,” on page 123. (For more information 
about zones in Vibe, see Chapter 16, “Setting Up Zones (Virtual Vibe Sites),” on page 139.)


To make the custom JAR file available to Vibe users:


1 Place the JAR file in the following directory. If the directory does not yet exist, create it.


Users can now reference this JAR file by adding a Custom Action element to a workflow, as 
described in “Adding On-Entry or On-Exit Events” in “Creating an Advanced Workflow” in the 
Novell Vibe 3.2 Advanced User Guide.


Linux: /opt/novell/teaming/apache-tomcat/
lib/custom-ext


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
lib\custom-ext
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13 13Adding Software Extensions to Your 
Vibe Site


You can customize your Novell Vibe site through the use of software extensions. Vibe administrators 
or Vibe developers can create custom extensions (add-ons) that enhance the power and usefulness of 
the Vibe software. For example, you might have an extension that enables Flash video support in 
Vibe. 


When you customize your Vibe site through the use of software extensions, as described in this 
section, the customizations are available only for the zone where the software extension is deployed. 
If you are creating customizations for workflows, and you want to make the customizations available 
to multiple zones, you can instead add the customizations as JAR files, as described in Chapter 12, 
“Enabling Custom JAR Files to Be Used on Your Vibe Site,” on page 121. (For more information about 
zones in Vibe, see Chapter 16, “Setting Up Zones (Virtual Vibe Sites),” on page 139.)


This section discusses how to add software extensions that have already been created.


 Section 13.1, “Creating a Software Extension,” on page 123
 Section 13.2, “Deploying the Extension in Your Vibe Site,” on page 123
 Section 13.3, “Viewing Your Vibe Extensions,” on page 124
 Section 13.4, “Removing an Extension from Your Vibe Site,” on page 124


If you want Vibe to communicate with a third-party application and display related information 
inside of Vibe, you can set up a remote application, as described in Chapter 14, “Using Remote 
Applications on Your Vibe Site,” on page 127. 


13.1 Creating a Software Extension
For information on how to create a custom software extension for Novell Vibe, see “Creating and 
Packaging Extensions for Deployment” in the Novell Vibe 3.2 Developer Guide.


13.2 Deploying the Extension in Your Vibe Site
1 Log in to the Novell Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 Under Management, click Extensions.
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4 Click Add a new extension.
5 In the Choose a File section, click Browse, then browse to the extension that you want to deploy.


The extension is a zip file that can contain definition xml files, custom JSP files, Java classes, 
html files, css files, JavaScript, and other third-party files.


6 Click Add.
The extension is now installed and is displayed in a table on the Manage Extensions page.
You might need to configure an extension after it has been installed. For information on how to 
configure extensions, see the installation instructions on the Web site where you obtained the 
extension.
Installation instructions are specific for each extension, and should be written by the extension 
creator.


13.3 Viewing Your Vibe Extensions
1 Log in to the Novell Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 Under Management, click Extensions.


The Extensions page is displayed.
The table lists all extensions that are currently available in the Vibe site.


13.4 Removing an Extension from Your Vibe Site
An extension cannot be removed from the Novell Vibe site if the extension is being referenced by a 
binder or entry. If an extension is being referenced somewhere in the Vibe site, you must first 
manually delete the files and definitions that are referencing the extension before you can remove the 
extension itself. When an extension is removed, it does not remove any actual data from the Vibe site.


To remove an extension from your Vibe site:


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 Under Management, click Extensions.


The Manage Extensions page is displayed.
4 In the table, click the (x) in the Remove column for the extension that you want to delete.
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5 Click OK.
The extension is removed from the Vibe site and can no longer be used.
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14 14Using Remote Applications on Your Vibe 
Site


A remote application is a program that runs on a remote server and delivers data for use on your 
Novell Vibe site (such as data from a remote database). For example, you could set up a remote 
application for Twitter that displays all of your Twitter entries in Vibe. 


Unlike creating an extension for Vibe, creating a remote application does not modify the Vibe 
software in any way.


 Section 14.1, “Adding a Remote Application to Your Vibe Site,” on page 127
 Section 14.2, “Creating an Application Group,” on page 129
 Section 14.3, “Managing Access Controls for Remote Applications,” on page 130
 Section 14.4, “Implementing Remote Applications on Your Vibe Site,” on page 131


If you want to make modifications to the Vibe software itself, you can add a software extension, as 
described in Chapter 13, “Adding Software Extensions to Your Vibe Site,” on page 123.


14.1 Adding a Remote Application to Your Vibe Site
After you or a developer have created a remote application, you need to make it available on your 
Novell Vibe site.


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 Under Manage, click Applications.


4 Click Add a New Application.
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5 Fill in the following fields:
Title: Specify a unique title for the remote application. Vibe site users who add the remote 
application to a form or view can select the title from the list of available remote applications. 
Name: Specify a unique name for the remote application. The name is for internal use in the 
Vibe database. The first character must be an alphabetic character (a-z, A-Z). For the rest of the 
name, you can use alphanumeric characters (a-z, A-Z, 0-9), hyphens (-), and underscores (_). 
Description: Provide a description of what the remote application does.
Trusted: Select Trusted if the application is extremely trustworthy (for example, if you write, 
maintain, and run the application on the same server that runs Vibe). If you select Trusted, Vibe 
applies access control according to the viewing user’s access control settings. For complete 
information about access control, see “Managing Remote Applications” in the Novell Vibe 3.2 
Advanced User Guide.
Post URL: Specify the URL of the remote application. Vibe posts requests for information, along 
with the requesting user and a security token for use by Vibe Web services, to this URL, then 
waits to receive the requested HTML snippets for posting on the Vibe site.
Post Timeout: Specify the number of seconds that Vibe should wait for a response from the 
remote application before it assumes that the remote application is not available. The default is 
60 (1 minute). If Vibe does not receive a response from the remote application, it displays the 
page requested by the user without any input from the remote application.
Maximum Idle Time: Specify the number of seconds that Vibe maintains idle connections 
through Vibe Web service with a remote application. The default is 3600 (1 hour). After the 
maximum idle time elapses, Vibe closes idle connections.
Same Address Policy: Select this option if interactions with the Vibe site are initiated by the 
remote application, and if the remote application must communicate with Vibe through the Vibe 
Web services machine by using the same security token for the entire communication.


6 Click Add to add the remote application to the list of remote applications that are available on 
your Vibe site, then click Close.
Users now see the new remote application in the list of tools within the designers and within the 
tool used to create accessories.
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14.2 Creating an Application Group
If you create a number of remote applications for your Novell Vibe site, you can create application 
groups for remote applications so they can all be assigned the same roles in the Access Control table. 
For example, you might have a group of remote applications that are allowed to perform 
administrative tasks and another group of remote applications that are granted only read access.


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 Under Manage, click Application Groups.


4 Click Add a New Application Group.


5 Fill in the following fields:
Application Group Title: Specify a unique title for the remote application group. Vibe site users 
who need to set access controls for a remote application can select the title from the list of 
available remote application groups. 
Application Group Name: Specify a unique name for the remote application group. The name 
is for internal use in the Vibe database. The first character must be an alphabetic character (a-z, 
A-Z). For the rest of the name, you can use alphanumeric characters (a-z, A-Z, 0-9), hyphens (-), 
and underscores (_). 
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Application Group Description: Provide a description of the types of remote applications that 
the application group includes.


6 Click Add to add the application group to the list of application groups that are available on your 
Vibe site, then select the new application group to add remote applications to it.


7 Fill in the following fields:
Applications: Start typing the title of a remote application, then select the remote application. 
Repeat for each application that you want to add to the application group.
Application Groups: Start typing the title of an existing application group that you want to nest 
in the new application group, then select the application group. Repeat for each application 
group that you want to nest in the application group.


8 Click Apply to save the application group, then click Close.


14.3 Managing Access Controls for Remote Applications
Because not all remote applications can be completely trusted, it is often a good idea to limit the 
privileges of the remote application. This section describes how you can accomplish this.


If you are running a trusted remote application, such as an application that you are maintaining on 
the same server as Novell Vibe, then you do not need to set access controls on it.


When an application is restricted to a specific role, the application can use Web services to perform 
only those tasks that are allowed for that role. For example, the Participant role can create new 
entries, modify entries that the user created, add comments to entries, and so on. Participants cannot 
perform system administration tasks and cannot modify other users’ entries.


Because workspace and folder owners can change the access control for places they own, you should 
communicate to your users about registered applications in the system and recommended access-
control settings.


To limit the remote application to privileges assigned to a specific role:


1 Log in to the Vibe site as the Vibe administrator.


2 Access the top workspace in the hierarchy by clicking the workspace tree icon , then clicking 
Home Workspace (this is the default name for the top workspace).


3 Click Workspace > Access Control.
4 On the Configure Access Control page, click Add an Application.
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5 In the Add an Application field, use the type-to-find to specify and select the application that you 
want to add.


6 In the access control table, select the check box that is located in the row of the remote 
application that you just added, and the column of the role that you want to assign to the 
application.


7 Click Save Changes > Close.


The application that you added is now restricted to those operations allowed for the role that you 
selected. For example, if you assigned the Participant role to the remote application, then the 
inheritance of workspace and folder access controls means that it is very likely that most workspaces 
and folders inherit this setting. Assuming that all places inherited this setting, the most powerful role 
the remote application can assume within the installation is that of a Participant.


You can assign access-control roles to groups of applications instead of assigning roles to one 
application at a time if you have enabled multiple applications for your site and have grouped them 
together in an application group, as described in Section 14.2, “Creating an Application Group,” on 
page 129.


14.4 Implementing Remote Applications on Your Vibe Site
After you as the Novell Vibe administrator have added remote applications to the Vibe site, users can 
implement them in custom forms and views, in workspaces, and as accessories. For instructions, see 
“Managing Remote Applications” in the Novell Vibe 3.2 Advanced User Guide.


![Need this? -- Before users can apply a remote application to an accessory, a custom entry, a 
workflow state, or a tag within a JSP file, you need to register the application with the Novell 
Teaming system. Before you can register a remote application as described in this section, the 
application first needs to be created, and you need to use the build file to build and deploy the 
application on Tomcat. ] 

Using Remote Applications on Your Vibe Site 131







132  Novell Vibe 3.2 Administration Guide







15 15Setting Up Mirrored Folders


A mirrored folder is a library folder within Novell Vibe that is synchronized with a folder located on 
a system drive outside of Vibe. When you perform basic actions (adding subfolders and files, 
modifying files, deleting folders and files) by using the Vibe interface or by accessing the file on the 
drive, the change is reflected in the other interface. The advantage to using mirrored files is that you 
can apply Vibe tools to files on a drive, including tools such as text search, workflow, and discussion 
(in the form of comments applied to the entry in the library folder).


Initial setup of mirrored folder resource drivers is done during Novell Vibe installation, as described 
in “Configuring Mirrored Folder Resource Drivers” in “Advanced Installation and Reconfiguration” 
in the Novell Vibe 3.2 Installation Guide. 


The Vibe Installation program enables you to set up as many as three mirrored folder resource 
drivers. If you need more than three, you must manually edit the installer.xml file, then update 
your Vibe installation. 


After you set up the mirrored folder resource drivers by using the Installation program, you must 
perform additional mirrored folder configuration on the Vibe site.


 Section 15.1, “Manually Setting Up More Than Three Mirrored Folder Resource Drivers,” on 
page 133


 Section 15.2, “Creating a Mirrored Files Folder for a Mirrored Folder Resource Driver,” on 
page 136


15.1 Manually Setting Up More Than Three Mirrored Folder 
Resource Drivers
 Section 15.1.1, “Editing the installer.xml File,” on page 133
 Section 15.1.2, “Updating Your Vibe Site Configuration,” on page 135


15.1.1 Editing the installer.xml File


The Novell Vibe Installation program enables you to set up three mirrored folder resource drivers. 
However, there is no limit to the total number of mirrored folder resource drivers that you can set up 
after installation. A useful strategy is to set up resource drivers for root directories, then set up 
Mirrored File folders for root directories and subdirectories as needed, as described in Section 15.2, 
“Creating a Mirrored Files Folder for a Mirrored Folder Resource Driver,” on page 136.


When you run the Vibe Installation program, it creates the installer.xml file in the directory where 
you run it. The installer.xml file stores the information you provided during installation. You can 
also edit it manually, then update your Vibe installation.


1 Make a backup copy of your existing installer.xml file.
2 Open the installer.xml file in a text editor.
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3 Search for mirrored.
4 Scroll down until you reach the three existing mirrored folder resource drivers.
5 Copy the mirrored folder resource driver that is most like the one you want to create, then paste 


it between the <MirroredFolder> and </MirroredFolder> tags.
The Vibe Installation program displays only the first three mirrored folder resource drivers, so 
you might want to place new resource drivers at the top of the list in order to double-check the 
information when you run the Vibe Installation program to implement your changes.


6 Set the parameters as needed for the file system location that you want to mirror in your Vibe 
site:


7 (Conditional) If you are setting up a webdav mirrored folder, set the following additional 
parameters: 


Tag Setting


enabled= true


type= file or webdav


id= The unique internal name for the mirrored folder resource driver. Use 
only alphanumeric characters. Do not include spaces, extended 
characters, or double-byte characters.


title= The name of the mirrored folder resource driver that displays on the 
Vibe site. The title can include any characters.


rootPath= For the file mirrored folder type, the absolute path to the directory 
from the point of view of the Vibe server.


For the webdav mirrored folder type, the path to the directory after the 
WebDAV server hostname, and optionally, the port number, as specified 
by the hostUrl= parameter. The path should start with a slash (/), 
because it is appended to the setting of the hostUrl= parameter. For 
example, if the full WebDAV server location is:


http://webdavserver/archive/docs


the rootPath= setting would be:


/archive/docs


readonly= true or false


zoneId= For a multi-zone Vibe site, this is the ID of the zone where you want the 
mirrored folder resource driver to be available. For information about 
Vibe zones, see Chapter 16, “Setting Up Zones (Virtual Vibe Sites),” on 
page 139. For a single-zone Vibe site, leave this parameter empty.


AllowedUsers idList= A list of Vibe user IDs that can access the mirrored folder resource 
driver and create mirrored folders. Use a semicolon (;) between user 
IDs.


AllowedGroups idList= A list of Vibe groups that can access the mirrored folder resource driver 
and create mirrored folders. Use a semicolon (;) between group IDs.
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8 Repeat Step 5 and Step 6 for each mirrored folder resource driver that you want to create.
9 Save the installer.xml file, then exit the text editor. 


15.1.2 Updating Your Vibe Site Configuration


After you edit the installer.xml file, you must run the Novell Vibe Installation program to update 
the configuration of your Vibe site. If you need assistance with any of the following steps, refer to the 
appropriate platform-specific instructions in “Installing and Setting Up a Basic Vibe Site” in “Basic 
Installation” in the Novell Vibe 3.2 Installation Guide. 


1 Stop Vibe.
2 Start the Vibe Installation program.


The Vibe Installation program reads the updated installer.xml file. If your edits inadvertently 
changed the syntax of the file, the Installation program cannot start. If this happens, correct the 
problem in the installer.xml file, or return to your backup copy and try your edits again.


3 Accept the License Agreement, then click Next.
4 Select Reconfigure Settings, then click Next.
5 Select Advanced, then click Next.
6 Click Next until you reach the Mirrored Folder Resource Driver Configuration page.


The Vibe Installation program displays the first three mirrored folder resource drivers listed in 
the installer.xml file.


7 (Conditional) If you placed the new resource drivers at the top of the list, review the information 
that you added, and make corrections if necessary.


8 Click Next.
9 Click Install to implement the new mirrored folder resources.


10 Start Vibe.


Tag Setting


hostUrl= The hostname, and optionally, the port number for the WebDAV server. 
For example:


http://webdav_hostname[:port]
https://webdav_hostname[:port]


Do not include the directory path to the data. Use the rootPath= 
parameter to specify the path to the directory on the WebDAV server. 
For example, if the full WebDAV server location is:


http://webdav_hostname/archive/docs


the hostUrl= setting would be:


http://webdav_hostname


user= The username that Vibe can use to connect to the WebDAV server. The 
WebDAV server must support HTTP Basic authentication (http://
en.wikipedia.org/wiki/Basic_access_authentication).


password= The password for the username specified by the user= parameter.
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15.2 Creating a Mirrored Files Folder for a Mirrored Folder 
Resource Driver
After you have set up one or more mirrored folder resource drivers in the Novell Vibe Installation 
program, you need to create a Mirrored Files folder for each resource driver in order to make the data 
accessible to users on your Vibe site.


1 Navigate to the workspace where you want to create a mirrored folder.
2 Create a new File folder:


2a Click Workspace > New Folder.


2b Specify a name for the folder that reflects the type of data that is available in the mirrored 
location.


2c Select Mirrored Files, then click OK.
3 Configure the new Mirrored Files folder to access the resource driver:


3a Select the new folder, then click Folder > Edit Folder.
3b Scroll down to the mirrored folder options at the bottom of the page.


3c Set the mirrored folder options as needed:
Resource Driver: Select the name of the mirrored folder resource driver, as specified in the 
Title field on the Mirrored Folder Resource Driver Configuration page in the Vibe 
Installation program or using the title= tag in the installer.xml file. 
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Resource Root Path: Displays the pathname you specified in the Vibe Installation program 
or the installer.xml file. 
Resource Path Relative to the Root Path: (Optional) Add a subdirectory path to restrict the 
scope of the files available in the Mirrored File folder.


IMPORTANT: After you configure a Mirrored Files folder with a resource driver, you 
cannot edit any of the mirrored folder settings except for the subdirectory path. If you need 
to change other settings, you can delete the Mirrored File folder and create a new one with 
different settings.


3d Click OK to save the mirrored folder settings.
4 Display the Mirrored Files folder, then click Folder > Manually Synchronize to create the initial 


metadata for the mirrored folder.
5 Set up a synchronization schedule to keep the metadata current:


5a Click Folder > Schedule Synchronization.


6 Select Enable Scheduled Synchronization.
7 Set schedule options as needed.


You can choose to have mirrored folder synchronization performed every day, or you can select 
specific days of the week (for example, on Monday, Wednesday, and Friday). You can choose to 
have synchronization performed once a day at a specified time (for example, at 2:00 a.m.), or you 
can set a time interval, so that it is performed multiple times each day (for example, every four 
hours). The smallest time interval you can set is .25 hours (every 15 minutes).


8 Click Apply > Close to save the synchronization schedule options for the mirrored folder.
9 Click the new Mirrored Files folder to display the directories and files in the mirrored location.


IMPORTANT: If you set up multiple Mirrored Files folders that point to the same files, and if 
Vibe users have been granted write access to those files, multiple Vibe users can gain write 
access to the same mirrored file at the same time. File locking is associated with each Mirrored 
File folder entry, not with the physical source files. Make sure that all Vibe users have access to 
mirrored files through the same Mirrored File folder.


10 Set appropriate access controls on the Mirrored Files folder, as described in Chapter 2, “Planning 
and Controlling User Access to Workspaces and Folders,” on page 19.
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16 16Setting Up Zones (Virtual Vibe Sites)


You can set up multiple virtual Novell Vibe sites within a single physical Vibe site by setting up Vibe 
zones. Each Vibe zone is completely independent. Each zone has its own unique URL, and data files 
for each zone are stored in a separate subdirectory of the Vibe file repository, so that no searching 
across zones is possible. 


 Section 16.1, “Creating a New Vibe Zone,” on page 139
 Section 16.2, “Configuring DNS to Support the New Zone,” on page 140
 Section 16.3, “Accessing the New Zone,” on page 141
 Section 16.4, “Setting Up Access Control for the New Zone,” on page 141


16.1 Creating a New Vibe Zone
1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 Under Management, click Zones.


The default zone name is kablink. It represents your initial Vibe site, from which all other zones 
can be managed.


4 Click Add a New Zone, then fill in the fields.
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Name: Specify a unique name to describe the zone. The name can include alphanumeric 
characters, periods, and underscores. Do not include spaces, extended characters, or double-
byte characters.
Virtual Host: Specify the hostname for the zone. You can use any hostname that does not 
conflict with an existing hostname.


5 Click Add, then click Close to create the zone.


16.2 Configuring DNS to Support the New Zone
The new zone URL has the following format:


http://virtual_hostname[:port]


where virtual_hostname is the hostname or fully qualified domain name of the Novell Vibe zone 
that you have set up in DNS.


All zones use the same port number as the physical Vibe site. If you have the Vibe site configured to 
listen on your browser default port, you do not need to include the port number in the zone URL. 
How you configure your Vibe site to listen on the browser default port varies by platform.


1 To perform an initial test of the Vibe zone, add the zone URL to the hosts file on your local 
workstation where you run your browser. The location of the hosts file and the format of the 
line to add vary by platform:


Linux: See “Setting Up Port Forwarding” in “Basic Installation” in the Novell Vibe 3.2 Installation Guide.


Windows: Specify the desired port numbers when you run the Vibe Installation program, as described in 
“HTTP/HTTPS Ports” in “Basic Installation” in the Novell Vibe 3.2 Installation Guide.


Linux /etc/hosts


ip_address vibe_zone_url hostname
172.16.5.18 www.myvibesite.com vibe1


Windows C:\Windows\system32\drivers\etc\hosts


ip_address vibe_zone_url
172.16.5.18 www.myvibesite.com
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2 Specify the zone URL in your Web browser.


http://www.myvibesite.com


3 Log in to the new zone by using the default administrator username (admin) and password 
(admin).
From this, you can see that each zone has its own site administrator who has administrative 
rights only within that particular zone.


4 Immediately change the site administrator password to a secure password of your own 
choosing, as described in “Accessing Your Basic Vibe Site as the Site Administrator” in “Basic 
Installation” in the Novell Vibe 3.2 Installation Guide.


5 After you can access the new zone successfully following the instructions in Step 1, have your 
network administrator make comparable changes to DNS so that the zone URL is recognized 
across your company or across the Internet as needed.


16.3 Accessing the New Zone
As with your original Novell Vibe site, the Vibe administrator username is admin, and the password 
is admin. For the security of the new zone, you should immediately change the zone’s administrator 
password.


1 In your Web browser, specify one of the following URLs, depending on whether or not you are 
using a secure SSL connection:


http://zone_hostname
https://zone_hostname


Replace zone_hostname with the zone hostname or fully qualified domain name that you set up 
in DNS. 


2 Log in using admin as the login name and admin as the password.
3 Change the default zone administrator password to a secure password:


3a Navigate to the personal workspace of the Vibe administrator.
3b Click Profile, then click Edit on the Profile page.
3c Specify a new password for the zone administrator in the New Password and Confirm New 


Password fields.
3d (Optional) Provide useful information in the additional fields of the zone administrator’s 


profile.
3e Click OK to return to the zone administrator’s profile.


IMPORTANT: The zone can only be administered by accessing the zone URL and by logging in 
through the zone administrator password. The zone cannot be administered from the main Vibe site, 
even when you are logged in as the main Vibe administrator.


16.4 Setting Up Access Control for the New Zone
After you log in to the zone as the zone administrator, you can set access controls for the zone.


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .

Setting Up Zones (Virtual Vibe Sites) 141







3 Under System, click Access Control for Zone Administration.


4 (Conditional) If you want to have more than one zone administrator:
4a Click Add a User, start typing the user’s name, then select the user from the drop-down list.
4b Select the check box in the Zone Administration column.
4c Click Save Changes.


5 (Optional) Add roles, as described in Section 2.4, “Managing Roles to Refine Access Control,” on 
page 27.


6 (Optional) Set other access controls for the zone, as described in “Controlling Access” in the 
Novell Vibe 3.2 Advanced User Guide.
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17 17Managing a Multiple-Language Vibe Site


 Section 17.1, “Accommodating Multiple Languages,” on page 143
 Section 17.2, “Adding a New Language,” on page 144


17.1 Accommodating Multiple Languages
 Section 17.1.1, “Understanding the Vibe Site Default Language,” on page 143
 Section 17.1.2, “Setting Up a Multilingual Workspace Name,” on page 143
 Section 17.1.3, “Changing the Default Language on the Login Page,” on page 144


17.1.1 Understanding the Vibe Site Default Language


There can be only one default language for the entire Novell Vibe site. You select the default language 
when you install Vibe, as described in “Accommodating Multiple Languages” in the Novell Vibe 3.2 
Installation Guide.


When you create Vibe users, you can select a locale for each user, which determines the language of 
each personal workspace. However, when users who speak various languages work together on a 
Vibe site, they can often see interface text that is not in their preferred language. Examples include:


 Standardized text such as Home Workspace, Global Workspaces, Personal Workspaces, and Team 
Workspaces in the Workspace tree


 Standardized group names, such as All Users
 Login page


Although you cannot change standardized group names, such as All Users, you can rename the 
standardized workspaces to include multiple languages. Although the Vibe login page can be 
displayed in only one language, you can change the page’s default language.You must be logged in as 
the Vibe administrator in order to perform these tasks.


17.1.2 Setting Up a Multilingual Workspace Name


1 Browse to the workspace.
2 Click Workspace > Edit Workspace.
3 In the Title field, add text in another language, then click OK.
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17.1.3 Changing the Default Language on the Login Page


The language of the Vibe login page is decided by the Guest user account. Because of this, you can 
display only one language for your entire Vibe site in the login page.


To change the language of the Guest user account, and therefore change the language that is 
displayed on the Vibe login page:


1 Navigate to the Guest workspace.
2 On the Profile page click Edit.


The User page is launched.
3 In the Locale drop-down list, select the language that you want to be displayed on your login 


page.
Users who log in as Guest view the Vibe site in the language that you select.


4 Click OK.


17.2 Adding a New Language
 Section 17.2.1, “Current Language Availability,” on page 144
 Section 17.2.2, “Text to Translate,” on page 145
 Section 17.2.3, “New Language Implementation,” on page 145


17.2.1 Current Language Availability


Novell Vibe is currently translated into 15 languages. Each language is identified by a language code 
in the Vibe software. Directory names and filenames include the language codes to identify the 
languages of directories and files.


 Chinese-Simplified (zh_TW)
 Chinese Traditional (zh_CN)
 Danish (da)
 Dutch (nl)
 English (en)
 French (fr)
 German (de)
 Hungarian (hu_HU)
 Italian (it)
 Japanese (ja)
 Polish (pl)
 Portuguese (pt_BR)
 Russian (ru_RU)
 Spanish (es)
 Swedish (sv)


Kablink Vibe is an open source project where additional languages can be contributed by interested 
members of the open source community.
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17.2.2 Text to Translate


You can translate the software interface text and pop-up text.


The files that contain the text strings in the Vibe interface (messages_language_code.properties) 
and in mouse-over pop-ups (help-messages_language_code.properties) are located in the 
following directory:


1 Identify the file in the language that you want to translate from.
2 Identify the language code for the language that you want to translate into.


Lists of standard language codes (http://en.wikipedia.org/wiki/Language_code) are available on 
the Internet.


3 Create a copy of the file that you want to translate, and name it with the appropriate language 
code.


4 Edit the file to translate in a text editor.
Useful information for translators is provided at the top of each file (in English).


5 Locate the following line:


Teaming.Lang=


6 Replace the existing language code with the language code for the language that you want to 
translate into.
The lines in the file have the following format:


tag=string


7 In each line, replace the text after the equal sign (=) with your translation for the string.
8 Save your translated file along with the other translated files.
9 Configure Vibe to recognize the new language, as described in Section 17.2.3, “New Language 


Implementation,” on page 145.


17.2.3 New Language Implementation


1 Change to the following directory:


2 Make a backup copy of the ssf-ext.properties file, located in the same directory with the 
ssf.properties file.


3 Open the ssf.properties file in a text editor.
4 Locate the following line:


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/WEB-INF/messages


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF\messages


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/WEB-INF/classes/config


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF\classes/config
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i18n.locale.support=en,da,de,es,fr,hu_HU,it,ja,nl,pl,pt_BR,ru_RU,sv,
zh_CN,zh_TW


5 Copy that line to the clipboard of your text editor.
6 Open the ssf-ext.properties file.
7 Scroll to the end of the ssf-ext.properties file, then paste the line you copied.
8 Type a comma (,) at the end of the line, followed by your language code.
9 Save and close the ssf-ext.properties file.


10 Close the ssf.properties file without saving it.
11 Stop and restart Vibe.
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II IISite Maintenance


 Chapter 18, “Managing Users,” on page 149
 Chapter 19, “Managing Workspaces,” on page 163
 Chapter 20, “Managing Disk Space Usage with Data Quotas and File Restrictions,” on page 169
 Chapter 21, “Managing Workspace and Folder Templates,” on page 187
 Chapter 22, “Creating and Managing Workflows,” on page 195
 Chapter 23, “Managing E-Mail Configuration,” on page 197
 Chapter 24, “Managing the Lucene Index,” on page 203
 Chapter 25, “Backing Up Vibe Data,” on page 209
 Chapter 26, “Monitoring the Vibe Site,” on page 213
 Chapter 27, “Reconfiguring the Vibe Site,” on page 231
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18 18Managing Users


As time passes on your Novell Vibe site, users come and go, resulting in the need for periodic 
maintenance activities.


 Section 18.1, “Synchronizing Users and Groups from an LDAP Directory,” on page 149
 Section 18.2, “Creating a New Local User,” on page 151
 Section 18.3, “Listing Vibe Users,” on page 152
 Section 18.4, “Renaming a Vibe User,” on page 154
 Section 18.5, “Deleting a Vibe User,” on page 155
 Section 18.6, “Disabling Vibe User Accounts,” on page 157
 Section 18.7, “Managing Local Users and Groups by Importing Profile Files,” on page 158
 Section 18.8, “Preventing Users from Creating User Accounts,” on page 158
 Section 18.9, “Enabling Users to Bypass the XSS Security Filter,” on page 160


18.1 Synchronizing Users and Groups from an LDAP Directory
 Section 18.1.1, “Adjusting LDAP Synchronization of Users and Groups,” on page 149
 Section 18.1.2, “Synchronizing Additional LDAP Attributes,” on page 149


18.1.1 Adjusting LDAP Synchronization of Users and Groups


Novell Vibe pulls user information from your LDAP directory service on the schedule that you set in 
the Configure LDAP Synchronization page on the Administration page. The LDAP synchronization 
schedule was initially set up during installation, as described in “User Synchronization Options” in 
“Basic Installation” in the Novell Vibe 3.2 Installation Guide. Therefore, to add new users to your Vibe 
site, you add the users to your LDAP directory, in a context from which Vibe synchronizes 
information.


As time passes, deletion of obsolete users and groups from your Vibe site becomes a larger concern. 
Periodically review the LDAP synchronization options described in “LDAP Synchronization 
Options” in “Basic Installation” in the Novell Vibe 3.2 Installation Guide to ensure that obsolete users 
and groups are being managed properly.


NOTE: If you change user information on the Vibe site, the changes are not transferred back to your 
directory service.


18.1.2 Synchronizing Additional LDAP Attributes


By default, Vibe synchronizes the following attributes from the LDAP directory:


 First name
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 Last name
 Phone number
 E-mail address
 Description


This information displays on each user’s personal user profile. 


To synchronize additional LDAP attributes, complete the following sections:


 “Identifying or Creating a Vibe Field for the LDAP Attribute” on page 150
 “Copying the Data Name of the Vibe Field” on page 150
 “Mapping the Vibe Field to the LDAP Attribute” on page 151


Identifying or Creating a Vibe Field for the LDAP Attribute


Before you can synchronize Vibe user profiles with additional attributes from your LDAP directory, 
you first need to ensure that there is a corresponding Vibe field for the LDAP attribute that you want 
to synchronize.


To view the existing fields in the user profile:


1 Navigate to a user profile and see if there is an existing field that corresponds to the LDAP 
attribute that you want to synchronize.


2 If the appropriate field already exists, continue with “Copying the Data Name of the Vibe Field” 
on page 150.
If the appropriate field doesn’t already exist, you must create it, as described in Section 3.2.4, 
“Customizing the Default User Profile View,” on page 45.


Copying the Data Name of the Vibe Field


Each field in Vibe has an internal data name, which is added when the field is created. When you 
create a field by using the Form and View Designers tool, Vibe requires that you enter a data name. 
This name is how Vibe identifies the field.


To map an LDAP attribute to a Vibe field, you must find the data name for the field.


The following procedure shows how to find the data name for a particular field in the user profile:


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 In the System section, click Form/View Designers.
4 Expand Profile View, then click User.
5 Expand Profile Form Definition, expand Form, then locate the Vibe field that you want to 


synchronize with an LDAP attribute.
6 Click the name of the field, then click Modify in the dialog box on the right side of the page.
7 Copy the text in the Data Name field, then continue with “Mapping the Vibe Field to the LDAP 


Attribute” on page 151.
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Mapping the Vibe Field to the LDAP Attribute


After you have copied the data name of the Vibe field that you want to synchronize with an LDAP 
attribute as described in “Copying the Data Name of the Vibe Field” on page 150, you can map the 
Vibe field to the LDAP attribute that you want to synchronize.


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
The Administration page is displayed.


3 In the System section, click Configure LDAP.
The map box in the Users section lists the LDAP attributes that are currently being synchronized.


The items in the list have the following format:


vibe_field_name=ldap_attribute_name


4 Add a new line to the list, specifying the Vibe field name to the left of the equal sign (=) and the 
LDAP attribute name to the right of the equal sign.
The vibe_field_name is the data name that you copied in “Copying the Data Name of the Vibe 
Field” on page 150, and ldap_attribute_name is the name of the LDAP attribute in your LDAP 
directory.


5 Repeat Step 4 for each LDAP attribute that you want to add to the user profile.
6 Select Run Immediately, then click Apply.


The status box shows the LDAP attribute information being added to Vibe users.


18.2 Creating a New Local User
You can manually create users on the Vibe site, rather than synchronizing user information from an 
LDAP directory. Users created in this way are local users, and are not added to your LDAP directory.


You can create local users in either of the following ways:


 Section 18.2.1, “Creating a New User from the Administration Page,” on page 151
 Section 18.2.2, “Creating a New User from the User List,” on page 152


18.2.1 Creating a New User from the Administration Page


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
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3 In the Management section, click User Accounts.
4 In the Add Account tab, provide the user’s information, then click OK.


18.2.2 Creating a New User from the User List


1 Click the Workspace tree icon  in the Action toolbar, then click Personal Workspaces.


2 Click New User, provide the user’s information, then click OK.


18.3 Listing Vibe Users
On the Novell Vibe site, you can view a comprehensive list of all the Vibe users.


1 In the Workspace tree, expand Home Workspace, then click Personal Workspaces.
All of the users are displayed in the main viewing window.


You can use this page in the following ways:


 Section 18.3.1, “Navigating the User List,” on page 153
 Section 18.3.2, “Navigating to a User’s Individual Workspace,” on page 153
 Section 18.3.3, “Adding Local Users,” on page 153
 Section 18.3.4, “Modifying the Title, Description, and Branding,” on page 153
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18.3.1 Navigating the User List


You can navigate the user list by using the tools in the Entry Listing toolbar.


For information on the navigation tools provided in this toolbar, see “Listing Folder Entries and 
Pages” in the Novell Vibe 3.2 User Guide.


18.3.2 Navigating to a User’s Individual Workspace


You can use the user list to navigate to a user’s individual workspace.


1 In the user list, in the Full Name column, click the name of the user whose workspace you want to 
navigate to.
If you have deleted a user workspace but have not yet purged the workspace, the user 
workspace is still displayed in the user list, but you are unable to navigate to the workspace.
If you want the user workspace to be removed from the user list, you must purge the workspace, 
as described in “Making Disk Space Available by Purging Deleted Items” in the Novell Vibe 3.2 
Advanced User Guide.
If you want to restore the workspace, see “Restoring Deleted Items” in the Novell Vibe 3.2 
Advanced User Guide.


18.3.3 Adding Local Users


A local user is a Vibe user who is not added to your LDAP directory. You can use the User List page 
to add new local users to your Vibe site.


If you want to add users through your LDAP directory service, see Section 5.1, “Adding New Users 
to Your Vibe Site,” on page 89.


1 In the user list, click New User.
The User page is displayed.


2 Provide the user’s information in the User page, then click OK.


18.3.4 Modifying the Title, Description, and Branding


By default, the workspace that contains all of the personal workspaces is named Personal Workspaces. 
The brand for this workspace is inherited from the parent workspace, and there is no workspace 
description. However, Vibe enables you to modify the name, description, and brand of the 
workspace.


 “Modifying the Title and Description” on page 153
 “Modifying the Brand” on page 154


Modifying the Title and Description


1 Navigate to the Personal Workspaces workspace.
2 Click Workspace > Edit Workspace in the Action toolbar.


Use this page to change the title and description of the workspace.
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Modifying the Brand


1 Navigate to the Personal Workspaces workspace.
2 Click Workspace > Brand Workspace in the Action toolbar.


Use the Workspace/Folder branding dialog box to modify the workspace brand. For more 
information about how to brand a workspace, see “Branding a Folder or Workspace” in the 
Novell Vibe 3.2 Advanced User Guide.


18.4 Renaming a Vibe User
Novell Vibe users are identified by name (first, middle, last) and by user ID. User names are used to 
identify personal workspaces. User IDs are used for logging in. You can change users’ names, but not 
their user IDs. How you change users’ name depends on how you created the user.


 Section 18.4.1, “Renaming a Vibe User from LDAP,” on page 154
 Section 18.4.2, “Renaming a Local Vibe User,” on page 154


18.4.1 Renaming a Vibe User from LDAP


If you are synchronizing user information from an LDAP directory, as described in “Adding Vibe 
Users from Your LDAP Directory” in “Basic Installation” in the Novell Vibe 3.2 Installation Guide, you 
change a user’s first, middle, or last name by updating it in the LDAP directory. The updated 
information then synchronizes to the Vibe site according to the schedule you have established for 
LDAP synchronization. If you change a user’s first, middle, or last name by updating information on 
the Vibe site, the change is not synchronized back to the LDAP directory, so the two sources of user 
information can be out of sync.


NOTE: After you have set up a user in Vibe, you must not change the user’s user ID in the LDAP 
directory. If you do, the association between the original LDAP user ID and new LDAP user ID is lost 
from the perspective of the Vibe site. A new Vibe account and workspace is created for the new user 
ID when LDAP synchronization takes place. Although it is possible to move folders from the user’s 
old workspace to the new workspace, any entries created with the old user ID cannot be associated 
with the new user ID, so this approach is not recommended.


18.4.2 Renaming a Local Vibe User


If you manually create Vibe users on the Vibe site, rather than synchronizing user information from 
an LDAP directory, you can change users’ names (first, middle, last) on the Vibe site.


When a user logs in to the Vibe site for the first time, the user’s personal workspace is created. Before 
a user logs in, he or she does not have a personal workspace. Vibe enables site administrators to 
manually rename both types of users.


 “Renaming Users Who Have Logged In to Vibe” on page 155
 “Renaming Users Who Have Not Logged In to Vibe” on page 155


NOTE: Vibe does not allow you to change a user ID after the user account has been created.
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Renaming Users Who Have Logged In to Vibe


To rename a user who has previously logged in to the Vibe site and therefore has a personal 
workspace:


1 Navigate to the user’s personal workspace.
2 Click Edit on the Profile page.


The User page is displayed.
3 Modify the First Name, Middle Name, and Last Name fields as desired.
4 Click OK.


Renaming Users Who Have Not Logged In to Vibe


To rename a user who has not previously logged in to the Vibe site and therefore does not have a 
personal workspace:


1 Search for a user you want to rename, as described in “Searching for Specific People, Places, or 
Tagged Items” in the Novell Vibe 3.2 User Guide.
The user’s profile page is displayed.


2 Click Modify.
The User page is displayed.


3 Modify the First Name, Middle Name, and Last Name fields as desired.
4 Click OK.


18.5 Deleting a Vibe User
When users no longer need access to your Novell Vibe site, you should delete their Vibe user 
accounts. How you delete a user depends on how you originally created the user.


When you delete a user, the entries and information that the deleted user contributed are preserved.


 Section 18.5.1, “Deleting a Local User,” on page 155
 Section 18.5.2, “Deleting a User through LDAP,” on page 156


18.5.1 Deleting a Local User


If you manually create Vibe users on the Vibe site, rather than synchronizing user information from 
an LDAP directory, you can delete users as described in this section.
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IMPORTANT: You should not delete users that are being synchronized with an LDAP directory by  
following the steps in this section. If you do, the user accounts are deleted along with all the data 
within the personal workspace, but the user accounts are re-created the next time users log in or the 
next time the LDAP sync occurrs. For information on how to properly delete users who are being 
synchronized with an LDAP directory, see Section 18.5.2, “Deleting a User through LDAP,” on 
page 156.


 “Deleting Individual User Accounts” on page 156
 “Deleting Multiple User Accounts” on page 156


Deleting Individual User Accounts


1 Log in to Vibe as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 In the Management section, click User Accounts.
4 Click the Disable/Delete Accounts tab.
5 Click Disable Individual Accounts.
6 In the User field, begin typing the name of the user whose account you want to delete, then click 


the name when it appears in the drop-down list.
7 (Optional) Repeat Step 6 to add other accounts to be deleted.
8 Click Delete Selected Accounts, then click Close.


Deleting Multiple User Accounts


1 Log in to Vibe as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 In the Management section, click User Accounts.
4 Click the Disable/Delete Accounts tab.
5 Click Select From All Accounts.
6 Select the accounts that you want to delete.
7 Click Delete Selected Accounts, then click Close.


18.5.2 Deleting a User through LDAP


If you add Vibe users by synchronizing with an LDAP directory, as described in “Adding Vibe Users 
from Your LDAP Directory” in “Basic Installation” in the Novell Vibe 3.2 Installation Guide, Vibe users 
are automatically deleted when you delete the corresponding User object in the LDAP directory. You 
can configure LDAP synchronization to automatically delete Vibe users’ workspaces and content as 
well. For more information, see “LDAP Synchronization Options” in “Basic Installation” in the Novell 
Vibe 3.2 Installation Guide.
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18.6 Disabling Vibe User Accounts
You might want to disable user accounts instead of deleting them. When you delete a user account, 
the account can never be re-activated, so you might want to disable the account rather than delete it if 
you think the user might return to your Vibe site. Disabled accounts do not count as a licensed user.


This section describes how to disable local user accounts as well as accounts that are being 
synchronized with an LDAP directory. You can disable individual accounts, or simultaneously 
disable multiple accounts.


 Section 18.6.1, “Disabling Individual User Accounts,” on page 157
 Section 18.6.2, “Disabling Multiple User Accounts,” on page 157


18.6.1 Disabling Individual User Accounts


1 Log in to Vibe as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 In the Management section, click User Accounts.
4 Click the Disable/Delete Accounts tab.
5 Click Disable Individual Accounts.
6 In the User field, begin typing the name of the user whose account you want to disable, then click 


the name when it appears in the drop-down list.
7 (Optional) Repeat Step 6 to add other accounts to be disabled.
8 Click Disable Selected Accounts, then click Close.


18.6.2 Disabling Multiple User Accounts


1 Log in to Vibe as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 In the Management section, click User Accounts.
4 Click the Disable/Delete Accounts tab.
5 Click Select From All Accounts.
6 Select the accounts that you want to disable.
7 Click Disable Selected Accounts, then click Close.
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18.7 Managing Local Users and Groups by Importing Profile 
Files
You can manage local users and groups by importing profile files that contain user or group 
information in XML format. This is a good way to simultaneously perform multiple actions when 
you are not using LDAP.


You can perform the following actions:


 Create or modify users
 Delete users
 Create or modify groups


To manage local users and groups by importing profile files:


1 Log in to Vibe as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 In the Management section, click User Accounts.
4 Click the Import Profiles tab.
5 Click Choose File, then navigate to and select the file that contains user or group profile 


information in XML format.
Ensure that the format of your file matches the format that is shown in the provided sample file. 
To view the provided sample file, click View a Sample File in the Import Files tab.


6 Click OK.


18.8 Preventing Users from Creating User Accounts
In some contexts, you do not want Novell Vibe users to be able to set up Vibe user accounts. You want 
Vibe account creation to be reserved for the Vibe administrator.


The Novell Vibe product name prior to version 3 is Novell Teaming. By default, Novell Teaming 2.0 
enabled all users to create additional user accounts. If you updated your Teaming site from 2.0 to 
Novell Vibe 3 or later, or from Novell Teaming 2.0 to 2.1 to Novell Vibe 3 or later, this functionality 
continues, and you might want to prevent users from creating user accounts. Starting with Teaming 
2.1, users by default are not allowed to create user accounts, so this section does not apply to new 
Teaming 2.1 or Vibe sites.


1 Click the Workspace tree icon , expand Home Workspace, then click Personal Workspaces to list 
your existing Vibe users.
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2 Click Workspace > Access Control in the Action toolbar.


3 Select no, then click Apply so that the workspace no longer inherits its access control settings 
from the parent workspace.
This activates the access control table.


4 For the All Users group, deselect the check box in the Participant column.
This removes the Add User option from the list of Vibe users under Personal Workspaces for 
regular Vibe users. It is still available for the Vibe administrator.
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5 Ensure that the check box in the Visitor column is selected.
This enables users to view all Vibe users in this folder.


6 Click Save Changes, then click Close.


18.9 Enabling Users to Bypass the XSS Security Filter
Cross-site scripting (XSS) is a client-side computer attack that is aimed at Web applications. Because 
XSS attacks can pose a major security threat, Novell Vibe contains a built-in security filter that 
protects against XSS vulnerabilities. This security filter is enabled by default. 


The XSS security filter protects the Vibe site from XSS in two key areas: 


 Text and HTML fields in entries and folders
 Uploaded HTML files


Specific users might need to add some of the content described in “Understanding What Content Is 
Not Permitted” on page 271. If you trust these users, you can enable them to bypass the XSS security 
filter by adding JavaScript and other restricted content. 


IMPORTANT: We do not recommend that you turn off the XSS security filter for the entire site. For 
more information about keeping your Vibe site secure from XSS, see Section 37.3.10, “Securing the 
Vibe Site against XSS,” on page 271.


Enabling a group to bypass the XSS filter is more efficient than enabling individual users because it 
requires you to modify the configuration file only once, when you initially authorize the group. After 
the initial setup, you can easily modify group membership.


 Section 18.9.1, “Enabling Groups to Bypass the XSS Security Filter,” on page 160
 Section 18.9.2, “Enabling Individual Users to Bypass the XSS Security Filter,” on page 161


18.9.1 Enabling Groups to Bypass the XSS Security Filter


The most efficient way to enable users to bypass the XSS security filter is to set up a group in Vibe, 
add users to this group who you trust, then authorize this group to bypass the XSS security filter. 
Only group members have the authority to bypass the XSS security filter.


1 Create a group in Vibe and add only users who you trust to this group.
Members of this group will be allowed to bypass the XSS security filter.
For information on how to create a group and add users to the group, see Section 5.2, “Creating 
Groups of Users,” on page 89.


2 On the Vibe server, change to the following directory:


3 Open the zone-ext.cfg.xml file in a text editor.
4 Add the following information to the xml file, inside the <zoneConfiguration> tags:


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/WEB-INF/classes/config


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF\classes\config
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<zone name="kablink">
 <xssConfiguration>
  <trustedGroups>
   <group name="trusted"/>
  </trustedGroups>
 </xssConfiguration>
</zone>


The group name value should contain the group ID for the group you want to be able to upload 
HTML files to the Vibe site.
If your Vibe system began as Teaming version 1, the zone name value is liferay.com instead of 
kablink


5 Stop and restart Vibe.


18.9.2 Enabling Individual Users to Bypass the XSS Security Filter


1 Change to the following directory:


2 Open the zone-ext.cfg.xml file in a text editor.
3 Add the following information to the xml file, inside the <zoneConfiguration> tags:


<zone name="kablink">
 <xssConfiguration>
  <trustedUsers>
   <user name="jchavez"/>
  </trustedUsers>
 </xssConfiguration>
</zone>


The user name value should contain the user ID for the user you want to be able to upload 
HTML files to the Vibe site.
If your Vibe system began as Teaming version 1, the zone name value is liferay.com instead of 
kablink


To enable multiple users to add HTML content to the Vibe site, create a group and enable the 
group to add content, as described in “Enabling Groups to Bypass the XSS Security Filter” on 
page 160. Or, you can enable multiple users on an individual basis by using multiple <user 
name> elements. For example:


<user name="jchavez"/>
<user name="ahall"/>
<user name="cjones"/>


4 Stop and restart Vibe.


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/WEB-INF/classes/config


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF\classes\config
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19 19Managing Workspaces


As an administrator for Novell Vibe, you can perform management functions on all Vibe workspaces. 
For information on how to perform general workspace management functions, such as creating a 
workspace, deleting a workspace, moving a workspace, and so forth, see “General Workspace 
Management” in the Novell Vibe 3.2 User Guide.


You can perform additional workspace management tasks as the Vibe administrator:


 Section 19.1, “Exporting/Importing Workspaces, Folders, and Entries,” on page 163
 Section 19.2, “Managing Workspace Disk Space Usage,” on page 168


19.1 Exporting/Importing Workspaces, Folders, and Entries
You can transfer data from one Novell Vibe site to another by exporting it from the source Vibe site 
and importing it into the destination Vibe site. When you export data, it remains in the source Vibe 
site and a copy of the exported data is imported into the destination Vibe site.


By default, only the Vibe administrator can export and import workspaces, folders, and entries. For 
information on how to make this functionality available to all workspace and folder owners, see 
Section 2.7, “Enabling Users to Import and Export Workspaces, Folders, and Entries,” on page 36.


 Section 19.1.1, “Understanding the Export and Import Process,” on page 163
 Section 19.1.2, “Exporting Workspaces,” on page 166
 Section 19.1.3, “Importing Workspaces,” on page 166
 Section 19.1.4, “Exporting Folders,” on page 166
 Section 19.1.5, “Importing Folders,” on page 167
 Section 19.1.6, “Exporting Folder Entries,” on page 167
 Section 19.1.7, “Importing Folder Entries,” on page 168


If you want to simply move or copy data within a single Vibe site, see “Copying a Workspace” and 
“Moving a Workspace”, “Copying a Folder” and “Moving a Folder”, or “Copying a Folder Entry” 
and “Moving a Folder Entry” in the Novell Vibe 3.2 User Guide.


19.1.1 Understanding the Export and Import Process


The export process creates a .zip file named export.zip that you can save to any convenient 
location on disk. The .zip file contains all the workspaces, folders, folder entries, and attachments 
that you elected to export.


When you export and import a workspace, folder, or folder entry, not all types of data are preserved.


 “Data That Is Preserved” on page 164
 “Data That Is Not Preserved” on page 165
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Data That Is Preserved


 Hierarchical structure of the workspace


If you are selecting specific folders within the workspace to export, the hierarchical structure to 
the selected folders must be preserved. For example, if you select to export a sub-folder but not 
the parent folder, the parent folder is also included in the export as a blank folder in order to 
keep the structure.


 All folders in the workspace (unless they are specifically excluded)
 All content in exported folders
 Access control information


User and group IDs are also preserved and are matched to the same users and groups if they 
exist on the Vibe system where the workspace, folder, or entry is imported.
Access control settings are not preserved if the workspace, folder, or entry is inheriting its access 
control settings from the parent folder or workspace in the original Vibe system. When you 
import a workspace, folder, or entry that is inheriting its access control settings, the workspace, 
folder, or entry assumes the access control settings of the higher-level workspace or folder where 
it is being imported. For more information on access control, see Chapter 2, “Planning and 
Controlling User Access to Workspaces and Folders,” on page 19.


 Landing pages for workspaces or folders
For more information on landing pages, see “Creating and Managing Landing Pages” in the 
Novell Vibe 3.2 Advanced User Guide.


 Entry definitions associated with any folder content
Entry definitions are custom entry forms that have been created in your folder or workspace. 
Entry definitions that are being used in any exported content are preserved, even if the 
definition is saved at a higher level in the workspace hierarchy. For more information on entry 
definitions, see “Designing Custom Folder Entry Forms” in the Novell Vibe 3.2 Advanced User 
Guide.


 Workflows associated with any workspace content
Workflows that are being used in any exported content are preserved, even if the workflow is 
saved at a higher level in the workspace hierarchy. 


NOTE: If your workflow contains an On Entry condition that starts a parallel workflow thread, 
as described in “Adding On-Entry or On-Exit Events” in the Novell Vibe 3.2 Advanced User Guide, 
the parallel workflow is automatically restarted when the workflow is imported.


For more information on workflows, see “Creating and Managing Workflows” in the Novell Vibe 
3.2 Advanced User Guide.


 Custom forms associated with any workspace content
Custom forms that are being used in any exported content are preserved, even if the custom 
form is saved at a higher level in the workspace hierarchy.For more information on custom 
forms, see “Designing Custom Folder Entry Forms” in the Novell Vibe 3.2 Advanced User Guide.


 Wiki links
For more information on wiki links, see “Linking to a Folder or Folder Entry” in the Novell Vibe 
3.2 User Guide.
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 Content in Mirrored Files folders
When you export a Mirrored Files folder, the files from the mirrored folder are written in the 
export file. However, when the folder is imported, the resulting folder becomes a Vibe library 
folder where all the files are added as regular file entries that are no longer mirrored. There is no 
way to export a mirrored folder and import it back into Vibe as a mirrored folder.


Data That Is Not Preserved


The following types of data are not included in the export and import processes:


 Profile information for user workspaces


When a user workspace is exported and imported, the profile information for the user is not 
preserved. To move user workspaces from one Vibe site to another, add users to the target Vibe 
server in one of the ways described in Section 5.1, “Adding New Users to Your Vibe Site,” on 
page 89. You can then export the folders within the workspace from the source Vibe site, then re-
import the folders into the target Vibe site to the user workspace for each appropriate user.


 Accessories
For more information on accessories, see “Managing Accessories” in the Novell Vibe 3.2 User 
Guide.


 Custom JSP files
Custom JSP files must be exported as part of an extension. (For more information on extensions, 
see Chapter 13, “Adding Software Extensions to Your Vibe Site,” on page 123.) However, if you 
have a workspace that leverages custom JSP files, the workspace still retains the settings that 
point to the custom JSP files. Therefore, if you export a workspace or folder that is referencing 
custom JSP files, and the Vibe site where you import the workspace has the same custom JSP 
files, the imported workspace or folder points to the correct custom JSP files.


 Permalinks
Entries that are exported receive new permalinks when they are imported. However, if an entry 
description contains a permalink to another entry that was also imported, then the permalink is 
preserved.


 Activity data, such as who visited the place, edit history, and workflow history
For more information about activity data, see “Generating Activity Reports for a Workspace”, 
“Generating an Activity Report on a Folder”, and “Generating Reports about a Folder Entry” in 
the Novell Vibe 3.2 User Guide.


 Entry ratings
For more information on entry ratings, see “Rating a Folder Entry” in the Novell Vibe 3.2 User 
Guide.


 Entry definitions that are not associated with folder content
Entry definitions are custom entry forms that have been created in your folder or workspace. For 
more information on entry definitions, see “Designing Custom Folder Entry Forms” in the 
Novell Vibe 3.2 Advanced User Guide.


 Workflows that are not associated with workspace content
For more information on workflows, see “Creating and Managing Workflows” in the Novell Vibe 
3.2 Advanced User Guide.


 E-mail notification settings
 Default folder columns
 Global filters
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19.1.2 Exporting Workspaces


1 Log in to the Vibe site as the Vibe administrator.
2 Navigate to the workspace that you want to export.
3 Click Workspace > Import/Export Workspace.


The Export/Import page is displayed.


4 Select Export This Folder or Workspace.
5 To export all contents of the folder or workspace, click OK.


or
To export only individual workspaces and folders, select Only export child folders or workspaces 
that are specifically checked, then expand the workspace tree and select the workspaces and folders 
that you want to export. Then click OK.


19.1.3 Importing Workspaces


1 Log in to the Vibe site as the Vibe administrator.
2 Navigate to the workspace where you want the imported workspace to reside.
3 Click Workspace > Import/Export Workspace.


The Export/Import page is displayed.
4 Select Import into This Folder or Workspace.


5 Browse to and select the workspace that you want to import, then click OK.


19.1.4 Exporting Folders


1 Log in to the Vibe site as the Vibe administrator.
2 Navigate to the folder that you want to export.
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3 Click Folder > Import/Export Folder.
The Export/Import page is displayed.


4 Select Export This Folder or Workspace.
5 To export all contents of the folder or workspace, click OK.


or
To export only individual workspaces and folders, select Only export child folders or workspaces 
that are specifically checked, then expand the workspace tree and select the workspaces and folders 
that you want to export. Then click OK.


19.1.5 Importing Folders


1 Log in to the Vibe site as the Vibe administrator.
2 Navigate to the folder or workspace where you want the imported folder to reside.
3 Click Folder > Import/Export Folder if you are importing into a folder.


or
Click Workspace > Import/Export Workspace if you are importing into a workspace.
The Export/Import page is displayed.


4 Select Import into This Folder or Workspace.


5 Browse to and select the folder that you want to import, then click OK.


19.1.6 Exporting Folder Entries


1 Log in to the Vibe site as the Vibe administrator.
2 Navigate to and select the folder entry that you want to export.
3 In the entry footer, click Export this entry.


You can now download the entry to your computer’s file system.
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19.1.7 Importing Folder Entries


1 Log in to the Vibe site as the Vibe administrator.
2 Navigate to the folder where you want the imported folder entry to reside.
3 Click Folder > Import/Export Folder.


The Export/Import page is displayed.
4 Select Import into This Folder or Workspace.


5 Browse to and select the folder entry that you want to import, then click OK.


19.2 Managing Workspace Disk Space Usage 
Disk space usage is managed on both a folder and workspace basis as well as an individual user or 
group basis.


You can enforce one or both of these types of data quotas. See Chapter 20, “Managing Disk Space 
Usage with Data Quotas and File Restrictions,” on page 169.
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20 20Managing Disk Space Usage with Data 
Quotas and File Restrictions


As time passes, your Novell Vibe site occupies more and more disk space as users post folder entries, 
attach files, create new versions of files, and so on. As the Vibe administrator, you can impose limits 
on the amount of data that is uploaded into the Vibe site. 


Only files and attachments count toward the data quota. Workspaces, folders, and entries that do not 
contain files and attachments do not count toward the data quota.


You can limit the amount of files and attachments for individual users and groups as well as 
individual workspaces and folders.


 Section 20.1, “Understanding the Types of Data Quotas,” on page 169
 Section 20.2, “Understanding Data Quota Behavior and Exclusions,” on page 170
 Section 20.3, “Managing Workspace and Folder Data Quotas,” on page 171
 Section 20.4, “Managing User Data Quotas,” on page 173
 Section 20.5, “General Data Quota Management,” on page 182
 Section 20.6, “Managing the File Upload Size Limit,” on page 184
 Section 20.7, “Setting a Maximum Number of Versions for Each File,” on page 185
 Section 20.8, “Automatically Deleting Old File Versions,” on page 185


20.1 Understanding the Types of Data Quotas
You as the Novell Vibe administrator can enable two kinds of data quotas:


 User data quotas
 Workspace and folder data quotas


You can enable one of these quotas, or both of them.


 Section 20.1.1, “Understanding User Data Quotas,” on page 169
 Section 20.1.2, “Understanding Workspace and Folder Data Quotas,” on page 170


20.1.1 Understanding User Data Quotas


User data quotas limit the amount of data individual users can add to the Vibe site. Any files and 
attachments that a user adds to the Vibe site counts toward his or her data quota, regardless of the 
folders or workspaces where the user adds them.
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20.1.2 Understanding Workspace and Folder Data Quotas


Workspace and folder quotas limit the amount of data that can be stored in individual workspaces 
and folders.


Sub-workspaces and sub-folders that have a data quota are subject to their own data quota as well as 
any data quotas that exist on parent folders and workspaces. For example, consider a workspace that 
has a data quota of 50 MB. The workspace contains two sub-workspaces: Workspace A and 
Workspace B. Users cannot upload data that is in excess of 50 MB into either of these sub-workspaces. 
Furthermore, users cannot upload data into both of these sub-workspaces that is in excess of 50 MB 
(for example, users cannot upload data that is in excess of 30 MB into both sub-workspace, because 
the amount of combined data for both sub-workspaces is greater than 50 MB).


20.2 Understanding Data Quota Behavior and Exclusions
 Section 20.2.1, “Understanding Default Data Quota Behavior,” on page 170
 Section 20.2.2, “Understanding Data Quota Exclusions,” on page 171


20.2.1 Understanding Default Data Quota Behavior


The following sections describe the default behavior for how user data quotas work after they have 
been enabled. (For information on how to enable data quotas for your Vibe site, see Section 20.3.1, 
“Enabling Workspace and Folder Data Quotas,” on page 171 and Section 20.4.2, “Setting User Data 
Quotas,” on page 175.)


 “Exceeding the Data Quota” on page 170
 “Exceeding the High-Water Mark” on page 170


Exceeding the Data Quota


By default, Vibe users are strictly held to the data quota that you set. If a user who is approaching his 
or her data quota tries to upload a file to the Vibe site and that file exceeds the user’s data quota, Vibe 
rejects the upload attempt and the entry is lost. This is also true with data quotas that are set on 
workspaces and folders.


For user data quotas (not for workspace and folder data quotas), you can allow users to post a final 
entry to the Vibe site even if the entry exceeds the user data quota. This approach is less strict and 
does not guarantee that users won’t exceed the data quota; however, it is more forgiving because it 
allows users to post one final upload to the Vibe site and does not erase the entry and attached file 
that they are trying to upload.


For information on how to configure your Vibe data quotas to be less strict by allowing users one 
final upload to the Vibe site, see Section 20.5.1, “Configuring Data Quotas to Be Less Strict,” on 
page 183.


Exceeding the High-Water Mark


When users exceed the data quota high-water mark, they are notified that they are approaching the 
data quota. Vibe informs them how many kilobytes of disk space are still available. 


For more information on selecting an appropriate high-water mark, see “Selecting an Appropriate 
High-Water Mark” on page 174.
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20.2.2 Understanding Data Quota Exclusions


Files stored in mirrored folders do not count against data quotas because they are not uploaded into 
the Vibe site.


20.3 Managing Workspace and Folder Data Quotas
 Section 20.3.1, “Enabling Workspace and Folder Data Quotas,” on page 171
 Section 20.3.2, “Setting Quotas on Workspaces and Folders,” on page 172
 Section 20.3.3, “Validating Workspace and Folder Quotas,” on page 172


20.3.1 Enabling Workspace and Folder Data Quotas


Before you can set data quotas on workspaces and folders, you must first enable them. You can 
enable data quotas so that only you as the Vibe administrator can manage workspace and folder 
quotas, or you can enable data quotas so that all users can manage the data quotas for their own 
workspaces and folders.


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 Under Management, click Data Quotas and File Upload Limits.


4 Click Initialize Workspace and Folder Quota Counts.
This sets up the workspace and folder data quota for your Vibe site. This operation can take a 
significant amount of time (10 to 20 minutes).
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5 Select Enable Workspace and Folder Quotas.
6 (Optional) If you want to allow users to manage the data quotas for their own workspaces and 


folders, select Allow Workspace and Folder Owners To Set Quotas.
7 Click Apply > Close.
8 Set data quotas on workspaces and folders as described in Section 20.3.2, “Setting Quotas on 


Workspaces and Folders,” on page 172.


20.3.2 Setting Quotas on Workspaces and Folders


Before you can set data quotas on workspaces and folders, you need to enable them, as described in 
Section 20.3.1, “Enabling Workspace and Folder Data Quotas,” on page 171.


You can set quotas on individual workspaces and folders, or you can set quotas on all workspaces 
and folders of a certain type. For example, you can configure all Photo Album folders in your Vibe 
site to have a data quota of 10 MB.


 “Setting Quotas on Individual Workspaces and Folders” on page 172
 “Setting Quotas on All Workspaces and Folders of a Certain Type” on page 172


Setting Quotas on Individual Workspaces and Folders


1 Navigate to the workspace and folder where you want to set the quota.
2 Click Workspace > Configure Views, URLs and Controls if you are setting the quota for a workspace.


or
Click Folder > Configure Views, URLs and Controls if you are setting the quota for a folder.


3 Click the Quotas tab.
4 In the Set a Quota field, specify the new data quota, then click OK.


Setting Quotas on All Workspaces and Folders of a Certain Type


When you set data quotas on all workspaces or folders of a certain type, the quota applies only to 
workspaces or folders that are created after you set the quota. Workspaces and folders that were 
created before the quota was set do not automatically have a data quota assigned to them.


To set a data quota on all workspaces and folders of a certain type, you need to modify the template 
for the workspace or folder where you want to set the data quota. For information on how to modify 
the template for workspaces and folders, see Section 21.2, “Modifying Workspace and Folder 
Templates,” on page 187.


20.3.3 Validating Workspace and Folder Quotas


Quota counts for workspaces and folders can become marginally inaccurate over time if multiple 
users are frequently adding and deleting files in a workspace or folder where a data quota has been 
set. 


You can repair any data quota inaccuracies by validating the data quota:


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
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3 Under Management, click Data Quotas and File Upload Limits.


4 Click Validate Workspace and Folder Quota Counts.
5 Click Apply > Close.


20.4 Managing User Data Quotas
Each user’s data quota establishes how much disk space the user’s attached files and file versions can 
occupy in the Vibe site. Workspaces, folders, and entries that do not contain files or attachments do 
not count toward a user’s data quota.


By default, users are not limited in the disk space that their attached files and file versions occupy in 
the Vibe site. As the Vibe administrator, you can decide when limiting users’ disk space usage 
becomes appropriate.


 Section 20.4.1, “Planning User Data Quotas,” on page 173
 Section 20.4.2, “Setting User Data Quotas,” on page 175
 Section 20.4.3, “Modifying User Data Quotas,” on page 178
 Section 20.4.4, “Removing User Data Quotas,” on page 180
 Section 20.4.5, “Managing Your Personal Data Quota,” on page 182
 Section 20.4.6, “Monitoring User Data Quotas,” on page 182


20.4.1 Planning User Data Quotas


 “Understanding User Data Quota Priority” on page 174
 “Selecting the Default User Data Quota for All Users” on page 174
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 “Selecting an Appropriate High-Water Mark” on page 174
 “Determining Data Quotas for Specific Users” on page 175
 “Determining Data Quotas for Specific Groups” on page 175


Understanding User Data Quota Priority


Because users can have multiple data quotas assigned to them, either individually, through group 
membership, or through the site-wide default, Vibe prioritizes the existing data quotas and uses only 
one for each individual Vibe user. If users have multiple data quotas that pertain to them, the priority 
level is as follows:


1. User Quota: A quota that is set for an individual user overrides the site-wide default quota and 
any other quotas that are associated with any groups where the user is a member.


2. Group Quota: A quota that is set for an individual group overrides the site-wide default quota. 
This pertains to all users who are members of that group.
When a user is a member of multiple groups that have  data quotas associated with them, the 
user is given the highest data quota. For example, if a Vibe user is a member of Group A, Group 
B, and Group C, and the data quotas for each of these groups is 10, 20, and 30, the Vibe user’s 
data quota is 30.


3. Site-Wide Default: The site-wide default quota is used for all Vibe users who have not been 
assigned individual quotas, and who are not associated with any groups where a quota has been 
set.


Selecting the Default User Data Quota for All Users


When you enable the data quota feature, the initial default data quota is 100 MB. This means that 
each Vibe user can upload 100 MB of files and attachments to the Vibe site. There is one default data 
quota for each Vibe zone. 


When you select the default data quota for your Vibe site, consider the size of your Vibe site, the 
number of Vibe users, the amount of available disk space, and so on. You can override the default 
data quota on a per-user and per-group basis, as described in Section 20.4.2, “Setting User Data 
Quotas,” on page 175.


As described in “Exceeding the Data Quota” on page 170, when a user adds enough files and 
attachments to exceed the data quota, the user can no longer attach files or create versions until 
existing files have been deleted and purged to free up storage space.


For information about purging deleted files to make storage space available, see Section 20.5.2, 
“Purging Deleted Files,” on page 183.


For information about the user experience when nearing or exceeding a data quota, see “Adding Files 
and Attachments to the Vibe Site When You Are Over Your Quota” in the Novell Vibe 3.2 Advanced 
User Guide. 


For information about which data quota is used when users have multiple data quotas that pertain to 
them, see “Understanding User Data Quota Priority” on page 174.


Selecting an Appropriate High-Water Mark


The high-water mark is the percentage of the data quota when users are notified that they are 
approaching their data quotas. The default high-water mark is 90% of a user’s data quota. 


This high-water mark also applies to data quotas that are set on workspaces and folders.

174  Novell Vibe 3.2 Administration Guide







Determining Data Quotas for Specific Users


If there is a user in your Vibe site who needs either a higher or lower data quota than the site-wide 
default, you can assign that user an individual user data quota.


When you set data quotas for specific users, remember that individual user data quotas override the 
default user data quota, as well as quotas that are assigned to any groups where the user is a member, 
as described in “Understanding User Data Quota Priority” on page 174.


Determining Data Quotas for Specific Groups


When you set data quotas for specific groups, remember that group data quotas override the default 
site-wide data quota, but do not override individual user quotas, as described in “Understanding 
User Data Quota Priority” on page 174.


20.4.2 Setting User Data Quotas


You can set data quotas for the entire Vibe site, for individual groups, and for individual users.


 “Setting a Default Data Quota” on page 175
 “Setting Data Quotas for Individual Groups” on page 176
 “Setting Data Quotas for Individual Users” on page 177


Setting a Default Data Quota


When you set a default data quota, the quota applies to all Vibe users who have not been assigned 
individual quotas, and who are not associated with any groups where a quota has been set.


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 Under Management, click Data Quotas and File Upload Limits.
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4 Select Enable User Data Quotas.
5 Set the Default Data Quota Size and Default High-Water Mark options as determined in 


Section 20.4.1, “Planning User Data Quotas,” on page 173.
6 Click Apply > Close to save the user data quota settings.


Setting Data Quotas for Individual Groups


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 Under Management, click Data Quotas and File Upload Limits.
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4 Select Enable User Data Quotas.
5 Click Add a Group.


6 In the Group field, start typing the name of the group for which you want to set a quota, then 
click the group name when it appears in the drop-down list.
Repeat this process to add additional groups for which you want to assign the same data quota.


7 In the Quota field, specify the disk space limit for the group.
8 Click OK, then click Apply > Close to save the user data quota settings.


Setting Data Quotas for Individual Users


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 Under Management, click Data Quotas and File Upload Limits.
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4 Select Enable User Data Quotas.
5 Click Add a User.


6 In the User field, start typing the name of the user for which you want to set a quota, then click 
the user’s name when it appears in the drop-down list.
Repeat this process to add additional users for which you want to assign the same data quota.


7 In the Quota field, specify the disk space limit for the user.
8 Click OK, then click Apply > Close to save the user data quota settings.


20.4.3 Modifying User Data Quotas


Vibe enables you to modify data quotas that you have previously set. You can modify data quotas for 
your entire Vibe site, or modify data quotas for individual groups and users.


 “Modifying User Data Quotas for the Entire Vibe Site” on page 178
 “Modifying User Data Quotas for Individual Groups and Users” on page 179


Modifying User Data Quotas for the Entire Vibe Site


Vibe enables you to easily modify the site-wide default user data quota.


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
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3 Under Management, click Data Quotas and File Upload Limits.


4 In the Default User Data Quota Size field, delete the existing quota and specify the new quota.
You can also modify the default high-water mark in the Default High-Water Mark field. For more 
information about the high-water mark, see “Selecting an Appropriate High-Water Mark” on 
page 174.


5 Click Apply > Close to save the user data quota settings.


Modifying User Data Quotas for Individual Groups and Users


Vibe enables you to easily modify individual group and user data quota settings that you have 
previously set.


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 Under Management, click Data Quotas and Fiile Upload Limits.
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4 In the Group Quotas table or User Quotas table, click the group name or user name that represents 
the group or user whose quota you want to modify.


5 In the Quota field, delete the existing quota and specify a new quota.
6 Click OK, then click Apply > Close to save the user data quota settings.


20.4.4 Removing User Data Quotas


Vibe enables you to disable data quotas that you have previously set. You can disable data quotas for 
your entire Vibe site, or remove data quotas from individual groups and users.


 “Disabling User Data Quotas for the Entire Vibe Site” on page 180
 “Removing User Data Quotas from Individual Groups and Users” on page 181


Disabling User Data Quotas for the Entire Vibe Site


If you decide that you no longer need to impose limits on the amount of data that users are permitted 
to upload into the Vibe site, you can disable the data quota feature. Disabling the data quota feature 
enables all Vibe users to upload as much data to the Vibe site as they want.


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
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3 Under Management, click Data Quotas and File Upload Limits.
The Data Quotas and File Upload Limits page is displayed.


4 Deselect Enable User Data Quotas, then click Apply.


Data quotas are no longer enabled for your Vibe site.


Removing User Data Quotas from Individual Groups and Users


You can remove data quotas that you have previously set for individual groups and users. Users are 
held to the site-wide data quota default setting if they do not have an individual quota defined for 
them and they are not members of any groups where a group quota has been assigned.


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 Under Management, click Data Quotas and File Upload Limits.
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4 In the Group Quotas table or User Quotas table, select the check box next to the group or user 
whose quota you want to remove.


5 Click Delete, then click Apply > Close to save the user data quota settings.


20.4.5 Managing Your Personal Data Quota


NOTE: As a Vibe administrator, you are also held to a data quota. If you want to assign yourself a 
larger quota than the site-wide default, you can add an individual quota for yourself, as described in 
“Setting Data Quotas for Individual Users” on page 177.


All Vibe users need to manage their personal data quotas. When you have a limited allocation of disk 
space, you need to be aware of the amount of disk space that you have available, know how to make 
more disk space available as you approach your quota, and know what counts against your quota 
and what doesn’t.


For information on how to accomplish these and other important tasks as you manage your data 
quota, see “Managing Your Data Quota” in the Novell Vibe 3.2 Advanced User Guide.


20.4.6 Monitoring User Data Quotas


You can monitor which users in the Vibe site have exceeded or are close to exceeding their data 
quotas by generating the following reports:


 Section 26.2.5, “Data Quota Exceeded Report,” on page 222
 Section 26.2.6, “Data Quota Highwater Exceeded Report,” on page 223


20.5 General Data Quota Management
This section describes tasks that are common to both types of data quotas: workspace and folder data 
quotas and user data quotas.


 Section 20.5.1, “Configuring Data Quotas to Be Less Strict,” on page 183
 Section 20.5.2, “Purging Deleted Files,” on page 183
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20.5.1 Configuring Data Quotas to Be Less Strict


This section applies only to user data quotas. You cannot configure workspace and folder quotas to 
be less strict, as described in this section.


As a Vibe administrator, you can decide how strictly you want to enforce user data quota adherence. 
You can maintain the default behavior, or you can be less strict by allowing users to post a final entry 
that exceeds the data quota.


For more information about the default behavior for a data quota, see Section 20.2.1, “Understanding 
Default Data Quota Behavior,” on page 170.


To configure Vibe to allow users to post a final entry that exceeds the data quota:


1 Change to the following directory:


2 Make a backup copy of the ssf-ext.properties file.
3 Open the ssf-ext.properties file in a text editor.
4 Add the following line to the ssf-ext.properties file:


data.quota.strict.conformance=false


5 Save and close the ssf-ext.properties file.
6 Stop and restart Vibe.


20.5.2 Purging Deleted Files


When users delete files or file versions, the disk space occupied by the deleted files and versions 
counts against the data quotas until users purge the files and versions, as described in “Making Disk 
Space Available by Purging Deleted Items” in the Novell Vibe 3.2 Advanced User Guide. 


As a Vibe administrator, you can purge files and versions anywhere on the Vibe site in order to 
recover disk space.


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Workspace tree icon , then click Home Workspace.
All global workspaces, team workspaces, and personal workspaces are located under the Home 
Workspace.


3 Click Trash at the bottom of the Left Navigation pane to display a list of all deleted files and 
versions.
By default, the list is ordered alphabetically by title.


4 (Optional) Click a column heading to sort the list by when items were deleted, who deleted the 
items, or where the items were deleted on the Vibe site.


5 Select items to purge, then click Purge.
After items have been purged, they cannot be recovered except from the archive store, as 
described in Section 25.4, “Manually Restoring Individual Entries,” on page 211.


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/WEB-INF/classes/config


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF\classes\config
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20.6 Managing the File Upload Size Limit
The file upload size limit conserves disk space on your Novell Vibe site because it prevents users 
from uploading large files to the Vibe site. The default size limit for uploading files into your Vibe site 
is 2 GB.


Browsers also impose limits on the size of files that can be uploaded. This limit differs depending on 
which browser you are using to run Vibe.


 Section 20.6.1, “Modifying the File Upload Size Limit for the Vibe Site,” on page 184
 Section 20.6.2, “Setting a File Upload Size Limit for Individual Users and Groups,” on page 184
 Section 20.6.3, “Setting a File Upload Size Limit for Individual Workspaces and Folders,” on 


page 185


20.6.1 Modifying the File Upload Size Limit for the Vibe Site


You as the Vibe administrator can increase or descrease this size limit for the Vibe site. Workspace 
and folder owners can set a file upload size limit for their own workspaces and folders, but the limit 
in individual workspaces and folders cannot exceed what you set for the Vibe site.


1 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
2 Under Management, click Data Quotas and File Upload Limits.
3 In the File Upload Size Limits section, specify the new file upload size limit.
4 Click Apply > Close.


20.6.2 Setting a File Upload Size Limit for Individual Users and Groups


You can assign a file upload size limit to individual users and groups that is different from the site-
wide file upload size limit. For example, if the file upload size limit for your Vibe site is 2 GB, but 
your Marketing team often uploads large files, you can give the Marketing group a file upload size of 
3 GB.


 “Setting a Limit for a Group” on page 184
 “Setting a Limit for a User” on page 185


Setting a Limit for a Group


1 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
2 Under Management, click Data Quotas and File Upload Limits.
3 In the File Upload Size Limits section, click Add a Group.
4 Specify the following information:


Group: Begin typing the group name for which you want to set a file upload size limit, then click 
the name when it appears in the list.
File Size Limit: Specify the new file size limit for the group.


5 Click OK.
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Setting a Limit for a User


1 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
2 Under Management, click Data Quotas and File Upload Limits.
3 In the File Upload Size Limits section, click Add a User.
4 Specify the following information:


User: Begin typing the user name for which you want to set a file upload size limit, then click the 
name when it appears in the list.
File Size Limit: Specify the new file size limit for the user.


5 Click OK.


20.6.3 Setting a File Upload Size Limit for Individual Workspaces and Folders


Workspace and folder owners can set a file upload size limit on individual workspaces and folders. If 
a site-wide limit has been set by the Vibe administrator, the limit on the workspace or folder must be 
less than the site-wide limit. For more information, see “Limiting the File Upload Size for Folders and 
Workspaces” in “Managing Folders” in the Novell Vibe 3.2 Advanced User Guide.


20.7 Setting a Maximum Number of Versions for Each File
Because a significant amount of data can be consumed by old versions of files, you can configure the 
Vibe site to allow only a certain number of file versions for each file version set within the folder or 
workspace. (A file version set includes the major file version and all minor file versions. For more 
information about major and minor file versions, see “Incrementing the Major Version Number of a 
File” in “Working with Files in a Folder Entry” in the Novell Vibe 3.2 User Guide.)


To configure the Vibe site in this way, navigate to the top-level workspace (which by default is called 
Home Workspaces), then follow the instruction in “Automatically Deleting Minor File Versions That 
Exceed the Allowed Maximum” in the Novell Vibe 3.2 Advanced User Guide.


20.8 Automatically Deleting Old File Versions
Because a significant amount of data can be consumed by old versions of files, you can configure all 
minor versions of each file to be automatically deleted after a specified number of days on the Vibe 
site. When you configure your Vibe site in this way, all minor versions of each document are deleted 
after the specified number of days (major versions are never deleted).


Workspace and Folder owners can remove this setting for their workspaces and folders, or specify a 
different number of days, as described in “Automatically Deleting Minor File Versions After a 
Specified Number of Days” in the Novell Vibe 3.2 Advanced User Guide.


1 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
2 Under System, click Configure File Version Aging.
3 Specify the number of days to wait before each lower-level version is automatically deleted, then 


click Apply > Close.
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21 21Managing Workspace and Folder 
Templates


Workspace and Folder templates are a powerful and efficient way to manage your Novell Vibe site. 
They enable you to customize the default features, default layout, and default access control settings 
of the workspaces and folders throughout your Vibe site. 


For example, the Team Workspaces template is used when any team workspace is created. By default, 
the access control settings for the Team Workspaces template specify that only team members are 
able to view the team workspace. However, if you want to run a more relaxed Vibe site and allow all 
Vibe users to view any team workspace, you can simply modify the access control settings on the 
Team Workspaces template.


Changes that you make to templates affect only those workspaces and folders that are created after 
the template was modified.


For more information about templates, see Section 3.5.1, “Understanding Templates,” on page 53.


 Section 21.1, “Creating Workspace and Folder Templates,” on page 187
 Section 21.2, “Modifying Workspace and Folder Templates,” on page 187
 Section 21.3, “Exporting Templates,” on page 191
 Section 21.4, “Importing Templates,” on page 193
 Section 21.5, “Reverting All Templates to the Factory Default,” on page 193


21.1 Creating Workspace and Folder Templates
For information on how to create new workspace and folder templates, see Section 3.5.3, “Creating 
Workspace and Folder Templates,” on page 56.


21.2 Modifying Workspace and Folder Templates
Novell Vibe enables you to modify default templates as well as custom templates that you have 
already created.


For information on how to create custom templates, see Section 3.5.3, “Creating Workspace and 
Folder Templates,” on page 56.


1 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
2 Under Management, click Workspace and Folder Teamplates.
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3 Click the workspace or folder template that you want to modify.
From this page you can do any of the following:


 Section 21.2.1, “Deleting the Template,” on page 188
 Section 21.2.2, “Exporting the Template,” on page 188
 Section 21.2.3, “Renaming the Template,” on page 189
 Section 21.2.4, “Adding an Existing Workspace Template,” on page 189
 Section 21.2.5, “Adding an Existing Folder Template,” on page 189
 Section 21.2.6, “Removing a Folder Template or Workspace Template from the Template,” on 


page 190
 Section 21.2.7, “Adding Access Controls to the Template,” on page 190
 Section 21.2.8, “Adding a Data Quota to the Template,” on page 190
 Section 21.2.9, “Changing the Default View for the Template,” on page 190
 Section 21.2.10, “Changing the Title, Description, Brand, and Icon for the Template,” on page 191
 Section 21.2.11, “Modifying the Accessory Panel for the Template,” on page 191


21.2.1 Deleting the Template


Deleting a template deletes the template and all sub-templates.


1 Click Manage This Template.
2 Click Delete This Template > OK.


21.2.2 Exporting the Template


1 Click Manage This Template.
2 Click Export This Template > OK.


For information on how to export multiple templates simultaneously, see Section 21.3.2, “Exporting 
Multiple Templates,” on page 192.
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21.2.3 Renaming the Template


You can change the information that is displayed on the Add New Workspace page (or Add New 
Folder page), when users select which type of workspace they want to add.


1 Click Manage This Template.
2 Click Modify This Template.
3 Specify the following information:


Name: This is the internal database name.
Template Title: This name appears in the Add New Workspace page (or Add New Folder page) 
when users select which type of workspace they want to add.
Description: This description appears in the Add New Workspace page (or Add New Folder 
page) when users select which type of workspace they want to add.


4 Click Modify.


21.2.4 Adding an Existing Workspace Template


You can add a workspace template to the template that you are currently modifying. The workspace 
template that you add becomes a sub-workspace to the main workspace. All template sub-
workspaces and sub-folders that you add are preserved when the template is used in your Vibe site.


1 Click Manage This Template.
2 Click Add Workspace Template.
3 In the Currently Defined Templates section, select the workspace template that you want to add.
4 Click Add.


A cloned copy of the workspace template is added as a sub-folder to the main workspace.


21.2.5 Adding an Existing Folder Template


You can add a folder template to the template that you are currently modifying. The folder template 
that you add becomes a sub-folder to the main workspace or folder. All template sub-workspaces and 
sub-folders that you add are preserved when the template is used in your Vibe site.


You can add a folder template to the template that you are currently modifying.


1 Click Manage This Template.
2 Click Add Folder Template.
3 In the Currently Defined Templates section, select the folder template that you want to add.
4 Click Add.


A cloned copy of the folder template is added as a sub-folder to the main folder or workspace.
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21.2.6 Removing a Folder Template or Workspace Template from the 
Template


You can also remove folder or workspace templates that you previously added to the template that 
you are modifying (as described in Section 21.2.4, “Adding an Existing Workspace Template,” on 
page 189 and Section 21.2.5, “Adding an Existing Folder Template,” on page 189.)  Or you can remove 
folder or workspace templates that exist by default in the template that you are modifying. For 
example, you can remove the Files folder template from the User Workspace template.


1 Expand the workspace tree on the Workspace and Folder Templates page.
2 Select the workspace or folder template that you want to remove.
3 Click Manage This Template.
4 Click Delete This Template > OK.


21.2.7 Adding Access Controls to the Template


1 Click Manage This Target.
2 Click Access Control.


The Configure Access Control page is displayed. 
For information on how to use this page, see Chapter 2, “Planning and Controlling User Access 
to Workspaces and Folders,” on page 19.


3 After you have made your access control modifications, click Close.


An example of adding access controls to a template is described in “Restricting Access to Personal 
Workspaces throughout the Vibe Site” on page 21.


21.2.8 Adding a Data Quota to the Template


1 Click Manage This Target.
2 Click Manage Folder Quota or Manage Workspace Quota, depending on if you are adding a quota to 


a folder or a workspace template.
The Manage Quota page is displayed. 
For information on data quotas for workspaces and folders, see Section 20.3, “Managing 
Workspace and Folder Data Quotas,” on page 171.


3 After you have set a data quota for the workspace or folder template, click OK.


21.2.9 Changing the Default View for the Template


1 Click Manage This Target.
2 Click Configure.


The Configure Default Settings page is displayed.
3 In the Default View section, select the default view that you want the template to have.
4 Click Apply > Close.

190  Novell Vibe 3.2 Administration Guide







21.2.10 Changing the Title, Description, Brand, and Icon for the Template


You can change the attributes of the template that are displayed in the workspace after the workspace 
is created.


1 Click Manage This Target.
2 Click Modify.
3 Change the title, description, brand, and icon as desired, then click OK.


21.2.11 Modifying the Accessory Panel for the Template


Vibe enables you to modify the Accessory Panel in a template.


If the Accessory Panel already contains accessories, you can modify them; or, you can create new 
accessories. For information on how to modify and create accessories, see “Managing Accessories” in 
the Novell Vibe 3.2 User Guide.


21.3 Exporting Templates
You might want to export templates for the following reasons:


 To import the template into another system.


For information on how to import a template, see Section 21.4, “Importing Templates,” on 
page 193.


 To back up the template.
This can be useful if you want to edit a template, so you can restore the original if your edits 
don’t go according to plan.


Novell Vibe enables you to export individual templates, or export multiple templates simultaneously.


 Section 21.3.1, “Exporting a Single Template,” on page 191
 Section 21.3.2, “Exporting Multiple Templates,” on page 192


21.3.1 Exporting a Single Template


1 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
2 Under Management, click Workspace and Folder Templates.
3 Click the workspace or folder template that you want to export.
4 Click Manage This Template.
5 Click Export This Template.
6 Click OK.
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21.3.2 Exporting Multiple Templates


1 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
2 Under Management, click Workspace and Folder Templates.


3 Click Export.


4 In the Select the Templates to be Exported section, select the template or templates that you want to 
export, then click OK.
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21.4 Importing Templates
You can import a template after you have exported it. For information on how to export a template, 
see Section 21.3, “Exporting Templates,” on page 191.


1 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
2 Under Management, click Workspace and Folder Templates.


3 Click Import.
The Import Templates page is displayed.


4 Browse for and select the templates that you want to import, then click OK.
The imported templates are displayed in the Manage Workspace and Folder Templates page.


21.5 Reverting All Templates to the Factory Default
When you revert all templates to the factory default, you lose any modifications that you have made 
to existing templates, as well as any custom templates that you might have created.


1 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
2 Under Management, click Workspace and Folder Templates.


3 Click Reset, then click OK.
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22 22Creating and Managing Workflows


Workflows can improve efficiency in your organization by automating common business processes. 


As an administrator for Novell Vibe, you have the ability to create workflows and make them 
available to all Vibe users. You can also import existing workflows and then tailor them to your 
specific organization.


Examples of workflows include approving documents, ordering supplies, hiring new employees, 
requesting paid time off, and getting expense reimbursements.


 Section 22.1, “Creating Global Workflows,” on page 195
 Section 22.2, “Downloading Existing Custom Forms and Workflows,” on page 196


22.1 Creating Global Workflows
You can create workflows that are accessible to all Novell Vibe users.


1 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
2 Under System, click Form/View Designers.


3 Follow the steps for creating and managing a workflow, as described in “Creating and 
Managing Workflows” in the Novell Vibe 3.2 Advanced User Guide.
Remember that when you create workflows at the Administration level, the workflows that you 
create can be leveraged by all users in your Vibe site.
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22.2 Downloading Existing Custom Forms and Workflows
The Novell Vibe Resource Library provides a collection of existing Novell Vibe folder entry forms 
and workflows that have been designed to solve specific business problems. You can easily 
download the custom forms and workflows, then import them into your Vibe environment. You can 
further customize these forms and workflows to suit your individual business needs.


1 Visit the Novell Vibe Resource Library (http://www.novell.com/products/vibe/resource-library/
).


2 Select the custom form or workflow that you want to use in your Vibe environment.
3 In the Attachment section, click the zip file to download it.
4 Import the file into your Vibe environment and deploy it for use.


For information on how to do this, follow the Novell Vibe Resource Library Deployment 
Instructions (http://www.novell.com/products/vibe/resource-library/demos/
form_workflow_deployment.html).
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23 23Managing E-Mail Configuration


After you enable e-mail integration for the Vibe site as described in Chapter 8, “Configuring E-Mail 
Integration,” on page 111, you can further modify the way e-mails are managed on the Vibe site.


 Section 23.1, “Configuring the Field that Vibe Uses When Sending E-Mails,” on page 197
 Section 23.2, “Configuring the Number of Users Who Can Be Included in the Same E-Mail 


Notification,” on page 198
 Section 23.3, “Configuring Vibe to Send E-Mail Messages and Notifications from a Custom 


Address,” on page 198
 Section 23.4, “Enabling Users to Configure a Folder or External E-Mail Address to Receive Sent 


E-Mails,” on page 200


23.1 Configuring the Field that Vibe Uses When Sending E-Mails
By default, e-mails that are sent from Vibe are sent with the recipients in the BCC field. You can 
configure Vibe to use the To field rather than the BCC field for all sent messages.


Configuring Vibe in this way makes it so message recipients can see other message recipients in the e-
mail notification. For information about how to configure Vibe to send individual messages to each 
user rather than including multiple users on the same message, see Section 23.2, “Configuring the 
Number of Users Who Can Be Included in the Same E-Mail Notification,” on page 198.


1 Change to the following directory:


2 Open the ssf.properties file in a text editor.
3 Search for the following line:


mail.notifyAsBCC=true


4 Make a backup copy of the ssf-ext.properties file, which is located in the same directory as 
the ssf.properties file.


5 Open the ssf-ext.properties file in a text editor.
6 Copy the mail.notifyAsBCC=true line from the ssf.properties file to the bottom of the ssf-


ext.properties file.
7 Change true to false, so that the line now reads mail.notifyAsBCC=false.
8 Save and close the ssf-ext.properties file.


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/WEB-INF/classes/config


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF\classes\config
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9 Close the ssf.properties file without saving it.
10 Stop and restart Vibe to configure Vibe to use the To field rather than the BCC field when 


sending messages.


23.2 Configuring the Number of Users Who Can Be Included in 
the Same E-Mail Notification
By default, Vibe imposes a limit of 500 message recipients for each e-mail notification that Vibe sends. 
You might want to change this limit to 1 if you have configured Vibe as described in Section 23.1, 
“Configuring the Field that Vibe Uses When Sending E-Mails,” on page 197.


1 Change to the following directory:


2 Make a backup copy of the ssf-ext.properties file, which is located in the same directory as 
the ssf.properties file.


3 Open the ssf.properties file in a text editor.
4 Search for the following line:


mail.rcpt.limit=500


5 Open the ssf-ext.properties file in a text editor.
6 Copy the mail.rcpt.limit=500 line from the ssf.properties file to the bottom of the ssf-


ext.properties file.
7 Change 500 to 1, so that the line now reads mail.rcpt.limit=1.
8 Save and close the ssf-ext.properties file.
9 Close the ssf.properties file without saving it.


10 Stop and restart Vibe to configure Vibe to include only one user in each e-mail notification that is 
sent.


23.3 Configuring Vibe to Send E-Mail Messages and 
Notifications from a Custom Address
For security reasons, your corporation’s e-mail system might be set up to automatically delete 
messages from internal users that are not sent from the corporate e-mail system. If your corporate e-
mail system is configured in this way, e-mail messages and notifications sent from Novell Vibe are 
automatically deleted.


You can configure Vibe to send e-mail messages directly from the Vibe server, rather than from 
internal users. These are messages that are sent when a user performs an action that creates a 
message. For example, when a user shares a workspace with another Vibe user, a message is sent to 
the receiving user’s e-mail mailbox. By default, this message is sent from the internal user. However, 
you can configure Vibe to send such messages from the Vibe server itself. Configuring Vibe in this 
way enables e-mail messages to be sent from Vibe, while maintaining the same level of security for 
your corporation.


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/WEB-INF/classes/config


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF\classes\config
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By default, Vibe is configured to send messages from individual users in the following scenarios:


 When sending a workflow notification, as described in “Adding On-Entry or On-Exit Events” in 
the Novell Vibe 3.2 Advanced User Guide.


 When sharing an entry, folder, or workspace, as described in “Sharing Workspaces, Folders, and 
Entries” in the Novell Vibe 3.2 Advanced User Guide.


 When creating an entry, as described in “Creating a Folder Entry” in the Novell Vibe 3.2 User 
Guide.


You can configure Vibe to send e-mail messages and notifications from an external address for an 
individual zone or for the entire Vibe site:


 Section 23.3.1, “Configuring a Zone-Specific E-Mail Address for Sent Messages,” on page 199
 Section 23.3.2, “Configuring a Site-Wide E-Mail Address for Sent Messages,” on page 199


23.3.1 Configuring a Zone-Specific E-Mail Address for Sent Messages


1 Change to the following directory:


2 Make a backup copy of the ssf-ext.properties file, which is located in the same directory as 
the ssf.properties file.


3 Open the ssf.properties file in a text editor.
4 Search for the following line:


ssf.outgoing.from.address.<zone name>=zoned@company.com


5 Open the ssf-ext.properties file in a text editor.
6 Copy the ssf.outgoing.from.address.<zone name>=zoned@company.com line from the 


ssf.properties file to the bottom of the ssf-ext.properties file.
7 Replace <zone name> with the name of the Vibe zone that you want e-mail messages to be 


addressed from and edit the e-mail address to reflect your company’s e-mail.
For example, if the name of your Vibe zone is kablink, and the name of your company is 
greenergy, the line would read:


ssf.outgoing.from.address.kablink=zone@greenergy.com


8 Save and close the ssf-ext.properties file.
9 Close the ssf.properties file without saving it.


10 Stop and restart Vibe.


23.3.2 Configuring a Site-Wide E-Mail Address for Sent Messages


1 Change to the following directory:


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/WEB-INF/classes/config


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF\classes\config
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2 Make a backup copy of the ssf-ext.properties file, which is located in the same directory as 
the ssf.properties file.


3 Open the ssf.properties file in a text editor.
4 Search for the following line:


ssf.outgoing.from.address=global@company.com


5 Open the ssf-ext.properties file in a text editor.
6 Copy the ssf.outgoing.from.address=global@company.com line from the ssf.properties 


file to the bottom of the ssf-ext.properties file.
Edit the e-mail address to reflect your company’s e-mail.
For example, if the name of your company is greenergy, the line would read:


ssf.outgoing.from.address=global@greenergy.com


7 Save and close the ssf-ext.properties file.
8 Close the ssf.properties file without saving it.
9 Stop and restart Vibe.


23.4 Enabling Users to Configure a Folder or External E-Mail 
Address to Receive Sent E-Mails
Like a personal e-mail Outbox for the Vibe site, users can configure a folder or external e-mail 
address to receive all e-mail messages that they send from the Vibe site. This can help users better 
track their activity.


To enable users to set up a folder or external e-mail address in this way, Vibe administrators must 
ensure that the following prerequisites are met:


 Enable the Vibe site to allow incoming e-mail.


For information on how to enable Vibe to allow incoming e-mail, see “Disabling/Enabling 
Inbound E-Mail Postings” in the  Novell Vibe 3.2 Administration Guide.


 Reset definitions on the Vibe site if the Vibe site was upgraded from a version of Vibe prior to 
3.1. If you are installing Vibe 3.1 or later as a new installation, you do not need to reset the 
definitions.
For information on how to reset the definitions, see “Resetting Your Definitions” in “Update” in 
the Novell Vibe 3.2 Installation Guide.


NOTE: If you have made customizations to definitions throughout the Vibe site and you do not 
want your customizations to be overwritten, you can manually add a field to the User Profile 
form, rather than resetting the definitions for the Vibe site. To do this, add the BCC Email Address 
element to the Contact Information section of the Profile Form Definition for the User Profile. For 
more information on how to modify the User Profile definition, see Section 3.2.4, “Customizing 
the Default User Profile View,” on page 45.


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/WEB-INF/classes/config


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF\classes\config
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For more information on how users can configure folders to receive sent e-mails, see “Setting Up a 
Folder or External E-Mail Address to Receive All Sent E-Mail Messages” in the Novell Vibe 3.2 
Advanced User Guide.

Managing E-Mail Configuration 201







202  Novell Vibe 3.2 Administration Guide







24 24Managing the Lucene Index


For background information about the Lucene index, see “Understanding Indexing” in “Advanced 
Installation and Reconfiguration” in the Novell Vibe 3.2 Installation Guide.


 Section 24.1, “Starting and Stopping the Lucene Index Server,” on page 203
 Section 24.2, “Changing Your Lucene Configuration,” on page 203
 Section 24.3, “Optimizing the Lucene Index,” on page 204
 Section 24.4, “Rebuilding the Lucene Index,” on page 205
 Section 24.5, “Performing Maintenance on a High Availability Lucene Index,” on page 206


24.1 Starting and Stopping the Lucene Index Server
 Section 24.1.1, “On Linux,” on page 203
 Section 24.1.2, “On Windows,” on page 203


24.1.1 On Linux


Use the following commands to manually start and stop the Lucene Index Server:


/etc/init.d/indexserver start
/etc/init.d/indexserver stop


24.1.2 On Windows


Use the following command at a DOS command prompt to manually start the Lucene Index Server:


c:\Program Files\Novell\Teaming\luceneserver\indexserver\bin\
indexserver-startup.bat


To stop the Lucene Index Server, close the command prompt window where you started the Lucene 
Index Server. 


24.2 Changing Your Lucene Configuration
The default Lucene Index Server configuration is appropriate for a medium-sized Novell Vibe site. If 
you have a larger Vibe site, you can change its Lucene Index Server configuration by rerunning the 
Vibe Installation program, selecting Reconfigure Settings, then selecting Advanced. For instructions, see 
“Changing Your Lucene Index Server Configuration” in “Advanced Installation and 
Reconfiguration” in the Novell Vibe 3.2 Installation Guide.
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24.3 Optimizing the Lucene Index
If you notice that search performance in Novell Vibe is becoming slower over time, you might want 
to optimize your Lucene index.


For a medium to large Vibe system, it is recommended that you run the optimization once a week. 
You should run the optimization during off hours or on weekends when the Vibe system is not being 
heavily used.


Optimizing the Lucene index does not repair a damaged or out-of-date index. To repair a damaged or 
out-of-date index, you must rebuild the index, as described in Section 24.4, “Rebuilding the Lucene 
Index,” on page 205.


 Section 24.3.1, “Optimizing a Single Search Index,” on page 204
 Section 24.3.2, “Optimizing the Search Index with Multiple Index Servers,” on page 204


24.3.1 Optimizing a Single Search Index


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 Under Management, click Search Index.


4 Click the Optimize Search Index tab.
5 Select Run Immediately if you want to run the optimization right now.
6 Select Run at Scheduled Time, then specify the days and times that you want the optimization to 


occur.
7 Click OK.


24.3.2 Optimizing the Search Index with Multiple Index Servers


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 In the Search Index section, click Index.
4 Click the Optimize Search Index tab.
5 Select Run Immediately if you want to run the optimization right now.
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6 Select Run at Scheduled Time, then specify the days and times that you want the optimization to 
occur.


7 Select each node that you want to optimize.
8 Click OK.


24.4 Rebuilding the Lucene Index
The Lucene index provides access to all data in your Novell Vibe site. If it becomes damaged or out-
of-date for some reason, you can rebuild it. Users might first notice a problem with the Lucene index 
if they cannot find information that they know should be available on the Vibe site. If you are 
running multiple Lucene Index Servers, follow the instructions in Section 24.5, “Performing 
Maintenance on a High Availability Lucene Index,” on page 206.


The steps to reset the search index differ depending on whether you have multiple Lucene Index 
servers.


 Section 24.4.1, “Rebuilding a Single Search Index,” on page 205
 Section 24.4.2, “Rebuilding the Search Index with Multiple Index Servers,” on page 206


24.4.1 Rebuilding a Single Search Index


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 In the Management section, click Search Index.


4 To reindex the entire Vibe site, select Re-Index Everything.
Depending on the size of your Vibe site, this can be a very time-consuming process.
or
Select one or more parts of your Vibe site to reindex.


5 Click OK to start the indexing.
Users can still access the Vibe site during the indexing process, but search results might not be 
accurate until the index has been completely rebuilt.
A message notifies you when indexing is complete.
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24.4.2 Rebuilding the Search Index with Multiple Index Servers


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 In the Search Index section, click Index.
4 To reindex the entire Vibe site, select Re-Index Everything.


Depending on the size of your Vibe site, this can be a very time-consuming process.
or
Select one or more parts of your Vibe site to reindex.


5 Select each node that you want to re-index.
6 Click OK to start the indexing.


Users can still access the Vibe site during the indexing process, but search results might not be 
accurate until the index has been completely rebuilt.
A message notifies you when indexing is complete.


24.5 Performing Maintenance on a High Availability Lucene 
Index
If you have a high availability Lucene configuration, you can take one Lucene node out of service for 
maintenance while other Lucene nodes continue to operate. Then you can synchronize the out-of-
date Lucene node with the current indexing data.


1 Log in to the Novell Vibe site as the Vibe administrator.
2 Take the Lucene node that needs maintenance out of service:


2a Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
2b Under Search Index, click Nodes.
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2c In the list, locate the node that needs maintenance.
2d Make sure that Enable Deferred Update Log is selected.
2e In the User Mode Access box, change Read and Write to Write Only.
2f Click Apply, then click Close.


The new setting is put into effect immediately, so that the Lucene node is no longer 
accessible to Vibe users.


3 Perform the needed maintenance on the Lucene server, then start the Lucene Index Server again.
4 Return the out-of-date Lucene node to full service:


4a Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
4b Under Search Index, click Nodes.


The out-of-date Lucene node is flagged with Deferred Update Log Records Exist.
The User Mode Access option shows Read and Write because this is the last selected setting. If 
you are checking the Tomcat catalina.out file, as described in “Observing Lucene Node 
Activity” in “Multi-Server Configurations and Clustering” in the Novell Vibe 3.2 Installation 
Guide, Vibe is not actually accessing the out-of-date Lucene node because it is out of sync 
with the Vibe site.


4c Select Apply Deferred Update Log Records to the Index, then click Apply.
The Deferred Update Log options disappear if the update is successful.


4d Click Close.
The Lucene node that was out of service has now been updated with current indexing data.
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25 25Backing Up Vibe Data


Reliable backups are critical to the stability of your Novell Vibe site.


 Section 25.1, “Locating Vibe Data to Back Up,” on page 209
 Section 25.2, “Scheduling and Performing Backups,” on page 211
 Section 25.3, “Restoring Vibe Data from Backup,” on page 211
 Section 25.4, “Manually Restoring Individual Entries,” on page 211


25.1 Locating Vibe Data to Back Up
In order to keep adequate backups of your Novell Vibe data, you must back up the following types of 
data. 


 Section 25.1.1, “Vibe File Repository,” on page 209
 Section 25.1.2, “Vibe Database,” on page 209
 Section 25.1.3, “Lucene Index,” on page 210
 Section 25.1.4, “Certificates,” on page 210


25.1.1 Vibe File Repository


For more information, see “Distributing Different Data Types to Different Locations” in “Advanced 
Installation and Reconfiguration” in the Novell Vibe 3.2 Installation Guide.


25.1.2 Vibe Database


Platform Default Location


Linux: /var/opt/novell/teaming


Windows: c:\Novell\Teaming\filerepository


Database 
Server Default Linux Location Default Windows Location


MySQL /var/lib/mysql c:\Program Files\MySQL\
MySQL Server version\Data


Microsoft SQL N/A c:\Program Files\Microsoft SQL Server\
MSSQL\Data


Oracle N/A N/A
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For more information, see “Creating the Vibe Database on a Remote Server” and “Running Multiple 
Database Servers” in “Multi-Server Configurations and Clustering” in the Novell Vibe 3.2 Installation 
Guide.


25.1.3 Lucene Index


For more information, see “Installing the Lucene Index Server on a Remote Server” and “Running 
Multiple Lucene Index Servers” in “Multi-Server Configurations and Clustering” in the Novell Vibe 
3.2 Installation Guide.


25.1.4 Certificates


If you have changed your password in the server.xml file when creating a new keystore file (as 
described in “Changing Your Password for the Keystore File” on page 257), be aware that these 
changes are not preserved when you upgrade Vibe. You should make these changes again after 
upgrading Vibe rather than backing up the server.xml file.


 “Linux Locations” on page 210
 “Windows Locations” on page 210


Linux Locations


Windows Locations


Platform Default Location


Linux: /var/opt/novell/teaming/lucene/zone_name


Windows: c:\Novell\Teaming\lucene\kablink


Certificate 
Type Default Location


Tomcat: /opt/novell/teaming/apache-tomcat/conf/.keystore


Java: /usr/lib/jvm/java-version/jre/lib/security/cacerts


Certificate 
Type


Default Location


Tomcat: c:\Program Files\Novell\Teaming\apache-tomcat\conf\.keystore


Java: c:\Program Files\Java\jreversion\lib\security\cacerts
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25.2 Scheduling and Performing Backups
You do not need to bring your Novell Vibe site down in order to perform backups. You might want to 
back up the Vibe file repository and the Vibe database every night, perhaps doing a full backup once 
a week and incremental backups on other days. You can back up the Lucene index whenever it is 
convenient. You can always reindex the Vibe site in order to re-create the Lucene index, but being 
able to restore one from backup can save time in case of an outage.


25.3 Restoring Vibe Data from Backup
If you need to restore your Novell Vibe site from a backup, restoring the same backup version for 
both the file repository and the database creates a Vibe site that is consistent within itself but might 
be missing information that was added after the backups were created. If you lose the file repository 
but not the database, you can restore the backed-up file repository and keep the more current 
database, but some entries then have files that are missing from the file repository. If you lose the 
database but not the file repository, you can run a report to identify entries created since the last 
database backup, as described in Section 26.2.4, “Content Modification Report,” on page 221. You can 
then notify the affected Vibe users that they need to re-create the entries that are not available in the 
backup.


25.4 Manually Restoring Individual Entries
All Vibe users can restore individual entries and attached files if the entry has been deleted but not 
yet purged. For information on how to do this, see “Restoring Deleted Items” in the Novell Vibe 3.2 
Advanced User Guide.


If an entry has been deleted and also purged from the Vibe site, it can usually be recovered from the 
archive store by a Vibe administrator, but this is not an easy process. Contact Novell Support (http://
www.novell.com/support) for assistance.
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26 26Monitoring the Vibe Site


You can monitor activity on your Novell Vibe site by using Vibe reports and log files. You can also 
use JMX to monitor Vibe and to perform certain management functions. 


 Section 26.1, “Using JMX to Monitor the Vibe Site,” on page 213
 Section 26.2, “Generating Reports,” on page 216
 Section 26.3, “Using Log Files,” on page 227
 Section 26.4, “Checking the Vibe Site Software Version,” on page 229


26.1 Using JMX to Monitor the Vibe Site
Java Management Extensions (JMX) is a Java technology for managing and monitoring applications, 
system objects, devices, and services. It is a lightweight, non-intrusive mechanism for gathering and 
monitoring useful runtime statistics. You can use JMX in addition to other tools that are included in 
the Vibe product to monitor your Vibe site.


 Section 26.1.1, “Installing and Configuring JMX for Vibe,” on page 213
 Section 26.1.2, “Requiring Authentication When Accessing Vibe through JMX,” on page 214
 Section 26.1.3, “Using JConsole to Monitor the Vibe Site,” on page 215


26.1.1 Installing and Configuring JMX for Vibe


1 Install Vibe as described in the Novell Vibe 3.2 Installation Guide.
2 Navigate to the following directory on the Vibe server: 


3 Open the vibe.management.properties file in a text editor.
4 Uncomment the following line:


#com.sun.management.jmxremote.port=8642


If this port is already in use on your server, change the port number to a port that is not in use.
5 (Recommended) To require authentication when accessing Vibe remotely through JMX, change 


the value of the following property to true:


com.sun.management.jmxremote.authentication=false


For more information about requiring authentication when accessing Vibe remotely through 
JMX, see Section 26.1.2, “Requiring Authentication When Accessing Vibe through JMX,” on 
page 214.


Linux: /opt/novell/teaming/apache-tomcat/conf 


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\conf
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6 By default, SSL is not enabled when accessing Vibe through JMX. If the JMX user is accessing 
Vibe from within the firewall (which is recommended), there is no reason to require an SSL 
connection. If SSL is required by your organization, you can enable it.
To require an SSL connection when accessing Vibe remotely through JMX, change the value of 
the following property to true:


com.sun.management.jmxremote.ssl=false


If you require an SSL connection when accessing Vibe through JMX, you must also set up a 
certificate and configure SSL as instructed in the online JMX documentation (http://
download.oracle.com/javase/6/docs/technotes/guides/management/agent.html).


7 Save your changes, then close the text editor.
8 Stop and restart the Vibe server.


26.1.2 Requiring Authentication When Accessing Vibe through JMX


For security reasons, you should configure JMX to require authentication when accessing Vibe. In a 
clustered environment where a firewall is protecting your entire system but where there is no firewall 
running between individual nodes (which is the recommended configuration), it is extremely 
important that authentication is required when accessing Vibe through JMX in order to prevent an 
unauthorized entity from gaining access to the Vibe system.


After you have required authentication for the JMX user as discussed in Section 26.1.1, “Installing 
and Configuring JMX for Vibe,” on page 213, you need to finish setting up the authentication:


 “Specifying a Password for One or Both JMX User Types” on page 214
 “Restricting Access to the Password File” on page 215


Specifying a Password for One or Both JMX User Types


The properties discussed in this section represent JMX user types that can have access to Vibe 
through JMX. These are not Vibe users, but rather are JMX users. These users are not reflected 
anywhere in your Vibe system.


1 Navigate to the following directory on the Vibe server:


2 Open the jmxremote.password file in a text editor.
3 Uncomment one or both of the user types, depending on whether you want the JMX user to have 


Read Only access or Read/Write access through JMX. If you plan to use only one user type (for 
example, Read/Write), leave the other one commented out.
Read Only access: Allows the JMX user to monitor or view Vibe data through JMX. 
To configure the JMX user to have Read Only access, uncomment the following user type:


# monitorVibeRole XYZ


Read/Write access: Allows the JMX user to perform state-changing actions such as initiating 
garbage collection of the JVM, changing an attribute of an MBean, or executing an operation on 
an MBean, as well as monitoring and viewing Vibe data through JMX. 
To configure the JMX user to have Read/Write access, uncomment the following user type:


Linux: /opt/novell/teaming/apache-tomcat/conf 


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\conf
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# controlVibeRole A&B


4 Replace the XYZ and/or A&B values to a secure password. For example, if you want to change the 
password for Read/Write access to novell, the line would look like the following:


controlVibeRole novell


Passwords are case-sensitive.
5 Save the jmxremote.password file and close the text editor.


Restricting Access to the Password File


The jmxremote.password file displays the usernames of the JMX users who can access the Vibe site 
through JMX, together with the passwords for these users, in plain text. For this reason it is important 
that you restrict access to this file to only the file owner, which is the operating system account where 
the Vibe server is running.


 “Restricting Access to the Password File on Linux” on page 215
 “Restricting Access to the Password File on Windows” on page 215


Restricting Access to the Password File on Linux


If your Vibe server is running on a Linux operating system, the file permissions are changed 
automatically when Vibe is installed. (The Vibe program runs this command: chmod 600 
vibe.jmxremote.password.)


Restricting Access to the Password File on Windows


If your Vibe server is running on a Windows operating system, you must change the permissions 
manually after Vibe is installed. For instructions on how to set file permissions on Windows, see How 
to Secure a Password File on Microsoft Windows Systems (http://download.oracle.com/javase/6/
docs/technotes/guides/management/security-windows.html).


26.1.3 Using JConsole to Monitor the Vibe Site


JConsole is a Java monitoring tool that comes with JDK. You can use JConsole to monitor your Vibe 
site through JMX.


 “Starting JConsole” on page 215
 “Using JConsole to Monitor Vibe” on page 216
 “Using Zenoss Core to Supplement JConsole Monitoring” on page 216


Starting JConsole


Because JConsole requires a considerable amount of system resources in order to run, you should not 
run JConsole from the same machine where Vibe is running. The section describes how to connect 
JConsole to Vibe from a remote machine.


The machine that you run JConsole from must have a JDK installed.


1 Navigate to the location where your JDK is installed, then in the bin directory launch following 
file appropriate for your operating system:
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The New Connection dialog box is displayed.
2 Select Remote Process, then specify the hostname and port number of the server where Vibe is 


running.
3 In the Username and Password fields, specify the username and password that you created in 


“Specifying a Password for One or Both JMX User Types” on page 214.
4 Click Connect.


The Java Monitoring & Management Console is displayed.


Using JConsole to Monitor Vibe


JConsole contains several tabs that help you monitor various aspects of your server. Information 
specific to Vibe is found in the MBeans tab in the Vibe folder. For specific information about the other 
tabs in JConsole, see Using JConsole (http://download.oracle.com/javase/6/docs/technotes/guides/
management/jconsole.html).


Using Zenoss Core to Supplement JConsole Monitoring


Zenoss Core is not a replacement for JConsole, but it can provide additional monitoring functionality. 
Zenoss provides the following capabilities:


 Define alerts on an MBean attribute based on the attribute’s acceptable value range, without 
relying on the JMX notification mechanism.


 Display performance graphs to view how data points change over time (JConsole displays only 
the current snapshot).


For more information about Zenoss, see Zenoss Core - Enterprise IT Monitoring (http://
sourceforge.net/projects/zenoss/).


26.2 Generating Reports
Most Novell Vibe reports are created in CSV format, so that you can import them into a spreadsheet 
and easily manipulate the data to suit your needs. The default CSV filename is report.csv. If you 
create multiple reports without manually renaming them, the default filename is incremented 
(report-n.csv). The default location to save the report varies by platform:


 Section 26.2.1, “Login Report,” on page 217
 Section 26.2.2, “User Activity Report,” on page 218
 Section 26.2.3, “User Access Report,” on page 219
 Section 26.2.4, “Content Modification Report,” on page 221
 Section 26.2.5, “Data Quota Exceeded Report,” on page 222


Linux: jconsole


Windows: jconsole.exe


Linux: /tmp


Windows: Your current Windows default directory
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 Section 26.2.6, “Data Quota Highwater Exceeded Report,” on page 223
 Section 26.2.7, “Disk Usage Report,” on page 224
 Section 26.2.8, “E-Mail Report,” on page 225
 Section 26.2.9, “License Report,” on page 226
 Section 26.2.10, “XSS Report,” on page 227


26.2.1 Login Report


The Login report lists the Vibe users who have logged in to the Vibe site during a specified period of 
time. In addition, it can include a dated list of every login by each user.


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 Under Reports, click Login Report.


4 Specify the date range for the Login report.
5 Leave the People field blank to list all user logins.


or
In the People field, start typing the first name of a Vibe user, then in the drop-down list of names 
that match what you have typed, select a user whose logins you want to be reported. Repeat this 
process to include multiple users in the report.


6 Select the type of Login report that you want to generate.
Summarize Login Entries: Lists how many times the selected users have logged into the Vibe 
site. In the Sort Report By drop-down list, select User, Last Login, or Number of Logins to organize 
the data.
List All Login Entries: Lists each individual user login and includes the following data about 
the action:
 First name
 Last name
 Username
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 Date
 Time


In the Sort report by drop-down list, select Login Date or User to organize the data most helpfully.
7 Click Create Report to generate the Login report.
8 Select a text editor to view the report in, then click OK.


For a short report, you might obtain the information you need by viewing the CSV file.
9 (Optional) Save the CSV file with a meaningful name in a convenient location, then retrieve it 


into a spreadsheet program for further examination.


26.2.2 User Activity Report


The User Activity report lists how many times specified users have viewed, added, modified, or 
deleted content on the Vibe site during a specified period of time. In addition, it can include the date 
and time of each action, along with the location of the action.


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 Under Reports, click User Activity Report.


4 Specify the date range for the User Activity report.
5 Leave the Select User field blank to list all user activity.


or
In the Select User field, start typing the first name of a Vibe user.
In the drop-down list of names that match what you have typed, select a user whose activity you 
want to be reported. Repeat this process to include additional users.


6 Select the type of User Activity report that you want to generate.
Activity Summary: Lists how many times the selected users have performed the following 
actions in the Vibe site:
 View
 Add
 Edit
 Delete (purge)
 Pre-Delete (delete but not purge)
 Restore (restore a deleted item that has not been purged)
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Workspace or Folder Activity: Lists each individual user action and includes the following data 
about the action:
 User
 Activity
 Date
 Time
 Folder
 Entry title
 Entry type


7 Click Create Report to generate the User Activity report.
8 Select a text editor to view the report in, then click OK.


For a short report, you might obtain the information you need by viewing the CSV file.
9 (Optional) Save the CSV file with a meaningful name in a convenient location, then retrieve it 


into a spreadsheet program for further examination.


26.2.3 User Access Report


The User Access report lists the locations on the Vibe site where a specified user has access rights. In 
addition, you can view, and if necessary, change or remove the access rights for any location. This 
report is especially useful on Vibe sites where Guest user access has been granted, as described in 
Section 5.4, “Allowing Guest Access to Your Vibe Site,” on page 92.


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 Under Reports, click User Access Report.


4 Start typing the first name of a Vibe user.
5 In the drop-down list of names that match what you have typed, select the user whose site 


access you want to be reported.
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In this example, the Guest user has access to the Guest workspace and also to Janet DeSoto’s 
personal workspace. This could be appropriate if Janet DeSoto’s job is to maintain a publicly 
available workspace, but would not be appropriate if the Guest access has been granted in error.


6 (Conditional) If you want to change the current access:
6a Click the name of a location to display the Configure Access Control page for that location.


In this example, the Guest user has been granted Visitor access to Janet DeSoto’s personal 
workspace.


6b Select or deselect access rights as needed.
6c Click Save Changes, then click Close to return to the User Access Report page
6d Rerun the report to view the results of your changes.


For example, if you removed the Guest access rights from Janet DeSoto’s personal 
workspace, her workspace is no longer listed in the User Access report for the Guest user.


7 (Conditional) If you want to save the user access information, select it and copy it into a text 
editor.


8 Click Close when you are finished checking user access rights.
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26.2.4 Content Modification Report


The Content Modification report lists changes to workspaces, folders, and folder entries, as well as 
users, groups, access rights, and workflows. By generating a Content Modification report, you can 
determine who has performed any of the following actions:


 Added, modified, moved, or deleted a workspace
 Added, modified, moved, or deleted a folder
 Added, modified, renamed, or deleted a file or one of its versions
 Added, modified, moved, or deleted an entry


For purposes of this report, users and groups are handled as if they are folder entries.
 Started or modified a workflow
 Modified or deleted access rights


The Content Modification report can also help you recover data that has been accidentally deleted.


1 Log in to the Vibe site as the Vibe administrator.
2 Determine the exact name of the workspace, folder, file entry, and so on where you want to 


check for content modifications.


3 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
4 Under Reports, click Content Modification Log.


5 Fill in the fields to specify where to check for content modifications and the type of 
modifications to check for:
Folder or Workspace: Start typing the name of a folder or workspace. In the drop-down list of 
names that match what you have typed, select the folder or workspace where you want to check 
for content modifications. The internal ID of the folder or workspace is displayed for reference.
Entry: (Optional) To restrict the content modification check to a specific entry in a folder, start 
typing text in the title of the entry. In the drop-down list of entry titles that match what you have 
typed, select the entry where you want to check for content modifications. The internal ID of the 
entry is displayed for reference.
Entity Type: (Optional) To further restrict the content modification check, select one of the 
following:
 Workspace (not the contents of the workspace, but the workspace itself)
 Folder (not the contents of the folder, but the folder itself)
 Folder entry (the contents of the folder entry)
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 Profiles (the contents of the Personal Workspaces folder where there is a personal 
workspace for each user)


 User (the contents of a user’s personal profile, such as the user’s name, e-mail address, and 
locale)


 Group (the contents of the group)
Filter by Operation: Further restrict the content modification check by selecting a specific action 
performed on the selected workspace, folder, or entry (add, modify, rename, delete, and so on).


6 Click Apply to generate the Content Modification report.
The results are displayed as an XML file.


7 (Conditional) If the results are too extensive, restrict the scope of the content modification check 
until you locate the modification that you are seeking.


8 Click Close when you are finished checking for content modifications.


A specialized use of the Content Modification report is to restore accidentally deleted data. For 
example, you can use the following steps to recover an accidentally deleted folder entry:


1 Run the Content Modification report to list all entry deletions in the folder where the entry was 
accidentally deleted.


2 Record the entry ID of the deleted entry.
3 Run the Content Modification report on the entry ID, selecting folderEntry in the Entity Type field.
4 Use the modification history of the entry to reconstruct the accidentally deleted entry.


26.2.5 Data Quota Exceeded Report


The Data Quota Exceeded report lists individual users who have exceeded the data quota. The report 
provides a spreadsheet with the following information for each user:


 Data Quota Used (MB): Displays the amount of disk space the user is currently using.
 Data Quota: Displays the user’s individual quota if one has been set.


For information on how to set a quota for individual users, see Section 20.4.2, “Setting User Data 
Quotas,” on page 175.


 Max Group Quota (MB): Displays the largest data quota for any group that the user is a 
member of. Users are assigned the highest of all data quotas for any group for which they are a 
member.
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 Default Data Quota (MB): Displays the site-wide default quota.
For information on how to set a default data quota, see Section 20.4.2, “Setting User Data 
Quotas,” on page 175.


To generate the Data Quota Exceeded report:


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 Under Reports, click Data Quota Exceeded Report.


4 Click Create Report to generate the report.
The report is launched in a spreadsheet.


26.2.6 Data Quota Highwater Exceeded Report


The Data Quota Highwater Exceeded report lists individual users who have exceeded the data quota 
high-water mark. The report provides the following information for each user:


 Data Quota Used (MB): Displays the amount of disk space the user is currently using.
 Data Quota: Displays the user’s individual quota if one has been set.


For information on how to set a quota for individual users, see Section 20.4.2, “Setting User Data 
Quotas,” on page 175.


 Max Group Quota (MB): Displays the largest data quota for any group that the user is a 
member of. Users are assigned the highest of all data quotas for any group for which they are a 
member.


 Default Data Quota (MB): Displays the site-wide default quota.
For information on how to set a default data quota, see Section 20.4.2, “Setting User Data 
Quotas,” on page 175.


To generate the Data Quota Highwater Exceeded report:


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 Under Reports, click Data Quota Highwater Exceeded Report.
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4 Click Create Report to generate the report.
The report is launched in a spreadsheet.


26.2.7 Disk Usage Report


The Disk Usage report lists the amount of disk space for workspaces on the Vibe site by user, by 
workspace, or by both. In addition, you can restrict the reporting to only those workspaces that 
exceed a specified number of megabytes.


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 Under Reports, click Disk Usage Report.


4 Select the type of Disk Usage report that you want to generate.
Total Usage by User: Lists all Vibe users whose disk space usage is above the amount specified 
in the Usage Greater Than field.
Total Usage by Workspace: Lists all workspaces where disk space usage is above the amount 
specified in the Usage Greater Than field. Disk space usage for each folder in each workspace is 
listed separately. The data is organized by workspace and folder ID.
Total Usage by User and Workspace: Combines the user and workspace data into a single 
report.
Usage Greater Than: Specify the number of megabytes above which you want to list disk space 
usage. This eliminates smaller disk space usages from the report.


5 Click Create Report to generate the Disk Usage report.
6 Select a text editor to view the report in, then click OK.


For a short report, you might obtain the information you need by viewing the CSV file.
7 (Optional) Save the CSV file with a meaningful name in a convenient location, then retrieve it 


into a spreadsheet program for further examination.
8 Click Close when you are finished checking disk space usage.
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26.2.8 E-Mail Report


The E-Mail Report lists mail messages that have been sent from and into the Vibe site. It also lists e-
mail errors that have been encountered.


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 Under Reports, click E-Mail Report.


4 Specify the date range for the E-Mail report.
5 Select whether you want a report on e-mail that was sent from Vibe, e-mail that was sent into 


Vibe, or e-mail errors that occurred.
6 Click Create Report.


The report contains the following information:
Send Date: Date when the e-mail was sent.
From Address: Address that the e-mail was sent from. 
This is the e-mail address that the user has defined in his or her user profile.
To Address: Address that the e-mail was sent to.
This is the e-mail address if the message was sent from Vibe, or it is the folder or workspace if 
the message was sent into Vibe.
Type: For messages that are sent from Vibe, this is the action that caused the message to be sent. 
For example, workflowNotification indicates that the e-mail message was sent as a result of a 
workflow notification. For messages that are sent into Vibe, this is emailPosting, which 
indicates that the e-mail message was converted to a Vibe entry via the internal Email Posting 
Agent. 
Status: Status of the message, such as Sent or Received.
Subject Line: Subject line of the message.
Attached Files: Filename of any attachments that were included in the e-mail message.
Errors: Any errors that are associated with the e-mail message.
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26.2.9 License Report


The License report lists information about your Vibe license, as well as information about the number 
of users in your Vibe site and how many of those users have accessed the site.


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 Under Reports, click License Report.


4 Specify the date range for the License report, then click Create Report.
The License report lists the following information:
 Vibe version
 License key type
 Date the license key was issued
 Date range when the license key is valid
 Maximum number of logged-in users during the date range
 Current active user count
 List of dates in the date range with the following user license information:


 Local Users: The user account was created within Vibe, and is not being synchronized 
from an LDAP directory.


 Users Synchronized from LDAP: The user account was created from an LDAP source. 
(Only synchronized accounts that are not marked as Deleted or Disabled are counted.)


 Users Who Used Vibe During the Previous 365 Days: Users who have logged in at 
least once in the past year.
User logins are counted only after your Vibe system is upgraded to Vibe 3 or later. The 
number of users who have logged in is always 0 for dates prior to the upgrade to Vibe 
3 or later. 
To see how many people accessed the Vibe site prior to the upgrade to Vibe 3 or later, 
or just for more detailed information in this area, run the Login report. For more 
information about the Login report, see Section 26.2.1, “Login Report,” on page 217.


The Vibe software does not limit the number of Vibe users that you can create, but sites where 
Vibe licenses have been purchased and the Vibe software installed are periodically audited 
against their purchased number of licenses.
The Vibe with Guest Access License is not displayed on this page. However, the Guest user 
feature described in Section 5.4, “Allowing Guest Access to Your Vibe Site,” on page 92 must be 
purchased in addition to the Standard Vibe license if you are using Guest user for non-registered 
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Vibe users. If you are using Guest user only for registered users, then you do not need to 
purchase a new license to use the Guest user feature. For more information, see “Updating Your 
Vibe License” in the Novell Vibe 3.2 Installation Guide.


5 Click Close when you are finished reviewing the License report.


For information on how to install a new Vibe license, see “Updating Your Vibe License” in “Basic 
Installation” in the Novell Vibe 3.2 Installation Guide.


26.2.10 XSS Report


Cross-site scripting (XSS) is a client-side computer attack that is aimed at Web applications. Because 
XSS attacks can pose a major security threat, Novell Vibe contains a built-in security filter that 
protects against XSS vulnerabilities. For more general information about XSS, see Section 37.3.10, 
“Securing the Vibe Site against XSS,” on page 271.


The XSS report in Vibe enables you to remove potentially harmful XSS threats from your Vibe site.


IMPORTANT: Because XSS attacks often are designed to wait for users with extra privileges (such as 
the administrator) to view the page where the attack was set, it is important that you don’t navigate 
to the page after you run the report.


For information about how to run the XSS report and safely remove XSS threats, see “TID 7007381: 
Running the XSS Report in Novell Vibe” in the Novell Support Knowledgebase (http://
www.novell.com/support).


26.3 Using Log Files
 Section 26.3.1, “Vibe Log File,” on page 227
 Section 26.3.2, “Tomcat Log File,” on page 228


26.3.1 Vibe Log File


The Novell Vibe log file (ssf.log) is available from the Vibe site.


1 Log in as the Vibe site administrator.


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .
3 Under Reports, click System Error Logs.


You are prompted to open or save a file named logfiles.zip, which contains the current 
ssf.log file. This file contains any stack traces or warning messages because of unexpected 
events encountered by the Vibe program.


4 Save the ssf.log file to a convenient location on the Vibe server.
This file is helpful when you need assistance resolving a problem with your Vibe site.


If you are unable to start Vibe and therefore cannot retrieve the log file as described above, the Vibe 
log file is also available in the following directory of your Vibe installation:


Linux: /opt/novell/teaming/apache-tomcat/webapps/ssf/WEB-INF/logs
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26.3.2 Tomcat Log File


In addition to the Novell Vibe error log file (ssf.log), the Tomcat error log file (catalina.out on 
Linux and stdout_*.log on Windows when Vibe runs as a service) is also useful. The Tomcat log file 
contains more information than the Vibe log file, because it includes problems encountered by 
Tomcat outside of the Vibe application itself. The location of the Tomcat log file varies by platform:


NOTE: When Vibe and Tomcat run as a Windows application, rather than as a Windows service, the 
information displayed in the command prompt window where you started Vibe is your only source 
of information. The data displayed in the command prompt window is not logged by Tomcat on 
Windows.


The Tomcat log file provides the following useful information:


 At the top, the Tomcat log file lists Tomcat startup messages.
 The System Properties section lists information about the supporting software packages that 


Tomcat relies on (for example, Java) and information about their current location and 
configuration.


 The System Environment section lists the currently set environment variables (for example, 
HOSTNAME, PATH, and JAVA_HOME).


 Exception and error data includes sufficient information for you to determine what user was 
trying to perform what action in what location on the Vibe site, to help you isolate and 
reproduce the problem.


NOTE: The Novell Vibe product name prior to version 3 is Novell Teaming. If your Vibe site was 
originally installed as a Teaming 2.0 or Vibe site, the root of your site is referred to as 
org.kablink in the Tomcat error log. If you updated from a Teaming 1.0 site or a Teaming 2.0 
beta site, the root of your site is referred to as com.liferay.


This file is helpful when you need assistance resolving a problem with your Vibe site.


Adjusting the Log Level for the Tomcat Log File


The log levels for various Tomcat functions are set in the log4j.properties file. Each type of 
information that is logged can have a log level of INFO, WARN, ERROR, FATAL, or DEBUG, 
depending on the type and quantify of information that you want logged. Some lines in the 
log4j.properties file are commented out with a pound sign (#), so that no information of that type 
is gathered. You can change the log level for each type of information and comment or uncomment 
lines to adjust the information gathered in the Tomcat log file to meet your troubleshooting needs.


1 Open the log4j.properties file in a text editor.
The location of the log4j.properties file varies by platform. 


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF\logs


Linux: /opt/novell/teaming/apache-tomcat/logs


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\logs
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2 Change log level settings as needed for the type of information you want to gather.
3 Comment or uncomment lines, depending on the type of information you want to gather.
4 Save the log4j.properties file, then exit the text editor.
5 Stop Vibe, then start Vibe to put the new logging level into effect.


26.4 Checking the Vibe Site Software Version
To display the version number and software date of the Novell Vibe software:


1 Log in to the Vibe site as the Vibe administrator


2 Click the Settings icon  in the upper right corner of the page, then click the Administration 


Console icon .


3 Click the information icon .
The Vibe software version and date are displayed in the Administration Information dialog box.


Linux: /opt/novell/teaming/apache-tomcat/webapps/ssf/WEB-INF


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF
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27 27Reconfiguring the Vibe Site


Many aspects of your Novell Vibe site can be changed when you are logged in to the Vibe site as the 
Vibe administrator. Some aspects of reconfiguring the Vibe site require you to rerun the Vibe 
installation program, as described in “Setting Configuration Options after Installation” in “Advanced 
Installation and Reconfiguration” in the Novell Vibe 3.2 Installation Guide.


 Section 27.1, “Basic Installation,” on page 231
 Section 27.2, “Advanced Installation,” on page 232


27.1 Basic Installation
The configuration settings that can be changed using a Basic installation are:


Location of TrueType Fonts for Stellent Converters
Default Locale for Novell Vibe
Network Information


Host
HTTP Port and Secure HTTP Port
Listen Port and Secure Listen Port
Shutdown Port and AJP Port


WebDAV Authentication Method
Database Selection


Database Type
JDBC URL
Credentials


Java JDK Location
Java Heap Size


Outbound E-Mail Configuration
Protocol
Host, Port, and Time Zone
Username, Password, and Authentication
Allow Sending E-Mail to All Users


Inbound E-Mail Configuration
Internal SMTP E-Mail Server
SMTP Bind Address
SMTP Port
Announce TLS


For information about these basic configuration options, see “Planning a Basic Vibe Installation” in 
“Basic Installation” in the Novell Vibe 3.2 Installation Guide.
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27.2 Advanced Installation
An Advanced installation includes the options available in a Basic installation, as well as the 
following additional options:


Web Services
Enable WSS Authentication
Enable Basic Authentication
Enable Token-Based Authentication
Enable Anonymous Access


Lucene Configuration
RSS Configuration


Max Elapsed Days
Max Inactive Days


Presence Configuration
Conferencing Configuration
     Conferencing URL
Reverse Proxy Configuration


Access Gateway Address
Logout URL
WebDAV Access Gateway Address


Integration with IIS for Windows Authentication
Mirrored Folder Resource Driver Configuration
Vibe Cluster Configuration


For information about these advanced configuration options, see “Planning an Advanced Vibe 
Installation” in “Advanced Installation and Reconfiguration” in the Novell Vibe 3.2 Installation Guide.
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III IIIInteroperability


Novell Vibe can be used in conjunction with various other software products. By incorporating these 
products into your Vibe system, you can add functionality, increase security, and maximize the value 
of Vibe.


 Chapter 28, “Novell Access Manager,” on page 235
 Chapter 29, “Internet Information Services (IIS),” on page 237
 Chapter 30, “Novell GroupWise,” on page 239
 Chapter 31, “Novell Messenger,” on page 241
 Chapter 32, “Novell Dynamic File Services,” on page 243
 Chapter 33, “Skype,” on page 245
 Chapter 34, “Twitter and Other Remote Applications,” on page 247
 Chapter 35, “YouTube,” on page 249
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28 28Novell Access Manager


Using Novell Vibe in conjunction with Novell Access Manager adds enterprise-level security to your 
Vibe system.


Before you can access your Vibe site through Novell Access Manger, you must first configure specific 
protected resources in Access Manager to be public, as described in Chapter 6, “Allowing Access to 
the Vibe Site through Novell Access Manager,” on page 99.


Furthermore, you can configure Novell Access Manager to work with Novell Vibe in the following 
ways:


 Configure Novell Access Manager to provide single sign-on access to the Vibe site.


For more information, see “Configuring Single Sign-On with Novell Access Manager” in the 
Novell Vibe 3.2 Installation Guide.


 Configure Novell Access Manager to allow access to iOS and Android mobile applications for 
Vibe.
For more information, see Section 5.7.2, “Configuring Mobile Device Access with Novell Access 
Manager,” on page 98.


When you set up Novell Access Manager to work with Vibe, ensure that you specify the correct 
HTTP/HTTPS port numbers during the Vibe installation, as described in “HTTP/HTTPS Ports When 
You Use Novell Access Manager with Vibe” in the Novell Vibe 3.2 Installation Guide.
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29 29Internet Information Services (IIS)


You can integrate Novell Vibe with Internet Information Services (IIS) to achieve Integrated Windows 
Authentication functionality. For more information about IIS and Integrated Windows 
Authentication with Vibe, see “Configuring Single Sign-On with Internet Information Services for 
Windows” in the Novell Vibe 3.2 Installation Guide.
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30 30Novell GroupWise


When you use Novell Vibe with GroupWise, some configuration steps are required to integrate the 
applications, as described in “Configuring GroupWise for Use with Novell Vibe” in the GroupWise 8 
Interoperability Guide:


 “Using GroupWise as the Vibe E-Mail System”
 “Enabling GroupWise/Vibe Integration for GroupWise Windows Client Users”
 “Accessing Your Vibe Site from the GroupWise Client”

Novell GroupWise 239







240  Novell Vibe 3.2 Administration Guide







31 31Novell Messenger


Novell Vibe enables you to integrate with Novell Messenger 2.2 and later. This integration displays 
users’ Messenger presence information within Vibe. For information about how to configure Vibe to 
work with Messenger, see Section 10.1, “Integrating Messenger with Vibe,” on page 115.
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32 32Novell Dynamic File Services


You can manage your Novell Vibe files by leveraging the functionality of Novell Dynamic File 
Services. Novell Dynamic File Services is an information life-cycle management technology that uses 
a policy-based approach for relocating files between two paths located on different storage devices. 
You can use Dynamic File services to better manage your premium storage for Vibe by offloading 
large or seldom used files to a secondary storage location. Dynamic File Services provides a merged 
view of the data to the Vibe application, which allows its users to transparently access their files 
without being aware of where they are physically stored. 


For information on how to configure Vibe with Novell Dynamic File Services, see “Setting Up a 
Merged View for Collaboration Applications: Novell Teaming” in the Dynamic File Services 
Administration Guide (http://www.novell.com/documentation/dynamic_file_services/
dynamic_admin_win/data/teaming.html) 
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33 33Skype


Novell Vibe enables you to integrate with Skype, so Vibe users can easily set up instant Skype 
meetings with other Vibe users, as described in “Using Skype From within Vibe” in the Novell Vibe 3.2 
User Guide.


Before users can use Skype from within Vibe, Vibe administrators must enable this functionality. For 
instructions on how to set up Vibe to work with Skype, see Section 10.2, “Integrating Skype with 
Vibe,” on page 116.
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34 34Twitter and Other Remote Applications


Novell Vibe enables you to incorporate third-party products such as Twitter into Vibe, through the 
use of remote applications.


For information on how to incorporate existing remote applications into your Vibe site, see 
Chapter 14, “Using Remote Applications on Your Vibe Site,” on page 127.
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35 35YouTube


Novell Vibe enables you to display YouTube videos directly from the Vibe site. This functionality is 
enabled by default and does not need to be activated by a Vibe administrator.


For more information about how to display YouTube videos on the Vibe site, see “Displaying 
YouTube Videos in a Folder Entry” in the Novell Vibe 3.2 User Guide.
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IV IVSite Security


 Chapter 36, “Security Administration,” on page 253
 Chapter 37, “Security Policies,” on page 267
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36 36Security Administration


SSL (Secure Socket Layer) and TLS (Transport Layer Security) can be used to secure the connections 
between your Novell Vibe site and other network services.


 Section 36.1, “Securing LDAP Synchronization,” on page 253
 Section 36.2, “Securing E-Mail Transfer,” on page 255
 Section 36.3, “Securing HTTP Browser Connections,” on page 255
 Section 36.4, “Securing Web Service Connections,” on page 265


36.1 Securing LDAP Synchronization
If your LDAP directory service requires a secure LDAP connection (LDAPS), you must configure 
Novell Vibe with a root certificate. The root certificate identifies the root certificate authority (CA) for 
your Vibe site, which enables you to generate a self-signed root certificate based on your eDirectory 
tree.


 Section 36.1.1, “Understanding How Vibe Uses the Root Certificate for Your eDirectory Tree,” on 
page 253


 Section 36.1.2, “Generating a Root Certificate in ConsoleOne,” on page 254
 Section 36.1.3, “Importing the Root Certificate into the Java Keystore,” on page 254


36.1.1 Understanding How Vibe Uses the Root Certificate for Your eDirectory 
Tree


You can generate a root certificate for your eDirectory tree by using either ConsoleOne or iManager, 
then import the root certificate into the Java keystore file (cacerts) on the Vibe server to make it 
accessible to Vibe. The default location for the Java keystore file is:


NOTE: For iManager instructions, see “TID 3176104: How to Enable SSL for Teaming LDAP 
Synchronization and Authentication” in the Novell Support Knowledgebase (http://
www.novell.com/support). If you are using Active Directory rather than eDirectory, consult your 
Active Directory documentation for a procedure comparable to the one provided in Section 36.1.2, 
“Generating a Root Certificate in ConsoleOne,” on page 254.


Linux: /usr/java/jdkversion/jre/lib/security


Windows: c:\Program Files\Java\jdkversion\jre/lib/security
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36.1.2 Generating a Root Certificate in ConsoleOne


1 On Linux or Windows, start ConsoleOne and authenticate to your eDirectory tree.
2 Expand the Security container, right-click the Tree_Name CA object, then click Properties.
3 Click Certificates > Self Signed Certificate.
4 Click Validate to update the certificate status, then click OK to close the Certificate Validation 


dialog box.
5 Click Export to export your eDirectory root certificate into a file that can be imported into the 


Java keystore file.
6 Click Next to accept the default of No for exporting a private key file along with the root 


certificate.
7 Select the output format for the root certificate file.


Either DER or Base64 format can be imported into the Java keystore file.
8 In the Filename field, specify the location where you want to create the root certificate file and the 


filename to use, such as SelfSignedRootCert.der.


IMPORTANT: You need to be able to access this file from the Vibe server. Specify an accessible 
location or copy it to the Vibe server after you create it.


9 Click Next to display a summary of the options you have selected, then click Finish to generate 
the root certificate file.


10 Click Cancel to close the Self Signed Certificate properties page of the Tree_Name CA object.
11 Exit ConsoleOne.
12 (Conditional) If necessary, copy the root certificate file to a convenient location on the Vibe 


server.


36.1.3 Importing the Root Certificate into the Java Keystore


1 On the Vibe server, make sure that you have access to the root certificate file.
2 Make sure that you can access the keytool tool:


For convenient use, you might need to add its location to the PATH environment variable.
3 Use the following command to import the root certificate into the Java keystore:


keytool -import -alias ldap_server_dns_name 
-keystore path_to_java_keystore_file 
-file root_certificate_file


For example:


keytool -import -alias ldapserver.yourcompanyname.com 
-keystore /usr/java/jdkversion/jre/lib/security/cacerts 
-file /certs/SelfSignedRootCert.der


4 When prompted, enter the password for the Java keystore.


Linux: /usr/java/jdkversion/bin/keytool


Windows: c:\Program Files\Java\jdkversion\bin\keytool.exe
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IMPORTANT: The default password used by Tomcat is changeit. If you want to specify a 
password other than this, then you must also specify this password in the server.xml Tomcat 
configuration file, as described in “Changing Your Password for the Keystore File” on page 257.
Do not forget the password you specify. 


5 Enter yes to accept the certificate import.
6 Use the following command to verify that the root certificate has been imported into the Java 


keystore:


keytool -list -keystore path_to_java_keystore_file


7 Enter the root certificate password to list the root certificate information.
8 Restart Vibe so that Tomcat rereads the updated Java keystore file.


You are now ready to configure your Vibe site for secure LDAP synchronization, as described in 
“Adding Vibe Users from Your LDAP Directory” in “Basic Installation” in the Novell Vibe 3.2 
Installation Guide.


36.2 Securing E-Mail Transfer
When you install Novell Vibe, you can choose whether or not the Vibe internal mail host uses TLS 
(Transport Layer Security) when it communicates with other SMTP mail hosts. For more information, 
see “Inbound E-Mail Security” in “Basic Installation” in the Novell Vibe 3.2 Installation Guide.


If your Vibe site needs to send e-mail messages to an e-mail system that requires secure SMTP 
(SMTPS), the Vibe site must have the same type of root certificate that is required for secure LDAP 
(LDAPS). If you have not already set up secure LDAP for your Vibe site, follow the instructions in 
Section 36.1, “Securing LDAP Synchronization,” on page 253 to set up secure SMTP for 
communications with your e-mail system.


36.3 Securing HTTP Browser Connections
Using secure HTTP (HTTPS) improves the security of your Novell Vibe site. During installation, you 
can choose to configure your Vibe site for HTTP or HTTPS. After installation, you can force secure 
HTTP connections.


 Section 36.3.1, “Preparing for Secure HTTP Connections,” on page 255
 Section 36.3.2, “Implementing Secure HTTP Connections,” on page 261
 Section 36.3.3, “Forcing Secure HTTP Connections,” on page 261
 Section 36.3.4, “Defaulting to Secure HTTP URLs,” on page 263


36.3.1 Preparing for Secure HTTP Connections


If you want users to access the Vibe site with a secure HTTP connection, you must configure Vibe 
with a root certificate and a server certificate. The root certificate identifies the root certificate 
authority (CA) for your Vibe site. The server certificate is customized for the specific server where 
Vibe is installed.


 “Understanding How Vibe Handles Certificates” on page 256
 “Creating a New Keystore File” on page 256
 “Generating a Certificate Signing Request” on page 258
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 “Submitting the Certificate Signing Request to a Certificate Authority (CA)” on page 258
 “Using the Certificate Signing Request to Generate a Self-Signed Certificate” on page 259
 “Importing the Certificate Files into the Vibe Keystore” on page 260
 “Replacing the Original Vibe Keystore File with Your Permanent Keystore File” on page 260


Understanding How Vibe Handles Certificates


Vibe uses a keystore to store certificates. The default keystore file that is installed along with Vibe is:


The original certificate in the default keystore is sufficient for you to set up secure HTTP connections 
during initial installation, but it is self-signed and has an expiration date, so you cannot use it 
permanently. Soon after installation, you must obtain a permanent certificate. You can use a 
commercially signed certificate or a self-signed certificate. There are advantages and disadvantages 
to each approach.


 Commercially Signed Certificate: The advantage to using a certificate signed by a commercial 
certificate authority (CA) is that browsers automatically accept these certificates. The 
disadvantage is that an additional step is required, with some wait time while you obtain the 
commercially signed certificate. 


 Self-Signed Certificate: The advantage to using a self-signed certificate is that it is quick and 
easy for you to do as the Vibe administrator. The disadvantage is that users receive a warning in 
the browser about the self-signed certificate the first time they access the Vibe site using secure 
HTTP. Users must manually accept the self-signed certificate, then the warning never occurs 
again.


After you obtain your permanent certificate, you can store it in the default Vibe keystore, or in a 
location of your own choosing. Vibe reads the location of its keystore from the following file:


If you do not want to use the default keystore location, you must update the server.xml file to match 
the location you choose for your keystore.


Creating a New Keystore File


Rather than updating the Vibe .keystore file that is provided during installation, it is easier to create 
a new .keystore file, then import your signed certificate into it.


1 Create a new directory where you want to create the new .keystore file, such as a certs 
directory in a convenient location.


2 Change to the new certs directory.
3 Make sure that you can access the keytool tool:


Linux: /opt/novell/teaming/apache-tomcat/conf/.keystore


Windows: c:\Program Files\Novell\Teaming\
apache-tomcat\conf\.keystore


Linux: /opt/novell/teaming/apache-tomcat/conf/server.xml


Windows: c:\Program Files\Novell\Teaming\
apache-tomcat\conf\server.xml
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For convenient use, you might need to add its location to the PATH environment variable.
4 Use the following command to create a new .keystore file:


keytool -genkey -alias tomcat -keyalg RSA -keystore .keystore


5 When prompted, specify a password for the new .keystore file, then confirm the password.


IMPORTANT: The default password used by Tomcat is changeit. If you want to specify a 
password other than this, then you must also specify this password in the server.xml Tomcat 
configuration file, as described in “Changing Your Password for the Keystore File” on page 257.
Do not forget the password you specify. 


6 When you are prompted for your first and last name, specify the fully qualified DNS name of the 
Vibe server, such as vibe.yourcompanyname.com.
You are then prompted for additional information about your organization:
 Organizational unit
 Organization
 City or locality
 State or province
 Two-letter country code


7 (Conditional) If you are planning to obtain a your certificate from a commercial certificate 
authority (CA), respond to the additional information prompts with accurate information 
appropriate to your organization.
or
(Conditional) If you are planning to generate a self-signed certificate, press Enter to skip through 
the prompts.


8 When you are prompted whether the information you provided is correct, enter yes.
9 Press Enter to use the same password that you specified in Step 5 as the key password for 


Tomcat.
10 List the files in the certs directory to see that a new .keystore file has been created.


Changing Your Password for the Keystore File


If you want to specify a password other than changeit for your .keystore file, as described in Step 5 
in “Creating a New Keystore File” on page 256, then you must also specify this password in the 
server.xml Tomcat configuration file.


NOTE: The password changes that you make are not preserved when you upgrade Vibe; you need to 
make these changes again after you upgrade.


1 Change to the following directory:


Linux: /usr/java/jdkversion/bin/keytool


Windows: c:\Program Files\Java\jdkversion\bin\keytool.exe
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2 Open the server.xml file in a text editor.
3 Locate the keystorePass attribute, then change the value of this attribute to your new 


password.
4 Save and close the server.xml file.


Generating a Certificate Signing Request


1 Use the following command to create a certificate signing request (CSR):


keytool -certreq -alias tomcat -keyalg RSA 
-file certreq.csr -keystore .keystore


2 Enter the keystore password to create the CSR.
3 List the files in the certs directory to see that a new certreq.csr file has been created along 


with the existing.keystore file.
4 Use the certreq.csr file to obtain a signed certificate.:


4a To use a commercial certificate authority (CA), continue with “Submitting the Certificate 
Signing Request to a Certificate Authority (CA)” on page 258.
or


4b To use a self-signed certificate, skip to “Using the Certificate Signing Request to Generate a 
Self-Signed Certificate” on page 259.


Submitting the Certificate Signing Request to a Certificate Authority (CA)


You can find a commercial certificate authority (CA) on the Internet by searching for “certificate 
authority.” The process of obtaining a signed certificate varies from company to company. Each 
company provides instructions to assist you.


The certificate authority sends you a set of certificate files that you import into the Vibe keystore. 
Import these files into the same keystore that you used to create the original certificate request. You 
must import all of the files that you receive. 


The following procedure is a guideline for importing the certifacate into the Vibe keystore. 
Instructions might vary depending on the certificate authority. 


1 Change to the certs directory where you created the root certificate file and the server 
certificate file.


2 Use the following command to import the root certificate file:


keytool -import -alias root -trustcacerts -keyalg RSA -keystore .keystore
-file CertificateAuthorityCert.der


3 Enter the keystore password to add the root certificate to the Vibe keystore.
4 Use the following command to import the SSL certificate file that you received from the 


certificate authority:


Linux: /opt/novell/teaming/apache-tomcat/
conf


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
conf
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keytool -import -alias tomcat -keyalg RSA -keystore .keystore
-file certificate_name.cer


5 Enter the keystore password to add the server certificate to the Vibe keystore.


Using the Certificate Signing Request to Generate a Self-Signed Certificate


If you do not want to wait to receive your signed certificate from a commercial certificate authority 
(CA), you can generate your own self-signed certificate using ConsoleOne or iManager. You must 
generate both a self-signed eDirectory root certificate file and a server certificate file.


 “Generating a Self-Signed Root Certificate File in ConsoleOne” on page 259
 “Generating a Self-Signed Server Certificate File in ConsoleOne” on page 259


NOTE: For iManager instructions, see “TID 7001857: Adding SSL Certificates to Teaming for HTTPS” 
in the Novell Support Knowledgebase (http://www.novell.com/support). If you are using Active 
Directory rather than eDirectory, consult your Active Directory documentation for a procedure 
comparable to the one provided in this section.


Generating a Self-Signed Root Certificate File in ConsoleOne


A root certificate identifies the root certificate authority (CA) for your Vibe site. In this case, 
eDirectory is acting as the root certificate authority.


1 On Linux or Windows, start ConsoleOne and authenticate to your eDirectory tree.
2 Expand the Security container, right-click the Tree_Name CA object, then click Properties.
3 Click Certificates > Self Signed Certificate.
4 Click Validate to update the certificate status, then click OK to close the Certificate Validation 


dialog box.
5 Click Export to export your eDirectory root certificate into a file that can be imported into the 


Vibe keystore file.
6 Click Next to accept the default of No for exporting a private key file along with the root 


certificate.
7 Select the output format for the root certificate file.


Either DER or Base64 format can be imported into the Vibe keystore file.
8 In the Filename field, specify the location (the certs directory where you created the certificate 


signing request) and the filename to use, such as SelfSignedRootCert.der.
9 Click Next to display a summary of the options you have selected, then click Finish to generate 


the root certificate file.
10 Click Cancel to close the Self Signed Certificate properties page of the Tree_Name CA object.
11 Continue with Generating a Self-Signed Server Certificate File in ConsoleOne.


Generating a Self-Signed Server Certificate File in ConsoleOne


A server certificate is customized for the specific server where Vibe is installed.


1 Click Tools > Issue Certificate.
2 Browse to and select the certreq.csr file that you created in the certs directory, then click 


Next.
This retrieves the contents of the CSR file into the CSR window.
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3 Click Next to accept the default of using an organization certificate authority.
4 Select SSL or TLS as the type of server certificate that you need, then click Next.
5 Select the validity period you want for the server certificate, then click Next.
6 Review the information that you have provided, then click Finish.
7 Select the output format for the server certificate file.


Either DER or Base64 format can be imported into the Vibe keystore file.
8 In the Filename field, specify the location (the certs directory where you created the Certificate 


Signing Request) and the filename to use, such as SelfSignedServerCert.der.
9 Click Save to create the public-key certificate file.


10 Exit ConsoleOne.


Importing the Certificate Files into the Vibe Keystore


After you have obtained or generated a signed certificate, you must import the certificate files into 
the Vibe keystore. This section describes how to import the files associated with a self-signed 
certificate. For information about how to import the files for a certificate that you receive from a 
certificate authority, see “Submitting the Certificate Signing Request to a Certificate Authority (CA)” 
on page 258.


1 Change to the certs directory where you created the root certificate file and the server 
certificate file.


2 Use the following command to import the root certificate file:


keytool -import -alias root -keyalg RSA -keystore .keystore
-file SelfSignedRootCert.der


3 Enter the keystore password to add the root certificate to the Vibe keystore.
4 Use the following command to import the server certificate file:


keytool -import -alias tomcat -keyalg RSA -keystore .keystore
-file SelfSignedServerCert.der


5 Enter the keystore password to add the server certificate to the Vibe keystore.
The new .keystore file is now ready to be added to your Vibe system.


6 Continue with “Replacing the Original Vibe Keystore File with Your Permanent Keystore File” 
on page 260.


Replacing the Original Vibe Keystore File with Your Permanent Keystore File


1 Change to the following directory on the Vibe server:


2 Rename the existing .keystore file to keystorebackup.
3 Copy your new .keystore from the certs directory to the conf directory.
4 Adjust the ownership and permissions of the new .keystore file to match those of the backed-


up keystore file.
5 Restart Vibe so that Vibe rereads the updated keystore file.


Linux: /opt/novell/teaming/apache-tomcat/conf


Windows: c:\Program Files\Novell\Teaming\
apache-tomcat\conf
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36.3.2 Implementing Secure HTTP Connections


When you run the Vibe installation program, you can choose between non-secure and secure HTTP 
connections, as described in “HTTP/HTTPS Ports” in “Basic Installation” in the Novell Vibe 3.2 
Installation Guide.


36.3.3 Forcing Secure HTTP Connections


With additional configuration, you can force users from a non-secure HTTP connection to a secure 
HTTPS connection. 


 “Using Novell Access Manager to Force Secure HTTP Connections” on page 261
 “Configuring Tomcat to Force Secure HTTP Connections” on page 261
 “Adding the Apache Web Server to Force Secure HTTP Connections” on page 262


Using Novell Access Manager to Force Secure HTTP Connections


With Novell Vibe, you can use Novell Access Manager to force secure HTTP connections. For more 
information, see “Configuring Single Sign-On with Novell Access Manager” in “Advanced 
Installation and Reconfiguration” in the Novell Vibe 3.2 Installation Guide.


Configuring Tomcat to Force Secure HTTP Connections


To reconfigure Tomcat, you must update two configuration files (both named web.xml) under two 
different directories (ssf and ssfs). The ssf directory name refers to SiteScape Forum, a legacy 
product name. The ssf directory contains the main Vibe Web application that you use when you 
interact with your browser. The ssfs directory name refers to SiteScape File System. The ssfs 
directory contains the Vibe WebDAV application that you use to access files on a remote WebDAV 
server from the Vibe site.


1 Log in to the Vibe server with sufficient rights to edit the web.xml files (root on Linux, 
Administrator on Windows).


2 Modify the web.xml file under the ssf directory:
2a Change to the directory where the web.xml file is located.


2b Make a backup copy of the web.xml file, then open the web.xml file in a text editor.
2c Add the following security constraint at the bottom of the file, immediately above the </


web-app> tag.


<security-constraint>
<web-resource-collection>
<web-resource-name>Entire Application</web-resource-name>
<url-pattern>/*</url-pattern>


</web-resource-collection>
<user-data-constraint>
<transport-guarantee>CONFIDENTIAL</transport-guarantee>


</user-data-constraint>
</security-constraint>


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/WEB-INF


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF
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2d (Conditional) If users access the Vibe site with Internet Explorer, find the following single 
line in the security constraint you just added:


<url-pattern>/*</url-pattern>


2e Replace it with the following set of lines:


  <!-- Patterns from web.xml.tmpl. -->
  <url-pattern>/a/*</url-pattern>
  <url-pattern>/ws/*</url-pattern>
  <url-pattern>/rss/*</url-pattern>
  <url-pattern>/atom/*</url-pattern>
  <!-- Patterns from subdirectories of webapps/ssf. -->
  <url-pattern>/applets/*</url-pattern>
  <url-pattern>/css/*</url-pattern>
  <url-pattern>/help/*</url-pattern>
  <url-pattern>/help_doc/*</url-pattern>
  <url-pattern>/i/*</url-pattern>
  <url-pattern>/images/*</url-pattern>
  <url-pattern>/js/*</url-pattern>


For Internet Explorer, this list of URL patterns forces secure HTTP connections for 
everything except the /s/* pattern (document files with extensions such as .odt and .doc) 
and the /ical/* pattern (calendar .ics files).


2f Save the modified web.xml file, then exit the text editor.
3 Modify the web.xml file under the ssfs directory:


3a Change to the directory where the web.xml file is located.


3b Make a backup copy of the web.xml file, then open the web.xml file in a text editor.
3c Add the following security constraint at the bottom of the file, immediately above the </


web-app> tag.


<security-constraint>
<web-resource-collection>
<web-resource-name>Entire Application</web-resource-name>
<url-pattern>/*</url-pattern>


</web-resource-collection>
<user-data-constraint>
<transport-guarantee>CONFIDENTIAL</transport-guarantee>


</user-data-constraint>
</security-constraint>


3d Save the modified web.xml file, then exit the text editor.


Adding the Apache Web Server to Force Secure HTTP Connections 


You can set up the Apache Web server to front your Vibe site and use a meta refresh (http://
en.wikipedia.org/wiki/Meta_refresh) to redirect users to a secure URL.


1 Install the Apache Web server on one server.
2 Configure Apache to listen on port 80.
3 Create an index.html file similar to the following example:


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssfs/WEB-INF


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssfs\WEB-INF
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<html>
<head>
<meta http-equiv="refresh" content="0;url=https://vibe_url" />
<title>Redirected to Secure Vibe</title>


</head>
<body>
This page is used to redirect to the Secure Vibe server. If your 
browser does not automatically redirect you in a few seconds, click 
<a href="https://vibe_url">here</a> to go to the secure page.


</body>
</html>


4 Replace vibe_url with the URL to your Vibe site.
5 Place the index.html file in the document root directory of the Apache Web server.


6 Restart the Apache Web server.


36.3.4 Defaulting to Secure HTTP URLs


 “Defaulting to Secure HTTP URLs in Vibe Links” on page 263
 “Defaulting to Secure HTTP URLs in E-Mail Notifications” on page 264


Defaulting to Secure HTTP URLs in Vibe Links


Vibe includes URLs to locations on the Vibe site in various links throughout the Vibe system. By 
default, the URLs are formed with HTTP rather than HTTPS. You can reconfigure Vibe to default to 
HTTPS for Vibe site URLs.


1 Log in to the Vibe server with sufficient rights to edit the ssf-ext.properties file (root on 
Linux, Administrator on Windows).


2 Change to the following directory:


3 Open the ssf.properties file in a text editor.
4 Locate and copy the following lines:


adapter.web.protocol=context-http
servelet.web.protocol=context-http
rss.web.protocol=context-http
ical.web.protocol=context-http
ssfs.web.protocol=context-http
simpleurl.web.protocol=context-http


5 Make a backup copy of the ssf-ext.properties file, located in the same directory with the 
ssf.properties file.


6 Open the ssf-ext.properties file in a text editor.
7 Paste the lines that you copied in Step 4 to the bottom of the file.


Linux: /srv/www/htdocs


Windows: c:\Program Files\Apache Software Foundation\Apache2.2\htdocs


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/WEB-INF/classes/config


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF\classes/config
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8 Change http to https.


adapter.web.protocol=context-https
servelet.web.protocol=context-https
rss.web.protocol=context-https
ical.web.protocol=context-https
ssfs.web.protocol=context-https
simpleurl.web.protocol=context-https


9 Close the ssf.properties file without saving.
10 Save the ssf-ext.properties file, then exit the text editor
11 Restart Vibe to put the change into effect.


Defaulting to Secure HTTP URLs in E-Mail Notifications


When an e-mail notification is sent from Vibe, Vibe includes a URL to the location on the Vibe site 
where the notification was sent. By default, the URLs in e-mail notifications are formed with http 
rather than https. You can reconfigure Vibe to default to https for Vibe site URLs.


1 Log in to the Vibe server with sufficient rights to edit the ssf-ext.properties file (root on 
Linux, Administrator on Windows).


2 Change to the following directory:


3 Open the ssf.properties file in a text editor.
4 Locate and copy the following line:


ssf.secure.links.in.email=false


5 Close the ssf.properties file without saving.
6 Make a backup copy of the ssf-ext.properties file, located in the same directory with the 


ssf.properties file.
7 Open the ssf-ext.properties file in a text editor.
8 Paste the line that you copied in Step 4 to the bottom of the file:


ssf.secure.links.in.email=false


9 Change false to true so that the line now looks like this:


ssf.secure.links.in.email=true


10 Save the ssf-ext.properties file, then exit the text editor
11 Restart Vibe to put the change into effect.


All system-generated e-mail notifications now default to secure HTTP URLs. However, all user-
generated e-mails from the Vibe system follow the current user’s context. For example, if a user is 
logged in as HTTP and chooses to share an entry with another user, the link in the e-mail notification 
uses HTTP.


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/WEB-INF/classes/config


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF\classes/config
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36.4 Securing Web Service Connections
Web Services in Vibe allow third-party applications to integrate with your Vibe system. To increase 
the security of your Vibe site, you can configure Vibe to allow only secure applications to integrate 
with Vibe. This section does not attempt to describe how to write a third-party application that 
supports HTTPS. Instead, this section describes how to configure your Vibe system to prevent non-
secure third-party applications from connecting with Vibe.


To prevent non-secure third-party applications from connecting with your Vibe system:


1 Log in to the Vibe server with sufficient rights to edit the web.xml files (root on Linux, 
Administrator on Windows).


2 Modify the web.xml file under the ssr directory:
2a Change to the directory where the web.xml file is located.


2b Make a backup copy of the web.xml file, then open the web.xml file in a text editor.
2c Add the following security constraint at the bottom of the file, immediately above the </


web-app> tag.


<security-constraint>
<web-resource-collection>
<web-resource-name>Entire Application</web-resource-name>
<url-pattern>/*</url-pattern>


</web-resource-collection>
<user-data-constraint>
<transport-guarantee>CONFIDENTIAL</transport-guarantee>


</user-data-constraint>
</security-constraint>


2d Save the modified web.xml file, then exit the text editor.


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssr/WEB-INF


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssr\WEB-INF
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37 37Security Policies


 Section 37.1, “Securing the Vibe Data,” on page 267
 Section 37.2, “Securing the Vibe Software,” on page 268
 Section 37.3, “Securing the Vibe Site,” on page 269


37.1 Securing the Vibe Data
 Section 37.1.1, “Limiting Physical Access to Vibe Servers,” on page 267
 Section 37.1.2, “Protecting the Vibe File Repository,” on page 267
 Section 37.1.3, “Protecting the Vibe Database,” on page 267


37.1.1 Limiting Physical Access to Vibe Servers


Servers where Novell Vibe data resides should be kept physically secure, so unauthorized persons 
cannot gain access to the server consoles.


37.1.2 Protecting the Vibe File Repository


The Novell Vibe file repository contains unencrypted data. See “Distributing Different Data Types to 
Different Locations” in “Advanced Installation and Reconfiguration” in the Novell Vibe 3.2 Installation 
Guide for details about how Vibe uses the local file system for data storage. These directories contain 
uploaded information in various formats (both native file formats and potentially a number of 
rendered formats (such as cached HTML versions of files, thumbnails, and RSS feeds) as well as 
archived data. These files are managed exclusively by the Vibe application software.


For data security, encrypted file systems should be used on servers where Vibe data resides. Only 
Vibe administrators should have direct access to Vibe data.


37.1.3 Protecting the Vibe Database


During installation, you select the encryption method that you want to use for the Vibe database, as 
described in “Database Encryption Algorithm” in “Basic Installation” in the Novell Vibe 3.2 Installation 
Guide. Three levels of encryption strength are available. The encryption algorithm cannot be changed 
after you have started using the Vibe database, so be sure to select the level of encryption appropriate 
for your Vibe site during initial installation.


Depending on your local security guidelines, you might want to encrypt the database connections 
between the Vibe software and the Vibe database. SSL-encrypted data between the Vibe application 
and the database server imposes a performance penalty because of the increased overhead of 
encrypting and decrypting the retrieved data.
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Support for this is highly dependent on the database client drivers and JDBC connector support, and 
on how you are configuring your database client and server certificates. You should check with your 
database vendor on how to set up SSL connections on both the client and server sides of the 
connection. You might need to modify the JDBC URL during installation, as described in “Database 
Location” in “Basic Installation” in the Novell Vibe 3.2 Installation Guide. For example, for MySQL, you 
might add useSSL=true&requireSSL=true to the options part of the JDBC URL.


37.2 Securing the Vibe Software
 Section 37.2.1, “Protecting the Vibe Configuration Files,” on page 268
 Section 37.2.2, “Protecting the Vibe Properties File,” on page 268
 Section 37.2.3, “Protecting Log Files,” on page 268
 Section 37.2.4, “Protecting the Vibe Process on Linux,” on page 269


37.2.1 Protecting the Vibe Configuration Files


The Novell Vibe configuration file (installer.xml) for the Vibe software should be protected from 
tampering. It contains username and password information for Vibe features that interact with other 
programs.


The initial installer.xml is created in the same directory where the Vibe Installation program is 
run. Backup copies are stored in:


37.2.2 Protecting the Vibe Properties File


The Vibe properties file (ssf.properties) should be protected from tampering. Like the Vibe 
configuration file, it contains username and password information, as well as many other details 
about your Vibe site configuration. The Vibe properties file (ssf.properties) is located in the 
following directory:


37.2.3 Protecting Log Files


The log files for Vibe and Tomcat should be protected against access by unauthorized persons. Log 
files contain very detailed information about your Vibe system and Vibe users.


The Vibe log file is available in the following directory of your Vibe installation:


Linux: /opt/novell/teaming/teaming-config


Windows: c:\Program Files\Novell\Teaming\teaming-config


Linux: /opt/novell/teaming/apache-tomcat/
webapps/ssf/WEB-INF/classes/config


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF\classes/config


Linux: /opt/novell/teaming/apache-tomcat/webapps/ssf/WEB-INF/logs


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF\logs
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The Tomcat log file is available in the following directory of your Vibe installation:


37.2.4 Protecting the Vibe Process on Linux


On Linux, Vibe is installed to run as a user other than the Linux root user. See “Linux User ID for 
Vibe” in “Basic Installation” in the Novell Vibe 3.2 Installation Guide.


37.3 Securing the Vibe Site
 Section 37.3.1, “Configuring a Proxy Server,” on page 269
 Section 37.3.2, “Setting the Vibe Administrator Password,” on page 269
 Section 37.3.3, “Setting Up SSL Connections,” on page 269
 Section 37.3.4, “Shortening the Vibe Session Timeout,” on page 270
 Section 37.3.5, “Using Role-Based Access Control,” on page 270
 Section 37.3.6, “Monitoring Inbound E-Mail,” on page 270
 Section 37.3.7, “Preventing Web Services Access,” on page 270
 Section 37.3.8, “Controlling RSS Feeds,” on page 270
 Section 37.3.9, “Securing Mirrored Folders,” on page 271
 Section 37.3.10, “Securing the Vibe Site against XSS,” on page 271


37.3.1 Configuring a Proxy Server


Your Novell Vibe system should be located behind your firewall. If Vibe users want to access the Vibe 
site from outside your firewall, you should set up a proxy server outside your firewall to provide 
access. You can use Novell Access Manager to protect your Vibe site, as described in “Configuring 
Single Sign-On with Novell Access Manager” in “Advanced Installation and Reconfiguration” in the 
Novell Vibe 3.2 Installation Guide.


37.3.2 Setting the Vibe Administrator Password


The Vibe site is initially installed to allow administrator access by using the username admin and the 
password admin. The Vibe administrator password should be changed immediately after installation, 
as described in “Accessing Your Basic Vibe Site as the Site Administrator” in “Basic Installation” in 
the Novell Vibe 3.2 Installation Guide.


37.3.3 Setting Up SSL Connections


All communication with the Vibe site should be configured to use SSL connections, as described in:


 Section 36.2, “Securing E-Mail Transfer,” on page 255
 Section 36.1, “Securing LDAP Synchronization,” on page 253
 Section 36.3, “Securing HTTP Browser Connections,” on page 255


Linux: /opt/novell/teaming/apache-tomcat/logs


Windows: c:\Program Files\Novell\Teaming\apache-tomcat\logs
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37.3.4 Shortening the Vibe Session Timeout


By default, if a user’s Vibe session is idle for four hours (240 minutes), Vibe logs the idle user out. For 
increased security for your Vibe site, you can make the session timeout shorter, as described in 
“Changing the Vibe Session Timeout” in “Advanced Installation and Reconfiguration” in the Novell 
Vibe 3.2 Installation Guide.


37.3.5 Using Role-Based Access Control


Vibe controls all access to folders and entries by using role-based access controls. Vibe is intended to 
be used primarily for the sharing of information, so many default access rights tend toward allowing 
at least universal read access. For information on setting access controls for your Vibe site, see:


 Chapter 2, “Planning and Controlling User Access to Workspaces and Folders,” on page 19 in 
this guide


 “Controlling Access” in the Novell Vibe 3.2 Advanced User Guide


37.3.6 Monitoring Inbound E-Mail


You can configure Vibe to receive e-mail and post the messages as entries in a folder, as described in 
“Enabling Inbound E-Mail” in “Basic Installation” in the Novell Vibe 3.2 Installation Guide. Because e-
mail is inherently non-secure, there is no way to be sure that the senders are who they claim to be. 
Entries posted by e-mail include the e-mail address of the sender to alert Vibe users about the origin 
of the postings.


37.3.7 Preventing Web Services Access


The default Vibe installation allows authenticated access via Web services, as described in 
“Configuring Web Services” in “Advanced Installation and Reconfiguration” in the Novell Vibe 3.2 
Installation Guide. If you are not using Web services, you can disable them.


37.3.8 Controlling RSS Feeds


Because RSS readers are outside of the authentication Vibe system, the URL provided by Vibe for an 
RSS feed embeds some authentication information about the user. This means that the RSS URL must 
be protected and not shared between users. For this reason, RSS is not recommended for use on 
highly sensitive data. If necessary, you can disable RSS feeds for your Vibe site, as described in 
“Managing RSS Feeds” in “Advanced Installation and Reconfiguration” in the Novell Vibe 3.2 
Installation Guide.
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37.3.9 Securing Mirrored Folders


Mirrored folders make files that are stored on a file system available to users on the Novell Vibe site. 
Two levels of security are provided for mirrored folder access:


 When you create mirrored folder resource drivers, as described in “Configuring Mirrored 
Folder Resource Drivers” in “Advanced Installation and Reconfiguration” in the Novell Vibe 3.2 
Installation Guide, you can choose read-only access or read/write access. In addition, you can 
identify specific Vibe users and groups that are allowed access to the mirrored folder resource 
drivers.


 When you set up the mirrored folders on the Vibe site, as described in Chapter 15, “Setting Up 
Mirrored Folders,” on page 133 in this guide, you can set access controls on the Mirrored File 
folder. 


37.3.10 Securing the Vibe Site against XSS


Cross-site scripting (XSS) is a client-side computer attack that is aimed at Web applications. Because 
XSS attacks can pose a major security threat, Novell Vibe contains a built-in security filter that 
protects against XSS vulnerabilities. This security filter is enabled by default. 


The following sections describe the types of content that the security filter blocks from the Vibe site, 
where exactly it blocks it from entering, and how you can disable the security filter or enable specific 
users to bypass the security filter.


 “Understanding What Content Is Not Permitted” on page 271
 “Understanding Where the Content Is Not Permitted” on page 271
 “Listing All XSS Threats in Your System” on page 272
 “Disabling the XSS Security Filter” on page 272


Understanding What Content Is Not Permitted


By default, the XSS security filter in Vibe is very strict, and does not allow users to add certain types 
of content. For example, the following content is not permitted:


 HTML that contains JavaScript
 Forms
 Frames
 Objects
 Applets


Understanding Where the Content Is Not Permitted


The type of content discussed in “Understanding What Content Is Not Permitted” on page 271 is 
filtered by Vibe in the following areas:


 Text and HTML fields in entries and folders
 Uploaded HTML files
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Listing All XSS Threats in Your System


Vibe enables you to run an XSS report that lists XSS threats that are contained in your Vibe system. 
For more information, see Section 26.2.10, “XSS Report,” on page 227.


Disabling the XSS Security Filter


IMPORTANT: Because of the serious nature of XSS attacks, we strongly recommend that you do not 
disable the XSS security filter for the entire site. If there are certain users who need to upload 
information to the Vibe site, you can grant those users access to bypass the XSS security filter, as 
described in Section 18.9, “Enabling Users to Bypass the XSS Security Filter,” on page 160.


It is possible to disable the XSS security filter for the entire site for each of these areas by copying the 
appropriate lines from the ssf.properties file, pasting them into the ssf-ext.properties file, 
then changing the values of the lines to false. The lines in the ssf.properties file that are 
responsible for enabling and disabling the XSS security filter are:


 xss.check.enable


 xss.content.filter.file.extensions
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About This Manual


The Novell Vibe 3.2 Developer Guide presents ways to extend the functionality of Novell Vibe. The 
guide is divided into the following sections:


 Chapter 1, “Web Services Overview,” on page 11


 Chapter 2, “Creating and Packaging Extensions for Deployment,” on page 25


 Chapter 3, “Remote Applications,” on page 31


 Chapter 4, “Creating JavaServer Pages (JSPs),” on page 41


 Appendix A, “Web Services Operations,” on page 71


 Appendix B, “Deprecated Web Services Operations,” on page 189


Audience


This guide is intended for programmers who want to write extensions for Vibe.


Feedback


We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comments feature at the bottom of each page of the 
online documentation.


Documentation Updates


For the most recent version of this manual, visit the Novell Vibe 3.2 Documentation Web site (http://
www.novell.com/documentation/vibe32). 


Additional Documentation


You can find more information in the Novell Vibe documentation, which is accessible from the 
Novell Vibe 3.2 Documentation Web site (http://www.novell.com/documentation/vibe32).


To access the Novell Vibe User Guide from within Vibe, click the Help icon (question mark).
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1 1Web Services Overview


Much of the information in this section references Teaming, which is the product name for the Vibe 
product for versions prior to Vibe 3. This information applies to Vibe 3 as well as earlier versions of 
the product.


Novell offers a set of operations that you can use in client programs to exchange information with a 
server that is running an installation of Novell Teaming 2.0 or later.


In addition to the overview information in this chapter, see Appendix A, “Web Services Operations,” 
on page 71, for reference information about the latest operations for the new interface. For reference 
information about earlier Web Services operations that have been superseded by the current release, 
see Appendix B, “Deprecated Web Services Operations,” on page 189.


 Section 1.1, “Vibe Web Services Terminology,” on page 11


 Section 1.2, “Web Services Implementation,” on page 12


 Section 1.3, “Authentication,” on page 14


 Section 1.4, “Server Endpoints,” on page 15


 Section 1.5, “Categories of Operations,” on page 15


 Section 1.6, “Client Stubs,” on page 16


 Section 1.7, “Managing Data,” on page 17


 Section 1.8, “Extending Vibe Web Services,” on page 23


1.1 Vibe Web Services Terminology
The following Novell Vibe definitions that can assist you when using the Vibe Web services:


 binder: A place such as a workspace or folder.


 binder configuration ID: A number that identifies the template used to create and configure a 
new workplace or folder. This number represents a set of information that Vibe uses to establish 
configuration settings, such as the default view, allowable views, allowable workflow, and 
workflow associations.


 binder ID: A unique number that identifies a specific workspace or folder. 


 data item name: A tag value that maps an HTML form element to a value stored in the Vibe 
database.


 definition ID: A unique 32-character hexadecimal identifier that maps to a definition for a 
specific type of entry. (You modify and create definitions by using the designers in the 
administration portlet.) You need to specify this value when creating a new entry in a folder.


 endpoint: The URL that you use to connect your client application to the Vibe server.
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 page: A level in the workspace hierarchy that represents a subset of binders. Most often used to 
group personal workspaces into sets that are convenient for display in the user interface. 
Section 1.7.6, “Binder Pages and search_getWorkspaceTreeAsXML,” on page 21 provides 
additional information about this hierarchical level.


 principal: A registered user or a group.


 principal ID: A unique number that identifies a specific user or group.


 stub: A proxy on the client. The stub code performs SOAP calls to the server.


1.2 Web Services Implementation
 Section 1.2.1, “Java Web Services,” on page 12


 Section 1.2.2, “Sample Clients,” on page 13


1.2.1 Java Web Services


Vibe implements Java Web services, which provide a set of operations that client programs can use to 
exchange information with Vibe. The alphabetized reference section in this documentation provides 
syntax for these operations (Appendix B, “Deprecated Web Services Operations,” on page 189). 


You can view a list of available operations online:


http://localhost:8080/ssf/ws


The latest operations are listed under the TeamingServiceV1 header, and the deprecated operations are 
listed under the Facade header.


You can also access the Vibe Web Services Description Language (WSDL) file:


http://localhost:8080/ssf/ws/TeamingServiceV1?wsdl


In the previous two examples, replace the localhost specification with the host and port for your 
Vibe installation.


NOTE: Vibe does not currently publish its WSDL file with Universal Description, Discovery, and 
Integration (UDDI) or the Web Services Inspection Language (WSIL). Use the alphabetized reference 
section in this manual (Appendix A, “Web Services Operations,” on page 71) or the URL-generated 
WSDL file to understand the Vibe operation interface. For reference information about earlier Web 
Services operations that have been superseded by the current release, see Appendix B, “Deprecated 
Web Services Operations,” on page 189.


When you make calls to Vibe Web services, there are two ways that you can implement lower-level 
Simple Object Access Protocol (SOAP) calls:


 Unzip client-side routines on the system running your application. These routines are Java 
classes and other files that produce a stub. Your application can use an interface with these stub 
routines, which make the SOAP calls to and from the server. See Section 1.6, “Client Stubs,” on 
page 16, for more information about implementing these client-side routines on your 
application’s system.


 Have your application perform the SOAP calls by using, for example, routines from the Apache 
Axis toolkit.
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Vibe Web services accepts and provides data by using Java objects and methods defined in the Vibe 
source code. (Visit the Open Source Community page (http://www.kablink.org) for more information 
about downloading the source code.) Although this section provides tips for locating object and 
method definitions, you might want to apply a tool such as Javadoc to the sources, so that you have 
reference pages to assist you in working with the Vibe objects and methods.


The primary method of learning to use Vibe Web services is by reviewing sample clients and their 
source code, which are provided in the Vibe sources.


1.2.2 Sample Clients


Vibe provides sample clients in its product code base that can assist you in learning how to use its 
Web services. The sample clients are located within the source code:


/ssf/samples/wsclient


The following sample clients are provided. The are listed in the order of how helpful they are in 
learning how to make Web service calls:


 teamingservice-client-with-stub.bat (Teaming 2.0+): Uses client-side routines to implement a 
Windows batch file for simple operations. This is the recommended method. Using this batch 
file requires the installation of the client-side routines.


 teamingservice-client-with-call.bat (Teaming 2.0+): Uses the Axis Call object when making 
Web service calls, as a way to implement a Windows batch file for simple operations.


 facade-client.bat (V1+): Uses the deprecated Web services interface. 


 wsExport.bat and wsImport.bat (Teaming 2.0+):  Takes data from a portion of the workspace 
and folder hierarchy and reproduces it on another file system. These tools are not a complete 
import and export facility, because they do not retain the workflow states, access-control 
settings, and history of the original objects.


You can find the source files for the sample clients here:


/ssf/samples/wsclient/src/org/kablink/teaming/samples/wsclient


The TeamingServiceClientWithCall.java file extends the WSClientBase.java file, which is also 
located in the /ssf/samples/wsclient/src/org/kablink/teaming/samples/wsclient directory.


Enabling the .bat clients (Windows systems only)


Before executing the sample .bat programs on a Windows system, you need to do some work in 
your build to enable them. 


1 Execute the build Ant target in /ssf/samples/wsclient/build.xml by entering ant from the 
command line.


To use one of the batch files:


1 Use a command line window to cd to the /ssf/samples/wsclient directory.


2 Type the filename for the batch file you want to execute.


To see a list of legal commands and arguments for one of the teamingservice or facade batch 
files, type only the filename of the batch file, then press the Return key.
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3 On the same line, just after the name of the batch file, type a command name and desired 
arguments.


4 Press the Return key.


If the command executes successfully, Vibe displays the return value in the command line window.


1.3 Authentication
Before determining how to connect your client application to the server, it is important to decide on 
the authentication method that you want to use. Vibe and its Web services support two types of 
authentication:


 Section 1.3.1, “HTTP Basic Authentication Access (ssr),” on page 14


 Section 1.3.2, “Web Services Security Access (ssf),” on page 14


1.3.1 HTTP Basic Authentication Access (ssr)


For basic authentication, use calls from your client application to pass a username and password as 
you establish an HTTP session. Then, perform SOAP calls or calls using the client-side routines. If 
you want to use basic authentication, you muse use the /ssr/secure/ws endpoint when connecting 
to the server. 


HTTP Basic Authentication is the existing transport authentication to authenticate the Web services 
client. HTTP Basic Authentication uses a username and password to authenticate a service client to a 
secure endpoint. To use this authentication mechanism, use /ssr/secure/ws endpoint. To enable 
this service on the Vibe side, select the Enable Basic Authentication (recommended) check box during 
product installation.


See Section 1.4, “Server Endpoints,” on page 15, for more information about connecting to the server.


1.3.2 Web Services Security Access (ssf)


For WSS authentication, you need to place the authentication information (username and password) 
in the SOAP calls. If you want to use this method of authentication, use the /ssf/ws endpoint to 
connect to the server.


Web Services Security (WSS) is a standard protocol from Oasis that provides a means for applying 
security to Web services. Unlike security mechanisms that rely on the use of transport layer services, 
WSS provides authentication at the message layer by using a SOAP header. To use this authentication 
mechanism, use /ssf/ws endpoint. The deprecated Web services operation is accessed only through 
this mechanism. This service is enabled on the Vibe side by selecting the Enable WSS Authentication 
(recommended) check box during product installation.


If you choose to use WSS authentication instead of HTTP basic authentication:


 Use the teamingservices-client-with-call.bat client and its sources to see an example of 
this type of authentication.


 You must use the /ssf/ws endpoint (see Section 1.4, “Server Endpoints,” on page 15, for more 
information).
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 You must use password-text methods.


Password-digest is still supported in Teaming 2.0 and earlier but support is dropped with 
Teaming 2.1. We strongly recommended that you use only the password-text method.


On the client side of the Web services transaction, the client code uses password-text to provide a 
username and password to the Web services framework, and the framework passes the password as 
plain text.


On the server side, the security framework allows Vibe to retrieve the clear-text password from the 
operation by using an application programming interface (API) call. Vibe applies its internal 
password encryptor and compares the result with the password stored in the database for the user 
when the password is retrieved.


Although it is easy to code, this method is not secure, because the password is transmitted in plain 
text. Systems requiring a higher level of security should connect to Vibe over SSL.


To use this service with the teamingservice-client-with-call.bat, edit the script and set the 
value of the -Dauthmethod switch to wss_text.


See Section 1.4, “Server Endpoints,” on page 15, for more information about connecting to the server.


1.4 Server Endpoints
An endpoint is the URL that you use to connect your client application to the Vibe server. Depending 
on the authentication method you want to use and other factors, you must choose one of the 
following five endpoints to specify in your client application:


 /ssf/ws/TeamingServiceV1: Use this endpoint if you want to use WSS authentication with the 
latest Web services operations. See Section 1.3, “Authentication,” on page 14.


 /ssf/ws/Facade: Use this endpoint if you want to use the deprecated Web services operation. This 
endpoint requires WSS authentication.


 /ssr/secure/ws/TeamingServiceV1: Use this endpoint only if you are using HTTP Basic 
Authentication with the latest Web services operations.


 /ssr/token/ws/TeamingServiceV1: Use this endpoint when you are making a Web services call 
as a remote application.


 /ssr/ws/TeamingServiceV1: Use this endpoint when you want to access Vibe as an anonymous 
user (not specifying any username or password).


1.5 Categories of Operations
To assist you in locating the operation you need to perform, the name of each operation is prefaced 
with its category name. For example, one category is called folder, and one operation within that 
category is folder_getEntry.


The following categories of Web services operations are available:


 binder: Operations that are specific to workspaces, common to workspaces and folders, or that 
are to be applied to the workspace tree beginning at a specific node in the tree.


 definition: Operations for obtaining and using definitions. Definitions are created by using the 
designers within the Vibe UI.


 folder: Operations that affect only folders and their contents (entries and comments).
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 ical: The operation that adds a calendar entry.


 ldap: Operations that work with LDAP data.


 license: Operations used for license compliance.


 migration: Operations that assist migration from the SiteScape Forum product to Vibe. See 
“Migrating from SiteScape Forum or Other Collaboration Software” in “Update” in the Novell 
Vibe 3.2 Installation Guide.


 profile: Operations affecting users and groups.


 search: Operations that assist in locating information based on criteria other than the defined 
type.


 template: Operations that create workspaces and folders, or that get lists of available templates. 
(To create a completely configured folder, use template_addBinder and not 
binder_addBinder.)


 zone: Operations that work with different Vibe starting points within the same installation. Each 
starting point contains its own unique workspace hierarchy.


1.6 Client Stubs
A stub is a proxy on the client. The stub code performs SOAP calls to the server. Vibe provides 
pregenerated Java stub classes that are included in the Kablink Vibe Web Services Java client library. 
To obtain the Kablink Vibe Web Services Java client library, see Section 1.7.1, “Working with Java 
Objects,” on page 17.


The following example is the deleteFolderEntry method defined in the sample Java class 
TeamingServiceClientWithStub.java file. The TeamingServiceClientWithStub.java file makes 
SOAP calls to Vibe through the use of the pregenerated Java stub classes. This method uses the 
folder_deleteEntry Web services operation to delete an entry from Vibe. This code assumes that your 
client is running on the same machine that is running the Vibe server (localhost). It uses the Basic 
Authentication mechanism for authentication.


  private static final String TEAMING_SERVICE_ADDRESS_BASIC   = "http://
localhost:8080/ssr/secure/ws/TeamingServiceV1";
  
  private static final String USERNAME = "admin";
  private static final String PASSWORD = "test";
      .
      .
      .
  public static void deleteFolderEntry(long entryId) throws Exception {
    TeamingServiceSoapServiceLocator locator = new 
TeamingServiceSoapServiceLocator();
    locator.setTeamingServiceEndpointAddress(TEAMING_SERVICE_ADDRESS_BASIC);
    TeamingServiceSoapBindingStub stub = (TeamingServiceSoapBindingStub) 
locator.getTeamingService();
    WebServiceClientUtil.setUserCredentialBasicAuth(stub, USERNAME, PASSWORD);


    stub.folder_deleteEntry(null, entryId);
    
    System.out.println("ID of the deleted entry: " + entryId);
  }
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1.7 Managing Data
Some operations are less intuitive than others for messages. This section provides additional 
information for those operations and includes the following subsections:


 Section 1.7.1, “Working with Java Objects,” on page 17


 Section 1.7.2, “Adding Folders and the Binder Configuration Identifier,” on page 18


 Section 1.7.3, “Attaching Files,” on page 20


 Section 1.7.4, “Fetching Attachments,” on page 20


 Section 1.7.5, “Adding Calendar Entries,” on page 21


 Section 1.7.6, “Binder Pages and search_getWorkspaceTreeAsXML,” on page 21


1.7.1 Working with Java Objects


The Web services operations often pass and return data within model objects as defined within the 
Kablink Vibe software. This is beneficial because it cuts down on the amount of code required to 
prepare, send, receive, and interpret data. For example, parsing XML strings requires more coding. 
For users who develop Web services client applications in Java, Kablink Vibe provides a client-side 
library that they can use directly for added convenience. Users who develop Web services client 
applications in a language other than Java must rely on their own tools for understanding and coding 
the Kablink Vibe Web interfaces that have been defined and exposed by the corresponding WSDL.


Regardless of the language and tools that are used to develop Web services applications, it is helpful 
to familiarize yourself with some of the Vibe source code in order to understand the model objects 
and methods that are used to pass parameters and receive returned data.


To obtain the Kablink Vibe Web Services Java client library, download the Kablink Vibe product 
distribution tar/zip file from the Kablink Web site  (http://kablink.org/teaming), and expand file in a 
directory. This product distribution tar/zip file contains teaming-2.*.*-wsclient.zip. This file 
contains:


 The Axis-generated Java source and class files for the client side stubs and model classes.


kablink-teaming-wsclient.jar


 Search utility classes that aid in building search queries.


kablink-teaming-util-search.jar


 All third-party libraries needed on the client side to run generated stubs.


The kablink-teaming-wsclient.jar file contains the Java source that defines model objects that 
are passed between the Web services client and the Vibe server as either input arguments to or return 
values from various Web service operations. These model classes are located in the org/kablink/
teaming/client/ws/model Java package. A significant number of the model classes build upon the 
base class DefinableEntity. The TeamingServiceSoapBindingStub.java class is the main stub 
class that application programs need to interact with in order to invoke various Web service 
operations.


To access Java sample programs that use the Kablink Vibe Web Services Java client library, download 
the Vibe source code from the Open Community Source page (http://www.kablink.org/) and examine 
the source code and scripts located in the /ssf/samples/wsclient directory. For example, the 
TeamingServiceClientWithStub.java class in /ssf/samples/wsclient/src/org/kablink/
teaming/samples/wsclient demonstrates how to use the supplied stub and model classes to 
invoke Vibe Web services operations with minimum coding effort.

Web Services Overview 17



http://www.kablink.org/





The kablink-teaming-wsclient.jar is also found with in the source tree in the /ssf/ws-client 
directory. To implement a client-side application of your own, all of the necessary libraries must be 
defined as being in your class path. When the sample program is run in /ssf/samples/wsclient, 
the accompanying build.xml Ant build script performs this function for you. It can be viewed as a 
template.


The names of the Web services operations use categories to organize the operations so they are easier 
for you to locate and understand. In general, the categories describe an item within Vibe that is the 
focus of the operation, such as folder, entry, binder, or attachments.


1.7.2 Adding Folders and the Binder Configuration Identifier


When you add a fully configured folder such as template_addBinder (page 184), you need to specify 
a binder configuration identifier, which identifies the template used to configure a folder of a 
particular type. For example, the blog-folder template specifies settings used to configure a new blog 
folder.


To review the blog-folder template:


1 Log in to Vibe as the Vibe administrator.


2 Click the Administration icon  in the upper-right corner of the page.


The Administration page is displayed.


3 Under Management, click Workspace and Folder Templates.


4 In the Standard Templates section, click Blog.


5 Click Manage This Target > Configure.


The Configure Default Settings page is displayed.
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The following configuration settings are available in the template:


 Definition inheritance


 Allowed Views


 Default View


 Default Entry Types


 Workflow Associations


 Allowed Workflows


At the time of this writing, Vibe does not provide a message that you can use to retrieve the binder 
configuration identifier for a particular type of folder. Use the following procedure to obtain the 
binder configuration identifier for the folder you want to create:


1 View any workspace or folder.


2 Click Manage > Add folder.


3 While viewing the Add new folder page, use your browser to view the HTML source code for the 
page.


4 Search for the type of folder you want to create (for example, discussion, blog, or calendar).
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5 In the input HTML tag that creates the radio button for that type of folder, note the 
name=”binderConfigId” and value=”nnn” pair of tag elements.


The number specified by the value element is the binder configuration identifier of the folder 
you want to create.


The following figure shows an example of the binder configuration information for a blog folder, as 
found in the HTML source for the Add new folder page:


Figure 1-1   The Binder Configuration Identifier in Source Code


1.7.3 Attaching Files


In Novell Vibe, attachments are files that are associated with an entry. An entry can have more than 
one attached file.


For Web services, an attachment is a file exchanged in conjunction with an operation being passed 
between the client and server. Vibe recognizes only the first file attachment to an operation being sent 
to the server and ignores all other attachments.


To attach more than one file to an entry in Vibe, you must use one of the upload operations multiple 
times. For example, to attach 17 files to an entry in Vibe, you must use folder_uploadFile 17 times. 
Your client source code establishes where in the file system it finds or places files used as attachments 
to messages.


The folder_uploadFile operation requires that you pass a data item name. This identifier maps to 
the value specified in the name attribute of the input HTML tag used to upload the file; this value is 
also used in a hidden HTML tag that communicates values between the HTML form and the Vibe 
database.


To upload a file into the standard form element used to contain attachments, specify ss_attachFile 
as the data item name. If you are uploading files into a custom form element, create an instance of 
that custom entry, use an operation to get the name of the hidden field, then use the name when 
attaching files to the entry you actually want to affect.


1.7.4 Fetching Attachments


When you use folder_getEntry to obtain information about an entry, you use a Boolean parameter 
to indicate if you want the entry’s attachments. If you specify that you do want the attachments, your 
client establishes where on its system it places the attached files.
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1.7.5 Adding Calendar Entries


When you pass the ical_uploadCalendarEntriesWithXML operation to the server, the Web services 
framework uses an XML formatted string of iCal data passed as the second parameter to the 
operation (<doc><entry>iCal data</entry></doc>).


1.7.6 Binder Pages and search_getWorkspaceTreeAsXML


When you use search_getWorkspaceTreeAsXML to obtain information about the hierarchical 
workspace tree, Novell Vibe returns XML formatted information about nodes in the tree, within the 
levels of the hierarchy you specify. Each node in the tree is a binder, which is typically a place (a 
workspace or folder). Sometimes, the XML element returned for a node is called a page.


The following graphic shows the workspace tree, which is expanded to show five levels of the 
workspace hierarchy:


Figure 1-2   Workspace Hierarchy Levels as Seen in the UI


In the graphic, each of the workspaces and folders are nodes in the workspace tree. The Workspaces 
workspace is the only binder at level 1. Level 2 binders include Global workspaces, Personal 
workspaces, and Team workspaces. The only binder shown at level 3 is the Corporate web site 
binder. Level 4 binders include folders and the December 2008 redesign workspace. The Calendar 
binder is located at level 5. If a binder has a plus sign next to it (for example, both the Global 
workspaces and Personal workspaces binders are preceded by plus signs), it means that there are 
hierarchy levels of binders that are not displayed in the UI.


If you use search_getWorkspaceTreeAsXML to get one level of the tree starting at the Workspaces 
node, Vibe returns information about Global workspaces, Personal workspaces, and Team 
workspaces.


As mentioned, some nodes in the tree are pages:
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Figure 1-3   Pages as They Appear in the UI


The /ssf/web/docroot/WEB-INF/classes/config/ssf.properties file contains a property 
called wsTree.maxBucketSize, which, by default, is set to 25. This means that the maximum number 
of sub-workspaces allowed is 25. If a folder or workspace has more subplaces, Vibe creates virtual 
buckets called pages. Each line in Figure 1-3 corresponds to a page. The Personal workspaces 
workspace has two pages.


When you use search_getWorkspaceTreeAsXML to retrieve information about nodes in the 
workspace tree, it can return more than one hierarchical level as you specify, unless it encounters a 
page. To expand the tree beyond a page, you must call search_getWorkspaceTreeAsXML again, pass 
the binder identifier of the page, and pass the number of levels beyond the page you want to retrieve.


Consider the following:


Figure 1-4   A Page Containing Sub-Workspaces


The wong//zeeman page contains workspaces. The workspaces listed (Wong, Charles (cwong), and 
Zeeman, Skip szeeman)) are one level beyond the page.


When you receive page information as a node in the workspace tree, you receive page and tuple 
attributes. For example, page=”2” and pageTuple=”charles_wong (cwong)//skip_zeeman 
(szeeman)”. To obtain information about the contents of this page, you need to specify the identifier 
of the page’s parent, the number of hierarchy levels you want expanded, and a concatenation of the 
page number and tuple values, as shown in this example:


search_getWorkspaceTreeAsXML 24 3 "2//charles_wong//skip_zeeman"


This code begins at binder number 24, accesses page number 2, and returns two hierarchical levels of 
data for all users between Charles Wong and Skip Zeeman.
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Given the structure of the Vibe pages and how Web services returns tree data, it is easiest to retrieve 
page data in this way. However, if you choose, you can actually retrieve paged tree data regardless of 
page number. To do this, specify any page number (Vibe actually ignores it), and specify a tuple in 
the correct order in which it appears in the tree, even if the set of users crosses pages. Vibe returns 
hierarchical information for all users in between the tuple values. However, if the number of returned 
nodes exceeds the value specified in the wsTree.maxBucketSize property (by default, 25 users), Vibe 
pages the data.


Finally, if you want to see all tree information without any page specifications, specify -1 as the value 
of the hierarchy levels you want returned.


1.8 Extending Vibe Web Services
Because Kablink Vibe is open source software, you have the source code that implements our Web 
services, and you can extend it. However, we invite you to operate within the spirit of an open source 
community by participating in the Kablink Vibe online community (http://www.kablink.org), 
sharing your code with others, and working with the Novell engineers to incorporate your Web 
services extensions into the base product. In this way, you make the product and community 
stronger, and you avoid doing work that might need to be redone in future versions of Kablink Vibe 
because of engineering changes.


Of course, whether you participate in the community or upgrade to future versions of the software is 
up to you. Regardless of your decision, Kablink Vibe includes an example that provides a structure 
that enables users of all versions of our software to extend our Web services in the most optimal way, 
minimizing work that you might need to do to maintain the extensions for every upgrade.


Kablink Vibe includes an extended Web services example, which adds the folder_getFolderTitle 
operation to the base Vibe web services, and also adds the getFolderTitle command to the 
teamingservice-client-with-call.bat sample client. The source code for the extension is located 
in this directory and in its subdirectories:


/ssf/samples/extendedws


This directory contains the readme.txt file, which provides simple directions for establishing the 
extension. 
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2 2Creating and Packaging Extensions for 
Deployment


Much of the information in this section references Teaming, which is the product name for the Vibe 
product for versions prior to Vibe 3. This information applies to Vibe 3 as well as earlier versions of 
the product.


Extensions in Novell Vibe enable you to bundle definition and template XML, custom workflow calls 
that implement the workflow action and condition interfaces, custom JSP files, and other Web-visible 
resources that are needed by the application browser interfaces.


Extensions can help you customize your Novell Vibe site, adding increased functionality that can 
help you solve specific business problems.


This section describes how to create an extension and then package it for deployment. For 
information on how to deploy an extension after it has been created and packaged, see “Adding 
Software Extensions to Your Vibe Site” in the  Novell Vibe 3.2 Administration Guide.


 Section 2.1, “Understanding the Differences between Extensions and Remote Applications,” on 
page 25


 Section 2.2, “Creating an Extension,” on page 26


 Section 2.3, “Packaging an Extension,” on page 26


 Section 2.4, “Deploying an Extension,” on page 28


 Section 2.5, “Updating an Extension,” on page 29


 Section 2.6, “Locating an Extension in the Vibe Directory Structure,” on page 29


 Section 2.7, “Retaining an Extension When Updating Your Vibe Software,” on page 29


2.1 Understanding the Differences between Extensions and 
Remote Applications
Extensions and remote applications can be used to accomplish many of the same functions; however, 
the way in which they are created and how they are implemented can differ dramatically. Before you 
create a Vibe extension or remote application, consider how you want to create it (such as what 
coding language you want to use), as well as the environment in which you want your extension or 
remote application to run (such as in an external Web application or Web server).


Table 2-1 depicts important technical differences between extensions and remote applications.
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Table 2-1   Technical Differences between Extensions and Remote Applications


2.2 Creating an Extension
Vibe extensions are made up of various files that are commonly used when designing a Web page.


To create an extension for your Novell Vibe site:


1 Create all of the necessary files. 


Vibe extensions are made up of various files that are commonly used when designing a Web 
page, such as JSP, HTML, XHTML, CSS, JS, GIF, JPG, PNG, CLASS, JAR, XML, PROPERTIES, and TXT.


2 After you have created all the necessary files, you must properly package the files, as discussed 
in Section 2.3, “Packaging an Extension,” on page 26.


2.3 Packaging an Extension
After you create an extension as described in Section 2.2, “Creating an Extension,” on page 26, you 
must package the extension before it can be deployed on the Vibe site.


1  Create a ZIP file that contains all of the files needed for your extension.


The ZIP file should have a relative directory structure that mirrors the layout of the teaming/
tomcat/webapps/ssf directory found in your Vibe installation.


For examples of how the extension directory structure should look, see Section 2.3.1, “Examples 
of the Archive Format,” on page 27.


Table 2-2 lists key files and their appropriate locations in this directory structure. 


 Extension Remote Application


Web Container Tomcat only Any container (for example, Tomcat, 
Apache, IIS)


Coding Language Java and JSP only Any language (for example, PHP, 
Ruby, .NET)


Web Application Must run inside the Vibe Web application Runs outside of the Vibe Web 
application


Server Runs on the same server as Vibe Can either run on the same server as 
Vibe (but on a separate Web 
application), or on an external server
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Table 2-2   File Locations for Vibe Extensions


2.3.1 Examples of the Archive Format


Your ZIP file should be structured in the Archive format. This section provides two examples of the 
archive format. Archive: VideoEntry.zip includes externally referenced files in the swf/, img/, 
and js/ directories. Archive: twitter.zip references only those files that are located within the 
WEB-INF directory.


 “Archive: VideoEntry.zip” on page 27


 “Archive: twitter.zip” on page 28


Archive: VideoEntry.zip


install.xml
js/
js/flashembed.min.js
swf/
swf/FlowPlayerClassic.swf
swf/FlowPlayerLight.swf
swf/FlowPlayerLP.swf
swf/FlowPlayerDark.swf
WEB-INF/
WEB-INF/classes/
WEB-INF/classes/config/
WEB-INF/classes/config/definitions/
WEB-INF/classes/config/definitions/VideoEntry.xml
WEB-INF/classes/config/definitions/VideoFolder.xml
WEB-INF/classes/config/templates/
WEB-INF/classes/config/templates/Video Folder Template.xml
WEB-INF/jsp/
WEB-INF/jsp/view.jsp
img/
img/no-flash.png
img/no-flash.svg


File Type Location


Web-visible resources, such as graphics, static html 
pages, js files, and css files.


tomcat/webapps/ssf


You can create additional folders inside the ssf 
directory. For example, you might want to create a js 
directory where you can place all your javascript files.


Templates WEB-INF/classes/config/templates


Definitions WEB-INF/classes/config/definitions


jsp WEB-INF/jsp


jar WEB-INF/lib
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Archive: twitter.zip


install.xml
WEB-INF/
WEB-INF/classes/
WEB-INF/classes/config/
WEB-INF/classes/config/definitions/
WEB-INF/classes/config/definitions/_user.xml
WEB-INF/classes/config/definitions/pubToTwitter.xml
WEB-INF/src/
WEB-INF/src/TwitterWorkflowAction.java
WEB-INF/lib/
WEB-INF/lib/TwitterExtension.jar
WEB-INF/lib/commons-httpclient-3.1.jar
WEB-INF/lib/twitter4j-2.0.8.jar
WEB-INF/jsp/
WEB-INF/jsp/password.jsp


2.3.2 Extension Metadata


The install.xml file should contain the following information:


<?xml version="1.0" encoding="utf-8"?>
<extension version="1.0" >
<title>Twitter Extension</title>
<author>Author's Name</author>
<creationDate>August 27 2009</creationDate>
<license>http://www.gnu.org/licenses/gpl-2.0.html GNU/GPL</license>
<authorEmail>nbjensen@novell.com</authorEmail>
<authorUrl>www.mysite.com</authorUrl>
<description>This Plugin is a sample.</description>
<usage>Instructions on how to use this extension.</usage>
</extension>


2.4 Deploying an Extension
After you have created and packaged an extension, it is ready to deploy into your Vibe site. 


NOTE: If your extension requires additional configuration after it is deployed into the Vibe site, 
ensure that you provide installation instructions on the page where the extension is downloaded.


You can deploy a Vibe extension in the following two ways:


 Section 2.4.1, “Deploying an Extension from the Vibe Interface,” on page 28


 Section 2.4.2, “Deploying an Extension from the Vibe Server,” on page 28


2.4.1 Deploying an Extension from the Vibe Interface


For information on how to deploy an extension by using the Vibe interface, see “Adding Software 
Extensions to Your Vibe Site” in the  Novell Vibe 3.2 Administration Guide.


2.4.2 Deploying an Extension from the Vibe Server


1 Copy the ZIP file that contains all the necessary files for your extension to the following location 
on the Vibe server: /var/opt/teamingdata/extensions/kablink/pickup


Vibe periodically checks this directory and deploys the file on the Vibe server.
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2.5 Updating an Extension
1 Navigate to and unzip the ZIP file that you created that contains all of the files for your 


extension.


2 Modify the install.xml file and any other files that you want to update.


3 Create a ZIP file with the updated files.


The name of this file must be the same name as your original extension.


4 Deploy your extension, as described in “Adding Software Extensions to Your Vibe Site” in the  
Novell Vibe 3.2 Administration Guide.


Vibe automatically updates your extension files with the latest files from your newly deployed 
extension.


2.6 Locating an Extension in the Vibe Directory Structure
You might need to locate an extension in the Vibe directory structure in the following scenarios:


 When you are developing and building the file structure for the extension


 When you are troubleshooting problems associated with the extension after it has been 
deployed


You can locate the WEB-INF contents and Web-visible contents of the extension at the following 
locations in the Vibe directory structure:


WEB-INF Contents: ssf/WEB-INF/ext/zoneKey/extensionName


Web-Visible Contents: ssf/ext/zoneKey/extensionName


The name of the extension is the name of the ZIP file that you created in Section 2.3, “Packaging an 
Extension,” on page 26.


2.7 Retaining an Extension When Updating Your Vibe Software
When extensions are located in the /var/opt/teamingdata/extensions directory, they are not lost 
during a Vibe software update.


However, if you install a new extension that has the same name as an existing extension, the existing 
extension is overwritten.
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3 3Remote Applications


Much of the information in this section references Teaming, which is the product name for the Vibe 
product for versions prior to Vibe 3. This information applies to Vibe 3 as well as earlier versions of 
the product.


You can set up your Novell Vibe installation so that remote applications—which often run on other 
server machines—provide HTML for segments of Vibe pages. Using this customization method gives 
you several advantages:


 Provides more control over the format and content than using Vibe designers or JSP files.


 Allows customization designers to work primarily within a familiar development environment 
(for example, using PHP or Perl) instead of requiring them to do most of their work within the 
Vibe environment.


 Protects the customization from the effects of any future updates to the Vibe source code.


 Eliminates the risk of implementing a customization that destabilizing the base product.


This topic includes the following sections:


 Section 3.1, “Understanding the Differences between Extensions and Remote Applications,” on 
page 31


 Section 3.2, “Remote Application Overview,” on page 32


 Section 3.3, “Creating a Remote Application,” on page 37


 Section 3.4, “Related Sections,” on page 39


NOTE: This chapter presents a “hello world” example application that you can implement quickly 
on your Novell Vibe server, using the Eclipse build environment and Tomcat. The registration and 
application sections assume use of this example application. For more information about the example 
application, see Section 3.3, “Creating a Remote Application,” on page 37.


3.1 Understanding the Differences between Extensions and 
Remote Applications
Extensions and remote applications can be used to accomplish many of the same functions; however, 
the way in which they are created and how they are implemented can differ dramatically.


For information about the technical differences between extensions and remote applications, see 
Section 2.1, “Understanding the Differences between Extensions and Remote Applications,” on 
page 25.

Remote Applications 31







3.2 Remote Application Overview
This section provides a conceptual overview about the interoperability between Novell Vibe and 
remote applications. If you prefer to learn by doing, you might want to skip this section and begin 
with Section 3.3, “Creating a Remote Application,” on page 37. 


Use the following very high-level steps as an overview for setting up a customization based on a 
remote application:


1 A site administrator registers a remote application, specifying a name and a URL for the 
application (for more information, see Section 3.4.1, “Registering a Remote Application,” on 
page 39).


2 After using configuration or designer tools to include HTML from a remote application, a page 
in Vibe performs an HTTP POST operation to the application’s URL and provides user-context 
information.


3 As an option, the remote application can use Web services to obtain Vibe data needed to 
generate its section of the page.


4 The remote application responds, providing its HTML to the Vibe code that is drawing the page.


Because Vibe has already begun to draw the page, providing structuring HTML tags (such as 
html, title, head, and body), the remote application should not specify those tags.


In Vibe, a remote application is treated as a principal; examples of other principals are users and 
groups. Vibe treats the application like a user, and users are subject to access control.


When Vibe makes a request of the remote application, it provides the user identifier for the user 
currently viewing the page, and it provides a security token. Depending upon the type of Vibe page 
that incorporates HTML from the remote application, the security token can be session-based (valid 
until the user signs out) or request-based (invalid immediately after the remote application responds 
to the request). In most cases, Vibe uses a combination of the registration information for the remote 
application, rights assigned to the user currently viewing the page, and rights granted to the remote 
application itself. 


There are several ways to apply HTML generated from remote applications:


 As an accessory (session-based token)


 As any portion of a custom form or view (session-based token)


 As a consequence of a workflow state change (request-based token)


 As a call from a tag within a custom JSP file (session-based token)


For more information, see the following subsections:


 Section 3.2.1, “Processing Flow for a Remote Accessory,” on page 33


 Section 3.2.2, “Processing Flow for a Remote Form,” on page 34


 Section 3.2.3, “Setting Access Control for Remote Applications,” on page 35


 Section 3.2.4, “Reviewing Supporting Source Code,” on page 36
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3.2.1 Processing Flow for a Remote Accessory


This section describes the flow of information when someone configures an accessory to use HTML 
from a remote application to provide its content. Consider the numbers in this graphic and the 
descriptions that follow it:


Figure 3-1   Conceptual Diagram for an Accessory Calling a Remote Application


1. The enclosing rectangle in the graphic represents a workspace or folder page. 


Vibe draws the page until it encounters the accessory.


2. The enclosed rectangle represents an accessory that is configured to use HTML generated from a 
remote application.


3. Vibe calls the remote application by using the HTTP POST method, and it provides the user ID 
of the person viewing the page and a security token.


The gray portion of the diagram indicates that control has been passed to the remote application, 
which might be located on a server machine separate from the one running Novell Vibe.


4. The rectangle in the gray area represents the remote application.


The remote application can access databases external to Vibe as part of its process for 
constructing the HTML needed to generate the accessory. The remote application can run in any 
environment that can generate an HTML response (for example, using PHP or Pearl scripts in its 
application environment).


5. As an option, the remote application can use the Vibe user ID and security token to log into the 
Vibe Web services and make calls, which can gather Vibe data in preparation for generating the 
HTML for the accessory. 
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6. This rectangle represents Vibe Web services.


In the graphic, both Web services and the Vibe user interface have access to information in the 
Vibe database.


After the remote application responds by returning HTML for the accessory, Vibe adds the HTML to 
the output stream and finishes drawing the page. Then, Vibe revokes the security token so that it can 
no longer be used.


3.2.2 Processing Flow for a Remote Form


This section describes the flow of information when someone uses the Vibe designers to specify that a 
remote application provides the HTML for the form used to create an entry. Consider the numbers in 
this graphic and the descriptions that follow it:


Figure 3-2   Conceptual Model for an Add-Entry Form Generated Remotely


1. The enclosing rectangle represents the add-entry page.


2. The enclosed rectangle represents the form used to add an entry.


3. Vibe does an HTTP POST to the remote application, sending the folder ID of the enclosing 
folder, the user ID of the person currently viewing the add-entry page, and a session-level 
security token.


4. The remote application builds the HTML needed to construct the form to be displayed on the 
Vibe page. The URL specified to the action element in the form tag points to the remote 
application.


5. The remote application can use the user ID and security token to log into Vibe Web services, 
which can gather data used to construct the form.


6. This rectangle represents the Vibe Web services.
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After the remote application responds by returning HTML for the form, Vibe adds the HTML to the 
output stream and finishes drawing the page. The user completes and then submits the form. 
Information on the form goes directly to the remote application, which then uses the folder ID, user 
ID, and security token to make Web services calls, which, in turn, create a new entry in the folder 
based on the information provided in the form.


When the user logs out, Vibe revokes the security token.


3.2.3 Setting Access Control for Remote Applications


 “Understanding Access Control Settings for Remote Applications” on page 35


 “Setting Access Controls on a Remote Application” on page 35


Understanding Access Control Settings for Remote Applications


As mentioned, Vibe treats a remote application as a Novell Vibe user, which allows for the 
application of access control. However, for non-workflow uses of remote applications, Vibe considers 
these factors when determining access control:


 Rights granted to the user currently viewing the page that contains HTML from the remote 
application.


 Rights granted to the remote application by the owner of the containing binder (workspace or 
folder).


 The Trusted designation, which a Site Administrator can grant to a remote application upon 
registration.


Vibe considers the role of the user viewing the page and the role assigned to the remote application, 
and Vibe grants the less powerful role to the application. For example, if the user viewing the page 
has the role of Visitor, and if the workspace or folder owner places the remote application in the role 
of Participant, the application has the rights associated with a Visitor. As another example, if the user 
is a Site Administrator, and if the application is a Participant, the application has the rights associated 
with a Participant.


When the site administer selects the Trusted check box while registering a remote application, then 
Vibe disregards any access control applied to the application and uses only the access control granted 
to the user viewing the page.


Finally, if Vibe calls a remote application as the result of a workflow state change, access control is 
determined by settings in the workflow definition, which can result in the application having the 
rights of either the entry owner or the folder owner.


Setting Access Controls on a Remote Application


Unless you are certain that an application is trusted (for example, an application that you maintain 
and run on the same server machine as Novell Vibe), you should strongly consider placing access 
controls on the remote application itself. For example, if the site administrator uses the access-control 
tools to place the remote application into the Participant role in the top Workspace, all workspaces 
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and folders that inherit access control automatically apply the same restrictions on the remote 
application. Then, if a site administrator views a page calling the remote application, the application 
is restricted to the rights granted to a Participant instead of those granted to a Site Administrator.


If you do not make any attempt to restrict the rights of a remote application, the remote application 
has the same rights as the user viewing the page that calls the application. For example, if a site 
administrator views the page, the remote application can use Site Administrator rights to do 
anything in Vibe using Web services calls.


To set access controls on a remote application:


1 Log in to the Vibe site as the Vibe administrator.


2 Click the Administration icon  in the upper-right corner of the page.


The Administration page is displayed.


3 Under System, click Access Control for Zone Administration Functions.


The Configure Access Control page is displayed.


4 In the provided table, click Add an Application.


5 In the Add an Application field, start typing the name of the remote application for which you 
want to set access controls. When the remote application appears in the drop-down list, select it.


6 Click the Add a role link at the top of the table.


7 From the drop-down list, select the role that you want to associate to the remote application.


Vibe adds a new column for the new role.


8 In the row of the remote application, select the check box that is located in the role column that 
you want to assign to the remote application.


9 Click Save Changes.


3.2.4 Reviewing Supporting Source Code


To learn more details about the interaction between Novell Vibe and a remote application, you can 
look at example source code. To download the Kablink Vibe code base, visit the Open Source 
Community page (http://www.kablink.org/).


After downloading the Kablink Vibe sources, review this code:


 SOAP wrappers for objects: These wrappers are located within the Kablink Vibe source code in 
/ssf/samples/wsclient/src/org/kablink/teaming/samples/wsclient/
TeamingServiceClientWithStub.java. 


For more information about Web services and SOAP wrappers, see Chapter 1, “Web Services 
Overview,” on page 11.


 Passed information: To see details about the information passed between Kablink Vibe and a 
remote application, see /ssf/main/src/org/kablink/teaming/remoteapplication/impl/
RemoteApplicationManagerImpl.java.
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3.3 Creating a Remote Application
This section demonstrates how to create a remote application using the hello-world application as an 
example.


The hello-world program is common code written by people just beginning to learn a programming 
language or paradigm. Usually, upon execution, a hello-world application writes a greeting to 
standard output. 


This section presents a hello-world application that ships in the Novell Vibe source code, which you 
can quickly deploy and implement in your Vibe installation. When it is executed as a remote 
application from a Vibe page, this application uses a Web services operation to greet the Vibe user by 
name.


To download the Vibe code base, visit the Open Source Community page (http://www.kablink.org/). 
After installing the code base, you can locate this example code here:


/ssf/samples/remoteapp


There are four important files in the /remoteapp hierarchy:


 The class file: This file contains the source code for the remote application.


/remoteapp/src/org/kablink/teaming/samples/remoteapp/web/
HelloWorldServlet.java


 The servlet-definition file: The servlet-definition file establishes the hello-world application as 
a Tomcat servlet.


/remoteapp/war/WEB-INF/web.xml


 The JSP file: The JSP file is the content of the response for the application.


/remoteapp/war/WEB-INF/jsp/hello_world/view.jsp


 The build file: The build file deploys the application in Tomcat, making it available for use as a 
remote application in Vibe.


/remoteapp/build.xml


The subsections that follow provide more detailed explanation about three of these files:


 Section 3.3.1, “Reviewing the Class File,” on page 37


 Section 3.3.2, “Reviewing the Servlet-Definition File,” on page 38


 Section 3.3.3, “Reviewing the JSP File,” on page 39


3.3.1 Reviewing the Class File


To review the Java source code used to implement this application, locate the following file:


/remoteapp/src/org/kablink/teaming/samples/remoteapp/web/HelloWorldServlet.java


Although this is not a complete description of all of the code contained in the example, the next few 
paragraphs explain some of the key parts of the HelloWorldServlet class defined in the 
HelloWorldServlet.java file.


The following line in the code creates the bean to contain the user’s first and last name 
(ss_userTitle), which is to be used by a JSP:
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private static final String PARAMETER_NAME_USER_TITLE = "ss_userTitle";


Toward the bottom of the file, the class defines the following method, which makes a Web services 
call, obtains the user object, and applies the getTitle method to the object, placing the user’s first 
and last name in a string: 


private String getUserTitle(TeamingServiceV1SoapBindingStub stub, String 
accessToken, Long userId) 
      throws ServiceException, DocumentException, RemoteException {
    User user = stub.profile_getUser(accessToken, userId, false);
    return user.getTitle();
}


The Web services call was set up in the doPost method, which then calls the getUserTitle method 
shown in the last code example. Consider this code from the doPost method:


  private static final String TEAMING_SERVICE_ADDRESS = "http://localhost:8080/ssr/
token/ws/TeamingServiceV1";
      .
      .
      .
// Get ready for web services calls to the Teaming.
TeamingServiceV1SoapServiceLocator locator = new 
TeamingServiceV1SoapServiceLocator();
      locator.setTeamingServiceV1EndpointAddress(TEAMING_SERVICE_ADDRESS);
TeamingServiceV1SoapBindingStub stub = (TeamingServiceV1SoapBindingStub) 
locator.getTeamingServiceV1();


// Get the title of the user by making a web services call.
String userTitle = getUserTitle(stub, accessToken, Long.valueOf(userId));


When using Web services in the context of a remote application, you must use the /ssr/token/ws/
TeamingServiceV1 endpoint. See Section 1.4, “Server Endpoints,” on page 15, for more information 
about specifying server endpoints for Web service calls.


Finally, the doPost code specifies the location of a JSP, which is used to generate the response:


String jsp = "/WEB-INF/jsp/hello_world/view.jsp";
RequestDispatcher rd = req.getRequestDispatcher(jsp); 


3.3.2 Reviewing the Servlet-Definition File


To review the XML used to define the hello-world servlet for Tomcat, locate this file:


/remoteapp/war/WEB-INF/web.xml


The XML file contains these lines:


  <servlet>
    <servlet-name>helloWorld</servlet-name>
    <servlet-class>org.kablink.teaming.samples.remoteapp.web.HelloWorldServlet</
servlet-class>
    <load-on-startup>1</load-on-startup>
  </servlet>
  
  <servlet-mapping>
    <servlet-name>helloWorld</servlet-name>
    <url-pattern>/helloWorld/*</url-pattern>
  </servlet-mapping>


The servlet tag defines the class code to be executed when someone specifies /helloWorld in the 
URL. The servlet-mapping tag establishes /helloWorld portion of the URL. (See Section 3.4.1, 
“Registering a Remote Application,” on page 39, for information about how this definition maps to 
the URL you specify when registering a remote application with Vibe.) 
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3.3.3 Reviewing the JSP File


To review the JSP file used to generate the output for the application, locate the following file:


/remoteapp/war/WEB-INF/jsp/hello_world/view.jsp


The file has the following content:


<%@ page isELIgnored="false" %>
<%@ taglib prefix="c" uri="http://java.sun.com/jsp/jstl/core" %>
<%@ taglib prefix="fmt" uri="http://java.sun.com/jsp/jstl/fmt" %>
<%@ taglib prefix="fn" uri="http://java.sun.com/jsp/jstl/functions" %>


<c:set var="title" value="${ss_userTitle}"/>
<c:if test="${empty title}"><c:set var="title" value="world"/></c:if>


<strong>Hello ${title}!</strong><br>


The JSP tests to see if the ss_userTitle bean is empty, and, if it is, substitutes the string Hello 
world! for Hello userTitle! 


Because the remote application is designed to provide a portion of an HTML page, the JSP file does 
not include HTML tags that structure the page, such as the html, title, head, and body tags. Vibe 
structures the page, and remote applications provide HTML for a segment within that page.


3.4 Related Sections
The following sections are for Novell Vibe administrators and advanced Vibe users:


 Section 3.4.1, “Registering a Remote Application,” on page 39


 Section 3.4.2, “Configuring an Accessory to Show a Remote Application,” on page 39


 Section 3.4.3, “Controlling the Access of Remote Applications,” on page 39


3.4.1 Registering a Remote Application


After you create a remote application, the system administrator needs to register the application with 
the Novell Vibe system before it can be applied to an accessory, a custom entry, a workflow state, or a 
tag.


For information on how to register a remote application, see “Using Remote Applications on Your 
Vibe Site” in the  Novell Vibe 3.2 Administration Guide.


3.4.2 Configuring an Accessory to Show a Remote Application


Novell Vibe enables you to view remote applications as accessories.


For information on how to create an accessory that displays a remote application, see “Setting Up a 
Remote Application as an Accessory” in the Novell Vibe 3.2 Advanced User Guide.


3.4.3 Controlling the Access of Remote Applications


Novell Vibe enables you to set access controls on your remote applications.


For information on why it is important to set access controls on remote applications, see Section 3.2.3, 
“Setting Access Control for Remote Applications,” on page 35.
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For information describing how users can set access controls on a remote application, see “Managing 
Access Controls for Remote Applications” in the Novell Vibe 3.2 Advanced User Guide.
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4 4Creating JavaServer Pages (JSPs)


Much of the information in this section references Teaming, which is the product name for the Vibe 
product for versions prior to Vibe 3. This information applies to Vibe 3 as well as earlier versions of 
the product.


 Section 4.1, “Overview of JSP Support,” on page 42


 Section 4.2, “Examples of Custom Entries,” on page 48


 Section 4.3, “Examples of Complex, HTML Data Types,” on page 67


JavaServer Pages (http://en.wikipedia.org/wiki/JavaServer_Pages)


JavaServer Pages technology (http://java.sun.com/products/jsp/)


NOTE: The method of specifying separate JSP files for the form, view, and mail was the primary 
method of applying JSP applications for versions of Novell Vibe prior to 2.0, and this method is still 
supported in Teaming 2.0 and later. However, Teaming 2.0 and later added support for specifying a 
single JSP file for the form and then inheriting the JSP in the view. Also, Teaming 2.0 and later 
supports replacing standard items (such as the title or description) with JSP files.


This topic describes the application of JavaServer Page (JSP) customizations in Novell Vibe.


Using form and view designers, you can add standard HTML or Vibe elements (for example, a text 
box or form elements to upload attachments) to standard entries. As another option, you can create 
new types of entries (for example, a paid-time-off-request entry, a resume-processing entry, a 
document-review entry, and so on). When you limit a folder to a custom task, then you created a 
dedicated application.


Using Vibe as an application-development platform is powerful. However, given the tools described 
in this guide so far, you may have noticed some limitations. For example, when you use the designers 
to create custom entries, you are allowed some control over the position of the custom elements on 
the page, but many formatting decisions are left to the Vibe software. If your application requires a 
level of formatting control that is difficult or impossible to achieve using the designers, you can use 
JSPs to enhance your customization.


This topic includes these sections:


 Section 4.1, “Overview of JSP Support,” on page 42


 Section 4.2, “Examples of Custom Entries,” on page 48


 Section 4.3, “Examples of Complex, HTML Data Types,” on page 67


NOTE: Although it includes examples of JSP tagging, it is beyond the scope of this topic to teach 
general tagging syntax and use cases for JavaServer Pages.
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4.1 Overview of JSP Support
This section explains the relationship between the Novell Vibe UI and the content of the JSP files, and 
provides other information to assist in your use of JSP customizations. If you prefer to learn by doing, 
you may want to skip this section and review the examples (see Section 4.2, “Examples of Custom 
Entries,” on page 48).


This section includes these subsections:


 Section 4.1.1, “Directory Structure,” on page 42


 Section 4.1.2, “Applicable Pages,” on page 43


 Section 4.1.3, “JSPs and the Vibe Designers,” on page 43


 Section 4.1.4, “Indexing Issues,” on page 46


 Section 4.1.5, “JSPs and Vibe Data Access,” on page 46


 Section 4.1.6, “Text Display in the HTML Editor,” on page 47


 Section 4.1.7, “Standard Styles,” on page 48


4.1.1 Directory Structure 


In the Novell Vibe implementation of JSP-based customizations, you specify the JSP files using the 
designers, which are located in the administration portlet. 


The designer interface expects to find the JSP files relative to this location within the server directory 
structure:


/WEB-INF/jsp/custom_jsps


Vibe ships sample JSP customizations in this directory:


/WEB-INF/jsp/custom_jsps/samples


By default, Vibe includes in this directory three files that you can use to practice applying a small JSP 
customization to a single element within a page:


custom_jsp.html
custom_jsp_form.html
custom_jsp_view.html
custom_jsp_mail.html


A section that follows describes how to apply this sample customization and what it looks like in the 
Vibe user interface (UI). For more information, see Section 4.2.1, “A JSP That Defines Only One Data 
Element,” on page 48.


Because the /custom_jsps directory contains JSP files for all customizations in the installation, 
Novell strongly recommends that you create subdirectories for each customization. For more 
information, see “Enabling Custom JSPs to Be Used on Your Vibe Site” in the  Novell Vibe 3.2 
Administration Guide.


For example, a section that follows shows sample JSPs that produce almost the entire bodies of the 
form and view pages for an entry, as it implements a W-4-form application. (A W-4 form is a 
government form in the U.S.A. that is used to withhold federal taxes from an employee’s paycheck.) 
For example, the sample W-4 application places its JSP files in this subdirectory:


.../custom_jsps/samples/w4
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See Section 4.2.2, “A JSP-Defined Entry (W-4 Form),” on page 52, for more information about the 
sample W-4 JSP customization.


4.1.2 Applicable Pages


You can apply JSP customizations to several types of Novell Vibe pages:


 Form: This is the page used to create a workspace, folder, entry, or comment.


 View:  This is the page that displays the content of the created workspace, folder, entry, or 
comment.


 Landing Page:  This is the page that displays the summarized content of the workspace or 
folder.


For information on how to reference a JSP file from a landing page, see “Adding a Custom JSP” 
in “Creating and Managing Landing Pages” in the Novell Vibe 3.2 Advanced User Guide.


 Mail:  This is the e-mail message that Vibe sends as a result of the Send mail footer toolbar 
function. 


For example, while viewing an entry, if you click Send mail, Vibe places this content into the body 
of the e-mail message to be sent.


4.1.3 JSPs and the Vibe Designers


Using the Vibe designers, you can remove or add elements of a binder (workspace or folder) or an 
entry. Using these tools, you can include one or more JSP files to customize content. 


For example, after accessing the form and view designers in the administration portlet, you can edit 
the definition for a discussion entry:


Figure 4-1   Using a Designer to Edit the Definition for a Discussion Entry


Expand the Entry form definition line so that you see the Form line:


Figure 4-2   Expand the Form Definition


After clicking Form, click Add in the tools box on the right side of the designer, and notice the Custom 
JSP link in the Layout options section:
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Figure 4-3   Locate the Link that Adds the Custom JSP File


Click Custom JSP, and, in the form, provide a caption (which is often used as the displayed title next 
to the page element), an internal-use name, and the JSP files that implement this customization. The 
following graphic shows the form used to specify JSP files, and provides the caption Highlighted text:


Figure 4-4   Completed Form for a JSP Customization


NOTE: Be sure to add the path to the filenames specified in the previous graphic. For example, the 
correct path for the form customization is samples/custom_jsp_form.jsp.


This example uses the sample JSP files provided in the /WEB-INF/jsp/custom_jsps directory. 


After submitting the form, the JSP customization appears in the definition for the discussion-entry 
form, which allows you to position it, remove standard elements, and so on. Notice the Custom JSP - 
Highlighted text JSP element positioned just below the standard Description element:
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Figure 4-5   The JSP Element Within the Definition


Because you provided the file specifications for the form, view, and mail when you added the JSP 
form element, Vibe remembers this new element and you can locate it within the designer tools using 
its caption. 


For example, after adding a custom form element, you usually want to add the corresponding 
custom view element. To do so, click the plus sign (+) next to the Entry view definition line to see the 
elements contained within the view page:


Figure 4-6   Expand the View Definition


Then, click the Entry view definition text to display tools, and then click Add in the tools box located on 
the right side of the designer. Because Vibe recorded the creation of the Highlighted text JSP 
customization, Highlighted text now appears in the Standard form elements section of the tools box. For 
example, notice the Highlighted text line toward the bottom of the list in this graphic:


Figure 4-7   The Custom Form Element is Available to the View Definition


To add the custom_jsp_view.html file to the view definition, click Highlighted text in the Standard 
form elements section of the tools box, and then click OK. Vibe adds the custom element to the view 
definition, and then you can reposition it within the definition as you desire. The following graphic 
shows the Entry data item - Highlighted text element just under the Description - Description element:
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Figure 4-8   Positioning the Custom Element


See Section 4.2.1, “A JSP That Defines Only One Data Element,” on page 48, for more information 
about how this customization appears in the UI.


4.1.4 Indexing Issues


When you use one JSP to define one page element, Vibe uses the internal-use data name that you 
assigned to the JSP in the designer to identify the data as well. In the example in the previous section 
(see Section 4.1.3, “JSPs and the Vibe Designers,” on page 43), the internal-use data name was 
highlightedText, and it applied to both the JSP file and the actual text collected by the custom text box.


When you use a JSP to define more than one page element, Vibe recognizes the JSPs to the extent that 
users can create and view a customized entry, but its tools do not recognize the multiple, distinct 
pieces of custom data within the JSP. As an additional step, you must use the designer to add form 
elements that match the unique elements found within the JSP file. After you complete this task, Vibe 
tools then recognize each distinct piece of custom data defined within the JSP. For example, users can 
now use the advanced search form to search based on exact values provided in those custom 
elements.


For more information about this additional task that must be performed when adding more than one 
custom element to the form using a JSP file, see “Identifying Multiple Data Items Defined in One JSP 
File” on page 63.


4.1.5 JSPs and Vibe Data Access


To enable all of the definition elements and building blocks for your custom JSP, include this line at 
the top of your JSP file:


<%@ include file="/WEB-INF/jsp/definition_elements/init.jsp" %>


Because JSP customizations within Novell Vibe are applied to a section of larger web pages, do not 
specify the html, head, or body HTML tags in your JSP file.


When using custom JSPs, you can customize binders and entries. Binders include all types of 
workspaces and include folders. Entries include entries as well as comments. Because customization 
of entries is most common, the rest of this section discusses data accessible when customizing an 
entry.


To access entry data, you access the properties of the ssDefinitionEntry object. For example, this 
tag from a Vibe JSP file tests for the existence of the entry title:


<c:if test="${empty ssDefinitionEntry.title}">


Here is a list of some of the object attributes that you can access from your custom JSPs:
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ssDefinitionEntry.title
ssDefinitionEntry.description
ssDefinitionEntry.fileAttachments
ssDefinitionEntry.creation.principal.title
ssDefinitionEntry.creation.date
ssDefinitionEntry.modification.principal.title
ssDefinitionEntry.modification.date


The identifier principal corresponds to the user who created or modified the entry.


Vibe provides Java beans that enable a JSP file to access the caption and the internal data name 
specified for the JSP file using designer tools:


property_name
property_caption


Use these beans when you are using one JSP file to add one custom element. In this scenario, the 
name and caption specifications for the JSP file are also applied to the custom data. (When using a 
JSP file to add more than one element, you specify the name and id HTML elements explicitly. For 
more information, see Section 4.2.2, “A JSP-Defined Entry (W-4 Form),” on page 52.)


When accessing the value of properties other than the name and caption, use the customAttributes 
method. For example, the following example shows a tag from a form JSP:


<input type="text" id="${property_name}" name="${property_name}" 
value="${ssDefinitionEntry.customAttributes[property_name].value}"/>


The tag both provides an HTML-tag identifier (id) and name (name) for the custom form element, 
and uses the customAttributes method to retrieve the value of the custom element (if it exists). 
Examples in a subsequent section demonstrate the use of beans and the customAttributes method, 
when customizing part of a standard entry form, view, or mail message (see Section 4.2.1, “A JSP That 
Defines Only One Data Element,” on page 48).


The description of properties, beans, and methods in this section is not exhaustive. To learn about 
other types of data available to you while using JSP files to create customizations, review the Vibe JSP 
files, which are found here:


/WEB-INF/jsp/definition_elements


For example, when searching this folder for occurrences of the ssDefinitionEntry object, you can 
locate this code, which is found in the popular_view.jsp file:


<c:if test="${!empty ssDefinitionEntry.totalReplyCount}">


The totalReplyCount property provides an integer that tells you the number of comments for the 
current entry.


4.1.6 Text Display in the HTML Editor


Unlike most property data, description data almost always requires additional processing within the 
JSP file. Remember that users create the description text using an HTML editor and that users can 
place coded items within the text (for example, inline graphics or the double-bracket notation 
([[text]]) often used in wiki entries to create a link to another entry).


Consider the following tagging from the /WEB-INF/jsp/definition_elements/
view_entry_data_description.jsp file:


<span><ssf:markup type="view" entity="${ssDefinitionEntry}"><c:out 
   value="${ssDefinitionEntry.description.text}" escapeXml="false"/></
ssf:markup></span>
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The ssf:markup tag takes raw text, but processes the information so that it includes properly coded 
HTML for inline graphics and links to other entries. The escapeXml element of the ssf:markup tag 
provides an escape for HTML tags. In other words, the false setting for escapeXml in the last 
example indicates that the system should escape the angle bracket characters (<tag-text>). In this 
way, HTML tags are included and properly processed by the browser.


4.1.7 Standard Styles


When creating JSP customizations, you are free to style your page elements as needed. However, if 
you would like to use the standard styles used by the Vibe product, you can find their definitions 
here:


/WEB-INF/jsp/common/ssf_css.jsp


As you explore the standard JSPs that ship with the product in the /WEB-INF/jsp/
definition_elements directory, note the name of the standard style, and view its CSS definition in 
the ssf_css.jsp file.


4.2 Examples of Custom Entries
This section provides examples of the two common approaches when using JSPs to customize an 
entry. Using the first approach, you use a JSP file to customize selected elements within the page 
segment; then, you can use the Novell Vibe designers to customize the remaining, non-JSP elements. 
Using the second approach, you use JSP files to define almost the entire page segment; you can use 
the designers to include desirable Vibe tools (such as the ability to subscribe to the entry, the send-
mail feature, workflow, attachments, and comments), if desired.


This section contains these subsections:


 Section 4.2.1, “A JSP That Defines Only One Data Element,” on page 48


 Section 4.2.2, “A JSP-Defined Entry (W-4 Form),” on page 52


4.2.1 A JSP That Defines Only One Data Element


Novell Vibe provides sample JSP files for you to apply as a way of learning about JSP customizations. 
These files create a custom text box on the form, and, after a user enters text and submits the form, 
these files display the text on the view page and in the mail message (sent using the Send mail tool in 
the footer tool bar).


This section contains these subsections:


 “Understanding the Form Customization” on page 48


 “Understanding the View Customization” on page 51


 “Understanding the Mail Customization” on page 51


Understanding the Form Customization


Let’s review the code in the /WEB-INF/jsp/custom_jsps/custom_jsp_form.jsp file. First, the file 
includes a tag that enables definition elements and building blocks for your JSP:


<%@ include file="/WEB-INF/jsp/definition_elements/init.jsp" %>
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Because it is defining a page segment within a larger web page, the JSP does not include html, 
head,or body HTML tags.


Next, the sample JSP file for the form includes bolded text that makes the new element very 
noticeable on the form:


<div style="padding:10px 0px 10px 0px;">
<span class="ss_bold">This is a custom jsp form element</span>
<br/>
<br/>


If the caption property is not empty, then the code uses its contents as a title for the custom element: 


<c:if test="${!empty property_caption}">
  <span class="ss_bold">${property_caption}</span>
  <br/>
</c:if>


Finally, the custom JSP file for the form displays the text box. It also displays the current value of the 
element (if it exists), which is applicable when a user modifies an existing entry. Consider the last 
portion of code in the custom JSP file for the form:


<input type="text" id="${property_name}" name="${property_name}" 
  value="${ssDefinitionEntry.customAttributes[property_name].value}"/>
</div>


When the system performs a get for the customAttribites method, it uses the value of the 
property_name bean as a parameter. This action results in the specification of the appropriate 
custom attribute. Then, this code obtains the value property for that custom attribute, displaying it 
within the text box, if it exists. If it does not exist, the text box is empty.


To use this custom JSP in an entry, you use the designers in the administrative portlet. This section 
describes how you can add the custom-text customization to a standard discussion entry. 


In the administration portlet, access the designer for entries, access the discussion entry, and click 
Form:


Figure 4-9   Accessing the Form for a Discussion Entry


To add the custom JSP to the form, click Add in the tools presented in the tools box on the right side of 
the page, and then click Custom JSP in the Layout options section:


Figure 4-10   Adding a Custom JSP to the Form


Complete the form located in the tools box:
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Figure 4-11   Complete the Form for the Custom JSP


NOTE: Be sure to add the path to the filenames specified in the previous graphic. For example, the 
correct path for the form customization is samples/custom_jsp_form.jsp.


In the previous graphic, the caption for the custom text box is Highlighted text. The form in the 
previous graphic also specifies all three custom JSP files: three separate file specifications for the 
form, the view, and the mail message.


After you submit the form, position the custom element within the entry definition. The rest of this 
section assumes a position just below the description. 


When a user adds a new entry for a discussion folder, the person sees this custom portion of the form:


Figure 4-12   The Custom Element on the Form


Assuming that the user entered Here is some text in the Highlighted text box, then submitting the form 
results in the user seeing this in the completed entry:
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Figure 4-13   The Custom Element in the View


The next section shows the JSP tagging that displays the custom element shown in the previous 
graphic.


Understanding the View Customization


First, the view JSP includes a tag that enables definition elements and building blocks for your JSP:


<%@ include file="/WEB-INF/jsp/definition_elements/init.jsp" %>


Then, the view JSP file uses the same code that the form JSP used to display the caption for the 
custom element, if it exists:


<div style="padding:10px 0px 10px 0px;">
<c:if test="${!empty property_caption}">
  <span class="ss_bold">${property_caption}</span>
  <br/>
</c:if>


Finally, the view JSP uses this code to provide a cyan background color and to display the custom 
data, if it exists:


<div style="background-
color:cyan;">${ssDefinitionEntry.customAttributes[property_name].value}</div>
</div>


Understanding the Mail Customization


The mail JSP contains the same code as the view JSP:


<%@ include file="/WEB-INF/jsp/definition_elements/init.jsp" %>


<div style="padding:10px 0px 10px 0px;">
<c:if test="${!empty property_caption}">
  <span class="ss_bold">${property_caption}</span>
  <br/>
</c:if>


<div style="background-
color:cyan;">${ssDefinitionEntry.customAttributes[property_name].value}</div>
</div>
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Because of space limitations or the desire to summarize entry data in mail messages, you can include 
or exclude data from the mail JSP, or you can format it differently.


After viewing the entry with the custom element, click Send mail in the footer tool bar. The custom 
element appears on the Send email form as follows:


Figure 4-14   The Custom Element on the Send-Email Form


The person receiving the e-mail sees this message (different e-mail clients might display the message 
with slightly different formatting):


Figure 4-15   The Custom Element in the Received E-mail Message


4.2.2 A JSP-Defined Entry (W-4 Form)


Some custom entries require formatting that is either difficult or impossible to achieve using a 
separate JSP file for every custom element. For example, there may be an HTML form that you are 
already using in your organization, and you want to use a nearly identical form within Novell Vibe.


This section describes custom JSPs that implement a W-4-form application. (A W-4 form is a 
government form in the U.S.A. that is used to withhold federal taxes from an employee’s pay.) This 
application requires that the entry resemble the paper form, but it allows for the use of standard tools 
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within Vibe. For example, this application allows users to add comments to the W-4 entry, to 
subscribe to the entry, to send e-mail upon creation of the entry, and to apply a workflow process to 
the entry. Finally, the application changes the styles of the buttons used to cancel or submit the form.


NOTE: It is possible to replace the entire, standard Novell Vibe form and to replicate coding for the 
Vibe tools (attachments, subscribing to the entry, and sending mail upon entry creation) using code in 
your JSP. However, doing so is significantly more difficult to code. The example in this section 
documents the best practice of using JSPs to generate most of the form while still enabling the Vibe 
tools for standard entries.


The graphic that follows shows the top portion of the W-4 form as it appears in a window sized to be 
narrow (note the lack of a “title” text box):


Figure 4-16   The Top Portion of the W-4 Form


Here is the bottom portion of the W-4 form, which includes standard Vibe tools in between the W-4 
content and the buttons:
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Figure 4-17   The Bottom Portion of the W-4 Form


When a user creates an entry of this type, it appears as follows (note the title of the entry, comprised 
of two elements found on the form):
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Figure 4-18   Example of a Created Entry for the W-4 Customization


This section contains these subsections:


 “Creating the Source Files” on page 55


 “Defining Custom Entries” on page 56


 “Coding the Form Files” on page 61


 “Coding the View File” on page 63


 “Identifying Multiple Data Items Defined in One JSP File” on page 63


 “Coding the Mail File” on page 65


Creating the Source Files


Because all JSP customizations are located in the /custom_jsps folders, it is recommended that you 
place application files in separate sub-folders. So, the W-4 application places source files here:


/WEB-INF/jsp/custom_jsps/samples/w4


These are the files required for the application:


w4_form_buttons.jsp
w4_form.jsp
w4_mail.jsp
w4_view.jsp
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NOTE: When developing the W-4 example, it was helpful to begin with the form and view files 
containing only standard HTML tagging. For example, to begin, the w4_form.jsp file only contained 
the JSP tag that set definitions, and a standard HTML table containing input HTML tags. As the next 
step, use the instructions in the sections that follow to add one element at a time to both the form and 
view. In the UI, create or modify an entry of this custom type, provide a value for the custom element, 
submit the form, and check the view to be sure that Novell Vibe properly captured the data for the 
custom element. Proceed with your customization one element at a time, until learning this 
customization process and debugging are no longer issues.


Defining Custom Entries


Although it is possible to use a JSP file to add a single element to a standard entry, the more likely 
application is the creation of a new definition for a custom entry. When creating a custom entry, it is 
common for an application to require that a JSP contain more than one custom element. 


To create a new entry definition, access the entry designer in the form and view designers, which are 
all located in the administrative portlet. Then, click Entry definitions:


Figure 4-19   Invoking Tools for Entry Definitions


In the tools box on the right side of the designer, click Add a new entry definition:


Figure 4-20   Add a New Entry Definition


When providing a caption for your custom entry, remember that this text appears when the user 
clicks the New drop-down menu:


Figure 4-21   The New Drop-Down Menu


In the entry designer, complete the information for the custom-entry definition and click OK at the 
bottom of the form:
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Figure 4-22   Complete the Form for the Custom-Entry Definition


Next, you must provide the JSP file specifications for the form page, view page, and mail message. In 
the hierarchy to the left of the entry designer, click the plus sign (+) next to Entry form definition to 
expand it:


Figure 4-23   Access the Form Definition


Click Form:


Figure 4-24   Access Tools for the Form Definition


In the tools box on the right side of the designer, click Add:
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Figure 4-25   Add an Element to the Form


In the Layout options section of the tools box, click Custom JSP:


Figure 4-26   Add the Custom JSP to the Form


Complete the form, providing the file specifications for the custom JSPs:


Figure 4-27   Providing File Specifications for the JSP Files


NOTE: Be sure to add the path to the filenames specified in the previous graphic. For example, the 
correct path for the form customization is samples/w4/w4_form.jsp.


Because Vibe assumes that directories are relative to the /WEB-INF/jsp/custom_jsps directory, the 
file specifications in the previous graphic begin with the   samples/w4/ string, indicating that the 
files are located in the /custom_jsps/samples/w4 directory.


Click OK to submit the form shown in the previous graphic.
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Because the W-4 application customizes the buttons for this form, and because standard tools appear 
in between the custom form and the buttons (for example, these tools include the form elements that 
upload and manage attachments), you need to specify the JSP file for the buttons as a separate step in 
the process.


Click Entry form definition again, click Add in the tools box, and, in the Layout options section, click 
Custom JSP. Fill out the form:


Figure 4-28   Complete the Form for the Buttons JSP


NOTE: Be sure to add the path to the filenames specified in the previous graphic. For example, the 
correct path for the buttons file is samples/w4/w4_form_buttons.jsp.


For the W-4 application, the standard title and buttons are not needed (the custom JSPs provide these 
elements). So, use the entry designer to delete the Title - Title and Form buttons elements from the form 
definition. Next, add the Subscribe to this entry and Send mail when entry is submitted elements. This is 
the appearance of the form definition when you are finished:


Figure 4-29   Customized Form Including Both JSP Files
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NOTE: After you learn JSP tagging and debugging, you can continue using the form designer at this 
stage of the process to enable Novell Vibe tools, such as indexing custom data and making custom 
elements available on the advanced search form (see “Identifying Multiple Data Items Defined in 
One JSP File” on page 63). However, when you are first learning to do these types of customizations, 
it is recommended that you code and debug each custom element one at a time, ensuring that users 
can successfully specify data for the custom elements before working further within the designer for 
the form definition.


To begin the work needed to define the view definition, click Entry view definition:


Figure 4-30   Access the View Definition


In the tools box on the right side of the designer, click Add. Vibe displays a list of elements that you 
can add to the view:


Figure 4-31   View Elements


Deeper in the list, locate and click the caption you provided for the form definition (in this example, 
W4 Federal Form):


Figure 4-32   Clicking the Caption for the Custom JSP


Use the designer tools to reposition the JSP within the view as desired. Here is one order that you can 
specify for your view (note the Entry data item - W4 Federal Form line):


Figure 4-33   Repositioning View Elements
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At this point in the process, you have a formatted and minimally functioning custom entry; a user 
can create an entry, and Vibe can display it. However, users cannot supply values for custom 
elements until you edit and debug the JSP files for the form and view so that they store and display 
custom data properly. 


Use the information in the next section (see “Coding the Form Files” on page 61) to guide the coding 
of your JSP files, activating custom elements in your form and view one element at a time. Continue 
until a user can create a complete entry, providing values for all custom elements on the form and 
ensuring that the view page displays values for all of the custom elements.


When you are finished debugging, you must go back into the form designer to further identify all 
custom elements in the form so standard tools in Vibe can access them (see “Identifying Multiple 
Data Items Defined in One JSP File” on page 63).


Coding the Form Files


Generally, when you are first learning to implement JSP customizations with Novell Vibe, you add 
one element, test it by creating an entry and reviewing the view, and then debug. For this reason, it 
can be helpful to have two windows open displaying Vibe pages: one in which to work within the 
designer and one in which to check a modified entry to see if the changes in the designer are taking 
effect.


Also, generally, many entries contain a title element. Vibe automatically uses the value of this element 
as the title for a created entry. For example, if you specify Let’s talk about the project plan in the title 
element of a form for a new discussion topic, then Let’s talk about the project plan appears as the title of 
the new entry. 


However, the W-4 application does not include a title element on the form. It uses JavaScript and 
DOM coding to construct a title for the entry. For example, if the person filling out a W-4 form 
specified Juanita as a first name and Suarez as a last name, then the created entry combines the values 
of two form elements and uses Juanita Suarez as the entry title. This customization was included to 
illustrate possibilities for your JSP customizations.


So, in the W-4 customization, the first-name and last-name elements need to be added to the form 
before the view can properly display its entry title. 


As mentioned, you include the JSP tag that establishes supporting definitions for Vibe 
customizations. Then, you specify HTML code needed for your specific customization. For the W-4 
application, the form and view use a standard HTML table. Here are the first few lines of the W-4 
form:


<%@ include file="/WEB-INF/jsp/definition_elements/init.jsp" %>


<table width="100%" cellpadding="6" cellspacing="0" summary="W4 form">
<tr>
<td><font size="-2">Form</font>
<b><font size="+2">W-4</font></b></td>
<td colspan="5"><font 
size="+1">Employee's Withholding
Allowance Certificate</font></td>
<td><font size="-2">OMB No. 1545-0010</font></td>
</tr>


Because the JSP customization defines a page segment within a larger web page, it does not specify 
html, head, or body HTML tags.
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The code that implements the first name and last name is the same syntactically as the code that 
implements single-element JSP files (see Section 4.2.1, “A JSP That Defines Only One Data Element,” 
on page 48). You provide identifiers for the custom elements, and you use the ssDefinitionEntry 
object, its attributes, and their values, to place existing data into the form element (if it exists). This is 
the code for the firstName and lastName attributes:


<tr>
<td colspan="2"><input type="text" name="firstName" id="firstName" 
size="25" value="${ssDefinitionEntry.customAttributes['firstName'].value}" /></td>
<td colspan="3"><input type="text" name="lastName" id="lastName"  
size="25" value="${ssDefinitionEntry.customAttributes['lastName'].value}" /></td>


Generally, the process of coding all other form elements is the same. However, coding radio buttons, 
check boxes, and select boxes (there are no select boxes in the W-4 example) require the knowledge of 
some additional details (see Section 4.3, “Examples of Complex, HTML Data Types,” on page 67).


The initial part of the JSP file for the buttons contains style information to be applied to the OK and 
Cancel buttons:


<style>
input.custom_submit {
  background-color: #009999;
  border: 1px solid #006666;
  color: #ffffff;
  font-size: 12px;
  padding: 0px 6px 0px 6px;
  cursor: pointer;
  white-space: nowrap;
}
</style>


The next section of code in the JSP file for the buttons contains the JavaScript that concatenates the 
first and last names, and assigns that string to the title form element:


<script language="JavaScript" type="text/javascript">
function mySubmit() {
    self.document.form1.title.value = self.document.form1.firstName.value + " " + 
self.document.form1.lastName.value;
}
</script>


When Vibe generates a form that creates an entry, the standard identifier for the form is form1.


Because this application required the removal of the title element of the form using the designers, the 
internal mechanism for recognizing and storing the data for a title has been removed. The next line in 
the JSP file for the buttons uses a “hidden” tag to replace the mechanisms removed by the deletions 
in the designer:


<input type="hidden" name="title" value="" />


Execution of the JavaScript routine mySubmit provides a value for the title element.


The final segment of code in the JSP file for the buttons contains HTML for the OK and Cancel 
buttons:


<input type="submit" class="custom_submit" name="okBtn" value="OK" 
onClick="ss_buttonSelect('okBtn');mySubmit();"/> 
<input type="submit" class="custom_submit" name="cancelBtn" value="Cancel" 
onClick="ss_buttonSelect('cancelBtn'); " />


The HTML for the OK button includes an onClick specification that executes the mySubmit 
JavaScript routine, creating the value of the entry title.
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Coding the View File


For the W-4 application, the JSP file for the view is a table identical to the one included in the form, 
except that it only displays values for each of the custom elements (if they exist). 


First, include the tag that establishes the JSP definitions:


<%@ include file="/WEB-INF/jsp/definition_elements/init.jsp" %>


Here is a sample of the code from the view file that displays the first name, last name, and social 
security number:


<tr>
<td colspan="2">${ssDefinitionEntry.customAttributes['firstName'].value}</td>
<td colspan="3">${ssDefinitionEntry.customAttributes['lastName'].value}</td>
<td colspan="2">${ssDefinitionEntry.customAttributes['ssn'].value}</td>
</tr>


The identifiers firstName, lastName, and ssn map to the name and id elements for the HTML input 
tags in the JSP for the form.


Complete the table so that it displays all of the custom elements.


Coding for most of the elements is virtually identical to the code displayed in the last example. 
However, displaying data from radio buttons, check boxes, and select boxes (there are no select boxes 
in the W-4 example) require the knowledge of some additional details (see Section 4.3, “Examples of 
Complex, HTML Data Types,” on page 67).


Identifying Multiple Data Items Defined in One JSP File


After adding and testing all custom elements, the custom entry for the W-4 application is complete, 
which means that someone can create and view an entry containing values for all custom elements. 
However, one of the desirable features ofNovell Vibe is the integration between features and tools. To 
enable this integration, you need to use the designers to report to the system that this entry includes 
custom data elements. As one example, after you report the existence of these elements, Vibe is able 
to index the custom data, which, in turn, allows users to perform advanced searches based on this 
custom data.


In summary, to report the custom elements to the system, use the form designer for the entry to add 
elements that use the same name and HTML data type (text box, radio button, and so on) as the 
element in the JSP files. 


To report custom elements, access the definition of the custom entry (W4: Employee Withholding (w4)), 
and open the form definition by clicking the plus sign (+) next to both Entry form definition and Form. 
Then, click Custom JSP - W4 Federal Form. Finally, add elements as children to Custom JSP - W4 Federal 
Form.


The instructions that follow show you how to add the first-name element.


As a reminder, here is the HTML from the JSP for the form that establishes the first-name element, 
whose form element is a text box:


<input type="text" name="firstName" id="firstName" 
size="25" value="${ssDefinitionEntry.customAttributes['firstName'].value}" />


In the tools box on the right side of the designer, click Text:
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Figure 4-34   Adding a Text Element for Indexing Purposes


In the form, specify the same data name (firstName) as the name and id elements used in the HTML 
input tag found in the JSP file, and provide the same caption:


Figure 4-35   Match the Name with the One Found in the JSP File


None of the other form values have an effect. Click the OK button to submit the form.


Repeat this action for all elements defined in the JSP file, including the hidden title element. The 
order of the elements does not have to match the order of the elements in the JSP file. When you are 
finished, the definition includes all of the elements shown in this graphic:
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Figure 4-36   All Elements Specified for Indexing Purposes


Notice that the elements appear as children to the custom JSP within the hierarchy (as opposed to 
peers).


Coding the Mail File


The W-4 application is a good example of a custom entry for which you might want to provide only a 
summary of the information in an e-mail message. For example, this is all of the code in the JSP for 
mail:


<%@ include file="/WEB-INF/jsp/definition_elements/init.jsp" %>


<table width="100%" class="border" cellpadding="6" 
summary="W4 Information">
<tr>
<td><font size="-2">Form</font> <b><font size="+2">W-4</font></b></td>
<td colspan="5"><font size="+1">Employee's Withholding
Allowance Certificate</font></td>
<td><font size="-2">OMB No. 1545-0010</font></td>
</tr>
<tr>
<td><font size="-3">Department of the Treasury<br />Internal
Revenue Service</font></td>
<td colspan="5">For Privacy Act and Paperwork Reduction Act Notice, see
elsewhere</td>
<td><font size="+2">2008</font></td>
</tr>
<tr><td colspan="7"><hr size="1" noshade="noshade" /></td></tr>
<tr>
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<td colspan="2"><font size="-1"><b>1</b> First name and
middle initial</font></td>
<td colspan="3"><font size="-1">Last name</font></td>
<td colspan="2"><font size="-1"><b>2</b> Your social security
number</font></td>
</tr>
<tr>
<td colspan="2">${ssDefinitionEntry.customAttributes['firstName'].value}</td>
<td colspan="3">${ssDefinitionEntry.customAttributes['lastName'].value}</td>
<td colspan="2">${ssDefinitionEntry.customAttributes['ssn'].value}</td>
</tr>
<tr><td colspan="7"><hr size="1" noshade="noshade" /></td></tr>


</table>


When a user views an entry of this type and clicks Send mail, that person sees:


Figure 4-37   Showing Partial Information in Mail
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4.3 Examples of Complex, HTML Data Types
This section provides examples of capturing and displaying custom data for radio buttons, check 
boxes, and select boxes. This section contains these sections:


 Section 4.3.1, “Radio Buttons,” on page 67


 Section 4.3.2, “Check Boxes,” on page 68


 Section 4.3.3, “Select Boxes,” on page 68


4.3.1 Radio Buttons


This section describes the radio buttons used in the W-4 application described in a previous section 
(see Section 4.2.2, “A JSP-Defined Entry (W-4 Form),” on page 52). This is the code from the JSP for 
the W-4 form that implements the Single, Married, and “Married but...” radio buttons:


<td colspan="4">
<font size="-1"><b>3</b>&nbsp;<input type="radio"  name="status" value="Single" 


<c:if test="${ssDefinitionEntry.customAttributes['status'].value == 'Single' || 
ssDefinitionEntry.customAttributes['status'].value != 'Married' && 
ssDefinitionEntry.customAttributes['status'].value != 
'MarriedBut'}">checked="checked"</c:if> />Single


<input type="radio"  name="status" value="Married" <c:if 
test="${ssDefinitionEntry.customAttributes['status'].value == 
'Married'}">checked="checked"</c:if> />Married


<input type="radio"  name="status" value="MarriedBut" <c:if 
test="${ssDefinitionEntry.customAttributes['status'].value == 
'MarriedBut'}">checked="checked"</c:if> />Married, but withhold at higher
Single rate.
</font></td>


The JSP tagging code selects the Single radio button by default.


This is the code from the JSP for the view that displays all radio buttons, including the selected 
button, but displays them as being disabled (so users do not attempt to change the value of the 
element on the view):


<td colspan="4">3 <input type="radio"  name="status" value="Single" 


<c:if test="${ssDefinitionEntry.customAttributes['status'].value == 'Single' || 
ssDefinitionEntry.customAttributes['status'].value != 'Married' && 
ssDefinitionEntry.customAttributes['status'].value != 
'MarriedBut'}">checked="checked"</c:if> DISABLED />Single


<input type="radio" name="status" value="Married" <c:if 
test="${ssDefinitionEntry.customAttributes['status'].value == 
'Married'}">checked="checked"</c:if> DISABLED />Married


<input type="radio" name="status" value="MarriedBut" <c:if 
test="${ssDefinitionEntry.customAttributes['status'].value == 
'MarriedBut'}">checked="checked"</c:if> DISABLED />Married, but withhold at higher
Single rate.
</td>
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4.3.2 Check Boxes


This section describes the check boxes used in the W-4 application described in a previous section 
(see Section 4.2.2, “A JSP-Defined Entry (W-4 Form),” on page 52). This is the code from the JSP for 
the W-4 form that implements the differing-names check box:


<td colspan="4">
<font size="-1"><b>&nbsp;&nbsp;check
here. You must call 1-800-772-1213 for a new card&nbsp;</b>
</font>


<input type="checkbox" name="boxFour" 
<c:if test="${ssDefinitionEntry.customAttributes['boxFour'].value == 
'true'}">checked="checked"</c:if>/>
</td>


Here is the code in the JSP for the view that displays the disabled check box (so users do not attempt 
to change the value of the element on the view):


<td colspan="4">
<font size="-1"><b>&nbsp;&nbsp;check here. You must call
1-800-772-1213 for a new card&nbsp;</b></font>


<input type="checkbox" name="boxFour" 
<c:if test="${ssDefinitionEntry.customAttributes['boxFour'].value == 
'true'}">checked="checked"</c:if> DISABLED />
</td>


4.3.3 Select Boxes


All other data types involve the storage of a single value. For both single-value and multiple-value 
select boxes,Novell Vibe stores the selected value or values in a value set. You can access the 
attribute’s value set using this notation:


ssDefinitionEntry.customAttributes[attributeName].valueSet


You can use the foreach tag to loop through the value set, using that information to present either 
form or view elements.


The W-4 application did not include an example of a select box, so this section presents code that 
implements a multiple-value select box that allows user to choose between the written numbers one 
through four:


Figure 4-38   Example of a Select Box on a Form


The previous graphic shows how the list looks by default, with no selections. Your code also needs to 
display currently selected items upon entry modification. 


This code labels the form element and initializes flag variables:
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<b>Test select box:</b><br/>


<c:set var="matchOne" value="0"/>
<c:set var="matchTwo" value="0"/>
<c:set var="matchThree" value="0"/>
<c:set var="matchFour" value="0"/>


Next, loop through the value set, and increment the flag that corresponds to a selected item:


<c:forEach var="selection" 
items="${ssDefinitionEntry.customAttributes['testSelection'].valueSet}" >
<c:if test="${selection == 'one'}"><c:set var="matchOne" value="1"/></c:if>
<c:if test="${selection == 'two'}"><c:set var="matchTwo" value="1"/></c:if>
<c:if test="${selection == 'three'}"><c:set var="matchThree" value="1"/></c:if>
<c:if test="${selection == 'four'}"><c:set var="matchFour" value="1"/></c:if>
</c:forEach>


Then, in the option HTML tags for the select list, use an if JSP tag to indicate that an option is 
selected:


<select name="testSelection" id="testSelection" multiple="multiple">
<option value="one" name="one" id="one" 
<c:if test="${matchOne == 1}">selected="selected" </c:if>>One</option>
<option value="two" name="two" id="two" 
<c:if test="${matchTwo == 1}">selected="selected" </c:if>>Two</option>
<option value="three" name="three" id="three" 
<c:if test="${matchThree == 1}">selected="selected" </c:if>>Three</option>
<option value="four" name="four" id="four" 
<c:if test="${matchFour == 1}">selected="selected" </c:if>>Four</option>
</select>          


In the view, you can display the selections in many ways. Here is one example:


Figure 4-39   Example of Displaying Selections on the View Page


This code displays the bolded header, and loops through the value set, counting the selections:


<b>Test selection:</b>


<c:set var="numSelections" value="0"/>
<c:forEach var="selection" 
items="${ssDefinitionEntry.customAttributes['testSelection'].valueSet}" >
<c:set var="numSelections" value="${numSelections + 1}"/>
</c:forEach>


Then, this code displays the written words that match the selections, separating them with commas, 
and does not display a comma after the last selection.


<c:set var="count" value="0"/>
<c:forEach var="selection" 
items="${ssDefinitionEntry.customAttributes['testSelection'].valueSet}" >
<c:set var="count" value="${count + 1}"/>
<c:if test="${selection == 'one'}">One</c:if>
<c:if test="${selection == 'two'}">Two</c:if>
<c:if test="${selection == 'three'}">Three</c:if>
<c:if test="${selection == 'four'}">Four</c:if>
<c:if test="${count != numSelections}">, </c:if>
</c:forEach>
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A AWeb Services Operations


Much of the information in this section references Teaming, which is the product name for the Vibe 
product for versions prior to Vibe 3. This information applies to Vibe 3 as well as earlier versions of 
the product.


This section provides alphabetized reference pages for the Web services operations of Novell 
Teaming 2.0 and later. 


NOTE: All examples in this reference section use the Novell Vibe client library. See Section 1.6, 
“Client Stubs,” on page 16, for more information about the client library and other ways to call Vibe 
Web services operations.


 “admin_destroyApplicationScopedToken” on page 75


 “admin_getApplicationScopedToken” on page 76


 “binder_addBinder” on page 77


 “binder_copyBinder” on page 78


 “binder_deleteBinder” on page 79


 “binder_deleteTag” on page 80


 “binder_getBinder” on page 81


 “binder_getBinderByPathName” on page 82


 “binder_getFileVersions” on page 83


 “binder_getFolders” on page 84


 “binder_getSubscription” on page 85


 “binder_getTags” on page 86


 “binder_getTeamMembers” on page 87


 “binder_getTrashEntries” on page 88


 “binder_indexBinder” on page 89


 “binder_indexTree” on page 90


 “binder_modifyBinder” on page 91


 “binder_moveBinder” on page 92


 “binder_preDeleteBinder” on page 93


 “binder_removeFile” on page 94


 “binder_restoreBinder” on page 95


 “binder_setDefinitions” on page 96


 “binder_setFunctionMembership” on page 97


 “binder_setFunctionMembershipInherited” on page 98
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 “binder_setOwner” on page 99


 “binder_setSubscription” on page 100


 “binder_setTag” on page 101


 “binder_setTeamMembers” on page 102


 “binder_testAccess” on page 103


 “binder_uploadFile” on page 104


 “definition_getDefinitionAsXML” on page 105


 “definition_getDefinitionByName” on page 106


 “definition_getDefinitions” on page 107


 “definition_getLocalDefinitionByName” on page 108


 “definition_getLocalDefinitions” on page 109


 “folder_addEntry” on page 110


 “folder_addEntryWorkflow” on page 111


 “folder_addMicroBlog” on page 112


 “folder_addReply” on page 113


 “folder_copyEntry” on page 114


 “folder_deleteEntry” on page 115


 “folder_deleteEntryTag” on page 116


 “folder_deleteEntryWorkflow” on page 117


 “folder_getEntries” on page 118


 “folder_getEntry” on page 119


 “folder_getEntryByFileName” on page 120


 “folder_getEntryTags” on page 121


 “folder_getFileVersions” on page 122


 “folder_getSubscription” on page 123


 “folder_modifyEntry” on page 124


 “folder_modifyWorkflowState” on page 125


 “folder_moveEntry” on page 126


 “folder_preDeleteEntry” on page 127


 “folder_removeFile” on page 128


 “folder_reserveEntry” on page 129


 “folder_restoreEntry” on page 130


 “folder_setEntryTag” on page 131


 “folder_setRating” on page 132


 “folder_setSubscription” on page 133


 “folder_setWorkflowResponse” on page 134


 “folder_synchronizeMirroredFolder” on page 135


 “folder_unreserveEntry” on page 136


 “folder_uploadFile” on page 137
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 “folder_uploadFileStaged” on page 138


 “ical_uploadCalendarEntriesWithXML” on page 140


 “ldap_synchAll” on page 141


 “ldap_synchUser” on page 142


 “license_getExternalUsers” on page 143


 “license_getRegisteredUsers” on page 144


 “license_updateLicense” on page 145


 “migration_addBinder” on page 146


 “migration_addBinderWithXML” on page 147


 “migration_addEntryWorkflow” on page 149


 “migration_addFolderEntry” on page 150


 “migration_addFolderEntryWithXML” on page 151


 “migration_addReply” on page 153


 “migration_addReplyWithXML” on page 154


 “migration_uploadFolderFile” on page 156


 “migration_uploadFolderFileStaged” on page 158


 “profile_addGroup” on page 160


 “profile_addGroupMember” on page 161


 “profile_addUser” on page 162


 “profile_addUserWorkspace” on page 163


 “profile_deletePrincipal” on page 164


 “profile_getFileVersions” on page 165


 “profile_getGroup” on page 166


 “profile_getGroupByName” on page 167


 “profile_getGroupMembers” on page 168


 “profile_getPrincipals” on page 169


 “profile_getUser” on page 170


 “profile_getUserByName” on page 171


 “profile_getUsers” on page 172


 “profile_getUserTeams” on page 173


 “profile_modifyGroup” on page 174


 “profile_modifyUser” on page 175


 “profile_removeFile” on page 176


 “profile_removeGroupMember” on page 177


 “profile_uploadFile” on page 178


 “search_getFolderEntries” on page 179


 “search_getTeams” on page 180


 “search_getWorkspaceTreeAsXML” on page 181


 “search_search” on page 182
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 “template_addBinder” on page 184


 “template_getTemplates” on page 185


 “zone_addZone” on page 186


 “zone_deleteZone” on page 187


 “zone_modifyZone” on page 188
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admin_destroyApplicationScopedToken


Destroys an application-scoped token.


Syntax


public void admin_destroyApplicationScopedToken( String accessToken, String token );


Description


The admin_destroyApplicationScopedToken operation destroys a previously acquired application 
scoped token. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


token 


The string representation of the previously acquired application-scoped token that you want to 
destroy.


return_value 


None.
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admin_getApplicationScopedToken


Requests an application-scoped token on behalf of the user.


Syntax


public String admin_getApplicationScopedToken( String accessToken, long applicationId,  long userId );


Description


The admin_getApplicationScopedToken operation requests the system to create and return an 
application-scoped token on behalf of the user.The token is subsequently utilized by the application. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


applicationId 


The identifier of the application set up with the Vibe system.


userId 


The identifier of the user on whose behalf you want the token to be created.


return_value 


A string representation of the requested token.
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binder_addBinder 


Adds an unconfigured binder to the workspace tree hierarchy. 


Syntax


public long binder_addBinder( String accessToken, Binder binder );


Description


The binder_addBinder operation adds either a workspace or folder to the hierarchy. 


To add a fully configured binder, use the template_addBinder operation instead. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part implementing a remote 
application, or the null value.


binder 


Data and methods for the Java Binder object, defined in the Vibe source code.


return_value 


The identifier of the new binder.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)


 template_addBinder (page 184)
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binder_copyBinder 


Creates a new binder identical to an existing one. 


Syntax


public long binder_copyBinder( String accessToken, long sourceId, long destinationId,            boolean 
cascade);


Description


The binder_copyBinder operation copies an existing workspace or folder, and creates a new one. 


Vibe automatically copies all non-binder content (entries and comments). As an option, you can 
replicate the source binder’s sub-binders (sub-workspaces or sub-folders).


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


sourceId 


The identifier of the binder you want to copy.


destinationId 


The binder identifier of the parent for the new workspace or folder.


cascade 


A Boolean value indicating whether you want to copy the source binder’s sub-binders (sub-
workspaces and sub-folders).


return_value 


The identifier of the new binder.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)

78 Novell Vibe 3.2 Developer Guide







binder_deleteBinder 


Deletes a binder. 


Syntax


public void binder_deleteBinder( String accessToken, long binderId, boolean deleteMirroredSource );


Description


The binder_deleteBinder operation deletes a workspace or folder. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binderId 


The binder identifier of the workspace or folder you want to delete.


deleteMirroredSource 


Deletes the source directory, if the folder being deleted is a mirrored folder.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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binder_deleteTag 


Removes a tag from a binder. 


Syntax


public void binder_deleteTag( String accessToken, long binderId, String tagId );


Description


The binder_deleteTag operation removes a tag from a workspace or folder. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binderId 


The identifier of the binder that applies the tag you want to remove.


tagId 


The tag you want to remove.


return_value 


None.


Example


  public static  void checkTags(long binderId) throws Exception {  ...                                                                   
Tag[] tags = setupTags(binderId);                                                                                                                     
for (int i=0; i<tags.length; ++i) {stub.binder_setTag(null, tags[i]);  }                                                            
tags = stub.binder_getTags(null, binderId);                                                                      
validateTags(tags);                                                                                                     
stub.binder_deleteTag(null, binderId, tags[0].getId());     


This code is taken from the source code for the teamingservice-client-with-stub.bat file.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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binder_getBinder 


Accepts a binder identifier to get information about a binder. 


Syntax


public Binder binder_getBinder( String accessToken, long binderId, boolean includeAttachments );


Description


The binder_getBinder operation gets information about a workspace or folder. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binderId 


The binder identifier for the workspace or folder for which you want information.


includeAttachments 


A Boolean value that indicates whether you want Vibe to return attached files.


By default, workspaces do not include attached files. However, users can use the designers to 
define workspaces that do include attached files.


return_value 


A Binder Java object that contains data and methods for the requested binder.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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binder_getBinderByPathName 


Accepts a directory specification to get information about a binder. 


Syntax


public Binder binder_getBinderByPathName( String accessToken, String pathName,                                       
boolean includeAttachments );


Description


The binder_getBinderByPathName operation uses a workspace-hierarchy path name to get 
information about a workspace or folder. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


pathName 


The titles of the binder for which you want information, preceded by the titles of all of its 
parents, separated by slashes:


Workspaces / Global workspaces / wsOrfolderTitle / ... / titleTargetWS


includeAttachments 


A Boolean value that indicates whether you want Vibe to return attached files.


By default, workspaces do not include attached files. However, users can use the designers to 
define workspaces that do include attached files.


return_value 


A Binder Java object that contains data and methods for the requested binder.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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binder_getFileVersions 


Returns information about the versions of a file.


Syntax


public void binder_getFileVersions( String accessToken, long binderID, String fileName );


Description


The binder_getFileVersion operation retrieves information about the versions of a file associated 
with a workspace or folder.


By default, workspaces and folders do not contain files, but users can alter definitions by using the 
designers in the user interface so that a custom workspace or folder can include one or more files.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binderID 


The binder identifier for the workspace or folder.


filename 


The filename of the file you want to retrieve version information about. 


return_value 


A File Version Java object that contains information about the file versions.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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binder_getFolders 


Returns a folder collection for a binder’s sub-folders.


Syntax


public FolderCollection binder_getFolders( String accessToken, long binderId,int firstRecord, int 
maxRecords );


Description


The binder_getFolders operation returns a folder collection, which contains information about the 
sub-folders of a specified binder. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value. 


binderId 


The binder identifier for the workspace or folder for which you want information about its sub-
folders.


firstRecord 


The index of the first record whose folder information you want to obtain. The index is 0-based.


maxRecord 


The maximum number of folders whose information should be returned. Specify -1 for 
unlimited.


return_value 


A FolderCollection Java object containing information about the sub-folders. 


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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binder_getSubscription 


Obtains subscription information about a binder. 


Syntax


public Subscription binder_getSubscription( String accessToken, long binderId );


Description


The binder_getSubscription operation returns subscription information for a specified binder. 
When a user subscribes to a binder, that person receives e-mail notifications. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binderId 


The binder identifier for the workspace or folder for which you want subscription information.


return_value 


A Subscription Java object containing subscription information.


Example


public static void checkBinderSubscriptions(long binderId) throws Exception { ...                                                                                                            
Subscription subscription = setupSubscription(binderId);                                          
stub.binder_setSubscription(null, binderId, subscription);                                             
subscription = stub.binder_getSubscription(null, binderId); 
validateSubscription(subscription);                                                                                                             
}


This code is taken from the source code for the teamingservice-client-with-stub.bat file.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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binder_getTags 


Obtains tags applied to a binder. 


Syntax


public Tag[] binder_getTags( String accessToken, long binderId );


Description


The binder_getTags operation gets tag information for a specified binder. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binderId 


The binder identifier for the workspace or folder whose tag information you want.


return_value 


An array of Tag Java objects, each containing information about one of the tags applied to the 
binder.


Example


  public static  void checkTags(long binderId) throws Exception {  ...                                                                   
Tag[] tags = setupTags(binderId);                                                                                                                     
for (int i=0; i<tags.length; ++i) {stub.binder_setTag(null, tags[i]);  }                                                            
tags = stub.binder_getTags(null, binderId);                                                                      
validateTags(tags);                                                                                                     
stub.binder_deleteTag(null, binderId, tags[0].getId());     


This code is taken from the source code for the teamingservice-client-with-stub.bat file.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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binder_getTeamMembers 


Obtains information about the members of a team assigned to a specified binder. 


Syntax


public TeamMemberCollection binder_getTeamMembers( String accessToken, long binderId );


Description


The binder_getTeamMembers operation obtains information about the members of a team assigned 
to a specified binder. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binder 


The binder identifier for the workspace or folder for which you want information about team 
members.


return_value 


A TeamMemberCollection Java object containing information about the members of a team 
assigned to the specified binder.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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binder_getTrashEntries


Returns a trash collection for a binder.


Syntax


public TrashCollection binder_getTrashEntries( String accessToken, long binderId );


Description


The binder_getTrashEntries operation returns a trash collection, which contains information 
about the contents of the trash for a specified binder. The items in a binder’s trash are all the sub-
binders and entries that are in the trash.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binderId 


The binder identifier for the workspace or folder for which you want information about its trash 
contents.


firstRecord 


The index of the first record whose trash information you want to obtain. The index is 0-based.


maxRecord 


The maximum number of items whose information should be returned. Specify -1 for 
unlimited.


return_value 


A TrashCollection Java object containing information about the trash contents.
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binder_indexBinder 


Indexes a binder and its content. 


Syntax


public void binder_indexBinder( String accessToken, long binderId );


Description


The binder_indexBinder operation indexes a workspace or folder (and its contents), optimizing the 
ability of Vibe to search its contents. This operation does not index sub-binders.


To index sub-binders, use the binder_indexTree operation.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binderId 


The binder identifier for the workspace or folder that you want to index.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)


 binder_indexTree (page 90)
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binder_indexTree 


Indexes a binder’s sub-binders. 


Syntax


public Long binder_indexTree( String accessToken, long binderId );


Description


The binder_indexTree operation indexes the specified workspace or folder, all sub-binders, and all 
content in all those binders. 


If you want to index a binder and its contents without indexing sub-binders, use the 
binder_indexBinder operation.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binderId 


The binder identifier for the workspace or folder that indicates the node where you want to 
begin indexing within the workspace hierarchy.


return_value 


An array of integers, with each integer being the identifier of a binder successfully indexed. 


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)


 binder_indexBinder (page 89)
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binder_modifyBinder 


Modifies a binder. 


Syntax


public void binder_modifyBinder( String accessToken, Binder binder );


Description


The binder_modifyBinder operation modifies a workspace or folder. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binder 


Data and methods for the Binder Java object, defined in the Vibe source code.


return_value 


None.


Example


public static Binder modifyBinder(Binder binder) throws Exception { ...                                                                         
binder.setTitle(binder.getTitle() + " (Modified)");                                                         
binder.getDescription().setText(binder.getDescription().getText() + " 
(Modified)");    stub.binder_modifyBinder(null, binder);                                                 
stub.binder_getBinder(null, binder.getId(), true);                                          
System.out.println("ID of the modified binder: " + binder.getId());                                        
return binder;                                                                                                                                                      
}


This code is taken from the source code for the teamingservice-client-with-stub.bat file.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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binder_moveBinder 


Moves a binder within the workspace tree hierarchy.


Syntax


public void binder_moveBinder( String accessToken, long binderId, long newParentBinderId );


Description


The binder_moveBinder operation moves either a workspace or folder within the workspace 
hierarchy. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binderId 


The binder identifier for the workspace or folder that you want to move.


newParentBinderId 


The binder identifier of the binder under which you want binderId to appear as a sub-binder.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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binder_preDeleteBinder


Predeletes a binder by moving it to the trash.


Syntax


public void binder_preDeleteBinder( String accessToken, long binderId );


Description


The binder_preDeleteBinder operation moves a workspace or folder to the trash. All contained 
binders and entries are also moved to the trash.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binderId 


The binder identifier for the workspace or folder that you want to move to the trash.


return_value 


None.
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binder_removeFile 


Removes a file from a binder. 


Syntax


public void binder_removeFile( String accessToken, long binderId, String fileName );


Description


The binder_removeFile operation removes a file from a workspace or folder. 


By default, workspaces do not contain files, but users can alter definitions by using the designers in 
the UI so that a custom workspace can include one or more files.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binderId 


The binder identifier for the workspace or folder from which you want to remove a file.


fileName 


The file name of the file you want to remove from the binder.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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binder_restoreBinder


Undeletes a binder by removing it from the trash and restoring it to its previous location in the Vibe 
site.


Syntax


public void binder_restoreBinder( String accessToken, long binderId );


Description


The binder_restoreBinder operation undeletes a workspace or folder by removing it from the 
trash and restoring it to its previous location in the Vibe site. 


Any containing binders that are in the trash are also undeleted.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binderId 


The binder identifier for the workspace or folder that you want to restore.


return_value 


None.
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binder_setDefinitions 


Associates workflow definitions with entry definitions. 


Syntax


public void binder_setDefinitions( String accessToken, long binderId, String[] entryDefinitionIds, String 
[] workflowDefinitionIds );


Description


The binder_setDefinitions operation associates entries within the specified binder with workflow 
processes. (Vibe associates identifiers in the first element of both arrays, the second element of both 
arrays, the third, and so on.)


When an entry is associated with a workflow process, creation of an entry of that type automatically 
places the entry into the initial state of the workflow process. By default, workspaces do not contain 
entries that can be associated with workflow processes. However, users can alter definitions by using 
the designers in the UI so that a custom workspace can include one or more files.


NOTE: This operation is an overwrite operation, setting all workflow associations for the folder; you 
cannot use repeated calls to this operation to set associations incrementally. Set all of the workflow 
associations for the folder with one call. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binderId 


The binder identifier for the folder or custom workspace within which you want entries 
associated with workflow processes.


entryDefinitionIds 


An array of definition identfiers for each type of entry to which you want to associate a 
workflow process.


workflowDefinitionIds 


An array of workflow identifiers in the order in which you want them applied to the entry-
definition identifiers in entryDefinitionIds.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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binder_setFunctionMembership 


Applies access-control settings to a binder. 


Syntax


public void binder_setFunctionMembership( String accessToken, long binderId,                    
FunctionMembership[] functionMemberships);


Description


The binder_setFunctionMembership operation provides access-control settings for a folder or 
workspace. The term function is analogous to an access-control role in the UI.


NOTE: This operation is an overwrite operation, that sets all function memberships for the folder or 
workspace; you cannot use repeated calls to this operation to set memberships incrementally. Set all 
memberships for the workspace or folder with one call.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binderId 


The binder identifier for the workspace or folder whose access control you want to set.


functionMemberships 


An array of FunctionMembership Java objects.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)


 binder_setFunctionMembershipInherited (page 98)
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binder_setFunctionMembershipInherited 


Establishes inheritance as the access-control mechanism for a folder or workspace. 


Syntax


public void binder_setFunctionMembershipInherited( String accessToken, long binderId,       boolean 
inherit );


Description


The binder_setFunctionMembershipInherited establishes whether a specified workspace or 
folder inherits access-control settings from its parent binder. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binderId 


The binder identifier for the workspace or folder for which you want to establish the inheritance 
setting for access control.


inherit 


A true or false value that establishes whether the binder inherits its access-control settings.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)


 binder_setFunctionMembership (page 97)
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binder_setOwner 


Establishes the owner of the binder. 


Syntax


public long binder_setOwner( String accessToken, long binderId, long userId);


Description


The binder_setOwner operation establishes the specified user as the owner of a workspace or folder. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binderId 


The binder identifier for the workspace or folder whose owner you want to establish.


userId 


The identifier for the user whom you want to be the owner of the binder.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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binder_setSubscription 


Establishes e-mail settings for a binder. 


Syntax


public void binder_setSubscription( String accessToken, long binderId, Subscription subscription );


Description


The binder_setSubscription operation establishes subscription settings for a workspace or folder. 
When a user subscribes to a binder, that person receives e-mail notifications.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binderId 


The binder identifier for the workspace or folder whose subscription you want to set.


subscription 


A Subscription Java object containing information used to establish e-mail notification settings 
for the specified binder.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)

100 Novell Vibe 3.2 Developer Guide







binder_setTag 


Applies a tag for a binder. 


Syntax


public void binder_setTag( String accessToken, Tag tag );


Description


The binder_setTag operation applies a tag to a workspace or folder. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


tag 


A Tag Java object that contains information applying the tag to a workspace or folder.


return_value 


None.


Example


  public static  void checkTags(long binderId) throws Exception {  ...                                                                   
Tag[] tags = setupTags(binderId);                                                                                                                     
for (int i=0; i<tags.length; ++i) {stub.binder_setTag(null, tags[i]);  }                                                            
tags = stub.binder_getTags(null, binderId);                                                                      
validateTags(tags);                                                                                                     
stub.binder_deleteTag(null, binderId, tags[0].getId());


This code is taken from the source code for the teamingservice-client-with-stub.bat file.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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binder_setTeamMembers 


Establishes members of a team for a binder. 


Syntax


public void binder_setTeamMembers( String accessToken, long binderId, String[] teamMembers );


Description


The binder_setTeamMembers operation establishes members of the team for a specified workspace 
or folder. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binder 


The binder identifier for the workspace or folder for which you want to establish team 
membership.


return_value 


None.


teamMembers 


Names of the team members.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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binder_testAccess 


Tests if the calling user has the specified access right on each of the specified binders. 


Syntax


public boolean[] binder_testAccess( String accessToken, String workAreaOperationName, long[] 
binderIds);


Description


The binder_testAccess operation tests if the calling user has the specified access right on each 
workspace or folder that is specified. 


If a binder does not exist, the result for that specific binder is set to <code>false</code>. If the 
access right is an unknown value in Vibe, then the result for all binders is set to <code>fasle</
code>.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


workAreaOperationName 


The string name of a org.kablink.teaming.security.function.WorkAreaOperation instance. See 
the Java source file for the names.


binderIds 


The ID of the binders against which to test the access.


return_value 


An array of boolean values where each value represents whether the access test was successful 
or not for each binder.
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binder_uploadFile 


Uploads a file into a binder. 


Syntax


public void binder_uploadFile( String accessToken, long binderId,                                                   String 
formDataItemName, String fileName );


Description


The binder_uploadFile operation performs an action equivalent to using the UI to upload a file to 
either a workspace or folder. You can attach only one file at a time; call this operation multiple times 
to attach more than one file to the binder. 


By default, workspaces do not include attached files. However, users can use the designers to define 
workspaces that do include attached files.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binderId 


The binder identifier for the workspace or folder into which you want to upload a file.


formDataItemname 


A string containing the internal identifier for the part of the entry that contains attached files. 
This identifier maps the name attribute of an input HTML tag on a form to data in the Vibe 
database; a hidden HTML tag communicates this file mapping to the server.


The name value for the standard entry element containing attached files is ss_attachFile. If 
you want to upload a file into a custom form element you defined using the designers, you need 
to look up the name identifier for that form element. 


If you are uploading to a folder file, specify upload as an argument to this parameter to make 
this attachment the primary file for the entry.


fileName 


A string containing the filename of the file you want to upload to the binder.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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definition_getDefinitionAsXML 


Obtains information about a definition. 


Syntax


public String definition_getDefinitionAsXML( String accessToken, String definitionId );


Description


The definition_getDefinitionAsXML operation returns a string of XML containing information 
about a specified definition. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


definitionId 


The definition identifier of the item about which you want information.


return_value 


An XML string containing information about the definition. This XML is free form; it does not 
have a firm, established schema.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)


 definition_getDefinitionByName (page 106)


 definition_getDefinitions (page 107)


 definition_getDefinitionByName (page 106)


 definition_getLocalDefinitions (page 109)
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definition_getDefinitionByName 


Obtains information about a global definition. 


Syntax


public DefinitionBrief definition_getDefinitionByName( String accessToken,                              String 
definitionName );


Description


The definition_getDefinitionByName operation obtains information about a global definition by 
using the definition name. To get information about a local definition, use the 
definition_getLocalDefinitionByName operation. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


definitionName 


The descriptive word or phrase used to name the global definition.


return_value 


A DefinitionBrief Java object containing information about the global definition.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)


 definition_getDefinitions (page 107)


 definition_getLocalDefinitionByName (page 108)
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definition_getDefinitions 


Obtains all global definitions in the installation.


Syntax


public DefinitionCollection definition_getDefinitions( String accessToken );


Description


The definition_getDefinitions operation obtains information about all global definitions in the 
installation. To get information about local definitions, use the definition_getLocalDefinitions 
operation.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


return_value 


A DefinitionCollection Java object containing information about all global definitions in the 
installation.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)


 definition_getLocalDefinitionByName (page 108)


 definition_getLocalDefinitions (page 109)
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definition_getLocalDefinitionByName 


Obtains information about a local definition. 


Syntax


public DefinitionBrief definition_getLocalDefinitionByName( String accessToken, long binderId, String 
name, boolean includeAncestors );


Description


The definition_getLocalDefinitionByname operation obtains information about a local 
definition by using a name. To get information about a global definition, use the 
definition_getDefinitionByname operation.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binderId 


The binder identifier for the workspace or folder whose local definition you want.


name 


The word or phrase used to name the local definition.


includeAncestors 


A Boolean value that indicates whether Vibe should check local definitions inherited from 
ancestor workspaces and folders, which are located higher in the hierarchy than the specified 
binder. If you specify false, Vibe checks only the local definitions created within the specified 
binder. 


return_value 


A DefinitionBrief Java object containing information about the definition that matches name.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)


 definition_getLocalDefinitionByName (page 108)


 definition_getLocalDefinitions (page 109)
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definition_getLocalDefinitions 


Obtains information about all local definitions.


Syntax


public DefinitionCollection definition_getLocalDefinitions( String accessToken, long binderId, boolean 
includeAncestors);


Description


The definition_getLocalDefinitions operation obtains information about the local definitions 
for a specified binder. If you want information about all global definitions in the installation, use the 
definition_getDefinitions operation. 


If you want to add a fully configured binder, use template_addBinder instead.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binderId 


The binder identifier for the workspace or folder whose local definitions you want.


includeAncestors 


A Boolean value that indicates whether Vibe should include local definitions inherited from 
ancestor workspaces and folders, which are located higher in the hierarchy than the specified 
binder. If you specify false, Vibe includes only the local definitions created within the specified 
binder. 


return_value 


A DefinitionCollection Java object that contains information about the binder’s local definitions.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)


 definition_getDefinitions (page 107)


 definition_getLocalDefinitionByName (page 108)
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folder_addEntry 


Adds an entry to a folder. 


Syntax


public long folder_addEntry( String accessToken, FolderEntry entry, String attachedFileName );


Description


The folder_addEntry operation adds an entry to a folder. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


entry 


A FolderEntry Java object containing information that Vibe uses to create the new entry.


attachedFileName 


(Optional) A string containing the filename of a file to attach to the new entry. If you are not 
attaching a file, specify the null value for this argument.


return_value 


The entry identifier of the newly created entry.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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folder_addEntryWorkflow 


Initiates a workflow process for a folder entry. 


Syntax


public void folder_addEntryWorkflow( String accessToken, long entryId, String workflowDefinitionId );


Description


The folder_addEntryWorkflow operation initiates a workflow process for a folder entry. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


entryId 


The entry identifier of the folder entry with which you want to initiate a workflow process.


workflowDefinitionId 


The definition identifier of the workflow process that you want to initiate for the specified folder 
entry.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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folder_addMicroBlog


Adds a micro-blog entry to a folder. 


Syntax


public long folder_addMicroBlog( String accessToken, string text );


Description


The folder_addMicroBlog operation adds a micro-blog entry to a folder. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


text 


A string containing the text of the micro-blog to create.


return_value 


The entry identifier of the newly created micro-blog entry.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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folder_addReply 


Adds a comment to a folder entry. 


Syntax


public long folder_addReply( String accessToken, long parentEntryId, FolderEntry reply,         String 
attachedFileName );


Description


The folder_addReply operation adds a comment to a folder entry. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


parentEntryId 


The entry identifier of the entry or comment that is to be the parent of the comment you are 
adding.


reply 


A FolderEntry Java object containing information that yyyy uses to create the new comment.


attachedFileName 


The filename of a file you are attaching to the comment. If you are not attaching a file, specify the 
null value for this argument.


return_value 


The entry identifier of the newly created comment.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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folder_copyEntry 


Copies a folder entry. 


Syntax


public long folder_copyEntry( String accessToken, long entryId, long parentFolderId );


Description


The folder_copyEntry operation copies a folder entry. 


NOTE: This operation does not copy workflow information for an entry.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


entryId 


The entry identifier of the folder entry you want to copy.


parentFolderId 


The folder identifier of the folder you want to contain the copied entry. 


return_value 


The entry identifier of the new entry created by copying the existing entry.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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folder_deleteEntry 


Deletes a folder entry. 


Syntax


public void folder_deleteEntry( String accessToken, long entryId );


Description


The folder_deleteEntry operation deletes a folder entry. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


entryId 


The entry identifier of the folder entry you want to delete.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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folder_deleteEntryTag 


Removes a tag from a folder entry. 


Syntax


public void folder_deleteEntryTag( String accessToken, long entryId, String tagId );


Description


The folder_deleteEntryTag operation removes a tag from a folder entry. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


entryId 


The entry identifier of the entry from which you want to remove a tag.


tagId 


A string identifying the tag you want to remove from the entry.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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folder_deleteEntryWorkflow 


Removes a workflow from an entry. 


Syntax


public void folder_deleteEntryWorkflow( String accessToken, long entryId,                                     String 
workflowDefinitionId );


Description


The folder_deleteEntryWorkflow operation removes a workflow process from a folder entry. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


entryId 


The entry identifier of the entry for which you want to remove a workflow process.


workflowDefinitionId 


A string containing the definition identifier for the workflow process you want to remove from 
the entry.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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folder_getEntries 


Obtains information about the entries within a specified folder. 


Syntax


public FolderEntryCollection folder_getEntries( String accessToken, long binderID, int firstRecord, int 
maxRecords );


Description


The folder_getEntries operation obtains information about the entries contained in a folder. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binderId 


The binder identifier for the folder containing the entries for which you want information.


firstRecord 


The index of the first record whose information you want to obtain. The index is 0-based.


maxRecords 


The maximum number of entries whose information should be returned. Specify -1 for 
unlimited.


return_value 


A FolderEntryCollection Java object containing information about the entries contained within 
the folder. 


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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folder_getEntry 


Accepts an entry identifier to get information about an entry in a folder. 


Syntax


public FolderEntry folder_getEntry( String accessToken, long entryId,                                        boolean 
includeAttachments );


Description


The folder_getEntry operation obtains information about an entry in a folder. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


entryId 


The entry identifier of the entry about which you want information.


includeAttachments 


A Boolean value that indicates whether you want Vibe to return the entry’s attachments. The 
client program is responsible for placement of attachment files on its local system.


return_value 


A FolderEntry Java object that contains information about the specified entry.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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folder_getEntryByFileName 


Accepts a filename to get information about an entry.


Syntax


public FolderEntry folder_getEntryByFileName( String accessToken, long binderId,                   String 
fileName, boolean includeAttachments );


Description


The folder_getEntryByFileName  operation obtains information about an entry in a folder by using 
the entry’s file name.


Although this operation is most useful for Files folders, it works for any folder that requires that all 
filenames within the folder to be unique.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binderId 


The binder identifier for the folder containing the entry for which you want information.


fileName 


The name of the file that corresponds with the entry for which you want information.


includeAttachment 


A Boolean value that indicates whether you want Vibe to return the entry’s attachments. The 
client program is responsible for placement of attachment files on its local system.


return_value 


A FolderEntry Java object that contains information about the specified entry.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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folder_getEntryTags 


Obtains information about an entry’s tags. 


Syntax


public Tag[] folder_getEntryTags( String accessToken, long entryId );


Description


The folder_getEntryTags operation gets information about each of the tags applied to a folder 
entry. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


entryId 


The identifier of the entry about whose tags you want information.


return_value 


An array of Tag Java objects, where each object contains information about one tag applied to the 
entry.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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folder_getFileVersions 


Returns information about the versions of a file. 


Syntax


public void folder_getFileVersions( String accessToken, long entryId, String fileName );


Description


The folder_getFileVersions operation retrieves information about the versions of a file associated 
with an entry. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


entryId 


The entry identifier of the entry.


fileName 


The filename of the file you want to retrieve version information about.


return_value 


A File Versions Java object containing information about the file versions.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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folder_getSubscription 


Obtains subscription information for a specified folder. 


Syntax


public Subscription folder_getSubscription( String accessToken, long entryId );


Description


The folder_getSubscription operation gets information about the e-mail notification settings for a 
specified folder. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


entryId 


The identifier for the entry whose subscription information you want.


return_value 


A Subscription Java object that contains information about e-mail notification settings for the 
specified folder.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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folder_modifyEntry 


Modifies an entry in a folder. 


Syntax


public void folder_modifyEntry( String accessToken, FolderEntry entry );


Description


The folder_modifyEntry operation modifies the contents of a folder entry. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


entry 


A FolderEntry Java object containing the information to apply to the existing folder entry.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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folder_modifyWorkflowState 


Changes the workflow state of an entry. 


Syntax


public void folder_modifyWorkflowState( String accessToken, long entryId, long StateId, String toState 
);


Description


The folder_modifyWorkflowState operation changes the workflow state of a folder entry. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


entryId 


The identifier of the entry whose workflow state you want to change.


stateID 


The token ID of the current workflow state from which you want the entry to transition to the 
new state.


toState 


A string identifying your desired workflow state.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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folder_moveEntry 


Moves an entry within the folder-tree hierarchy.


Syntax


public void folder_moveEntry( String accessToken, long entryId, long parentId );


Description


The folder_moveEntry operation moves an entry to be under a new parent within the folder 
hierarchy. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


entryId 


The identifier of the entry you want to move.


parentId 


The identifier of the folder that is to be the new parent of the specified entry.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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folder_preDeleteEntry 


Predeletes an entry by moving it to the trash.


Syntax


public void folder_preDeleteEntry( String accessToken, long entryId );


Description


The folder_preDeleteEntry operation moves an entry to the trash. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


entryId 


The entry identifier of the entry that you want to move to the trash.


return_value 


None.
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folder_removeFile 


Removes a file attachment from an entry.


Syntax


public void folder_removeFile( String accessToken, long entryId, String fileName );


Description


The folder_removeFile operation removes a file attachment from an entry in a folder. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


entryId 


The identifier of the entry that includes the attachment you want to remove.


fileName 


A string containing the filename of the attachment you want to remove from the entry.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)

128 Novell Vibe 3.2 Developer Guide







folder_reserveEntry 


Reserves an entry.


Syntax


public void folder_reserveEntry( String accessToken, long entryId );


Description


The folder_reserveEntry operation reserves an entry in a folder, preventing others from 
modifying it. 


Users reserve and release an entry in the UI using the Reserve and Unreserve menu items.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


entryId 


The identifier of the entry you want to reserve.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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folder_restoreEntry 


Undeletes an entry by removing it from the trash and restoring it to its previous location in the Vibe 
site.


Syntax


public void folder_restoreEntry( String accessToken, long entryId );


Description


The folder_restoreEntry operation undeletes an entry. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


entryId 


The entry identifier of the entry that you want to restore.


return_value 


None.
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folder_setEntryTag 


Applies a tag to a folder entry. 


Syntax


public void folder_setEntryTag( String accessToken, Tag tag );


Description


The folder_setEntryTag operation applies a tag to a folder entry. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


tag 


A Tag Java object containing information about the tag you want to apply.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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folder_setRating 


Sets a rating for a folder entry.


Syntax


public void folder_setRating( String accessToken, long entryId, long value );


Description


The folder_setRating operation applies a “star” rating to an entry. 


In the UI, entries can have ratings that range from a lowest value of 1 star to the highest value of 5 
stars.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


entryId 


The identifier of the entry for which you want to apply a rating.


ratingValue 


An integer indicating how many stars you want to set as the rating.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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folder_setSubscription 


Establishes subscription settings for an entry. 


Syntax


public void folder_setSubscription( String accessToken, long entryId, Subscription subscription );


Description


The folder_setSubscription operation establishes settings for e-mail notifications for a specified 
entry. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


entryId 


The identifier of the entry for which you want to set subscription information.


subscription 


A Subscription Java object that contains subscription information to be applied to the specified 
entry.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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folder_setWorkflowResponse 


Applies an answer to a workflow question for a specified entry. 


Syntax


public void folder_setWorkflowResponse( String accessToken, long entryId,                                   long 
stateId, String question, String response );


Description


The folder_setWorkflowResponse operation establishes an answer for a workflow question for a 
specified entry. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


entryId 


The identifier of the entry that is currently in the workflow state within which you want to apply 
an answer to a question.


stateId 


The token ID of the current workflow state that defines the question that you want to affect.


question 


A string identifying the question that you are providing an answer to.


response 


A string identifying the response you want to apply to the workflow question.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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folder_synchronizeMirroredFolder 


Synchronizes a mirrored folder with its source folder. 


Syntax


public void folder_synchronizeMirroredFolder( String accessToken, long binderId );


Description


The folder_synchronizeMirroredFolder operation synchronizes a mirrored folder with its source 
folder. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binderId 


The identifier of the mirrored folder that you want to synchronize.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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folder_unreserveEntry 


Releases a locked entry. 


Syntax


public void folder_unreserveEntry( String accessToken, long entryId );


Description


The folder_unreserveEntry operation releases a locked entry. 


Users reserve and release an entry in the UI by using the Reserve and Unreserve menu items.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


entryId 


The identifier of the entry that you want to release from its lock.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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folder_uploadFile 


Uploads a file as an attachment to an entry. 


Syntax


public void file_uploadFile( String accessToken, long entryId, String formDataItemName,         String 
fileName );


Description


The file_uploadFile operation uploads a file as an attachment to an entry. You can attach only one 
file at a time; call this operation multiple times to attach more than one file to the entry.


Because transferring files across the Internet can be time-consuming, you can upload files that have 
already been moved to a staging area on the Vibe server by using the folder_uploadFileStaged 
operation.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


entryId 


The identifier of the entry that is to include the new attached file.


formDataItemName 


A string containing the internal identifier for the part of the entry that contains attached files. 
This identifier maps the name attribute of an input HTML tag on a form to data in the Vibe 
database; a hidden HTML tag communicates this file mapping to the server.


The name value for the standard entry element containing attached files is ss_attachFile. If 
you want to upload a file into a custom form element you defined by using the designers, you 
need to look up the name identifier for that form element. 


If you are uploading to a folder file, specify upload as an argument to this parameter to make 
this attachment the primary file for the entry.


fileName 


A string containing the filename of the file you want to attach to the entry.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)


 folder_uploadFileStaged (page 138)
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folder_uploadFileStaged 


Locates a locally stored file and attaches it to an entry. 


Syntax


public void file_uploadFileStaged( String accessToken, long entryId, String formDataItemName, String 
fileName, String stagedFileRelativePath );


Description


As a way to streamline the transfer of files, the file_uploadFileStaged operation accesses a file that 
has been copied locally to the Vibe server, avoiding transferring them over the Internet. The 
operation then attaches the file to a folder entry in Vibe. In order for the Web services client to utilize 
this operation, the Vibe administrator must first configure the server to allow this operation by 
specifying staging.upload.files.enable and staging.upload.files.rootpath configuration 
settings in ssf-ext.properties file. Because it involves Vibe administrator  access to the server 
environment, this operation is reserved only for major migration projects where individual file 
uploads through the HTTP protocol do not meet the performance requirements of the project.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


entryId 


An identifier for the entry to which you want to attach a file.


formDataItemName 


A string containing the internal identifier for the part of the entry that contains attached files. 
This identifier maps the name attribute of an input HTML tag on a form to data in the Vibe 
database; a hidden HTML tag communicates this file mapping to the server.


The name value for the standard entry element containing attached files is ss_attachFile. If 
you want to upload a file into a custom form element you defined by using the designers, you 
need to look up the name identifier for that form element. 


If you are uploading to a folder file, specify upload as an argument to this parameter to make 
this attachment the primary file for the entry.


fileName 


A string containing the filename of the file you want to attach to the entry.


stagedFileRelativePath 


A pathname of the file relative to the staging area on the server side. On the Vibe server, the 
staging directory is designated by the value of the staging.uploads.files.rootpath 
configuration setting. This relative pathname is resolved against the staging directory of the 
Vibe server to identify the input file.


return_value 


None.
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See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)


 folder_uploadFile (page 137)
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ical_uploadCalendarEntriesWithXML 


Adds a calendar entry to a folder. 


Syntax


public void ical_uploadCalendarEntriesWithXML( String accessToken, long folderId, String 
iCalDataAsXML );


Description


The ical_uploadCalendarEntriesWithXML adds a calendar entry using iCal information in an XML 
string. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


folderId 


The identifier of the folder where you want to add a calendar entry.


iCalDataAsXML 


A string containing XML formatted calendar data (<doc><entry>iCal data</entry>...</
doc>). 


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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ldap_synchAll 


Synchronizes all users with the current information that is in LDAP. 


Syntax


public void ldap_synchAll( String accessToken );


Description


The ldap_synchAll operation synchronizes all users with the current information that is in LDAP. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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ldap_synchUser 


Synchronizes one user with the latest information in LDAP for that person. 


Syntax


public void ldap_synchUser( String accessToken, long userId );


Description


The ldap_synchUser operation synchronizes one user with the latest information in LDAP for that 
person. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


userId 


The identifier of the user whose information you want synchronized with that person’s LDAP 
data.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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license_getExternalUsers 


Obtains a count of external users. 


Syntax


public long license_getExternalUsers( String accessToken );


Description


The license_getExternalUsers operation obtains a count of legal external users for the current 
license. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


return_value 


An integer indicating the number of allowed external users.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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license_getRegisteredUsers 


Obtains a count of registered Vibe users. 


Syntax


public long license_getRegisteredUsers( String accessToken );


Description


The license_getRegisteredUsers operation obtains a count of the current number of registered 
users on the system. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


return_value 


An integer that is the count of users currently registered on the system.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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license_updateLicense 


Updates the Vibe license.   


Syntax


public void license_updateLicense( String accessToken );


Description


The license_updateLicense operation updates the Vibe license. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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migration_addBinder 


Accepts a Java object to add a binder, allowing preservation of SiteScape Forum data.


Syntax


public long migration_addBinder( String accessToken, Binder binder );


Description


The migration_addBinder operation adds either a workspace or folder to the hierarchy, allowing 
you to specify SiteScape Forum data (such as the person who created the workspace or folder in 
Forum, the Forum creation date, the user who last modified the workspace or folder in Forum, and 
the date of the last modification in Forum).


If you prefer to use XML to specify data, use the migration_addBinderWithXML operation. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binder 


Data and methods for the Java Binder object, defined in the Vibe source code. Edit the 
information in the Binder object to reflect the Forum values.


return_value 


The identifier of the newly created binder.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)


 migration_addBinderWithXML (page 147)
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migration_addBinderWithXML 


Accepts XML to add a binder, allowing preservation of SiteScape Forum data. 


Syntax


public long migration_addBinderWithXML( String accessToken, long parentId, String definitionId, 
String inputDataAsXML, String creator, Calendar creationDate, String modifier,                    Calendar 
modificationDate );


Description


The migration_addBinderWithXML operation adds either a workspace or folder to the hierarchy, 
allowing you to specify SiteScape Forum data (such as the person who created the workspace or 
folder in Forum, the Forum creation date, the user who last modified the workspace or folder in 
Forum, and the date of the last modification in Forum).


If you prefer to use a Java object to specify data, use the migration_addBinder operation. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


parentId 


The identifier of the workspace or folder that is to contain the new binder.


definitionID 


A string that identifies the definition used to create the new binder.


inputDataAsXML 


An XML string that provides the data needed to construct the workspace or folder.


creator 


A string containing the username of the person who created the workspace or folder in Forum.


creationDate 


A Calendar Java object that contains the creation date of the workspace or folder in Forum.


modifier 


A string containing the username of the person who last modified the workspace or folder in 
Forum.


modificationDate 


A Calendar Java object that contains the modification date of the workspace or folder in Forum.


return_value 


The identifier of the newly created binder.
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See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)


 migration_addBinder (page 146)
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migration_addEntryWorkflow 


Associates an entry with a workflow process, allowing preservation of SiteScape Forum data.


Syntax


public void migration_addEntryWorkflow( String accessToken, long binderId, long entryId,     String 
definitionId, String startState, String modifier, Calendar modificationDate );


Description


The migration_addEntryWorkflow operation associates an entry with a workflow process, while 
preserving values from a SiteScape Forum installation. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binderId 


The identifier of the folder containing the entry with which you want to associate a workflow 
process.


entryId 


The identifier of the entry with which you want to associate the workflow process.


definitionId 


A string containing the definition identifier for the workflow process you want to associate with 
the entry.


startState 


A string containing the name of the state of the entry as it was last set in the Forum installation.


modifier 


A string containing the username of the person who last modified the workflow state in the 
Forum installation.


modificationDate 


A Calender Java object that contains the date that the workflow state was last modified in the 
Forum installation.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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migration_addFolderEntry 


Accepts a Java object to add an entry to a folder, allowing preservation of SiteScape Forum data. 


Syntax


public long migration_addFolderEntry( String accessToken, FolderEntry entry, boolean subscribe );


Description


The migration_addFolderEntry operation adds an entry to a folder.


If you prefer to use an XML string to create the new entry, use the 
migration_addFolderEntryWithXML operation. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


entry 


A FolderEntry Java object that contains information used to create the new entry, including 
information from the entry in the Forum installation.


subscribe 


A Boolean value that implements the Forum notify me when someone replies to this entry feature by 
establishing a subscription for the entry owner.


return_value 


The identifier of the newly created entry.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)


 migration_addFolderEntryWithXML (page 151)
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migration_addFolderEntryWithXML 


Accepts XML to add an entry to a folder, allowing preservation of SiteScape Forum data.


Syntax


public long migration_addFolderEntryWithXML( String accessToken, long binderId,                String 
definitionId, String inputDataAsXML, String creator, Calendar creationDate,                   String modifier, 
Calendar modificationDate, boolean subscribe );


Description


The migration_addFolderEntry operation adds an entry to a folder, allowing you to preserve data 
from the entry as it last existed in an installation of SiteScape Forum. 


If you prefer to create the entry by using a Java object, use the migrate_addFolderEntry operation.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binderId 


The identifier of the folder that is to contain the new entry.


definitionId 


A string containing the definition identifier for the new entry.


inputDataAsXML 


A string containing the XML elements used to construct the new entry.


creator 


A string containing the username of the person who created the entry in the Forum installation.


creationDate 


A Calendar Java object containing the date the entry was created in the Forum installation.


modifier 


A string containing the username of the person who last modified the entry in the Forum 
installation.


modificationDate 


A Calendar Java object containing the date the entry was last modified in the Forum installation.


subscribe 


A boolean value that implements the Forum feature “notify me when someone replies to this 
entry” by establishing a subscription for the entry owner.


return_value 


The identifier of the binder for the newly created entry.
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See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)


 migration_addFolderEntry (page 150)
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migration_addReply 


Accepts a Java object to add a comment, allowing preservation of SiteScape Forum data. 


Syntax


public long migration_addReply( String accessToken, long parentEntryId, FolderEntry reply );


Description


The binder_addReply operation adds a comment to an entry or a reply, and allows you to preserve 
data from the reply as it last appeared in a Forum installation. 


If you prefer to add the comment by using XML, use the migrate_addReplyWithXML operation.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


parentEntryId 


The identifier of the entry or comment that is the parent of the comment you want to create.


reply 


A FolderEntry Java object that contains information used to construct the new comment, 
including data reflecting the reply as it last appeared in the Forum installation.


return_value 


The identifier of the newly created comment.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)


 migration_addReplyWithXML (page 154)
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migration_addReplyWithXML 


Accepts XML to add a comment, allowing preservation of SiteScape Forum data. 


Syntax


public long migration_addReplyWithXML( String accessToken, long binderId, long parentId, String 
definitionId, String inputDataAsXML, String creator, Calendar creationDate, String modifier, Calendar 
modificationDate );


Description


The migration_addReplyWithXML operation adds a comment to an entry or to another comment, 
allowing you to preserve data from the reply as it last appeared in the SiteScape Forum installation.


If you prefer to add the comment by using a Java object, use the migration_addReply operation. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binderId 


The identifier of the folder that contains the entry to which you want to add the comment.


parentId 


The identifier of the entry or comment that is to be the parent of the newly created comment.


definitionId 


A string containing the definition identifier for the comment you want to create.


inputDataAsXML 


An XML string whose elements are used to create the new comment.


creator 


A string containing the username of the person who created the reply in the Forum installation.


creationDate 


A Calendar Java object containing the date that the reply was created in the Forum installation.


modifier 


A string containing the username of the person who last modified the reply in the Forum 
installation.


modificationDate 


A Calendar Java object that contains the date that the reply was last modified in the Forum 
installation.


return_value 


The identifier of the newly created comment.

154 Novell Vibe 3.2 Developer Guide







See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)


 migration_addReply (page 153)
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migration_uploadFolderFile 


Uploads an entry attachment, allowing preservation of SiteScape Forum data. 


Syntax


public void migration_uploadFolderFile( String accessToken, long binderId, long entryId,         String 
formDataItemName, String fileName, String modifier, Calendar modificationDate );


Description


The migration_uploadFolderFile operation attaches a file to an entry, allowing you to preserve 
data from the attachment as it last appeared in a SiteScape Forum installation. You can attach only 
one file at a time; call this operation multiple times to attach more than one file to the entry.


Because moving files across the Internet can be time-consuming, you can create attachments from 
Forum files that have already been copied to a staging area on the Vibe server by using the 
migration_uploadFolderFileStaged operation.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binderId 


The identifier of the folder containing the entry to which you want to attach a file.


entryId 


The identifier of the entry to which you want to attach a file.


formDataItemName 


A string containing the internal identifier for the part of the entry that contains attached files. 
This identifier maps the name attribute of an input HTML tag on a form to data in the Vibe 
database; a hidden HTML tag communicates this file mapping to the server.


The name value for the standard entry element containing attached files is ss_attachFile. If 
you want to upload a file into a custom form element you defined by using the designers, you 
need to look up the name identifier for that form element. 


If you are uploading to a folder file, specify upload as an argument to this parameter to make 
this attachment the primary file for the entry.


fileName 


A string containing the name of the file you want to upload.


modifier 


A string containing the username of the last person in the Forum installation to modify the file.


modificationDate 


A Calendar Java object containing the date that the file was last modified in the Forum 
installation.
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return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)


 migration_uploadFolderFileStaged (page 158)
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migration_uploadFolderFileStaged 


Uploads a local copy of an entry attachment, allowing preservation of SiteScape Forum data. 


Syntax


public void migration_uploadFolderFileStaged( String accessToken, long binderId, long entryId, String 
formDataItemName, String fileName, String stagedFileRelativePath, String modifier, Calendar 
modificationDate );


Description


The migration_uploadFolderFileStaged operation accesses a file that has been copied locally to 
the Vibe server as a way to streamline the transfer of files, avoiding transferring them over the 
Internet. The operation then attaches the file to a folder entry in Vibe.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binderId 


The identifier of the binder containing the entry to which you want to attach a file.


entryId 


The identifier of the entry to which you want to attach a file.


formDataItemName 


A string containing the internal identifier for the part of the entry that contains attached files. 
This identifier maps the name attribute of an input HTML tag on a form to data in the Vibe 
database; a hidden HTML tag communicates this file mapping to the server.


The name value for the standard entry element containing attached files is ss_attachFile. If 
you want to upload a file into a custom form element you defined by using the designers, you 
need to look up the name identifier for that form element. 


If you are uploading to a folder file, specify upload as an argument to this parameter to make 
this attachment the primary file for the entry.


fileName 


A string containing the name of the file you want to attach to an entry.


stagedFileRelativePath 


A pathname of the file relative to the staging area on the server side. On the Vibe server, the 
staging directory is designated by the value of the staging.upload.files.rootpath 
configuration setting. This relative pathname is resolved against the staging directory of the 
Vibe server to identify the input file.


Although the files can be present in any folder structure within the staging area, one streamlined 
way to approach this task is to unzip the Forum hidden directory into the staging area. Then, use 
this parameter to specify the relative path through the hidden folder structure to the location of 
the file to be attached to the entry in Vibe.
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modifier 


A string containing the username of the person who last modified the file in the Forum 
installation.


modificationDate 


A Calendar Java object that contains the date that the file was last modified in the Forum 
installation.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)


 migration_uploadFolderFile (page 156)
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profile_addGroup 


Adds a group.


Syntax


public long profile_addGroup( String accessToken, Group group );


Description


The profile_addGroup operation adds a new group to Vibe. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


group 


A Group Java object containing information needed to create the new group in Vibe.


return_value 


The identifier of the newly created group.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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profile_addGroupMember 


Adds a user to a group.


Syntax


public void profile_addGroupMember( String accessToken, String groupName, String userName );


Description


The profile_addGroupMember operation adds a user to a group. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


groupName 


A string containing the name of the group.


userName 


A string containing the name of the user to be added to the group.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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profile_addUser 


Adds a user profile. 


Syntax


public long profile_addUser( String accessToken, User user );


Description


The profile_addUser operation adds a profile for a new Vibe user. 


After you add a user profile, you can add a user workspace for the new user by using the 
profile_addUserWorkspace operation.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


user 


A User Java object containing the information needed to create a new user.


return_value 


The identifier of the newly created user.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)


 profile_addUserWorkspace (page 163)
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profile_addUserWorkspace 


Adds a user workspace for an existing user. 


Syntax


public long profile_addUserWorkspace( String accessToken, long userId );


Description


The profile_addUserWorkspace operation adds a user workspace for an existing user.


To create a new user before using this operation, use the profile_addUser operation, which creates 
a profile for a new user. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


userId 


The identifier of the user for whom you want to create a user workspace.


return_value 


The binder identifier of the newly created user workspace.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)


 profile_addUser (page 162)
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profile_deletePrincipal 


Removes a group or user. 


Syntax


public void profile_deletePrincipal( String accessToken, long principalId,                                   boolean 
deleteWorkspace );


Description


The profile_deletePrincipal operation removes a group or user. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


principalId 


The identifier of the group or user you want to delete.


deleteWorkspace 


When you delete a user, this Boolean value indicates whether Vibe should delete the 
corresponding user workspace.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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profile_getFileVersions


Returns information about the versions of a file. 


Syntax


public void profile_getFileVersions( String accessToken, long principalId, string fileName );


Description


The profile_getFileVersions operation retrieves information about the versions of a file 
associated with a user or group.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


principalId 


The identifier for the principal (a user or group).


fileName 


The filename of the file you want to retrieve version information about.


return_value 


A File Version Java object containing information about the file versions.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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profile_getGroup 


Accepts a group identifier to obtain the title and the description of the group. 


Syntax


public Group profile_getGroup( String accessToken, long groupId, boolean includeAttachments );


Description


The profile_getGroup operation obtains the title and the description of the group. 


If you want to get information about the members of a group, use the profile_getGroupMembers 
operation.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


groupId 


The identifier of the group about which you want information.


includeAttachments 


A Boolean value that indicates whether you want files that are attached to the group.


By default, you cannot attach files to a group. However, a site administrator can use the 
designers in the UI to customize a group to be able to include files.


return_value 


A Group Java object containing information about all of the group members.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)


 profile_getGroupByName (page 167)


 profile_getGroupMembers (page 168)
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profile_getGroupByName 


Accepts a group name to obtain the title and the description of the group.


Syntax


public Group profile_getGroupByName( String accessToken, String groupName,                    boolean 
includeAttachments )


Description


The profile_getGroupByName operation obtains the title and the description of a group. 


If you want to get information about the members of a group, use the profile_getGroupMembers 
operation.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


groupName 


A string containing the name of the group.


includeAttachments 


A Boolean value that indicates whether you want files attached to the group.


By default, you cannot attach files to a group. However, a site administrator can use the 
designers in the UI to customize a group to be able to include files.


return_value 


A Group Java object containing information about all of the group members.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)


 profile_getGroup (page 166)


 profile_getGroupMembers (page 168)
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profile_getGroupMembers 


Obtains information about the members of a group.


Syntax


public PrincipalCollection profile_getGroupMembers( String accessToken, String groupName );


Description


The profile_getGroupMembers operation obtains information about members of a group. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


groupName 


A string containing the name of the group whose members you want information about.


return_value 


A PrincipalCollection Java object containing information about the members of the specified 
group.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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profile_getPrincipals 


Gets information for users and groups in the installation. 


Syntax


public PrincipalCollection profile_getPrincipals( String accessToken, int firstRecord,                       int 
maxRecords );


Description


The profile_getPrincipals operation gets information for users and groups in the installation. 
Because the set of information is potentially very large, you can use successive calls to this operation 
to receive manageable subsets of information for each call. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


firstRecord 


The number of the record (information about one user or group) to begin returning. Use this 
parameter to page the returned list of principals.


The number of the first record 0. 


maxRecords 


The largest number of records you want returned in this call. For an unlimited number specify -
1.


return_value 


A PrincipalCollection Java objection containing information about the set of users and groups 
you requested.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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profile_getUser 


Accepts a user identifier to get information about a user. 


Syntax


public User profile_getUser( String accessToken, long userId, boolean includeAttachments );


Description


The profile_getUser operation accepts a user identifier and returns information about a Vibe user. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


userId 


The identifier of the user about whom you want information.


includeAttachments 


A Boolean value that specifies whether Vibe should return attachments to the user’s profile.


By default, the only attached files are the users’ pictures. However, the site administrator can 
customize the profile to include other files by using the designer tools in the UI.


return_value 


A User Java object that contains information about the requested user.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)


 profile_getUserByName (page 171)

170 Novell Vibe 3.2 Developer Guide







profile_getUserByName 


Accepts a username to get information about a user. 


Syntax


public User profile_getUserByName( String accessToken, String userName,                              boolean 
includeAttachments );


Description


The profile_getUserByName operation accepts a username as a parameter and returns information 
about a Vibe user.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


userName 


A string containing the username of the user for whom you want information.


includeAttachments 


A Boolean value that indicates whether Vibe should return attached files.


By default, the only attached files are the users’ pictures. However, the site administrator can 
customize the profile to include other files by using the designer tools in the UI.


return_value 


A User Java object containing information about the requested user.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)


 profile_getUser (page 170)
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profile_getUsers


Obtains information for users in the installation. 


Syntax


public UserCollection profile_getUsers( String accessToken, boolean captive, int firstRecord, int 
maxRecords );


Description


The profile_getUsers operation gets information for users in the installation. Because the set of 
information is potentially very large, you can use successive calls to this operation to receive 
manageable subsets of information for each call. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


captive 


Set this to true if you want the permalink URL returned for each user workspace to represent 
captive mode. When a user workspace is viewed in captive mode, the master heading and the 
sidebar are removed from the display, which allows the page to fit better in a small screen. The 
default is false. 


firstRecord 


The number of the record to begin returning. Use this parameter to page the returned list of 
users.


The number of the first record is 0.


maxRecord 


The largest number of records you want to return in this call. Specify -1 for unlimited.


return_value 


A UserCollection Java object that contains information about the entries contained within the 
folder.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)


 profile_getUserByName (page 171)
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profile_getUserTeams


Obtains information about all teams that the specified user is a member of.


Syntax


public TeamCollection search_getUserTeams( String accessToken, long userId );


Description


The search_getUsersTeams operation obtains information about all teams that the user is a member 
of. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


userId 


The identifier of the user about whom you want information. 


return_value 


A UserCollection Java object that contains information about the entries contained within the 
folder.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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profile_modifyGroup 


Modifies a group.


Syntax


public void profile_modifyGroup( String accessToken, Group group );


Description


The profile_modifyGroup operation modifies information associated with a group. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


group 


A Group Java object containing modified information about a group.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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profile_modifyUser 


Modifies a user. 


Syntax


public void profile_modifyUser( String accessToken, User user );


Description


The profile_modifyUser operation modifies information associated with a user. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


user 


A User Java object containing modified information about a user.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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profile_removeFile 


Removes a file from the user profile. 


Syntax


public void profile_removeFile( String accessToken, long principalId, String fileName );


Description


The profile_removeFile operation removes a file from a user profile. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


principalId 


The identifier for the principal (by default, a user) from which you want to remove a file.


By default, only user profiles contain files. However, it is possible for site administrators to 
customize groups by using the designer tools in the UI.


fileName 


A string containing the name of the file you want to remove.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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profile_removeGroupMember 


Removes a user from a group. 


Syntax


public void profile_removeGroupMember( String accessToken, String groupName,                    String 
userName );


Description


The profile_removeGroupMember operation removes a user from membership in a group. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


groupName 


A string containing the name of the group from which you want to remove a member.


userName 


A string containing the name of the user you want to remove from the specified group.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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profile_uploadFile


Uploads a file as an attachment to a user or group. 


Syntax


public void profile_uploadFile( String accessToken,  long principalID, String formDataItemName, String 
fileName );


Description


The profile_uploadFile operation performs an action similar to using the user interface to upload 
a picture to user profiles. Files are attached one at a time; call this operation multiple times to attach 
more than one file to the binder.


By default, only user profiles contain files. However, it is possible for site administrators to customize 
groups by using the designer tools in the user interface,


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


principalId 


The identifier for the user or group to which you want to attach a file.


formDataItemName 


A string containing the internal identifier for the part of the principal entry that contains 
attached files. This identifier maps the name attribute of an input HTML tag on a form to data 
in the Vibe database; a hidden HTML tag communicates this file mapping to the server.


The name value for the standard entry element containing attached files is ss_attachFile. To 
upload a file into the custom forms element you defined by using the designer, you need to look 
up the name identifier for that form element.


To upload a picture for a user profile, specify picture as an argument to this parameter to make 
this attachment one of the pictures associated with the user profile.


fileName 


A string containing the filename of the file you want to upload to the principal.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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search_getFolderEntries


Obtains information about the entries that match the specified search query.


Syntax


public String search_getFolderEntries( String accessToken, String query, int offset, int maxResults ); 


Description


The search_getFolderEntries operation obtains information about the entries matching the 
specified search query. Because the list of each result can be lengthy, this operation lets you make 
multiple calls, receiving a subset of the search results each time.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


query 


A search query represented in XML.


offset 


An integer indicating at which result you want to begin receiving information. The first result is 
numbered 0.


maxResults 


An integer indicating the number of results you want returned. The value of -1 indicates 
unlimited.


return_value 


A FolderEntryCollection Java object containing information about the entries contained within 
the folder.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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search_getTeams 


Obtains information about the teams that the calling user is a member of. 


Syntax


public TeamCollection search_getTeams( String accessToken );


Description


The search_getTeams operation obtains information about the teams that the calling member is a 
user of. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


return_value 


A TeamCollection Java object that contains information about the teams that the calling user is a 
member of.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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search_getWorkspaceTreeAsXML 


Obtains information needed to construct the Vibe workspace and folder tree. 


Syntax


public String search_getWorkspaceTreeAsXML( String accessToken, long binderId, int levels, String 
page );


Description


The search_getWorkspaceTreeAsXML operation obtains information needed to construct the Vibe 
workspace and folder tree. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


binderId 


The identifier of the binder whose descendants you want to include in the workspace and folder 
tree information.


The top workspace in the Vibe tree has a binder identifier of 1.


levels 


The number of hierarchical levels down from the node specified by binderId that you want to 
include in the returned information. The value -1 indicates that you want all subsequent levels.


page 


A parameter used to expand pages of binders. When you specify a valid page identifier, Vibe 
expands the page by the number of levels indicated in the levels parameter. 


If you do not want to use this call expand pages, pass null as this parameter.


See Section 1.7.6, “Binder Pages and search_getWorkspaceTreeAsXML,” on page 21 for more 
detailed information about working with pages.


return_value 


A string containing XML elements needed to construct each node within the requested levels of 
the workspace hierarchy.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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search_search 


Returns XML for results of a search query.


Syntax


public String search_search( String accessToken, String query, int offset, int maxResults );


Description


The search_search operation returns XML for the results of a search query represented in XML. 
Because the list of each results can be lengthy, this operation is designed so that you can make 
multiple calls, receiving a subset of the search results each time.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


query 


A search query represented in XML.


offset 


An integer indicating at which result you want to begin receiving information. The first result is 
numbered 0.


maxResults 


An integer indicating the number of results you want returned.


return_value 


A string of XML containing information about the search results that match your specified 
criteria.


Example


The following input query string in XML matches all users whose first name begins with the letter J 
or the last name is Smith.
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<QUERY>
     <AND>
          <FIELD fieldname="_entityType" exactphrase="true">
               <TERMS>user</TERMS>
          </FIELD>
          <FIELD fieldname="_docType" exactphrase="true">
               <TERMS>entry</TERMS>
          </FIELD>
          <OR>
               <FIELD fieldname="lastName" exactphrase="true">
                    <TERMS>Smith</TERMS>
               </FIELD>
               <FIELD fieldname="firstName" exactphrase="false">
                    <TERMS>J*</TERMS>
               </FIELD>
          </OR>
     </AND>
</QUERY>


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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template_addBinder 


Adds a fully configured workspace or folder to the workspace hierarchy.


Syntax


public long template_addBinder( String accessToken, long parentId, long binderConfigId, String title );


Description


The template_addBinder operation adds a fully configured workspace or folder to the workspace 
hierarchy. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


parentId 


The identifier of the workspace or folder that is to contain the new binder.


binderConfigId 


The identifier that maps to the default configuration for the folder you want to create.


You can use the template_getTemplates information to get a configuration identifier from a 
binder that has a configuration you want for your new binder. Or, you can get a binder 
configuration identifier from the Vibe user interface. See Section 1.7.2, “Adding Folders and the 
Binder Configuration Identifier,” on page 18, for information about getting a configuration 
identifier from the user interface.


title 


A string containing the title of the new binder.


return_value 


The binder identifier of the newly created workspace or folder.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)


 template_getTemplates (page 185)
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template_getTemplates 


Obtains information about all defined templates in the installation.  


Syntax


public TemplateCollection template_getTemplates( String accessToken );


Description


The template_getTemplates operation obtains information about all defined templates in the 
installation. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


return_value 


A TemplateCollection Java object that contains information about all templates in the 
installation.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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zone_addZone 


Adds a zone to the installation. 


Syntax


public Long zone_addZone( String accessToken, String zoneName, String virtualHost,              String 
mailDomain );


Description


The zone_addZone operation adds a zone to the installation. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


zoneName 


A string containing the name of the new zone.


virtualHost 


A string specifying the virtual host. (See the installation guide for more information.)


mailDomain 


This parameter is not used.


return_value 


The zone identifier, which is the binder identifier of the top workspace in the new zone.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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zone_deleteZone 


Deletes a zone.


Syntax


public void zone_deleteZone( String accessToken, String zoneName );


Description


The zone_deleteZone operation deletes a zone. 


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


zoneName 


A string containing the name of the zone you want to delete.


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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zone_modifyZone 


Modifies a zone. 


Syntax


public void zone_modifyZone( String accessToken, String zoneName, String virtualHost,          String 
mailDomain );


Description


The zone_modifyZone operation changes a zone’s virtual host specification.


Parameters and Return Value


accessToken 


Either the security token passed to your application by Vibe as part of implementing a remote 
application, or the null value.


zoneName 


A string containing the name of the new zone.


virtualHost 


A string specifying the virtual host. (See the installation guide for more information.)


mailDomain 


This parameter is not used


return_value 


None.


See Also


 Java objects in the Vibe sources (see Section 1.7.1, “Working with Java Objects,” on page 17)
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B BDeprecated Web Services 
Operations 


This topic provides alphabetized reference pages for deprecated Web services operations provided 
by Novell Teaming. 


NOTE: Novell recommends that you do not use these Web services operations in new applications. 
Instead, use the operations documented in Appendix A, “Web Services Operations,” on page 71. 
Novell continues to support the operations in this appendix for backward compatibility for 
applications written to interoperate with Teaming 1.0.3 or earlier.


The following are conventions used in this reference section:


NOTE: All examples in this reference section use Apache Axis run-time library methods that specify 
Web service operations and their argument lists. If you are not using Apache Axis, map the Apache 
methods to those you are using to implement your Web service calls.


The search operation is under development and subject to change or deletion at any time. Do not use 
this operation in your client applications.


What you see What it means


Click the Add a team workspace button.


Click the Getting Started link.


Items that are clickable on the page, programming 
variables, or syntax parameters are presented in italic 
font.


Blog summary - Provides a....


Note: Remember that....


Defined terms in a list, note headers, section headers 
on a reference page, and list items on a reference 
page are presented in bold font.


Type status, then press Enter.


Open the ManagerGuide.pdf file.


Use the open_db routine with its lock parameter.


Text that you must type, file names, commands, 
command options, routines, Web services messages, 
and parameters are presented in Courier font when 
occurring in a body of text.


[page] Optional syntax parameters are enclosed in brackets ([ 
]).


..., paramSyntax1  |  paramSyntax2,... Required parameters that accept two or more optional 
syntaxes are separated by the vertical-line character.


(V1—V1.0.3) The versions of Teaming that support the Web 
services operation (“all versions between Version 1.0 
through Version 1.0.3”)
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Web service operations contained in this reference section are used by this Windows based client: /
ssf/samples/wsclient/facade-client.bat. With the exception of uploadCalendarEntries, use 
the same parameters for the batch-file command that you use for the corresponding Web service 
message.


The following table maps the facade-client.bat command name to its corresponding, linked Web 
services message, which is documented in this reference section:


facade-client.bat command Web services message


addEntry addFolderEntry


addFolder addFolder


addReply addReply


[none] addUserWorkspace


indexBinder indexFolder


listDefinitions getDefinitionListAsXML


migrateBinder migrateBinder


migrateEntry migrateFolderEntry


migrateReply migrateReply


migrateFile migrateFolderFile


migrateFileStaged migrateFolderFileStaged


migrateWorkflow migrateEntryWorkflow


modifyEntry modifyFolderEntry


printAllPrincipals getAllPrincipalsAsXML


printDefinition getDefinitionAsXML


printDefinitionConfig getDefinitionConfigAsXML


printFolderEntry getFolderEntryAsXML


printFolderEntries getFolderEntryAsXML


printPrincipal getPrincipalAsXML


printTeamMembers getTeamMembersAsXML


printTeams getTeamsAsXML


printWorkspaceTree getWorkspaceTreeAsXML


setDefinitions setDefinitions


setFunctionMembership setFunctionMembership


setFunctionMembershipInherited setFunctionMembershipInherited


setOwner setOwner


setTeamMembers setTeamMembers


synchronize synchronizeMirroredFolder
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uploadCalendar uploadCalendarEntries


uploadFile uploadFolderFile


facade-client.bat command Web services message
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addFolder


Adds a folder to the workspace-tree hierarchy. (V1—V1.0.3)


Syntax


public long addFolder( long parentBinderId, long binderConfigId, String title );


Description


The addFolder operation adds a folder to the workspace and folder hierarchy. 


Parameters and Return Value


parentBinderId 


The identifier of the workspace or folder that is to contain the new folder.


binderConfigId 


The identifier that maps to the default configuration for the folder you want to create.


title 


A string providing a title for the new entry.


return_value 


The binder identifier of the newly created folder.


Example


call.setOperationName(new QName(“addFolder”));                                                                         Object 
result = call.invoke(new Object[] {new Long(21), new Long(146), new String(“My new 
folder”)}); 


This code creates a new to the container whose binder identifier is 21, gives the folder a 
configuration identifier of 146 (on our test installation, this corresponds to a discussion folder), 
and establishes the title of the new folder as My new folder. The container whose binder identifier 
is 21 can be either a workspace or folder.


See Also


 The operation table for the Windows based facade-client.bat program (Appendix B, 
“Deprecated Web Services Operations,” on page 189)


 Section 1.7.1, “Working with Java Objects,” on page 17
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addFolderEntry


Adds an entry to a folder. (V1—V1.0.3)


Syntax


public long addFolderEntry( long folderId, String definitionId, String inputDataAsXML,            String 
attachedFileName  |  null );


Description


The addFolderEntry operation adds an entry to a folder. 


Parameters and Return Value


folderId 


The binder identifier of the folder that is to contain the new entry.


definitionId 


The 32-character, hexadecimal identifier that maps to the type of entry to be created (for 
example, some default entry types are topic, file, blog, wiki, and calendar).


The easiest way to work with definition identifiers for entries is to specify null for this value. 
When you specify null, Teaming automatically applies the definition identifier for the default 
entry type of the folder in which you are creating a new entry. For example, by default, you want 
to create an entry in a blog folder. If you pass null as the definition identifier, Teaming 
automatically applies the definition identifier for a blog entry.


As another option, you can use the getDefinitionConfigAsXML operation to get information 
about all definitions. Then, you can parse the XML string for the definition identifier of the type 
of entry you want. 


inputDataAsXML 


A string of XML containing the values needed to create an entry of your desired type.


Use the Teaming UI to create a complete entry of the type you want this Web services operation 
to create, note the entry identifier, and then use the getFolderEntryAsXML operation to return 
XML for the entry. Then, use the returned XML as a template for this parameter.


attachedFileName 


The name of the file you wish to attach to the new entry. This is an optional parameter. The file 
must be located in the directory in which the client code executes.


return_value 


The entry identifier for the newly created entry.
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Examples


call.setOperationName(new QName(“addFolderEntry”));                                                                         
Object result = call.invoke(new Object[] {new Long(21), new 


String(“402883b90cc53079010cc539bf260002“), s, filename}, filename); 


This code creates a new entry in the folder whose binder identifier is 21; the specified entry-
definition identifier maps to a discussion topic. The variable s contains XML elements needed by 
Teaming to create the entry. The new entry includes the attached file whose filename is specified 
by the value of the filename variable. 


call.setOperationName(new QName(“addFolderEntry”));                                                                         
Object result = call.invoke(new Object[] {new Long(21), new 


String(“402883b90cc53079010cc539bf260002“), s, null}); 


This code produces the same effect as the last example, except that it does not attach a file.


See Also


 The operation table for the Windows based facade-client.bat program (Appendix B, 
“Deprecated Web Services Operations,” on page 189)


 getFolderEntryAsXML (page 203)


 getDefinitionConfigAsXML (page 200)
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addReply


Adds a new comment to an entry or comment. (V1.0.3)


Syntax


public long addReply( long folderId, long parentEntryId, String definitionId,                                String 
inputDataAsXML, String attachedFileName | null );


Description


The addReply operation adds a new comment to an entry or to an existing comment. 


Parameters and Return Value


folderId 


The binder identifier of the folder containing the entry or comment to which you want to apply 
the new comment.


parentEntryId 


The entry identifier for the entry or comment to which you want to apply the comment.


definitionId 


The 32-character, hexadecimal identifier that maps to the type of comment to be created.


You can use the getDefinitionListAsXML operation to get metadata for all definitions. Then, 
you can parse the XML string for the definition identifier of the type of comment you want. 


inputDataAsXML 


A string of XML containing the values needed to create a comment of your desired type. 


Use the Teaming UI to create a complete comment of the type you want this Web services 
operation to create, note the entry identifier, and then use the getFolderEntryAsXML operation 
to return XML for the entry. Then, use the returned XML as a template for this parameter. 


attachedFileName 


The name of the file you wish to attach to the new comment. This is an optional parameter. The 
file must be located in the directory in which the client code executes.


return_value 


The entry identifier of the newly created comment.


Example


call.setOperationName(new QName(“addReply”));                                                                         Object 
result = call.invoke(new Object[] {new Long(21), new Long(45), null, s, null}); 


This code creates a new comment in the folder whose binder identifier is 21, and applies it to the 
entry or comment whose entry identifier is 45. The first null value instructs Teaming to use the 
default comment type for the folder. The variable s contains XML elements needed by Teaming 
to create the comment. Because of the final null value, the new comment does not include an 
attached file. 
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See Also


 The operation table for the Windows based facade-client.bat program (Appendix B, 
“Deprecated Web Services Operations,” on page 189)


 getFolderEntryAsXML (page 203)


 getDefinitionListAsXML (page 201)
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addUserWorkspace


Adds a new personal workspace. (V1.0.3)


Syntax


public long addUserWorkspace ( long userId );


Description


The addUserWorkspace operation adds a new personal workspace to the workspace hierarchy. 


The primary purpose of this operation is to assist with migrating data from SiteScape Forum to 
Teaming. By default using Teaming, the creation of the personal workspace occurs when someone 
first uses the portal software to sign in with a username and password. If you want to migrate Forum 
information as sub-content to a personal workspace in Teaming, use this operation before creating 
the sub-content.


Parameters and Return Value


userId 


The identifier for the user for whom you want to create the personal workspace


return_value 


The binder identifier of the newly created personal workspace.


Example


call.setOperationName(new QName(“addUserWorkspace”));                                                                         
Object result = call.invoke(new Object[] {new Long(21)}); 


This code creates a new personal workspace. 
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getAllPrincipalsAsXML


Returns summary information for users and groups. (V1—V1.0.3)


Syntax


public String getAllPrincipalsAsXML( int firstRecord, int maxRecords );


Description


The getAllPrincipalsAsXML operation returns XML elements that provide summary information 
about registered users and defined groups. You can use this operation to identify a particular user by 
name or other data, obtain an identifier for a particular user, and then use the getPrincipalAsXML 
operation to gather a finer level of information about that person.


Parameters and Return Value


firstRecord 


The index of the first record whose user or group information you want to obtain. The index for 
the first principal in the system is 1.


maxRecords 


The maximum number of user and group records whose information should be returned. 


You can use the previous parameter and this parameter in subsequent calls to 
getAllPrincipalsAsXML to process data for sets of users and groups at a time (for example, 50 
at a time, or 100 at a time).


return_value 


A string containing the XML elements providing information about the requested set of users 
and groups.


Example


call.setOperationName(new QName(“getAllPrincipalsAsXML”));                                                                         
Object result = call.invoke(new Object[] {new Integer(100), new Integer(50)}); 


This code requests information for users and groups starting with the record number 100 and 
including up to 50 records.


See Also


 The operation table for the Windows based facade-client.bat program (Appendix B, 
“Deprecated Web Services Operations,” on page 189)


 getAllPrincipalsAsXML (page 198)
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getDefinitionAsXML


Returns information about one definition. (V1—V1.0.3)


Syntax


public String getDefinitionAsXML( String definitionId );


Description


The getDefinitionAsXML operation returns an XML string containing information about one 
definition. You work with definitions using the designers in the administration UI.


For example, if you pass one of the definition identifiers for an entry type listed in the 
addFolderEntry reference page, Teaming returns information about the definition for that entry.


As an alternative, you can use the getDefinitionConfigAsXML operation to obtain all definitions in 
Teaming and then parse the larger string for the definition information you want.


Parameter and Return Value


definitionId 


The identifier of the definition whose information you want. Definitions are maintained using 
the designers in the administration UI, and define the components of an object in Teaming.


return_value 


A string of XML whose elements provide information about the components of an object in 
Teaming.


Example


call.setOperationName(new QName("getDefinitionAsXML"));                                                                         
Object result = call.invoke(new Object[] {new 


String("402883b9114739b301114754e8120008")}); 


This code requests XML-formatted information about the definition for a wiki entry.


See Also


 The operation table for the Windows based facade-client.bat program (Appendix B, 
“Deprecated Web Services Operations,” on page 189)


 addFolderEntry (page 193)


 getDefinitionConfigAsXML (page 200)
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getDefinitionConfigAsXML


Returns information about all configuration definitions. (V1—V1.0.3)


Syntax


public String getDefinitionConfigAsXML( );


Description


The getDefinitionConfigAsXML operation returns information about all configuration definitions. 
The configuration information does not include workflow or template definitions. You can uses the 
returned information to extract the definition identifier for a given entry type to use in a subsequent 
call to addFolderEntry.


Return Value


return_value 


A string of XML whose elements describe all configuration definitions.


Example


call.setOperationName(new QName(“getDefinitionConfigAsXML”));                                                                         
Object result = call.invoke(); 


This code obtains information about all configuration settings.


See Also


 The operation table for the Windows based facade-client.bat program (Appendix B, 
“Deprecated Web Services Operations,” on page 189)


 addFolderEntry (page 193)
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getDefinitionListAsXML


Returns metadata for all definitions in the installation. (V1.0.3)


Syntax


public String getDefinitionListAsXML ();


Description


The getDefinitionListAsXML operation returns metadata for all definitions in the installation. This 
metadata includes information such as the definition name and identifier. 


When using other Web services operations that require a definition identifier, you can use this 
message, parse the XML for the name (discussion, blog, calendar, comment), and obtain the 32-
character, hexadecimal identifier that maps to the desired object.


Return Value


return_value 


A string of XML whose elements contain metadata for all definitions in the installation.


Example


call.setOperationName(new QName(“getDefinitionListAsXML”));                                                                         
Object result = call.invoke(); 


This code obtains metadata for all definitions in the installation. 


See Also


 The operation table for the Windows based facade-client.bat program (Appendix B, 
“Deprecated Web Services Operations,” on page 189)
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getFolderEntriesAsXML


Returns a string containing XML providing summary information about entries in a folder.       (V1—
V1.0.3)


Syntax


public String getFolderEntriesAsXML( long folderId );


Description


The getFolderEntriesAsXML operation returns XML elements containing summary information 
about each entry in the specified folder. 


Parameter and Return Value


folderId 


The binder identifier of the folder containing the entries for which you want information.


return_value 


A string containing XML elements containing summary information for each entry in the folder 
specified by folderId.


Example


call.setOperationName(new QName(“getFolderEntriesAsXML”));                                                                         
Object result = call.invoke(new Object[] {new Long(21)}); 


This code returns a string containing XML information for all of the entries in the folder whose 
binder identifier is 21.


See Also


 The operation table for the Windows based facade-client.bat program (Appendix B, 
“Deprecated Web Services Operations,” on page 189)
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getFolderEntryAsXML


Returns information about one entry in a folder. (V1—V1.0.3)


Syntax


public String getFolderEntryAsXML( long folderId, long entryId, boolean includeAttachments );


Description


The getFolderEntryAsXML operation returns XML whose elements provide information about one 
entry in a folder. 


Parameters and Return Value


folderId 


The binder identifier of the folder containing the entry whose information you want.


entryId 


The identifier of the entry whose information you want.


includeAttachments 


A boolean value that indicates whether you want Teaming to return the entry’s attachments. The 
client program is responsible for placement of attachment files on its local system.


return_value 


A string containing XML elements for the requested entry.


Example


call.setOperationName(new QName(“getFolderEntryAsXML”));                                                                         
Object result = call.invoke(new Object[] {new Long(21), new Long(34), new 


Boolean.FALSE}); 


This code returns XML that includes information contained in entry number 34 in the folder 
whose identifier is 21. Because of the value of the last parameter, Teaming does not place the 
entry’s file attachments in the client program’s source directory.


See Also


 The operation table for the Windows based facade-client.bat program (Appendix B, 
“Deprecated Web Services Operations,” on page 189)


 Section 1.7.4, “Fetching Attachments,” on page 20
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getPrincipalAsXML


Returns information about one user or group. (V1—V1.0.3)


Syntax


public String getPrincipalAsXML( long binderId, long principalId );


Description


The getPrincipalAsXML operation returns XML whose elements provide information about one 
registered user or defined group. 


Parameters and Return Value


binderId 


The binder identifier of the principal’s parent workspace. The information returned by 
getAllPrincipalsAsXML includes the binder number of this containing workspace.


principalId 


The identifier that maps to the user or group for which you want to gather information.


return_value 


A string containing XML elements whose elements provide information about the specified user 
or group.


Example


call.setOperationName(new QName(“getPrincipalAsXML”));                                                                         
Object result = call.invoke(new Object[] {new Long(2), new Long(25)}); 


This code returns information about a user or group, whose parent workspace has a binder 
identifier of 2 and whose principal identifier is 25. 


See Also


 The operation table for the Windows based facade-client.bat program (Appendix B, 
“Deprecated Web Services Operations,” on page 189)


 getAllPrincipalsAsXML (page 198)
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getTeamMembersAsXML


Returns information about all team members assigned within a workspace or folder. (V1—V1.0.3)


Syntax


public String getTeamMembersAsXML( long binderId );


Description


The getTeamMembersAsXML operation returns XML that names members of a team assigned within 
the specified workspace or folder. 


Parameter and Return Value


binderId 


The binder identifier of the workspace or folder for which you want information about team 
members. The getTeamsAsXML operation returns information about all workspaces and folders 
that have assigned teams.


return_value 


A string containing XML elements describing team members for the specified place.


Example


call.setOperationName(new QName(“getTeamMembersAsXML”));                                                                         
Object result = call.invoke(new Object[] {new Long(23)); 


This code returns an XML string whose elements describe all of the team members assigned in 
the workspace or folder associated with the binder identifier of 23. 


See Also


 The operation table for the Windows based facade-client.bat program (Appendix B, 
“Deprecated Web Services Operations,” on page 189)


 getTeamsAsXML (page 206)
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getTeamsAsXML


Returns information about all workspaces and folders that have assigned teams. (V1—V1.0.3)


Syntax


public String getTeamsAsXML( );


Description


The getTeamsAsXML operation returns an XML string providing information about all workspaces 
and folders that have assigned teams. You can use this operation to obtain the list of places that have 
assigned teams, note a binder number of a particular place, and then use the getTeamMembersAsXML 
operation to obtain the list of team members for that place. 


Return Value


return_value 


An XML string whose elements describe workspaces and folders that have assigned teams.


Example


call.setOperationName(new QName(“getTeamsAsXML”));                                                                         
Object result = call.invoke(); 


This code returns information about all places in the Teaming installation that have assigned 
teams.


See Also


 The operation table for the Windows based facade-client.bat program (Appendix B, 
“Deprecated Web Services Operations,” on page 189)


 getTeamMembersAsXML (page 205)
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getWorkspaceTreeAsXML


Returns information needed to construct the Teaming workspace and folder tree.            (V1—V1.0.3)


Syntax


public String getWorkspaceTreeAsXML( long binderId, int levels, String page );


Description


The getWorkspaceTreeAsXML operation returns XML elements needed to construct the requested 
portion of the Teaming workspace tree. 


Parameters and Return Value


binderId 


The binder identifier of the starting node of the returned portion of the hierarchy. The top 
workspace in the Teaming tree has a binder identifier of 1.


levels 


The number of hierarchical levels down from the node specified by binderId that you want to 
include in the returned information. The value -1 indicates that you want all subsequent levels.


page 


A parameter used to expand pages of binders. When you specify a valid page identifier, 
Teaming expands the page by the levels indicated in the levels parameter. 


If you do not want to expand pages using this call, pass null as this parameter.


The Web-services overview topic contains more detailed information about working with pages 
(Section 1.7.6, “Binder Pages and search_getWorkspaceTreeAsXML,” on page 21).


return_value 


A string containing XML elements needed to construct each node within the requested levels of 
the workspace hierarchy.


Example


call.setOperationName(new QName(“getWorkspaceTreeAsXML”));                                                                         
Object result = call.invoke(new Object[] {new Long(1), new Integer(3), null}); 


This code returns a string containing XML information for the first three levels of the workspace 
hierarchy. The following depicts these levels using default workspace titles:


Level 1: Workspaces


     Level 2: Global, Personal, and Team workspaces


          Level 3: Children of Global, Personal, and Team


The children of Global workspaces, Personal workspaces, and Team workspaces can be either 
workspaces or folders. 

Deprecated Web Services Operations 207







See Also


 The operation table for the Windows based facade-client.bat program (Appendix B, 
“Deprecated Web Services Operations,” on page 189)


 Section 1.7.6, “Binder Pages and search_getWorkspaceTreeAsXML,” on page 21
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indexFolder


Indexes a folder. (V1.0.3)


Syntax


public void indexFolder( long folderId );


Description


The indexFolder operation indexes a folder.


The primary use of this operation is to index data after you migrate it from SiteScape Forum into 
Teaming. (The migration operations transfer the data but do not index it.)


Parameter


folderId 


The binder identifier of the folder you want to index.


Example


call.setOperationName(new QName(“indexFolder”));                                                                         
Object result = call.invoke(new Object[] {new Long(21)}); 


This indexes the folder whose binder identifier is 21.


See Also


 The operation table for the Windows based facade-client.bat program (Appendix B, 
“Deprecated Web Services Operations,” on page 189)
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migrateBinder


Creates a new workspace or folder while preserving SiteScape Forum data. (V1.0.3)


Syntax


public long migrateBinder ( long parentId, String definitionId, String inputDataAsXML,            String 
creator, Calendar creationDate, String modifier, Calendar modificationDate );


Description


The migrateBinder operation creates a workspace or folder in Teaming that preserves values from a 
SiteScape Forum installation (for example, the name of the person who created the item in Forum, the 
Forum creation date, the person who last modified the item in Forum, and the date of the last 
modification in Forum). 


Parameters and Return Value


parentId 


The binder identifier of the parent of the newly created workspace or folder.


definitionId 


The 32-character, hexadecimal identifier that maps to the type of workspace or folder to be 
created.


You can use the getDefinitionListAsXML operation to get metadata for all definitions. Then, 
you can parse the XML string for the definition identifier of the type of workspace or folder you 
want to create. 


inputDataAsXML 


A string of XML supplying the elements and values needed to construct the workspace or folder 
you want to create.


creator 


A string containing the username of the person who created the corresponding workspace or 
folder in the Forum installation.


creationDate 


Calendar data specifying the date when the corresponding workspace or folder was created in 
Forum.


modifier 


A string containing the username of the person who last modified the corresponding workspace 
or folder in Forum.


modificationDate 


Calendar data specifying the date when the corresponding workspace or folder was modified in 
Forum.


return_value 


The binder identifier of the newly created workspace or folder.
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Example


call.setOperationName(new QName(“migrateBinder”));                                                                         
Object result = call.invoke(new Object[] {new Long(21), def, input, new 


String("JSmith"), createcal, new String("JGarces"), modcal}); 


This code creates a new binder determined by the definition in the def variable (use the 
getDefinitionListAsXML operation to obtain the correct string for your binder type), and the 
binder will be a child of the binder whose identifier is 21. The input variable contains an XML 
string, properly formatted for your binder type, which Teaming uses to create binder content. 
The remaining four parameters provide names (literals) and dates (the createcal and modcal 
variables) for the creation and last modification of the corresponding item in the Forum 
installation.


See Also


 The operation table for the Windows based facade-client.bat program (Appendix B, 
“Deprecated Web Services Operations,” on page 189)


 getDefinitionListAsXML (page 201)
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migrateEntryWorkflow


Associates an entry with a workflow process while preserving SiteScape Forum data. (V1.0.3)


Syntax


public void migrateEntryWorkflow ( long binderId, long entryId, String definitionId,                  String 
startState, String modifier, Calendar modificationDate );


Description


The migrateEntryWorkflow operation associates a workflow process with an entry in Teaming, 
while preserving values from a SiteScape Forum installation (for example, the state to which the 
entry should be set, the person who last changed workflow state in Forum, and the date of the last 
state change in Forum). 


Parameters and Return Value


binderId 


The binder identifier of the folder that contains the entry to which you want to associate a 
workflow process.


entryId 


The entry identifier of the entry to which you want to associate a workflow process.


definitionId 


The 32-character, hexadecimal identifier that maps to the workflow-process definition.


Before using this message, you must replicate the Forum workflow processes in Teaming.


startState 


The current state of the Teaming entry (which would reflect its last state in Forum).


modifier 


A string containing the username of the person who last changed the workflow process in 
Forum.


modificationDate 


Calendar data specifying the date when the workflow process was last changed in Forum.


Example


call.setOperationName(new QName(“migrateEntryWorkflow”));                                                                         
Object result = call.invoke(new Object[] {new Long(21), new Long(45), 


String("ptoProcess"), String("PTO Request"), new String("JGarces"), modcal}); 


This code associates the ptoProcess workflow process with the entry whose identifier is 45 and 
which is located in a folder whose binder identifier is 21. The entry should be placed in the PTO 
Request state. The operation also provides the name of the person who last changed the 
workflow state in Forum and the date when that state change occurred.
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See Also


 The operation table for the Windows based facade-client.bat program (Appendix B, 
“Deprecated Web Services Operations,” on page 189)
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migrateFolderEntry


Creates a new folder entry while preserving SiteScape Forum data. (V1.0.3)


Syntax


public void migrateFolderEntry ( long binderId, String definitionId, String inputDataAsXML,          
String creator, Calendar creationDate, String modifier, Calendar modificationDate );


Description


The migrateFolderEntry operation creates a folder entry in Teaming that preserves values from a 
SiteScape Forum installation (for example, the name of the person who created the item in Forum, the 
Forum creation date, the person who last modified the item in Forum, and the date of the last 
modification in Forum).


When creating entries within a Files folder in Teaming, use this operation to create the entry, and then 
use either migrateFolderFile or migrateFolderFileStaged to attach the file to the entry.


Parameters and Return Value


binderId 


The binder identifier of the folder to contain the new entry.


definitionId 


The 32-character, hexadecimal identifier that maps to the type of entry to be created.


The easiest way to work with definition identifiers for entries is to specify null for this value. 
When you specify null, Teaming automatically applies the definition identifier for the default 
entry type of the folder in which you are creating a new entry. For example, by default, you want 
to create an entry in a blog folder. If you pass null as the definition identifier, Teaming 
automatically applies the definition identifier for a blog entry.


As another option, you can use the getDefinitionListAsXML operation to get metadata for all 
definitions. Then, you can parse the XML string for the definition identifier of the type of 
workspace or folder you want to create. 


inputDataAsXML 


A string of XML supplying the elements and values needed to construct the type of entry you 
want to create.


creator 


A string containing the username of the person who created the corresponding entry in the 
Forum installation.


creationDate 


Calendar data specifying the date when the corresponding entry was created in Forum.


modifier 


A string containing the username of the person who last modified the corresponding entry in 
Forum.
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modificationDate 


Calendar data specifying the date when the corresponding entry was modified in Forum.


return_value 


The entry identifier of the newly created entry.


Example


call.setOperationName(new QName(“migrateFolderEntry”));                                                                         
Object result = call.invoke(new Object[] {new Long(21), def, input, new 


String("JSmith"), createcal, new String("JGarces"), modcal}); 


This code creates a new entry of the type determined by the definition in the def variable (use 
the getDefinitionListAsXML operation to obtain the correct string for your entry type), and 
the new entry is to be located in the binder whose identifier is 21. The input variable contains an 
XML string, properly formatted for your entry type, which Teaming uses to create entry content. 
The remaining four parameters provide names (literals) and dates (the createcal and modcal 
variables) for the creation and last modification of the corresponding entry in the Forum 
installation.


See Also


 The operation table for the Windows based facade-client.bat program (Appendix B, 
“Deprecated Web Services Operations,” on page 189)


 getDefinitionListAsXML (page 201)


 migrateFolderEntry (page 214)


 migrateFolderFileStaged (page 218)
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migrateFolderFile


Attaches a file to an entry while preserving SiteScape Forum data. (V1.0.3)


Syntax


public void migrateFolderFile ( long binderId, long entryId, String fileUploadDataItemName, String 
filename, String modifier, Calendar modificationDate );


Description


The migrateFolderFile operation attaches a file to a folder entry in Teaming that preserves values 
from a SiteScape Forum installation (for example, the person who last modified the item in Forum, 
and the date of the last modification in Forum). 


Parameters and Return Value


binderId 


The binder identifier of the folder that contains the entry to which you want to attach a file.


entryId 


The entry identifier of the entry to which you want to attach the file.


fileUploadDataItemName 


The internal-use name used by the database to identify the file as an element of an entry.


For example, a Forum custom command allowed for uploading different files into a single entry 
that served different functions, such as an expense report, a meeting presentation, and so on. 
These custom file uploads have associated internal-use names that are different than the 
reserved internal-use name applied to standard file entries or standard attachments.


If you are migrating to a folder file, specify upload as an argument to this parameter to make 
this attachment the primary file for the entry. 


filename 


The name of the file to be attached to the entry.


modifier 


A string containing the username of the person who last modified the corresponding file in 
Forum.


modificationDate 


Calendar data specifying the date when the corresponding file was modified in Forum.
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Example


call.setOperationName(new QName(“migrateFolderFile”));                                                                         
Object result = call.invoke(new Object[] {new Long(21), new Long(45), 
String("_budgetReport"), String("budget-report.xls"), new String("JGarces"), 
modcal}); 


This code attaches the budget-report.xls file to the entry whose identifier is 45 and is located 
in a folder whose binder identifier is 21. The internal-use name that maps to the file as an 
element in the entry is _budgetReport. The operation also provides the name of the person who 
modified the file in Forum and the date when that modification occurred.


See Also


 The operation table for the Windows based facade-client.bat program (Appendix B, 
“Deprecated Web Services Operations,” on page 189)
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migrateFolderFileStaged


Locates a locally stored file, and attaches it to an entry while preserving Forum data. (V1.0.3)


Syntax


public void migrateFolderFileStaged ( long binderId, long entryId,                                                  String 
fileUploadDataItemName, String filename, String stagedFileRelativePath, String modifier, Calendar 
modificationDate );


Description


The migrateFolderFileStaged accesses a Forum file that has been copied locally on the Teaming 
server as a way to streamline the transfer of files, avoiding transferring them over the Internet. The 
operation then attaches the file to a folder entry in Teaming that preserves values from a SiteScape 
Forum installation (for example, the person who last modified the item in Forum, and the date of the 
last modification in Forum).


Parameters and Return Value


binderId 


The binder identifier of the folder that contains the entry to which you want to attach a file.


entryId 


The entry identifier of the entry to which you want to attach the file.


fileUploadDataItemName 


The internal-use name used by the database to identify the file as an element of an entry.


For example, a Forum custom command allowed for uploading different files into a single entry 
that served different functions, such as an expense report, a meeting presentation, and so on. 
These custom file uploads have associated internal-use names that are different than the 
reserved internal-use name applied to standard file entries or standard attachments.


If you are migrating to a folder file, specify upload as an argument to this parameter to make 
this attachment the primary file for the entry.


filename 


The name of the file to be attached to the entry.


stagedFileRelativePath 


The relative path specification, beginning with the staging area designated in the 
ssf.properties and ssf-ext.properties files on the Teaming server. (See the installation 
guide for more information about these files.)


Although the files can be present in any folder structure within the staging area, one streamlined 
way to approach this task is to unzip the Forum hidden directory into the staging area. Then, use 
this parameter to specify the relative path through the hidden folder structure to the location of 
the file to be attached to the entry in Teaming.


modifier 


A string containing the full name of the person who last modified the corresponding file in 
Forum.
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modificationDate 


Calendar data specifying the date when the corresponding file was modified in Forum.


Example


call.setOperationName(new QName(“migrateFolderFileStaged”));                                                                         
Object result = call.invoke(new Object[] {new Long(21), new Long(45), 
String("_budgetReport"), String("budget-report.xls"), String("hidden/ssf/
myworkspace/myforum/4567849"), new String("JGarces"), modcal}); 


To locate the file, Teaming begins with the defined staging folder and then applies the relative 
path hidden/ssf/myworkspace/myforum/456789.This code attaches the budget-report.xls 
file to the entry whose identifier is 45 and is located in a folder whose binder identifier is 21. The 
internal-use name that maps to the file as an element in the entry is _budgetReport. The 
operation also provides the name of the person who modified the file in Forum and the date 
when that modification occurred.


See Also


 The operation table for the Windows based facade-client.bat program (Appendix B, 
“Deprecated Web Services Operations,” on page 189)
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migrateReply


Creates a new comment while preserving SiteScape Forum data. (V1.0.3)


Syntax


public void migrateReply ( long binderId, long parentId, String definitionId,                                    String 
inputDataAsXML, String creator, Calendar creationDate, String modifier,                           Calendar 
modificationDate );


Description


The migrateReply operation creates a comment in Teaming that preserves values from a SiteScape 
Forum installation (for example, the name of the person who created the item in Forum, the Forum 
creation date, the person who last modified the item in Forum, and the date of the last modification 
in Forum).


Parameters and Return Value


binderId 


The binder identifier of the folder that will contain the new comment.


parentId 


The binder identifier of the entry or comment to which you want to apply the new comment.


definitionId 


The 32-character, hexadecimal identifier that maps to the type of comment to be created.


You can use the getDefinitionListAsXML operation to get metadata for all definitions. Then, 
you can parse the XML string for the definition identifier of the type of comment you want to 
create. 


inputDataAsXML 


A string of XML supplying the elements and values needed to construct the type of comment 
you want to create.


creator 


A string containing the username of the person who created the corresponding reply in the 
Forum installation.


creationDate 


Calendar data specifying the date when the corresponding reply was created in Forum.


modifier 


A string containing the username of the person who last modified the corresponding reply in 
Forum.


modificationDate 


Calendar data specifying the date when the corresponding reply was modified in Forum.


return_value 


The entry identifier of the newly created comment.
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Example


call.setOperationName(new QName(“migrateReply”));                                                                         
Object result = call.invoke(new Object[] {new Long(21), new Long(45), def, input, 


new String("JSmith"), createcal, new String("JGarces"), modcal}); 


This code creates a new comment of the type determined by the definition in the def variable 
(use the getDefinitionListAsXML operation to obtain the correct string for your comment 
type). The new comment is to be located in the binder whose identifier is 21, and applied to an 
entry or comment whose identifier is 45. The input variable contains an XML string, properly 
formatted for your comment type, that Teaming uses to create comment content. The remaining 
four parameters provide names (literals) and dates (the createcal and modcal variables) for the 
creation and last modification of the corresponding reply in the Forum installation.


See Also


 The operation table for the Windows based facade-client.bat program (Appendix B, 
“Deprecated Web Services Operations,” on page 189)
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modifyFolderEntry


Modifies a single entry. (V1—V1.0.3)


Syntax


public void modifyFolderEntry( long folderId, long entryId, String inputDataAsXML );


Description


The modifyFolderEntry operation modifies one entry in a folder. 


Parameters and Return Value


folderId 


The binder identifier of the folder that contains the entry to be modified.


entryId 


The identifier of the entry to be modified.


inputDataAsXML 


A string of XML containing the values needed to modify the entry.


return_value 


None.


Example


call.setOperationName(new QName(“modifyFolderEntry”));                                                                         
Object result = call.invoke(new Object[] {new Long(21), new Long(43), s}); 


This code modifies entry 43 in the folder whose binder ID is 21. The variable s contains XML 
elements needed by Teaming to modify the contents of the entry.   


See Also


 The operation table for the Windows based facade-client.bat program (Appendix B, 
“Deprecated Web Services Operations,” on page 189)
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setDefinitions


Establishes workflow-entry associations for a folder. (V1.0.3)


Syntax


public void migrateEntryWorkflow ( long binderId, String[] definitionIds,                                  String[] 
workflowAssociations );


Description


The setDefinitions operation uses two arrays to associate workflow identifiers with entry 
identifiers for a folder. (Teaming associates identifiers in the first element of both arrays, the second 
element of both arrays, the third, and so on.)


When an entry is associated with a workflow process, creation of an entry of that type automatically 
places the entry into the initial state of the workflow process.


NOTE: This operation is an overwrite operation, setting all workflow associations for the folder; you 
cannot use repeated calls to this operation to set associations incrementally. So, set all of the workflow 
associations for the folder with one call.


Parameters and Return Value


binderId 


The binder identifier of the folder in which you want to associate entry and workflow identifiers.


definitionIds 


An array of entry identifiers.


workflowAssociations 


An array of workflow identifiers.


Before using this message, you must replicate the Forum workflow processes in Teaming.


Example


call.setOperationName(new QName(“setDefinitions”));                                                                         
Object result = call.invoke(new Object[] {new Long(21), entries, workflows}); 


This code passes two array variables, entries and workflows. Teaming uses the corresponding 
elements in both arrays to create entry-workflow associations for the folder whose binder 
identifier is 21. 


See Also


 The operation table for the Windows based facade-client.bat program (Appendix B, 
“Deprecated Web Services Operations,” on page 189)
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setFunctionMembership


Applies access-control settings to a folder or workspace. (V1—V1.0.3)


Syntax


public void setFunctionMembership( long binderId, String inputDataAsXML );


Description


The setFunctionMembership operation provides access-control settings for folder or a workspace. 
The term function is analogous to a role in the user interface (UI).


The primary use of this operation is to establish access-control settings when migrating workspaces 
and folders from Forum to Teaming. You must ensure that you have migrated Forum user and group 
names to Teaming that are required for your access-control settings.


NOTE: This operation is an overwrite operation, setting all function memberships for the folder or 
workspace; you cannot use repeated calls to this operation to set memberships incrementally. So, set 
all memberships for the workspace or folder with one call.


Parameters and Return Value


binderId 


The binder identifier of the folder or workspace for which you want to set access control.


inputDataAsXML 


A string of XML containing the values needed to set access control. Here is an example of XML 
that sets the visitor function:


<workAreaFunctionMemberships>
<workAreaFunctionMembership>
<property name="functionName">__role.visitor</property>
<property name="memberName">jGarces</property>
<property name="memberName">sChen</property>
<property name="members">1,2,3</property>
</workAreaFunctionMembership>
   .
   .
   .
</workAreaFunctionMemberships>


To obtain the functionName value:


1. Sign in as a site administrator for Teaming.


2. In the administration portlet, click Configure role definitions.


3. Click any item (for example, Participant).


4. Note or copy the identifier in the Role Name text box (for example, __role.participant). 
This identifier begins with a double underscore ( _ ).


You can pass either user or group names (for example, jGarces or sChen) or user or group 
identifiers (for example, 1, 2, 3). Teaming reserves the identifiers -1 for the workspace or folder 
owner, and -2 for a team member.
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Example


call.setOperationName(new QName(“setFunctionMembership”));                                                                         
Object result = call.invoke(new Object[] {new Long(21), s}); 


This code uses the content of the XML string s to establish access-control settings for the folder 
or workspace whose binder identifier is 21.   


See Also


 The operation table for the Windows based facade-client.bat program (Appendix B, 
“Deprecated Web Services Operations,” on page 189)
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setFunctionMembershipInherited


Establishes inheritance as the access-control mechanism for a folder or workspace. (V1.0.3)


Syntax


public void setFunctionMembershipInherited( long binderId, boolean inherit );


Description


The setFunctionMembershipInherited operation allows you to establish that a folder or 
workspace is to inherit its access-control settings from the parent binder. The primary purpose of this 
operation is to set inheritance for folders and workspaces that you migrate from Forum.


Parameters and Return Value


binderId 


The binder identifier of the folder or workspace for which you want to establish inheritance for 
its access-control settings.


inherit 


A boolean value that determines whether the folder or workspace uses inheritance to establish 
its access settings.


Example


call.setOperationName(new QName(“setFunctionMembershipInherited”));                                                                         
Object result = call.invoke(new Object[] {new Long(21), new Boolean.TRUE}); 


This code establishes inheritance as the access-control mechanism for the folder or workspace 
whose binder identifier is 21.   


See Also


 The operation table for the Windows based facade-client.bat program (Appendix B, 
“Deprecated Web Services Operations,” on page 189)
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setOwner


Establishes the owner of a folder or workspace. (V1.0.3)


Syntax


public void setOwner( long binderId, long userId );


Description


The setOwner operation allows you to establish an owner for a folder or workspace. The primary 
purpose of this operation is to mirror Forum ownership as you migrate folders and workspaces.


Parameters and Return Value


binderId 


The binder identifier of the folder or workspace for which you want to establish ownership.


userId 


The user identifier of the person whom you want to be the owner of a folder or workspace.


Example


call.setOperationName(new QName(“setOwner”));                                                                         Object 
result = call.invoke(new Object[] {new Long(21), new Long(345)}); 


This code establishes the user whose identifier is 345 as the owner of the folder or workspace 
whose binder identifier is 21.   


See Also


 The operation table for the Windows based facade-client.bat program (Appendix B, 
“Deprecated Web Services Operations,” on page 189)
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setTeamMembers


Establishes the membership of a team for a folder or workspace. (V1.0.3)


Syntax


public void setTeamMembers( long binderId, String[] memberNames );


Description


The setTeamMembers operation establishes the members of a team for a folder or workspace.


Parameters and Return Value


binderId 


The binder identifier of the folder or workspace for which you want to establish team 
membership.


memberNames 


An array containing the names of all team members for the folder or workspace.


Example


call.setOperationName(new QName(“setTeamMembers”));                                                                         
Object result = call.invoke(new Object[] {new Long(21), users}); 


This code establishes each username in the array users as team members for the folder or 
workspace whose binder identifier is 21.   


See Also


 The operation table for the Windows based facade-client.bat program (Appendix B, 
“Deprecated Web Services Operations,” on page 189)

228 Novell Vibe 3.2 Developer Guide







synchronizeMirroredFolder


Synchronizes the mirrored folder with the folder on the external drive. (V1.0.3)


Syntax


public void synchronizeMirroredFolder( long binderId );


Description


The synchronizeMirroredFolder operation synchronizes a mirrored folder with the corresponding 
file on the external drive. A new mirrored folder does not synchronize with its external drive until a 
synchronization occurs manually in the user interface (UI) or using this message.


Parameters and Return Value


binderId 


The binder identifier of the mirrored file that you want to synchronize with its external drive.


Example


call.setOperationName(new QName(“synchronizedMirroredFolder”));                                                                         
Object result = call.invoke(new Object[] {new Long(21)}); 


This code synchronizes with its external drive the mirrored folder whose binder identifier is 21.   


See Also


 The operation table for the Windows based facade-client.bat program (Appendix B, 
“Deprecated Web Services Operations,” on page 189)
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uploadCalendarEntries


Creates new calendar entries from a file. (V1—V1.0.3)


Syntax


public void uploadCalendarEntries( long folderId, String XMLCalendarData );


Description


The uploadCalendarEntries operation uses iCal information in an XML string or in an attachment 
to add entries to a calendar folder. 


NOTE: The uploadCalendar command in the facade-client.bat batch file accepts two required 
parameters and an optional third parameter. The second parameter is a file containing XML that 
specifies iCal data. The third, optional parameter is an iCal formatted file. Both files must be located 
in the same directory as facade-client.bat. Again, if you want the iCal file to be the only source of 
data for newly created entries, place an empty XML document in the file specified as the second 
command parameter.


Parameters and Return Value


folderId 


The binder identifier of the calendar folder that is to contain the new entries.


XMLCalendarData 


A string containing XML formatted calendar data (<doc><entry>iCal data</entry>...</
doc>). If you wish to specify all of your calendar data in an iCal file attached to the message, pass 
an empty document for this string (<doc></doc>).


return_value 


None.


Example


call.setOperationName(new QName(“uploadCalendarEntries”));                                                                         
Object result = call.invoke(new Object[] {new Long(21), s}); 


This code creates new entries in the calendar folder whose binder ID is 21. Teaming uses XML-
formatted iCal information contained in the s variable to create the new calendar entries. 


See Also


 The operation table for the Windows based facade-client.bat program (Appendix B, 
“Deprecated Web Services Operations,” on page 189)


 Section 1.7.5, “Adding Calendar Entries,” on page 21
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uploadFolderFile


Attaches a file to an entry to a folder. (V1—V1.0.3)


Syntax


public void uploadFolderFile( long folderId, String entryId, String fileUploadDataItemName,       String 
attachedfileName );


Description


The uploadFolderFile operation attaches a file to an entry in a folder. You can attach only one file at 
a time; call this operation multiple times to attach more than one file to the entry. Files to be attached 
must be located in the same directory as the executing client. 


Parameters and Return Value


folderId 


The binder identifier of the folder that contains the entry to which you want to attach a file.


entryId 


The identifier of the entry to which you want to attach a file.


fileUploadDataItemName 


A string containing the internal identifier for the part of the entry that contains attached files. 
This identifier maps the name attribute of an input HTML tag on a form to the Teaming 
database; a hidden HTML tag communicates this mapping to the server.


The name value for the standard entry element containing attached files is ss_attachFile. If 
you want to upload a file into a custom form element you defined using the designers, you need 
to look up the name identifier for that form element (see also getDefinitionConfigAsXML or 
getFolderEntryAsXML).


attachedFileName 


The name of the file you wish to attach to the new entry. This client is responsible for locating on 
its local system the file to be used as an attachment.


return_value 


None.


Example


call.setOperationName(new QName(“uploadFolderFile”));                                                                         
Object result = call.invoke(new Object[] {new Long(21), new Long(43), new 


String(“ss_attachFile”), filename}, filename); 


This code attaches a file to entry 43 in the folder whose binder ID is 21. The name of the file to be 
attached to the entry is contained in the variable filename. 
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See Also


 The operation table for the Windows based facade-client.bat program (Appendix B, 
“Deprecated Web Services Operations,” on page 189)


 Section 1.7.3, “Attaching Files,” on page 20


 getDefinitionConfigAsXML (page 200)


 getFolderEntryAsXML (page 203)
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		definition_getDefinitionByName Obtains information about a global definition. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		definition_getDefinitions Obtains all global definitions in the installation.

		Syntax

		Description

		Parameters and Return Value

		See Also



		definition_getLocalDefinitionByName Obtains information about a local definition. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		definition_getLocalDefinitions Obtains information about all local definitions.

		Syntax

		Description

		Parameters and Return Value

		See Also



		folder_addEntry Adds an entry to a folder. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		folder_addEntryWorkflow Initiates a workflow process for a folder entry. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		folder_addMicroBlogAdds a micro-blog entry to a folder. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		folder_addReply Adds a comment to a folder entry. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		folder_copyEntry Copies a folder entry. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		folder_deleteEntry Deletes a folder entry. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		folder_deleteEntryTag Removes a tag from a folder entry. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		folder_deleteEntryWorkflow Removes a workflow from an entry. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		folder_getEntries Obtains information about the entries within a specified folder. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		folder_getEntry Accepts an entry identifier to get information about an entry in a folder. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		folder_getEntryByFileName Accepts a filename to get information about an entry.

		Syntax

		Description

		Parameters and Return Value

		See Also



		folder_getEntryTags Obtains information about an entry’s tags. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		folder_getFileVersions Returns information about the versions of a file. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		folder_getSubscription Obtains subscription information for a specified folder. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		folder_modifyEntry Modifies an entry in a folder. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		folder_modifyWorkflowState Changes the workflow state of an entry. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		folder_moveEntry Moves an entry within the folder-tree hierarchy.

		Syntax

		Description

		Parameters and Return Value

		See Also



		folder_preDeleteEntry Predeletes an entry by moving it to the trash.

		Syntax

		Description

		Parameters and Return Value



		folder_removeFile Removes a file attachment from an entry.

		Syntax

		Description

		Parameters and Return Value

		See Also



		folder_reserveEntry Reserves an entry.

		Syntax

		Description

		Parameters and Return Value

		See Also



		folder_restoreEntry Undeletes an entry by removing it from the trash and restoring it to its previous location in the Vibe site.

		Syntax

		Description

		Parameters and Return Value



		folder_setEntryTag Applies a tag to a folder entry. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		folder_setRating Sets a rating for a folder entry.

		Syntax

		Description

		Parameters and Return Value

		See Also



		folder_setSubscription Establishes subscription settings for an entry. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		folder_setWorkflowResponse Applies an answer to a workflow question for a specified entry. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		folder_synchronizeMirroredFolder Synchronizes a mirrored folder with its source folder. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		folder_unreserveEntry Releases a locked entry. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		folder_uploadFile Uploads a file as an attachment to an entry. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		folder_uploadFileStaged Locates a locally stored file and attaches it to an entry. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		ical_uploadCalendarEntriesWithXML Adds a calendar entry to a folder. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		ldap_synchAll Synchronizes all users with the current information that is in LDAP. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		ldap_synchUser Synchronizes one user with the latest information in LDAP for that person. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		license_getExternalUsers Obtains a count of external users. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		license_getRegisteredUsers Obtains a count of registered Vibe users. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		license_updateLicense Updates the Vibe license. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		migration_addBinder Accepts a Java object to add a binder, allowing preservation of SiteScape Forum data.

		Syntax

		Description

		Parameters and Return Value

		See Also



		migration_addBinderWithXML Accepts XML to add a binder, allowing preservation of SiteScape Forum data. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		migration_addEntryWorkflow Associates an entry with a workflow process, allowing preservation of SiteScape Forum data.

		Syntax

		Description

		Parameters and Return Value

		See Also



		migration_addFolderEntry Accepts a Java object to add an entry to a folder, allowing preservation of SiteScape Forum data. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		migration_addFolderEntryWithXML Accepts XML to add an entry to a folder, allowing preservation of SiteScape Forum data.

		Syntax

		Description

		Parameters and Return Value

		See Also



		migration_addReply Accepts a Java object to add a comment, allowing preservation of SiteScape Forum data. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		migration_addReplyWithXML Accepts XML to add a comment, allowing preservation of SiteScape Forum data. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		migration_uploadFolderFile Uploads an entry attachment, allowing preservation of SiteScape Forum data. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		migration_uploadFolderFileStaged Uploads a local copy of an entry attachment, allowing preservation of SiteScape Forum data. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		profile_addGroup Adds a group.

		Syntax

		Description

		Parameters and Return Value

		See Also



		profile_addGroupMember Adds a user to a group.

		Syntax

		Description

		Parameters and Return Value

		See Also



		profile_addUser Adds a user profile. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		profile_addUserWorkspace Adds a user workspace for an existing user. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		profile_deletePrincipal Removes a group or user. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		profile_getFileVersionsReturns information about the versions of a file. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		profile_getGroup Accepts a group identifier to obtain the title and the description of the group. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		profile_getGroupByName Accepts a group name to obtain the title and the description of the group.

		Syntax

		Description

		Parameters and Return Value

		See Also



		profile_getGroupMembers Obtains information about the members of a group.

		Syntax

		Description

		Parameters and Return Value

		See Also



		profile_getPrincipals Gets information for users and groups in the installation. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		profile_getUser Accepts a user identifier to get information about a user. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		profile_getUserByName Accepts a username to get information about a user. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		profile_getUsersObtains information for users in the installation. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		profile_getUserTeamsObtains information about all teams that the specified user is a member of.

		Syntax

		Description

		Parameters and Return Value

		See Also



		profile_modifyGroup Modifies a group.

		Syntax

		Description

		Parameters and Return Value

		See Also



		profile_modifyUser Modifies a user. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		profile_removeFile Removes a file from the user profile. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		profile_removeGroupMember Removes a user from a group. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		profile_uploadFileUploads a file as an attachment to a user or group. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		search_getFolderEntriesObtains information about the entries that match the specified search query.

		Syntax

		Description

		Parameters and Return Value

		See Also



		search_getTeams Obtains information about the teams that the calling user is a member of. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		search_getWorkspaceTreeAsXML Obtains information needed to construct the Vibe workspace and folder tree. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		search_search Returns XML for results of a search query.

		Syntax

		Description

		Parameters and Return Value

		Example

		See Also



		template_addBinder Adds a fully configured workspace or folder to the workspace hierarchy.

		Syntax

		Description

		Parameters and Return Value

		See Also



		template_getTemplates Obtains information about all defined templates in the installation. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		zone_addZone Adds a zone to the installation. 

		Syntax

		Description

		Parameters and Return Value

		See Also



		zone_deleteZone Deletes a zone.

		Syntax

		Description

		Parameters and Return Value

		See Also



		zone_modifyZone Modifies a zone. 

		Syntax

		Description

		Parameters and Return Value

		See Also





		B Deprecated Web Services Operations 

		addFolderAdds a folder to the workspace-tree hierarchy. (V1—V1.0.3)

		Syntax

		Description

		Parameters and Return Value

		Example

		See Also



		addFolderEntryAdds an entry to a folder. (V1—V1.0.3)

		Syntax

		Description

		Parameters and Return Value

		Examples

		See Also



		addReplyAdds a new comment to an entry or comment. (V1.0.3)

		Syntax

		Description

		Parameters and Return Value

		Example

		See Also



		addUserWorkspaceAdds a new personal workspace. (V1.0.3)

		Syntax

		Description

		Parameters and Return Value

		Example



		getAllPrincipalsAsXMLReturns summary information for users and groups. (V1—V1.0.3)

		Syntax

		Description

		Parameters and Return Value

		Example

		See Also



		getDefinitionAsXMLReturns information about one definition. (V1—V1.0.3)

		Syntax

		Description

		Parameter and Return Value

		Example

		See Also



		getDefinitionConfigAsXMLReturns information about all configuration definitions. (V1—V1.0.3)

		Syntax

		Description

		Return Value

		Example

		See Also



		getDefinitionListAsXMLReturns metadata for all definitions in the installation. (V1.0.3)

		Syntax

		Description

		Return Value

		Example

		See Also



		getFolderEntriesAsXMLReturns a string containing XML providing summary information about entries in a folder. (V1— V1.0.3)

		Syntax

		Description

		Parameter and Return Value

		Example

		See Also



		getFolderEntryAsXMLReturns information about one entry in a folder. (V1—V1.0.3)

		Syntax

		Description

		Parameters and Return Value

		Example

		See Also



		getPrincipalAsXMLReturns information about one user or group. (V1—V1.0.3)

		Syntax

		Description

		Parameters and Return Value

		Example

		See Also



		getTeamMembersAsXMLReturns information about all team members assigned within a workspace or folder. (V1—V1.0.3)

		Syntax

		Description

		Parameter and Return Value

		Example

		See Also



		getTeamsAsXMLReturns information about all workspaces and folders that have assigned teams. (V1—V1.0.3)

		Syntax

		Description

		Return Value

		Example

		See Also



		getWorkspaceTreeAsXMLReturns information needed to construct the Teaming workspace and folder tree. (V1—V1.0.3)

		Syntax

		Description

		Parameters and Return Value

		Example

		See Also



		indexFolderIndexes a folder. (V1.0.3)

		Syntax

		Description

		Parameter

		Example

		See Also



		migrateBinderCreates a new workspace or folder while preserving SiteScape Forum data. (V1.0.3)

		Syntax

		Description

		Parameters and Return Value

		Example

		See Also



		migrateEntryWorkflowAssociates an entry with a workflow process while preserving SiteScape Forum data. (V1.0.3)

		Syntax

		Description

		Parameters and Return Value

		Example

		See Also



		migrateFolderEntryCreates a new folder entry while preserving SiteScape Forum data. (V1.0.3)

		Syntax

		Description

		Parameters and Return Value

		Example

		See Also



		migrateFolderFileAttaches a file to an entry while preserving SiteScape Forum data. (V1.0.3)

		Syntax

		Description

		Parameters and Return Value

		Example

		See Also



		migrateFolderFileStagedLocates a locally stored file, and attaches it to an entry while preserving Forum data. (V1.0.3)

		Syntax

		Description

		Parameters and Return Value

		Example

		See Also



		migrateReplyCreates a new comment while preserving SiteScape Forum data. (V1.0.3)

		Syntax

		Description

		Parameters and Return Value

		Example

		See Also



		modifyFolderEntryModifies a single entry. (V1—V1.0.3)

		Syntax

		Description

		Parameters and Return Value

		Example

		See Also



		setDefinitionsEstablishes workflow-entry associations for a folder. (V1.0.3)

		Syntax

		Description

		Parameters and Return Value

		Example

		See Also



		setFunctionMembershipApplies access-control settings to a folder or workspace. (V1—V1.0.3)

		Syntax

		Description

		Parameters and Return Value

		Example

		See Also



		setFunctionMembershipInheritedEstablishes inheritance as the access-control mechanism for a folder or workspace. (V1.0.3)

		Syntax

		Description

		Parameters and Return Value

		Example

		See Also



		setOwnerEstablishes the owner of a folder or workspace. (V1.0.3)

		Syntax

		Description

		Parameters and Return Value

		Example

		See Also



		setTeamMembersEstablishes the membership of a team for a folder or workspace. (V1.0.3)

		Syntax

		Description

		Parameters and Return Value

		Example

		See Also



		synchronizeMirroredFolderSynchronizes the mirrored folder with the folder on the external drive. (V1.0.3)

		Syntax

		Description

		Parameters and Return Value

		Example

		See Also



		uploadCalendarEntriesCreates new calendar entries from a file. (V1—V1.0.3)

		Syntax

		Description

		Parameters and Return Value

		Example

		See Also



		uploadFolderFileAttaches a file to an entry to a folder. (V1—V1.0.3)

		Syntax

		Description

		Parameters and Return Value

		Example

		See Also








